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Введение

В книге, которую вы держите в руках, описывается последняя, двенадцатая,
версия популярной программы векторной графики CorelDRAW. Эта программа
входит в состав пакета графических программ CorelDRAW Graphic Suite 12, не-
давно выпущенного в свет известной фирмой-производителем программных
графических продуктов Corel Corporation. Здесь же рассматриваются три допол-
нительные программы данного графического пакета: Corel R.A.V.E. 3.0,
CorelTRACE 12 и Corel CAPTURE 12.

Книга объединяет в себе учебное пособие и справочник. Ее можно использовать
как при практическом освоении описываемой программы "с нуля", так и при
более углубленном изучении ее теми пользователями, которые давно уже в ней
работают. Эти качества стали возможны благодаря следующим принципам,
на которых базируется изложение автором материала:

П тщательно продуманный порядок изложения информации, которая сопрово-
ждается многочисленными иллюстрациями, что позволяет использовать
книгу в качестве учебника;

П полнота справочной информации о программе CorelDRAW 12, в том числе
о ее достоинствах и недостатках, новых функциях и средствах, а также почти
обо всех параметрах настройки и режимах работы;

П строгая систематизация материала, основанная на описании не отдельных
инструментальных средств и режимов работы программы, а выполняемых
в ней операций по обработке графических документов;

G подробное описание действий пользователя по выполнению конкретных
операций;

О предоставление необходимых сведений о прикладной области, в которой ис-
пользуется данная программа.

Все эти качества представленного материала позволят вам, уважаемый пользователь,
быстро и качественно освоить программу векторной графики CorelDRAW 12. Книга
рассчитана на широкий круг пользователей.
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Структура книги
Данная книга состоит из введения, десяти глав, двух приложений и предметного
указателя. Дадим им краткую характеристику.

В главе 1 "Знакомство с CorelDRAW 12"приводятся самые обшие сведения о рассмат-
риваемой программе. Здесь представлена следующая информация о CorelDRAW 12:
назначение, основные достоинства и недостатки программы, отличия от преды-
дущей версии, а также ресурсы компьютера, требуемые для работы.

В главе 2 "Интерфейс CorelDRA W 12" описывается пользовательский интерфейс
программы, без ознакомления с которым невозможно освоение конкретных
операций, рассматриваемых в книге.

Глава 3 "Технологические возможности CorelDRA W 42" посвящена тем способам,
приемам и техническим средствам программы, которые лежат в основе многих
операций по обработке графических документов. Вы их также должны изучить,
прежде чем перейти к рассмотрению основных функций программы.

В главе 4 "Обработка векторных объектов" приводится подробная информация
об операциях обработки объектов векторной графики. Здесь, а также в следую-
щих трех главах книги, описываются способы выполнения различных операций,
а также даются их сравнительные характеристики. Кроме того, в начале каждой
из этих глав указываются достоинства и недостатки программы в отношении тех
ее функций, которые рассматриваются ниже.

Глава 5 называется "Обработка растровых изображений", глава 6— "Обработка
текста", а глава 7-- "Работа с документом". В этих трех главах приводится под-
робная информация об операциях, выполняемых в отношении растровых и тек-
стовых объектов, а также самого графического документа.

В главе 8 "Настройка параметров CorelDRAW 12" описываются установочные
параметры программы. Как известно, рассматриваемая программа обладает
очень широкими возможностями настройки ее параметров. Каждый пользова-
тель, работающий в CorelDRAW 12, должен знать все эти параметры и уметь их
регулировать, чтобы создать для себя наилучшие условия для практического
решения стоящих перед ним задач.

В главе 9 "Команды меню CorelDRA W 12" приводится краткая справочная инфор-
мация обо всех командах основного меню программы, с указанием ссылок на те
разделы книги, в которых эти команды описываются более подробно. Данная гла-
ва может быть полезна в тех случаях, когда у вас возникнет проблема в отноше-
нии какой-либо команды меню, и необходимо быстро получить справку по ней.

Глава 10 "Дополнительные программы"посвящена трем важнейшим дополнитель-
ным программам графического пакета CorelDRAW Graphic Suite 12: Corel
R.A.V.E. 3.0 (программа создания видеоклипов), CorelTRACE 12 (программа
трассировки) и Corel CAPTURE 12 (программа-фотограф, используемая для
съемки с экрана).

В приложении / указаны быстрые клавиши программы CorelDRAW 12, а в при-
ложении 2— алфавитный список основных терминов векторной графики, кото-
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рые необходимо знать каждому пользователю, работающему в этой программе
и изучающему ее по данной книге.

В конце книги приведен подробный предметный указатель, являющийся основ-
ным средством поиска в книге необходимой справочной информации.

Порядок работы
Независимо от того, как вы собираетесь использовать эту книгу: в качестве учеб-
ного пособия или для получения справочной информации — обязательным усло-
вием является наличие у вас компьютера с установленными на нем программой
векторной графики CorelDRAW 12 и тремя описанными дополнительными про-
граммами. Это связано с тем, что осваивать конкретные операции, описанные
в книге, лучше всего при их практическом повторении на компьютере.

Чтобы получить справку по конкретному вопросу, воспользуйтесь предметным
указателем. В нем вы найдете ссылки на те страницы книги, где находится нуж-
ная вам информация. Если в программе предусмотрены различные способы вы-
полнения интересующей вас операции, то в книге они, как правило, приведены
все. Поэтому, перейдя на конкретную страницу, отмеченную в указателе, про-
смотрите весь соответствующий раздел, чтобы получить полную информацию
о выбранной операции.

Заметим при этом, что в предметном указателе систематизирована основная, но
не вся информация, представленная в книге. В частности, в нем отсутствуют
ссылки на описания команд меню и быстрые клавиши программы
CorelDRAW 12 (глава 9 и приложение />, а также термины векторной графики
(приложение 2). Поэтому альтернативным способом поиска в книге необходимой
информации является ее оглавление, в котором весь материал систематизирован
в порядке, удобном для практического освоения программы.

Если вы хотите использовать данную книгу в качестве учебного пособия, мы
рекомендуем начать ее последовательное чтение с самого начала. При этом вам
не нужно подробно знакомиться со всеми альтернативными способами выпол-
нения различных операций или изучать все описываемые параметры или фай-
ловые форматы. Достаточно лишь в них ориентироваться. Все, что вам требует-
ся при этом делать, — запустить в работу CorelDRAW 12 и следовать тем
инструкциям, которые приведены в книге. Если в процессе чтения материала
вам встретится незнакомый термин, воспользуйтесь приложением 2, находящим-
ся в самом конце книги.

Принятые соглашения
Прежде чем приступить к работе с книгой, познакомьтесь с теми соглашения-
ми, которые в ней используются для описания команд и инструментов рассмат-
риваемых программ:

G названия всех команд и элементов управления выделены полужирным начер-
танием;
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П когда речь идет о мыши (щелчок, двойной щелчок), то имеется в виду левая,
основная кнопка мыши; правая кнопка всегда указывается дополнительно;

П если в тексте есть ссылка на отдельную клавишу, то она дается и угловых
скобках; при ссылке на комбинацию клавиш каждая из них заключается
в угловые скобки, а между собой эти клавиши объединяются знаком "+";

О если в конце названия команды меню или элемента управления стоит много-
точие, свидетельствующее о некоторой задержке в ее выполнении, то в тек-
сте книги это многоточие будет опущено;

П при ссылке на некоторую команду основного меню (с указанием подменю,
если команда входит и в него) название этой команды может указываться
двумя способами, например: 1) команда То Front (Вверх) подменю Order
(Упорядочить) меню Arrange (Расположить) или 2) команда Arrange > Order »
То Front (Расположить ^ Упорядочить > Вверх);

П при ссылке на один из пяти образцов инструментов, входящих в состав ра-
бочего инструмента Artistic Media (Комплект художника) CorelDRAW 12, бу-
дет использовано следующее обозначение: Artistic Media > Sprayer (Комплект
художника > Распылитель), где Sprayer — один из таких инструментов. Ана-
логичное соглашение будет действовать и в отношении двух разновидностей
рабочего инструмента Interactive Connector (Интерактивный соединитель);

D для установления взаимно-однозначного соответствия между открытой
вкладкой диалогового окна Options (Параметры) и ее представлением в спи-
ске категорий настроек в книге дается не фактическое название выбранной
вкладки, отображаемое в этом окне, а перечень наименований категорий,
к которым она относится, например: Workspace > Customization »Command
Bars (Рабочая область > Настройка > Командные панели).



Глава 1

Знакомство с CorelDRAW 12

Назначение

Программа векторной графики CorelDRAW 12 вместе с программой растровой
графики Corel PHOTO-PAINT 12 и несколькими дополнительными программа-
ми составляет пакет графических программ CorelDRAW Graphic Suite 12, разра-
ботанный известной фирмой-производителем графических программных про-
дуктов Corel Corporation. CorelDRAW 12 предназначена для разработки макетов
документов, в которых преобладает графическая информация, с целью их пуб-
ликации в качестве типографской продукции и в электронном виде.

Программы, позволяющие обрабатывать векторные объекты наряду с растровы-
ми изображениями и текстовой информацией, обычно называются программами
векторной графики. Это название можно отнести и к программе CorelDRAW 12.
Вместе с тем, ее функциональные возможности существенно шире, чем у других
известных программ подобного типа (Macromedia FreeHand и Adobe Illustrator).

Фактически, CorelDRAW 12 представляет собой некий гибрид программы век-
торной графики, издательской программы (верстка печатных документов),
а также программы разработки электронных документов. Это дает основание
рассматривать CorelDRAW 12 как универсальную графика-издательскую про-
грамму, не имеющую в настоящее время аналогов на рынке прикладных про-
граммных продуктов, предназначенных для разработки документов.

Примечание

На практике термин "графико-издательская программа" не применяется, хотя
он бопее точно отражает возможности программы CorelDRAW 12, чем тради-
ционно используемые определения "программа векторной графики" и "графи-
ческая программа".
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Достоинства
Перечислим основные достоинства рассматриваемой программы, выделяющие
ее среди других современных графических и издательских программ.

Широкие функциональные возможности
CorelDRAW 12 позволяет обрабатывать самую разнообразную информацию,
представляемую в документе в виде векторных и растровых объектов, блоков
обычного и художественного текста, объектов OLE (они создаются в других
приложениях), а также объектов Интернета (используются при электронной
публикации).

Программа предоставляет пользователю возможность работы с многостранич-
ными документами, для которых допускается форматирование отдельных стра-
ниц,, их нумерация, а также компоновка на печатных листах, что характерно для
обычных издательских программ. Она позволяет формировать электронные вер-
сии разрабатываемых документов для их публикации в Интернете или на
компакт-дисках.

По широте функциональных возможностей CorelDRAW 12 намного превосходит
любые другие существующие графические и издательские программы. Она по-
зволяет делать многое из того, что доступно различным программам векторной
и растровой графики, текстовым редакторам, а также программам верстки пе-
чатных и электронных документов.

Высокие эксплуатационные качества
CorelDRAW 12 обладает удобством и простотой эксплуатации, гибкостью и ши-
ротой диапазона настройки установочных параметров. Справочная система
программы предоставляет пользователю всю необходимую информацию, как по
его запросам, так и в контекстном режиме.

В программе применен современный интерфейс плоского типа, который харак-
теризуется тем, что инструменты, находящиеся на различных панелях, отобража-
ются в виде обычных плоских рисунков, а выделение одного из них происходит
только при установке на нем указателя. В число рабочих инструментов про-
граммы входит целая группа интерактивных инструментов, с которыми очень
удобно работать благодаря расположению элементов управления параметрами
инструмента рядом с обрабатываемым объектом. Конструкция перестраиваемой
панели свойств, предназначенной для настройки параметров выполняемой опе-
рации, доведена до совершенства, а количество других панелей инструментов
сведено к минимуму.

Установочные параметры CorelDRAW 12 могут быть настроены и сохранены
в файле в качестве нового образца пользовательского интерфейса. Это позволя-
ет создавать любое количество такич интерфейсов и применять их в зависимо-
сти от решаемых задач или склонностей пользователей программы. Предусмот-
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рена возможность импорта и экспорта образцов интерфейсов CorelDRAW 12,
что позволяет обмениваться ими между пользователями, работающими на раз-
личных компьютерах.

Современные технические решения
В CorelDRAW 12 реализованы самые современные технические решения по об-
работке в документе объектов различных типов. Наиболее впечатляющими опе-
рациями обработки являются следующие:

d создание различных геометрических фигур путем их рисования от руки;

П формирование размерных и соединительных линий различных типов;

П наложение и распыление изображений вдоль контуров векторных объектов;

О выполнение заливок шести типов для векторных объектов;

О регулировка прозрачности растровых и векторных изображений;

П создание девяти эффектов векторной графики;

О создание в растровых изображениях документа почти всех эффектов фильт-
рации, предусмотренных в программе растровой графики Corel PHOTO-
PAINT 12;

О слияние информации при печати.

Высокое качество цветопередачи
Программа CorelDRAW 12 обладает высоким качеством цветопередачи благода-
ря следующим свойствам:

О современному механизму цветового управления программой, который бази-
руется на использовании стандартных цветовых профилей;

О большому набору библиотек стандартных и составных цветов;

G возможности выполнения операции цветоделения для гексахромной печати
(шестью базовыми цветами), которая характеризуется повышенным качест-
вом цветопередачи в печатных оттисках.

Высокий уровень сервиса
Он достигается за счет следующих функций программы:

П поиск в документе объектов с заданными атрибутами оформления, а также
замена одних заданных атрибутов объектов на другие;

П возврат к любому промежуточному состоянию документа с целью изменения
последующих операций по его обработке;

О интерактивное цветовое управление программой с помощью диалогового
окна Color Management (Цветовое управление), представляющего собой
управляемую схему взаимодействия составных частей компьютерной системы,
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по которой производится цветовая коррекция содержимого обрабатываемого
документа;

П создание и использование макрокоманд VBA с помощью известного прило-
жения Microsoft Visual Basic 6.3 с целью автоматизации обработки объектов
в документах.

Формирование электронных версий документа
Документ, обрабатываемый в CorelDRAW 12, может быть не только распечатан,
но и преобразован в электронную форму с сохранением его в одном из двух
векторных файловых форматов:

G HTML — применяется в Интернете (при сохранении изображений в отдель-
ных файлах формата GIF, JPEG, PNG или Flash);

О PDF — доступен для любых видов электронной публикации.

В программе предусмотрены все необходимые функции для полной разработки
электронных графических документов, в том числе:

О вставка в объекты документа закладок и гиперссылок, обеспечивающих связи
между отдельными объектами и страницами данного документа, а также ме-
жду текущим документом и другими сетевыми документами;

П вставка в документ объектов Интернета (флажки, переключатели, списки,
кнопки и т. п.), выполняющих различные управляющие или информацион-
ные функции при электронной публикации документа в Web;

П формирование в объектах документа интерактивных состояний, создающих
(при электронной публикации документа) эффекты интерактивности под
воздействием мыши на области срабатывания этих объектов.

Примечание

Следует отметить одно важное достоинство нынешней версии программы
CorelDRAW по сравнению с предыдущими ее версиями. Оно состоит в том, что
в CorelDRAW 12 практически отсутствует проблема искажения русских текстов
в формируемых электронных документах различных форматов.

Недостатки
Все существующие недостатки программы CorelDRAW 12 можно разбить на две
группы:

О недоработки, вызванные ошибками разработчиков или нарушением заданных
условий эксплуатации программы;

П сравнительные недостатки, связанные с невыполнением отдельных функций,
которые реализованы в других графических и издательских программах.
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Недоработки программы
К числу недоработок CorelDRAW 12, которые удалось обнаружить автору, отно-
сятся следующие:

О при раскрытии нескольких стационарных докеров они могут располагаться
не традиционным образом (когда только одни их них доступен для использо-
вания), а друг под другом, что существенно ограничивает доступ к ним;

Примечание

Указанный недостаток компоновки стационарных докеров может быть устранен
с помощью мыши путем временного перевода каждого из них в плавающую
форму, а затем — снова в стационарную.

Г) не работает режим формирования пунктирной линии вокруг комбинирован-
ного объекта при его перемещении или трансформации (этот режим задается
на панели свойств кнопкой Draw Complex Objects When Moving or Transforming
(Очертить сложные объекты при перемещении и трансформации) при ис-
пользовании рабочего инструмента Pick (Выбор) и отсутствии в документе
выделенных объектов);

О нельзя подключать файлы аудиоклипов к интерактивным состояниям типа
Down (в CorelDRAW 11 этот недостаток отсутствовал);

П многие установленные шрифты недоступны для использования при работе
с русскоязычным текстом (названия таких шрифтов предстаачяются серым
цветом, а не черным);

П не функционирует режим печати с наложением для областей обводки век-
торных и текстовых объектов документа;

П в режиме слияния информации при печати не загружаются табличные дан-
ные, хранящиеся в файлах известных форматов (DBF и др.), отвечающих
стандарту ODBC, который поддерживает Windows XP (в предыдущей версии
программы этот недостаток отсутствовал);

П в докере Insert Character (Вставить символ) не предусмотрен режим форми-
рования в документе мозаик символов, который имелся в CorelDRAW 1 1 ;

О при обработке растрового изображения командой фильтрации Wet Paint (Жид-
кая краска), входящей в подменю Distort (Искажение) меню Bitmaps (Растро-
вая графика), происходит значительное смещение вверх обработанного изо-
бражения (в предыдущей версии программы этот недостаток отсутствовал);

П в плавающих докерах заголовки отображаются всегда, даже при снятом
флажке Show titles on floating dockers, находящемся на вкладке
Workspace > General (Рабочая область »Общие) диалогового окна Options
(Параметры). И только в случае установки этого флажка и последующего его
сброса данный режим отключится в текущем сеансе работы программы.

2 Зак. 2*0
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Сравнительные недостатки программы
В CorelDRAW 12 отсутствует ряд функций, которые реализованы в программе
векторной графики Adobe Illustrator и издательской программе QuarkXPress.
Перечислим основные из них:

П создание многослойных изображений для растровых и текстовых объектов
документа (Illustrator);

П оформление линий обводки мозаичными узорами (Illustrator);

П формирование рамок многоугольной формы при наложении изображений на
контуры векторных объектов (Illustrator);

П создание в документе целых наборов потомков выбранных символов, а также
обработка таких наборов (Illustrator);

d отсутствие стандартных библиотек символов, входящих в установочный ком-
плект программы (Illustrator);

CI работа с текстом, имеющим вертикальную ориентацию строк (Illustrator);

О ввод обычного текста во внутреннюю область разомкнутого контура (Illustrator);

П обработка больших документов, хранящихся в нескольких файлах (QuarkXPress);

П создание плавающих колонтитулов, списков и предметных указателей
(QuarkXPress).

Отличия от CorelDRAW 11
Данный раздел предназначен для тех пользователей, которые хорошо знают
одиннадцатую версию программы CorelDRAW и хотят быстро познакомиться
с новыми функциями двенадцатой версии, описываемой в книге. Это позволит
им значительно сократить время, требуемое для освоения программы.

Новые функции
Перечислим новые функции программы CorelDRAW 12.

Работа с библиотечными символами
В CorelDRAW 12 существенно расширен выбор функций по работе с символа-
ми. Теперь стало возможным использовать не только собственные символы до-
кумента, но и так называемые внешние символы, которые хранятся в файлах
библиотек (с расширением csl) с целью их применения во многих документах.

Использование динамических направляющих
В рассматриваемой программе предусмотрен режим работы с динамическими
направляющими, существенно облегчающими позиционирование перемещае-
мых объектов по отношению к другим объектам документа. Динамическая
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направляющая представляет собой прямую линию, имеющую один из заданных
углов наклона, которая появляется на экране при определенном положении
в документе перемещаемого объекта. Рядом с этой направляющей отображаются
угол ее наклона и расстояние перемещаемого объекта по отношению к сравни-
ваемому объекту.

Улучшенный режим привязки к объектам
Если в предыдущих версиях программы CorelDRAW привязка точки захвата пе-
ремещаемого объекта осуществлялась лишь к узелкам и геометрическим цен-
трам других объектов документа, то теперь привязка стала возможна и ко мно-
гим другим элементам объектов. При этом на экране отображается значок
и название того элемента, к которому происходит привязка.

Расширенные возможности выравнивания текстовых
объектов
При выполнении операции выравнивания объектов с помощью команды Align
and Distribute (Выровнять и распределить) стало возможным выравнивать тек-
стовые объекты относительно базовых линий их первых и последних текстовых
строк.

Поддержка многих языков
CorelDRAW 12 имеет многоязычный интерфейс, а также позволяет работать
в документе с иностранными текстами. Для правильного отображения таких
текстов предусмотрена возможность выбора в программе требуемых кодовых
страниц.

Создание стандартных фигур путем их рисования
Теперь появилась возможность создания фигур прямоугольников, эллипсов,
параллелограммов и трапеций путем рисования образующих фигур, отдаленно
напоминающих результирующие.

Удаление пересекающихся участков векторных контуров
Если несколько векторных объектов расположено друг на друге, то вы сможете
сформировать из них составной контур путем удаления выбранных пересекаю-
щихся участков контуров этих объектов.

Перенос параметров и атрибутов между объектами
Если в программе CorelDRAW 11 рабочие инструменты Eyedropper (Пипетка)
и Paintbucket (Ведро с краской) использовались для передачи атрибутов заливки
и обводки от одних векторных объектов к другим таким объектам, а также для
передачи цвета раскраски выбранного пиксела документа, то теперь функции
этих инструментов существенно расширились. В CorelDRAW 12 стало возможным
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переносить от одних объектов к другим многие параметры и атрибуты, выбор
которых производится на панели свойств. К их числу относятся:

П для векторных объектов: атрибуты заливки и обводки исходного объекта,
цвет выбранного пиксела документа, а также параметры существующих эф-
фектов векторной графики;

П для текстовых объектов — параметры форматирования;

П для объектов произвольных типов — координаты объекта, а также параметры
его трансформации.

Экспорт информации для офисных документов
Выбранное содержимое документа вы можете сохранить в файле такого форма-
та, который лучше всего подходит к импорту в офисный документ, разработан-
ный в программе Microsoft Word или WordPerfect Office. Выбор требуемого
формата производится автоматически в зависимости от назначения формируе-
мого файла.

Новые рабочие инструменты
Перечислим два новых рабочих инструмента CorelDRAW 12, отсутствующих
в предыдущей версии программы.

Новый инструмент Virtual Segment Delete (Удаление виртуального сегмента)
позволяет выполнить обработку контуров векторных объектов, наложенных
друг на друга, путем удаления тех их видимых частей, на которых произво-
дятся щелчки мышью. Удаляемый участок контура, выбираемый указателем
в момент выполнения щелчка мышью, ограничивается ближайшими к ука-
зателю точками пересечения данного контура с другими контурами пере-
крывающихся объектов документа.

Новый инструмент Smart Drawing (Умное рисование) предназначен для
создания геометрических фигур (в том числе и автофигур, содержащих
управляющие маркеры) путем автоматического преобразования в них ис-
ходных фигур, нарисованных от руки.

Новый докер Symbol Manager
Новый докер Symbol Manager (Диспетчер символов) пришел на смену докеру
Library (Библиотека), который использовался в CorelDRAW П. Он обеспечивает
доступ к собственным символам документа, а также ко внешним символам,
хранящимся в файлах библиотек (с расширением csl). Заметим, что старый
докер Library позволял работать лишь с символами, созданными в самом обра-
батываемом документе.
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Новые команды
Перечислим новые команды CorelDRAW 12, указав их назначение.

Меню File
Меню File (Файл) включает следующие новые команды:

О Сжатая ZIP-папка, входящая в подменю Send To (Отправить), — создает ар-
хивный файл формата ZIP для активного документа, помещая этот файл
в папку, содержащую исходный файл данного документа;

О Export For Office (Экспортировать для офиса) — сохраняет содержимое
документа в файле векторного формата EMF или WPG либо растрового
формата PNG. Выбор формата производится автоматически в зависимости от
заданного назначения формируемого файла, который предполагается исполь-
зовать в документе, разработанном в одном из офисных приложений
(Microsoft Word или WordPerfect Office).

Меню Edit
Меню Edit (Правка) содержит следующие новые команды:

О в подменю Symbol (Символ):

• Symbol Manager (Диспетчер символов) — управляет открытием одноимен-
ного докера, предназначенного для работы с символами документа;

• Break Link (Разорвать связь) — преобразует в собственные символы доку-
мента те используемые внешние символы, хранящиеся в файле библиоте-
ки символов (с расширением csl), потомки которых были предварительно
выделены;

• Update From Link (Обновить через связь) — обновляет связи с теми внеш-
ними символами, потомки которых были выбраны в документе;

• Export Library (Экспортировать библиотеку) — позволяет сформировать
файл библиотеки символов из тех символов активного документа, потом-
ки которого были выделены;

О Overprint Outline (Печать обводки с наложением) — подключает режим печа-
ти с наложением (без выбивки) фонового объекта в области заливки верхнего
объекта;

П Overprint Fill (Печать заливки с наложением) — подключает режим печати
с наложением фонового объекта в области обводки верхнего объекта.

Меню View
Меню View (Вид) включает следующие новые команды:

П Dynamic Guides (Динамические направляющие) — управляет режимом работы
с динамическими направляющими;
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П Dynamic Guides Setup (Настройка динамических направляющих) — открывает
диалоговое окно Options (Параметры) на вкладке Workspace > Dynamic Guides
(Рабочая область »Динамические направляющие) с параметрами настройки
динамических направляющих.

Меню Text
Меню Text (Текст) содержит новую команду Encode (Кодировка), которая пред-
назначена для выбора требуемой кодовой таблицы, позволяющей правильно
отобразить иностранный текст, выбранный в документе.

Меню Help
Меню Help (Помощь) включает новую команду Working with Office (Работа
с офисом), которая открывает раздел справочной системы CorelDRAW 12, по-
священный совместной работе данной программы с офисными приложениями
Microsoft Word и WordPerfect Office.

Требования к компьютеру
Сформулируем требования к ресурсам персонального компьютера, обеспечи-
вающие установку программы векторной графики CorelDRAW 12 (всех про-
грамм графического пакета CorelDRAW Graphic Suite 12), а также нормальную
работу в ней (в них):

О процессор — не ниже Pentium II, 233 МГц;

П оперативная память: минимальная 128 Мбайт, рекомендуемая -
256 Мбайт;

G дисковая память, требуемая для установки:

П только программы CorelDRAW 12 — 250 Мбайт;

П всего пакета программ — 380 Мбайт;

G свободная дисковая память — не менее 100 Мбайт;

П монитор — размером не менее 17-ти дюймов с разрешением экрана не ниже
1024x768 точек;

П устройство чтения компакт-дисков;

П операционная система — Windows XP.
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Интерфейс CorelDRAW 12

Программа векторной графики CorelDRAW 12 обладает высокими эксплуатаци-
онными качествами за счет совершенства пользовательского интерфейса. Дан-
ный интерфейс характеризуется следующим набором качеств:

П удобство и простота эксплуатации;

О привлекательный внешний вид;

G широкие возможности настройки.

В частности, CorelDRAW 12 позволяет работать с несколькими вариантами
пользовательского интерфейса, которые отличаются друг от друга командами
меню, быстрыми клавишами, панелями инструментов, а также установочными
параметрами программы. Тот или иной вариант интерфейса выбирается (созда-
ется) в зависимости от решаемых в программе задач или от пристрастий дизай-
неров, работающих на компьютере.

Устройство интерфейса
При запуске программы на экране отображается панель Welcome to CorelDRAW(R) 12
(Добро пожаловать в CorelDRAW(R) 12) с набором управляющих кнопок и ги-
перссылок, предназначенных для открытия окна программы в одном из шести
режимов (рис. 2.1).

К числу этих кнопок и гиперссылок относятся:

П кнопка New (Новый), используемая для формирования нового графического
документа;

D список гиперссылок с названиями пяти документов, открывавшихся послед-
ними, который позволяет открыть один из этих документов (это список рас-
положен над надписью Recently Used (Последние использовавшиеся));

О кнопка Open (Открыть), используемая для открытия любого документа, хра-
нящегося в файле на диске;
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П кнопка New From Template (Новый из шаблона), с помощью которой откры-
вается одноименное диалоговое окно с целью выбора одного из библиотеч-
ных шаблонов программы, на основе которого будет создан новый документ;

П кнопка CorelTUTOR (Учебник CorelTUTOR), используемая для создания
нового документа и последующего открытия окна Web-обозревателя, в кото-
рый загружается электронный учебник программы CorelDRAW 12;

О кнопка What's New? (Что нового?), предназначенная для вывода на экран
раздела справочной системы CorelDRAW 12, содержащего сведения о новых
возможностях этой программы.

Welcome to CorelDRAW(R) 12

New

Internet_Text.cdr
Int pb jjrnport.cdr

Text.cdr
5ymbols.cdr

5-iO.CDR

Recently Used Open

New From Template

Click a graphic to begin,..

CorelTUTOR

Show this Welcome Screen at startup

What's New?

www.designer.com

Рис. 2.1. Панель Welcome to CorelDRAW(R) 12

Щелкнув на надписи www.designer.com, вы подключитесь к Web-сайту Интерне-
та, который представляет коллектив дизайнеров, работающих с продукцией
фирмы Corel Corporation.

Если перед щелчком на выбранной кнопке или гиперссылке снять флажок Show
this Welcome Screen at startup (При запуске показать эту панель с приглашени-
ем), то при следующих запусках программы будет применяться установленный
вами режим без вывода данной панели на экран.

Пользовательский интерфейс программы CorelDRAW 12 является современным
интерфейсом плоского типа, который характеризуется тем, что объемный вид
кнопки инструмента появляется лишь при ее выборе указателем. Благодаря это-
му ускоряется поиск нужных инструментов в программе и снижается вероят-
ность их ошибочного выбора.

На рис. 2.2 изображено окно программы при открытии в нем нового до-
кумента.
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1/
Рис. 2.2. Окно программы CorelDRAW 12. Здесь: 1 —системные меню;
2 — заголовок программы; 3 — строка меню; 4 — стандартная панель;

5 — панель свойств; 6 — горизонтальная линейка; 7 — системные кнопки;
8 — блок инструментов; 9 — вертикальная линейка; 10 — навигатор страниц;
11—строка состояния; 12 — страница документа; 13 — компоновочная зона;

14 — полосы прокрутки; 15 — навигатор документа; 16 — докер;
17 — цветовая палитра

Поскольку CorelDRAW 12 работает в операционной среде Windows, интерфейс
программы содержит стандартный набор элементов, известных каждому пользо-
вателю:

П системные кнопки программы и документа Свернуть, Восстановить/Развернуть
и Закрыть;

П системные меню программы и документа;

О строка заголовка программы;

О строка заголовка документа (при неполном его открытии).

Рассмотрим другие составные части интерфейса программы, которые изображе-
ны на рис. 2.2.

О Строка меню (menu bar) находится под заголовком программы. Представляет
собой панель, где указаны названия списков команд основного меню про-
граммы, сгруппированные по функциональному признаку. Чтобы открыть
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определенный список, нужно щелкнуть на соответствующем названии.
(См. разд. "Меню команд" настоящей главы.)

П Стандартная панель (standard bar) размещена под строкой меню. Постоянно
присутствует на экране и включает инструменты, позволяющие выполнять
наиболее распространенные операции по работе с документами (создание,
открытие, сохранение, печать и другие). Размещение инструментов на пане-
ли и их состав фиксированы, благодаря чему ими легко оперировать.
(См. разд. "Панели инструментов" данной главы.)

П Панель свойств (property bar) расположена под стандартной панелью. Данная
панель постоянно присутствует на экране и содержит элементы управления и
индикации, которые используются для настройки параметров активного ра-
бочего инструмента. Обладает свойством трансформации, то есть ее состав и
вид изменяются в зависимости от применяемого рабочего инструмента и вы-
полняемой операции. (См. разд. "Панели инструментов"настоящей главы.)

ГЭ Блок инструментов (toolbox) находится слева на экране. Этот блок представ-
ляет собой вертикальную панель с кнопками управления, которые называют-
ся рабочими инструментами и применяются для выполнения различных опе-
раций с объектами документа. В каждой ячейке блока могут размещаться
один или несколько инструментов. Если инструментов несколько, то в пра-
вом нижнем углу ячейки указывается черная треугольная метка. При щелчке
на ней открывается дополнительная панель с инструментами, которые отно-
сятся к данной ячейке блока. (См. разд. "Блок инструментов" данной главы.)

О Строка состояния (status bar) размещается вдоль нижнего края окна про-
граммы. Позволяет отобразить текущую информацию о применяемом инст-
рументе и выполняемой операции, а также цвет или узор заливки и цвет об-
водки выбранного объекта. (См. разд. "Строка состояния"настоящей главы.)

П Докеры обычно принимают стационарную форму и размещаются на экране
справа (могут быть также представлены в плавающей форме). Используются
для работы с системными средствами программы и различной вспомогатель-
ной информацией, необходимой при обработке документов. Если в программу
загружено несколько докеров, они либо размещаются на отдельных панелях,
либо представляются в виде нескольких вкладок одной панели с открытием
одной из них (переход на новую вкладку выполняется с помощью щелчка на
ее ярлычке). (См. разд. "Докеры"настоящей главы.)

О Цветовая палитра располагается на экране справа. Она представляет собой
набор цветовых образцов, позволяющих раскрашивать объекты документа.
В программе можно одновременно работать с несколькими цветовыми па-
литрами, находящимися в открытом состоянии. (См. разд. "Цветовые палитры"
данной главы.)

П Рабочая область программы находится между блоком инструментов (слева),
панелью свойств (вверху), стационарными докерами или цветовой палитрой
(справа) и строкой состояния (внизу). В данной области находятся одно или
несколько рабочих окон с открытыми документами. Обычно работа в про-
грамме выполняется с одним документом, который открывается на экране
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полностью (см. рис. 2.2). Однако возможна одновременная обработка и не-
скольких открытых документов, находящихся в рабочей области.

П Рабочее окно документа предназначено для размещения в нем открытого до-
кумента, а также для управления его перемещением и отображением на эк-
ране. В данном окне представлен такой стандартный набор элементов:

• в верхней части — заголовок окна при его неполном открытии, содержа-
щий следующие элементы (в порядке слева направо): системное меню,
название документа и системные кнопки управления;

• в центральной части — область обработки, где отображается содержимое
документа и производится его обработка;

• в нижней части (в порядке слева направо): навигатор страниц, горизон-
тальная полоса прокрутки, навигатор документа;

• справа — вертикальная полоса прокрутки.

О Рабочая область документа отображается в видимой области рабочего окна
документа. Состоит из двух частей: открытой страницы (двух открытых стра-
ниц) макета документа и периферийной области, которая называется компо-
новочной зоной. Края страницы отображаются на экране сплошной линией
с тенью.

П Компоновочная зона предназначена для формирования, обработки и времен-
ного хранения объектов документа, которые можно в дальнейшем разместить
на ее страницах и вывести на печать. Если некоторый объект находится
в компоновочной зоне, то при изменении текущей страницы документа его
положение не меняется. Та максимально возможная область открытого до-
кумента, которая может отображаться в рабочем окне, называется монтаж-
ным столом.

^" Примечание

В программе допускается работа с многостраничными документами. В таком
документе страницы могут отличаться своими размерами и ориентацией.

П Навигатор страниц является составной частью рабочего окна документа,
Он представлен в виде набора элементов управления (кнопок управления,
ярлычков страниц и контекстных меню для этих ярлычков), с помощью ко-
торых можно производить различные операции по манипуляции страницами
активного документа. (См. разд. "Манипуляция страницами документа" гл. 7.)

О Навигатор документа представлен в виде небольшого белого значка квадрат-
ной формы, который находится в правом нижнем углу рабочего окна доку-
мента (в месте стыка двух полос прокрутки). Позволяет регулировать область
документа, отображаемую в его рабочем окне, в том случае, если открытые
страницы отображаются не полностью. Для работы с навигатором документа
следует поместить указатель в его внутреннюю область и нажать кнопку мыши.
При этом откроется рабочее окно навигатора с миниатюрой изображения
открытых страниц, в котором регулируется область отображения документа.
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Это происходит путем перемещения рамки, очерчивающей данную область
(рис. 2.3). Чтобы завершить работу с навигатором, достаточно отпустить
кнопку мыши.

Рис. 2.3. Навигатор документа в процессе работы.
Здесь: 1 — рабочее окно навигатора документа;

2 — область отображения документа в рабочем окне

Интерфейс CorelDRAW 12 содержит также диалоговые окна, дополнительные
панели инструментов и справочную систему программы. Диалоговые окна
предназначены для настройки параметров команд и рабочих инструментов,
а также установочных параметров программы (см. разд. "Диалоговые окна" данной
главы). С помощью панелей инструментов выполняются различные операции,
которые относятся к определенным режимам работы программы (см. разд.
"Панели инструментов" настоящей главы). Справочная система предоставляет
пользователю необходимую помощь при работе с программой, а также позволя-
ет изучить ее самостоятельно (см. разд. "Справочная система"данной главы).

Ниже подробно рассматриваются наиболее важные элементы интерфейса про-
граммы.

Строка состояния
Строка состояния программы может состоять из одного или двух рядов спра-
вочной информации. По умолчанию отображаются два ряда, которые содержат
такие сведения (рис. 2.4):

П- вверху:

• слева и в центральной части — информацию о выделенных объектах до-
кумента;

* справа — прямоугольный образец заливки, слева от которого указывается
тип заливки или ее цвет; при двойном щелчке на этом образце открыва-
ется диалоговое окно с параметрами заливки используемого типа;
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П внизу:

• слева — текущие координаты указателя;

• в центре — перечень действий, которые можно выполнить с помощью
выбранного рабочего инструмента;

• справа — прямоугольный образец обводки, слева от которого указываются
цвет и толщина обводки; при двойном щелчке на этом образце открывается
диалоговое окно Outline Pen (Контурное перо) с параметрами обводки.

tttdtfi:»iE6a Ней»-52,L06 Cental: <S*,Mlj Ш,ЗгО> mttnuWf' (да19тц1еиЧ.яув 1 "
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Рис. 2.4. Вариант строки состояния CorelDRAW 12 с двумя рядами информации

В строке состояния может также отображаться и другая служебная информация,
не упомянутая выше. Здесь, в частности, вы можете указать текущие состояния
управляющих клавиш <Caps Lock>, <Num Lock> и <Scroll Lock>. Перечень
сведений, выводимых в строке состояния, а также место их размещения задают-
ся в режиме настройки ее параметров (см. разд. "Параметры интерфейса"гл. 8),

Некоторые операции по настройке параметров строки состояния производятся
с помощью ее контекстного меню. Для открытия контекстного меню строки
состояния выполните два действия.

1. Установите указатель в любое место строки состояния, щелкните правой
кнопкой мыши и в открывшемся общем контекстном меню панелей инстру-
ментов выберите пункт Customize (Настроить).

2. Выберите пункт Status Bar (Строка состояния).

В результате откроется вложенное меню команд строки состояния, в котором
находятся такие команды:

П Reset to Default (Восстановить строку состояния) — задание исходных пара-
метров строки состояния, применяемых в программе по умолчанию;

П в подсписке Size (Размер):

• One Line (Один ряд) — отображение верхнего ряда строки;

• Two Lines (Два ряда) — отображение двух рядов строки;

О в подсписке Position (Положение):

• Тор (Вверху) — размещение строки состояния вверху экрана (под строкой
меню);

• Bottom (Внизу) — расположение строки внизу экрана;

О Properties (Свойства) — открытие диалогового окна Options (Параметры)
с целью настройки параметров строки состояния.
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Меню команд
Программа CorelDRAW 12 содержит различные команды, которые для удобства
использования сгруппированы определенным образом в виде раскрывающихся
списков (в том числе и вложенных). Эти списки называются меню команд.
В зависимости от месторасположения этих меню и того, как в них выполняется
группировка команд, различают основные и контекстные (вспомогательные)
меню.

Основное меню программы содержит наиболее важные команды, сгруппирован-
ные по своему функциональному назначению в одиннадцати списках. Такие
списки расположены в свернутом состоянии в виде строки меню, которая нахо-
дится под заголовком программы (см. рис. 2.2). (Команды основного меню
программы CorelDRAW 12 описаны в гл. Я)

Контекстное меню включает группу команд, которые связаны с определенным
элементом интерфейса или обрабатываемым объектом и размешены в непосред-
ственной близости от него. Данное меню открывается одним из двух способов
(в зависимости от его принадлежности):

О щелчком правой кнопки мыши при установке указателя на соответствующем
элементе интерфейса программы, обрабатываемом объекте или в свободной
области документа;

О щелчком левой кнопки мыши на кнопке открытия меню активного докера
(с меткой черного треугольника), находящейся в правом верхнем углу докера.

Как правило, контекстное меню содержит все команды, относящиеся к данному
элементу или объекту. Это позволяет значительно повысить эффективность
обработки документа, так как не требует времени на поиск нужных команд
в основном меню программы. Кроме того, во многих контекстных меню можно
работать с командами, которых вообще нет в основном меню.

Рассмотрим функции различных надписей и меток, которые могут встречаться
в названиях пунктов основного и контекстных меню программы:

П значок черного треугольника в конце пункта указывает на наличие подменю
команд. При установке на нем указателя открывается дополнительный спи-
сок команд (он также может быть вложенным);

П символ многоточия в конце названия пункта указывает, что при выполнении
данной команды будет возникать некоторая задержка, связанная с настрой-
кой параметров команды (в открывшемся диалоговом окне или докере) или
с манипуляцией мышью;

П указание группы клавиш (со знаком "+" между ними) или клавиши в конце
пункта означает, что данная команда выполняется путем совместного нажа-
тия этих клавиш, которые в данном случае называются быстрыми;

П подчеркивание символа в названии пункта меню указывает на то, что при
нажатии соответствующей клавиши, которую называют горячей, будет выбран
данный пункт меню и команда выполнится;
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Примечание

В отличие от быстрых клавиш, горячие клавиши действуют только при открытии
соответствующего списка команд основного меню программы. Для выполнения
необходимой команды с помощью горячих клавиш следует предварительно
нажать клавишу <Alt>. Горячие клавиши позволяют не только выполнять
команды меню, но и задавать состояние дискретных параметров в диалоговых
окнах CorelDRAW 12 (клавиша <A1t> там также используется).

О серый цвет с белым отливом, применяемый для отображения пункта меню,
указывает на то, что данная команда в настоящий момент недоступна дня
использования;

П метка-галочка слева от названия команды активизирует режим, определяе-
мый названием данной команды. Например, галочка в пункте Guidelines
(Направляющие) меню View (Вид) устанавливает режим отображения на-
правляющих, при отсутствии галочки указанный режим будет отключен.

В программе CorelDRAW 12 предусмотрен режим настройки команд основного
и контекстных меню. С его помощью вы сможете не только изменить состав
команд любого имеющегося меню, но и указать для этих команд новые быстрые
и горячие клавиши (см. разд. "Параметры интерфейса"гл. 8).

Блок инструментов
Блок инструментов (toolbox) программы CorelDRAW 12 представляет собой
набор кнопок управления, которые сгруппированы в одном месте (на одной
основной и нескольких дополнительных панелях) и позволяют выполнять наи-
более важные операции по формированию и обработке объектов документа,
Такие кнопки называются рабочими инструментами (или просто инструмента-
ми}, их общее количество в данной программе составляет 45 (в CorelDRAW 11
их было 43).

^ Примечание Д

CorelDRAW 12 содержит много других инструментов, находящихся на специ-
ально предназначенных для них панелях, которые называются панелями инст-
рументов. В отличие от рабочих инструментов, они выполняют более узкие
функции.

На рис. 2.5 изображены все рабочие инструменты, входящие в состав блока ин-
струментов CorelDRAW 12. Здесь основная панель блока находится слева, а до-
полнительные — справа.

Основная панель блока инструментов постоянно присутствует на экране (если,
конечно, установлен режим отображения блока), а дополнительные панели от-
крываются только при переносе из них инструментов на основную панель. Та-
кой перенос необходим потому, что для работы в программе можно применять
лишь четырнадцать инструментов, находящихся на основной панели.
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Рис. 2.5. Блок инструментов программы

В том случае, если в некоторой ячейке данной панели расположено несколько
инструментов (фактически они размешаются на соответствующей дополнитель-
ной панели), то в ее правом нижнем углу находится небольшая черная метка.
Если установить указатель на такой метке и выполнить щелчок кнопкой мыши
или установить указатель в любом месте ячейки, нажать на кнопку мыши и
удерживать ее в нажатом состоянии некоторое время, то на экране отобразится
дополнительная панель с инструментами, которые относятся к данной ячейке.
Чтобы перенести выбранный инструмент на основную панель, требуется помес-
тить на нем указатель и щелкнуть кнопкой мыши. В результате указанный ин-
струмент займет место в ячейке основной панели блока инструментов, и его
кнопка будет находиться в активном состоянии, при этом дополнительная па-
нель закроется.

При работе с дополнительными панелями блока инструментов в CorelDRAW 12
следует учитывать и такую особенность: в том случае, если какая-либо из этих
панелей уже открыта и при этом указатель перемещается из текущей ячейки
основной панели блока в другую ячейку, имеющую черную метку, то открыва-
ется дополнительная панель, которая относится к данной ячейке, а предыдущая
панель закрывается.

Рассмотрим рабочие инструменты CorelDRAW 12 в порядке их размещения
в блоке инструментов программы (с отсчетом сверху вниз для основной панели
блока и слева направо для дополнительных панелей), указав при этом изобра-
жения кнопок инструментов и быстрые клавиши.
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Рабочий инструмент Pick (Выбор) находится в первой ячейке блока инст-
рументов. Быстрая клавиша отсутствует. Этот инструмент предназначен для вы-
полнения следующих четырех операций:

П выделение одного или нескольких объектен;

О перемещение по области документа выбранного объекта с возможным его
копированием;

О трансформация объекта (масштабирование, поворот и наклон);

П выделение составной части группового объекта.

Для выделения группы объектов следует выполнить на них последовательные
щелчки (при нажатой клавише <Shift>) или создать (при нажатой кнопке мы-
ши) прямоугольную выделяющую область, полностью охватывающую эти объек-
ты. Перемещение объекта производится при нажатой левой кнопке мыши (если
перед отпуском данной кнопки щелкнуть правой кнопкой мыши, то этот объект
будет скопирован). Трансформация объекта выполняется с помощью выделяю-
щих маркеров. Для выделения некоторой части группового объекта следует на-
жать клавишу <Ctrl> и щелкнуть на данной части объекта.

Рабочий инструмент Shape (Форма) расположен во второй ячейке блока
инструментов. Быстрая клавиша — <FlO>. Инструмент выполняет три функции:

П обработка векторных контуров Безье с помощью узелков и контрольных точек
(чтобы обработать этим инструментом контур стандартной геометрической
фигуры, его необходимо предварительно преобразовать в кривую Безье коман-
дой Arrange > Convert To Curves (Расположить > Преобразовать в кривые));

О выделение в блоке текста любых текстовых символов для их форматирования;

П регулировка геометрических параметров стандартных геометрических фигур
с помощью управляющих узелков и маркеров.

Рабочий инструмент Knife (Нож) находится во второй ячейке блока инстру-
ментов. Быстрая клавиша отсутствует. Инструмент используется для выполне-
ния трех функций относительно векторных объектов:

О разрывает контур объекта в месте воздействия на него;

О разбивает объект с замкнутым контуром на части по произвольной линии,
которую создает пользователь;

П изменяет форму объекта с произвольным контуром (замкнутым или разомк-
нутым).

Инструмент Knife позволяет также разделить растровое изображение на части по
произвольной линии разреза.

Рабочий инструмент Eraser (Ластик) расположен во второй ячейке блока
инструментов. Быстрая клавиша — <Х>. Инструмент позволяет сделать полно-
стью прозрачной ту область выделенного объекта векторного или растрового
типа, на которую он воздействует. В том случае, если данная область полностью
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отделяет друг от друга некоторые части обрабатываемого объекта, преобразовать
эти части в отдельные объекты можно с помощью команды Arrange > Break
Apart (Расположить > Разъединить).

Рабочий инструмент Smudge Brush (Мажущая кисть) находится во второй
ячейке блока инструментов. Быстрая клавиша отсутствует. С помощью данного
инструмента можно изменять форму векторного объекта, имеющего конур Безье,
путем воздействия им на этот контур (с той или иной стороны) при нажатой кнопке
мыши. Область воздействия инструмента имеет эллиптическую форму, парамет-
ры которой регулируются.

] Рабочий инструмент Roughen Brush (Разрыхляющая кисть) расположен во
второй ячейке блока инструментов. Быстрая клавиша отсутствует. Инструмент
позволяет сформировать зубцы в контуре Безье векторного объекта путем переме-
щения вдоль выбранного участка этого контура. Параметры зубцов регулируются.

Рабочий инструмент Free Transform (Произвольная трансформация) нахо-
дится во второй ячейке блока инструментов. Быстрая клавиша — <F5>. Данный
инструмент предназначен для выполнения в интерактивном режиме операций
трансформации выделенного объекта: поворот, зеркальный разворот, масштаби-
рование и наклон, Тип трансформации указывается на панели свойств, а резуль-
тат обработки определяется положением инструмента (указателя мыши) относи-
тельно объекта, который зафиксирован в момент нажатия кнопки мыши,
а также манипуляцией им после нажатия кнопки.

Новый рабочий инструмент Virtual Segment Delete (Удаление виртуального
сегмента), расположен во второй ячейке блока инструментов. Быстрая клавиша
отсутствует. Позволяет выполнить обработку контуров векторных объектов, на-
ложенных друг на друга, путем удаления тех их видимых частей, на которых
производятся щелчки мышью. Удаляемый участок контура, выбираемый указа-
телем в момент выполнения щелчка мышью, ограничивается ближайшими
к указателю точками пересечения данного контура с другими контурами пере-
крывающихся объектов документа.

Рабочий инструмент Zoom (Масштаб) находится в третьей ячейке блока
инструментов. Быстрая клавиша — <Z>. Инструмент регулирует масштаб ото-
бражения документа в рабочем окне. Щелчок левой кнопкой мыши увеличивает
масштаб в два раза, а щелчок правой кнопкой (или левой при нажатой клавише
<Shift>) приводит к уменьшению масштаба в два раза. Выделение прямоуголь-
ной области документа (при нажатой кнопке мыши) полностью отображает
данную область на экране при максимально возможных ее размерах.

Рабочий инструмент Hand (Рука) расположен в третьей ячейке блока инст-
рументов. Быстрая клавиша — <Н>, Инструмент позволяет переместить доку-
мент (при нажатой кнопке мыши) в его рабочем окне. Дублирует работу полос
прокрутки окна документа.
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Рабочий инструмент Freehand (Рисование от руки) находится в четвертой
ячейке блока инструментов. Быстрая клавиша отсутствует. Инструмент предна-
значен для рисования произвольной линии, которая является контуром Безье.
Линия создается путем перемещения указателя по области документа при нажа-
той кнопке мыши.

Рабочий инструмент Bezier (Безье) расположен в четвертой ячейке блока
инструментов. Быстрая клавиша отсутствует. Этот инструмент используется для
формирования контура Безье, форма которого определяется с помошью щелч-
ков в местах размещения его узелков с последующей регулировкой мышью (при
нажатой ее кнопке) контрольных точек, которые относятся к данному узелку.

Рабочий инструмент Artistic Media (Комплект художника) находится в четвер-
той ячейке блока инструментов. Быстрая клавиша — <1>. Данный инструмент
включает, в свою очередь, набор из пяти дополнительных инструментов, выбрать
которые можно на панели свойств: Preset (Фигурная кисть) — предназначен для
создания фигурной линии заданного профиля; Brush (Художественная кисть) -
позволяет накладывать векторное изображение на выделенный контурный объект;
Sprayer (Распылитель) — выполняет распределение заданного набора изображе-
ний вдоль контурной линии; Calligraphic (Каллиграфическое перо) — использует-
ся для рисования фигурной линии, толщина которой зависит от угла ее наклона
к горизонтальной оси; Pressure (Перо с нажимом) — позволяет рисовать фигур-
ную линию, толщина которой регулируется с помощью клавиш-стрелок, чем ими-
тируется рисование линии пером, чувствительным к его нажиму.

Рабочий инструмент Реп (Перо) расположен в четвертой ячейке блока ин-
струментов. Быстрая клавиша отсутствует. Инструмент используется для фор-
мирования контура Безье с помощью узелков и контрольных точек. Отличается
от рабочего инструмента Bezier (Безье) двумя свойствами:

О возможностью отображения на экране формируемого сегмента контура;

П набором инструментов на панели свойств, который почти совпадает с набо-
ром для рабочего инструмента Freehand (Рисование от руки).

Рабочий инструмент Polyline (Ломаная линия) находится в четвертой ячейке
блока инструментов. Быстрая клавиша отсутствует. Инструмент позволяет рисо-
вать комбинированную линию, состоящую из прямолинейных и криволинейных
участков. Прямолинейные участки формируются последовательными щелчками
мыши, а криволинейные — перемещением указателя при нажатой кнопке мыши.

Рабочий инструмент 3 Point Curve (Кривая по трем точкам) расположен
в четвертой ячейке блока инструментов. Быстрая клавиша отсутствует. Данный
инструмент предназначен для рисования гладкой кривой по трем точкам. Концы
этой кривой формируются при нажатой кнопке мыши и определяются положе-
нием указателя в моменты нажатия и отпускания кнопки мыши. Третья (про-
межуточная) точка кривой задается щелчком мыши после требуемого переме-
щения указателя.
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Рабочий инструмент Interactive Connector (Интерактивный соединитель)
находится в четвертой ячейке блока инструментов. Быстрая клавиша отсутству-
ет. Инструмент включает, в свою очередь, набор из двух инструментов создания
соединительных линий, выбрать которые можно на панели свойств: Angled
connector (Угловой соединитель) и Straight connector (Прямой соединитель).
Первый из этих инструментов позволяет создать соединительные линии, со-
стоящие из линейных отрезков, параллельных осям координат, параметры кото-
рых регулируются в интерактивном режиме. Применяется для рисования раз-
личных блок-схем. Отличие второго инструмента от первого состоит в том, что
он предназначен для создания соединительных линий, каждая из которых явля-
ется отрезком прямой линии, соединяющим узелки (базовые точки) двух вы-
бранных объектов.

Рабочий инструмент Dimension (Размер) расположен в четвертой ячейке
блока инструментов. Быстрая клавиша отсутствует. Инструмент используется
для рисования размерных линий различных типов с автоматическим вычисле-
нием и отображением соответствующих размеров (в масштабе заданной едини-
цы измерения), которые относятся к выбранным точкам объекта. Кроме того,
позволяет также рисовать линии сносок.

Рабочий инструмент Rectangle (Прямоугольник) находится в пятой ячейке
блока инструментов. Быстрая клавиша — <F6>. Данный инструмент позволяет
формировать (при нажатой кнопке мыши) геометрические фигуры в виде пря-
моугольников, в которых допускается скруглять углы. Если в процессе создания
фигуры удерживать нажатой клавишу <Shift>, то она будет сформирована от
центра. При нажатии клавиши <Ctrl> будет образована правильная фигура
(в данном случае — квадрат).

Рабочий инструмент 3 Point Rectangle (Прямоугольник по трем точкам)
расположен в пятой ячейке блока инструментов. Быстрая клавиша отсутствует.
Отличается от инструмента Rectangle тем, что фигура прямоугольника формиру-
ется по трем точкам, Исходная сторона фигуры задается путем перемещения
указателя при нажатой кнопке мыши, а перпендикулярная ей сторона — после-
дующим щелчком мыши после перемещения указателя при отжатой данной
кнопке.

Рабочий инструмент Ellipse (Эллипс) находится в шестой ячейке блока ин-
струментов. Быстрая клавиша — <F7>. Инструмент предназначен для формиро-
вания фигур в виде эллипсов, секторов и дуг. Работает по аналогии с инстру-
ментом Rectangle.

Рабочий инструмент 3 Point Ellipse (Эллипс по трем точкам) расположен
в шестой ячейке блока инструментов. Быстрая клавиша отсутствует. Отличается
от инструмента Ellipse тем, что формирует фигуру эллипса (сектора или дуги) по
трем точкам. Исходная ось эллипса задается путем перемещения указателя при
нажатой кнопке мыши, а сама фигура образуется последующим щелчком мыши
после перемещения указателя при отжатой данной кнопке.
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Рабочий инструмент Polygon (Многоугольник) находится в седьмой ячейке
блока инструментов. Быстрая клавиша —- <Y>. Инструмент позволяет формиро-
вать фигуры в виде выпуклых и звездчатых многоугольников. Работает по ана-
логии с инструментом Rectangle.

Рабочий инструмент Graph Paper (Сотовая структура) расположен в седьмой
ячейке блока инструментов. Быстрая клавиша — <D>. Данный инструмент пред-
назначен для формирования фигур, которые яшшются наборами прямоугольных
ячеек. Работает по аналогии с инструментом Rectangle (Прямоугольник).

Рабочий инструмент Spiral (Спираль)' находится в седьмой ячейке блока
инструментов. Быстрая клавиша — <А>. Инструмент используется для форми-
рования фигур в форме спиралей (симметричных и логарифмических). Работает
по аналогии с инструментом Rectangle.

Рабочий инструмент Basic Shapes (Базовые формы) расположен в восьмой
ячейке блока инструментов. Быстрая клавиша отсутствует. Инструмент позволя-
ет формировать автофигуры, которые относятся к категории базовых форм.
Каждая такая автофигура представлена в виде геометрической фигуры, форма
которой выбирается на панели свойств, а геометрические параметры регулируются
с помощью управляющих и выделяющих маркеров в интерактивном режиме.

Рабочий инструмент Arrow Shapes (Формы стрелок) находится в восьмой
ячейке блока инструментов. Быстрая клавиша отсутствует. Отличие от инстру-
мента Basic Shapes состоит в том, что можно формировать автофигуры в виде
стрелок.

Рабочий инструмент Flowchart Shapes (Формы блок-схем) расположен
в восьмой ячейке блока инструментов. Быстрая клавиша отсутствует. Отличие
от инструмента Basic Shapes состоит в том, что инструмент предназначен для
формирования автофигур в виде элементов блок-схем.

Рабочий инструмент Star Shapes (Формы звезд) находится в восьмой ячейке
блока инструментов. Быстрая клавиша отсутствует. Отличие от инструмента
Basic Shapes заключается в том, что автофигуры создаются в форме звезд.

Рабочий инструмент Calicut Shapes (Формы выносок) расположен в вось-
мой ячейке блока инструментов. Быстрая клавиша отсутствует. Отличие от ин-
струмента Basic Shapes состоит в том, что позволяет формировать автофигуры
в виде выносок к иллюстрациям.

Рабочий инструмент Text (Текст) находится в девятой сверху ячейке блока
инструментов. Быстрая клавиша — <F8>. Инструмент предназначен для ввода и
обработки текстовой информации, которая представлена в форме обычного или
художественного текста.

Рабочий инструмент Interactive Blend (Интерактивный переход) расположен
сятой ячейке блока инструментов. Быстрая клавиша отсутствует. Данный
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инструмент используется для формирования эффекта перехода применительно
к двум векторным объектам (при этом выделение объектов не требуется), из
которых создается комбинированный объект (см. разд. "Создание эффектов" гл. 4,
подразд. "Переход") Параметры эффекта можно задать с помощью интерактивной
управляющей конструкции инструмента и панели свойств.

Рабочий инструмент Interactive Contour (Интерактивный контур) находится
в десятой ячейке блока инструментов. Быстрая клавиша отсутствует. Инстру-
мент позволяет формировать в векторном объекте эффект контура (см. разд.
"Создание эффектов" гл. 4, подразд. "Контур"). Параметры эффекта задаются так
же, как и для инструмента Interactive Blend.

Рабочий инструмент Interactive Distortion (Интерактивное искажение) рас-
положен в десятой ячейке блока инструментов. Быстрая клавиша отсутствует.
Инструмент предназначен для формирования в векторном объекте эффекта ис-
кажения (см. разд. "Создание эффектов" гл.4, подразд. "Искажение"). Параметры
эффекта задаются так же, как и для инструмента Interactive Blend.

Рабочий инструмент Interactive Envelope (Интерактивная оболочка) нахо-
дится в десятой ячейке блока инструментов. Быстрая клавиша отсутствует. Ин-
струмент используется для создания в векторном объекте эффекта оболочки
(см. разд. "Создание эффектов" гл. 4, подразд. "Оболочка"). Параметры эффекта за-
даются так же, как и для инструмента Interactive Blend.

Рабочий инструмент Interactive Extrude (Интерактивное выдавливание) рас-
положен в десятой ячейке блока инструментов. Быстрая клавиша отсутствует.
Инструмент позволяет формировать в векторном объекте эффект выдавливания
(см. разд. "Создание эффектов" гл. 4> подразд. "Выдавливание"). Параметры эффекта
задаются так же, как и для инструмента Interactive Blend.

Рабочий инструмент Interactive Drop Shadow (Интерактивная тень от объек-
та) находится в десятой ячейке блока инструментов. Быстрая клавиша отсутст-
вует. Данный инструмент предназначен для формирования в векторном объекте
эффекта тени от объекта (см. разд. "Создание эффектов" гл. 4, подразд. "Тень"). Па-
раметры эффекта задаются так же, как и для инструмента Interactive Blend.

Рабочий инструмент Interactive Transparency (Интерактивная прозрачность)
расположен в десятой ячейке блока инструментов. Быстрая клавиша отсутствует.
Инструмент позволяет регулировать уровень прозрачности объекта (произволь-
ного типа) по одному из следующих законов: равномерному, градиентному, с ис-
пользованием шаблона или текстуры. Режим регулировки прозрачности объекта
подключается на панели свойств, а выбор параметров прозрачности производится
с помощью интерактивной управляющей конструкции инструмента и данной па-
нели. Элементы управления данной конструкции предназначены для регулировки
градиентного рисунка, формы шаблона или мозаичного элемента текстуры, по
которым будет изменяться уровень прозрачности объекта. Параметры прозрачно-
сти задаются гак же, как и для инструмента Interactive Blend.
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Рабочий инструмент Eyedropper (Пипетка) находится в одиннадцатой ячей-
ке блока инструментов, Быстрая клавиша отсутствует. Инструмент предназначен
для считывания из объекта документа, выбираемого щелчком мыши, опреде-
ленного набора его параметров и атрибутов с целью последующей передачи их
другим объектам документа с помощью инструмента Paintbucket.

Рабочий инструмент Paintbucket (Ведро с краской) расположен в одинна-
дцатой ячейке блока инструментов. Быстрая клавиша отсутствует. Инструмент
используется для передачи параметров и атрибутов, считанных инструментом
Eyedropper из некоторого объекта документа, другим объектам, выбираемым
с помощью щелчков мыши.

Рабочий инструмент Outline (Контур) находится в двенадцатой ячейке бло-
ка инструментов. Быстрая клавиша отсутствует. С помощью этого инструмента
можно выполнять операции обводки выделенного векторного объекта, парамет-
ры которой устанавливаются с помощью управляющих кнопок, размещенных на
дополнительной панели блока инструментов, имеющей следующий вид:

Для открытия диалоговых окон Outline Pen (Контурное перо) и Outline Color
(Цвет обводки) с параметрами настройки линии обводки объекта используются
две левые кнопки, для открытия докера Color (Цвет) с целью выбора в нем цве-
та линии обводки предназначена правая кнопка. Остальные восемь кнопок за-
дают толщину этой линии, которая указывается Б изображении выбранной
кнопки и в ее контекстной подсказке.

Рабочий инструмент Fill (Заливка) расположен в тринадцатой ячейке блока
инструментов. Быстрая клавиша отсутствует. Инструмент выполняет заливку
любого типа (равномерную, градиентную, шаблоном, текстурой или узором
PostScript) выбранного векторного объекта. Выбрать тип заливки и настроить ее
параметры можно в пяти диалоговых окнах; Uniform Fill (Равномерная заливка),
Fountain Fill (Градиентная заливка), Pattern Fill (Заливка шаблоном), Texture Fill
(Заливка текстурой) и PostScript Texture (Текстура PostScript) и в одном доке-
ре — Color (Цвет). Эти окна открываются с помощью управляющих кнопок,
расположенных в дополнительной панели блока инструментов, имеющей сле-
дующий вид:

Рабочий инструмент Interactive Fill (Интерактивная заливка) находится
в четырнадцатой ячейке блока инструментов. Быстрая клавиша-— <G>. Инст-
румент выполняет заливку любого типа векторного объекта. Выбор типа заливки
производится на панели свойств, а регулировка ее параметров выполняется
с помощью интерактивной управляющей конструкции инструмента и данной
панели. Управляющая конструкция инструмента предназначена для настройки
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параметров градиентной заливки, а также для регулировки формы применяе-
мого шаблона или мозаичного элемента текстуры.

Рабочий инструмент Interactive Mesh Fill (Интерактивная заливка по сетке)
расположен в четырнадцатой ячейке блока инструментов. Быстрая клавиша —
<М>. Данный инструмент позволяет выполнить в интерактивном режиме гради-
ентную заливку внутренней области векторного объекта, параметры которой
выбираются с помощью регулируемой сетки типа Безье, накладываемой на объ-
ект, и рабочей цветовой палитры. Цветовые оттенки области заливки объекта
определяются положением узелков сетки и цветами раскраски мест их размеще-
ния. Для формирования сетки Безье следует выбрать инструмент и выполнить
щелчок в области выбранного объекта. Число ячеек в ряду и колонке сетки за-
дается на панели свойств.

Новый рабочий инструмент Smart Drawing (Умное рисование) расположен
в пятнадцатой ячейке блока инструментов. Быстрая клавиша — <S>. Предна-
значен для создания геометрических фигур (в том числе и автофигур, содержа-
щих управляющие маркеры) путем автоматического преобразования в них ис-
ходных фигур, нарисованных от руки.

В состав блока инструментов CorelDRAW 12 входит целая группа так называе-
мых интерактивных инструментов. Их отличительной особенностью является
наличие управляющей конструкции, которая размещается непосредственно на
обрабатываемом объекте или рядом с ним. Элементы управления такой конст-
рукции (маркеры и ползунки) позволяют вам настраивать параметры инстру-
мента, не отвлекая своего взгляда от объекта обработки и наблюдая результат
регулировки в интерактивном режиме.

Перечислим интерактивные инструменты программы, число которых равно де-

сяти: .-тэд Interactive Connector (Интерактивный соединитель), Interactive

Blend (Интерактивный переход),

Interactive Distortion (Интерактивноетур),

Interactive Contour (Интерактивный кон-

искажение), Interactive

Envelope (Интерактивная оболочка), \&] Interactive Extrude (Интерактивное вы-

давливание), Interactive Drop Shadow (Интерактивная тень от объекта),

Interactive FillInteractive Transparency (Интерактивная прозрачность),

Interactive Mesh Fill (Интерактивная заливка по(Интерактивная заливка) и
сетке).

Прежде чем использовать тот или иной рабочий инструмент CorelDRAW 12,
необходимо настроить его параметры, которые делятся на две группы: стацио-
нарные и текущие. Первая группа включает параметры, определяющие общие
режимы работы инструмента (они остаются неизменными в течение длитель-
ного периода), а также исходные параметры инструментов, заданные по умол-
чанию. Во вторую группу входят параметры, которые регулируются в оператив-
ном режиме на панели свойств.
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Стационарные параметры рабочих инструментов располагаются на соответст-
вующих вкладках диалогового окна Options (Параметры) с параметрами на-
стройки программы (см. разд. "Параметры интерфейса"гл. 8).

[̂  Примечание

Для большинства (но не для всех) рабочих инструментов вкладку окна Options,
содержащего стационарные параметры выбранного инструмента, можно от-
крыть, выполнив двойной щелчок на кнопке данного инструмента.

Выбор текущих параметров рабочего инструмента обычно производится на па-
нели свойств. Эти параметры настраиваются перед началом операции с исполь-
зованием выбранного инструмента или в процессе ее выполнения.

Панели инструментов
В CorelDRAW 12 представлены не только рабочие инструменты, входящие
в состав описанного выше блока, но и многие другие инструменты, располагае-
мые на различных панелях инструментов. Стандартная панель инструментов
и панель свойств являются основными. Они обычно представлены в стационар-
ной форме и всегда присутствуют на экране (см. рис. 2.2). С помощью стан-
дартной панели можно выполнять общие операции по работе с документами,
а с помощью панели свойств (она является перестраиваемой) — настраивать
параметры рабочих инструментов, применяемые в процессе обработки объектов.

Стандартная панель
Стандартная панель инструментов выполняет наиболее распространенные опе-
рации с документами (создание, открытие, сохранение, печать и др.). Большин-
ство элементов управления панели дублирует команды основного меню про-
граммы. Однако есть и такие элементы, для которых отсутствуют аналогичные
команды. На рис. 2.6 изображен вид стандартной панели на экране.

13 14

Рис. 2.6. Стандартная панель инструментов

Поясним назначение элементов управления этой панели (их номера, приведен-
ные на рисунке, даны здесь в квадратных скобках):

П [1] — кнопка New (Новый), предназначенная для формирования нового до-
кумента (дублирует действие одноименной команды меню File (Файл));

П [2] — кнопка Орел (Открыть), используемая для открытия документов, хра-
нящихся в выбранных файлах, или формирования нового документа на базе
заданного шаблона (дублирует действие одноименной команды меню File);
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О [3] — кнопка Save (Сохранить), позволяющая сохранить активный документ
в своем файле с прежними параметрами сохранения (дублирует действие од-
ноименной команды меню File);

П [4] — кнопка Print (Печать), применяемая для перехода в режим вывода до-
кумента на печать (дублирует действие одноименной команды меню File);

П [5] — кнопка Cut (Вырезать), с помошью которой можно удалить из доку-
мента выбранные объекты (выделенную текстовую информацию) и одновре-
менно поместить их в буфер обмена Windows (дублирует действия одноимен-
ной команды меню Edit (Правка));

П [6] — кнопка Сору (Копировать), используемая для копирования в буфер
обмена выделенных объектов или текстовой информации (дублирует дейст-
вия одноименной команды меню Edit);

П [7] — кнопка Paste (Вставить), применяемая для вставки в активный доку-
мент информации, которая размешена в буфере обмена (дублирует действие
одноименной команды меню Edit);

О [8] — кнопка Undo (Отменить) с раскрывающимся списком выполненных
операций, которые можно отменить. Отмена последней операции произво-
дится при щелчке на кнопке со значком изогнутой влево стрелки, которая
дублирует действие одноименной команды меню Edit. Щелкнув на значке
черного треугольника, справа от кнопки, вы откроете список выполненных
операций, которые размещаются в обратном порядке по отношению к по-
рядку их выполнения. Чтобы отменить как данную операцию, так и все по-
следующие, находящиеся в списке выше, необходимо установить в списке
указатель на названии выбранной операции и выполнить щелчок;

О [9] — кнопка Redo (Вернуть) с раскрывающимся списком отмененных ранее
операций, которые могут быть повторно выполнены. Повторное выполнение
последней отмененной операции возможно при щелчке на кнопке со значком
изогнутой вправо стрелки, которая дублирует действие одноименной команды
меню Edit. Открыть список отмененных операций можно щелчком на значке
черного треугольника справа от нее. Чтобы повторно выполнить как данную
операцию, так и все те, которые были отменены после нее, необходимо уста-
новить указатель на названии выбранной операции и выполнить щелчок;

П [10] — кнопка Import (Импорт), предназначенная для импорта в документ
информации (графической или текстовой), хранящейся в выбранных файлах
(дублирует действие одноименной команды меню File (Файл));

П [11] —- кнопка Export (Экспорт), используемая для выполнения операции
экспорта, состоящей в сохранении выбранных (всех) объектов документа или
текстовой информации в отдельном файле (дублирует действие одноименной
команды меню File);

П [12] — раскрывающийся список Zoom Levels (Уровни масштабирования), по-
зволяющий выбрать масштаб отображения активного документа в его рабо-
чем окне. Содержит такие пункты:

• То Selected — выделенные объекты заполняют рабочее окно документа
полностью;
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• То Fit — то же по отношению ко всем объектам, находящимся на текущей
странице документа и в компоновочной зоне;

• То Page — полностью отображается открытая страница документа, кото-
рая размещается в центре окна и окружена со всех сторон компоновочной
зоной (представляет собой стандартный режим отображения документа,
которому соответствует масштаб 100 %);

• То Width — текущая страница документа открыта во всю ширину;

• То Height — текущая страница открыта во всю высоту;

• численные значения со знаком процента — значения масштаба, которые
указываются в процентах по отношению к масштабу для стандартного ре-
жима отображения документа в рабочем окне;

П [13] — кнопка Application Launcher (Запуск приложения), открывающая до-
полнительную панель со списком программ, входящих в состав графического
пакета CorelDRAW Graphic Suite 12, которые могут быть запущены в работу;

О [14] — кнопка Corel Online (Corel в сети), открывающая докер Web Connector
(Соединитель с Web), с помощью которого можно получить через Web раз-
личную информацию, относящуюся к программе CorelDRAW 12 (в том числе
обзорную справочную информацию, файлы обновления, сценарии и шабло-
ны). Дублирует действие команды Web Connector подменю Dockers (Докеры)
меню Window (Окно).

Панель свойств
Панель свойств отличается от других панелей инструментов CorelDRAW 12 тем,
что трансформируется в зависимости от выбранного рабочего инструмента,
а также от тех действий, которые выполняет пользователь в процессе обработки
документа. Другими словами, состав панели и ее вид зависят от того, какой ра-
бочий инструмент применяется в настоящее время и какая операция выполня-
ется с его помощью (на панели свойств расположены параметры настройки ак-
тивного рабочего инструмента).

В CorelDRAW 12 текущие параметры рабочих инструментов задаются на панели
свойств. Здесь могут находиться такие типы элементов упраштения (см. рис. 2.2):
кнопки управления; линейные регуляторы или ползунки; поля (со счетчиками
или без них), предназначенные для ввода числовых и символьных данных; рас-
крывающиеся списки; раскрывающиеся панели с дополнительными элементами
управления.

Примечание

Ввод с клавиатуры данных в редактируемые поля панели свойств характеризу-
ется одной особенностью, которая состоит в необходимости завершать данную
операцию нажатием клавиши <Enter>. Только при таком условии новые данные
вступят в силу.
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Поскольку панель свойств обычно отображается на экране в стационарной
форме, то она состоит только из одного ряда инструментов. В том случае, если
таких инструментов много, некоторые из них, находящиеся справа, при низком
разрешении экрана монитора (800x600 точек и ниже) могут оказаться за преде-
лами экрана и стать недоступными для использования. Чтобы решить эту про-
блему, можно воспользоваться двумя способами:

П настроить параметры монитора, указав более высокое его разрешение.
Если оно не может быть выше установленного, то следует задать более мел-
кий экранный шрифт;

О перевести панель из стационарной формы в плавающую. Для этого требуется
поместить указатель на свободное место панели, нажать кнопку мыши и пе-
ретащить панель на новое место, не подводя при этом к краям рабочей
области интерфейса программы. Вследствие этого те инструменты панели,
которые не отображались на экране, разместятся во втором ее ряду и станут
доступными дня работы.

Дополнительные панели
Кроме описанных выше двух основных панелей инструментов (стандартной и
свойств), в CorelDRAW 12 представлено также восемь дополнительных панелей.
К их числу относятся: Text (Текст), Zoom (Масштаб), Internet (Интернет), Print
Merge (Слияние при печати), Transform (Трансформация), Visual Basic for
Applications (Visual Basic для приложений), Scrapbook (Записная книжка)
и Transformations (Трансформации). Функции этих панелей соответствуют их
названиям.

Кроме этих панелей инструментов, входящих в состав установочного комплекта
программы, вы можете также формировать свои собственные панели, имеющие
произвольную компоновку (см. разд. "Параметры интерфейса" гл. 8).

В отношении панелей Text, Zoom и Transform следует заметить, что многие их
инструменты дублируются инструментами панели свойств при выполнении со-
ответствующих операций, Тем не менее, с помощью указанных панелей можно
значительно облегчить работу в программе. Объясняется это тем, что данные
панели, в отличие от панели свойств, вы можете расширять, добавляя к ним
другие инструменты, которые не входят в их стандартный состав и отсутствуют
на панели свойств.

Дополнительные панели являются плавающими. Это означает, что они имеют
заголовки, и их можно перемещать по рабочей области интерфейса программы.
Вместе с тем, каждую из них можно сделать стационарной путем состыковки ее
с одной из панелей, которые постоянно присутствуют на экране, блоком инст-
рументов или цветовой палитрой.

Чтобы открыть любую панель, выполните три действия.

1. Поместите указатель в свободное место одной из панелей или блока инстру-
ментов, которые расположены на экране.
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2. Откройте контекстное меню со списком всех панелей инструментов с помо-
щью правой кнопки мыши.

3. Выполните щелчок левой кнопкой мыши на выбранной панели. Вследствие
этого откроется соответствующая панель, а слева от ее названия появится га-
лочка.

Для удаления панели с экрана необходимо выполнить аналогичные действия.
Чтобы закрыть плавающую панель, нужно щелкнуть на кнопке закрытия (с пе-
рекрестием) в правом верхнем углу панели.

Вторым способом открытия или закрытия какой-либо панели инструментов яв-
ляется выполнение команды с ее названием, входящей в подменю Toolbars (Па-
нели инструментов) меню Window (Окно).

CorelDRAW 12 обладает широкими возможностями по настройке (изменению
компоновки) панелей инструментов, управлению их открытием, а также форми-
рованию новых панелей. Переход в режим настройки панелей производится
путем выполнения команды Tools > Customization (Инструменты > Настройка).
При этом на экране отобразится диалоговое окно Options (Параметры), на
вкладках Command Bars (Командные панели) и Commands (Команды) которого
производятся различные операции по настройке панелей инструментов (см. разд.
"Параметры интерфейса"гл. 8).

Опишем состав дополнительных панелей программы.

Панель Text
Панель инструментов Text (Текст) позволяет выполнять различные операции по
форматированию текстовой информации документа, представляемой в виде
обычного или художественного текста (рис. 2.7).
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Рис. 2.7. Панель инструментов Text

Поясним назначение элементов управления этой панели (их номера, приведен-
ные на рисунке, даны здесь в квадратных скобках):

П [1] — кнопочный переключатель Default Style to Edit, используемый для за-
дания стиля обычного или художественного текста, который применяется по
умолчанию, с целью его редактирования (если в документе установлен тек-
стовый курсор, данный переключатель будет заблокирован);

Q [2] — раскрывающийся список Style List, позволяющий выбрать существую-
щий текстовый стиль;

О [3] — список Font List, в котором производится выбор текстового шрифта;

d [4] — список Font Size List, используемый для выбора кегля шрифта;
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О [5] — кнопка Bold, предназначенная для задания полужирного начертания;

П [6] — кнопка Italic, используемая для задания начертания курсивом;

О [7] — кнопка Underline, задающая начертание с подчеркиванием;

3 [8] — кнопка Horizontal Alignment, открывающая дополнительную панель
с выключками, представляющими собой режимы выравнивания текста по го-
ризонтали: None (Нет), Left (Слева), Center (По центру), Right (Справа), Full
(Полная) и Force Full (Принудительная);

П [9] — кнопка Decrease Indent, применяемая для дискретного уменьшения
отступа текста от левой границы текстовой области;

П [10] — кнопка Increase Indent, с помощью которой можно дискретно увели-
чить отступ текста от левой границы;

П [11] — кнопка Show/Hide Bullet, предназначенная для оформления текстовых
абзацев маркерами;

О [12] — кнопка Non-printing Characters, используемая для выбора режима ото-
бражения служебных (непечатаемых) символов.

Панель Zoom
Панель инструментов Zoom (Масштаб) предназначена для выполнения опера-
ций масштабирования активного документа в его рабочем окне (рис. 2.8).

Рис. 2,8. Панель инструментов Zoom

Поясним назначение элементов управления этой панели (их номера, приведен-
ные на рисунке, даны здесь в квадратных скобках):

П [1] — раскрывающийся список Zoom Levels, используемый для выбора мас-
штаба отображения активного документа в его рабочем окне:

• выделенные объекты полностью заполняют рабочее окно документа
(пункт То Selected);

• то же в отношении всех объектов, расположенных на текущей странице
документа и в компоновочной зоне (То Fit);

• полностью видна открытая страница документа, находящаяся в центре и
окруженная со всех сторон компоновочной зоной (является стандартным
режимом отображения документа, которому соответствует масштаб 100 %)
(То Page);

• данная страница документа открыта во всю ширину (То Width);

• текущая страница открыта во всю высоту (То Height);
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• значения масштаба, которые указаны в процентах по отношению к мас-
штабу для стандартного режима отображения документа в рабочем окне -
численные значения со знаком процента;

П [2] — кнопка Zoom To Selected, с помощью которой рабочее окно документа
заполняется выделенными объектами;

П [3| — кнопка Zoom To All Objects, предназначенная для заполнения данного
окна всеми объектами текущей страницы документа и компоновочной зоны;

П [4J — кнопка Zoom To Page, используемая для полного отображения текущей
страницы документа, окруженной со всех сторон компоновочной зоной;

О [5] — кнопка Zoom To Page Width, с помощью которой можно открыть дан-
ную страницу документа на всю ее ширину;

П [6] — кнопка Zoom To Page Height, предназначенная для открытия текущей
страницы на всю ее высоту;

П [7] — кнопка Zoom In, предназначенная для удвоения масштаба отображения
документа;

П [8] — кнопка Zoom Out, используемая для уменьшения масштаба в два раза.

Панель Internet
Панель инструментов Internet (Интернет) позволяет вставлять гиперссылки и
закладки в объекты документа, а также выполнять различные операции с инте-
рактивными состояниями, которые реализуются при электронной публикации
документа (рис. 2.9).
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Рис. 2.9, Панель инструментов Internet

Поясним назначение элементов управления этой панели (их номера, приведен-
ные на рисунке, даны здесь в квадратных скобках):

О [1] — кнопка Create Rollover, предназначенная для создания интерактивных
состояний для выбранного объекта документа;

О [2] — кнопка Edit Rollover, с помощью которой активизируется режим редак-
тирования интерактивных состояний;

ГЦ [3] — кнопка Extract all Objects from Rollover, используемая для извлечения
всех объектов, созданных для интерактивных состояний, а также для удале-
ния этих состояний;

CJ [4] — кнопка Finish Editing Rollovers, применяемая для отмены режима редак-
тирования интерактивных состояний;
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G [5] — кнопка Live Preview of Rollovers, используемая для подключения режи-
ма имитации эффекта интерактивности, который возникает в электронном
документе под воздействием мыши на области срабатывания;

П [6] — раскрывающийся список Active Rollover Stale, предназначенный для
выбора одного из трех имеющихся в объекте интерактивных состояний;

П [7] — кнопка Duplicates State, используемая для копирования объектов теку-
щего состояния в состояние другого типа, отличное от исходного, в котором
какие-либо объекты отсутствуют;

П [8] — кнопка Deletes Rollover State, с помощью которой можно удалить объ-
екты из текущего состояния, если оно не является состоянием типа Normal;

О [9] — список Behavior, в котором производится выбор одного из трех режи-
мов ввода управляющей информации:

• ввод гиперссылки (пункт URL);

• подключение к документу выбранного файла аудиоклипа (Sound);

• ввод закладки (Bookmark);

В [10] — кнопка Show Hotspot, подключающая режим отображения в докумен-
те областей срабатывания;

П [11] — кнопка Make Text Web compatible, выполняющая обработку выбран-
ных блоков обычного текста с целью их сохранения в виде текста, а не изо-
бражения при преобразовании исходного документа в электронный формат
HTML;

П [12] — кнопка Publish to Web - HTML, открывающая диалоговое окно
Publish To The Web (Публикация на Web) с целью настройки в нем парамет-
ров создаваемого электронного документа для Web;

П [13] -- список (с редактируемым полем) Internet Address или только
поле Internet Bookmark, предназначенные для задания гиперссылки или за-
кладки;

П [14] — список Target Frame, используемый для выбора режима отображения
в окне Web-обозревателя новой страницы электронного документа, которая
связана с его текущей страницей через гиперссылку. Здесь представлены та-
кие пункты:

• (попе) — управляющая информация отсутствует;

• _self — новая страница выводится в прежнем окне обозревателя;

• _top — текущая страница выводится в окне обозревателя одна, при этом
его разбивка на разделы отменяется;

• Jblank — связанная страница документа выводится в новом окне обозре-
вателя;

• ^parent — выполняется замещение связанной страницей той, которая на-
ходится в основном разделе окна обозревателя;
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П [15j — кнопка Alt Comments, используемая для открытия дополнительной
панели с целью ввода контекстного сообщения, которое отображается
в электронном документе рядом с указателем;

П [16] — кнопка Hotspot, с помощью которой открывается дополнительная па-
нель для задания формы и варианта оформления области срабатывания,

Панель Print Merge
Панель инструментов Print Merge (Слияние при печати) используется для вы-
полнения различных операций по слиянию при печати информации документа
с информацией, которая последовательно выбирается из таблицы данных, соз-
данной или импортированной пользователем (рис. 2.10).

2 3
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Рис. 2.10. Панель инструментов Print Merge

Поясним назначение элементов управления этой панели (их номера, приведен-
ные на рисунке, даны здесь в квадратных скобках):

О [1] _ кнопка Create/Load Print Merge Fields, открывает окно мастера Print
Merge Wizard (Мастер слияния при печати), который позволяет создавать
собственную таблицу данных или импортировать в нее информацию из фай-
ла базы данных, выбранного на диске;

П [2] — кнопка Edit Print Merge Fields, используемая для открытия того же ок-
на с текущей таблицей данных для ее редактирования;

О [3] — кнопка Perform Print Merge, с помощью которой можно открыть диа-
логовое окно Print (Печать), позволяющее настроить параметры печати и вы-
дать сигнал на распечатку документа в режиме слияния информации;

П |4] — раскрывающийся список Print merge field, используемый для выбора
полей данной таблицы данных, которые выводятся на печать;

a [5J — кнопка Insert selected print merge field, предназначенная для выбора
режима создания в документе (с помощью щелчков мыши) меток выбран-
ного поля таблицы, с целью указания мест вывода информации из таблицы
при печати в режиме слияния.

Панель Transform
Панель инструментов Transform (Трансформация) позволяет выполнять различ-
ные операции, связанные с трансформацией (изменением формы) объектов до-
кумента с помощью задания численных знамений их параметров (рис. 2.11).

.1 Зак. 250
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Рис. 2.11. Панель инструментов Transform

Поясним назначение элементов управления этой панели (их номера, приведен-
ные на рисунке, даны здесь в квадратных скобках):

О [I] — два поля Object(s) Position, используемые для выбора координат гео-
метрического центра объекта;

П [2] — два поля Object(s) Size, предназначенные для указания размеров объекта;

G [3] — два поля Scale Factor, в которых задаются коэффициенты масштабиро-
вания по горизонтали и вертикали;

П [4] — кнопка Nonproportional Scaling/Sizing Ratio, с помощью которой можно
выбрать режим непропорционального масштабирования;

П [5] — две кнопки Mirror Buttons, используемые для выполнения зеркального
разворота объекта по горизонтали и вертикали;

П [6] — поле Angle of Rotation, в котором задается угол поворота объекта;

О [7] — два поля Center of Rotation Position, предназначенные для выбора ко-
ординат центра вращения объекта;

П [8] — два поля Skew Angle, используемые для задания углов наклона сторон
прямоугольной выделяющей рамки объекта;

G [9] — кнопка Apply To Duplicate, с помощью которой можно задать режим
создания копии объекта с выбранными параметрами трансформации;

О [10] — кнопка Relative to Object, предназначенная для выбора координат
объекта и центра его вращения в относительных единицах, то есть относи-
тельно его исходного положения.

Панель Visual Basic for Applications
Панель инструментов Visual Basic for Applications (Visual Basic для приложений)
изображена на рис. 2.12. Она предназначена для работы с программой Microsoft
Visual Basic 6.3, которая позволяет автоматизировать обработку документов
в различных приложениях (в данном случае — в CorelDRAW 12) путем форми-
рования и воспроизведения макрокоманд (macros).

Примечание

В тех случаях, когда требуется подчеркнуть, что макрокоманда сформирована
или формируется с помощью программы Microsoft Visual Basic, будем ее обо-
значать аббревиатурой VBA.
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Рис. 2.12. Панель инструментов Visual Basic for Applications

Поясним назначение элементов управления этой панели (их номера, приведен-
ные на рисунке, даны здесь в квадратных скобках):

О [I] — кнопка Run a VBA Macro, предназначенная для открытия диалогового
окна с целью выбора в нем существующей макрокоманды VBA для ее после-
дующего воспроизведения;

О [2] -• кнопка VBA Editor, используемая для открытия окна программы
Microsoft Visual Basic 6.3 для написания в нем новой макрокомавды или ре-
дактирования существующей;

П [3] — кнопка VBA Design/Run, применяемая для выбора режима конструиро-
вания макрокоманд, которая блокирует воспроизведение макрокоманды VBA
в процессе ее написания или отладки;

П [41 — кнопка Records VBA Macro, с помощью которой можно записывать
макрокоманды в процессе обработки объектов документа;

О [5] — кнопка Pauses VBA Macro Recording, предназначенная для приостанов-
ки записи текущей макрокоманды с целью выполнения операций, которые
в нее входить не будут;

О [6] — кнопка Stops VBA Macro Recording, используемая для остановки записи
макрокоманды.

Панель Scrapbook
Новая панель инструментов Scrapbook (Записная книжка) используется для от-
крытия одноименного докера на одной из его трех вкладок, определяющих раз
личные режимы работы в нем (рис. 2.13),

1 2 3

Рис. 2.13. Панель инструментов Scrapbook

Поясним назначение кнопок управления этой панели (их номера, приведенные
на рисунке, даны здесь в квадратных скобках):

О [1] — кнопка Browse Scrapbook Tab, открывающая докер Scrapbook на вклад-
ке Browse (Просмотр), на которой производится просмотр содержимого



Q8 Глава 2

библиотек клипов (образцов векторной и растровой графики), хранящихся
на компакт-дисках установочного комплекта CorelDRAW 12, с целью выбора
клипов для их загрузки в активный документ;

П [2] — кнопка Contents on the Web Scrapbook Tab, открывающая данный докер
на вкладке Contents on the Web (Содержимое на Web), на которой произво-
дится выход в Интернет с целью поиска там необходимых файлов;

П [31 — кнопка Search Scrapbook Tab, открывающая докер Scrapbook на вклад-
ке Search (Поиск) с целью поиска по заданным ключевым словам требуемых
клипов в библиотеках, хранящихся на компакт-дисках CorelDRAW 12.

Панель Transformations
Новая панель инструментов Transformations (Трансформации) позволяет от-
крыть докер Transformation (Трансформация) на одной из его пяти вкладок, оп-
ределяющих различные режимы трансформации объектов документа (рис. 2.12).

2 3 4 5

Transformations E

Рис. 2.14. Панель инструментов Transformations

Поясним назначение кнопок управления этой панели (их номера, приведенные
на рисунке, даны здесь в квадратных скобках):

О [1] — кнопка Position, открывающая докер Transformation на вкладке Position
(Положение) для выполнения операции перемещения выделенного объекта
или его созданной копии;

CJ [2] — кнопка Rotate, открывающая данный докер на вкладке Rotate (Пово-
рот) для выполнения операции поворота выбранного объекта или его сфор-
мированной копии;

О [3] — кнопка Scale, открывающая докер Transformation на вкладке Scale and
Mirror (Масштаб и зеркальный разворот) для выполнения операций масшта-
бирования и зеркальных разворотов выделенного объекта или его созданной
копии;

П [4) — кнопка Size, открывающая данный докер на вкладке Size (Размер) для
выполнения операции изменения размеров выбранного объекта или его
сформированной копии;

G [5] — кнопка Skew, открывающая докер Transformation на вкладке Skew
(Наклон) для выполнения операции наклона выделенного объекта или его
созданной копии.
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Цветовые палитры
Цветовая палитра представляет собой набор образцов цветов, расположенных на
отдельной панели, с помощью которых можно раскрашивать объекты докумен-
та. В CorelDRAW I 2 цветовая палитра представлена в виде узкой вертикальной
панели с одним столбцом цветовых образцов и кнопками управления по ее кра-
ям, которая размещается справа на экране (см. рис. 2.2). При работе с палитрой
указанная панель открывается, при этом на экране отображаются четыре столб-
ца цветовых образцов и полоса прокрутки, предназначенная для их перемеще-
ния по горизонтали.

В CorelDRAW 12 можно одновременно работать с несколькими цветовыми па-
литрами, которые располагаются на экране рядом друг с другом,

Следует обратить внимание на то, что в режиме настройки параметров палитры
предусмотрена возможность задания до семи столбцов с образцами, которые
будут постоянно находиться на экране. Кроме того, цветовую палитру можно
перевести в плавающую форму (как и любую панель инструментов) путем пере-
таскивания ее с помощью мыши из того места, где она обычно располагается.
В этом случае палитра примет почти квадратную форму, при этом на ее панели
будут размещены все цветовые образцы, которые к ней относятся,

В программе допускается варьирование оттенков цветового образца, заданного
в палитре, при выполнении операции заливки или обводки векторного объекта.
Есть два способа выполнения данного действия. Первый из них применяется
при раскраске объекта определенным оттенком (одним из 49-ти, относящихся
к заданному образцу цвета), а второй — при смешении текущего цвета палитры
с цветом, в который объект был окрашен ранее (см. ниже).

На рис. 2.15 изображены три вида цветовой палитры. Слева палитра показана
в обычном виде (с открытой панелью оттенков), в центре — в открытом виде,
а справа — в плавающей форме.

Опишем элементы управления цветовой палитры и их функции:

П кнопка белого цвета (вверху палитры) с условными обозначениями парамет-
ров и черной меткой в правом нижнем углу — предназначена для открытия
контекстного меню палитры путем щелчка на ней любой кнопки мыши;

П две кнопки с черными треугольными значками (вверху и внизу) — исполь-
зуются для перемещения образцов цветов по вертикали в палитре, представ-
ленной в свернутом состоянии;

П кнопка со значком в форме черного треугольника с ограничителем (внизу па-
литры) — предназначена для открытия палитры, когда на экране отображается
четыре столбца цветовых образцов и горизонтачьная полоса прокрутки.

Рабочая (открытая) цветовая палитра позволяет выполнять следующие операции
по обработке объектов документа;

О задавать цвета заливки и обводки для их применения по умолчанию при рас-
краске новых объектов документа;
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раскрашивать внутреннюю область выбранного векторного объекта (графиче-
ского или текстового) заданным цветом, то есть выполнять его равномерную
заливку;

раскрашивать контур выбранного объекта выбранным цветом, то есть вы-
полнять его обводку;

изменять цвет равномерной заливки или обводки выделенного объекта путем
нанесения на него оттенка другого цвета.

Рис. 2.15. Три вида цветовой палитры. Здесь: 1 — кнопка открытия контекстного меню;
2 — кнопка прокрутки палитры вверх; 3 — значок прозрачной области объекта;
4 — панель с оттенками цветов; 5 — выбранный оттенок; б — заданный цвет;
7 — кнопка прокрутки палитры вниз; 8 — кнопка раскрытия цветовой палитры

В контекстном меню цветовой палитры представлены следующие 15 команд:

G Set Outline Color (Задать цвет обводки) — выполнение обводки выделенного
векторного объекта выбранным цветом, а при отсутствии такого объекта -
задание данного цвета в качестве цвета обводки по умолчанию;
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О Set Fill Color (Задать цвет зачивки) — выполнение равномерной заливки вы-
деленного векторного объекта выбранным цветом, а при отсутствии такого
объекта — задание данного цвета в качестве цвета заливки по умолчанию;

П в подменю Palette (Палитра);

• New (Новый) — формирование и открытие новой пустой цветовой палит-
ры, в которой отсутствуют образцы цветов;

• Open (Открыть) — открытие выбранного файла цветовой палитры (с рас-
ширением cpl), который хранится на диске;

• Save (Сохранить) — сохранение текущей палитры в ее собственном файле.

• Save As (Сохранить как) — сохранение палитры в другом файле;

• Close (Закрыть) — удаление палитры с экрана;

П в подменю Edit (Правка):

• Change Color (Изменить цвет) — задание режима изменения выбранного
цветового образца с помощью диалогового окна Select Color (Выбрать
цвет);

• Palette Editor (Редактор палитр) — открытие диалогового окна редактора
цветовых палитр, используемого для редактирования пользовательских
цветовых палитр, допускающих формирование новых цветовых образцов,
а также редактирование и удаление имеющихся;

• Find Color (Найти цвет) — используется для поиска в палитре образца
цвета по его названию;

П Set As Default (Использовать по умолчанию) — задает режим использования
текущей палитры в качестве палитры по умолчанию;

П Show Color Names (Показать названия цветов) — подключает режим отображе-
ния в палитре названий цветов при ее преобразовании в плавающую форму;

П Scroll to Start (Прокрутить к началу) — выполняет прокрутку цветовых об-
разцов в начало палитры;

О Scroll to End (Прокрутить к концу) — выполняет прокрутку образцов цветов
в конец палитры;

П Customize (Настроить) — открывает диалоговое окно Options (Параметры) на
вкладке с параметрами настройки цветовых палитр.

Программа содержит целый набор цветовых палитр, которые представлены
в различных цветовых форматах, в том числе и большую группу палитр библио-
течных цветов (см. разд. "Цветовые форматы" гл. 3). Загрузить цветовые палитры
можно с помощью команд подменю Color Palettes (Цветовые палитры) меню
Window (Окно). Названия этих команд соответствуют наименованиям открывае-
мых палитр.

В качестве палитры по умолчанию при установке программы задается пользователь-
ская палитра Default CMYK palette, в которой образцы цветов представлены в фор-
мате цветовой модели CMYK. В программе CorelDRAW 12 обычно используется
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эта палитра (при создании документов для печати) или палитра Default PRB palette
(при формировании электронных документов).

Кроме тех цветовых палитр, названия которых указаны в списке Color Palettes
(Цветовые палитры), в программе предусмотрена возможность загрузки и других
палитр, входящих в состав графического пакета CorelDRAW Graphic Suite 32.
Для этой цели используется докер Color Palette Browser (Просмотр цветовых
палитр), открываемый одноименной командой, входящей в два подменю: Color
Palettes (Цветовые палитры) и Dockers (Докеры) меню Window (Окно).

Рабочее окно докера Color Palette Browser содержит шюженный список всех
палитр данного пакета программ. Выбранная палитра откроется сразу же после
того, как будет открыт список, в котором она находится, и установлен с помо-
щью мыши флажок слева от ее названия. Щелкнув на кнопке с изогнутой
стрелкой (вверху докера), вы откроете дополнительное диалоговое окно, благо-
даря которому можно загрузить в программу любой файл палитры (с расшире-
нием cpl), хранящийся в дисковой памяти компьютера.

Раскраска объекта образцом цвета
Раскраска объекта с помощью цветовой палитры может быть выполнена двумя
способами. Опишем их.

Первый способ
1. Выделите необходимый векторный объект с помощью инструмента Pick

(Выбор) или фрагмент текста с помощью инструмента Text (Текст).

2. Установите указатель на требуемом образце цвета рабочей цветовой палитры
и выполните щелчок левой или правой кнопкой мыши. При щелчке левой
кнопкой будет выполнена заливка внутренней области выделенного объекта
(выбранных текстовых символов) заданным цветом, а при щелчке правой -
его обводка. При этом применяемый цвет отобразится в строке состояния
соответственно в качестве текущего цвета заливки или обводки.

Второй способ
1. Отобразите на экране объект документа, который требуется раскрасить (при

этом выделять объект не обязательно).

2. Поместите указатель на выбранном образце цвета, нажмите кнопку мыши и,
удерживая ее, перетащите данный образец цвета в область объекта. При этом
возле стрелки указателя появится один из трех значков: квадратик, рамочка
или квадратик с изображением страницы документа. Квадратик указывает на
то, что указатель размешен внутри объекта и при отпуске кнопки мыши бу-
дет выполнена его заливка. Рамочка означает, что указатель находится на
контуре объекта и будет выполнена его обводка, а квадратик со страницей -
указатель расположен снаружи от объекта и будет выбран цвет, применяемый
по умолчанию при заливке новых объектов документа. Отпустите кнопку
мыши после того, как указатель примет необходимую форму.
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Выбор образца цвета по умолчанию
Опишем порядок выбора в палитре цветов, применяемых для заливки и обводки
новых векторных объектов.

1. Отмените выделение каких-либо объектов в документе путем выбора инст-
румента Pick (Выбор) и щелчка в свободном месте рабочего окна документа.

2. Установите указатель на требуемом цветовом образце рабочей цветовой па-
литры и выполните щелчок левой или правой кнопкой мыши. Чтобы задать
цвет заливки по умолчанию, используйте левую кнопку, для задания цвета
обводки — правую.

3. В открывшемся диалоговом окне Uniform Fill (Равномерная заливка) или
Outline Color (Цвет обводки) укажите типы новых объектов, в раскраске кото-
рых будет применен выбранный цвет, с помощью трех флажков: Graphic (Гра-
фика), Artistic Text (Художественный текст) и Paragraph Text (Обычный текст).

4. Закройте окна щелчком на кнопке подтверждения ОК.

Раскраска объекта цветовыми оттенками
Чтобы раскрасить объект оттенками выбранного в палитре цвета, воспользуй-
тесь одним из двух способов, рассмотренных ниже.

Первый способ
1. Выделите объект, который требуется раскрасить.

2. Установите указатель на необходимом цветовом образце палитры, нажмите
кнопку мыши и удерживайте ее до тех пор (около секунды), пока не откро-
ется дополнительная палитра квадратной фор\ты, содержащая 49 оттенков
заданного цвета.

3. Отпустите кнопку мыши и поместите указатель на выбранном оттенке. По-
сле этого выполните щелчок левой или правой кнопкой мыши. При щелчке
левой кнопкой будет выполнена заливка выделенного объекта выбранным
оттенком, а при щелчке правой — его обводка.

Второй способ
1. Выделите предварительно раскрашенный объект, для которого требуется из-

менить цвет области заливки или обводки.

2. Установите указатель на необходимом цветовом образце палитры, который
будет применен при изменении цвета раскраски объекта.

3. Выполните операцию смешения цветов. Для этого нажмите клавишу <Ctrl> и
щелкните на выбранном образце цвета нужное количество раз кнопкой мы-
ши (для заливки используйте левую кнопку, а для обводки — правую).
При каждом щелчке к текущему цвету объекта будет добавляться некоторый
оттенок цвета, выбранного в палитре.
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Докеры
Докер (покерное окно) представляет собой прямоугольную панель с элементами
управления и индикации, имеющую вид вкладки диалогового окна или палитры
Adobe Photoshop. Докеры позволяют загружать в программу CorelDRAW 12 ее
системные средства и дополнительную информацию, необходимые в процессе
обработки документа. Особенность докеров состоит том, что в открытом со-
стоянии они не мешают выполнению операций, которые не имеют к ним отно-
шения. Докеры широко применяются в современных графических программах,
разработанных фирмой Corel Corporation.

Любой докер можно представить на экране в двух формах: стационарной и пла-
вающей. Стационарный докер обычно находится в правой части экрана и гра-
ничит с вертикальной полосой прокрутки рабочего окна документа (слева), па-
нелью свойств (сверху), цветовой палитрой или другим стационарным докером
(справа) и строкой состояния программы (снизу). В том случае, если в про-
грамму загружено несколько стационарных докеров, они будут либо размещать-
ся рядом в правой части экрана, соприкасаясь друг с другом, либо представлять
собой отдельные вкладки, одна из которых открыта.

Плавающий докер очень похож на палитру, используемую в одной из графиче-
ских программ с маркой Adobe. В CorelDRAW 12 предусмотрено объединение
докеров в группы, которые можно свободно перемешать по экрану, изменять их
размеры и сворачивать. Внешне плавающий докер отличается от обычной па-
литры только тем, что в нем отсутствует заголовок, хотя в программе и преду-
смотрена возможность его вывода (флажок Show titles on floating dockers на
вкладке Workspace > General (Рабочая область > Общие) диалогового окна Options
(Параметры)).

На рис. 2.16 изображен вид на экране плавающих (слева) и стационарных докеров.

Программа CorelDRAW 12 содержит 24 докера. Чтобы их открыть, необходимо
применить соответствующие команды меню программы, названия которых
обычно идентичны наименованиям докеров. В частности, с помощью команд
подменю Dockers (Докеры) меню Window (Окно) можно открыть любой из до-
керов CorelDRAW 12, за исключением Insert Character (Вставить символ).
Открытие наиболее важных докеров выполняется и из других мест основного и
контекстных меню программы.

При очередном открытии докер будет представлен в окне программы в такой же
форме, что и при его последнем выводе на экран (в текущем или предыдущем
сеансах работы программы). В том случае, когда докеры открываются в первый
раз после установки программы, они принимают стационарную форму, разме-
щаясь рядом друг с другом. Чтобы такие докеры не занимали много места на
экране, их можно поместить на одной панели, представив в виде отдельных
вкладок. Таким образом, при новом открытии данных докеров они будут иметь
вид вкладок.

Докер можно перевести из одной формы в другую двумя способами. Первый из
них заключается в двойном щелчке на заголовке открытого докера (метке заго-
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ловка в виде двух линий). При этом вся группа докеров, в которую входит ак-
тивный докер, преобразуется в противоположную форму. Второй способ пред-
назначен для изменения формы представления отдельного докера. Чтобы вы-
полнить эту операцию, необходимо установить указатель на ярлычке вкладки,
нажать кнопку мыши и, удерживая ее, перетащить докер в область другой от-
крытой панели с докерами (любой разновидности) и отпустить кнопку мыши.
Кроме того, перемещаемую вкладку можно также разместить в свободном месте
рабочей области программы (при переводе докера в плавающую форму) или
состыковать с цветовой палитрой, стационарным докером или с панелью инст-
рументов (при переводе в стационарную форму).

3 4
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Рис. 2.16. Стационарные и плавающие докеры CorelDRAW 12. Здесь: 1 — кнопки
свертывания групп докеров; 2 — кнопка закрытия группы докеров; 3 — кнопка закрытия

активного докера; 4 — кнопка закрытия группы докеров
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В том случае, если докеры, загруженные в программу, временно не нужны, их
можно свернуть, оставив при этом открытыми. Для свертывания группы ста-
ционарных докеров нужно выполнить щелчок на кнопке в левом верхнем углу,
имеющей вид стрелки (в форме двух треугольников), направленной вправо.
Чтобы свернуть группу плавающих докеров, следует щелкнуть на небольшой
кнопке с черной треугольной меткой, которая расположена в правом верхнем
углу рядом с кнопкой закрытия (см. рис. 2.16).

Для удаления с экрана группы стационарных или плавающих докеров достаточ-
но щелкнуть на кнопке закрытия Close Docker Group, находящейся в правом
верхнем углу. Для закрытия какого-либо одного докера в группе необходимо
выполнить щелчок правой кнопкой мыши на его ярлычке, открыть контекстное
меню и выбрать команду Close (Закрыть), Стационарный докер, размещенный
на открытой вкладке, можно также закрыть с помощью щелчка на кнопке за-
крытия Close Active Docker, которая находится слева от такой же кнопки, ис-
пользуемой для закрытия всей группы докеров (см. рис. 2.16).

Диалоговые окна
Кроме докеров, в CorelDRAW 12 применяются также и обычные диалоговые
окна. Они позволяют выполнять настройку параметров различных команд и ра-
бочих инструментов, а также установочных параметров программы.

Особенность диалогового окна состоит в том, что при его открытии можно вы-
полнять лишь те операции по настройке параметров, которые имеют отношение
к данному окну. В этом заключается его существенное отличие от докера. Ис-
ключением являются лишь два диалоговых окна: Format Text (Форматировать
текст) и Align and Distribute (Выровнять и распределить), относящихся к одно-
именным командам. При их открытии можно выполнять любые операции с до-
кументом.

Большинство диалоговых окон CorelDRAW 12 состоит из нескольких вкладок.
на которых параметры настройки группируются по функциональному признаку,
В любой момент в окне может быть открыта лишь одна вкладка. Для того чтобы
перейти на другие вкладки, обычно применяются ярлычки с их названиями,
которые отображаются в общей области окна. Выполнив щелчок на выбранном
ярлычке, вы откроете соответствующую вкладку.

В диалоговых окнах прикладных программ предусмотрены и другие способы
перехода между вкладками (например, с помощью кнопок). Один из них при-
меняется, в частности, в CorelDRAW 12 для окна Options (Параметры) с пара-
метрами настройки программы. В этом окне для выполнения перехода на тре-
буемую вкладку необходимо выбрать соответствующий элемент пложённого
списка категорий настроек (см. гл. 8).

Для обработки растровых изображений документа в программе используется
одно необычное диалоговое окно, которое без преувеличений можно назвать
универсальным. Это окно имеет такую особенность: не выходя из него, вы мо-
жете выполнять последовательную настройку параметров не одной, а многих
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команд, используя контекстное меню для перехода от одной команды к другой
и контролируя свои действия в режиме предварительного просмотра. Благодаря
этому можно существенно сэкономить время, которое затрачивается на поиск
нужной команды из группы однотипных команд. Это особенно важно при фор-
мировании в растровом изображении каких-либо художественных эффектов или
при его коррекции.
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Рис. 2.17. Варианты открытия окна коррекции и эффектов
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Универсальное диалоговое окно предназначено для работы с командами коррек-
ции и цветовой обработки растровых изображений (подменю Adjust (Коррекция),
Transform (Преобразовать) и Correction (Коррекция) меню Effects (Эффекты),
а также командами фильтрации (десять подменю меню Bitmaps (Растровая гра-
фика)). Учитывая функции этих команд, данное окно будем в дальнейшем на-
зывать окном коррекции и эффектов.

Чтобы сменить команду в данном окне, применяется контекстное меню, кото-
рое можно открыть путем щелчка на кнопке с меткой черного треугольника
в правом верхнем углу окна. При выполнении перехода от одной команды
к другой диалоговое окно предыдущей команды автоматически закрывается и
открывается новое. Для смены этих окон затрачивается совсем немного времени
(при этом закрытие старого окна происходит автоматически). Вследствие этого
возникает иллюзия того, что вы работаете в одном и том же диалоговом окне
(универсальном), не выходя из него и не теряя времени на то, чтобы закрыть
окно с параметрами старой команды и загрузить окно для команды новой.

Окно коррекции и эффектов обладает еще одним достоинством, которое состо-
ит в многообразии форм его представления на экране в отношении режима
предварительного просмотра. Существуют три варианта его открытия:

П без встроенных окон просмотра, когда результат обработки можно наблюдать
прямо в рабочем окне активного документа;

П с двумя окнами просмотра, в левом располагается копия исходного изобра-
жения, а в правом — копия результирующего;

О с одним окном просмотра (с результирующим изображением).

Выполнить переход от одного варианта открытия окна к другому можно с по-
мощью двух кнопок управления, которые находятся в левом верхнем углу окна.

На рис. 2.17 изображены три вида окна коррекции и эффектов при работе с ко-
мандой фильтрации Posterize (Постеризовать) подменю Transform (Преобразо-
вать) меню Effects (Эффекты). Контекстное меню окна в процессе его открытия
показано внизу справа.

Справочная система
Справочная система CorelDRAW 12 используется для оказания пользователю
помощи, которая может ему понадобиться при обработке документа, а также
при самостоятельном освоении программы. Работа данной системы выполняет-
ся в двух режимах: контекстной подсказки и запроса.

Режим контекстной подсказки предназначен для предоставления оперативной
информации о выполняемых в данный момент действиях, конкретной команде,
инструменте или элементе управления открытого докера. Указанная подсказка
предоставляется пользователю в следующих видах:

П сведения об обрабатываемом объекте и применяемом рабочем инструмен-
т е — в строке состояния программы;
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О сведения о назначении выбранной команды меню, название элемента интер-
фейса программы или элемента управления (элемента списка) докера — ря-
дом с указателем при его установке на названии команды, элементе интер-
фейса или элементе докера;

О сведения о содержимом открытого диалогового окна — в окне справочной
системы программы путем загрузки соответствующего информационного
раздела с помощью кнопки Help (Помошь) данного окна.

Режим запроса предназначен для предоставления требуемой справочной инфор-
мации пользователю по созданному им запросу. Для перехода в этот режим ис-
пользуется команда Help Topics (Справочная система) меню Help (Помощь). Дан-
ная команда открывает диалоговое окно справочной системы CorelDRAW 12,
которое используется для ввода запроса и организации поиска.

^ Примечание

Меню Help содержит и другие команды, предназначенные для получения раз-
личной справочной информации о работе программы (см. разд. "Команды меню
Help" гл. 9). В частности, команда CorelTUTOR (Учебник по CorelDRAW) позволя-
ет открыть электронный учебник, который загружается в окно Web-обозревателя,
используемого на компьютере по умолчанию.

Окно справочной системы CorelDRAW 12 имеет стандартное устройство, харак-
терное для справочных систем многих приложений, работающих в Windows,
В отличие от старых версий данной программы, в которых формирование за-
проса и вывод справочной информации производится в отдельных окнах, здесь
используются два окна, совмещенные друг с другом.

В левой части окна справочной системы расположены четыре вкладки, опре-
деляющие режимы предоставления справочной информации по запросу:
Содержание, Указатель, Поиск и Избранное (последняя вкладка новая, отсутст-
вовавшая в CorelDRAW 11). Справа расположено рабочее окно, в которое выво-
дится выбранная справочная информация.

Во многих разделах справочной системы используются гиперссылки, позво-
ляющие получить дополнительную справку по нужной вам теме, конкретизи-
рующую ту или иную информацию.

На рис. 2.18 показан вид диалогового окна справочной системы CorelDRAW 12,
открытого на вкладке Содержание.

Вкладка Содержание предназначена для работы в режиме учебного пособия.
Здесь вся информация систематизирована по разделам и подразделам, заголовки
которых можно последовательно просмотреть, выводя в рабочем окне содержи-
мое нужных разделов (см. рис. 2.18).

На вкладке Указатель реализован режим предметного указателя, который исполь-
зуется чаще всего. Поиск требуемого раздела в информационной базе справочной
системы и его отображение производится по ключевому слову (фразе), вводимому
в строку поиска. Это слово характеризует тематику нужного вам раздела.
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Рис. 2.18. Окно справочной системы программы с открытой вкладкой Содержание

На вкладке Поиск также выполняется поиск справочной информации по клю-
чевым словам. Но в данном случае эти слова определяют не тематику разделов,
а текстовое содержимое, в котором они встречаются.

Содержимое вкладки Избранное формируется самим пользователем из тех раз-
делов справочной системы, к которым ему чаще всего приходится обращаться
в процессе работы в программе.

Поясняющие надписи в этом окне даны на языке применяемой операционной
системы Windows (в данном случае они русскоязычные).
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Технологические возможности
CorelDRAW12
Любая программа, предназначенная для разработки документов, обладает набо-
ром возможностей (назовем их технологическими), которые облегчают реализа-
цию ее основных функций или лежат в их основе. К числу таких возможностей
программы CorelDRAW 12 отнесем работу со слоями, видами, стилями, связя-
ми, символами, механизмом OLE, интерактивными состояниями, цветами, со-
бытиями, макрокомандами (сценариями) и файлами. Умение использовать тех-
нологические возможности CorelDRAW 12 является необходимым условием для
профессиональной работы компьютерного дизайнера в этой программе.

Слои
Слои используются при обработке различных графических документов. Для рас-
трового документа, представляющего собой изображение растровой графики,
в каждом слое может находиться всего один объект. Если же документ относит-
ся к векторному типу (в том числе и создаваемый в CorelDRAW 12), то в от-
дельном его слое может находиться любое количество объектов различных ти-
пов, располагаемых по отношению друг к другу в произвольном порядке.

Создание любых графических документов невозможно без использования слоев.
В CorelDRAW 12 слои документа выполняют следующие функции:

G управление отображением, печатью и редактированием объектов документа и
линий разметки (направляющих и сетки), распределенных по отдельным
слоям;

П перемещение объектов по толщине документа: как между слоями, так и
внутри каждого из них;

П формирование шаблонных объектов, располагаемых в одном и том же месте
на всех страницах документа.

Для выполнения в рассматриваемой программе различных операций со слоями до-
кумента используется докер Object Manager (Диспетчер объектов), который откры-
вается одноименной командой подменю Dockers (Докеры) меню Window (Окно).
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На рис. 3.1 докер Object Manager показан в процессе обработки некоторого до-
кумента, изображенного слева в своем рабочем окне. В данном примере выде-
лен верхний объект документа, расположенный в компоновочной зоне.

1 2 3

! ЧШ Form OOjed - Ft None. Outline
D «aXHi-wr;
i Щ-ф яою*чг [NORMAL:

Q »Д »-'И1.1. • i
Q-O Р^ТЭОП will S S'Jss - Fill G'e,

1 -Q Drop Shedow OFOI*

'-•Л, ftOBBrtmafi

Й"О "»5>вг P»gi
ф- даг. >*Я|ОиИе!

Раде 1 /"Раде 2 [ 1 Irr
Рис. З.1. Докер Object Manager в процессе работы

Рассмотрим устройство докера Object Manager (Диспетчер объектов). Он содер-
жит следующие элементы:

О рабочее окно с вложенными списками объектов и линий разметки, относя-
щимися к отдельным страницам документа;

П шесть кнопок управления (три из них расположены вверху докера, а три —
внизу);

О контекстное меню докера, открываемое кнопкой со значком черного тре-
угольника (в правом верхнем углу);

О контекстные меню рабочего окна докера, относящиеся к отдельным элемен-
там списков и открываемые правой кнопкой мыши.

В рабочем окне докера расположены апоженные списки объектов (с линиями
разметки), относящиеся к отдельным страницам и слоям активного документа
(см. рис. 3.1). На верхнем уровне иерархии (вложения) каждого такого списка
находится либо текущая рабочая страница (Page ...). либо главная страница
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документа (Master Page). Главная страница управляет работой следующих со-
ставных частей документа:

О направляющих, располагаемых в слое Guides (Направляющие);

П объектов компоновочной зоны, относящихся к слою Desktop (Рабочий стол);

П шаблонных объектов, размещаемых в главных слоях (Master Layer ...), созда-
ваемых пользователем;

П сетки, относящейся к слою Grid (Сетка).

На втором уровне иерархии списка находятся отдельные слои, а на третьем -
объекты, относящиеся к этим слоям и текущей странице документа. Если доку-
мент содержит объекты Интернета, то все они будут размещаться в отдельном
слое, расположенном над всеми остальными слоями документа (см. рис. 3.1).

Рассмотрим (в порядке слева направо) управляющие элементы, находящиеся
в строке списка второго уровня иерархии, который относится к некоторому
слою определенной страницы документа.

П Три управляющих значка с изображениями глаза, принтера и карандаша.
Первый из них означает видимость на экране объектов текущего слоя данной
страницы документа, второй — возможность их распечатки, а третий — воз-
можность редактирования. При щелчке на любом из этих значков он станет
блеклым (серого цвета), при этом соответствующая функция будет отключе-
на, а при повторном щелчке — снова будет активизирована,

О Значок прямоугольника, цвет которого определяет раскраску контуров объ-
ектов данного слоя при отображении на экране только их. При двойном
щелчке на этом значке откроется список образцов цветов, в котором вы мо-
жете выбрать новый цвет раскраски контуров объектов текущего слоя. Пере-
ход в режим отображения контуров может быть выполнен одним из двух
способов:

• для представления в контурах всех объектов документа выполните коман-
ду Simple Wireframe (Упрощенный каркас) или Wireframe (Каркас) меню
View (Вид);

• для представления в контурах только объектов выбранного слоя докумен-
та установите указатель на строке данного слоя, откройте правой кнопкой
мыши контекстное меню и выполните команду Properties (Свойства);
в открывшемся диалоговом окне Layer <л> Properties (Свойства слоя <п>)
(см. рис. 3.2), где « — порядковый номер текущего слоя, установите фла-
жок Override full color view (для ограничения действия данной функции
только текущей страницей документа установите также флажок Apply all
property changes to the current page only), после чего закройте окно щелч-
ком на кнопке ОК.

О Название текущего слоя. Чтобы его изменить, подведите к нему указатель
мыши, откройте правой кнопкой контекстное меню и выполните команду
Rename (Переименовать), перейдя в 'режим редактирования надписи. После
ввода с клавиатуры нового названия слоя щелкните мышью в любом свобод-
ном месте рабочего окна докера.
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Layer 1 Properties
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Рис. 3.2. Диалоговое окно Layer 1 Properties

Поясним назначение шести кнопок управления докера Object Manager (Диспет-
чер объектов), указав в квадратных скобках их номера, приведенные на рис. 3.1.

На верхней панели докера расположены:

П [1] — кнопка Show Object Properties, подключающая режим отображения
в рабочем окне докера параметров заливки и обводки объектов документа;

П [2] — кнопка Edit Across Layers, задающая режим редактирования объектов,
находящихся во всех слоях документа;

О [3] — кнопка Layer Manager View, активизирующая режим работы с диспет-
чером слоев, при котором в рабочем окне докера отображаются лишь эле-
менты списков, относящиеся ко второму уровню иерархии (т. е. слои).

Внизу докера находятся:

П [4] — кнопка New Layer, создающая новый рабочий слой;

О [5] — кнопка New Master Layer, создающая новый главный слой, предназна-
ченный для размещения шаблонных объектов, отображаемых на всех стра-
нидах документа;

П [6] — кнопка Delete, удаляющая выделенный элемент списка.

Докер Object Manager (Диспетчер объектов) позволяет выполнять различные
операции с объектами и слоями документа с помощью управляющих значков спи-
сков, кнопок управления докера, а также команд контекстных меню. Кроме того,
вы можете манипулировать элементами списков с помощью мыши путем перетас-
кивания их мышью (при нажатой ее кнопке) из одного места в другое. Таким
образом, с помощью этого докера можно выполнять следующие операции:

О переходить на любую страницу документа;

П выделять отдельные объекты и слои;
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О перемешать объекты по толщине документа (как между различными его
слоями, так и внутри текущего слоя);

О изменять порядок расположения слоев в документе;

П группировать объекты, находящиеся на одной странице документа.

Контекстное меню докера Object Manager, открываемое кнопкой в правом
верхнем углу, содержит следующие одиннадцать команд:

П New Layer (Новый слой) — создает в документе новый рабочий слой, кото-
рый располагается над всеми существующими рабочими слоями, за исклю-
чением слоя с объектами Интернета, если он имеется;

О New Master Layer (Новый главный слой) — создает в документе новый глав-
ный слой, предназначенный для размещения шаблонных объектов;

О Delete Layer (Удалить слой) — удаляет активный слой документа, выделен-
ный в рабочем окне докера;

П Move To Layer (Переместить в слой) — перемещает выделенный объект
в другой слой документа, выбранный щелчком мыши в окне докера (с со-
хранением положения этого объекта на текущей странице документа);

О Copy To Layer (Скопировать в слой) — копирует выделенный объект в дру-
гой слой документа, выбранный щелчком мыши (с сохранением его положе-
ния на текущей странице документа);

О Hide/Show Object Properties (Спрятать/Показать свойства объекта) — управ-
ляет отображением в рабочем окне докера параметров заливки и обводки
объектов;

П Edit Across Layers (Редактировать во всех слоях) — подключает режим редак-
тирования объектов, находящихся во всех слоях документа, а не только в ак-
тивном слое (наличие галочки в названии команды свидетельствует об акти-
визации данного режима);

d Expand To Show Selection (Открыть список для выделенного объекта) — зада-
ет режим раскрытия ветви вложенного списка с объектами документа, отно-
сящейся к некоторому объекту, выделенному в документе;

О Show Pages And Layers (Показать страницы и слои) — отображает в рабочем
окне докера только элементы списков, относящиеся к первым двум уровням
его иерархии (страницы и слои документа);

П Show Pages (Показать страницы) — отображает в окне докера только элемен-
ты списков, относящиеся к первому уровню иерархии (страницы);

G Show Layers (Показать слои) — отображает в окне докера только страницы
документа, а также слои, относящиеся к главной странице.

В рабочем окне докера Object Manager (Диспетчер объектов) есть три контекст-
ных меню, открываемых правой кнопкой мыши: для текущей страницы (при
установке указателя на ее названии), для текущего слоя и для текущего объекта.
Первое контекстное меню полностью идентично меню навигатора страниц,
а третье — меню рабочего окна документа, относящемуся к выделенному объекту.
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Второе контекстное меню окна докера Object Manager, относящееся к текущему
слою документа, содержит следующие семь команд:

П Visible (Видимые) — управляет режимом отображения объектов выбранного
слоя документа;

О Printable (Печатаемые) — управляет режимом вывода на печать этих объектов;

О Editable (Редактируемые) — управляет режимом редактирования объектов
данного слоя;

П Master (Главные) — преобразует объекты, находящиеся в текушем слое до-
кумента (на различных страницах) в шаблонные объекты, отображаемые на
каждой странице; данная операция выполняется путем преобразования те-
кущего рабочего слоя документа в главный слой;

П Delete (Удалить) — удаляет выбранный слой;

П Rename (Переименовать) — подключает режим переименования текущего слоя;

П Properties (Свойства) - - открывает диалоговое окно Layer <n> Properties
(Свойства слоя <п>) с параметрами настройки выбранного слоя (см. рис. 3.2).

Виды
Вид (вид документа) представляет собой вариант отображения на экране в за-
данном масштабе некоторой страницы документа или ее отдельной области.
В CorelDRAW 12 с видами документа допускается выполнение следующих опе-
раций:

П формирование в документе различных видов;

П манипуляция видами (переход от одного вида к другому);

П сохранение созданных видов в файле документа.

Использование видов повышает эффективность обработки графического доку-
мента, поскольку снижает потери времени, связанные с переходами между от-
дельными его участками.

Все операции с видами выполняются с помощью докера View Manager (Диспет-
чер видов), который открывается одноименной командой подменю Dockers
(Докеры) меню Window (Окно).

На рис. 3.3 и 3.4 докер View Manager показан в процессе работы с некоторым
документом, состоящим из двух страниц. На первом рисунке активизирован вид
View I, отображающий на экране первую страницу документа, а на втором -
вид View 3, отображающий в увеличенном масштабе растровое изображение,
находящееся на второй странице.

Рассмотрим устройство докера View Manager (Диспетчер видов), который вклю-
чает следующие элементы:

П рабочее окно, содержащее список видов документа;

П семь кнопок управления (вверху докера);
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Рис. 3.3. Пример использования докера View Manager
(активизирован первый вид документа)

Рис. 3.4. Пример использования докера View Manager
(активизирован третий вид документа)
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О контекстное меню докера с кнопкой для его раскрытия со значком черного
треугольника (в правом верхнем углу);

П контекстное меню рабочего окна докера, раскрываемое правой кнопкой мыши.

В рабочем окне докера находится список видов, созданных в документе. Каждая
строка списка, относящаяся к некоторому виду, содержит следующие элементы
управления и информацию (в порядке слева направо):

П два управляющих значка с изображениями страницы документа и лупы;

П наименование вида, доступное для редактирования;

О номер страницы документа (с буквой "Р" впереди, относящейся к текущему виду);

О масштаб отображения данной страницы (в процентах).

Рассмотрим назначение этих значков. Первый из них, имеющий форму страни-
цы, управляет отображением выбранной страницы документа, а второй, с изо-
бражением лупы, — выбором текущего масштаба. Управление происходит сле-
дующим образом. Если в строке некоторого вида имеется значок страницы, то
при переходе к данному виду будет открыта указанная в его строке страница
документа, а если данного значка нет, то останется открытой прежняя страница.
То же относится и к значку лупы, позволяющему выбрать новый масштаб или
оставить прежний.

При щелчке мышью на названии выбранного вида подключится режим редак-
тирования его названия, а если щелкнуть в правой части строки данного вида,
то этот вид будет активизирован.

На верхней панели докера View Manager расположено семь кнопок управления.
Поясним их назначение, указав в квадратных скобках номера, приведенные
на рис. 3.3:

П [1] — кнопка Zoom One-Shot, выбирающая рабочий инструмент Zoom (Масштаб)
программы с целью однократного масштабирования им документа в рабочем
окне;

П [2] — кнопка Zoom In, увеличиваю]цая в два раза масштаб отображения до-
кумента;

П [3] — кнопка Zoom Out, уменьшающая в два раза масштаб документа;

О [4] — кнопка Zoom To Selected, заполняющая область обработки рабочего
окна документа выделенным объектом;

CJ [5] — кнопка Zoom To All Objects, заполняющая данную область всеми объек-
тами, находящимися на текущей странице документа и в компоновочной зоне;

П [6] — кнопка Add Current View, формирующая новый вид документа;

П [7] — кнопка Delete Current View, удаляющая текущий вид.

Контекстное меню докера View Manager (Диспетчер видов) (и такое же меню
его рабочего окна) включает следующие пять команд:

П Switch to View (Перейти к виду) — производит переход к виду, выделенному
в рабочем окне документа;
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П New (Новый) — создает новый вид из текущего состояния документа в рабо-
чем окне;

G Delete (Удалить) — удаляет выбранный вид;

П Rename (Переименовать) — подключает режим переименования текущего
вида;

П Zoom Tools (Инструменты масштаба) — управляет отображением кнопок
управления докера.

Стили
В современных программах, предназначенных для разработки различных доку-
ментов, часто используются стили. В широком смысле слова стиль представляет
собой набор параметров, зафиксированный в файле под некоторым именем,
который служит для ускорения обработки в документе объектов определенного
типа или выполнения конкретной операции. В CorelDRAW 12 при обработке
объектов документов используются текстовые, графические и цветовые стили,
а при распечатке документов — стили печати.

В текстовом стиле указываются параметры форматирования текста обычного
или художественного типа, в частности: шрифт, стиль начертания символов,
кегль, межстрочный интервал (интерлиньяж), тип и параметры заливки симво-
лов текста, параметры их контуров и т. п. В графическом стиле задаются пара-
метры заливки выбранного типа и параметры обводки для объектов векторной
графики. Цветовой стиль представляет собой образец цвета с набором оттенков^
сформированных на его основе.

Кроме указанных выше стилей, в CorelDRAW 12 используются и другие стили,
выполняющие более узкие функции (стили печати, начертания текстовых сим-
волов, оформления линий, оформления различных эффектов и др.) Информа-
ция о таких стилях будет даваться по ходу изложения материала в книге.

Примечание

В программе CorelDRAW 12 кроме стилей применяют также и шаблоны (шаблон-
ные документы). Шаблон представляет собой файл документа (с расширением
cdt вместо cdr), в состав которого могут входить различные стили и объекты.
Шаблон используется в качестве образца при формировании на его основе новых
обычных документов, а также для передачи своих стилей другим документам.

Текстовые и графические стили
В рассматриваемой программе используются текстовые стили двух типов: обыч-
ные и художественные. Первые из них предназначены для форматирования
обычного текста, а вторые — художественного (см. разд. "Типы текста" гл. 6).
Графические стили предназначены для оформления векторных графических
объектов, а также для раскраски текстовых символов.
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В число текстовых и графических стилей любого документа обязательно входят
три стиля, используемые в программе по умолчанию при оформлении новых
объектов, — Default Graphic (Графический стиль по умолчанию), Default Artistic
Text (Стиль художественного текста по умолчанию) и Default Paragraph Text
(Стиль обычного текста по умолчанию).

Независимо от того, к какому из указанных трех типов относится стиль, он
поддерживает следующие атрибуты оформления объектов:

G любые типы и параметры заливки, за исключением заливки по сетке;

П любые параметры равномерной обводки.

С помощью стилей нельзя передавать атрибуты прозрачности объектов и имею-
щиеся в них эффекты векторной графики.

В процессе обработки текстовых и векторных объектов документа допускается
не только применять готовые стили, но и изменять параметры существующих
стилей, а также создавать новые. При сохранении документа все находящиеся
в нем стили будут сохранены в его файле. Если создается новый документ, то
в него будут загружены стили из шаблона, на базе которого этот документ фор-
мируется (см. разд. "Создание нового документа"гл. 7).

Для выполнения различных операций с текстовыми и графическими стилями
используется докер Graphic and Text Styles (Графические и текстовые стили),
который открывается одноименной командой подменю Dockers (Докеры) меню
Window (Окно). Кроме того, с помощью списка Style List (Список стилей), на-
ходящегося на панели свойств и панели инструментов Text (Текст), можно при-
менять существующие стили к выбираемым в документе текстовым объектам.

На рис. 3.5 докер Graphic and Text Styles показан в процессе работы с некото-
рым документом. Два одинаковых образца художественного текста и две одина-
ковых фигуры эллипса были оформлены различными стилями (в порядке сверху
вниз): Default Artistic Text, New Artistic Text, Default Graphic и New Graphic.
Первый и третий стили являются стилями по умолчанию, а второй и четвертый
были созданы непосредственно в документе.

Рассмотрим устройство докера Graphic and Text Styles, который включает сле-
дующие элементы:

П рабочее окно, содержащее значки стилей или их список;

П контекстное меню докера, открываемое кнопкой со значком черного тре-
угольника, находящееся в правом верхнем углу;

П контекстные меню рабочего окна докера, открываемые правой кнопкой мы-
ши при установке указателя либо в свободном месте окна, либо на значке
выбранного стиля (мы эти меню рассматривать не будем, поскольку в их со-
став входит только часть команд меню докера).

Контекстное меню докера Graphic and Text Styles (Графические и текстовые
стили) содержит следующие команды:

О Enable Styles (Подключить стили) — подключает режим защиты стиля по
умолчанию, соответствующего типу выбранного объекта (блок обычного или
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художественного текста или объект векторной графики), от изменения пара-
метров форматирования или оформления данного объекта. Если этот режим
отключен (галочка в названии команды отсутствует), то произойдет передача
стилю по умолчанию текущих параметров обрабатываемого объекта незави-
симо от того, каким стилем он был оформлен;

Graphic and Text;

CorelDRAW 12
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Рис. З.5. Докер Graphic and Text Styles в процессе работы

О Apply Style (Применить стиль) — применяет выбранный стиль к выделенно-
му объекту;

D в подменю Template (Шаблон) входят три команды:

• Load (Загрузить) — загружает в активный документ текстовые, графиче-
ские и цветовые стили из выбранного шаблона;

• Save As (Сохранить как) — сохраняет стили указанных типов в новом
файле шаблона с включением в него содержимого активного документа
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(флажок With contents установлен) или без такого включения (данный
флажок сброшен);

• Save As Default for New Documents (Сохранить для использовании в новых
документах) — сохраняет стили в шаблоне, используемом в программе по
умолчанию;

Примечание

В CorelDRAW 12 предусмотрены три способа сохранения текстовых и графиче-
ских стилей активного документа в шаблоне по умолчанию с целью их переноса
в новые документы. Первый из них состоит в использовании указанной выше
команды Save As Default for New Documents; второй — в установке флажков
Styles (Стили) и Save options as defaults for new documents (Сохранить па-
раметры по умолчанию для новых документов) на вкладке Document (Доку-
мент) диалогового окна Options (Параметры); и третий способ — в выполнении
команды Tools > Save Settings As Default (Инструменты > Сохранить настройки
для использования по умолчанию).

П в подменю View (Вид) находятся четыре команды по выбору формы пред-
ставления информации о стилях в рабочем окне докера Graphic and Text
Styles: Large Icon (Большой значок), Small Icon (Маленький значок), List
(Список) и Details (Подробности);

О Find/Find Next (Найти/Найти снова) — выполняет последовательный поиск
(с выделением) объектов документа, оформленных выбранным стилем;

О Copy Properties From (Скопировать свойства из) — производит передачу па-
раметров форматирования или оформления выделенного в документе объек-
та стилю, выбранному в рабочем окне докера;

О Edit Hot Key (Редактировать горячую клавишу) — открывает диалоговое окно
Options (Параметры) на вкладке Workspace > Customization > Commands (Рабо-
чая область > Настройка > Команды) для ввода или коррекции быстрой кла-
виши, относящейся к заданному стилю;

П подменю Show (Показать) включает четыре команды, управляющие отобра-
жением стилей в рабочем окне докера:

• Graphic Styles (Графические стили) — выводит в окне только графические
стили;

« Artistic Text Styles (Стили художественного текста) — выводит стили ху-
дожественного текста;

• Paragraph Text Styles (Стили обычного текста) — выводит стили обычного
текста;

• Auto-View (Автоматическое отображение) — выводит стили, соответст-
вующие типу выделенного в документе объекта;

П в подменю New (Новый) находятся три команды по созданию нового стиля:
Graphic Style (Графический стиль), Artistic Text Style (Стиль художественного
текста) и Paragraph Text Style (Стиль обычного текста);
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G Delete (Удалить) — удаляет выбранный стиль;

П Rename (Переименовать) — подключает режим переименования текущего
стиля;

О Properties (Свойства) — открывает диалоговое окно Options (Параметры) на
вкладке Document > Styles (Документ > Стили) с параметрами настройки вы-
бранного стиля.

Всю совокупность операций по работе с текстовыми и графическими стилями
можно разбить на три группы; операции создания, коррекции и применения
стилей. Рассмотрим их.

Создание нового стиля
1. Откройте контекстное меню докера Graphic and Text Styles (Графические и

текстовые стили), щелкнув на кнопке в правом верхнем углу,

2. Поместите указатель в пункт New (Новый) и в раскрывшемся подменю из
трех пунктов выберите название нужного вам типа создаваемого стиля,
щелкнув на нем. В результате будет создан новый стиль заданного типа с те-
ми же параметрами, что и стиль того же типа, используемый по умолчанию.

3. В случае необходимости переименуйте созданный вами стиль. Для этого
щелкните на значке (или названии) данного стиля правой кнопкой мыши
и в раскрывшемся контекстном меню рабочего окна докера выберите коман-
ду Rename (Переименовать). После этого введите с клавиатуры нужное
название стиля и сделайте щелчок в свободном месте окна докера.

Коррекция стиля (первый способ)

1. Оформите должным образом текстовый или векторный объект, который бу-
дет использован в качестве образца (выделять этот объект не обязательно).

2. Выделите в рабочем окне докера Graphic and Text Styles значок стиля, пара-
метры которого должны быть изменены, откройте контекстное меню окна
докера и выполните команду Copy Properties From (Скопировать свойства
из), придав указателю вид жирной стрелки. Поместите эту стрелку в область
объекта, используемого в качестве образца, и щелкните кнопкой мыши.

Коррекция стиля (второй способ)
1. Выделите в рабочем окне докера Graphic and Text Styles значок стиля, кото-

рый будет корректироваться.

2. Поместите на этом значке указатель, откройте правой кнопкой контекстное
меню окна докера, относящееся к данному стилю, и выполните команду
Properties (Свойства). При этом откроется диалоговое окно Options (Пара--
метры) на вкладке Document > Styles (Документ > Стили).

3. Выполните настройки параметров выбранного стиля на этой вкладке, после
чего закройте окно щелчком на кнопке ОК.
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Применение стиля (первый способ)
1. Выберите рабочий инструмент Pick (Выбор) и выделите им объект докумен-

та, который будет оформляться стилем.

2. В рабочем окне докера выполните одно из действий:

• сделайте двойной щелчок на значке (или названии) нужного стиля;

• выделите значок требуемого стиля, откройте правой кнопкой мыши кон-
текстное меню окна докера и выполните команду Apply Style (Применить
стиль).

Применение стиля (второй способ)
1. Отобразите на экране ту область документа, где находится объект, который

будет оформляться стилем (выделять этот объект не обязательно).

2. В рабочем окне докера поместите указатель на значок нужного стиля, на-
жмите кнопку мыши и перетащите этот значок на объект, после чего кнопку
отпустите.

Цветовые стили
Для раскраски различных объектов документа в CorelDRAW 12 могут исполь-
зоваться не только цветовые палитры, но и так называемые цветовые стили.
Они представляют собой наборы цветовых образцов, которые формируются
пользователем и сохраняются вместе с документом. Любой цветовой стиль
состоит из одного исходного образца цвета, называемого цветом-родителем
(родителем), и набора оттенков, зависящих от него и называемых цветами-
потомками (потомками). В программе допускается автоматическое формиро-
вание таких наборов.

Потомки обладают следующим свойством: каждый из них отличается от своего
родителя или другого потомка, входящего в ту же группу, лишь уровнем ярко-
сти или насыщенности. При изменении цвета-родителя автоматически изменя-
ются и цветовые оттенки его потомков, а также раскраска тех объектов доку-
мента, при оформлении которых они использовались.

Все операции по созданию, коррекции и применению цветовых стилей выпол-
няются в CorelDRAW 12 с помощью докера Color Styles (Цветовые стили), ко-
торый открывается одноименной командой подменю Dockers (Докеры) меню
Window (Окно).

На рис. 3.6 докер Color Styles показан в процессе раскраски линии обводки век-
торного объекта одним из его цветовых образцов. В окне докера находятся три
цветовых стиля. Верхний стиль содержит одного родителя и пять потомков (об-
разцы составных цветов), средний стиль —- также одного родителя и пять по-
томков (образцы стандартных цветов), а нижний стиль — только одного родите-
ля (составной цвет).
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Рис. 3.6. Докер Color Styles в процессе работы

Рассмотрим устройство докера Color Styles (Цветовые стили), который включает
следующие элементы:

П рабочее окно, содержащее вложенные списки цветовых образцов, относящиеся
к цветовым стилям открытых в программе документов (в CorelDRAW 12
нельзя использовать цветовые стили других открытых документов для оформ-
ления ими объектов активного документа);

П пять кнопок управления, находящихся вверху докера;

П контекстное меню рабочего окна докера, относящееся к отдельным элемен-
там списка и открываемое щелчком правой кнопкой мыши.

На верхней панели докера Color Styles расположено пять кнопок управления.
Поясним их назначение, указав в квадратных скобках номера, приведенные
на рис. 3.6:

П [1] — кнопка New Color Style, подключающая режим выбора цвета-родителя
для нового цветового стиля;

ГЗ [2] — кнопка New Child Color(s), открывающая диалоговое окно Create a New
Child Color (Создать новый цвет-потомок) (см. рис. 3.7) для формирования
одного или нескольких цветовых оттенков (цветов-потомков) для текущего
стиля;

П [3] — кнопка Edit Color Style, задающая режим редактирования выбранного
элемента цветового стиля;

П [4] — кнопка Auto-create Color Styles, активизирующая режим автоматиче-
ского создания новых цветовых стилей на основе выбранных в документе
объектов;
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[5] — кнопка Converts selected color to spot, преобразующая все составные
(полиграфические) цвета текущего цветового стиля в оттенки стандартного
(плашечного) цвета-родителя.

Примечание

Элементы цветового стиля, являющиеся образцами стандартных цветов, отли-
чаются от элементов стиля составных цветов наличием белой квадратной мет-
ки в левом нижнем углу каждого цветового образца (см. рис. 3.6).

Create в New Child Color

v: J t,

Hue: ,217

Number of shades ~

Create:.P "«i shadesof: C:71M:4IV:0

•.'• Lighter Shades

1 Darker shades

f Both

5hade.similarity

Different Similar

. 4 Cancel Help

Рис. З.7. Диалоговое окно Create a New Child Color

В состав контекстного меню рабочего окна докера Color Styles (Цветовые сти-
ли), открываемого правой кнопкой мыши, входят следующие команды:

П Edit Color (Редактировать цвет) — открывает диалоговое окно для редактиро-
вания в нем выбранного цветового образца;

D Create а СЫЫ Color (Создать цвет-потомок) — формирует один или несколь-
ко цветов-потомков для выбранного стиля;

П Convert to Spot (Преобразовать в стандартный) — преобразует все составные
цвета выбранного стиля в оттенки стандартного цвета-родителя;

Примечание

Все используемые в документе оттенки, относящиеся к некоторому цветовому
стилю со стандартным цветом-родителем, будут выведены на печать в режиме
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цветоделения на отдельную пленку, из которой будет в дальнейшем изготов-
лена форма для печати готовым красителем.

П Convert to CMYK (Преобразовать в CMYK) — преобразует текущий цветовой
формат выбранного стиля в формат CMYK;

П Convert to RGB (Преобразовать в RGB) — преобразует текущий цветовой
формат данного стиля в формат RGB;

П Delete (Удалить) — удаляет выделенный цвет-потомок или весь цветовой
стиль;

П Rename (Переименовать) — переименовывает текущий элемент стиля;

П в подменю Sort (Сортировать) находятся две команды сортировки цветовых
стилей:

• By Names (По именам) — сортирует элементы выбранного стиля по их
названиям;

• By Color Styles with Children (По цветовым стилям с цветами-
потомками) — сортирует цветовые стили активного документа по нали-
чию в них цветов-потомков (такие стили располагаются в списке выше);

П Show Color in Color Docker (Показать цвет в докере "Цвет") — открывает до-
кер Color (Цвет) с выбором в нем того цвета, который задан в палитре Color
Styles (Цветовые стили);

П Add to Default Palette (Добавить в палитру по умолчанию) — переносит выде-
ленный образец цвета в цветовую палитру, используемую в программе по
умолчанию.

Опишем порядок выполнения различных операций с цветовыми стилями.

Создание нового цветового стиля
Выберите цвет-родитель нового стиля одним из следующих способов:

П щелчком на кнопке [1] докера Color Styles откройте диалоговое окно New Color
Style (Новый цветовой стиль), задайте в этом окне нужный цвет, представлен-
ный в формате выбранной цветовой модели, и щелкните на кнопке ОК;

П нажмите кнопку мыши и перетащите требуемый образец цвета из рабочей
цветовой палитры в свободную область рабочего окна докера;

П выберите рабочий инструмент Pick (Выбор) и перетащите им в рабочее окно
докера векторный объект документа, раскрашенный нужными цветами;

П выделите в документе объект с заданной раскраской и щелчком на кноп-
ке [41 докера цветовых стилей откройте диалоговое окно Auto-create Color
Styles (Автоматически создать цветовые стили). Настройте в этом окне тре-
буемые параметры, после чего закройте его щелчком на кнопке ОК. Данное
окно содержит следующие элементы настройки:

• флажки Use fill colors и Use outline colors, при установке которых задаются
режимы формирования цветовых стилей из цветов заливки и обводки вы-
бранного объекта;

4 Зак. 250
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• флажок Automatically link similar colors together, при установке которого
подключается режим автоматического формирования связей подчиненно-
сти между близкими оттенками;

• флажок Convert child palette colors to CMYK, при установке которого активи-
зируется режим преобразования цветов-потомков в формат модели CMYK;

• ползунок Parent creation index, задающий пороговое значение, опреде-
ляющее формирование связей подчиненности.

Формирование одного цвета-потомка
1. В рабочем окне докера Color Styles (Цветовые стили) выделите мышью цвет-

родитель нужного цветового стиля.

2. Щелчком на кнопке [2] докера откройте диалоговое окно Create a New Child
Color (Создать новый цвет-потомок) (см. рис. 3.7).

3. Используя ползунки Saturation (Насыщенность) и Brightness (Яркость), от-
регулируйте требуемый цвет для заданного элемента стиля, контролируя его
в области просмотра квадратной формы, находящейся справа.

4. Щелкните на кнопке подтверждения ОК.

Формирование набора цветов-потомков
1. В рабочем окне докера Color Styles выделите мышью цвет-родитель нужного

стиля.

2. С помощью кнопки [2] докера откройте диалоговое окно Create a New Child
Color.

3. Настройте в этом окне следующие параметры (см. рис. 3.7):

• количество формируемых оттенков (поле Create);

• тоновые характеристики оттенков: более светлые, чем исходный цвет (пе-
реключатель Lighter shades), более темные (переключатель Darker shades),
светлые и темные (переключатель Lighter and darker shades);

• степень близости оттенков друг к другу (ползунок Shade similarity).

4. Закройте окно щелчком на кнопке подтверждения ОК.

Коррекция элемента цветового стиля
1. Выделите мышью в нужном цветовом стиле тот цвет-родитель или цвет-

потомок, который должен быть откорректирован.

2. Щелчком на кнопке [3] докера Color Styles (Цветовые стили) откройте диа-
логовое окно Edit Color Style (Редактировать цветовой стиль), выберите
в нем нужный цвет и щелкните на кнопке подтверждения ОК. При этом
произойдет следующее. Если корректировался цвет-потомок, то остальные
элементы стиля останутся неизменными, а если цвет-родитель, то все цвета-
потомки изменят свою окраску в соответствии с новым цветом-родителем.
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Применение цветового стиля
1. Откройте докер Color Styles.

2. Отобразите в рабочем окне документа векторный или текстовый объект, ко-
торый должен быть раскрашен цветовым стилем (выделять объект не обяза-
тельно).

3. В рабочем окне докера откройте список элементов требуемого стиля и выде-
лите в нем нужный цветовой образец.

4. Для выполнения заливки объекта выберите один из двух вариантов действий:

• выделите объект рабочим инструментом Pick (Выбор) и сделайте двойной
щелчок на выбранном элементе стиля;

• установите указатель на нужном элементе стиля, нажмите кнопку мыши и
перетащите этот элемент во внутреннюю область объекта. Как только
черная стрелка указателя изменится на белую, а справа от нее появится
квадратик, раскрашенный заданным цветом, отпустите кнопку.

5. Для выполнения обводки объекта поместите указатель на нужный элемент
стиля, нажмите кнопку мыши и перетащите этот элемент на контур объекта.
Как только черная стрелка указателя изменится на белую, а справа от нее
появится квадратная рамка, раскрашенная заданным цветом (см. рис. 3.6),
отпустите кнопку.

Связи
В документах CorelDRAW 12 могут устанавливаться связи следующих типов:

П между текстовыми рамками и дорожками, в которых размешаются блоки
обычного текста, относящиеся к одному текстовому материалу (такие связи
называются текстовыми) (см. разд. "Обработка обычного текста" гл. 6, под-
разд. "Перетекание текста")',

П между документом и файлом импортированного растрового изображения
(см. разд. "Импорт и экспорт информации"&}. 7, подразд. "Операция импорта")',

G между документом и объектом OLE, хранящимся в отдельном файле
(см. разд. "Механизм OLE" данной главы);

О между двумя объектами активного документа или объектом и другой страни-
цей документа (см. разд. "Создание электронных документов" гл. 7, подразд. "Об-
работка исходного документа");

П между объектом документа и другим документом сети Интернет или испол-
няемым файлом (см. разд. "Создание электронных документов" гл. 7, подразд. "Об-
работка исходного документа").

Примечание

Связи последних двух типов реализуются лишь в электронных версиях исход-
ного документа.
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Для выполнения различных операций со связями документа, за исключением тек-
стовых, используется докер Link Manager (Диспетчер связей), который открывает-
ся одноименной командой подменю Dockers (Докеры) меню Window (Окно).

На рис. 3.8 докер Link Manager показа}! в процессе работы с некоторым доку-
ментом, состоящим из двух страниц (открыта первая страница) и содержащим
различные связи.

Привет всем

Программа
CorelDRAW 12|

Page
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Рис. З.8. Докер Link Manager в процессе работы

1.;

Рассмотрим устройство докера Link Manager (Диспетчер связей), который
включает следующие элементы:

О рабочее окно, в котором отображается информация о связях документа;

О пять кнопок управления, расположенных внизу докера;

П контекстное меню окна докера, раскрываемое правой кнопкой мыши.

Информация о связях объектов документа представляется в окне докера в виде списка.
Каждая строка списка относится к некоторому объекту-источнику, инициирующему
связь. В ней представлена следующая информация (в порядке слева направо):

О состояние связи (поле Status);

П значок типа связи;
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О адрес связи (поле Link);

П номер страницы, на которой данный объект находится (поле Page).

В примере, представленном на рис. 3.8, установлены следующие связи (в квад-
ратных скобках даны их номера, указанные на рисунке):

О [1] — между объектом на первой странице и файлом видеоклипа;

П [2] — между объектом на первой странице и файлом аудиоклипа;

П 13] — между объектом на первой странице документа и объектом на второй
странице с закладкой "2";

П [4] — между объектом на первой странице и Web-сайтом компании Corel;

П [5] — между объектом на второй странице документа и объектом на первой
странице с закладкой "1";

П [6] — между документом и файлом формата GIF, содержащим растровое
изображение, которое находится на второй странице;

П [7] — между документом и файлом объекта OLE на второй странице;

G [8] — между объектом на второй странице и Web-сайтом компании Corel.

Внизу докера Link Manager (Диспетчер связей) расположены четыре кнопки
управления. Поясним их назначение, указав в квадратных скобках номера, при-
веденные на рис. 3.8:

П [9| — кнопка Break Link to Externally Linked Object, внедряющая в тело доку-
мента растровое изображение, связанное с ним;

П [10] — кнопка Update the Selected Out of Date Object, обновляющая храня-
щуюся в документе копию низкого разрешения для измененного растрового
изображения, связанного с документом;

П [11] — кнопка Fix Broken Link to Externally Linked Object, позволяющая вос-
становить связь с файлом изображения, выбранного в докере, в случае пере-
мещения этого файла в другое место дисковой памяти компьютера или его
переименования;

П [12] — кнопка Open Link with its Associated Application, выполняющая одну из
двух функций:

• загрузка растрового изображения, имеющего выделенную связь с докумен-
том, в ассоциированное с ним приложение с целью его редактирования;

• запуск Web-обозревателя с загрузкой в него через Интернет документа,
указанного в выбранной гиперссылке;

П [13] — кнопка Refresh the Entire List, обновляющая все связи документа.

Если поместить указатель в некоторую строку списка связей и щелкнуть правеж
кнопкой мыши, то откроется контекстное меню рабочего окна докера Link
Manager, включающее девять команд:

П Select (Выбрать) — выполняет переход на ту страницу документа, где нахо-
дится объект-источник с выбранной в докере связью, и выделяет этот объект
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(данную операцию вы можете также выполнить двойным щелчком мыши
в строке связи, выделенной в докере);

П Open (Открыть) — загружает растровое изображение, связанное с докумен-
том, в ассоциированное с ним приложение или запускает Web-обозреватель
с загрузкой в него через Интернет документа, связанного с исходным;

О Resolve (Внедрить) — внедряет в тело документа растровое изображение, свя-
занное с ним;

П Update (Обновить) — обновляет хранящуюся в документе копию низкого
разрешения для измененного растрового изображения, связанного с доку-
ментом;

П Fix Broken Link (Восстановить нарушенную связь) — позволяет восстановить
связь с данным растровым изображением, которая была утеряна из-за пере-
мещения изображения в другое место дисковой памяти или удаления;

О Verify Link (Проверить связь) — проверяет наличие связи с текущим объек-
том при обновлении в поле Status значка связи;

П Refresh (Обновить связь) — выполняет проверку всех связей с объектами;

П Link Properties (Свойства связи) — выводит информацию о связанном рас-
тровом изображении и о его копии низкого разрешения, находящейся в до-
кументе;

П Display Large/Small Thumbnail (Отобразить большие/маленькие значки) -
изменяет размеры значков, отображаемых в рабочем окне докера.

Символы
Символом называется вторичный объект, образованный из некоторых исходных
объектов произвольных типов с целью упрощения его последующего копирова-
ния в документы, разрабатываемые в CorelDRAW 12, а также минимиза-
ции файловых размеров этих документов, содержащих многочисленные копии
символов.

В CorelDRAW 12 символы обладают следующими свойствами;

О они могут храниться в файлах двух типов:

• самих документов CorelDRAW 12 (собственные символы документов);

• библиотек символов, имеющих расширение csl (внешние символы)*;

G доступ к собственным символам текущего документа, а также ко внешним
символам производится через докер Symbol Manager (Диспетчер символов);

П из символа, выбранного в докере Symbol Manager, можно сформировать
в документе любое количество копий, называемых потомками символа или
просто потомками (instances);

1 В предыдущей версии программы CorelDRAW отсутствовала возможность работы
с внешними символами.
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П любой потомок, содержащийся в документе, допускает следующую обработку':

• перемещение в документе;

• трансформацию (масштабирование, поворот, наклон и зеркачьные развороты);

• регулировку прозрачности, выполняемую с помощью ползунка
Transparency (Прозрачность), находящегося на вкладке Symbol (Символ)
докера Object Properties (Свойства объекта);

П любой собственный символ можно отредактировать в окне документа.

^ Примечание

Следует отметить, что символы используются и в других известных графиче-
ских и мультимедийных приложениях, в частности, в программе векторной гра-
фики Adobe Illustrator и в программе создания видеоклипов Macromedia Flash.
В обеих этих программах возможности обработки символов и их потомков су-
щественно шире, чем в CorelDRAW 12.

Все операции с символами выполняются в CorelDRAW 12 с помощью докера
Symbol Manager, а также следующих восьми команд, составляющих подменю
Symbol (Символ) меню Edit (Правка):

G New Symbol (Новый символ) — формирует новый символ из выделенных
объектов документа;

О Edit Symbol (Редактировать символ) — подключает режим редактирования
символа, потомок которого выбран в документе;

G Finish Editing Symbol (Закончить редактирование символа) — отключает ре-
жим редактирования символа;

G Revert to Objects (Вернуться к объектам) — разрывает связь, установленную
между выбранным потомком и образующим символом;

П Symbol Manager (Диспетчер символов) — управляет открытием одноимен-
ного докера, предназначенного для работы с символами документа;

О Break Link (Разорвать связь) — преобразует в собственные символы документа
те используемые внешние символы, хранящиеся в файле библиотеки символов
(с расширением csl), потомки которых были предварительно выделены;

П Update From Link (Обновить через связь) — обновляет связи с теми внешни-
ми символами, потомки которых были выбраны в документе;

П Export Library (Экспортировать библиотеку) — формирует файл библиотеки
символов из тех символов документа, потомки которого были выделены
в документе.

Доступ к указанным командам имеется также через контекстное меню рабочего
окна документа, открываемое правой кнопкой мыши при установке указателя

1 Выделенный потомок отличается от обычного объекта документа тем, что его вы-
деляющие маркеры имеют синий цвет, а не черный.
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на выделенном потомке или на тех выбранных объектах документа, из которых
предполагается создание символа.

На рис. 3,9 показан пример работы с собственным символом документа, который
был образован из растрового изображения и текстовой надписи (этот символ изо-
бражен в области просмотра докера Symbol Manager, находящегося справа). Здесь
в документе находятся три потомка данного символа. Верхний потомок имеет те
же параметры, что и у символа; средний потомок наклонен, а нижний потомок,
который выделен, является частично прозрачным (уровень его прозрачности задан
в плавающем докере Object Properties (Свойства объекта)).

6 7 8 9 1 0

Рис. 3.9. Пример работы с собственным символом документа

Рассмотрим устройство докера Symbol Manager (Диспетчер символов), который
включает следующие элементы управления (их номера, приведенные на рис. 3.9,
даны здесь в квадратных скобках):

G [1] — область просмотра выделенного (активного) символа;

О [2] — кнопка Add Library, позволяющая выбрать на диске файл библиотеки
символов (с расширением csl) для включения его в одну из двух групп биб-
лиотек: локальных или сетевых, доступных для использования;

П [3] — кнопка Export Library, предназначенная для сохранения выделенных
символов в файле новой библиотеки символов;
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G [4] — область выбора библиотеки символов для загрузки в рабочее окно до-
кера, включающая:

• пункт с названием документа — собственная библиотека символов обра-
батываемого документа;

• раскрывающийся список Local Symbols — группа файлов локальных биб-
лиотек, скопированных в отдельную папку;

• список Network Symbols — группа файлов сетевых библиотек, хранящихся
в разных местах дисковой памяти компьютера, пути к которым заданы
пользователем;

О [5] — рабочее окно докера, обеспечивающее доступ к открытой библиотеке
символов;

П [6] — кнопка Insert Symbol, выполняющая вставку в центр текущей страницы
документа потомка того символа, который был выбран в рабочем окне докера;

D [7] — кнопка Edit Symbol, подключающая режим редактирования выбранного
символа в рабочем окне документа (для выхода из этого режима следует вы-
полнить команду Finish Editing Symbol (Закончить редактирование символа),
входящую:

• в подменю Symbol (Символ) основного меню Edit (Правка);

• в контекстное меню, раскрываемое правой кнопкой мыши в окне до-
кумента;

О [8] — кнопка Delete Symbol, удаляющая символ, выделенный в рабочем окне
докера;

О (9] — кнопка Scale to World Units, выполняющая масштабирование вставляе-
мого в документ потомка активного символа в соответствии с текущим мас-
штабом рисования;

Примечание

Масштаб рисования (drawing scale) представляет собой отношение между
фиктивными размерами страницы документа CorelDRAW 12, отображаемыми
на измерительных линейках, выведенных на экран, и реальными размерами
этой страницы. Данный масштаб можно задать с помощью кнопки Edit Scale,
находящейся на вкладке Document > Rulers (Документ > Линейки) диалогового
окна Options (Параметры).

П [10J — кнопка Purge Unused Definitions, удаляющая из открытой библиотеки
те символы, потомки которых отсутствуют в документе.

На рис. 3.10 показан пример работы в документе с двумя внешними символами,
входящими в библиотеку символов Syrnbol2.csl. Обратите внимание на то, что
эти символы нельзя редактировать, о чем свидетельствуют значки в виде пере-
черкнутого карандаша, находящегося в левой колонке рабочего окна докера
Symbol Manager.
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Рис. 3.10. Пример работы с внешними символами

Механизм OLE
В современных программах, предназначенных для разработки документов различ-
ных типов, широко используется механизм связывания и внедрения объектов
(Object Linking and Embedding — OLE). Он позволяет вставлять в документ, созда-
ваемый в некотором приложении, объекты, созданные в других приложениях, ко-
торые можно редактировать непосредственно в документе. Объекты, введенные
в документ с помощью указанного механизма, называются объектами OLE.

Механизм OLE работает следующим образом. Если в документ, обрабатываемый
соответствующим приложением, вставлен объект, созданный в другом приложе-
нии, то при его выборе произойдет запуск относящегося к нему приложения,
где этот объект может быть отредактирован. Внедрение объекта OLE заключается
в его вставке непосредственно в тело документа, а связывание — в установлении
связи между документом и файлом этого объекта.
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В программе CorelDRAW 12 механизм OLE реализован в полном объеме. Это оз-
начает, что вы можете его использовать как при вставке в активный документ
OLE-объектов (режим контейнера), так и при использовании объектов и докумен-
тов CorelDRAW 12 в документах иных типов, разработанных в других приложени-
ях (режим сервера). Этот механизм существенно расширяет функциональные
возможности программы, поскольку позволяет вводить в документ самые разно-
образные объекты, создание которых либо невозможно в CorelDRAW 12, либо
требует большого усилия и времени со стороны разработчика (диаграммы, мате-
матические формулы таблицы и т. п.).

Независимо от того, исходный объект какого типа был создан в другом прило-
жении (графический или текстовый), в качестве объекта OLE он будет пред-
ставлен в документе CorelDRAW 12 как графический объект, для которого
допускаются лишь три операции: перемещение, масштабирование и редакти-
рование.

Перечислим операции, которые можно выполнять при работе в режиме OLE,
указав при этом используемые команды программы:

CJ создание в активном документе нового объекта OLE с внедрением его в тело
документа — команда Edit V Insert New Object (Правка > Вставить новый обь-
ект), диалоговое окно которой показано на рис. 3.11;

О внедрение в документ существующего OLE-объекта, хранящегося в отдель-
ном файле, либо связывание этого объекта с документом — та же команда;

П внедрение в документ объекта OLE или установление с ним связи при усло-
вии, что данный объект является составной частью другого документа, хра-
нящегося в файле, — команда Edit > Paste Special (Правка > Специальная
вставка);

О редактирование объекта OLE — три команды подменю Object (Объект) меню
Edit (Правка):

• Изменить — переносит в окно программы CorelDRAW 12 инструменты
того приложения, в котором выбранный объект OLE создавался, с целью
его редактирования;

• Открыть — загружает данный OLE-объект в окно приложения, в котором
был создан;

• Преобразовать — позволяет преобразовать тип объекта OLE, в том числе
и отобразить его в документе в виде пиктограммы;

П изменение параметров связи, установленной с объектом OLE, -- команда
Edit > Links (Правка > Связи).

На рис. 3.12 изображено окно программы CorelDRAW 12 в режиме создания
диаграммы с помощью приложения Microsoft Graph 2000. Данная диаграмма
представляет собой внедренный объект OLE.

На рис. 3.13 показан вид диаграммы после ее создания (она выделена).

Рассмотрим порядок выполнения в CorelDRAW 12 основных операций, исполь-
зующих механизм OLE.
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в режиме создания нового объекта OLE
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Рис. 3.12. Пример создания в CorelDRAW 12 диаграммы,
являющейся внедренным объектом OLE
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Рис. 3.13. Вид диаграммы после ее создания

Создание нового объекта OLE
1. Выполните команду Edit* Insert New Object (Правка * Вставить новый объ-

ект), открыв ее диалоговое окно Insert New Object (Вставить новый объект)
с выбранным переключателем Создать новый (см. рис. ЗЛО).

2. Выберите в списке приложений, доступных для CorelDRAW 12 в режиме OLE,
то приложение, которое будет использовано при создании нового объекта
(в данном примере выбрана программа создания диаграмм Microsoft Graph 2000).

3. Закройте окно Insert New Object щелчком на кнопке ОК. При этом в окно
программы CorelDRAW 12 будут перенесены инструменты и команды задан-
ного приложения, что позволит вам создать в нем требуемый объект OLE.

4. Создайте объект, после чего восстановите состояние интерфейса
CorelDRAW 12, щелкнув в свободном месте области документа.

Вставка в документ объекта OLE,
целиком хранящегося в файле
1. Выполните команду Edit * Insert New Object, открыв ее окно Insert New Object.

2. Выберите переключатель Создать из файла, перейдя в режим вставки сущест-
вующего объекта OLE, хранящегося в файле.
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3. С помощью кнопки Browse (Просмотр) выберите на диске файл вставляе-
мого объекта.

4. Определитесь в отношении флажка Связь, при установке которого будет реа-
лизован режим связывания объекта, а при его снятии — режим его внедрения.

5. Вставьте на текущую страницу документа объект OLE, щелкнув на кнопке ОК.
При этом будет загружена первая по порядку страница того другого докумен-
та, который хранится в выбранном вами файле.

Вставка в документ части другого документа
как объекта OLE
1. Откройте документ-источник в приложении, в котором он был создан,

и скопируйте из него в буфер обмена Windows ту информацию, которая
должна быть вставлена в документ CorelDRAW 12 в качестве объекта OLE.

2. Выполните команду Edit > Paste Special (Правка > Специальная вставка), от-
крыв диалоговое окно Специальная вставка.

3. Выберите один из двух режимов вставки в документ объекта OLE: его вне-
дрение (переключатель Вставить) или связывание (кнопка Вставить связь).

4. Для режима внедрения выберите из списка в центре окна команды тот фор-
мат, в котором будет представлена вводимая информация.

5. Щелкните на кнопке подтверждения ОК.

Обработка объекта OLE
После того как в документе был создан новый объект OLE или вставлен такой
объект из файла, с ним можно выполнять следующие операции обработки:

П перемещать по области документа или по его толщине (см. разд. "Перемещение
объектов" гл. 7)\

О масштабировать (с помощью выделяющих маркеров);

О удалять (с помощью клавиши <Del>);

П редактировать.

Для перевода OLE-объекта в режим редактирования можно воспользоваться
следующими способами:

П выбрать рабочий инструмент Pick (Выбор) и сделать двойной щелчок на объ-
екте;

П выполнить команду Изменить или Открыть подменю Object (Объект) меню
Edit (Правка).

При этом откроется окно приложения, в котором данный объект создавался
и где он может быть обработан.
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Если объект OLE связан с текущим документом, то эту связь можно отредакти-
ровать, использовав для этого команду Edit > Links (Правка > Связи). В диалого-
вом окне команды предусмотрены следующие операции со связями:

П выбор режима обновления связи с файлом объекта: автоматический (пере-
ключатель Автоматическое) или ручной (переключатель По запросу);

П ручное обновление связи (кнопка Обновить сейчас);

П смена файл а- источника (кнопка Сменить источник);

П открытие файл а- источника в собственном приложении (кнопка Открыть ис-
точник) (проверка показала, что данный режим не всегда работает);

П разрыв связи, когда связанный объект внедряется в тело документа (кнопка
Разорвать связь).

Интерактивность
В программе CorelDRAW 12 предусмотрена возможность создания интерактив-
ных эффектов, которые реализуются в электронных версиях документов форма-
та HTML. Интерактивный эффект состоит в том, что вид электронного доку-
мента изменяется под воздействием мыши при вводе ее указателя или щелчке
в так называемой области срабатывания (горячей зоне). Эта область формируется
вокруг некоторого объекта в исходном документе, обрабатываемом в программе,

Чтобы создать интерактивный эффект, необходимо для выбранного объекта до-
кумента сформировать интерактивные состояния (rollover states), каждое из ко-
торых задает вид текущей страницы документа, возникающий при определенной
манипуляции мышью по отношению к данному объекту. Этому состоянию ста-
вится в соответствие либо исходный объект, либо его модифицированная копия,
либо другие объекты, сформированные в дополнение к копии или вместо нее.
Таким образом с помощью мыши происходит управление видом электронного
документа, создающее в данном документе эффект интерактивности.

В CorelDRAW 12 для любого объекта документа могут быть сформированы три
различных интерактивных состояния:

П Normal— исходное состояние (присутствует всегда), возникающее при от-
крытии электронного документа, когда в текущей области срабатывания нет
указателя мыши;

П Over— состояние, возникающее при вводе указателя в область срабатывания
при отжатой кнопке мыши;

О Down — состояние, возникающее при нажатии кнопки мыши в данной об-
ласти.

Перечислим средства программы, используемые при работе с интерактивными
состояниями:

П панель инструментов Internet (Интернет) — предназначена для вставки ги-
перссылок и закладок в объекты документа, а также для выполнения раз-
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личных операций с его интерактивными состояниями с целью подготовки
документа для его электронной публикации (см. разд. "Панели инструментов"
гл. 2)\

О команда Enable Rollover (Активизировать интерактивность) меню View
(Вид) — подключает в активном документе режим имитации воздействия
мыши на области срабатывания, предназначенные для работы в будущем
электронном документе с целью создания эффекта интерактивности;

П четыре команды подменю Rollover (Интерактивность) меню Effects (Эффекты):

• Create Rollover (Создать интерактивность) — задает режим формирования
в выбранном объекте интерактивных состояний трех типов: Normal (ис-
ходное состояние), Over (состояние, появляющееся при вводе указателя
в область срабатывания) и Down (состояние, появляющееся при нажатии
кнопки мыши в данной области);

• Extract Rollover Objects (Извлечь объекты интерактивности) — удаляет из
выбранного объекта его интерактивные состояния с размещением в доку-
менте тех дополнительных объектов, которые были сформированы ранее
для состояний Over и Down;

• Edit Rollover (Редактировать интерактивность) — открывает панель инст-
рументов Internet (Интернет) с переходом в режим редактирования интер-
активных состояний;

• Finish Editing Rollover (Завершить редактирование интерактивности) — ис-
пользуется для выхода из режима редактирования данных состояний.

Примечание

Перечисленные пять команд дублируются соответствующими кнопками панели
Internet (Интернет), расположенными в левой ее части.

На рис. 3.14 показаны три фрагмента окна программы CorelDRAW 12 с панелью
Internet и рабочим окном документа, каждое из которых соответствует опреде-
ленному интерактивному состоянию, созданному для векторного объекта
в форме эллипса. Состояние Normal характеризуется градиентной заливкой объ-
екта и наличием гиперссылки (она всегда задается для данного состояния);
состояние Over— увеличенным масштабом объекта, заливкой шаблоном, эф-
фектом тени и подключенным файлом аудиоклипа; состояние Down — также
увеличенным масштабом объекта и заливкой текстурой.

Таким образом, при вводе указателя в область срабатывания, относящуюся
к данному объекту, размеры эллипса увеличатся, его раскраска изменится и
появится тень, при этом будет звучать заданный вами клип. При щелчке мышью
в данной области тень исчезнет, раскраска объекта снова изменится и подклю-
чится удаленная связь с документом, указанным в гиперссылке.
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Рис. 3.14. Пример создания интерактивных состояний

Порядок создания интерактивных состояний
1. Откройте панель инструментов Internet (Интернет), расположив ее так, что-

бы она не закрывала область обработки рабочего окна документа (лучше
всего ее состыковать с панелью свойств).

2. Создайте и выделите в документе объект произвольного типа, для которого
будут создаваться интерактивные состояния.

3. Задайте на панели Internet (Интернет) для данного объекта требуемую управ-
ляющую и текстовую информацию из приведенного ниже перечня:

• гиперссылка (список Internet Address при выбранном пункте URL в спи-
ске Behavior);
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• закладка (список Internet Bookmark при выбранном пункте Bookmark
в списке Behavior);

• форма области срабатывания (кнопка Hotspot);

• контекстное сообщение, отображаемое в электронном документе рядом
с указателем (кнопка Alt Comments).

4. Сформируйте в выбранном объекте интерактивные состояния, щелкнув на
кнопке Create Rollover (первая слева).

5. Перейдите в режим редактирования данных состояний (кнопка Edit
Rollover, вторая слева).

6. Отредактируйте состояние типа Normal (одноименный пункт в списке Active
Rollover State). Для этого отрегулируйте положение в документе и форму ис-
ходного объекта, а в случае необходимости создайте дополнительные объекты.

7. Перейдите в состояние типа Over и отредактируйте его, обработав или уда-
лив исходный объект и сформировав (при необходимости) новые объекты.

8. Выберите состояние типа Down и выполните его редактирование (таким же
образом, как и состояние Over).

9. Отключите режим редактирования, щелкнув на кнопке Finish Editing
Rollover (четвертая слева).

10. Если вы собираетесь сохранять изображения документа в файле формата
Flash с использованием файлов аудиоклипов, связанных с интерактивными
состояниями, то сделайте следующее. Выберите в списке Behavior пункт
Sound. Для каждого из состояний типа Over и Down, выбираемых в списке
Active Rollover State, задайте связи с файлами используемых клипов (список
Add behavior и кнопка Sound File).

Примечание

Проверка показала, что в CorelDRAW 12 нельзя подключать файлы аудиокли-
пов к состояниям Down объектов с интерактивными состояниями. Заметим, что
такой недостаток отсутствовал в предыдущих версиях данной программы.

Цветовые форматы
Под цветовым форматом понимается способ кодирования цветов, которые ис-
пользуются в графических изображениях, созданных на компьютере. Различают
цветовые форматы четырех типов:

О форматы цветовых моделей;

О форматы систем соответствия цветов;

G табличные форматы;

О дуплексный формат.

Рассмотрим цветовые форматы, используемые в программе CorelDRAW 12.
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Форматы цветовых моделей
Цветовой моделью называется такой способ представления цветов в изображе-
нии, когда каждый цвет разделяется на базовые цветовые компоненты с указа-
нием их количественных значений. Наиболее распространенными цветовыми
моделями являются RGB (Red — красный, Green — зеленый, Blue — синий) и
CMYK (Cyan — голубой, Magenta — пурпурный, Yellow — желтый, ЫасК -
черный). Первая из этих моделей используется при отображении цветов на эк-
ране монитора и при сканировании, а вторая — в полиграфии.

Большинство цветовых моделей описывает цвета, входяшие в цветовые про-
странства соответствующих устройств, предназначенных для отображения или
вывода графической информации, хотя есть и такие модели, которые от этих
устройств не зависят (модель Lab).

Примечание

Цветовым пространством (цветовым охватом) называется совокупность цве-
товых и тоновых оттенков, которые воспроизводит или воспринимает то или
иное техническое или биологическое устройство. В документах, предназначен-
ных для печати, под цветовым пространством подразумевается пространство
цветовой модели CMYK.

Рассмотрим основные цветовые модели, применяемые в CorelDRAW 12.

Модель RGB используется в программе для оформления векторных, растровых
и текстовых объектов документа. Является моделью аддитивных цветов, созда-
ваемых излучающими элементами (например, люминофором монитора). Состо-
ит из трех базовых цветов: красного, зеленого и синего. Каждый из них описы-
вается 8 битами двоичной информации. Это позволяет описать 16,7 млн. цветов,
входящих в цветовое пространство данной модели. Применяется при работе
с монитором и сканером.

Модель CMYK также используется для оформления векторных, растровых и тек-
стовых объектов. Является моделью субтрактивных цветов, которые создаются
отражающими элементами (в частности, красками), Состоит их четырех базовых
цветов: голубого, пурпурного, желтого и черного, каждый из которых описыва-
ется 8 битами. Эти цвета соответствуют тем краскам, которые используются при
печати цветных изображений на типографском оборудовании. Применяется
в полиграфической печати.

Примечание

Аддитивными называются цвета, получаемые путем сложения цветовых со-
ставляющих (при излучении световых волн), а субтрактивными — путем их
вычитания (при поглощении этих волн).

Модель CMY используется лишь для оформления векторных и текстовых объек-
тов документа. Отличается от модели CMYK тем, что не содержит четвертой
составляющей, определяющей оттенки черного цвета. Это приводит к появле-
нию в изображении незначительных искажений в области темных тонов.
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Модель Lab применяется для оформления векторных, растровых и текстовых
объектов. Отображает цветовое пространство вне зависимости от конкретного
устройства ввода-вывода. Базируется на трех характеристиках цвета: светлоте и
двух дополнительных параметрах, характеризующих диапазоны изменения цве-
товых оттенков.

Модель HSB используется лишь для оформления векторных и текстовых объектов
документа. Описывает цветовое пространство, основанное на трех характеристиках
цвета: цветовом тоне (Hue), насыщенности (Saturation) и яркости (Brightness).

Модель Hexachrome применяется в современной технологии цветной полиграфи-
ческой печати, которая базируется на шести составных цветах. Кроме четырех
базовых цветов модели CMYK (голубого, пурпурного, желтого и черного),
в этой модели используются также оранжевый и зеленый компоненты. Благода-
ря этому значительно повышается качество цветопередачи в печатных оттисках.
В CorelDRAW 12 данная модель может использоваться в режиме печати доку-
мента с цветоделением.

Форматы систем соответствия цветов
Под системой соответствия цветов понимается библиотека цветовых образцов,
определенным образом названных и каталогизированных. Если при использова-
нии некоторой цветовой модели нужный цвет задается с помощью его числовых
параметров, то для рассматриваемого цветового формата выбор цветового об-
разца производится из выбранной библиотеки цветов (в CorelDRAW 12 таких
библиотек несколько). При этом вы можете руководствоваться лишь названием
цветового образца и его представлением на экране. Цвета, входящие в состав
такой системы, называются библиотечными.

Существуют два типа библиотечных цветов: стандартные (или плашечные)
и составные (полиграфические). Стандартные цвета (PANTONE и др.) пред-
ставляют собой цвета готовых красителей, для которых в режиме цветоделения
формируются отдельные пленки. С их помощью будет выполняться печать на
типографском оборудовании. Составные цвета (TRUMACH Color и др.) — это
такие библиотечные цвета, которые при выводе цветоделенных пленок разделя-
ются на базовые цветовые компоненты модели CMYK.

Примечание

Следует отметить, что термины "стандартные цвета" и "составные цвета" ино-
гда используют и в отношении способа формирования библиотечных цветов.
В таком случае цветовой образец называют стандартным, если он выбирался
из некоторого каталога, и составным, если этот образец представляет собой
комбинацию двух или трех базовых цветов CMYK-модели- При этом термины
"плашечный" и "полиграфический" не употребляются.

Стандартные цвета, выводимые в соответствующем диалоговом окне или докере
программы, будут отличаться от образцов составных цветов наличием белой
квадратной метки в левом нижнем углу.
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Любой составной цвет, используемый при оформлении векторного или тексто-
вого объекта документа, может быть преобразован в стандартный цвет с помо-
щью докера Color Styles (Цветовые стили) (см, разд. "Стили" настоящей главы,
подразд. "Цветовые стили"). Заметим при этом, что все используемые в документе
оттенки некоторого стандартного цвета будут выведены на печать в режиме цве-
тоделения на отдельную пленку.

В CorelDRAW 12 форматы систем соответствия цветов могут применяться при
оформлении лишь векторных и текстовых объектов документа.

Табличные форматы
Указанные форматы основаны на использовании так называемых цветовых таб-
лиц, которые представляют собой фиксированные наборы цветовых образцов
(не более 256), формируемые программой из некоторой цветовой палитры либо
из исходного изображения.

Табличный способ представления цветов в изображении заключается в следую-
щем. Каждый цветовой оттенок исходного изображения заменяется на наиболее
близкий к нему цветовой образец из предварительно сформированной или вы-
бранной цветовой таблицы. В результате такой обработки произойдет уменьше-
ние файлового размера изображения (при некотором ухудшении его качества),
что во многих случаях является определяющим, особенно при электронной пуб-
ликации документа. Такое преобразование также используют и при создании
в изображениях художественных эффектов.

В программе предусмотрены три табличных цветовых формата:

П черно-белый формат (Black and White) — раскраска изображения двумя цве-
тами: черным и белым (1 бит двоичной информации для каждого пиксела);

П формат оттенков серого (Grayscale) — раскраска оттенками серого цвета
(8 бит);

О формат палитровых цветов (Paletted) — раскраска цветовыми оттенками из
выбранной цветовой таблицы (не более 256 бит).

В графических программах с маркой Adobe вместо термина "палитровые цвета"
используется "индексированные цвета".

В CorelDRAW 12 табличные форматы могут использоваться при оформлении
любых графических и текстовых объектов документа.

Дуплексный формат
Дуплексный формат является комбинацией других цветовых форматов. Он ха-
рактеризуется раскраской предварительно обесцвеченного растрового изображе-
ния оттенками выбранных цветов (от одного до четырех), представленных в за-
данных форматах цветовых моделей или систем соответствия цветов. Если при
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раскраске изображения с дуплексным форматом использовались стандартные
цвета, то при печати в режиме цветоделения документа с этим изображением
каждый из этих цветов будет выведен на отдельную цветоделенную пленку.

В CorelDRAW 12 дуплексный формат может использоваться лишь при оформ-
лении растровых объектов документа.

Цветоделение
Цветоделение — это процесс разложения цветного изображения, созданного
в компьютере, на несколько одноцветных изображений при их распечатке на
пленках (их называют цветоделейными) с целью изготовления из них форм для
печати цветных оттисков на типографском оборудовании. Каждое составное
изображение, относящееся к отдельной форме, является растрированным. Это
означает, что оно состоит из точек (элементов) растра, имеющих определенные
форму, расположение и размеры. Геометрические параметры этих точек выби-
раются таким образом, чтобы при полиграфической печати они располагались
рядом, а не накладывались друг на друга, создавая красочное изображение,
идентичное или близкое к исходному изображению.

Если в документе используются цвета, относящиеся к тем или иным цветовым
моделям, то при печати в режиме цветоделения одной страницы документа будут
выведены четыре пленки для составных (полиграфических) цветов, представляю-
щих базовые цвета модели CMYK: голубой, пурпурный, желтый и черный. Если
же некоторые объекты документа раскрашены стандартными (плашечными) цве-
тами, то для каждого из них будет выведена отдельная пленка.

Таким образом, общее число цветоделенных пленок, а также их типы определя-
ются теми цветами, которые использовались при оформлении содержимого ак-
тивного документа. Это следует иметь в виду в процессе разработки документа.

Настройка всех параметров режима цветоделения выполняется на вкладке
Separations (Цветоделение) одноименного диалогового окна команды Print (Пе-
чать) меню File (Файл) (см. разд. "Печать документа" гл. 7, подразд. "Команда
Print"). В частности, здесь можно задать режим преобразования всех стандартных
цветов, используемых в документе, в составные цвета, установив для этого фла-
жок Convert spot colors to process.

В CorelDRAW 12 имеется большой выбор цветовых моделей и систем соответст-
вия цветов, влияющих на процесс цветоделения. При использовании различных
цветовых форматов необходимо иметь в виду следующее:

П для тех объектов документа, цветовые параметры которых представлены
в любых доступных цветовых моделях, цветоделение будет всегда выполнять-
ся составными цветами модели CMYK;

D если разрабатываемый документ предназначен для печати, то в качестве ра-
бочей цветовой палитры рекомендуется использовать палитру Default CMYK
palette, образцы цветов которой входят в цветовое пространство модели
CMYK;
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П для объектов, раскрашенных библиотечными цветами, цветоделение может
выполняться как составными, так и стандартными цветами в зависимости от
используемой библиотеки. К числу библиотек стандартных цветов графиче-
ского пакета CorelDRAW Graphic Suite 12, доступ к которым имеется через
докер Color Palette Browser (Просмотр цветовых палитр) программы
CorelDRAW 12, относятся следующие 15 библиотек:

• HKS Colors, HKS Е, HKS К, HKS N и HKS Z;

• PANTONE (R) solid coated, PANTONE (R) solid uncoated,
PANTONE (R) solid matte, PANTONE (R) metallic coated,
PANTONE (R) pastel coated и PANTONE (R) pastel uncoated;

• FOCOLTONE Colors, SpectraMaster Colors, TOYO COLOR FINDER и
DIC COLOR.

Печать с наложением и цветовые ловушки
Серьезной проблемой полиграфической печати является неточность совмеще-
ния печатных форм, которая приводит к появлению в цветном оттиске различ-
ных паразитных искажений типа муара и контуров. Для борьбы с этим нежела-
тельным явлением, возникающим в графических документах, предназначенных
для печати, используют два средства: печать с наложением и цветовые ловушки.

Печать с наложением — это такой режим печати некоторого объекта документа,
когда в другом объекте, на котором находится первый объект, не будет форми-
роваться пустая область (выбивка) в месте его расположения, следствием чего
яш1яется наложение красок при печати. Данный режим рекомендуется исполь-
зовать в тех случаях, когда наложение слоев краски не влечет за собой заметных
цветовых искажений в печатном оттиске. Указанное условие будет выполняться
для двух групп объектов:

П темных объектов, печатаемых поверх светлых;

П объектов с окраской, составной частью которой (для модели CMYK) являет-
ся цвет фонового изображения.

Цветовая ловушка — это небольшой контур вокруг объекта, который печатается
поверх другого объекта (фонового), имеющего выбивку. Введение цветовых ло-
вушек позволяет компенсировать ошибку в совмещении форм при печати на
типографском оборудовании.

Существуют два общих способа создания цветовых ловушек: растяжка и заслон-
ка. Растяжка состоит в увеличении размеров объекта, расположенного на фо-
новом, а заслонка — в уменьшении размера выбивки в фоновом объекте. Выбор
одного из этих способов зависит от соотношения тоновых параметров наложен-
ных объектов. Если светлый объект расположен на темном, то рекомендуется
использовать для него растяжку, в противном случае — заслонку.

В CorelDRAW 12 предусмотрен ручной способ задания режимов печати с наложе-
нием для отдельных векторных и текстовых объектов документа, а также автома-
тический способ формирования цветовых ловушек для всех объектов документа.
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Задание печати с наложением
Чтобы задать режим печати с наложением для некоторого объекта векторного
или текстового типа, расположенного поверх другого объекта документа (фоно-
вого), сделайте следующее.

1. Выделите верхний объект рабочим инструментом Pick (Выбор).

2. Установите на данном объекте указатель, откройте правой кнопкой контек-
стное меню и выполните одну из двух команд: Overprint Fill (Печатать поверх
заливки) или Overprint Outline (Печатать поверх контура). В первом случае
подключится режим печати с наложением (без выбивки) фонового объекта
в области заливки верхнего объекта, а во втором — в области его обводки.

3. Для печати с наложением во всей области расположения верхнего объекта
выполните ту из указанных выше двух команд, которая еще не применялась.

Если для выбранного объекта задействован какой-либо из указанных выше ре-
жимов, то слева от названия соответствующей команды будет стоять галочка.
При этом объект, печатаемый с наложением, будет отмечен на экране одним из
трех шахматных узоров, если активизирован режим отображения в документе
областей объектов, печатаемых с наложением (установлен флажок Show
overprints на вкладке Workspace > General (Рабочая область > Общие) диалогового
окна Options (Параметры)).

••«••••
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Рис. 3.15. Различные варианты печати с наложением:
1 — печать поверх заливки и обводки (без выбивок);

.2 — печать поверх обводки (с выбивкой для заливки);
3 — печать поверх заливки (с выбивкой для обводки);

4 — печать без наложения {с обеими выбивками)
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Для использования заданных режимов печати с наложением при печати доку-
мента с цветоделением следует на вкладке Separations (Цветоделение) диалого-
вого окна Print (Печать) установить флажок Preserve document overprints (Со-
блюдать печать поверх в документе).

На рис. 3.15 показаны различные варианты печати с наложением для вектор-
ного объекта прямоугольной формы. Слева изображен фрагмент документа
с фоновым прямоугольником желтого цвета. На нем расположены четыре
меньших одинаковых прямоугольника серого цвета, имеющих пунктирную об-
водку. Для трех верхних прямоугольников заданы различные режимы печати
с наложением. Справа показан цветоделенный печатный оттиск (для желтого
красителя), наблюдаемый в режиме предварительного просмотра.

Формирование цветовых ловушек
Автоматический способ задания цветовых ловушек будет функционировать
в процессе печати документа CorelDRAW 12 лишь при условии выбора драйвера
принтера типа PostScript, применение которого обязательно при выводе цвето-
деленных пленок для растровой печати составными цветами.

Перечислим элементы настройки данного режима, находящиеся на вкладке
Separations (Цветоделение) диалогового окна Print (Печать), в области Trapping
(Треппинг) (см. рис. 7.26):

О флажок Always overprint black (Всегда печатать черным поверх), при установ-
ке которого задается режим печати без выбивок для объектов черного или
почти черного цвета;

П флажок Auto-spreading (Автоматическое распространение), при установке
которого подключается режим автоматического формирования контуров для
векторных объектов (с цветами области их заливки), которые будут печатать-
ся поверх фоновых объектов. Данный режим будет использован лишь для тех
объектов, которые удовлетворяют следующим трем условиям:

• отсутствие собственных линий обводки;

• равномерная заливка внутренних областей;

• отсутствие цветовых ловушек, установленных в ручном режиме.

При установке флажка Auto-spreading появится доступ к следующим дополни-
тельным элементам:

П флажок Fixed width, позволяющий подключить режим задания фиксирован-
ной толщины контура ловушки;

П поле Maximum/Width, в котором указывается толщина контура в пунктах:
максимальная (при сброшенном флажке Fixed width) или фиксированная
(при установленном);

П поле Text above, используемое для ввода минимальной величины кегля тек-
стовых символов, для которых еще будут создаваться ловушки.
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Цветовое управление
В CorelDRAW 12 поддерживается современный механизм цветового управления,
который базируется на использовании стандартных цветовых профилей. Здесь
предусмотрены цветовые профили для монитора, сканера, цветных принтеров
(композитного принтера и принтера для цветоделения), а также для растровых
изображений документа, имеющих произвольные цветовые форматы.

Примечание

Композитным называется принтер, формирующий цветные оттиски. Частным
случаем композитного принтера является цветной струйный принтер.

Цветовой профиль представляет собой набор параметров, описывающих цветовое
пространство устройства отображения или вывода графической информации
(монитора, сканера или принтера). Этот набор, который сохраняется в файле,
предназначен для устранения или сведения к минимуму цветовых искажений
в изображении, возникающих при несоответствии цветовых пространств ис-
пользуемых устройств.

Примечание

Международный консорциум по цвету (ICC) разработал универсальный язык
описания параметров цветовых профилей с целью их унификации. Это позво-
лило определить стандартные цветовые профили для организации цветового
управления в различных графических и издательских программах, а также для
их внедрения в файлы графических документов.

Списки цветовых профилей, доступных для использования в CorelDRAW 12,
формируются тремя способами:

П в процессе установки программы;

П при ручном подключении внешних профилей, хранящихся на диске;

О при извлечении цветовых профилей из файлов графических документов
в режиме их импорта или открытии (см. гл. 7).

В программе реализованы следующие функции по работе с цветовыми профи-
лями:

О использование в документах цветовых профилей для монитора, сканера и
цветных принтеров, а также для внутреннего цветового пространства про-
граммы, заданного для цветовой модели RGB (Internal RGB space), в кото-
ром представляются все растровые изображения документа;

П применение к импортируемому растровому изображению профиля, содер-
жащегося в его файле;

Г) применение произвольного цветового профиля к выбранному в документе рас-
тровому изображению, имеющему один из семи цветовых форматов: черно-
белый, оттенков серого, дуплексный, палитровых цветов, RGB, Lab или CMYK;
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О извлечение профиля из файла, импортируемого или открываемого графиче-
ского документа с включением его в список профилей, доступных для ис-
пользования в CorelDRAW 12;

П внедрение цветового профиля в экспортируемое растровое изображение;

О внедрение профиля в сохраняемый документ.

Под режимом цветового управления CorelDRAW 12 понимается реализация сле-
дующих трех составляющих:

П управляющих связей между программой, информационными файлами (при
их импорте, сохранении и экспорте) и различными устройствами (монито-
ром, сканером и принтерами), указывающих направления, по которым будет
производиться цветовая коррекция;

О цветовых профилей, обеспечивающих цветовую коррекцию для заданных
связей;

G способа преобразования цветовых пространств, с помощью которого произ-
водится изменение базовых цветовых параметров изображения при его пере-
воде из одного цветового пространства в другое.

Выбор режима цветового управления производится в диалоговом окне Color
Management (Цветовое управление), которое открывается одноименной коман-
дой меню Tools (Инструменты).

На рис. 3.16 показан вид данного окна на экране в момент установления управ-
ляющей связи между принтером для цветоделения и монитором, моделирую-
щим цвета печатного оттиска, получаемого при типографской печати.

Данное окно представляет собой схему возможного взаимодействия составных
частей компьютерной системы с работающей программой CorelDRAW 12, по
которой допускается выполнение цветовой коррекции изображений. Между от-
дельными составными частями такой системы пользователь может задать управ-
ляющие связи.

Для активизации некоторой связи достаточно поместить указатель на соответст-
вующую стрелку серого цвета, ознакомиться (при необходимости) с содержани-
ем контекстной подсказки, которая появится при этом на экране, и щелкнуть
мышью, в результате чего цвет стрелки станет красным. Аналогичным образом
выполняется и обратная операция по удалению связи (при щелчке на красной
стрелке она станет серой). Отсутствие красных стрелок в окне означает полное
отключение режима цветового управления программой.

Чтобы задать цветовые профили, которые будут использоваться в программе по
умолчанию, необходимо последовательно открыть в окне пять списков профи-
лей, представленных названиями текущих профилей по умолчанию, а также
черными треугольными метками справа от них. Четыре таких списка располо-
жены рядом с изображениями, к которым они относятся: монитора, сканер»
и двух принтеров: композитного и с цветоделением.

Пятый список профилей находится в центре (под схемой цветовой модели
RGB, представленной в виде трех частично перекрытых цветных кружков). Этот
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профиль позволяет настроить цветовое пространство RGB, используемое в ка-
честве внутреннего пространства программы для всех изображений документа.
Если нужный профиль в выбранном вами списке отсутствует, то его можно по-
пытаться найти на диске, щелкнув мышью в пункте Get profile from disk (Загру-
зить профиль с диска).

^~~ Примечание

Файлы цветовых профилей, входящих в состав указанных списков, хранятся
в папке Color, вложенной в основную папку графического пакета CorelDRAW
Graphic Suite 12.

Coloi Management х

Generic internal RGB profile

Generic CMYK printer profile v Generic offset separations profile

•to
Choose this option to make
your monitor simulate the output
of your separations printer

Genetic Profile

S,tyle: ; Default settings Cancel Help

Рис. 3.16. Диалоговое окно Color Management

Если щелкнуть мышью на схеме цветовой модели RGB, то откроется диалого-
вое окно Advanced Settings (Расширенные настройки), содержащее следующие
элементы настройки:

П раскрывающийся список Rendering Intent (Цель обработки), предназначен-
ный для выбора способа преобразования цветовых пространств, который за-
дает алгоритм изменения величин базовых цветовых параметров изображения
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при переходе из одного цветового пространства в другое; включает следую-
щие пункты:

• Absolute Colorimelric — сохраняет неизменными те цветовые оттенки ис-
ходного изображения, которые входят в новое цветовое пространство;

• Automatic — автоматически выбирает тот способ преобразования цветовых
пространств, который обеспечивает минимальные цветовые искажения
для конкретного изображения;

• Perceptual — сохраняет визуальное соотношение между цветовыми оттен-
ками исходного и конечного изображений при возможном изменении их
числовых значений;

• Relative Colorimetric — сохраняет неизменными цветовые оттенки исход-
ного изображения, входящие в новое цветовое пространство, с последую-
щим смещением всех цветов результирующего изображения с целью сов-
падения его белой точки (наиболее яркого участка) с белой точкой
исходного изображения;

• Saturation — сохраняет соотношения между уровнями насыщенности цве-
тов при возможном изменении цветовых оттенков;

П список Color Engine (Цветовой механизм), позволяющий выбрать одну из
двух систем цветового управления, с помощью которых производится цвето-
вая коррекция документа при переходе из одного цветового пространства
в другое:

• Kodak Digital Science CMM — система цветового управления, используе-
мая в CorelDRAW 12;

• Microsoft ICM 2.0 CMM — система цветового управления операционной
системы Windows XP.

При щелчке на значке с изображением некоторого устройства (или страниц доку--
мента) откроется диалоговое окно с расширенными параметрами цветового управ-
ления данным устройством. В частности, для значка монитора таким окном явля-
ется Advanced Display Settings (Расширенные настройки монитора). В этом окне
вы можете задать параметры, относящиеся к отображению цветов документа, не
входящих в цветовое пространство модели CMYK, в том чис/? служебный цвет и
уровень прозрачности дополнительного изображения, наносимого на области ис-
ходного изображения, находящиеся вне цветового охвата. Однако для того чтобы
выполнить такую операцию, необходимо предварительно установить в исходном
окне Color Management (Цветовое управление) связь между монитором и одним и:;;
принтеров, означающую имитацию на экране цветов печатных оттисков. В про
тивном случае вы не сможете задать указанные параметры.

В левой нижней части окна Color Management находится список Style (Стиль)
с двумя кнопками справа от него. В этом списке вы можете выбрать один го
стандартных стилей цветового управления CorelDRAW 12. Каждый такой стиль
представляет собой некоторый режим цветового управления, параметры кото
рого зафиксированы в файле под определенным именем. Кнопка со знаком



126 Глава 3

"плюс" используется для создания нового стиля с параметрами текущего режима
цветового управления, а кнопка со знаком "минус" — для удаления из списка
выбранного стиля.

Применение требуемого цветового профиля к выбранному в документе растро-
вому изображению производится с помощью команды Bitmaps > Mode > Apply
ICC Profile (Растровая графика > Режим > Применить профиль ICC). В результа-
те произойдет цветовая коррекция изображения, вызванная соответствующим
преобразованием его цветового пространства. (См. разд. "Общие операции" гл. 5,
подразд. "Применение цветового профиля".)

События
Под термином события здесь понимается системная функция CorelDRAW 12,
состоящая в фиксации в оперативной памяти компьютера промежуточных со-
стояний обрабатываемого документа для возможного возвращения к любому из
них с целью изменения порядка выполнения последующих операций. Данная
функция существенно повышает эффективность обработки сложного документа,
в котором часто приходится отменять одни варианты обработки объектов и за-
менять их другими.

Функция "события" реализуется с помощью докера Undo (Отмена), который от-
крывается одноименной командой подменю Dockers (Докеры) меню Window
(Окно).

Известно, что с помощью кнопки Undo (Отмена) стандартной панели также
можно отменить целую группу операций и перейти к любому предыдущему со-
стоянию открытого документа. Однако данная кнопка не позволяет отображать
выбранное промежуточное состояние в рабочем окне документа до выполнения
операции отмены. В этом и состоит основное преимущество рассматриваемого
докера.

Докер Undo состоит из следующих элементов (см. рис. 3.17):

01 рабочее окно, в котором находится список операций, выполнявшихся при
обработке активного документа после его открытия;

О две кнопки управления внизу докера.

Каждая строка списка операций состоит из двух элементов; значка операции
(слева) и ее названия. Если в одной из строк списка щелкнуть мышью, то про-
изойдет следующее:

G строка с выбранной операцией выделится синим цветом;

П все нижележащие строки станут серыми, при этом соответствующие им опе-
рации будут отменены;

П в рабочем окне документа отобразится предыдущее состояние документа,
которое имело место при выполнении выбранной операции.

Таким образом вы можете перейти к любому промежуточному состоянию от-
крытого документа. Как только в документе, находящемся в выбранном проме-
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жуточном состоянии, будет выполнено некоторое действие, то все последующие
строки серого цвета, представляющие отмененные операции, будут удалены из
докера.

На рис. 3.17 показан пример использования докера Undo (Отмена). В левой час-
ти рисунка показан вид обрабатываемого документа и данного докера после вы-
полнения последней операции, а в правой — при выделении в окне докера не-
которого промежуточного состояния документа.

1 2

Рис. 3.17. Докер Undo в процессе работы

Поясним назначение двух кнопок управления докера Undo, указав в квадратных
скобках их номера, приведенные на рис. 3.17:

О [1] — кнопка Save List to a VBA macro, подключающая режим сохранения
в файле макрокоманды VBA, автоматически формируемой из набора опера-
ций, представленных в рабочем окне докера;

ГЛ [2] — кнопка Clear Undo list, удаляющая из окна докера весь список опера-
ций, за исключением первой строки File New (Новый файл), означающей от-
крытие документа,

Макрокоманды и сценарии
Для автоматизации обработки документов в CorelDRAW 12 предусмотрено ис-
пользование макрокоманд и сценариев. Рассмотрим эти функции программы.

Макрокоманды
Макрокоманда (macro) представляет собой набор команд, зафиксированный под
определенным именем в памяти компьютера, с помощью которого автоматизируется
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многократное выполнение заданных операций в некоторой прикладной
программе (в нашем случае — операций обработки графических документов
в CorelDRAW 12). Макрокоманды могут использоваться самостоятельно или
включаться в состав других макрокоманд более высокого уровня.

В CorelDRAW 12 предусмотрены широкие возможности работы с макрокоман-
дами, которые базируются на применении двух альтернативных средств обра-
ботки макрокоманд:

П универсального программного средства Microsoft Visual Basic 6.3, предназна-
ченного для автоматизации обработки документов в различных приложениях
(рабочее название данной программы — Visual Basic for Applications или со-
кращенно VBA);

Если аббревиатура VBA используется рядом со словом "макрокоманда", то это
означает, что данная макрокоманда была создана с помощью указанного выше
средства.

П утилиты Corel SCRIPT Editor (Редактор сценариев Corel), которая в послед-
них двух версиях программы CorelDRAW не используется для создания но-
вых макрокоманд (сценариев),

С помощью программы Visual Basic for Applications, устанавливаемой вместе
с CorelDRAW 12, можно выполнять следующие операции с макрокомандами:

О записывать макрокоманды в процессе обработки документа с их последую-
щим сохранением в файле текущего документа или в отдельном файле
с расширением gms, представляющем собой глобальный источник макроко-
манд (такой файл называют модулем GMS);

П воспроизводить любую макрокоманду, входящую в состав одного из откры-
тых документов CorelDRAW 12 либо относящуюся к одному из модулей
GMS, имеющихся на компьютере;

О составлять тексты макрокоманд и выполнять их отладку в окне программы
Visual Basic.

Для работы с макрокомандами VBA, созданными в Visual Basic, используются
следующие средства CorelDRAW 12:

П панель инструментов Visual Basic for Applications (Visual Basic для приложе-
ний) (см. разд. "Панели инструментов" гл. 2)\

П команды, входящие в подменю Visual Basic меню Tools (Инструменты),
к числу которых относятся: Play (Воспроизвести), Record (Записать), Pause
(Приостановить), Stop (Остановить), Visual Basic Editor (Редактор Visual
Basic), Security (Безопасность) и Add-in Manager (Диспетчер дополнений).

Настройка параметров режима работы с макрокомандами VBA производится на
вкладке Workspace > VBA (Рабочая область > VBA) диалогового окна Options
(Параметры) (см. разд. "Параметры интерфейса"м. 8).
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Сценарии
Сценарий (script) — это та же макрокоманда, но созданная с помощью специа-
лизированного средства Corel SCRIPT Editor (Редактор сценариев Corel). Не-
смотря на универсальность и широкие возможности программы Visual Basic for
Applications, разработчики CorelDRAW 12 все же не отказались от использова-
ния сценариев. Это связано со следующими преимуществами сценариев по
сравнения с макрокомандами VBA:

П сохранение записанного сценария в отдельном файле (с расширением esc),
что позволяет передавать отдельные сценарии другим пользователям, а также
идентифицировать их по названиям этих файлов;

О наличие значков сценариев с изображениями обработанных ими объектов и
их названий, что существенно облегчает поиск требуемых сценариев с целью
их воспроизведения;

П высокая степень защищенности сценариев от вирусов, что не требует приня-
тия специальных защитных мер, как при работе с макрокомандами VBA.

К сожалению, в состав двух последних версий программы CorelDRAW не входят
библиотеки готовых сценариев. Такие сценарии использовались только в CorelDRAW
версий 10 и ниже. Чтобы с ними можно было работать в CorelDRAW 12. необходи-
мо скопировать их файлы в отдельную папку из папки Draw\Scripts, вложенной
в основную папку программы CorelDRAW 10.

Следует отметить, что разработчики программы отказались от функций записи,
написания и отладки сценариев, которые имелись в девятой и более ранних
версиях CorelDRAW, что, по-видимому, связано с полномасштабным использо-
ванием программы Microsoft Visual Basic 6.3.

Примечание

В CorelDRAW 10/11/12 отсутствует возможность пополнения существующих
библиотек сценариев самим пользователем. По мнению автора, никакого прак-
тического смысла в замене специализированной программы Corel SCRIPT
Editor на универсальную Visual Basic for Applications не было.

Для работы со сценариями используются следующие средства CorelDRAW 12:

G команда Run Script (Запустить сценарий) меню Tools (Инструменты), позво-
ляющая выбрать на диске файл требуемого сценария (с расширением esc)
с целью его воспроизведения;

П дополнительный докер Corel Scripts Manager (Диспетчер сценариев Corel),
доступ к которому имеется с помощью кнопки Scripts (Сценарии), которую
пользователь должен предварительно установить на одну из панелей инстру-
ментов.

Докер Corel Scripts Manager предназначен для визуального поиска сценариев,
находящихся в папке Scripts и вложенных в нее других папках, а также для вос-
произведения выбранного сценария.

5 Зак. 2J О
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На рис. 3.18 зафиксирован момент вывода на новую панель инструментов кноп-
ки открытия докера Corel Scripts Manager. Данная операция выполняется на
вкладке Workspace > Customization > Commands (Рабочая область > Настройка >
Команды) диалогового окна Options (Параметры), где вы должны в верхнем
списке выбрать пункт Window (Окно), а в рабочем окне — элемент Corel Scripts
Manager, который следует перетащить мышью в рабочее окно документа.
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Рис. 3.18. Пример вывода на новую панель кнопки Scripts

Файловые форматы
В этом разделе приведена краткая справочная информация по всем файловым
форматам, используемым в CorelDRAW 12.

Векторные форматы
Общее количество — 39.
G AI ' — векторный файловый формат (полное название — Adobe Illustrator,

расширение — ai). Разработан компанией Adobe Systems Incorporated для ис-
пользования в Windows и Macintosh. Предназначен для хранения графиче-
ских документов, создаваемых в программе векторной графики Adobe
Illustrator, а также для переноса этих документов в другие приложения. Име-
ет несколько разновидностей, определяемых версиями программы, для кото-
рых документы предназначены. Близок к векторному формату FH, который



Технологические возможности CorelDRAW 12 131

используется приложением Macromedia FreeHand. В CorelDRAW 12 применя-
ется следующими командами меню File (Файл): Орел (Открыть), Save As
(Сохранить как), Import (Импорт) и Export (Экспорт). Обозначение в про-
грамме — AI - Adobe llustrator.

П CDR — векторный файловый формат (полное название — CorelDRAW, рас-
ширение — cdr). Используется для хранения и переноса графических доку-
ментов (с векторной, растровой и текстовой информацией), создаваемых
в программе векторной графики CorelDRAW. Имеет несколько разновидно-
стей, определяемых версиями программы. Существенно отличается от фор-
мата AI. В CorelDRAW 12 применяется следующими командами меню File
(Файл): Open (Открыть), Save As (Сохранить как) и Import (Импорт). Обо-
значение в программе — CDR - CorelDRAW.

П CDT- векторный файловый формат (полное название CorelDRAW
Template, расширение — cdt). Отличается от формата CDR лишь тем, ч го
в нем хранятся файлы шаблонов (шаблонных документов), на основе кото-
рых в CorelDRAW 12 формируются новые обычные документы, обрабаты-
ваемые в программе. В CorelDRAW 12 применяется следующими командами
меню File (Файл): Open (Открыть) и Save As (Сохранить как). Обозначение
в программе - CDT - CorelDRAW Template,

П CDX'— векторный файловый формат (полное название CorelDRAW
Compressed, расширение — cdx). Отличается от формата CDR меньшим раз-
мером файла документа благодаря использованию сжатия информации при
ее сохранении. В CorelDRAW 12 применяется следующими командами меню
File (Файл): Open (Открыть) и Import (Импорт). Обозначение в программе -
CDX - CorelDRAW Compressed.

О CGM — векторный файловый формат (полное название — Computer Graphics
Metafile, расширение — cgm). Предназначен для обмена между различными
приложениями, работающими под Windows, сложной векторной и растровой
графикой, а также сопутствующими текстовыми данными. Поддерживает
цвета RGB. Обычно используется при работе с графикой только одного тина.
В CorelDRAW 12 применяется следующими командами меню File (Файл):
Open (Открыть), Save As (Сохранить как), Import (Импорт) и Export (Экс-
порт). Обозначение в программе — CGM - Computer Graphics Metafile.

П CLK —- векторный файловый формат (расширение — elk). Является собствен-
ным форматом программы создания видеоклипов Corel R.A.V.E., входящей
в состав графического пакета CorelDRAW Graphic Suite. Предназначен для со-
хранения анимационных графических документов с целью их последующей
обработки в указанной программе. В CorelDRAW 12 применяется следующими
командами меню File (Файл): Open (Открыть), Save As (Сохранить как) и
Import (Импорт). Обозначение в программе — CLK - Corel R.A.V.E.

О СМХ— векторный файловый формат (полное название — Corel Presentation
Exchange, расширение — cmx). Является метафайловым форматом, поддер-
живающим векторную, растровую и текстовую информацию, а также цвета
RGB, CMYK и Pantone. Предназначен для сохранения документов, создан-
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ных в программе CorelDRAW, с целью их последующего переноса в другие
приложения с маркой Corel. В CorelDRAW 12 применяется следующими ко-
мандами меню File (Файл): Open (Открыть), Save As (Сохранить как), Import
(Импорт) и Export (Экспорт). Обозначения в программе — СМХ - Corel
Presentation Exchange и СМХ - Corel Presentation Exchange 5.0.

О СРХ — векторный файловый формат (расширение — срх). Является собст-
венным форматом программы Corel ArtShow 5. Поддерживает векторную и
растровую графику. В CorelDRAW 12 применяется следующими командами
меню File (Файл): Open (Открыть) и Import (Импорт). Обозначение в про-
грамме — СРХ - Corel СМХ Compressed.

П CSL — векторный файловый формат (полное название — Corel Symbol
Library, расширение — csl). Предназначен для хранения библиотек символов,
формируемых в CorelDRAW 12, с целью использования содержимого этих
библиотек при разработке в данной программе различных документов.
В CorelDRAW 12 применяется тремя командами меню File (Файл): Open (От-
крыть), Save As (Сохранить как) и Import (Импорт), а также командой Export
Library (Экспортировать библиотеку) подменю Symbol (Символ) меню Edit
(Правка). Обозначение в программе — CSL - Corel Symbol Libtary.

П DES — векторный файловый формат (полное название — Corel DESIGNER,
расширение — des). Является собственным форматом программы векторной
графики Corel DESIGNER (бывшей Micrografx Designer). В CorelDRAW 12
применяется следующими командами меню File (Файл): Open (Открыть),
Save As (Сохранить как) и Import (Импорт). Обозначение в программе -
DES - Corel DESIGNER.

П DRW— векторный файловый формат (расширение — drw). Является собст-
венным форматом программы векторной графики Micrografx Designer 2.x, 3.x,
работающей под Windows. В CorelDRAW 12 применяется следующими ко-
мандами меню File (Файл): Open (Открыть) и Import (Импорт). Обозначение
в программе — DSF, DRW - Corel/Micrografx Designer.

О DSF— векторный файловый формат (расширение — dsf). Векторный файло-
вый формат DSF является собственным форматом графической программы
Micrografx Designer 6.0. В CorelDRAW 12 применяется следующими команда-
ми меню File (Файл): Open (Открыть) и Import (Импорт). Обозначение
в программе — DSF, DRW - Corel/Micrografx Designer.

П DWG — векторный файловый формат (полное название — AutoCAD Drawing
Database, расширение — dwg). Предназначен для сохранения и переноса век-
торной графики, создаваемой в программе AutoCAD. В CorelDRAW 12 при-
меняется следующими командами меню File (Файл): Open (Открыть), Save As
(Сохранить как), Import (Импорт) и Export (Экспорт). Обозначение в про-
грамме - DWG - AutoCAD.

О DXF ~ векторный файловый формат (полное название — Document Exchange
Format, расширение — dxf). Предназначен для переноса графических доку-
ментов между приложениями, создающими трехмерную графику (в частно-
сти, 3D Studio MAX и AutoCAD), а также для загрузки таких документов
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в программы векторной графики. В файлах данного формата хранится лишь
векторная информация (растровые изображения документа содержатся в от-
дельных файлах, связанных с исходным). В CorelDRAW 12 применяется сле-
дующими командами меню File (Файл): Open (Открыть), Save As (Сохранить
как), Import (Импорт) и Export (Экспорт). Обозначение в программе -
DXF - AutoCAD.

П EMF' — векторный файловый формат (полное название — Enhanced Metafile
Format, расширение — emf)- Является улучшенной версией векторного фор-
мата WMF, используемого в Windows. Поддерживает векторную и растровою
графику, а также цвета RGB. В отличие от формата WMF обеспечивает по-
вышенное качество передачи заливок и обводок объектов векторной графи-
ки, а также меньший размер файла. В CorelDRAW 12 применяется следую-
щими командами меню File (Файл): Open (Открыть), Save As (Сохранить
как), Import (Импорт) и Export (Экспорт). Обозначение в программе -
EMF - Enhanced Window Metafile.

П EPS - векторный файловый формат (полное название - Encapsulated
PostScript, расширение - eps). Основан на языке программирования
PostScript. Позволяет сохранять в файле любую графическую и текстовую
информацию с целью ее передачи в другие приложения или распечатки.
Данный формат широко используется многими графическими и издатель-
скими приложениями благодаря его аппаратной независимости и высокому
качеству печатаемых изображений. Допускает возможность сохранения
в файле двух версий изображений: I) постскриптового изображения, закоди-
рованного на языке PostScript и содержащего полную информацию о графи-
ческих и текстовых объектах документа; 2) растровой копии данного изобра-
жения, отображаемой на экране при отсутствии в используемой программе
интерпретатора PostScript для вывода на экран его исходной копии.
В CorelDRAW 12 применяется следующими командами меню File (Файл):
Open (Открыть), Import (Импорт) и Export (Экспорт). Обозначение в про-
грамме - EPS - Encapsulated PostScript и PS, PRN, EPS - PostScript
Interpreted.

П FH — векторный файловый формат (полное название — FreeHand, расшире-
ние — Ri< номер eepcuu>). Предназначен для хранения графических докумен-
тов, создаваемых в программе векторной графики Macromedia FreeHand,
а также для переноса этих документов в другие приложения. Близок к век-
торному формату AI, используемому в Adobe Illustrator. Имеет несколько
разновидностей, определяемых версиями программы FreeHand (номер вер-
сии отображается в файловом расширении). В CorelDRAW 12 применяется
следующими командами меню File (Файл): Open (Открыть) и Import (Им-
порт). Обозначение в программе — FH - Macromedia Freehand.

П flash — векторный файловый формат (полное название — Shockwave Flash,
расширение — swf). Широко используется при создании видеоклипов благода-
ря поддержке анимационных, интерактивных и звуковых эффектов, а также
редактируемой текстовой информации. Обеспечивает небольшие размеры
файлов. Доступен для использования многими Web-обозревателями, что
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позволяет вставлять видеоклипы данного формата в Web-страницы.
В CorelDRAW 12 применяется следующими командами меню File (Файл):
Export (Экспорт) и Flash embedded in HTML (Flash, внедренный в HTML),
вторая из которых входит в подменю Publish To The Web (Публикация на
Web). Обозначение в программе — SWF - Macromedia Flash.

О FMV'-- векторный файловый формат (полное название — Frame Vector
Metafile, расширение — fmv). Поддерживает векторную графику и текстовую
информацию. В CorelDRAW 12 применяется следующими командами меню
File (Файл): Open (Открыть), Save As (Сохранить как), Import (Импорт) и
Export (Экспорт). Обозначение в программе — FMV - Frame Vector Metafile.

П GEM— векторный файловый формат (расширение— gem). Позволяет со-
хранять векторные объекты (графические и текстовые), преобразуя текстовые
символы в кривые. В CorelDRAW 12 применяется следующими командами
меню File (Файл): Open (Открыть), Save As (Сохранить как), Import (Импорт)
и Export (Экспорт). Обозначение в программе — GEM - GEM File.

П HPGL — векторный файловый формат (полное название — Hewlett-Packard
Graphics Language, расширение — pit). Представляет собой язык векторной
графики, предназначенный для печати на плоттерах. Требует установки спе-
циальных шрифтов (обычные шрифты типа True Type и Туре 1 здесь
не используются). В CorelDRAW 12 применяется следующими командами
меню File (Файл): Open (Открыть), Save As (Сохранить как), Import (Импорт)
и Export (Экспорт). Обозначение в программе — PLT - HPGL Plotter File.

О HTML — векторный файловый формат (полное название - HyperText
Markup Language, расширение — htm). Предназначен для создания электрон-
ного документа с целью его публикации на Web. Электронный документ
представляет собой связанный набор Web-страниц, являющихся копиями
страниц исходного документа. Текстовая и управляющая информация в та-
ком документе сохраняется в HTML-файлах, а графическая — в файлах сле-
дующих форматов: GIF, JPEG, PNG и Flash. В CorelDRAW 12 применяется
следующими командами меню File (Файл): Open (Открыть), Import (Импорт).
HTML и Flash embedded in HTML (Flash, внедренный в HTML), последние
две из которых входят в подменю Publish To The Web (Публикация на Web).
Обозначение в программе — HTM - HyperTexl Markup Language.

П МЕТ— векторный файловый формат (расширение — met). В CorelDRAW 12
применяется следующими командами меню File (Файл): Open (Открыть) и
Import (Импорт). Обозначение в программе — МЕТ - MET MetaFile.

О NAP— векторный файловый формат (расширение — пар). В CorelDRAW 12
применяется следующими командами меню File (Файл): Open (Открыть) и
Import (Импорт). Обозначение в программе — NAP - NAP MetaFile.

О PAT— векторный файловый формат (расширение — pat). Векторный файло-
вый формат PAT допускает сохранение векторной и растровой графики.
В рассматриваемой программе используется для сохранения многоцветных
шаблонов для заливки, представляющих собой векторные изображения.
В CorelDRAW 12 применяется следующими командами меню File (Файл):
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Open (Открыть) и Save As (Сохранить как). Обозначение в программе PAT -
Pattern File.

П PDF— векторный файловый формат (полное название — Portable Document
Format, расширение — pdf). Основан на языке PostScript, Предназначен для
передачи графической и текстовой информации между различными прило-
жениями, для вывода графических документов на печать, а также для их
электронной публикации с помощью известной программы Acrobat Reader.
Данный формат характеризуется более компактным кодом по сравнению
с форматом EPS. Он допускает сохранение в файле документа различной
управляющей информации, необходимой при его электронной публикации
(гиперссылки, закладки, примечания, связи с исполняемыми файлами
и т. п.). В CorelDRAW 12 применяется следующими командами меню File
(Файл): Open (Открыть), Import (Импорт) и Publish To PDF (Публикация
в формате PDF). Обозначение в программе — PDF - Adobe Portable Document
Format.

О PFB — векторный файловый формат (расширение — pfb). Используется для
сохранения контуров шрифтов типа PostScript (Type I), метрика которых со-
храняется в файлах с расширением pfm. В CorelDRAW 12 применяется
командой Export (Экспорт) меню File (Файл). Обозначение в программе -
PFB - Adobe Type I Font.

d PIC— векторный файловый формат (расширение — pic). Является графиче-
ским форматом программы Lotus 1-2-3, предназначенной для разработки
электронных таблиц. В CorelDRAW 12 применяется следующими командами
меню File (Файл): Open (Открыть) и Import (Импорт). Обозначение в про-
грамме — PIC - Lotus Pic.

О PICT— векторный файловый формат (полное название — Macintosh PICT,
расширение — pet). Разработан фирмой Apple Computer Inc. для компьюте-
ров Macintosh. Является собственным форматом программы QuickDraw. Ши-
роко используется для обмена графической информации между различными
приложениями (поддерживает векторную и растровую графику). Особенно
эффективен при сохранении больших областей векторных объектов с равно-
мерной заливкой. В CorelDRAW 12 применяется следующими командами
меню File (Файл): Open (Открыть), Save As (Сохранить как), Import (Импорт)
и Export (Экспорт). Обозначение в программе — РСТ - Macintosh PICT.

О РРТ— векторный файловый формат (полное название — PowerPoint, расши-
рение ppt). Является собственным форматом программы Microsoft
PowerPoint, предназначенной для разработки презентаций. В CorelDRAW 12
применяется следующими командами меню File (Файл): Open (Открыть)
и Import (Импорт). Обозначение в программе — РРТ - Microsoft PowerPoint

П PRN— векторный файловый формат (полное название — Print, расширение -
ргп). Является метафайловым форматом, основанным на языке PostScript
с текстовой кодировкой ASCII. Предназначен для сохранения графических до-
кументов в файлах с целью их последующей распечатки на принтере типа
PostScript без использования исходного приложения. В CorelDRAW 12 приме-
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няется следующими командами меню File (Файл): Open (Открыть), Import
(Импорт) и Print (Печать). Обозначение в программе — PS, PRN, EPS -
PostScript Interpreted.

ГЗ PS — векторный файловый формат (полное название — PostScript, расшире-
ние - ps). Является метафайловым форматом, основанным на языке
PostScript с текстовой кодировкой ASCII. Предназначен для сохранения лю-
бой графической и текстовой информации в файле с целью ее передачи
в другие приложения или распечатки на принтере типа PostScript.
В CorelDRAW 12 применяется следующими командами меню File (Файл):
Орел (Открыть), Import (Импорт) и Print (Печать). Обозначение в програм-
ме - PS, PRN, EPS - PostScript Interpreted.

П SHW'— векторный файловый формат (расширение — shw). Является собст-
венным форматом программы Corel Presentations. В CorelDRAW 12 применя-
ется следующими командами меню File (Файл): Open (Открыть) и Import
(Импорт). Обозначение в программе — SHW - Corel Presentation.

G SVG — векторный файловый формат (полное название — Scalable Vector
Graphics, расширение — svg). Предназначен для создания векторной графики
для Web. Позволяет организовывать интерактивный режим работы с элек-
тронным документом путем вставки в объекты исходного документа гипер-
ссылок и различных команд, написанных на языке Java-сценариев, храня-
щихся в отдельных файлах. В CorelDRAW 12 применяется следующими
командами меню File (Файл): Open (Открыть), Save As (Сохранить как),
Import (Импорт) и Export (Экспорт). Обозначение в программе — SVG -
Scalable Vector Graphics.

Г\ SVGZ— векторный файловый формат (полное название— Scalable Vector
Graphics Compressed, расширение — svgz). Отличается от предыдущего фор-
мата SVG сжатием информации при ее сохранении. В CorelDRAW 12 приме-
няется следующими командами меню File (Файл): Open (Открыть), Save As
(Сохранить как), Import (Импорт) и Export (Экспорт). Обозначение в про-
грамме — SVGZ - Compressed SVG.

П TTF— векторный файловый формат (полное название — True Type Font, рас-
ширение — ttf). Используется для сохранения обычных масштабируемых
шрифтов типа True Type. В CorelDRAW 12 применяется командой Export
(Экспорт) меню File (Файл). Обозначение в программе — TTF - True Type Font,

D VSD — векторный файловый формат (полное название — Visio Drawing, рас-
ширение - vsd). Поддерживает векторную и растровую графику.
В CorelDRAW 12 применяется следующими командами меню File (Файл):
Open (Открыть) и Import (Импорт). Обозначение в программе — VSD - Visio.

О WMF— векторный файловый формат (полное название — Windows Metafile,
расширение — wmf). Предназначен для сохранения графической и текстовой
информации с целью ее переноса в различные приложения, работающие
в среде Windows. Имеет ряд недостатков по сравнению с векторным форма-
том EMF, являющимся его улучшенной версией (особенно в отношении рас-
тровой и текстовой информации). В CorelDRAW 12 применяется следующими
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командами меню File (Файл): Open (Открыть), Save As (Сохранить как),
Import (Импорт) и Export (Экспорт). Обозначение в программе — WMF -
Windows Metafile.

G WPG — векторный файловый формат (полное название — WordPerfect Graphic,
расширение — wpg). Поддерживает векторную и растровую графику, однако
в основном используется для сохранения векторной информации. Допускает
использование в файле до 256 цветов, выбранных из более чем миллиона цве-
тов. В CorelDRAW 12 применяется следующими командами меню File (Файл):
Open (Открыть), Save As (Сохранить как), Import (Импорт) и Export (Экспорт).
Обозначение в программе — WPG - Corel WordPerfect Graphic.

Растровые форматы
Общее количество — 23.

П BMP— растровый файловый формат (полное название— Windows Bitmap,
расширение — bmp). Применяется многими графическими приложениями,
работающими в среде Windows. Обеспечивает высокое качество сохраняемых
растровых изображений, а также быструю обработку тех, которые имеют не-
большие размеры. Поддерживает следующие цветовые форматы: черно-
белый, оттенков серого, индексированных (палитровых) цветов и RGB. До-
пускает регулировку глубины цвета и сжатие информации. Не позволяет со-
хранять атьфа-каналы и внедрять цветовой профиль. В CorelDRAW 12 также
используется разновидность данного формата, ориентированная на операци-
онную систему OS/2. В CorelDRAW 12 применяется следующими командами
меню File (Файл): Import (Импорт) и Export (Экспорт). Обозначения в про-
грамме - BMP - Windows Bitmap и BMP - OS/2 Bitmap.

П CAL — растровый файловый формат (полное название — CALS Raster, рас-
ширение — cal). Поддерживает растровую графику, представляемую в черно-
белом цветовом формате. В CorelDRAW 12 применяется следующими коман-
дами меню File (Файл): Import (Импорт) и Export (Экспорт). Обозначение
в программе — CAL - CALS Compressed Bitmap.

П СРТ — растровый файловый формат (полное название — Corel PHOTO-
PAINT, расширение — cpt). Является собственным форматом программы
растровой графики Corel PHOTO-PAINT. Поддерживает информацию о сло-
ях, каналах и векторных контурах растрового изображения, а также любые
цветовые форматы. Используется для хранения многослойных изображений,
созданных в указанной программе, с целью их последующей обработки
в ней. Допускает вставку изображений в графические документы, создавае-
мые в других программах с маркой Corel. В CorelDRAW 12 применяется сле-
дующими командами меню File (Файл): Import (Импорт) и Export (Экспорт).
Обозначение в программе — СРТ - Corel PHOTO-PAINT Image.

О CUR — растровый файловый формат (полное название — Cursor Resource, рас-
ширение — cur). Используется в Windows для хранения изображений значков
указателей мыши, максимальный размер которых составляет 32x32 пиксела.
В CorelDRAW 12 применяется следующими командами меню File (Файл):
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Import (Импорт) и Export (Экспорт). Обозначение в программе — CUR -
Windows З.х/NT Cursor Resource.

О ЕХЕ~ растровый файловый формат (расширение — ехе). В CorelDRAW 12
применяется командой Import (Импорт) меню File (Файл). Обозначение
в программе — EXE - Windows З.х/NT Bitmap Resource.

П FPX— растровый файловый формат (полное название — FlashPix, расшире-
ние — fpx). Предназначен для хранения цифровых фотографий. Допускает
формирование в одном файле нескольких копий изображения, имеющих
различные разрешения. Поддерживает авторские коды разработчиков изо-
бражений, представляемых в форме водяных знаков. В CorelDRAW 12 при-
меняется следующими командами меню File (Файл): Import (Импорт) и
Export (Экспорт). Обозначение в программе — FPX - Kodak FlashPix Image.

П GIF— растровый файловый формат (полное название — Graphics Interchange
Format, расширение — gif). Является одним из трех растровых форматов, ис-
пользуемых в Web (GIF, JPEG и PNG). Обеспечивает высокое качество изо-
бражения при небольшом файловом объеме благодаря использованию таб-
личных цветовых форматов и эффективному способу сжатия информации,
Допускает передачу полностью прозрачных участков изображения, а также
режим чередования, при котором происходит ускоренная загрузка изображе-
ния по сети при постепенном повышении его качества. Усовершенствован-
ная разновидность данного формата (GIF89a) позволяет создавать файлы
видеоклипов. Поддерживается практически всеми современными графиче-
скими программами. В CorelDRAW 12 применяется следующими командами
меню File (Файл): Import (Импорт), Export (Экспорт) и Web Image Optimizer
(Оптимизатор изображения для Web). Обозначения в программе — GIF -
CompuServe Bitmap и GIF - GIF Animation.

О ICO — растровый файловый формат (полное название — Icon Resource, рас-
ширение — ico). Используется в Windows для хранения изображений значков
исполняемых файлов (пиктограмм). В CorelDRAW 12 применяется следую-
щими командами меню File (Файл): Import (Импорт) и Export (Экспорт).
Обозначение в программе — ICO - Windows З.х/NT Icon Resource.

П IMG — растровый файловый формат (полное название — GEM Paint, рас-
ширение — img). Поддерживает индексированные (палитровые) цвета с глу-
биной цвета от 1 до 4 бит, а также сжатие информации по методу RLE.
В CorelDRAW 12 применяется следующими командами меню File (Файл):
Import (Импорт) и Export (Экспорт). Обозначение в программе — IMG -
GEM Paint File.

П JPEG — растровый файловый формат (полное название — Joint Photographic
Experts Group, расширение — jpg). Является одним из трех растровых форма-
тов, используемых в Web (GIF, JPEG и PNG). Отличается от других растро-
вых форматов эффективным способом сжатия графической информации за
счет удаления из файла той ее части, которая не оказывает заметного влия-
ния на качество изображения. Поддерживает следующие цветовые форматы:
оттенков серого, RGB и CMYK. Позволяет плавно регулировать уровень
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сжатия информации в файле, а также использовать режим чередования,
обеспечивающий постепенное повышение качества изображения при его за-
грузке по сети. Не допускает сохранять в изображении прозрачные участки и
не поддерживает альфа-каналы. В CorelDRAW 12 применяется следующими
командами меню File (Файл): Import (Импорт), Export (Экспорт) и Web
Image Optimizer (Оптимизатор изображения для Web). Обозначение в про-
грамме — JPG - JPEG Bitmaps.

О MAC — растровый файловый формат (полное название — MACPaint, расши-
рение — mac). Является собственным форматом программы MacPaint, рабо-
тающей на Macintosh. Поддерживает только два цвета и палитру шаблонов.
Максимальный размер изображений, сохраняемых в данном формате, со-
ставляет 720x572 пиксела. В CorelDRAW 12 применяется следующими ко-
мандами меню File (Файл): Import (Импорт) и Export (Экспорт). Обозначе-
ние в программе — MAC - MACPaint Bitmap.

П PCD — растровый файловый формат (полное название — Kodak Photo CD, рас-
ширение — pcd). Предназначен для сохранения высококачественных изображе-
ний, имеющих высокое разрешение. Используется многими программами рас-
тровой графики. В CorelDRAW 12 применяется командой Import (Импорт) меню
File (Файл). Обозначение в программе — PCD - Kodak Photo-CD Image.

П PCX— растровый файловый формат (полное название — Paintbrush, расшире-
ние — рсх). Разработан специально для графической программы PaintBrush,
являющейся стандартным приложением к ранним версиям операционной сис-
темы Windows. Позволяет сохранять изображения следующих цветовых форма-
тов: черно-белого, оттенков серого, индексированных (палитровых) цветов и
RGB. При сохранении изображения допускает регулировку глубины цвета.
Не поддерживает цветовой профиль и альфа-каналы. В CorelDRAW 12 приме-
няется следующими командами меню File (Файл): Import (Импорт) и Export
(Экспорт). Обозначение в программе — PCX - PaintBrush.

G PNG — растровый файловый формат (полное название — Portable Network
Graphic, расширение — png). Является одним из трех растровых форматов,
используемых в Web (GIF, JPEG и PNG). Существуют две разновидности
данного формата: PNG-8 и PNG-24, которые различаются между собой сле-
дующими свойствами. Формат PNG-8 базируется на использовании таблич-
ной цветовой палитры, допускающей регулировку цветовых образцов,
и обеспечивает передачу полностью прозрачных участков (как формат GIF).
Формат PNG-24 поддерживает передачу любых прозрачных участков. Для
обоих этих форматов предусмотрен режим чередования, реализуемый при
загрузке файла по сети. В CorelDRAW 12 применяется следующими коман-
дами меню File (Файл): Import (Импорт), Export (Экспорт) и Web Image
Optimizer (Оптимизатор изображения для Web). Обозначение в программе -
PNG - Portable Network Graphics.

П РР — растровый файловый формат (полное название — Picture Publisher,
расширение — рр<номер eepcuu>. Является собственным форматом графиче-
ской программы Picture Publisher версий 4 и 5. В CorelDRAW 12 применяется
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следующими командами меню File (Файл): Import (Импорт) и Export (Экс-
порт). Обозначение в программе — PPF - Picture Publisher, PP4 - Picture
Publisher 4 и РР5 - Picture Publisher 5.

О PSD — растровый файловый формат (полное название — Photoshop, расши-
рение — psd). Является собственным форматом программ растровой графики
Adobe Photoshop и Adobe ImageReady. Позволяет сохранять информацию
о слоях, каналах и векторных контурах растрового документа Photoshop,
а также о кадрах и интерактивных состояниях документа ImageReady. Под-
держивает любые цветовые форматы. Служит для хранения многослойных
изображений, созданных в данных программах, с целью их последующей об-
работки. Допускает использование во многих графических приложениях.
В CorelDRAW 12 применяется следующими командами меню File (Файл):
Import (Импорт) и Export (Экспорт). Обозначение в программе — PSD -
Adobe Photoshop.

П RIFF— растровый файловый формат (расширение — rif). Является собствен-
ным форматом графической программы Corel Painter (бывшей MetaCreations
Painter). Характеризуется большими размерами файлов по сравнению с фор-
матами GIF и JPEG, а также возможностью сжатия информации в файле без
какой-либо ее потери. В CorelDRAW 12 применяется командой Import (Им-
порт) меню File (Файл). Обозначение в программе — RIFF - Painter 5/6.

G SCT~ растровый файловый формат (полное название — Scitex Continuous
Tone, расширение — set). Предназначен для высококачественной обработки
файлов изображений на компьютерных системах типа Scitex. Позволяет со-
хранять изображения, представленные в следующих цветовых форматах: от-
тенков серого, RGB и CMYK. Характеризуется очень большими файловыми
размерами изображений формата CMYK. He поддерживает цветовой про-
филь и альфа-каналы. В CorelDRAW 12 применяется следующими команда-
ми меню File (Файл): Import (Импорт) и Export (Экспорт). Обозначение
в программе — SCT - Scitex CT Bitmap.

G TGA — растровый файловый формат (полное название - Targa, расшире-
ние — tga). Создан фирмой Truevision с целью выделения отдельных кадров
видеоизображений для их цифровой обработки и переноса между различны-
ми приложениями. Поддерживает следующие цветовые форматы: оттенков
серого, индексированных (палитровых) цветов и RGB. He допускает исполь-
зование цветового профиля. В CorelDRAW 12 применяется следующими ко-
мандами меню File (Файл): Import (Импорт) и Export (Экспорт). Обозначе-
ние в программе — TGA - Targa Bitmap.

О TIFF— растровый файловый формат (полное название— Tagged Image File
Format, расширение — tif)- Является самым распространенным растровым
форматом, доступным для использования практически всеми существующи-
ми графическими приложениями. Поддерживает следующие цветовые фор-
маты: черно-белый, оттенков серого, индексированных (палитровых) цветов,
RGB, CMYK и Lab. Для каждого из этих форматов, за исключением первого,
обеспечивается сохранение альфа-каналов. Допускается сохранение вектор-
ных контуров, сжатие сохраняемой информации, а также внедрение в файл
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цветового профиля. В CorelDRAW 12 применяется следующими командами
меню File (Файл): Import (Импорт) и Export (Экспорт). Обозначение в про-
грамме - TIP - TIFF Bitmap.

П WI — растровый файловый формат (полное название — Wavelet Compressed
Bitmap, расширение - wi). Разработан фирмой Corel Corporation.
В CorelDRAW 12 применяется следующими командами меню File (Файл):
Import (Импорт) и Export (Экспорт). Обозначение в программе -
WI - Wavelet Compressed Bitmap

П XCF — растровый файловый формат (расширение— xcf). В CorelDRAW 12
применяется командой Import (Импорт) меню File (Файл). Обозначение
в программе — XCF - Gimp Image.

G ХРМ— растровый файловый формат (полное название — XpixMap Image,
расширение — xpm). В CorelDRAW 12 применяется следующими командами
меню File (Файл): Import (Импорт) и Export (Экспорт). Обозначение в про-
грамме — ХРМ - XpixMap Image.

Текстовые форматы
Общее количество — 8.

П DOC — текстовый файловый формат (полное название — Microsoft Word lor
Windows, расширение — doc). Является собственным форматом текстового
редактора Microsoft Word (имеет несколько разновидностей, определяемых
его версиями). Применяется для переноса текстовой информации между
приложениями, поддерживающими этот формат, с сохранением большинства
элементов форматирования текста. Программа CorelDRAW 12 поддерживает
все разновидности данного формата, начиная от второй версии Word и за-
канчивая Word 2000. В CorelDRAW 12 применяется следующими командами
меню File (Файл): Import (Импорт) и Export (Экспорт). Обозначение в про-
грамме - DOC - MS Word.

П Quattro — текстовый файловый формат (расширения — wq, wb). Является
собственным форматом программы Corel Quattro Pro. В CorelDRAW 12 при-
меняется командой Import (Импорт) меню File (Файл). Обозначение в про-
грамме - WQ, WB - Corel Quattro Pro.

О RTF— текстовый файловый формат (полное название — Microsoft Rich Text
Format, расширение — rtf). Предназначен для переноса текстовой информа-
ции между различными приложениями с сохранением большинства элемен-
тов ее форматирования. Представляет собой текстовый файл, состоящий из
информационной и управляющей частей. В первой из них находится содер-
жательная информация, а во второй — управляющая, содержащая параметры
форматирования и оформления текста. В CorelDRAW 12 применяется сле-
дующими командами меню File (Файл): Import (Импорт) и Export (Экспорт).
Обозначение в программе — RTF - Rich Text Format.

П TXT— текстовый файловый формат (полное название — ASCII Text, расши-
рение — txt). Предназначен для переноса текстовой информации между
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различными приложениями без сохранения элементов форматирования тек-
ста. Использует кодовый набор ASCII. В CorelDRAW 12 применяется сле-
дующими командами меню File (Файл): Import (Импорт) и Export (Экспорт).
Обозначение в программе — TXT - ANSI Text.

О WK— текстовый файловый формат (расширение — wk). Является собствен-
ным форматом программы Lotus 1-2-3, предназначенной для разработки
электронных таблиц. В CorelDRAW 12 применяется командой Import (Им-
порт) меню File (Файл). Обозначение в программе — WK - LOTUS 1-2-3.

П WP — текстовый файловый формат (полное название — WordPerfect, расши-
рение — ч/р<номер версии>). Является собственным форматом программы
Corel WordPerfect. В CorelDRAW 12 применяется следующими командами
меню File (Файл): Import (Импорт) и Export (Экспорт). Обозначение в про-
грамме — WP... - Corel WordPerfect....

О WS — текстовый файловый формат (полное название —- WordStar, расшире-
ния — ws<HOMep eepcuu>, wsd, wsw). Является собственным форматом про-
граммы WordStar. В CorelDRAW 12 применяется следующими командами
меню File (Файл): Import (Импорт) и Export (Экспорт). Обозначение в про-
грамме — WS... - WordStar ....

G XLS — текстовый файловый формат (полное название— Microsoft Excel,
расширение — xls). Является собственным форматом программы Microsoft
Excel, предназначенной для разработки электронных таблиц. В CorelDRAW 12
применяется командой Import (Импорт) меню File (Файл). Обозначение
в программе — XLS - Microsoft Excel.
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Обработка векторных объектов
Программа CorelDRAW 12 предоставляет пользователю широкие возможности
по обработке объектов векторной графики. Перечислим ее функции в данной
области:

О импорт информации, хранящейся в файлах векторных форматов;

П экспорт информации (векторной, растровой и текстовой), сохраняемой
в файлах векторных форматов;

П рисование линий следующих четырех типов: обычных, фигурных, размерны*
и соединительных;

О формирование стандартных геометрических фигур: прямоугольников, эллип-
сов, многоугольников, спиралей, а также наборов прямоугольных ячеек (со-
товых структур);

О создание автофигур, представляющих собой фигуры заданных форм, для ко-
торых допускается регулировка в интерактивном режиме с помощью управ-
ляющих и выделяющих маркеров;

П обработка линий и фигур;

О наложение образцов изображений на контуры векторных объектов;

П распыление наборов изображений вдоль контуров объектов;

G оформление внутренних областей объектов заливками различных типов: рав-
номерной, градиентной, шаблонной, текстурной, узором PostScript, а также
управляемой градиентной заливкой по сетке;

П оформление линий обводки векторных контуров;

О регулировка прозрачности объектов по равномерному и градиентному зако-
нам, а также с использованием шаблонов и текстур;

О формирование одного объекта из нескольких векторных объектов при раз-
личных вариантах их объединения;

О выполнение (несколькими способами) различных операций трансформации
объектов;

О создание следующих эффектов векторной графики: переход, контур, искаже-
ние, оболочка, выдавливание, тень, линза, перспектива и PowerClip.
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Следует отметить, что многие из представленных ранее функций являются уни-
кальными для данной программы, либо они реализованы в большем объеме,
чем в любой другой программе векторной графики. Это, прежде всего, относит-
ся к формированию размерных и соединительных линий, регулировке прозрач-
ности, а также к созданию некоторых эффектов.

Чтобы объективно оценить указанньге возможности CorelDRAW 12, отметим те
функции обработки векторных объектов, которые в этой программе отсутству-
ют, но имеются в программе векторной графики Adobe Illustrator и издательской
программе QuarkXPress:

П создание многослойных изображений (Illustrator);

П оформление линий обводки мозаичными узорами (Illustrator);

П формирование рамок в форме многоугольников в режиме наложения изо-
бражений (Illustrator);

О формирование шаблонов для заливки с прозрачными участками (Illustrator);

П формирование произвольного набора атрибутов оформления для всего вы-
бранного слоя документа, что позволяет автоматически оформлять все суще-
ствующие и будущие объекты данного слоя (Illustrator);

G создание и оформление вложенных слоев документа, что позволяет создавать
комплексные изображения объектов путем присвоения различных атрибутов
оформления этим слоям (Illustrator);

П создание в векторных объектах эффектов, имитирующих действие команд
фильтрации для растровых изображений (Illustrator);

П создание стилей оформления линий, представляющих образцы линий обвод-
ки в виде набора полосок или штрихов заданных размеров и раскраски
(QuarkXPress).

В этой главе рассматриваются все перечисленные выше функции CorelDRAW 12
по работе с векторными объектами, за исключением операций импорта и экс-
порта (см. разд. "Импорт и экспорт информации"гл. 7).

Рисование линий
Любой объект векторной графики состоит из двух частей: векторного контура
(замкнутого или разомкнутого), определяющего форму объекта, и его внутрен-
ней области, охватываемой этим контуром. Оформление контура называется
обводкой, а заполнение внутренней области однородным фоном или узором -
заливкой.

В процессе создания векторного объекта происходит формирование его контура,
а также заливка и обводка этого объекта параметрами, заданными в программе
по умолчанию.

Под рисованием линии понимается формирование и оформление векторного
контура, а под редактированием существующей линии — ее обработка, связан-
ная с изменением формы, толщины, прозрачности и иных параметров.
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CorelDRAW 12 предоставляет пользователю возможность рисования линий че-
тырех типов. Перечисли их, указав используемые при этом средства программы:

П обычные линии, базирующиеся на контура?; Безье, — 5 рабочих инструмегь

Freehand (Рисование от руки),

Реп (Перо) и

гон

Bezier (Безье),

Polyline (Ломаная линия),

3 Point Curve (Кривая по трем точкам);

Примечание

Контур Безье (или кривая Безье) представляет собой векторный контур, со-
стоящий из узелков, отрезков соединительных линий и контрольных точек, рас-
положенных на отрезках прямых, проходящих через узелки (см. разд. "Рисова-
ние обычных линий" данной главы, подразд. "Инструмент Bezier").

фигурные линии — инструменты Preset (Фигурная кисть), Calligraphic (Кал-
лиграфическое пе

чего инструмента

зо) и Pressure (Перо с нажимом), входящие в состав рабо-

Artistic Media (Комплект художника);

размерные линии и сноски — рабочий инструмент J^- Dimension (Размер);

соединительные линии — инструменты Angled connector (Угловой соедини-
тель) и Straight connector (Прямой соединитель), входящие в состав рабочего

Interactive Connector (Интерактивный соединитель).инструмента

Примечание

В дальнейшем мы будем обозначать любой инструмент, входящий в состав ра-
бочего инструмента Artistic Media (всего таких инструментов— пять), следую-
щим образом: Artistic Media > "Англоязычное название инструмента"
(Комплект художника > "Русскоязычное название инструмента"). Аналогичные
обозначения будем использовать и в отношении двух разновидностей рабочего
инструмента Interactive Connector.

Опишем все операции рисования линий, предусмотренные в CorelDRAW 12.

Рисование обычных линий
Для рисования обычных линий используется пять рабочих инструментов:
Freehand, Polyline, Bezier, Pen и 3 Point Curve. Рассмотрим их по порядку.

Инструмент Freehand

Freehand (Рисование от руки) используется для рисо-Рабочий инструмент

вания линий (разомкнутых и замкнутых) от руки, когда контур линии повторяет
траекторию перемещения указателя по документу при нажатой кнопке мыши.
Этот способ рисования является самым простым, но не очень точным, поскольку
при перемещении мыши возникает дрожание руки, которое передается линии,
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делая ее неровной. Для устранения этих неровностей в программе предусмотре-
но автоматическое сглаживание линии после ее создания. Настройка парамет-
ров инструмента производится на панели свойств.

В процессе рисования линии указанным инструментом автоматически формиру-
ется контур Безье, узелки и контрольные точки которого можно в дальнейшем
использовать для ее обработки. Данную операцию лучше всего выполнять с по-
мощью рабочего инструмента Shape (Форма), специально для этого предназна-
ченного (см. разд. "Обработка линий и фигур" настоящей главы).

На рис. 4.1 зафиксировано два момента процесса рисования разомкнутой линии
инструментом Freehand. Вверху расположена панель свойств с параметрами соз-
данной линии; посредине — формируемая линия в момент, непосредственно
предшествующий отпуску кнопки мыши; внизу — готовая линия (она выделе-
на). Обратите внимание на то, что результирующая линия имеет более сглажен-
ную форму, чем формируемая, повторяющая траекторию перемещения указате-
ля. Это вызвано тем, что на панели свойств был задан достаточно высокий
уровень сглаживания, равный 60 единицам (крайний справа инструмент).

Рис. 4.1. Пример рисования линии инструментом Freehand

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Freehand (их номера, приведенные на
рисунке, даны здесь в квадратных скобках):

П [1] — два поля Object(s) Position, в которых указываются координаты геомет-
рического центра выбранного объекта (в данном случае — сформированной

, линии);

П [2] — два поля Object(s) Size, используемые для задания размеров объекта;

П [3] — два поля Scale Factor, определяющие коэффициенты масштабирования
объекта по горизонтали и вертикали;

О [4] - кнопка Nonproportional Scaling/Sizing Ratio, подключающая режим
непропорционального масштабирования объекта;

П [5] — поле Angle of Rotation, используемое для ввода угла поворота объекта;

О [6] — две кнопки Mirror Buttons, выполняющие зеркальные развороты объ-
екта по горизонтали и вертикали;
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П [7] — раскрывающийся список Start Arrowhead Selector, предназначенный
для выбора головных наконечников стрелок (они будут располагаться в ис-
ходных точках формируемых линий);

О [8J — список Outline Style Selector, в котором производится выбор стиля
оформления линии;

G [9] — список End Arrowhead Selector, используемый для выбора хвостовых
наконечников стрелок (они будут находиться в конечных точках формируе-
мых линий);

О [10] — кнопка Auto-Close Curve, задающая режим автоматического замыка-
ния концов линии;

О [11]— раскрывающийся список (с редактируемым полем) Outline Width,
предназначенный для выбора (ввода) толщины линии;

О [12] — ползунок Freehand Smoothing, регулирующий уровень сглаживания
линии, которая будет сформирована.

Порядок работы
1. Откройте документ на нужной странице и отобразите в требуемом масштабе

ту его область, где будет нарисована линия.

2. Воспользуйтесь рабочим инструментом Pick (Выбор) и отмените возможные
выделения объектов в документе, щелкнув в его свободной области.

3. Выберите рабочий инструмент Freehand (Рисование от руки).

4. Если вы хотите задать параметры линии, которые будут использоваться
в текущем документе по умолчанию при рисовании многих линий, сделайте
следующее. Выберите геометрические параметры в следующих списках пане-
ли свойств (см. рис. 4.1): [7]— головной наконечник линии, [8]— стиль
оформления линии, [9] — хвостовой наконечник и [11] — толщина линии.
Задайте цвет линии, щелкнув правой кнопкой мыши на выбранном образце
цвета в рабочей цветовой палитре. Каждый раз при изменении того или
иного параметра линии на экране будет открываться панель Outline Pen
(Контурное перо) или Outline Color (Цвет обводки) с установленным флаж-
ком Graphic (Графика), которую необходимо закрыть щелчком на кнопке
подтверждения ОК.

Примечание

Панель Outline Pen (Контурное перо) представляет собой небольшое диалого-
вое окно с тремя флажками и двумя кнопками управления. Поскольку
в CorelDRAW 12 есть еще одно окно с таким же названием, относящееся к ра-
бочему инструменту Outline (Контур), мы не будем использовать термин "диа-
логовое окно" в отношении данной панели, чтобы не вносить путаницы.

5. С помощью ползунка [12] задайте требуемый уровень сглаживания форми-
руемой линии, чтобы устранить или уменьшить неровности, вызванные дро-
жанием руки при ее рисовании.
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6. Установите указатель в исходную точку документа, нажмите кнопку мыши, пе-
реместите указатель по заданной траектории в конечную точку, после чего кноп-
ку отпустите. Если вы рисуете замкнутую линию, то конечная и исходная точки
должны совпасть, о чем будет свидетельствовать изменение формы указателя
(вместо значка волнистой линии, расположенной справа внизу от крестообраз-
ной метки, появится изображение изогнутой стрелки, направленной вниз).

7. Отрегулируйте различные параметры созданной линии. Это вы можете сде-
лать с помощью инструментов панели свойств, рабочей цветовой палитры
(вместе с правой кнопкой мыши), а также выделяющих маркеров, располо-
женных вокруг созданного объекта и в его центре. Используя эти маркеры,
вы можете переместить линию в другое место документа, а также выполнить
следующие операции трансформации: масштабирование по горизонтали и
вертикали, поворот относительно произвольной точки документа и наклон.

8. Если необходимо отредактировать форму линии, то сделайте это с помощью
рабочего инструмента Shape (Форма) (см. разд. "Обработка линий и фигур" на-
стоящей главы, подразд, "Инструмент Shape").

Инструмент Polyline

Рабочий инструмент -Щ- Polyline (Ломаная линия) является улучшенной верси-

ей рабочего инструмента Freehand (Рисование от руки), рассмотренного выше.
Он отличается от указанного инструмента тем, что позволяет рисовать прямо-
линейные участки линии с помощью щелчков мыши. При этом процесс рисо-
вания линии завершается двойным щелчком мыши, а не одинарным.

Настройка параметров рассматриваемого инструмента производится на панели
свойств, которая имеет такой же вид, что и для инструмента Freehand, за исклю-
чением дополнительной кнопки Auto-Close Curve (Автоматически замыкать кри-
вую), расположенной крайней справа. В нажатом состоянии этой кнопки задается
режим формирования замкнутой линии, а в отпущенном — линии разомкнутой.

. ' •

Рис,. 4.2. Пример рисования линии инструментом Polyline

На рис. 4.2 зафиксированы два момента процесса рисования разомкнутой линии
инструментом Polyline. Вверху изображена панель свойств с параметрами соз-
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данной линии; посредине — формируемая линия в момент, непосредственно
предшествующий отпуску кнопки мыши; внизу — готовая линия (она выделе-
на), имеющая более сглаженную форму, чем в процессе формирования.

Порядок работы

Порядок работы с инструментом Polyline будет почти таким же, как и для инст-
румента Freehand (см, разд. "Инструмент Freehand" данной главы, подразд. "Порядок
работы"), за исключением того, что на шаге 3 инструкции, относящейся ко вто-
рому инструменту, следует выбрать инструмент Polyline, а шаг 6 заменить сле-
ду юшим шагом:

П выберите режим рисования замкнутой или разомкнутой линии (кнопка Auto-
Close Curve), после чего сформируйте линию, руководствуясь следующими
указаниями:

• если будущий участок линии будет криволинейным, то его формирование
следует выполнять при нажатой кнопке мыши;

• если будущий участок линии будет прямолинейным, то в начале него
кнопка мыши отпускается (если была нажата) или делается ею щелчок
(в противном случае), а в конце — кнопка нажимается (если следующим
будет криволинейный участок) или делается щелчок (если прямолиней-
ный). Чтобы наклон формируемого прямолинейного участка изменялся
дискретно, с приращением 15°, выполняйте эту операцию при нажатой
клавише <Ctrl>;

• чтобы завершить рисование линии, следует сделать двойной щелчок в ее
последней точке;

• если вы рисуете замкнутую линию при отжатой кнопке Auto-Close Cune,
то конечная и исходная точки должны совпасть, о чем будет свидетельст-
вовать изменение формы указателя (справа внизу от крестообразной мет-
ки появится изображение изогнутой стрелки, направленной вниз).
Для завершения рисования такой линии достаточно выполнить одинар-
ный щелчок в точке ее замыкания.

Bezier (Безье) производится путем

Инструмент Bezier

Рисование линии рабочим инструментом

последовательных щелчков или нажатий кнопки мыши в местах расположения
будущих узелков, с возможной регулировкой кривизны формируемого участка
линии перетаскиванием мышью контрольных точек текущего узелка.

Основное отличие линий, создаваемых инструментом Bezier, от линий, рисуе-
мых инструментом Freehand (Рисование от руки), состоит в более высокой точ-
ности их формирования, а также в более гладких формах.

В основу работы инструмента Bezier положен известный математический метод
Безье, широко используемый в современных графических программах для
рисования и редактирования контурных линий. Суть данного метода состоит
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в представлении векторного контура, образующего его контурную линию, в виде
совокупности элементов трех типов: узелков, отрезков соединительных линий
(сегментов) и контрольных точек. Такой контур называется контуром Безье или
кривой Безье.

С помощью контрольных точек регулируется форма сегментов контура. Каждый
узелок может иметь до двух таких точек, которые на экране соединены с теку-
щим узелком отрезками прямых пунктирных линий, являющихся касательными
к прилегающим сегментам контура. Создав кривую Безье, вы можете затем от-
редактировать ее форму путем перетаскивания мышью ее узелков и контроль-
ных точек, изменения типов узелков, а также добавления новых узелков или
удаления существующих. Это позволяет с высокой точностью формировать и
редактировать такие кривые.

В CorelDRAW 12 используются узелки трех типов: симметричные (symmetrical),
сглаженные (smooth) и угловые (cusp). Симметричным называется узелок, для
которого обе контрольные точки расположены на прямой линии и на одинако-
вом расстоянии от узелка. Сглаженный узелок отличается от симметричного тем,
что допускает раздельную регулировку контрольных точек, которые также нахо-
дятся на одной прямой. Угловой узелок позволяет независимо изменять положе-
ние любой из его контрольных точек.

В процессе рисования линии инструментом Bezier происходит создание новых
узелков различных типов, а также регулировка положения контрольных точек
последнего узелка (он будет симметричным, если только не был сформирован
щелчком мыши, что привело бы к отсутствию в нем контрольных точек).

Дополнительной функцией рассматриваемого инструмента является редактиро-
вание линии в процессе ее формирования. Это достигается за счет выделения
(щелчком мыши) любого промежуточного узелка контура линии с целью:

О его перемещения по области документа;

G раздельной регулировки контрольных точек данного промежуточного узелка
(он будет сглаженным), если они в нем имеются;

О удаления выбранного узелка двойным щелчком мыши или нажатием клави-
ши <Del>.

При переходе в режим редактирования промежуточных узелков линии, созда-
ваемой инструментом Bezier, на панели свойств становятся доступными те же
элементы настройки, что и при работе с рабочим инструментом Shape (Форма),
специально предназначенным для редактирования контуров Безье
(см. разд. "Обработка линии и фигур" настоящей главы, подразд. "Инструмент Shape").

На рис. 4.3 зафиксирован момент формирования некоторой линии инструмен-
том Bezier. Вверху изображена панель свойств.

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Bezier (их номера, приведенные на ри-
сунке, даны здесь в квадратных скобках):

П [1] — кнопка Auto-Close Curve, выполняющая автоматическое замыкание
концов линии прямолинейным отрезком;
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П [2] — кнопка Select All Nodes, выделяющая все узелки на контуре линии.

Под остачьными номерами здесь указаны: [3] — промежуточные узелки (пассив-
ные); [4] — концевой узелок (активный); [5] — регулируемая контрольная точка.

Рис. 4.3. Пример формирования линии инструментом Bezier

Порядок работы

1. Откройте документ на нужной странице и отобразите в требуемом масштабе
ту его область, где будет нарисована линия.

2. Воспользуйтесь рабочим инструментом Pick (Выбор) и отмените возможные
выделения объектов в документе, щелкнув в его свободной области.

3. Если вы хотите задать цвет линии, который будет использоваться в текущем
документе по умолчанию, щелкните правой кнопкой мыши на выбранном
образце цвета в рабочей цветовой палитре.

4. Выберите рабочий инструмент Bezier (Безье).

5. Выполните последовательность действий, каждое из которых состоит в сле-
дующем. Установите указатель в том месте документе, где должен находиться
следующий узелок образующего контура линии, и сделайте одно из двух:

• щелкните кнопкой мыши, если в узелке, который будет при этом создан,
не должно быть контрольных точек;

• нажмите кнопку, сформировав узелок, отрегулируйте кривизну сегмента
линии, примыкающего к этому узелку (путем перемещения его контроль-
ной точки), после чего кнопку мыши отпустите.

6. Если создаваемая линия должна быть замкнутой, то выберите один из двух
вариантов действий:

• соедините концы линии прямолинейным отрезком, щелкнув на кнопке [I]
панели свойств;

• поместите указатель в исходную точку линии и, как только форма указа-
теля изменится (вместо значка линии с узелком, находящимся спраиа
внизу от крестообразной метки, появится изображение направленной
вниз изогнутой стрелки), щелкните мышью.
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1. Для выхода из режима рисования разомкнутой линии сделайте двойной щел-
чок в конечной точке линии или выберите в блоке инструментов любой
другой рабочий инструмент (дли замкнутой линии этого делать не нужно).

8. Чтобы отрегулировать различные параметры линии, выберите снова рабочий
инструмент Pick и выполните настройку требуемых параметров с помощью
инструментов панели свойств (они будут такими же, как на рис. 4.1, за ис-
ключением отсутствующего ползунка [12]}, рабочей цветовой палитры и вы-
деляющих маркеров объекта.

9. Если необходимо отредактировать форму линии, сделайте это с помощью
рабочего инструмента Shape (Форма) (см. разд. "Обработка линий и фигур" на-
стоящей главы, подразд. "Инструмент Shape").

Инструмент Реп

Рабочий инструмент %g Реп (Перо) является модификацией рассмотренного

выше рабочего инструмента Bezier (Безье) и отличается от него следующими
свойствами:

П предусмотрена возможность отображения будущего сегмента образующего
контура формируемой линии, исходящего из текущего узелка (вторая справа
кнопка на панели свойств);

CJ предусмотрена возможность добавления и удаления промежуточных узелков
щелчками мыши (первая справа кнопка на данной панели);

О выделение промежуточного узелка с целью его перемещения в другое место
документа или регулирования его контрольных точек производится при на-
жатой клавише <Ctrl>;

П наличие на панели свойств всех элементов настройки (за исключением по-
следнего), относящихся к рабочему инструменту Freehand (Рисование от руки).

На рис. 4.4 зафиксирован момент формирования некоторой линии инструмен-
том Реп. Вверху представлена панель свойств.

1 2

Рис. 4.4. Пример формирования линии инструментом Реп

Поясним назначение последних двух элементов управления панели свойств,
доступных для использования при работе с инструментом Реп (их номера, при-
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веденные на рисунке, даны здесь в квадратных скобках). Остальные элементы
здесь те же, что и при работе с инструментом Freehand:

П [1] — кнопка Preview Mode, задающая режим отображения будущего сегмен-
та контура линии, который будет реализован щелчком кнопки мыши в теку-
щем месте расположения указателя;

П [2] — кнопка Auto Add-Delete, подключающая режим удаления существующих
и добавления новых узелков к контуру линии с помощью щелчков мыши.

Порядок работы

Порядок работы с инструментом Реп будет почти таким же, как и для инстру-
мента Bezier (см. разд. "Инструмент Bezier" данной главы, подразд. "Порядок рабо-
ты"). Исключение состоит лишь в том, что на шаге 4 инструкции, относящейся
ко второму инструменту, следует выбрать инструмент Реп, а при выполнении
шага 6 необходимо учесть отсутствие на панели свойств кнопки Auto-Close
Curve.

Инструмент 3 Point Curve

Рабочий инструмент £& 3 Point Curve (Кривая по трем точкам) предназначен

для рисования по трем точкам разомкнутой линии, представляющей собой
гладкую кривую. Концы этой кривой формируются при нажатой кнопке мыши
и определяются положением указателя в моменты нажатия и отпускания кнопки
мыши. Форма кривой задается щелчком мыши после требуемого перемещения
указателя.

Создаваемая линия представляет собой кривую Безье. Она содержит всего два
узелка: начальный и конечный, каждый из которых имеет всего одну контроль-
ную точку.

Параметры инструмента 3 Point Curve задаются на панели свойств, которая име-
ет тот же вид, что и для рабочего инструмента Freehand (Рисование от руки).

у: иг.109пгт1 I .15,19й mn . ' 100.0 "4

Рис. 4.5. Пример формирования гладкой кривой 3 Point Curve

На рис. 4.5 зафиксированы три момента процесса рисования гладкой кривой
инструментом 3 Point Curve. Слева находится формируемый вспомогательный
отрезок прямой, задающий концы будущей линии; посредине ~ создаваемая
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кривая в момент, непосредственно предшествующий щелчку мыши; справа —
результирующая кривая (она выделена). Вверху изображена панель свойств
с параметрами выделенного объекта.

Порядок работы

1. Откройте документ на нужной странице и отобразите в требуемом масштабе
ту область, где будет нарисована гладкая кривая.

2. Выберите рабочий инструмент Pick (Выбор) и отмените возможные выделе-
ния объектов в документе, щелкнув в его свободной области.

3. Если вы хотите задать цвет кривой, который будет использоваться в текущем
документе по умолчанию, щелкните правой кнопкой мыши на выбранном
образце цвета в рабочей цветовой палитре.

4. Выберите рабочий инструмент 3 Point Curve (Кривая по трем точкам).

5. Установите указатель в исходной точке свободной области документа нажми-
те кнопку мыши, нажмите при необходимости клавишу <Ctrl>, чтобы угол
наклона к горизонтали вспомогательного отрезка прямой, соединяющего
концы будущей кривой, был кратным 15°, переместите указатель в точку
расположения конечной точки кривой и отпустите кнопку.

6. Отрегулируйте форму кривой по ее виду на экране и, как только она удовле-
творит вас, щелкните кнопкой мыши.

7. Чтобы отредактировать различные параметры созданного объекта, выберите
снова рабочий инструмент Pick и выполните настройку требуемых парамет-
ров с помощью инструментов панели свойств, рабочей цветовой палитры и
выделяющих маркеров объекта.

Рисование фигурных линий

В состав программы CorelDRAW 12 входит рабочий инструмент '•$£; Artistic
Media (Комплект художника), который фактически представляет собой набор из
пяти инструментов: Preset (Фигурная кисть), Brush (Художественная кисть),
Sprayer (Распылитель), Calligraphic (Каллиграфическое перо) и Pressure (Перо
с нажимом). Выбор инструмента Artistic Media производится в блоке инстру-
ментов программы, а его конкретного образца — на панели свойств.

Инструменты Preset, Calligraphic и Pressure используются для рисования фигур-
ных линий, толщина которых изменяется по определенному закону, заданному
пользователем. Инструмент Brush предназначен для наложения одного выбран-
ного изображения на контур векторного объекта, a Sprayer — для случайного
распределения (распыления) набора образцов изображений вдоль данного кон-
тура (см. разд. "Наложение и распыление изображений" настоящей главы).

Особенность рисования фигурных линий инструментами Preset, Calligraphic и
Pressure состоит в том, что фактически они создают не фигурные линии, а век-
торные объекты с замкнутыми контурами, проходящими по их границам. Чтобы
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завершить процесс рисования такой линии, необходимо выполнить заливку соз-
данного объекта. Параметры настройки этих инструментов задаются на панели
свойств.

Инструмент Artistic Media > Preset
Рабочий инструмент Artistic Media > Preset (Комплект художника > Фигурная
кисть) позволяет рисовать фигурную линию, толщина которой переменна и опрс -
деляется ее стандартным профилем, выбранным на панели свойств. Предусмотре-
ны два способа формирования фигурных линий данного типа: в качестве новою
векторного объекта документа и путем преобразования в фигурную линию суще-
ствующего объекта. Во втором случае может также использоваться альтернативное
средство CorelDRAW 12 — докер Artistic Media (Комплект художника).

На рис. 4.6 зафиксированы два момента рисования фигурной линии инструмен-
том Preset (Фигурная кисть). Вверху находится панель свойств с параметрами
выделенной линии; посредине — формируемая линия в момент, непосредствен-
но предшествующий отпуску кнопки мыши; внизу —- результирующая линия
(она выделена).

Рис. 4.6. Пример рисования фигурной линии инструментом Preset

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Artistic Media > Preset (их номера, при-
веденные на рисунке, даны в квадратных скобках):

П [1] — кнопка Preset, подключающая указанный инструмент;

О [2] — ползунок Freehand Smoothing, регулирующий уровень сглаживания
фигурной линии (точнее — его образующего контура);

П [3] — поле Artistic Media Tool Width, в котором задается максимальная тол-
щина линии;

П [4] — раскрывающийся список Preset Stroke List, предназначенный для вы-
бора стандартного профиля фигурной линии.
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Порядок создания новой фигурной линии

1. Откройте документ на нужной странице и отобразите в требуемом масштабе
ту его область, где будет нарисована линия.

2. Выберите рабочий инструмент Artistic Media (Комплект художника).

3. На панели свойств выполните следующие настройки (см. рис. 4.6): подклю-
чите инструмент Preset (Фигурная кисть) (кнопка [1]); задайте требуемый
уровень сглаживания линии (ползунок [2|) и ее максимальную толщину (по-
ле [3]); выберите стандартный профиль линии (список [4]).

4. Сформируйте замкнутый контур линии. Для этого установите указатель
в исходной точке документа, нажмите кнопку мыши и переместите указатель
по заданной траектории в конечную точку, после чего кнопку отпустите.

5. Отрегулируйте геометрические параметры фигурной линии с помощью инст-
рументов панели свойств или выделяющих маркеров. Используя данные
маркеры, расположенные вокруг созданного вами объекта и в его центре, вы
можете переместить линию в другое место документа, а также выполнить
следующие операции трансформации: масштабирование по горизонтали и
вертикали, поворот относительно произвольной точки документа и наклон.

6. Выполните оформление фигурной линии. Для заливки ее внутренней облас-
ти вы можете использовать рабочую цветовую палитру (с левой кнопкой
мыши), а также рабочие инструменты Fill (Заливка) и Interactive Fill (Интер-
активная заливка). Для обработки контура фигурной линии можно восполь-
зоваться рабочей цветовой палитрой (с правой кнопкой мыши), а также
рабочим инструментом Outline (Контур). (См. разд. "Заливка" и "Обводка" на-
стоящей главы.)

Порядок преобразования объекта в фигурную линию

1. Откройте документ на нужной странице и отобразите ту его область, где на-
ходится векторный объект, контур которого будет преобразован в фигурную
линию.

2. Для формирования фигурной линии без использования докера Artistic Media
(Комплект художника) сделайте следующее. Выберите рабочий инструмент
Artistic Media (Комплект художника), а на панели свойств — инструмент
Preset (Фигурная кисть) (кнопка [1]). Выделите объект, щелкнув на нем мы-
шью. Задайте на панели свойств толщину линии (поле [3]) и выберите ее
стандартный профиль (список [4]). Если параметры, установленные по умол-
чанию, вас устраивают, то хотя бы один из них введите повторно, чтобы дать
программе сигнал на формирование фигурной линии вдоль контура выбран-
ного объекта.

3. Чтобы сформировать фигурную линию с использованием докера Artistic
Media (Комплект художника), выполните следующие действия. Откройте до-
кер Artistic Media (Комплект художника), выполнив одноименную команду
подменю Dockers (Докеры) меню Window (Окно). Выделите объект рабочим
инструментом Pick (Выбор). Нажмите мышью кнопку Auto Apply (Автомати-
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чески применить) с изображением замка, расположенную внизу докера.
Водном из двух рабочих окон докера, содержащих стандартные профили
фигурных линий, а также образцы изображений для наложения и распыле-
ния, выберите нужный стандартный профиль (он черного цвета), щелкнув на
нем мышью. В результате будет сформирована фигурная линия заданного
профиля и произойдет автоматический переход в режим работы с инстру-
ментом Artistic Media > Preset (Комплект художника > Фигурная кисть).

Примечание

В нижнем окне докера представлен весь список профилей фигурных линий и
образцов изображений для наложения и распыления, доступных для использо-
вания в CorelDRAW 12, а в верхнем — лишь те из них, которые использовались
последними в текущем сеансе работы программы.

4. Отрегулируйте геометрические параметры фигурной линии с помощью инст-
рументов панели свойств или выделяющих маркеров объекта.

5. Выполните оформление фигурной линии, если ее параметры должны отли-
чаться от параметров оформления исходного объекта. Для заливки ее внут-
ренней области вы можете использовать рабочую цветовую палитру (с левой
кнопкой мыши), а также рабочие инструменты Fill (Заливка) и Interactive Fill
(Интерактивная заливка). Для обработки контура фигурной линии можно
воспользоваться рабочей цветовой палитрой (с правой кнопкой мыши),
а также рабочим инструментом Outline (Контур). (См. разд. "Заливка" и "Обвод-
ка " данной главы.)

Инструмент Artistic Media t Calligraphic
Рабочий инструмент Artistic Media > Calligraphic (Комплект художника >
Каллиграфическое перо) используется для создания фигурной линии, толщин::,
которой зависит от угла ее наклона к оси рисования (при угле 0° она будет ми-
нимальна, а при 90° — максимальна).

Угол наклона этой оси к горизонтали задается на панели свойств. Предусмотре-
ны два способа формирования фигурных линий данного типа: в качестве новогс
векторного объекта документа и путем преобразования в фигурную линию су-
ществующего объекта (докер Artistic Media (Комплект художника) в данном
случае не используется).

На рис. 4.7 зафиксированы два момента рисования фигурной линии инструмен-
том Calligraphic (Каллиграфическое перо). Вверху изображена панель свойств
с параметрами выделенной линии; посредине — формируемая линия в момент,
непосредственно предшествующий отпуску кнопки мыши; внизу — результи-
рующая линия (она выделена).

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Artistic Media > Calligraphic (их номера.
приведенные на рисунке, даны здесь в квадратных скобках):

G [1] — кнопка Calligraphic, подключающая данный инструмент;
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О [21 — ползунок Freehand Smoothing, регулирующий уровень сглаживания
линии;

О [3] — поле Artistic Media Tool Width, в котором задается максимальная тол-
щина линии;

О [4) — поле Calligraphic Angle, в котором указывается угол наклона оси рисо-
вания к горизонтали.

100 ,; *3J;lQ,Qmm .145,0

Рис. 4.7. Пример рисования фигурной линии инструментом Calligraphic

Порядок создания новой фигурной линии

1. Откройте документ на нужной странице и отобразите в требуемом масштабе
ту область, где будет нарисована линия,

2. Выберите рабочий инструмент Artistic Media (Комплект художника).

3. На панели свойств выполните следующие регулировки (см. рис. 4.7): под-
ключите инструмент Calligraphic (Каллиграфическое перо) (кнопка [1]); за-
дайте требуемый уровень сглаживания линии (ползунок [2]) и ее максималь-
ную толщину (поле [3]); выберите угол наклона оси рисования (поле [4]).

4. Сформируйте замкнутый контур линии. Для этого установите указатель
в исходной точке документа, нажмите кнопку мыши и переместите указа-
тель по заданной траектории в конечную точку, после чего кнопку мыши от-
пустите.

5. Отрегулируйте геометрические параметры фигурной линии с помощью инст-
рументов панели свойств или выделяющих маркеров объекта. С помощью
данных маркеров вы можете переместить линию в другое место документа
или выполнить операции по ее трансформации.

6. Выполните заливку внутренней области фигурной линии, а также оформле-
ние ее контура (см, разд. "Заливка" и "Обводка"настоящей главы).
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Порядок преобразования объекта в фигурную линию

1. Откройте документ на нужной странице и отобразите ту его область, где на-
ходится векторный объект, контур которого будет преобразован в фигурную
линию.

2. Выберите рабочий инструмент Artistic Media (Комплект художника).

3. Подключите на панели свойств инструмент Calligraphic (Каллиграфическое
перо), нажав кнопку [1].

4. Выделите объект, установив на нем указатель и щелкнув кнопкой мыши.

5. Задайте на панели свойств толщину линии (поле [3]) и величину угла наклона
оси рисования (поле [4]). Если вас устраивают все параметры, заданные по
умолчанию, то хотя бы один из них введите повторно, чтобы дать программе
сигнал на формирование фигурной линии вдоль контура выбранного объекта.

6. Отрегулируйте геометрические параметры фигурной линии, используя для
этого инструменты панели свойств или выделяющие маркеры объекта.

7. Выполните оформление фигурной линии, если ее параметры должны отличаться
от параметров оформления исходного объекта. Для заливки ее внутренней облас-
ти вы можете использовать рабочую цветовую палитру (с левой кнопкой мыши),
а также рабочие инструменты Fill (Заливка) и Interactive Fffl (Интерактивная за-
ливка). Для обработки контура фигурной линии можно воспользоваться рабочей
цветовой палитрой (с правой кнопкой мыши), а также рабочим инструментом
Outline (Контур). (См. разд. "Заливка" и "Обводка" данной главы.)

Инструмент Artistic Media > Pressure
Рабочий инструмент Artistic Media > Pressure (Комплект художника > Перо с на-
жимом) предназначен для рисования линии, толщина которой определяется
нажатием одной из двух клавиш-стрелок, направленных вверх и вниз. С их по-
мощью имитируется рисование пером, чувствительным к его нажиму (при нажа-
тии клавиши со стрелкой вверх толщина линии увеличивается, а со стрелкой
вниз — уменьшается). Данный инструмент используется лишь при формирова-
нии линий в качестве новых объектов документа.

На рис. 4.S зафиксированы два момента рисования фигурной линии инструмен-
том Pressure (Перо с нажимом). Вверху находится панель свойств с параметрами
выделенной линии; посредине — формируемая линия в момент, непосредствен-
но предшествующий отпуску кнопки мыши; внизу — результирующая линия
(она выделена).

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Artistic Media > Pressure (их номера,
приведенные на рисунке, даны здесь в квадратных скобках):

О [1] — кнопка Pressure, подключающая указанный инструмент;

П [2] — ползунок Freehand Smoothing, регулирующий уровень сглаживания линии;

П [3] — поле Artistic Media Tool Width, определяющее максимальную толщину
линии.
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Рис. 4.8. Пример рисования фигурной линии инструментом Pressure

Порядок создания новой фигурной линии

1. Откройте документ на нужной странице и отобразите в требуемом масштабе
ту область, где будет нарисована линия.

2. Выберите рабочий инструмент Artistic Media (Комплект художника).

3. На панели свойств выполните следующие настройки (см. рис. 4.8): выберите
инструмент Pressure (Перо с нажимом) (кнопка [1]); задайте требуемый уро-
вень сглаживания линии (ползунок [2|) и ее максимальную толшину (поле [3]).

4. Сформируйте контур линии. Для этого установите указатель в исходной точ-
ке документа, нажмите кнопку мыши и перемещайте указатель по нужной
вам траектории, регулируя при этом толщину линии с помощью клавиш-
стрелок, напраштенных вверх и вниз. Перейдя в конечную точку линии, от-
пустите кнопку мыши.

5. Отрегулируйте геометрические параметры фигурной линии, используя инст-
рументы панели свойств и выделяющие маркеры объекта. С помощью этих
маркеров вы можете переместить линию в другое место документа, а также
трансформировать ее.

6. Выполните заливку внутренней области фигурной линии, а также оформите
ее контур (см. разд. "Заливка" и "Обводка" настоящей главы).

Рисование размерных линий и сносок
Программа CorelDRAW 12 предоставляет пользователю возможность формиро-
вания в документе размерных линий и сносок, являющихся необходимым атри-
бутом любых чертежей. Размерные линии позволяют указывать размеры любых
объектов документа, а сноски — формировать поясняющие текстовые надписи.
относящиеся к тем или иным объектам, и связанные с ними ломаные линии.
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Для создания размерных линий и сносок используется рабочий инструмент
Dimension (Размер). Рассмотрим его.

Инструмент Dimension

Рабочий инструмент Dimension обладает широкими возможностями по

формированию размерных линий и сносок, обеспечивая при этом простоту
и удобство работы. К числу этих возможностей относятся:

О рисование размерных линий любых типов (горизонтальных, вертикальных,
наклонных и угловых), а также ломаных линий, относящихся к текстовым
сноскам;

О большой набор регулируемых параметров;

П автоматическое вычисление и отображение размеров объектов (в заданных
единицах измерения);

П автоматическое изменение указываемых размеров при трансформации объектов.

Инструмент Dimension работает в шести различных режимах, определяющих
типы формируемых линий. Выбор этих режимов, а также настройка параметров
линий производится на панели свойств.

На рис. 4.9 показан пример создания горизонтальной размерной линии. Слева
изображен объект в процессе формирования для него размерной линии (перед
заключительным щелчком мыши), а справа — после выполнения щелчка. Ввер-
ху изображена панель свойств с параметрами созданной линии.

1 2 3 4 5 6 12 13 14

Рис. 4.9. Пример создания горизонтальной размерной линии
инструментом Dimension

degrees ™; Lm: Prefix* j •'] Suffix:

Рис. 4.10. Пример создания угловой размерной линии инструментом Dimension

6 Зак, 250
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На рис. 4.10 дан пример формирования угловой размерной линии. Слева изо-
бражен объект в процессе создания для него размерной линии, а справа —
после выполнения заключительного щелчка. Вверху представлена панель
свойств с параметрами созданной линии.

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Dimension (их номера, приведенные
на рис. 4.9, даны в квадратных скобках):

О [1] — кнопка Auto Dimension Tool, задающая режим рисования вертикальных
и горизонтальных размерных линий;

П [2] — кнопка Vertical Dimension Tool, подключающая режим рисования вер-
тикальных размерных линий;

СЗ [3] — кнопка Horizontal Dimension Tool, активизирующая режим рисования
горизонтальных размерных линий;

О [4] — кнопка Slanted Dimension Tool, задающая режим рисования наклонных
размерных линий;

О [5] — кнопка Callout Tool, подключающая режим рисования линий сносок;

D [6] — кнопка Angular Dimension Tool, активизирующая режим рисования уг-
ловых размерных линий;

П [7] — раскрывающийся список Dimension Style, в котором производится
выбор стиля оформления размерных величин, доступный для использования
в первых четырех режимах рисования размерных линий;

О [8] — список Dimension Precision, используемый для выбора варианта ото-
бражения дробных величин;

О [9] — список Dimension Units, предназначенный для выбора единиц измерения;

G [10] — кнопка Show Units for Dimension, подключающая режим отображения
наименования выбранных единиц измерения;

О [11] — поле Prefix for Dimension, в котором производится ввод начальной
константы, используемой в размерных надписях;

О [12] — поле Suffix for Dimension, предназначенное для задания конечной
константы в данных надписях;

П [13] — кнопка Dynamic Dimensioning, задающая режим доступа к инструмен-
там, используемым для настройки параметров размерных линий;

О [14] — кнопка Text Position Drop Down, раскрывающая дополнительную па-
нель с пятью вариантами расположения размерных надписей, которые могут
использоваться в первых четырех режимах рисования размерных линий.

Порядок работы

1. Откройте документ на нужной странице и отобразите в требуемом масштабе
ту его область, для объектов которой будут формироваться размерные линии
или сноски.

2. Выберите рабочий инструмент Dimension (Размер).
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3. Задайте нужный режим рисования линий, нажав на панели свойств одну из
шести кнопок под номерами от [1] до [6] (см. рис. 4.9).

4. Чтобы настроить параметры будущих размерных линий, подключите режим
использования соответствующих инструментов на панели свойств, нажав
кнопку [13].

5. Задайте следующие параметры:

• для первых четырех режимов рисования размерных линий - стиль
оформления размерных величин (список [7]);

• вариант отображения дробных величин (список [8]);

• используемые единицы измерения (список [9]);

• режим отображения названия выбранных единиц измерения (кнопка [10]);

• начальные и конечные константы в размерных надписях, если их предпо-
лагается использовать (поля [11] и [12]);

• для первых четырех режимов рисования — вариант расположения размер-
ной надписи (кнопка [14]).

6. Для рисования размерной линии (произвольного типа) выполните следую-
щие действия. Щелкните в исходной точке объекта измерения, а затем -
в конечной, соединив эти точки отрезком прямой. Сформируйте участок ли-
нии, связанный с размерной надписью, для чего переместите указатель
в нужное место документа при отжатой кнопке мыши и сделайте заключи-
тельный щелчок. В результате автоматически сформируется соответствующая
размерная надпись с указанием фактического линейного или углового разме-
ра (в заданных единицах) между выбранными точками объекта.

7. Для формирования сноски установите указатель в нужном месте внутри объ-
екта и сделайте первый щелчок. Затем переместите указатель в другое место,
снаружи объекта, и выполните второй щелчок. После этого выберите третью
точку (с той же самой вертикальной координатой, что и для второй) и щелк-
ните третий раз. В результате эти три точки соединятся между собой лома-
ной линией, а в последней точке появится текстовый курсор. Введите с кла-
виатуры в данное место документа требуемую надпись, которая будет
представлена художественным текстом. Параметры форматирования этой
надписи вы можете задать на панели свойств, которая при этом примет та-
кой же вид, как и при работе с инструментом Text (Текст).

^ Ъримечание

Параметры оформления формируемых линий будут соответствовать тем, кото-
рые используются по умолчанию, а параметры форматирования надписи —
параметрам по умолчанию для художественного текста.

Отрегулируйте при необходимости параметры оформления созданных вами
линий, для каждой из которых сделайте следующее. Выделите линию рабо-
чим инструментом Pick (Выбор); для изменения цвета линии щелкните правой
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кнопкой мыши на выбранном образце цвета рабочей цветовой палитры; для
изменения геометрических параметров линии воспользуйтесь рабочим инст-
рументом Outline (Контур), выполнив требуемые регулировки в его диалого-
вом окне Outline Pen (Контурное перо).

Рисование соединительных линий
Рисование соединительных линий производится с помощью инструментов
Angled connector (Угловой соединитель) и Straight connector (Прямой соедини-

тель), входящих в состав рабочего инструмента Щ Interactive Connector (Интер-

активный соединитель). Выбор этих инструментов, а также настройка их пара-
метров производятся на панели свойств.

Инструмент Interactive Connector > Angled connector
Рабочий инструмент Interactive Connector > Angled connector (Интерактивный
соединитель > Угловой соединитель) используется для формирования соедини-
тельных линий, состоящих из прямолинейных отрезков, параллельных осям ко-
ординат. Такого рода соединения характерны для различных схем и диаграмм.

Соединительные линии, создаваемые инструментом Angled connector (Угловой
соединитель), обладают двумя характерными свойствами:

О они задают связи между опорными точками векторных объектов, в качестве
которых могут использоваться узелки контуров объектов, геометрические
центры объектов, а также концы и управляющие маркеры других соедини-
тельных линий;

П места стыковки линий с опорными точками объектов жестко фиксированы,
что позволяет перемещать и трансформировать эти объекты, не разрушая их
связи.

Процесс создания соединительной линии инструментом Angled connector (Угло-
вой соединитель) состоит из двух этапов. На первом из них происходит рисова-
ние линии (при нажатой кнопке мыши), соединяющей между собой две вы-
бранные опорные точки объектов документа. На втором этапе регулируется
форма созданной линии с помощью рабочего инструмента Shape (Форма) путем
манипуляции маркерами, расположенными вдоль нее.

^ Примечание

Инструмент Angled connector позволяет также создавать соединительные линии
и без привязки к опорным точкам объектов. Такие соединительные линии, кото-
рые называются свободными, можно перемещать по области документа или
трансформировать с помощью рабочих инструментов Pick (Выбор) и Shape.

На рис. 4.11 вверху зафиксирован момент формирования инструментом Angled
connector одной из двух соединительных линий, а внизу — момент редактирова-
ния этой линии инструментом Shape.
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Рис. 4.11. Пример работы с инструментами Angled connector и Shape

Поясним назначение двух кнопок управления панели свойств, доступных при
рисовании соединительных линий различных типов (их номера, приведенные на
рисунке, даны здесь в квадратных скобках):

П [1] — кнопка Angled connector, подключающая одноименный инструмент
(в данном случае она нажата);

П [2] — кнопка Straight connector, подключающая одноименный инструмент.

Порядок работы

1. Откройте документ на нужной странице и отобразите в требуемом масштабе
ту его область, для объектов которой будут формироваться соединительные
линии.

2. Выберите рабочий инструмент Interactive Connector (Интерактивный соеди-
нитель).

3. Подключите на панели свойств инструмент Angled connector (Угловой соеди-
нитель), нажав кнопку [1] (см. рис. 4.11).
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4. Установите указатель на выбранной опорной точке (на узелке или в центре)
одного объекта и нажмите кнопку мыши. Затем поместите указатель на одну
из опорных точек другого объекта и отпустите кнопку. В результате между
этими двумя точками будет проведена соединительная линия, состоящая из
нескольких прямолинейных отрезков, параллельных осям координат.

^ Примечание

Поиск конечной опорной точки производится следующим образом. Плавно пе-
ремещайте указатель вдоль контура объекта или в области нахождения его
геометрического центра, пока не произойдет скачкообразный переход в бли-
жайшую опорную точку. Помните при этом, что геометрический центр объекта
можно использовать в качестве опорной точки лишь для стандартных фигур,
сформированных соответствующими рабочими инструментами программы
(см. разд. "Формирование фигур" настоящей главы).

5. Чтобы отредактировать форму некоторой соединительной линии, сделайте
следующее. Выберите рабочий инструмент Shape (Форма) и выделите эту ли-
нию щелчком мыши. После этого, последовательно устанавливая указатель
на том или ином маркере линии, переместите его мышью (по горизонтали
или вертикали) в нужное место документа.

6. Для изменения цвета или геометрических параметров линии сделайте сле-
дующее. Выберите рабочий инструмент Pick (Выбор) и выделите данную ли-
нию щелчком мыши. Чтобы изменить цвет линии, щелкните правой кнопкой
мыши на выбранном цветовом образце рабочей цветовой палитры, а для ре-
дактирования ее геометрических параметров воспользуйтесь соответствую-
щими элементами панели свойств,

Инструмент Interactive Connector > Straight connector
Рабочий инструмент Interactive Connector > Straight connector (Интерактивный
соединитель > Прямой соединитель) применяется при рисовании различных се-
тевых схем и графиков, в которых необходимо задавать прямолинейные связи
между отдельными пунктами или узлами сети. В качестве таких пунктов и узлов
здесь выступают опорные точки векторных объектов, а именно: узелки контуров
этих объектов, их геометрические центры, а также концы других соединитель-
ных линий.

Формирование соединительной линии данного типа производится при нажатой
кнопке мыши. Таким образом вы сможете создать целую сеть прямых соедине-
ний, каждое из которых будет обладать следующим свойством: при перемеще-
нии связанного объекта по области документа или его трансформации точки
соединения этого объекта с другими объектами остаются неизменными.

^ Примечание

Инструмент Straight connector (Прямой соединитель) позволяет также созда-
вать свободные соединительные линии, не имеющие привязки к опорным точкам
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объектов документа. Такие линии можно перемещать по области документа и
трансформировать с помощью рабочих инструментов Pick (Выбор) и Shape
(Форма).

На рис. 4.12 вверху зафиксирован момент формирования инструментом Straigllt
connector одной из двух соединительных линий, а внизу — момент завершения
перемещения левого связанного объекта инструментом Pick.

щд. ̂
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Рис. 4.12. Пример работы с инструментами Straight connector и Pick

При работе с данным инструментом на панели находятся те же элементы управ-
ления, что и для инструмента Angled connector. Единственное отличие состоит
в том, что в данном случае должна быть нажата кнопка Straight connector, а не
Angled connector, чтобы этот инструмент был выбран.

Порядок работы

1. Откройте документ на нужной странице и отобразите в требуемом масштабе ту
область, для объектов которой будут формироваться соединительные линии.

2. Выберите рабочий инструмент Interactive Connector (Интерактивный соеди-
нитель).
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3. Подключите на панели свойств инструмент Straight connector (Прямой со-
единитель), нажав кнопку [2] (см, рис. 4.11).

4. Установите указатель на выбранной опорной точке одного объекта, нажмите
кнопку мыши, поместите указатель на одну из опорных точек другого объек-
та и отпустите кнопку. В результате между этими двумя точками будет про-
ведена соединительная линия.

Примечание

Поиск конечной опорной точки производится следующим образом. Плавно пе-
ремещайте указатель вдоль контура объекта или в области нахождения его
геометрического центра, пока не произойдет скачкообразный переход в бли-
жайшую опорную точку.

5. Для изменения параметров созданной соединительной линии сделайте следую-
щее. Выделите данную линию рабочим инструментом Pick (Выбор). Чтобы изме-
нить цвет линии, щелкните правой кнопкой мыши на выбранном цветовом об-
разце рабочей цветовой палитры, а для редактирования ее геометрических
параметров воспользуйтесь соответствующими элементами панели свойств.

Формирование фигур
В состав программы CorelDRAW 12 входят четыре группы рабочих инструмен-
тов, предназначенные для создания векторных объектов стандартных геометри-
ческих форм, называемых здесь фигурами. Перечислим их:

П первая группа включает пять инструментов, создающих стандартные геомет-
рические фигуры, указанные в названиях этих инструментов: Rectangle
(Прямоугольник), Ellipse (Эллипс), Polygon (Многоугольник), Spiral (Спи-
раль) и Graph Paper (Сотовая структура);

О вторая группа включает два инструмента, создающие фигуры прямоугольни-
ков и эллипсов альтернативным способом: 3 Point Rectangle (Прямоугольник
по трем точкам) и 3 Point Ellipse (Эллипс по трем точкам);

G третья группа включает новый инструмент Smart Drawing (Умное рисование),
позволяющий создавать геометрические фигуры путем автоматического пре-
образования в них исходных фигур, нарисованных от руки;

О четвертая группа включает пять инструментов, создающих так называемые
автофигуры: Basic Shapes (Базовые формы), Arrow Shapes (Формы стрелок),
Flowchart Shapes (Формы блок-схем), Star Shapes (Формы звезд) и Callout
Shapes (Формы выносок).

^ Примечание

Автофигура отличается от обычной фигуры тем, что в ней предусмотрены
управляющие маркеры, позволяющие регулировать мышью ее геометрические
параметры.
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Для всех инструментов первой и четвертой групп порядок формирования фигур
будет аналогичным.

1. Выберите требуемый инструмент.

2. Установите указатель в свободном месте документа.

3. Нажмите кнопку мыши и переместите указатель по диагонали в нужное
место документа, после чего кнопку отпустите. В результате сформируется
соответствующая фигура, размеры которой будут совпадать с размерами во-
ображаемого прямоугольника, по диагонали которого перемешался указа-
тель. Если в процессе перетаскивания указателя была нажата клавиша
<Ctrl>, то будет создана правильная фигура, а при нажатии клавиши <Shift>
формирование фигуры будет происходить не с угла, а из ее центра, находя-
щегося в месте расположения указателя в момент нажатия кнопки мыши.

Рассмотрим возможности указанных инструментов, а также порядок работы
с ними.

Инструмент Rectangle

Рабочий инструмент Rectangle (Прямоугольник) входит в первую группу

инструментов, создающих фигуры. Он предназначен для формирования прямо-
угольников и квадратов, в которых допускается скруглять углы. Предусмотрена
как индивидуальная регулировка радиуса скругления каждого угла прямоуголь-
ника, так и групповая для всех углов сразу.

i ? 8 10 I \ 121314

_.__„._.. M.mcrJZJjii JOC.Q; *
тз.аззпуп .- j 54,3951™, :ioc.o;_<

3 г.оре о

Рис. 4.13. Пример создания и обработки фигуры прямоугольника инструментами
Rectangle и Shape

На рис. 4.13 зафиксированы четыре момента процесса создания (инструментом
Rectangle) и обработки (рабочим инструментом Shape (Форма)) фигуры прямо-
угольника с двумя скругленными углами. Здесь изображены: вверху слева -
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контур формируемого прямоугольника в момент, непосредственно предшествую-
щий отпуску кнопки мыши; вверху справа — созданный прямоугольник; внизу
слева — тот же прямоугольник в процессе регулировки инструментом Shape ра-
диусов скругления его двух нижних углов; внизу справа — результирующая фигу-
ра, представляюшая собой прямоугольник с двумя скругленными углами.

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Rectangle (их номера, приведенные на
рисунке, даны здесь в квадратных скобках):

П [1] — два поля Object(s) Position, в которых указываются координаты геомет-
рического центра объекта, представляющего собой фигуру прямоугольника;

П [2] — два поля Object(s) Size, используемые для ввода размеров объекта;

П1 [3] — два поля Scale Factor, задающие коэффициенты масштабирования объ-
екта по горизонтали и вертикали;

П [4] — кнопка Nonproportional Scaling/Sizing Ratio, подключающая режим не-
пропорционального масштабирования;

О [5] — поле Angle of Rotation, в котором указывается угол поворота объекта;

О [6] — две кнопки Mirror Buttons, выполняющие зеркальные развороты объ-
екта по горизонтали и вертикали;

П [7] — два поля (со счетчиками) Left Rectangle Corner Roundness, используе-
мые для ввода коэффициентов скругления левых углов прямоугольника;

О [8] — два поля (со счетчиками) Right Rectangle Corner Roundness, предназна-
ченные для ввода коэффициентов скругления правых углов прямоугольника;

^ Примечание

Коэффициенты скругления углов прямоугольника задаются в относительных
единицах в диапазоне от 0 до 100. При нулевом значении данного параметра
скругление соответствующего угла отсутствует, а при максимальном значении,
равном 100, радиус скругления равен половине минимального размера прямо-
угольника.

П [9] — кнопка Round Corner Together, активизирующая режим групповой ре-
гулировки радиусов скругления углов прямоугольника, когда величина этого
радиуса будет одинакова для всех углов;

П [10] — кнопка Wrap Paragraph Text, открывающая панель управления с па-
раметрами настройки текстовой оборки1 для выбранного объекта;

П [11]— раскрывающийся список (с редактируемым полем) Outline Width,
в котором производится выбор (ввод) толщины линии обводки объекта;

О [12] — кнопка То Front, перемещающая объект на передний план текущего
слоя документа;

1 Текстовая оборка представляет собой пустую область, появляющуюся в тексте
в результате обтекания им некоторого объекта, находящегося внутри него.
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П [13] — кнопка То Back, перемещающая объект на задний план данного слоя;

П [14] — кнопка Convert To Curves, преобразующая контур прямоугольника в
кривую Безье.

Порядок работы
1. Откройте документ на нужной странице и отобразите в требуемом масштабе

ту область, где будет создаваться геометрическая фигура.

2. Выберите рабочий инструмент Rectangle (Прямоугольник).

3. Задайте в полях [7] и [8] панели свойств коэффициенты скругления всех уг-
лов формируемого прямоугольника (см. рис. 4.13).

4. Создайте фигуру прямоугольника (или квадрата). Для этого установите указа-
тель в нужной точке документа, нажмите кнопку мыши (при необходимости
нажмите одну или две управляющие клавиши <Ctrl> и <Shift>), переместите
указатель по диагонали в другое место документа и отпустите кнопку.

5. Отрегулируйте геометрические параметры фигуры прямоугольника.
Для этого воспользуйтесь различными инструментами панели свойств, выде-
ляющими маркерами, расположенными вокруг и в центре созданного объек-
та, а также управляющими узелками квадратной формы черного цвета, нахо-
дящимися на его контуре (в последнем случае должен быть выбран рабочий
инструмент Shape (Форма)). С помощью маркеров вы можете переместить
мышью фигуру в другое место документа или трансформировать ее (масшта-
бировать по горизонтали и вертикали, повернуть относительно произвольной
точки документа или наклонить). Изменение коэффициентов скругления уг-
лов прямоугольника может быть выполнено одним из трех способов:

• вводом одного значения коэффициента скругления для всех углов прямо-
угольника в одно из полей [7] и [8] при включенном режиме групповой
регулировки (кнопка [9] нажата);

• вводом различных значений коэффициентов скругления во все эти поля
при отключенном данном режиме (кнопка [9] отжата);

• перетаскиванием мышью управляющих узелков на контуре прямоуголь-
ника, для чего нужно выполнить следующие действия. Выберите инстру-
мент Shape и выделите мышью узелки в тех вершинах прямоугольника,
где необходимо скруглить углы. Подведите к одному из узелков указатель,
придав ему вид жирной стрелки с небольшой крестообразной меткой внизу.
Нажмите кнопку мыши и переместите выбранный узелок по периметру
прямоугольника в нужном направлении, задав требуемый радиус скругле-
ния выбранных углов, после чего отпустите кнопку мыши.

1. Выполните заливку и обводку созданного объекта, используя для этого рабочую
цветовую палитру или соответствующие рабочие инструменты CorelDRAW 12
(см. разд. "Заливка" и "Обводка" настоящей главы).

2. Отрегулируйте при необходимости другие параметры данного объекта, опре-
деляющие:

• положение объекта по толщине текущего слоя документа (кнопки [12] и [13]);
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• вид текстовой оборки, которая будет сформирована вокруг объекта при
его расположении внутри текста обычного типа (кнопка [10]);

• возможность редактирования контура объекта с помощью узелков и кон-
трольных точек (кнопка [14]);

• прозрачность объекта (см. разд. "Регулировка прозрачности" данной главы).

Инструмент 3 Point Rectangle

Рабочий инструмент 3 Point Rectangle (Прямоугольник по трем точкам)

входит во вторую группу инструментов, создающих фигуры. Как и рабочий ин-
струмент Rectangle (Прямоугольник), он также предназначен для формирования
прямоугольников и квадратов, в которых допускается скруглять углы, и отлича-
ется от него лишь способом создания фигуры.

Этот способ состоит в формировании прямоугольника по трем точкам. Исход-
ная сторона фигуры задается путем перемещения указателя при нажатой кнопке
мыши, а перпендикулярная ей сторона — последующим щелчком мыши после
перемещения указателя при отжатой данной кнопке.

При работе с инструментом 3 Point Rectangle панель свойств принимает тот же
вид, что и для инструмента Rectangle.

На рис. 4.14 зафиксированы три момента процесса создания фигуры прямо-
угольника инструментом 3 Point Rectangle. Слева показана исходная сторона
фигуры в момент, непосредственно предшествующий отпуску кнопки мыши;
посредине — контур формируемого прямоугольника в момент перед щелчком
мыши; справа — созданный прямоугольник. Вверху изображена панель свойств
с параметрами выделенного объекта, находящегося справа.
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Рис. 4.14. Пример создания фигуры прямоугольника инструментом 3 Point Rectangle

Порядок работы
Порядок работы с инструментом 3 Point Rectangle будет почти таким же, как и
для инструмента Rectangle (см. разд. "Инструмент Rectangle" данной главы, подразд.
"Порядок работы"), за исключением того, что на шаге 2 инструкции, относящейся
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ко второму инструменту, следует выбрать инструмент 3 Point Rectangle, а шаг 4
заменить на следующие два шага:

П установите указатель в свободном месте документа, нажмите кнопку мыши и
путем перетаскивания указателя по области документа сформируйте исход-
ную сторону прямоугольника, после чего кнопку отпустите. Чтобы наклон
формируемой стороны изменялся дискретно, с приращением 15°, выполняй-
те эту операцию при нажатой клавише <Ctrl>;

П перемещая указатель по документу (при отжатой кнопке мыши), отрегули-
руйте размер другой стороны фигуры, перпендикулярной первой стороне,
после чего щелкните кнопкой мыши. Если в процессе перемещения указате-
ля была нажата клавиша <Ctrl>, то будет создан квадрат, а при нажатии кла-
виши <Shift> формирование фигуры будет происходить из ее центра, нахо-
дящегося в месте расположения указателя в момент нажатия кнопки мыши
на предыдущем шаге.

Инструмент Ellipse

Рабочий инструмент О Ellipse (Эллипс) входит в первую группу инструментов,

создающих фигуры. Он предназначен для формирования эллипсов и кругов,
а также их отдельных частей (секторов и дуг). Выбор типа фигуры, создаваемой
инструментом, производится на панели свойств. Там же задаются углы поворота
образующих радиусов, определяющих форму сектора или дуги.

На рис. 4.15 показаны три различных фигуры, созданные инструментом Ellipse:
эллипс (слева), сектор (посредине) и дуга (справа). Особенность двух последних
фигур состоит в том, что они были сформированы из первой фигуры путем пре-
образования ее типа и без каких-либо регулировок параметров. Вверху изображена
панель свойств с параметрами для выделенного объекта, находящегося справа.
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Рис. 4.15. Пример создания фигур инструментом Ellipse

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Ellipse (их номера, приведенные на ри-
сунке, даны здесь в квадратных скобках):

О [1] — два поля Object(s) Position, в которых указываются координаты геомет-
рического центра объекта, представляющего собой фигуру эллипса, сектора
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или дуги (для последних двух фигур здесь указываются координаты обра-
зующего эллипса);

О [2] — два поля Object(s) Size, определяющие размеры объекта;

П [3] — два поля Scale Factor, в которых задаются коэффициенты масштабиро-
вания объекта, по горизонтали и вертикали;

О [4] — кнопка Nonproportional Scaling/Sizing Ratio, подключающая режим
непропорционального масштабирования объекта;

О [5] — поле Angle of Rotation, в котором указывается угол поворота объекта;

О [6] — две кнопки Mirror Buttons, выполняющие зеркальные развороты
объекта по горизонтали и вертикали;

П [7] — кнопка Ellipse, задающая режим создания фигуры в форме эллипса;

П [8] — кнопка Pie, подключающая режим создания фигуры в форме сектора;

О [9] — кнопка Arc, активизирующая режим создания фигуры в форме дуги;

П [10] — два поля (со счетчиками) Starting and Ending Angles, в которых указы-
ваются углы поворота образующих радиусов (в направлении против часовой
стрелки), определяющие форму сектора или дуги;

П [II] — кнопка Clockwise/Counterclockwise Arcs or Pies, управляющая направ-
лением перехода от первого образующего радиуса ко второму при формиро-
вании сектора или дуги;

П [12] — кнопка Wrap Paragraph Text, открывающая панель управления с па-
раметрами настройки текстовой оборки для выбранного объекта;

О [13] — раскрывающийся список (с редактируемым полем) Outline Width,
в котором производится выбор (ввод) толщины линии обводки;

П [14] — кнопка То Front, перемещающая объект на передний план текущего
слоя документа;

О [15] — кнопка То Back, перемешающая объект на задний план данного слоя;

П [16] — кнопка Convert To Curves, преобразующая контур фигуры в кривую
Безье.

Порядок работы
1. Откройте документ на нужной странице и отобразите в требуемом масштабе

ту область, где будет создаваться геометрическая фигура.

2. Выберите рабочий инструмент Ellipse (Эллипс).

3. Задайте на панели свойств режим формирования нужной фигуры, нажав одну
из трех кнопок: [7], [8] или [9] (см. рис. 4.15). Если это будет сектор или дуга,
то укажите для выбранной фигуры углы поворота образующих радиусов (поля
[10]), а также направление, в котором эти углы вычисляются (кнопка [И]).

4. Создайте фигуру требуемой формы в порядке, описанном в начеые раздела
"Формирование фигур " данной главы.
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с вершиной, отличной от соседней. При этом центральная ее часть, образованная
пересечением диагоналей, является полой (прозрачной), недоступной для заливки.

^ Примечание

В CorelDRAW 12 предусмотрено формирование и так называемых сплошных
звезд, внутри которых отсутствуют полые области.

На рис. 4.17 зафиксированы четыре момента процесса создания (инструментом
Polygon) и обработки (рабочим инструментом Shape (Форма)) фигуры пяти-
угольника. Здесь показаны: вверху слева — контур формируемой фигуры выпук-
лого пятиугольника в момент, непосредственно предшествующий отпуску кноп-
ки мыши; вверху справа — созданная фигура; внизу слева — та же фигура
в процессе регулировки инструментом Shape ее серединных узелков; внизу
справа — результирующая фигура, представляющая собой сплошную пятико-
нечную звезду.
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Рис. 4.17. Пример создания и обработки фигуры пятиугольника
инструментами Polygon и Shape

Следует отметить, что создать сплошную звезду (без полой середины) можно
не только путем регулировки мышью серединных маркеров в существующем
выпуклом многоугольнике, что было продемонстрировано на рис. 4.17, но и
в процессе формирования самой фигуры. Для этого вы должны сделать двойной
щелчок на кнопке инструмента Polygon и в окне Options (Параметры), открыв-
шемся на вкладке Polygon Tool с параметрами данного инструмента, задать ре-
жим формирования сплошных звезд (переключатель Polygon as Star) и отрегу-
лировать остроту их углов (ползунок Sharpness).

На рис. 4.18 показан пример формирования сплошной пятиконечной звезды
путем задания соответствующего режима работы инструмента Polygon. Вверху
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находится панель свойств; слева — обычный выпуклый пятиугольник; справа —
сплошная звезда (она выделена); внизу — окно Options с параметрами формиро-
вания таких звезд.

Numta of points/slaes:

Sharpness: |sc

Рис. 4.18. Пример создания сплошной звезды инструментом Polygon

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Polygon (их номера, приведенные
на рис. 4.17, даны здесь в квадратных скобках):

П [1] — два поля Object(s) Position, в которых указываются координаты геомет-
рического центра объекта, представляющего собой фигуру многоугольника;

П [2] — два поля Object(s) Size, используемые для задания размеров объекта;

О [3] — два поля Scale Factor, задающие коэффициенты масштабирования объ-
екта по горизонтали и вертикали;

О [4] — кнопка Nonproportional Scaling/Sizing Ratio, подключающая режим не-
пропорционального масштабирования;

П [5] — поле Angle of Rotation, определяющее угол поворота объекта;

О [6] — две кнопки Mirror Buttons, выполняющие зеркальный разворот объекта
по горизонтали и вертикали;

О [7] — кнопка Polygon, подключающая режим создания выпуклых много-
угольников;

П [8] — кнопка Star, задающая режим создания звезд, полых внутри;

О [9] — поле (со счетчиками) Number of Points on Polygon, в котором указыва-
ется число вершин в многоугольнике;

О [10] — ползунок Sharpness of Polygon, регулирующий остроту вершин звезды
(с числом вершин не менее семи) путем задания количества промежуточных
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вершин фигуры, которые будут находиться между двумя вершинами, соеди-
ненными отрезком прямой;

П [11] — кнопка Wrap Paragraph Text, открывающая панель управления с па-
раметрами настройки текстовой оборки для выбранного объекта;

П [12] — раскрывающийся список (с редактируемым полем) Outline WidtK,
в котором производится выбор (ввод) толщины линии обводки;

О [13] — кнопка То Front, перемещающая объект на передний план текущего
слоя документа;

П [14] — кнопка То Back, перемещающая объект на задний план;

О [15] — кнопка Convert To Curves, преобразующая контур многоугольника
в кривую Безье.

Порядок работы
1. Откройте документ на нужной странице и отобразите в требуемом масштабе

ту его область, где будет создаваться геометрическая фигура.

2. Выберите рабочий инструмент Polygon (Многоугольник).

3. Задайте на панели свойств следующие параметры будущей фигуры
(см. рис. 4.17):

• тип фигуры: выпуклый многоугольник (кнопка [7]) или звезда (кнопка [8]);

• количество вершин (поле [9]);

• остроту вершин звезды (ползунок [10]).

4. Создайте фигуру требуемой формы в порядке, описанном в начале раздела
"Формирование фигур " данной главы.

5. Отрегулируйте геометрические параметры фигуры. Для этого вы можете вос-
пользоваться различными инструментами панели свойств, выделяющими
маркерами, расположенными вокруг и в центре созданного объекта, а также
управляющими узелками, находящимися на его контуре (в последнем случае
должен быть выбран рабочий инструмент Shape (Форма)). С помощью мар-
керов вы можете переместить фигуру мышью в другое место документа или
трансформировать ее. Узелки позволяют симметрично изменить форму фи-
гуры (относительно ее геометрического центра), а также повернуть ее. Работа
с управляющими узелками происходит следующим образом. Выберите инст-
румент Shape, подведите указатель к одному из узелков и нажмите кнопку
мыши; переместите выбранный узелок по периметру фигуры в нужном на-
правлении, после чего отпустите кнопку мыши.

6. Выполните заливку и обводку созданного объекта (см. разд. "Заливка" и "Об-
водка" настоящей главы).

1. Отрегулируйте при необходимости другие параметры данного объекта, опре-
деляющие:

• положение объекта по толщине текущего слоя документа (кнопки [13] и [14]);
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вид текстовой оборки объекта (кнопка [11]);

• возможность редактирования контура объекта с помошью узелков и кон-
трольных точек (кнопка [15]);

• прозрачность объекта (см. разд. "Регулировка прозрачности" настоящей главы).

Инструмент Spiral

Рабочий инструмент •"(§) Spiral (Спираль) входит в первую группу инструмен-

тов, создающих фигуры. Он предназначен для формирования спиралей двух ти-
пов: симметричных и логарифмических. Симметричная спираль характеризуется
фиксированным шагом витка, а логарифмическая — переменным шагом, кото-
рый изменяется по логарифмическому закону (каждый следующий виток спира-
ли все дальше отстоит от предыдущего).

На рис. 4.19 показан пример создания спиралей различных типов. Слева пред-
ставлена сформированная ранее симметричная спираль; справа — создаваемая
в данный момент логарифмическая спираль; вверху — панель свойств с пара-
метрами второй спирали.

Рис. 4.19. Пример создания спиралей инструментом Spiral

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Spiral (их номера, приведенные на ри-
сунке, даны здесь в квадратных скобках):

П [1] — поле (со счетчиками) Spiral Revolutions, в котором указывается число
витков спирали;

П [2] — кнопка Symmetrical Spiral, задающая режим формирования спирали
симметричного типа, который характеризуется фиксированным шагом;

П [3] — кнопка Logarithmic Spiral, подключающая режим формирования спира-
ли логарифмического типа, для которого шаг спирали возрастает по лога-
рифмическому закону;
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О [4] — ползунок Spiral Expansion Factor, регулирующий коэффициент увели-
чения шага спирали логарифмического типа.

Порядок работы
1. Откройте документ на нужной странице и отобразите в требуемом масштабе

ту его область, где будет создаваться геометрическая фигура.

2. Выберите рабочий инструмент Spiral (Спираль).

3. Задайте на панели свойств следующие параметры (см. рис. 4.19):

• количество витков спирали (поле Щ);

• тип спирали: симметричная (кнопка [2]) или логарифмическая (кнопка [3]);

• для логарифмической спирали — коэффициент увеличения шага спирали
(ползунок [4]).

4. Сформируйте фигуру требуемой формы в порядке, описанном в начале разде-
ла "Формирование фигур" данной главы.

5. Отрегулируйте геометрические параметры данной фигуры с помощью выде-
ляющих маркеров, расположенных вокруг и в центре созданного объекта.
Используя эти маркеры, вы можете переместить мышью фигуру в другое ме-
сто документа или трансформировать ее.

6. Для изменения направления расположения витков спирали выберите рабо-
чий инструмент Pick (Выбор) и щелкните на одной из двух кнопок Mirror
Buttons, расположенных в центре панели свойств, С их помощью вы сможете
зеркально развернуть объект по горизонтали (верхняя кнопка) или вертикали
(нижняя кнопка).

7. Выполните обводку фигуры, воспользовавшись для этого рабочей цветовой
палитрой (вместе с правой кнопкой мыши) или рабочим инструментом
Outline (Контур) (см. разд. "Обводка"настоящей главы).

Инструмент Graph Paper

Рабочий инструмент jj® Graph Paper (Сотовая структура) входит в первую

группу инструментов, создающих фигуры. Он предназначен для формирования
набора одинаковых прямоугольных ячеек, которые группируются в одном ком-
бинированном объекте прямоугольной формы.

Число ячеек по горизонтали и вертикали задается на панели свойств с помощью
всего одного элемента управления — двух полей Graph Paper Columns and Rows
(под номером [1] на рис. 4.20). В верхнем поле указывается число ячеек в сото-
вой структуре по горизонтали, а в нижнем — по вертикали.

На рис. 4.20 показан пример работы инструментом Graph Paper. Слева изобра-
жена сотовая структура в процессе ее формирования, а справа — после завер-
шения этого процесса.
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Рис. 4.20. Пример создания сотовой структуры инструментом Graph Paper

Порядок работы
1. Откройте документ на нужной странице и отобразите в требуемом масштабе

ту его область, где будет создаваться геометрическая фигура.

2. Выберите рабочий инструмент Graph Paper (Сотовая структура).

3. Введите в поля [1] панели свойств число ячеек по горизонтали и вертикали
(см. рис. 4.20).

4. Создайте фигуру сотовой структуры в порядке, описанном в начале раздела
"Формирование фигур" данной главы.

5. Отрегулируйте геометрические параметры данной фигуры с помощью выде-
ляющих маркеров, расположенных вокруг и в центре созданного объекта.
Используя эти маркеры, вы можете переместить мышью фигуру в другое ме-
сто документа или трансформировать ее.

6. Чтобы однообразно оформить все ячейки фигуры, имеющие одинаковые
размеры и прямоугольную форму, выполните заливку и обводку фигуры,
воспользовавшись рабочей цветовой палитрой или соответствующими рабо-
чими инструментами (см. разд. "Заливка" и "Обводка"настоящей главы).

7. Если каждая ячейка фигуры должна иметь свои атрибуты оформления, то
сделайте следующее. Выполните команду Arrange > Ungroup (Располо-
жить > Разгруппировать), преобразовав исходный групповой объект в не-
сколько независимых объектов, представляющих собой одинаковые прямо-
угольники. Выберите рабочий инструмент Pick (Выбор). Последовательно
выделяя по одному или по несколько прямоугольников (щелчками мыши
при нажатой клавише <Shift>), выполните их заливку и обводку либо удалите
лишние прямоугольники клавишей <Del>. Для завершения обработки пря-
моугольников снова объедините их в один объект командой Arrange > Group
(Расположить > Сгруппировать).
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Инструмент Smart Drawing

Новый рабочий инструмент Smart Drawing (Умное рисование) входит
в единственном числе в третью группу инструментов, формирующих геометри-
ческие фигуры. Он позволяет создавать фигуры путем автоматического преобра-
зования в них исходных фигур, нарисованных от руки.

Если исходная фигура отдаленно напоминает прямоугольник, эллипс, треуголь-
ник, параллелограмм или трапецию, то из нее будет образована стандартная
геометрическая фигура одной из указанных форм. Причем в последних трех
случаях она будет представлять собой автофигуру, содержащую управляющий
маркер. Во всех остальных случаях результирующая фигура может иметь произ-
вольную форму, отличающуюся от формы исходной фигуры лишь отсутствием
неровностей, вызванных рисованием от руки.

На рис. 4.21 показан пример создания инструментом Smart Drawing трех гео-
метрических фигур: прямоугольника (слева), эллипса (посредине) и трапеции
(справа). Вверху здесь зафиксирован момент завершения процесса рисования
образующих ФИГУР> а внизу изображены результирующие фигуры.

1 2 3

Рис. 4.21. Пример создания различных фигур инструментом Smart Drawing

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Smart Drawing (их номера, приведен-
ные на рисунке, даны здесь в квадратных скобках):

П [\] — раскрывающийся список Shape Recognition Level, в котором произво-
дится выбор степени близости результирующей фигуры к исходной;

О [2] — список Smart Smoothing Level, используемый для выбора уровня сгла-
живания краев результирующей фигуры по сравнению с исходной;

П [3] — список Outline Width, предназначенный для выбора толщины линии
обводки фигуры.
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Инструменты создания автофигур
В CorelDRAW 12 предусмотрена возможность создания автофигур, представ-
ляющих собой специальные векторные объекты, обладающие двумя характер-
ными свойствами:

П имеют заданные геометрические формы;

П геометрические параметры этих объектов можно регулировать в интерактив-
ном режиме с помощью управляющих маркеров (они раскрашены разными
цветами).

Программа позволяет создавать автофигуры пяти типов. Для этой цели исполь-
зуется такое же количество рабочих инструментов, находящихся в восьмой
ячейке блока инструментов (четвертая группа инструментов формирования фи-
гур). В названии каждого из этих инструментов указывается тип автофигур, ко-
торые могут быть им созданы. Выбор рабочего образца автофигуры производит-
ся на панели свойств (список Perfect Shapes).

К числу инструментов формирования автофигур относятся следующие:

Basic Shapes (Базовые формы) — 15 образцов базовых фигур;
V

Arrow Shapes (Формы стрелок) — 21 образец стрелок;

Flowchart Shapes (Формы блок-схем) — 23 образца элементов блок-схем;

Star Shapes (Формы звезд) — 12 образцов звезд;

Callout Shapes (Формы выносок) — 6 образцов выносок.

^ Примечание

Все автофигуры, создаваемые в CorelDRAW 12, доступны также и для тексто-
вого редактора Microsoft Word 97/2000.

На рис. 4.22 представлены некоторые образцы автофигур, созданные с помощью
указанных выше инструментов (каждому из них соответствует отдельный ряд
фигур). Вверху вы видите панель свойств с открытым списком Perfect Shapes.
содержащим образцы выносок в связи с выбором инструмента Callout Shapes.

Порядок работы
1. Откройте документ на нужной странице и отобразите в требуемом масштабе

ту его область, где будет создаваться автофигура.

2. Выберите рабочий инструмент для создания автофигуры требуемого типа,
указанного в названии инструмента: Basic Shapes (Базовые формы), Arrow
Shapes (Формы стрелок), Flowchart Shapes (Формы блок-схем), Star Shapes
(Формы звезд) и Callout Shapes (Формы выносок).
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Рис. 4.22. Пример создания автофигур следующими инструментами:
1 — Basic Shapes, 2 — Arrow Shapes, 3 — Flowchart Shapes,

4 — Star Shapes и 5 — Callout Shapes.
Под номером 6 отмечены управляющие маркеры выделенного объекта

3. Откройте в центре панели свойств список Perfect Shapes (Совершенные
формы) с образцами автофигур заданного типа и выберите в нем требуе-
мый образец, щелкнув на нем.

4. Сформируйте автофигуру в порядке, описанном в начале раздела "Формирова-
ние фигур" данной главы.

5. Отрегулируйте геометрические параметры фигуры путем воздействия мышью
на ее разноцветные управляющие маркеры (при их наличии), а также на
обычные выделяющие маркеры.

6. Задайте на панели свойств стиль оформления линии обводки фигуры (спи-
сок Outline Style Selector) и толщину данной линии (поле Outline Width).

7. Выполните заливку и обводку созданного вами объекта, используя для этого
рабочую цветовую палитру или соответствующие рабочие инструменты
(см, разд. "Заливка" и "Обводка" настоящей главы).

8. Отрегулируйте при необходимости другие параметры данного объекта, опре-
деляющие:

• положение объекта по толщине текущего слоя документа (кнопки
То Front и То Back);

• вид текстовой оборки объекта (кнопка Wrap Paragraph Text);

• прозрачность объекта (см. разд. "Регулировка прозрачности" данной главы).
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Обработка линий и фигур
Создав некоторый векторный объект, представляющий собой линию или фигуру,
вы можете откорректировать его форму, используя следующие шесть рабочих ин-
струментов CorelDRAW 12, находящихся во второй ячейке блока инструментов:

Shape (Форма), ! Knife (Нож), $ Eraser (Ластик), ф Smudge Brush

(Мажущая кисть), щ Roughen Brush (Разрыхляющая кисть) и Virtual

Segment Delete (Удаление виртуального сегмента).

Эти инструменты позволяют выполнять следующие операции:

О Shape — редактирование контуров Безье с помощью узелков и контрольных точек;

О Knife — коррекция формы объекта путем перерисовки его отдельных участ-
ков, а также разбивка данного объекта на несколько;

П Eraser — удаление отдельных участков объекта, на которые происходит воз-
действие (при нажатой кнопке мыши);

П Smudge Brush — изменение формы объекта с контуром Безье путем воздейст-
вия на этот контур изнутри или снаружи от объекта при нажатой кнопке
мыши;

П Roughen Brush — формирование зубцов в контуре Безье путем воздействия на
выбранный участок контура при нажатой кнопке мыши;

П Virtual Segment Delete — удаление (щелчками мыши) отдельных участков
контуров пересекающихся векторных объектов.

Настройка параметров всех этих инструментов производится на панели свойств.

Инструмент Shape

Рабочий инструмент :Д| Shape (Форма) предназначен для обработки векторных
контуров Безье, состоящих из узелков, сегментов и контрольных точек.

Перечислим рабочие инструменты CorelDRAW 12, которые создают векторные
объекты с контурами Безье, доступными для обработки Shape:

О пять инструментов рисования обычных линий: Freehand (Рисование от руки),
Polyline (Ломаная линия), Bezier (Безье), Реп (Перо) и 3 Point Curve (Кривая
по трем точкам);

О три инструмента рисования фигурных линий — Artistic Media > Preset (Ком-
плект художника * Фигурная кисть). Artistic Media > Calligraphic (Комплект
художника > Каллиграфическое перо) и Artistic Media > Pressure (Комплект
художника > Перо с нажимом);

Особенность обработки фигурной линии инструментом Shape состоит в том,
что инструмент воздействует не на видимый контур данного векторного объекта,
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доступный для обводки, а на образующий контур Беэье, проходящий посредине
толщины линии. Этот контур будет отображаться на экране (в виде пунктирной
линии голубого цвета) лишь при выделении объекта инструментом Shape.

О инструмент формирования спиралей Spiral (Спираль).

В том случае, когда объект представляет собой одно из двух:

О геометрическую фигуру, созданную одним из рабочих инструментов:
Rectangle (Прямоугольник), 3 Point Rectangle (Прямоугольник по трем точ-
кам), Ellipse (Эллипс), 3 Point Ellipse (Эллипс по трем точкам) или Polygon
(Многоугольник);

G автофигуру, созданную одним из рабочих инструментов: Basic Shapes (Базо-
вые формы), Arrow Shapes (Формы стрелок), Flowchart Shapes (Формы блок-
схем), Star Shapes (Формы звезд) или Calloul Shapes (Формы выносок),

то его контур вы сможете обработать инструментом Shape лишь после его пре-
образования в кривую Безье с помощью команды Arrange > Convert To Curves
(Расположить> Преобразовать в кривые) или кнопки Convert To Curves панели
свойств (она крайняя справа).

Если же объект представляет собой сотовую структуру, созданную рабочим инст-
рументом Graph Paper (Сотовая структура), то инструмент Shape сможет обрабо-
тать лишь его составные части (прямоугольники). Для этого нужно разгруппиро-
вать исходный объект, а контуры выбранных для обработки прямоугольников
преобразовать в кривые Безье.

В процессе обработки контура Безье с узелками и контрольными точками до-
пускается выполнять самые разнообразные операции, в том числе: перемещать
узелки и контрольные точки мышью, создавать новые узелки, удалять лишние,
изменять типы узелков и многое другое. Все эти операции выполняются как
в интерактивном режиме, так и с помощью элементов управления панели свойств.

На рис. 4.23 показан пример обработки контура эллипса инструментом Shape
(задан режим вертикального отражения выделенных узелков). Вверху изображе-
на панель свойств.

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21
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Рис. 4.23. Пример работы с инструментом Shape
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Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Shape (их номера, приведенные на ри-
сунке, даны здесь в квадратных скобках):

Р [1] — кнопка Add Nodes, создающая новый узелок в том месте контура, кото-
рое было отмечено щелчком мыши;

П [2] — кнопка Delete Nodes, удаляющая выделенные узелки;

О [3] — кнопка Join Two Nodes, объединяющая два выделенных концевых узел-
ка контура в один;

О [4] — кнопка Break Curve, разрывающая контур в выделенном узелке;

О [5] — кнопка Convert Curve To Line, преобразующая криволинейный сегмент
контура, входящий в выделенный узелок, в прямолинейный сегмент;

О [6] — кнопка Convert Line To Curve, преобразующая прямолинейный сегмент
контура, входящий в выделенный узелок, в криволинейный сегмент;

П [7] — кнопка Make Node A Cusp, преобразующая выделенный узелок в угло-
вой узелок;

П [8] — кнопка Make Node Smooth, преобразующая выбранный узелок в сгла-
женный;

d [9] — кнопка Make Node Symmetrical, преобразующая выделенный узелок
в симметричный;

О [10] — кнопка Reverse curve direction, изменяющая направление формирова-
ния контура на противоположное;

О [11] — кнопка Extend Curve to Close, соединяющая два выделенных концевых
узелка прямолинейным отрезком;

О [12] — кнопка Extract Subpath, отделяющая составной контур, содержащий
выделенные узелки;

П [13] — кнопка Auto-Close Curve, автоматически замыкающая концы каждого
из составных контуров;

О [14] — кнопка Stretch and Scale Nodes, задающая режим перемещения и
масштабирования выделенных узелков;

О [15] — кнопка Rotate and Skew Nodes, подключающая режим поворота и на-
клона выбранных узелков;

d [16] — кнопка Align Nodes, выравнивающая выделенные узелки;

О [17] — кнопка Elastic Mode, задающая режим эластичной кривой;

О [18] — кнопка Select All Nodes, выделяющая все узелки;

О [19] — ползунок Curve Smoothness, регулирующий уровень сглаживания уча-
стков контура в местах расположения выделенных узелков;

О [20] — кнопка Reflect Nodes Horizontally, подключающая режим симметричного
изменения горизонтального положения одного из двух выделенных узелков
контура при перемещении указателем второго узелка данного контура;
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П [21] — кнопка Reflect Nodes Vertically, подключающая режим симметричного
изменения вертикального положения одного из двух выделенных узелков
контура при перемещении указателем второго узелка (см. рис. 4.23).

Порядок работы
1. Откройте документ на нужной странице и отобразите в требуемом масштабе

область расположения векторного объекта, подлежащего обработке.

2. Если контур данного объекта не является кривой Безье, то преобразуйте его
в такую кривую. Для этого выделите объект рабочим инструментом Pick
(Выбор) и выполните команду Arrange > Convert To Curves (Расположить 1>
Преобразовать в кривые).

3. Выберите рабочий инструмент Shape (Форма) и щелкните на объекте, если
он не был выделен.

4. С помощью инструментов панели свойств (см. рис. 4.23) отредактируйте
форму контура Безье объекта, руководствуясь при этом следующими реко-
мендациями:

• чтобы выделить один узелок контура, достаточно щелкнуть на нем мы-
шью, а чтобы выделить несколько узелков, можно воспользоваться одним
из двух способов: последовательно щелкнуть на всех выделяемых узелках
при нажатой клавише <Shift> или сформировать с помощью указателя
(при нажатой кнопке мыши) прямоугольную область, охватывающую все
узелки, которые должны быть выделены;

• для создания нового узелка поместите указатель в нужном месте контура
и сделайте одно из двух: отметьте это место щелчком мыши, а затем
щелкните на кнопке [1] панели свойств или сделайте двойной щелчок
кнопкой мыши в выбранном месте контура;

• чтобы удалить некоторый узелок, выделите его и щелкните на кнопке [2]
либо выполните двойной щелчок на данном узелке;

• для разрыва контура в некоторой точке выделите эту точку мышью и
щелкните на кнопке [4]. Если исходный контур был разомкнут, то в ре-
зультате такого разрыва он разделится на две связанные между собой час-
ти, доступные для редактирования. Для их полного отделения друг от
друга необходимо сделать дополнительный щелчок на кнопке [12];

• для замыкания концов одного или нескольких составных контуров можно
воспользоваться тремя способами. Первый способ: выделите концевые
узелки, связываемые друг с другом, и щелкните на кнопке [3], в результа-
те чего эти узелки сойдутся в один общий узелок, а прилегающие к ним
сегменты контура изменят свою форму. Второй способ: выделите связы-
ваемые узелки и щелкните на кнопке [И], соединив эти узелки отрезком
прямой. Третий способ: щелкните на кнопке [13] без предварительного
выделения концевых узелков, в результате чего произойдет замыкание
концов каждого из составных контуров отрезками прямых;
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• если обрабатываемый объект представляет собой фигурную линию или
стрелку, для которой необходимо изменить направление в документе, то
для этого достаточно щелкнуть на кнопке [10];

• для выделенных узелков контура можно выполнить следующие три опе-
рации: а) переместить эти узелки с помощью мыши по горизонтали или
вертикали, щелкнув для этого на кнопке [14]; б) повернуть выбранные
узелки мышью на любой угол или сместить их относительно друг друга
(кнопка [15]); в) выровнять положение выбранных узелков по горизонта-
ли или вертикали (кнопка [16]);

• чтобы устранить опасность образования петель в контуре при перемеще-
нии его узелков, следует нажать кнопку [17];

• для сглаживания формы сегментов контура, примыкающих к выделенным
узелкам, следует воспользоваться ползунком [19];

• для симметричного изменения горизонтального или вертикального поло-
жения одного из двух узелков контура выделите два требуемых узелка
щелчками на них при нажатой клавише <Shift>, нажмите кнопку [20] или
[21], после чего выполните необходимое перемещение мышью одного из
этих узелков.

Инструмент Knife

Рабочий инструмент 4: # Knife (Нож) позволяет выполнять следующую обработ-

ку векторных объектов:

О разрыв контура объекта;

П разделение на части объекта с замкнутым контуром;

О изменение формы объекта.

На рис. 4.24 показан пример использования инструмента Knife для разбивки
векторного объекта в форме эллипса на два независимых объекта по произволь-
ной траектории. Вверху расположена панель свойств с заданными параметрами
инструмента; посредине — обрабатываемый объект в момент, непосредственно
предшествующий отпуску кнопки мыши; внизу — два результирующих объекта,
левый из которых выделен и немного смещен влево.

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Knife (их номера, приведенные на ри-
сунке, даны в квадратных скобках):

П [1] — кнопка Leave As One Object, задающая режим сохранения единого объ-
екта в процессе его обработки;

П [2] — кнопка Auto-Close On Cut, подключающая режим автоматического за-
мыкания контуров составных частей объекта.
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1 2

Рис. 4.24. Пример работы с инструментом Knife

f^~ Примечание

Если в процессе обработки объекта был включен режим его сохранения, то ре-
зультирующий объект также будет один. Чтобы его разделить на независимые
объекты, представляющие собой сформированные данным инструментом час-
ти, необходимо дополнительно выполнить команду Arrange > Break Apart
(Расположить * Разъединить).

Порядок работы
1. Откройте документ на нужной странице и отобразите в требуемом масштабе

область расположения объекта, подлежащего обработке (выделять этот объ-
ект не обязательно).

2. Выберите рабочий инструмент Knife (Нож).

3. Чтобы разорвать контур объекта в некотором месте, сделайте следующее.
На панели свойств отожмите кнопки [1] и [2] (см. рис. 4.24). Поместите ука-
затель, имеющий вид наклоненного ножа, в место будущего разрыва контура
объекта и, как только нож расположится вертикально, щелкните кнопкой
мыши. В результате в месте щелчка появится метка разрыва в форме квад-
ратной рамки с более толстым ободком, чем для обычного узелка.

f Примечание

Если обрабатываемый объект имел замкнутый контур, а его внутренняя об-
ласть была залита, то в результате разрыва контура эта область станет про-
зрачной (при условии, что задан режим отсутствия отображения внутренних
областей объектов с разомкнутыми контурами).
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4. Для разделения объекта с замкнутым контуром на два независимых объекта
сделайте следующее. На панели свойств отожмите кнопку [1] и нажмите
кнопку [2], после чего выполните один из двух вариантов действий,

• Если линия разреза должна быть прямой, поместите указатель, имеющий
вид наклоненного ножа, в исходную точку разреза и, как только нож рас-
положится вертикально, щелкните кнопкой мыши. После этого перемес-
тите указатель в конечную точку разреза, также расположенную на конту-
ре, и при повторном изменении его формы сделайте еще один щелчок.
В результате исходный объект разделится на два отдельных объекта по от-
резку прямой, проходящей через эти две точки. При этом каждый из
вновь образованных объектов будет иметь замкнутый контур.

• Если линия разреза должна иметь произвольную форму, поместите указа-
тель в исходную точку разреза, нажмите кнопку мыши, переместите ука-
затель по нужной вам траектории в конечную точку, после чего кнопку
отпустите. При этом сформируется линия разреза, совпадающая с траек-
торией перемещения указателя.

5. Чтобы изменить на некотором участке форму объекта, имеющего замкнутый
или разомкнутый контур, выполните следующее. На панели свойств отожми-
те кнопку [1] и нажмите кнопку [2]. Если новый участок контура объекта
должен быть прямолинейным, то сформируйте его так же, как это описыва-
лось на предыдущем шаге инструкции в отношении формирования прямой
линии разреза для объекта с замкнутым контуром. Если же форма нового
участка контура является произвольной, то он формируется (при нажатой
кнопке мыши) точно так же, как произвольная линия разреза для объекта
с замкнутым контуром (см. предыдущий шаг инструкции). В результате обработ-
ки объекта с замкнутым контуром будут сформированы два объекта; резуль-
тирующий, который вам необходим, и дополнительный. Для удаления по-
следнего необходимо его выделить рабочим инструментом Pick (Выбор) и
нажать клавишу <Del>.

Инструмент Eraser

Рабочий инструмент ,$>* Eraser (Ластик) удаляет из выбранного векторного

объекта те участки, на которые он воздействует при нажатой кнопке мыши.
С помощью этого инструмента вы можете решать следующие две задачи:

П формировать внутри обрабатываемого объекта полые (полностью прозрач-
ные) области произвольных форм;

П разбивать объект на несколько частей с замкнутыми контурами, которые за-
тем могут быть преобразованы в отдельные объекты с помощью команды
Arrange » Break Apart (Расположить > Разъединить).

На рис. 4.25 показан пример использования инструмента Eraser для форми-
рования полой области внутри векторного объекта эллиптической формы.
Вверху представлена панель свойств с заданными параметрами инструмента;
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посредине — обрабатываемый объект в момент, непосредственно предшествую-
щий отпуску кнопки мыши; внизу — результирующий объект.

I 2

:8j5 mm

Рис. 4.25. Пример работы с инструментом Eraser

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Eraser (их номера, приведенные на ри-
сунке, даны в квадратных скобках):

П [1] — поле Erase Thickness, в котором указывается толщина ластика (ширина
области воздействия инструмента на объект обработки);

G [2] — кнопка Auto-Reduce On Erase, задающая режим автоматического удале-
ния лишних узелков на участках контуров, формируемых инструментом;

П [3] — кнопка Circle/Square, позволяющая выбрать одну из двух форм ласти-
ка: круглую (кнопка отжата) или квадратную (нажата).

Порядок работы
1. Откройте документ на нужной странице и отобразите в требуемом масштабе

ту его область, где находится объект обработки.

2. Выделите этот объект рабочим инструментом Pick (Выбор).

3. Выберите рабочий инструмент Eraser (Ластик).

4. На панели свойств задайте следующие параметры (см. рис. 4.25):

• толщину ластика (поле [1]);

• форму ластика (кнопка [3]);

• режим удаления лишних узелков (кнопка \2\).

5. Выполните обработку (при нажатой кнопке мыши) областей заливки и об-
водки объекта, удалив из них лишние области.

7 Зак. 250
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6. Если в результате обработки будут сформированы отдельные части, не
имеющие между собой общих точек, которые вы хотите преобразовать в не-
зависимые объекты, то выполните для этого команду Arrange > Break Apart
(Расположить > Разъединить).

Инструмент Smudge Brush

Рабочий инструмент Smudge Brush (Мажущая кисть) позволяет изменять форму

векторного объекта, имеющего конур Безье, путем воздействия на этот контур
(снаружи или изнутри объекта) при нажатой кнопке мыши. Область воздействия
инструмента имеет эллиптическую форму, параметры которой регулируются на
панели свойств.

На рис. 4.26 показан пример использования инструмента Smudge Brush для
формирования углубления в области векторного объекта эллиптической формы.
Вверху находится панель свойств с заданными параметрами инструмента; по-
средине — обрабатываемый объект в момент, непосредственно предшествующий
отпуску кнопки мыши; внизу — результирующий объект.

2 3 4 5 6 7

0,0

Ц
о.
а

Рис. 4.26. Пример работы с инструментом Smudge Brush

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Smudge Brush (их номера, приведенные
на рисунке, даны в квадратных скобках):

П [1] — поле Nib size, в котором указывается максимальный размер профиля
кисти эллиптической формы, представляющего собой отображаемую на эк-
ране область воздействия инструмента на векторный контур;

[2] — кнопка Use stylus pressure setting, открывающая дополнительную па-
нель управления с параметрами настройки специального инструмента- пера,
подключенного к компьютеру вместе с планшетом, при изменении нажима

О
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которого на планшет регулируются степень и область воздействия данного
инструмента на контур объекта;

О [3] — поле Add Dryout to the effect, задающее коэффициент высыхания кисти,
который характеризует уменьшение размеров профиля кисти в зависимости от
расстояния, пройденного инструментом от обрабатываемого участка контура;

И [4] — кнопка Use stylus tilt setting, открывающая дополнительную панель
управления с параметрами инструмента-пера, определяющими зависимость
между углом наклона данного инструмента к плоскости планшета и эллип-
тической формой профиля кисти;

П [5] — поле Enter a fixed value for tilted setting, определяющее угол наклона инст-
румента к плоскости документа (в градусах), от которого зависит форма профиля
кисти (чем меньше угол, тем более сплющенным будет этот профиль);

П [6j — кнопка Use stylus bearing setting, открывающая дополнительную панель
управления с параметрами инструмента-пера, определяющими зависимость
между углом ориентации данного инструмента на планшете и углом наклона
к вертикали большой оси эллипса профиля кисти;

П [7] — поле Enter a fixed value for bearing setting, в котором указывается угол
ориентации профиля кисти (в градусах), представляющей собой угол наклона
к вертикали большей оси эллипса профиля.

Порядок работы
1. Откройте документ на нужной странице и отобразите в требуемом масштабе

ту его область, где находится объект обработки.

2. Выделите этот объект рабочим инструментом Pick (Выбор).

3. Если контур объекта не является кривой Безье, преобразуйте его в такую
кривую, выполнив команду Arrange > Convert To Curves (Расположить >
Преобразовать в кривые).

4. Выберите рабочий инструмент Smudge Brush (Мажущая кисть).

5. На панели свойств задайте следующие параметры (см. рис. 4.26):

• максимальный размер профиля кисти (поле [1]);

• коэффициент высыхания кисти (поле [3]);

• угол наклона инструмента к плоскости документа (поле [5]);

• угол ориентации профиля кисти (поле [?)).

6. Установите указатель снаружи (изнутри) того участка контура объекта, кото-
рый должен быть обработан, нажмите кнопку мыши и перетащите указатель
по заданной траектории вовнутрь (наружу от) объекта, после чего кнопку
мыши отпустите. В результате в месте обработки объекта появится углубле-
ние (выступ) заданной вами формы.

7. Повторите два предыдущих шага инструкции для всех участков контура объ-
екта, требующих обработки.
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Инструмент Roughen Brush

Рабочий инструмент :'$? Roughen Brush (Разрыхляющая кисть) позволяет сфор-

мировать зубцы в контуре Безье векторного объекта путем перемещения вдоль
выбранного участка этого контура. Параметры зубцов регулируются на панели
свойств.

На рис. 4.27 показан пример использования инструмента Roughen Brush для
формирования зубцов в контуре векторного объекта эллиптической формы.
Вверху представлена панель свойств с заданными параметрами инструмента;
посредине — обрабатываемый объект в момент, непосредственно предшествую-
щий отпуску кнопки мыши; внизу — результирующий объект.

I 8

15,0 mm :30,0 Fixed Direction *;».45,Q

Рис. 4.27. Пример работы с инструментом Roughen Brush

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Roughen Brush (их номера, приведен-
ные на рисунке, даны в квадратных скобках):

П [1] — поле Nib size, в котором указывается максимальная высота зубцов;

П [2] — кнопка Use stylus pressure to control the frequency of the spikes, откры-
вающая дополнительную панель для настройки специального инструмента-
пера, подключенного к компьютеру вместе с планшетом, регулирующего час-
тоту зубцов в зависимости от его нажима на планшет;

П [3] — поле Enter a value for frequency of spikes, задающее частоту зубцов;

П [4] — поле Add Dryout to the effect, определяющее коэффициент высыхания
кисти, который характеризует уменьшение размеров зубцов при одновремен-
ном увеличении их частоты в зависимости от расстояния, пройденного инст-
рументом вдоль обрабатываемого участка контура от точки нажатия кнопки
мыши;

П1 [5] — кнопка Use stylus tilt, открывающая дополнительную панель управле-
ния с параметрами инструмента-пера, определяющими зависимость между
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углом наклона данного инструмента к плоскости планшета и углом и высо-
той формируемых зубцов;

П [6] — поле Enter a fixed value for tilted setting, в котором указывается угол на-
клона инструмента к плоскости документа (в градусах), от которого зависят
фактический угол и высота зубцов (чем меньше угол, тем более острыми и
высокими будут зубцы);

О [7] — раскрывающийся список Spike Direction, используемый для выбора
одного из двух вариантов наклона зубцов:

• Auto — симметричное расположение зубцов на контуре;

• Fixed Direction — фиксированный угол наклона зубцов к вертикали, зада-
ваемый в следующем по порядку поле;

О [8] — поле Enter a fixed value for bearing setting, определяющее величину фик-
сированного угла наклона зубцов к вертикали (в градусах).

Порядок работы

1. Откройте документ на нужной странице и отобразите в требуемом масштабе
ту его область, где находится объект обработки.

2. Выделите этот объект рабочим инструментом Pick (Выбор).

3. Если контур объекта не является кривой Безье, преобразуйте его в такую
кривую, выполнив команду Arrange > Convert To Curves (Расположить > Преоб-
разовать в кривые).

4. Выберите рабочий инструмент Roughen Brush (Разрыхляющая кисть).

5. На панели свойств задайте следующие параметры (см. рис. 4.27):

• максимальную высоту зубцов (поле [1]);

• частоту зубцов (поле [3]);

• коэффициент высыхания кисти (поле [4]);

• угол наклона инструмента к плоскости документа (поле [6|);

• вариант наклона зубцов (список [7]);

• угол наклона зубцов к вертикали, если выбран второй вариант наклона
(поле [8]).

6. Установите указатель в исходной точке обрабатываемого участка контура
объекта, нажмите кнопку мыши и перетащите указатель вдоль этого участка
до его конца, после чего отпустите кнопку мыши. В результате будут сфор-
мированы зубцы.

7. Повторите два предыдущих шага инструкции для всех участков контура объ-
екта, требующих обработки.
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Инструмент Virtual Segment Delete

Новый рабочий инструмент '$% Virtual Segment Delete (Удаление виртуального

сегмента) позволяет выполнить обработку контуров векторных объектов, нало-
женных друг на друга, путем удаления тех их видимых частей, на которых про-
изводятся щелчки мышью. Удаляемый участок контура, выбираемый указателем
в момент выполнения щелчка мышью, ограничивается ближайшими к указате-
лю точками пересечения данного контура с другими контурами перекрываю-
щихся объектов документа.

На рис. 4.28 показан пример обработки векторных контуров инструментом
Virtual Segment Delete. Вверху рассмотрен случай формирования составного
контура из перекрывающихся фигур прямоугольника и эллипса, а внизу — слу-
чай образования прозрачных ячеек в сотовой структуре, сформированной инст-
рументом Graph Paper.

Рис. 4.28, Пример использования инструмента Virtual Segment Delete

Наложение и распыление
изображений
Программа CorelDRAW 12 обладает широкими оформительскими возможностя-
ми в отношении векторных объектов. Среди них особенно выделяются функции
наложения и распыления изображений± которые реализуются с помощью двух

Artistic Media (Комплект художника):разновидностей рабочего инструмента

Brush (Художественная кисть) и Sprayer (Распылитель).
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Наложение изображения
Под наложением изображения понимается операция по расположению выбран-
ного образца векторного изображения вдоль контура векторного объекта доку-
мента, в результате которой происходит следующее:

П данное изображение трансформируется;

П его горизонтальная осевая линия совмещается с контуром для наложения;

П начальная и конечная точки изображения совмещаются с такими же точками
этого контура;

О максимальная ширина изображения становится равной той, которая задается
пользователем.

Операция наложения выполняется с помощью рабочего инструмента Artistic
Media > Brush (Комплект художника > Художественная кисть).

В CorelDRAW 12 используется стандартный набор образцов изображений для
наложения. Кроме того, вы можете создавать собственные образцы (кнопка
Save Artistic Media stroke на панели свойств), а также удалять те, которые были
созданы вами ранее (кнопка Delete). (См. разд. "Создание образцов и шаблонов" на-
стоящей главы, подразд. "Образцы изображений".)

Предусмотрены два способа наложения изображения: на формируемый вектор-
ный контур и на контур существующего векторного объекта, внутренняя об-
ласть которого при этом удаляется, Во втором случае может использоваться аль-
тернативное средство — докер Artistic Media (Комплект художника).

Векторное изображение, сформированное в результате наложения, может быть
обработано. Для этого вы должны выполнить две команды меню Arrange (Рас-
положить): Break Apart (Разъединить), которая в данном случае называется
Break Artistic Media Group Apart (Разъединить группу для комплекта художни-
ка), и Ungroup (Разгруппировать). Первая из этих команд отделяет изображение
от контура, на который оно наложено, а вторая разгруппировывает его.

На рис. 4.29 показан пример наложения трех изображений на разомкнутые кри-
вые и контуры эллипсов. Вверху изображена панель свойств с параметрами на-
ложения для выделенного объекта, а справа — докер Artistic Media.

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Artistic Media > Brush (их номера, при-
веденные на рисунке, даны в квадратных скобках):

О [1] — кнопка Brush, подключающая данный инструмент;

О [2] — ползунок Freehand Smoothing, регулирующий уровень сглаживания
контурной линии;

П [3] — поле (со счетчиками) Artistic Media Tool Width, в котором указывается
максимальная ширина наложенного изображения;

П [4] — кнопка Browse, подключающая режим выбора на диске файла с образ-
цом изображения, предназначенным для наложения;
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[5] — раскрывающийся список Brush Stroke List, предназначенный для вы-
бора одного их образцов изображений, доступных для наложения;

[6] — кнопка Save Artistic Media stroke, сохраняющая выделенный в доку-
менте векторный объект в файле (с расширением стх) в качестве образца
для наложения;

[7] —- кнопка Delete, удаляющая выбранный образец из списка [5] при усло-
вии, что этот образец было сформирован пользователем.

V ^

Рис. 4.29. Пример выполнения операции наложения изображения

Порядок наложения на формируемый контур
1. Откройте документ на нужной странице и отобразите в требуемом масштабе ту

его область, где будет формироваться контур с наложенным изображением.

2. Выберите рабочий инструмент Artistic Media (Комплект художника).

3. На панели свойств выполните следующие настройки (см, рис. 4.29):

• подключите инструмент Brush, (кнопка [1]);

• установите требуемый уровень сглаживания формируемой контурной ли-
нии (ползунок [2]);

• задайте максимальную ширину накладываемого изображения (поле [3]);

• выберите рабочий образец изображения, используемый для наложения
(список (5J).

4. Сформируйте контур, на который будет наложено выбранное изображение.
Для этого установите указатель в исходном месте документа, нажмите кнопку
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мыши, переместите указатель по заданной траектории в конечную точку, по-
сле чего отпустите кнопку мыши.

5. Отрегулируйте геометрические параметры наложенного изображения с по-
мощью инструмента [3] панели свойств или выделяющих маркеров, распо-
ложенных вокруг созданного вами объекта и в его центре. Используя эти
маркеры, вы можете переместить изображение в другое место документа,
а также трансформировать его (масштабировать по горизонтали и вертикали,
повернуть относительно произвольной точки документа или наклонить).

6. Если необходимо, измените цвета заливки и обводки данного изображения,
используя для этого рабочую цветовую палитру и обе кнопки мыши.

Порядок наложения на существующий контур
1. Откройте документ на нужной странице и отобразите ту его область, где на-

ходится векторный объект, на контур которого будет наложено изображение.

2. Чтобы сформировать наложенное изображение без использования докера
Artistic Media (Комплект художника), сделайте следующее. Выберите рабочий
инструмент Artistic Media (Комплект художника) и подключите на панели
свойств инструмент Brush (кнопка [1]). Выделите щелчком мыши объект, на
контур которого будет наложено изображение. Задайте на панели свойств
максимальную ширину накладываемого изображения (поле [3]) и выберите
образец данного изображения (список [5]). Если значения этих параметров,
заданные по умолчанию, вас устраивают, то хотя бы один из них выберите
повторно, что даст программе сигнал на формирование изображения вдоль
контура выбранного объекта.

3. Для формирования наложенного изображения с помощью докера Artistic
Media (Комплект художника), выполните следующие действия. Откройте до-
кер Artistic Media (Комплект художника), выполнив одноименную команду
подменю Dockers (Докеры) меню Window (Окно). Выделите объект рабочим
инструментом Pick (Выбор). Нажмите мышью кнопку Auto Apply (Автомати-
чески применить) с изображением замка, расположенную внизу докера.
В одном из двух рабочих окон докера, содержащих стандартные профили
фигурных линий, а также образцы изображений для наложения (одиночные)
и распыления (в виде гирлянд), выберите мышью нужное одиночное изо-
бражение. В результате произойдет наложение выбранного изображения
на контур выделенного объекта и автоматический переход в режим работы
с инструментом Artistic Media > Brush (Комплект художника > Художествен-
ная кисть).

К~Ппрйм е ч а н и е

В нижнем окне докера Artistic Media представлен весь список профилей фи-
гурных линий и образцов изображений для наложения и распыления „доступ-
ных для использования в CorelDRAW 12, а в верхнем — лишь те из них, кото-
рые использовались последними в текущем сеансе работы программы.
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4, Отрегулируйте геометрические параметры сформированного изображения
с помощью соответствующего инструмента панели свойств или выделяющих
маркеров объекта.

5. Если необходимо, измените цвета раскраски наложенного изображения, ис-
пользуя рабочую цветовую палитру.

Распыление изображений
Под распылением изображений понимается операция по формированию изобра-
жения гирлянды, представляющей собой набор выбранных образцов векторных
изображений, случайным образом распределенных вдоль контура некоторого
векторного объекта и определенным образом трансформированных. Данная
операция выполняется рабочим инструментом Artistic Media * Sprayer (Ком-
плект художника > Распылитель).

В CorelDRAW 12 используется библиотека стандартных наборов образцов изо-
бражений для распыления. Кроме того, вы можете создавать собственные такие
наборы (кнопка Add to Spraylist на панели свойств), а также удалять те, которые
были созданы вами ранее (кнопка Delete). (См. разд. "Создание образцов и шабло-
нов" настоящей главы, подразд. "Образцы изображений".)

Предусмотрены два способа распыления изображений: на формируемый век-
торный контур и на контур существующего векторного объекта, внутренняя об-
ласть которого при этом удаляется. Во втором случае может использоваться аль-
тернативное средство — докер Artistic Media (Комплект художника).

Изображение гирлянды, сформированное путем распыления, может быть обра-
ботано. Для этого вы должны выполнить две команды меню Arrange (Располо-
жить): Break Apart (Разъединить), которая в данном случае называется Break
Artistic Media Group Apart (Разъединить группу для комплекта художника),
и Ungroup (Разгруппировать). Первая из этих команд отделяет изображение гир-
лянды от контура, вдоль которого оно расположено, а вторая разгруппировыва-
ет его.

На рис. 4.30 показан пример формирования изображений трех гирлянд спосо-
бом распыления изображений. Вверху изображена панель свойств с параметра-
ми выделенного (нижнего) изображения, а справа — докер Artistic Media.

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Artistic Media > Sprayer (их номера,
приведенные на рисунке, даны в квадратных скобках):

EJ [1] — кнопка Sprayer, подключающая данный инструмент;

О [2] — ползунок Freehand Smoothing, регулирующий уровень сглаживания
формируемого контура, вдоль которого будут распыляться выбранные изо-
бражения;

О [3] — два поля (со счетчиками) Size of Object(s) to be Sprayed, предназначен-
ные для задания абсолютного (верхнее поле) и относительного коэффициен-
тов масштабирования распыляемых изображений;
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Рис. 4.30. Пример выполнения операции распыления изображений

[4] -• кнопка Incremental Scaling, подключающая режим относительного
масштабирования для последующих изображений;

[5] — кнопка Browse, задающая режим выбора на диске папки с файлами,
содержащими наборы образцов изображений для распыления;

[6] — раскрывающийся список Spraylist File List, в котором производится
выбор набора образцов изображений для распыления (пункт New Spraylist
используется при последовательном формировании из объектов документа
нового набора образцов);

[7] — кнопка Save Artistic Media stroke, сохраняющая текущий набор образ-
цов в файле (с расширением cdr) для их последующего распыления;

[8] — кнопка Delete, удаляющая текущий набор образцов;

[9] — список Choice of spray order, предназначенный для выбора одного из
следующих вариантов расположения распыляемых образцов в формируемом
изображении гирлянды:

• Randomly — в случайном порядке;

• Sequentially — в порядке расположения образцов в рабочем наборе;

• By Direction — в зависимости от расположения текущего участка контура;

[10] — .кнопка Add to Spraylist, добавляющая выделенный объект документа
к текущему набору изображений, предназначенных для распыления;
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П [11] — кнопка Spraylist Dialog, формирующая из текущего набора образцов
изображений их рабочий набор, фактически используемый при распылении;

О [12] — два поля Dabs/Spacing оГ Object(s) to be Sprayed, в верхнем из которых
указывается коэффициент кратности для распыляемых образцов изображе-
ний, а в нижнем — величина промежутка между соседними образцами
в формируемом изображении гирлянды;

П [13] — кнопка Rotation, открывающая панель управления с параметрами по-
ворота распыляемых изображений;

П [14] — кнопка Offset, открывающая панель управления с параметрами их
смещения;

СЗ [15] — кнопка Reset Values, восстанавливающая исходные значения парамет-
ров распыляемых изображений.

Порядок распыления вдоль формируемого контура
1. Откройте документ на нужной странице и отобразите в требуемом масштабе

ту его область, где будет формироваться изображение гирлянды.

2. Выберите рабочий инструмент Artistic Media (Комплект художника).

3. На панели свойств выполните следующие настройки (см. рис. 4.30):

• подключите инструмент Sprayer (Распылитель) (кнопка [1]);

• задайте требуемый уровень сглаживания формируемой контурной линии
(ползунок [2]);

• выберите набор образцов изображений для распыления (список [6]);

• выберите в данном наборе рабочие образцы, которые фактически будут
использованы при распылении (кнопка [11]). При этом откроется диало-
говое окно Create Playlist (Создать рабочий список), содержащее два ра-
бочих окна и набор кнопок управления между ними. В левом окне пред-
ставлен исходный набор изображений для распыления, а в правом -
рабочий набор, который можно отредактировать с помощью указанных
кнопок;

• если необходимо, настройте геометрические параметры распыляемых изо-
бражений.

4. Сформируйте контур, вдоль которого будут распыляться рабочие образцы
изображений. Для этого установите указатель в исходном месте документа,
нажмите кнопку мыши, переместите указатель по заданной траектории в ко-
нечную точку, после чего отпустите кнопку мыши.

5. Отрегулируйте геометрические параметры созданного изображения гирлян-
ды. Это вы можете сделать с помощью соответствующих инструментов пане-
ли свойств, а также выделяющих маркеров объекта. Используя эти маркеры,
можно переместить данное изображение в другое место документа, а также
его трансформировать.
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Порядок распыления вдоль существующего контура
1. Откройте документ на нужной странице и отобразите ту его область, где на-

ходится векторный объект, вдоль контура которого будут распыляться изо-
бражения.

2. Чтобы сформировать изображение гирлянды без использования докера
Artistic Media (Комплект художника), сделайте следующее. Выберите рабочий
инструмент Artistic Media (Комплект художника), подключите на панели
свойств инструмент Sprayer (кнопка [1]). Выделите щелчком мыши объект,
вдоль контура которого будут распыляться изображения. Выберите на панели
свойств набор образцов для распыления (список [6]), рабочие образцы
(кнопка [11]), а также параметры распыляемых изображений. Если значения
этих параметров, заданные по умолчанию, вас устраивают, то введите хотя
бы один из них повторно, что даст программе сигнал на формирование изо-
бражения гирлянды.

3. Для создания изображения гирлянды докером Artistic Media (Комплект худож-
ника), выполните следующие действия. Откройте докер Artistic Media (Ком-
плект художника), выполнив одноименную команду подменю Dockers (Доке-
ры) меню Window (Окно). Выделите объект рабочим инструментом Pick
(Выбор). Нажмите мышью кнопку Auto Apply (Автоматически применить)
с изображением замка, находящуюся внизу докера. В одном из двух рабочих
окон докера, содержащих стандартные профили фигурных линий, а также об-
разцы изображений для наложения (одиночные) и распыления (в виде гир-
лянд), выберите мышью нужное изображение гирлянды. В результате произой-
дет распределение образцов изображений из заданного набора вдоль контура
выделенного объекта, а также автоматический переход в режим работы с инст-
рументом Artistic Media > Sprayer (Комплект художника > Распылитель).

Примечание

В нижнем окне докера Artistic Media представлен весь список профилей фи-
гурных линий и образцов изображений для наложения и распыления, доступ-
ных для использования в CorelDRAW 12, а в верхнем — лишь те из них, кото-
рые использовались последними в текущем сеансе работы программы.

4. Отрегулируйте геометрические параметры созданного изображения гирлян-
ды. Это вы можете сделать с помощью соответствующих инструментов пане-
ли свойств, а также выделяющих маркеров объекта.

Заливка
CorelDRAW 12 предоставляет пользователю широкие возможности по заливке
векторных графических и текстовых объектов документа. Программа позволяет
выполнять заливки следующих шести типов: равномерную, градиентную, шаб-
лоном, текстурой, узором PostScript, а также регулируемую градиентную заливку
по сетке.
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Равномерная заливка
Равномерной заливкой называется операция раскраски внутренней области век-
торного объекта каким-либо одним цветом. Такую раскраску можно выполнить
с помощью следующих средств программы:

П рабочей (открытой) цветовой палитры;

I рабочих инструментов

П рабочего инструмента

Fill (Заливка) и Ф Interactive Fill (Интерактивная

Paintbucket (Ведро с краской) совместно с рабо-

Eyedropper (Пипетка);

П докеров Color (Цвет) и Color Styles (Цветовые стили).

При работе с цветовой палитрой, а также с инструментами Fill (Заливка)
и Interactive Fill (Интерактивная заливка) можно задавать параметры заливки
для их использования в документе по умолчанию.

Цветовая палитра
Рабочая цветовая палитра используется чаше всего для равномерной заливки. Она
характеризуется простотой эксплуатации, но ограниченными возможностями, свя-
занными с фиксированным набором образцов цветов, входящих в ее состав.

Порядок заливки

1 . Откройте нужную цветовую палитру. Это вы можете сделать с помощью соот-
ветствующей команды подменю Color Palettes (Цветовые палитры) меню
Window (Окно) или докера Color Palette Browser (Просмотр цветовых палитр),
который открывается одноименной командой из того же подменю команд.

2. Чтобы задать цвет заливки для его использования в текущем документе по
умолчанию, выполните следующие действия. Выберите рабочий инструмент
Pick (Выбор) и отмените им возможные выделения объектов в документе,
щелкнув мышью в его свободной области. Установите указатель на нужном
цветовом образце палитры и сделайте одно из двух: щелкните мышью, вы-
брав цвет данного образца, или нажмите кнопку мыши и в открывшейся до-
полнительной палитре с цветовыми оттенками поместите указатель на тре-
буемом оттенке и щелкните мышью, выбрав его. В результате на экране
откроется панель Uniform Fill (Равномерная заливка) с предупреждающим
сообщением о вступлении в силу нового цвета заливки для графических объ-
ектов (установлен флажок Graphic (Графика)), которую необходимо закрыть
щелчком на кнопке подтверждения ОК.

^^ Примечание
Панель Uniform Fill (Равномерная заливка) представляет собой небольшое
диалоговое окно с тремя флажками и двумя кнопками управления. Поскольку
в CorelDRAW 12 есть еще одно окно с таким же названием, мы не будем ис-
пользовать термин "диалоговое окно" в отношении данной панели, чтобы не
вносить путаницы.
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3. Для равномерной заливки некоторого векторного объекта документа выдели-
те этот объект инструментом Pick, установите указатель на заданном цвето-
вом образце палитры и либо щелкните мышью, либо откройте дополнитель-
ную палитру с оттенками, поместите указатель на требуемом оттенке и
сделайте щелчок.

4. Если вы хотите изменить цвет заливки выделенного объекта, воспользуйтесь
одним из трех способов:

• повторите предыдущий шаг инструкции для другого цвета палитры;

• установите указатель на выбранном цветовом образце палитры, нажмите
клавишу <Ctrl> и щелкните требуемое число раз на этом образце, сфор-
мировав промежуточный оттенок между исходным цветом объекта и цве-
том, выбранным в палитре;

• поместите указатель на образце цвета заливки, находящемся справа
в верхнем ряду строки состояния программы, и двойным щелчком мыши
откройте диалоговое окно Uniform Fill (Равномерная заливка); выберите
в этом окне нужный цвет, после чего закройте его щелчком на кнопке
подтверждения ОК.

Инструмент Fill

Рабочий инструмент Sft Fill (Заливка) обладает наиболее широкими возможно-

стями для равномерной заливки векторных объектов, которые реализуются
с помощью диалогового окна Uniform Fill (Равномерная заливка) (рис. 4.31).

Uniform Fill

Рис. 4.31. Диалоговое окно Uniform Fill, открытое на вкладке Models
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Порядок заливки

1. Чтобы задать цвет заливки для его использования в текущем документе по
умолчанию, сделайте следующее. Выберите рабочий инструмент Pick (Выбор)
и отмените им возможные выделения объектов в документе, щелкнув мышью
в его свободной области. Щелчком на кнопке рабочего инструмента Fill
(Заливка) откройте его дополнительную панель, на которой щелкните на
кнопке Fill Color Dialog (первая слева). При этом на экране откроется панель
Uniform Fill (Равномерная заливка) с предупреждающим сообщением о всту-
плении в силу нового цвета заливки для графических объектов (установлен
флажок Graphic (Графика)), которую необходимо закрыть щелчком на кноп-
ке ОК. В результате откроется диалоговое окно Uniform Fill (Равномерная
заливка).

2. Для равномерной заливки некоторого векторного объекта выделите этот объект
инструментом Pick, откройте дополнительную панель инструмента Fill, щелк-
нув на его кнопке, после чего сделайте щелчок на кнопке Fill Color Dialog.
В результате откроется диалоговое окно Uniform Fill (Равномерная заливка).

3. Выберите один из трех возможных режимов работы с цветами, которые
представлены на отдельных вкладках окна Uniform Fill:

• режим работы с цветовыми моделями (является основным) — вкладка
Models (Модели);

• режим работы с цветовыми гармониями, представляющими собой наборы
оттенков, гармонично сочетающихся между собой, — вкладка Mixers
(Смесители);

• режим работы с библиотечными цветами — вкладка Palettes (Палитры).

4. При работе на вкладке Models выполните следующие действия (см. рис. 4.31).
В раскрывающемся списке Model (Модель) выберите цветовую модель,
в формате которой будет задаваться цвет заливки. Выберите требуемый обра-
зец цвета, используя для этого цветовой синтезатор, состоящий из рабочего
окна и цветовой шкалы (левая часть вкладки), или поля, в которых указыва-
ются числовые значения базовых цветовых параметров (область Components
справа). Положение бегунка на шкале определяет цветовой оттенок, а поло-
жение квадратного маркера в рабочем окне — яркость и насыщенность
(для типа синтезатора, базирующегося на цветовой модели HSB, который
используется в диалоговом окне по умолчанию). В случае, когда синтезиро-
ванный цветовой образец не входит в цветовое пространство модели CMYK,
определитесь в отношении введения данного образца в указанное простран-
ство (для этого необходимо щелкнуть на квадратной кнопке в области
Reference, находящейся справа от слова New). Чтобы отметить область рабо-
чего окна синтезатора, в которой цветовые параметры находятся вне цветового
охвата, откройте контекстное меню щелчком на кнопке Options (Параметры) и
выполните команду Gamut Alarm (Предупреждающая раскраска), установив га-
лочку в ее названии. При этом данная область раскрасится цветом, выбранным
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в CorelDRAW 12 в качестве предупреждающего. Используя команды данного
меню, вы можете выполнить и другие регулировки: выбрать дополнитель-
ную цветовую модель для отображения в ее формате параметров заданного
образца ивета (подменю Value 2); поменять местами текущий и предыдущий
цветовые образцы (команда Swap Colors); выбрать другой тип пвегового син-
тезатора (подменю Color Viewers), Если вы хотите добавить выбранный цве-
товой образец к цветовой палитре, используемой по умолчанию, щелкните
на кнопке Add To Palette.

^"Примечание

В области Reference, находящейся в правом верхнем углу вкладки Models,
представлены два прямоугольных цветовых образца: текущий (внизу) и вы-
бранный ранее. Если какой-либо из них не входит в область охвата модели
CMYK, то слева от него появится квадратная кнопка, цвет которой входит
в данную область и при этом минимально отличается от исходного. При щелчке
на этой кнопке ее цвет будет передан основному образцу, а сама кнопка исчез-
нет с экрана.

5. При работе на вкладке Mixers (Смесители) выполните следующие действия.
Выберите цветовую модель (раскрывающийся список Model), схему задания
базовых цветовых гармоний1 (список Hues), а также схему формирования для
этих гармоний набора цветовых оттенков (список Variation). Отрегулируйте
базовые цветовые гармонии с помощью синтезатора гармоний, имеющего
вид цветного кольца с расположенной на нем интерактивной управляющей
конструкцией, Используя ползунок Size, отрегулируйте число цветовых от-
тенков (от I до 20), которые автоматически формируются для каждой из со-
ставных частей гармоний (этими оттенками раскрашены цветные квадрати-
ки, расположенные в несколько рядов под синтезатором). Если вам
необходимо перенести некоторые из этих оттенков в цветовую палитру, ис-
пользуемую по умолчанию, выделите соответствующие квадратики мышью
(с помощью клавиши <Ctrl> или <Shift>), после чего щелкните на кнопке
Add To Palette.

6. При работе на вкладке Palettes (Палитры) выполните следующие действия.
Откройте список Palette (Палитра) и выберите в нем требуемую библиотеку
цветов. Задайте базовый цвет, используя рабочее окно с набором цветных
прямоугольников (в левой части вкладки) и прокручивающуюся цветовую
шкалу справа от него. Сформируйте цветовой образец, отрегулировав пол-
зунком Tint оттенок выбранного базового цвета. Если вы хотите добавить за-
данный цветовой образец к цветовой палитре по умолчанию, щелкните на
кнопке Add To Palette.

7. Закройте окно Uniform Fill щелчком на кнопке подтверждения ОК.

1 Цветовые гармонии представляют собой наборы из групп цветовых образцов (до
пяти), гармонично сочетающихся друг с другом по цветовым и тоновым оттенкам.
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Инструмент Interactive Fill

Интерактивный рабочий инструмент ^ Interactive Fill (Интерактивная заливка)

также можно использовать для равномерной заливки векторных объектов, хотя
его основным назначением является выполнение заливок более сложных типов.
Параметры настройки инструмента задаются на панели свойств. В частности,
здесь вы можете открыть диалоговое окно Uniform Fill (Равномерная заливка), по-
зволяющее выбрать любой цветовой формат и образец цвета для заливки.

Данный инструмент не рекомендуется использовать для задания цвета заливки
по умолчанию, поскольку изменение значения любого параметра на панели
свойств приводит к открытию на экране панели Fill (Заливка), которое блокиру-
ет дальнейшие регулировки.

На рис. 4.32 показан вид панели свойств при выполнении равномерной заливки
инструментом Interactive Fill (Интерактивная заливка).

Рис. 4.32. Панель свойств при выполнении равномерной заливки
инструментом Interactive Fill

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Interactive Fill в режиме равномерной
заливки (их номера, приведенные на рисунке, даны в квадратных скобках):

О [1] — кнопка Edit Fill, открывающая диалоговое окно Uniform Fill (Равномер-
ная заливка) для выбора цвета заливки;

П [2] — раскрывающийся список Fill Type, используемый для выбора заданного
типа заливки, представленного пунктом Uniform Fill;

П [3] — список Uniform Fill Type, в котором производится выбор цветового
формата для заливки;

П [4] — поле (со счетчиками) First Color Component, в котором указывается
значение первого базового цветового параметра выбранной цветовой модели;

П [5] — аналогичное поле Second Color Component для второго параметра;

П [6] — аналогичное поле Third Color Component для третьего параметра;

О [7] — аналогичное поле Fourth Color Component для четвертого параметра,
если он имеется;

О [8) — кнопка Copy Fill Properties, подключающая режим передачи параметров
заливки выделенному объекту от другого объекта документа.

Порядок заливки

1. Выберите рабочий инструмент Interactive Fill (Интерактивная заливка).

2. Выделите в документе требуемый векторный объект, щелкнув на нем
мышью.
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3. Если вы хотите перенести на выбранный объект параметры заливки из дру-
гого объекта документа, сделайте следующее. Щелкните на кнопке |8] пане-
ли свойств, придав указателю вид жирной черной стрелки. Кончик этой
стрелки поместите в область объекта-образца и сделайте щелчок мышью, за-
вершив на этом выполнение данной инструкции.

4. На панели свойств выполните следующие настройки (см. рис. 4.32):

• выберите режим равномерной заливки (пункт Uniform Fill в списке [2));

• выберите цветовой формат (список [3]);

• задайте количественные значения базовых цветовых параметров (поля
[41 — [7]) либо нажмите кнопку [1] и в открывшемся при этом диалоговом
окне Uniform Fill (Равномерная заливка) выберите цвет заливки.

Инструмент Paintbucket

Рабочий инструмент ;<% Paintbucket (Ведро с краской) предназначен для рав-

номерной заливки и обводки векторных объектов документа цветом^ который

был предварительно выбран рабочим инструментом --JP Eyedropper (Пипетка).

Порядок заливки

1. Откройте ту страницу документа, на которой необходимо выбрать цвет для
заливки.

2. Выберите инструмент Eyedropper (Пипетка).

3. Установите указатель в том месте документа, которое раскрашено требуемым
цветом, и щелкните кнопкой мыши. При этом данный цвет будет передан
образцу заливки в строке состояния программы.

4. Выберите инструмент Paintbucket (Ведро с краской).

5. Откройте страницу, на которой находится векторный объект, предназначен-
ный для заливки (выделять его не обязательно).

6. Поместите указатель во внутреннюю область данного объекта и щелкните
мышью.

7. Повторите шаги 5 и 6 инструкции для всех объектов, которые должны быть
залиты выбранным цветом.

Докер Color
Докер Color (Цвет) позволяет выполнять равномерную заливку и обводку век-
торных объектов документа произвольными цветами, которые выбираются или
синтезируются пользователем и представляются в заданных цветовых форматах.

На рис. 4.33 докер Color показан в процессе заливки выделенного объекта,
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* X

Рис. 4.33. Докер Color в процессе работы

Порядок заливки

1. Откройте докер Color (Цвет), выполнив одноименную команду подменю
Dockers (Докеры) меню Window (Окно).

2. Выделите требуемый векторный объект рабочим инструментом Pick (Выбор).

3. Откройте в докере Color нужную вкладку, щелкнув на одной из трех кнопок
в правом верхнем углу (см. рис, 4.33):

• кнопка Shows color sliders (левая) — открывает вкладку с ползунками,
предназначенную для синтеза цветовых образцов;

• кнопка Shows color viewers (средняя) — открывает вкладку с цветовым
синтезатором, также предназначенную для синтеза цветовых образцов;

• кнопка Shows color palettes (правая) — открывает вкладку с палитрами
библиотечных цветов, предназначенную для выбора библиотечных цветов,

4. При работе на вкладке с ползунками выполните следующие действия. От-
кройте список, находящийся вверху докера, и выберите в нем цветовую мо-
дель, в формате которой будет синтезироваться цветовой образец. Используя
ползунки докера, отрегулируйте базовые цветовые параметры синтезируемого
образца цвета. Если этот образец не входит в цветовое пространство модели
CMYK, определитесь в отношении введения его в указанное пространство.
Чтобы отметить области направляющих ползунков, не входящие в цветовой
охват модели CMYK, откройте контекстное меню докера Color (Цвет) (кноп-
ка с треугольной меткой в правом верхнем углу) и выберите в нем команду
Gamut Alarm (Предупреждающая раскраска). С помощью команд контекст-
ного меню докера можно выполнить и другие операции, в частности, сделать
область заливки или обводки выбранного объекта прозрачной (команды
No Fill и No Outline) или поменять местами текущий и предыдущий цветовые
образцы (команда Swap Colors).
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Примечание

В левом верхнем углу докера Color представлены два прямоугольных цвето-
вых образца: текущий (внизу) и выбранный ранее. Если какой-либо из них не
входит в область охвата модели CMYK, то справа от него появится квадратная
кнопка, цвет которой входит в данную область и при этом минимально отлича-
ется от исходного. При щелчке на этой кнопке цвет ее будет передан основно-
му образцу, а сама кнопка исчезнет с экрана.

5. При работе на вкладке с цветовым синтезатором выполните следующие дей-
ствия. Откройте список, находящийся вверху докера Color, и выберите в нем
цветовую модель, в формате которой будет синтезироваться образец цвета.
Задайте этот образец цвета с помощью цветового синтезатора, состоящего из
рабочего окна и цветовой шкалы, либо полей, задающих числовые значения
базовых цветовых параметров. Положение бегунка на шкале определяет цве-
товой оттенок, а положение квадратного маркера в рабочем окне — яркость
и насыщенность (для типа синтезатора, базирующегося на цветовой модели
HSB, который используется в докере по умолчанию). Если синтезированный
цветовой образец не входит в цветовое пространство модели CMYK, опреде-
литесь в отношении введения данного образца в указанное пространство.

6. При работе на вкладке с палитрами библиотечных цветов выполните сле-
дующие действия. Откройте список вверху докера Color и выберите в нем
требуемую библиотеку цветов. Задайте базовый цвет, используя рабочее окно
с набором цветных полосок и прокручивающуюся цветовую шкалу справа от
него. С помощью ползунка внизу докера сформируйте требуемый цветовой
образец, отрегулировав оттенок выбранного базового цвета. Если данный об-
разец цвета не входит в цветовое пространство модели CMYK, то определи-
тесь в отношении введения данного образца в указанное пространство.

7. Щелкните на кнопке Fill (Заливка), расположенной внизу докера.

Докер Color Styles
Докер Color Styles (Цветовые стили) применяется для равномерной заливки и об-
водки векторных объектов документа цветовыми стилями, представляющими собой
наборы цветовых образцов, формируемых пользователем и сохраняемых вместе
с документом. Цветовые стили характеризуются зависимостью используемых в до-
кументе цветовых оттенков этих стилей от исходных цветов, на базе которых эти
оттенки были сформированы. (См. разд. "Стили"гл. 3, подразд. "Цветовые стили".)

Градиентная заливка
Градиентной заливкой называется операция раскраски внутренней области век-
торного объекта оттенками двух или более цветов, выбираемых в качестве базо-
вых, при плавных переходах от одного цвета к другому и выбранной форме этих
переходов (типе градиента).
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В программе предусмотрены четыре типа градиентов: линейный, радиальный,
конический и квадратный. Каждый из них характеризуется определенным гра-
диентным узором (см. рис. 4.34).

В CorelDRAW 12 градиентная заливка выполняется с помощью двух рабочих
инструментов: Interactive Fill (Интерактивная заливка) и Fill (Заливка).

Инструмент Interactive Fill

Интерактивный рабочий инструмент Interactive Fill используется чаще всего

при выполнении градиентной заливки. Это связано с удобством настройки па-
раметров заливки, которая производится с помощью управляющей конструкции
инструмента, а также элементов управления панели свойств.

Данный инструмент имеет следующие ограничения на выполнение градиентной
заливки по сравнению с инструментом Fill (Заливка):

Р в качестве базовых цветов градиентного узора можно использовать всего два
цвета, а формирование градиентных оттенков в цветовом круге происходит
лишь по отрезку прямой, соединяющей эти цвета;

^ Примечание

Чтобы обойти указанное ограничение, достаточно выполнить настройку пара-
метров заливки в диалоговом окне Fountain Fill (Градиентная заливка)
(см. ниже рис. 4.35), которое можно открыть первой слева кнопкой панели
свойств.

3 не допускается заливка отдельных текстовых символов, выделенных рабочим
инструментом Text (Текст);

П инструмент Interactive Fill не рекомендуется использовать для задания пара-
метров заливки по умолчанию, поскольку изменение любого параметра на
панели свойств приводит к открытию на экране панели Fill (Заливка), бло-
кирующей дальнейшие регулировки.

Рис. 4.34. Пример выполнения градиентной заливки
с использованием инструмента Interactive Fill

На рис. 4.34 показан пример выполнения градиентной заливки с помощью ра-
бочего инструмента Interactive Fill (Интерактивная заливка) и представлены че-
тыре векторных объекта прямоугольной формы. При заливке использовались
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следующие типы градиентов (в порядке слева направо): линейный, радиальный,
конический и квадратный. Вверху изображена панель свойств с параметрами
заливки для выделенного объекта (он крайний справа), на котором находится
упраатяюшая конструкция данного инструмента.

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Interactive Fill в режиме градиентной
заливки (их номера, приведенные на рисунке, даны в квадратных скобках):

О [1] — кнопка Edit Fill, открывающая диалоговое окно Fountain Fill (Градиент-
ная заливка) для выбора параметров градиентной заливки;

П [2] — раскрывающийся список Fill Type, используемый для выбора одного из
четырех типов градиентов, используемых при заливке данного типа: линей-
ный (пункт Linear), радиальный (Radial), конический (Conical) или квадрат-
ный (Square);

П [3] — список цветовых образцов Fill Dropdown, в котором производится вы-
бор первого базового цвета градиентной заливки;

G [4] — аналогичный список Last Fill Picker, используемый для выбора второго
базового цвета;

СЗ [5] — поле (со счетчиками) Fountain Fill MidPoint, в котором указывается по-
ложение средней точки в градиентном изображении, раскрашенной усред-
ненным оттенком базовых цветов;

G [6] — два поля (со счетчиками) Fountain Fill Angle and Edge Pad, верхнее из
которых задает угол наклона оси градиентных переходов к горизонтальной
оси координат, а нижнее — величину смещения границ переходов от краев
объекта;

П [7] — поле (со счетчиками) Fountain Step, определяющее количество гради-
ентных переходов;

П [8] — кнопка Fountain Step Lock/Unlock, блокирующая регулировку числа
градиентных переходов;

П [9] — кнопка Copy Fill Properties, задающая режим передачи параметров за-
ливки выделенному объекту от другого объекта документа.

Порядок заливки

1. Выберите рабочий инструмент Interactive Fill (Интерактивная заливка).

2. Выделите в документе требуемый векторный объект, щелкнув на нем.

3. Если вы хотите перенести на выбранный объект параметры заливки из дру-
гого объекта документа, сделайте следующее. Щелкните на кнопке [9] пане-
ли свойств, придав указателю вид жирной черной стрелки. Кончик этой
стрелки поместите в область объекта-образца и сделайте щелчок мышью, за-
вершив на этом выполнение данной инструкции.

4. В списке [2] панели свойств выберите режим градиентной заливки и требуе-
мый тип градиента (см. рис. 4.34).



216 Глава 4

5. Определите базовые цвета заливки одним из двух способов:

• перетаскиванием мышью цветовых образцов из рабочей цветовой палитры на
квадратные маркеры управляющей конструкции инструмента Interactive Fill;

• выбором цветов в списках [3] и [4] панели свойств.

6. Настройте другие параметры градиентной заливки, используя для этого один
из трех способов:

• перемещением мышью квадратных маркеров управляющей конструкции
инструмента (они определяют положение в объекте начальной и конечной
границ цветовых переходов) и бегунка, расположенного между ними. Бе-
гунок задает положение того места области заливки, которое будет рас-
крашено усредненным оттенком;

• с помощью инструментов панели свойств, обладающих более широкими
возможностями настройки параметров, чем управляющая конструкция
инструмента;

• с использованием диалогового окна Fountain Fill (Градиентная заливка)
(кнопка [1]), которое обладает максимальными возможностями настройки
параметров градиентной заливки, свойственными рабочему инструменту
Fill (Заливка).

Инструмент Fill

Рабочий инструмент Fill (Заливка) обладает наибольшими возможностями
по выполнению градиентной заливки, которые реализуются с помощью диало-
гового окна Fountain Fill (Градиентная заливка) (рис. 4.35). В этом окне вы мо-
жете, в частности, задавать любые количества базовых цветов, а цветовые пере-
ходы между этими цветами формировать в цветовом круге не только по прямой
линии, но и по другим направлениям.

Порядок заливки

1. Чтобы выбрать параметры градиентной заливки для их использования в те-
кущем документе по умолчанию, сделайте следующее. Используя рабочий
инструмент Pick (Выбор), отмените все выделения в документе, щелкнув
в его свободной области. Щелчком на кнопке рабочего инструмента Fill (За-
ливка) откройте его дополнительную панель, на которой щелкните на кноп-
ке Fountain Fill Dialog (вторая слева). При этом на экране откроется панель
Fountain Fill (Градиентная заливка) с предупреждающим сообщением о всту-
плении в силу новых параметров градиентной заливки для графических объ-
ектов (установлен флажок Graphic (Графика)), которую следует закрыть
щелчком на кнопке подтверждения ОК. В результате откроется диалоговое
окно Fountain Fill с параметрами настройки (см. рис. 4.35).

2. Для градиентной заливки некоторого векторного объекта выделите этот объ-
ект инструментом Pick. Откройте дополнительную панель инструмента Fill,
щелкнув на его кнопке, а затем шелкните на кнопке Fountain Fill Dialog, от-
крыв диалоговое окно Fountain Fill.
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Fountain Fill

Type:

r Center offset

: Horizontal:

Vertical: I °

'•'r Color blend "-"

j '"•" Two color

-I ftorn' Л

' ' To: D

Мй-point: ,—

Custom

Presets:!

•' Cancel Help

Рис. 4.35. Диалоговое окно Fountain Fill

3. В раскрывающемся списке Presets, находящемся внизу окна Fountain Fill,
выберите требуемый стиль градиентной заливки, представляющий собой на-
бор параметров градиентной заливки, зафиксированных в памяти программы
под определенным именем. Если выбранный стиль вас полностью устраива-
ет, завершите выполнение данной инструкции щелчком на кнопке подтвер-
ждения ОК, в противном случае перейдите к следующему ее шагу.

4. Задайте в данном окне следующие параметры градиентной заливки:

• в раскрывающемся списке Туре (Тип) — тип градиента;

• в области Center offset (Смещение центра окна) — относительные коор-
динаты центра градиентной заливки (поля Horizontal и Vertical);

• в области Options (Параметры): угол поворота оси градиентных переходов
(поле Angle); количество градиентных переходов (поле Steps); величину
смещения границ переходов от краев объекта (поле Edge pad);

• в области Color blend (Цветовой переход) — базовые цвета и дополнитель-
ные цветовые параметры. В частности, для двухцветной градиентной за-
ливки (переключатель Two Colors) задаются следующие параметры: два
базовых цвета (списки цветовых образцов From и То); направление фор-
мирования оттенков (три кнопки справа); положение средней точки (пол-
зунок Mid-point). Для многоцветной заливки (кнопка Custom) вы можете
выбрать любые базовые цвета (прокручивающийся список цветовых об-
разцов справа), отметив их положение на цветовой шкале с помощью
маркеров, устанавливаемых над этой шкалой двойными щелчками мыши,
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5. Чтобы использовать в дальнейшем выбранные вами параметры для заливки
других объектов документа, зафиксируйте их в качестве нового стиля оформ-
ления градиентной заливки (кнопка "+" справа от списка Presets).

6. Закройте окно Fountain Fill щелчком на кнопке подтверждения ОК.

Заливка шаблоном
Заливка шаблоном (шаблонная заливка) предстаапяет собой операцию оформления
внутренней области векторного объекта мозаичным узором, составленным из вы-
бранного образца векторного или растрового изображения, называемого шаблоном.

В CorelDRAW 12 заливка указанного типа выполняется с помощью двух рабочих
инструментов: Interactive Fill (Интерактивная заливка) и Fill (Запивка).

Инструмент Interactive Fill

Интерактивный рабочий инструмент Interactive Fill используется чаще всего
при выполнении заливки шаблоном. Это связано с удобством настройки пара-
метров заливки, которая производится с помощью управляющей конструкции
инструмента, а также элементов управления панели свойств.

Данный инструмент имеет следующие ограничения на выполнение шаблонной
заливки по сравнению с рабочим инструментом Fill (Заливка):

П не допускается заливка отдельных текстовых символов, выделенных рабочим
инструментом Text (Текст);

П инструмент не рекомендуется использовать для задания параметров заливки
по умолчанию, поскольку изменение значения любого параметра на панели
свойств приводит к открытию на экране панели Fill, которая блокирует даль-
нейшие регулировки.

I 6 7 8 10 11 12 13

V я! »*59.0rtim Т*''1 '
w» •Ji.tK31.0 тт.. . T.1I

Рис. 4.36. Пример выполнения шаблонной заливки
с использованием инструмента Interactive Fill

На рис. 4.36 показан пример выполнения заливки шаблонами с помощью рабо-
чего инструмента Interactive Fill (Интерактивная заливка) и представлены четыре
векторных объекта прямоугольной формы. При заливке первых трех использова-
лись различные шаблоны, а для четвертого объекта задавался тот же шаблон, что
и для третьего, но с другими геометрическими параметрами. Вверху изображена
панель свойств с параметрами заливки для выделенного объекта (он крайний
справа), на котором находится управляющая конструкция данного инструмента.
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Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Interactive Fill в режиме шаблонной
заливки (их номера, приведенные на рисунке, даны в квадратных скобках):

П [1] — кнопка Edit Fill, открывающая диалоговое окно Pattern Fill (Заливка
шаблоном) для выбора параметров заливки шаблоном;

П [2] — раскрывающийся список Fill Type, предназначенный для выбора одной
из трех разновидностей шаблонной заливки: двухцветным шаблоном (пункт
Two Color Pattern), многоцветным шаблоном (Full Color Pattern) или растро-
вым шаблоном (Bitmap Pattern);

О [3] — список образцов шаблонов First Dropdown, в котором производится
выбор рабочего шаблона заданного типа;

О [4] — список образцов цветов Front Color, предназначенный для выбора пер-
вого цвета раскраски двухцветного шаблона;

О [5] — аналогичный список Back Color, используемый для выбора второго
цвета раскраски двухцветного шаблона;

П [6] — кнопка Small Tile for Pattern, задающая малый размер шаблона для за-
ливки;

П [7] — кнопка Medium Tile for Pattern, определяющая средний размер данного
шаблона;

О [8] — кнопка Large Tile for Pattern, выбирающая крупный размер шаблона;

П [9] — два поля (со счетчиками) Edit Tiling of Pattern, используемые для зада-
ния ширины и высоты шаблона;

П [10] — кнопка Transform Fill With Object, подключающая режим трансформа-
ции изображения области заливки вместе с объектом;

П [11] — кнопка Mirror Fill Tiles, производящая зеркальный разворот соседних
элементов мозаичного узора, которым выполняется заливка объекта;

П [12] — кнопка Create Pattern, задающая режим формирования нового образ-
ца двухцветного или многоцветного шаблона;

П [13] — кнопка Copy Fill Properties, активизирующая режим передачи пара-
метров заливки выделенному объекту от другого объекта.

Порядок заливки

1. Выберите рабочий инструмент Interactive Fill (Интерактивная заливка).

2. Выделите в документе требуемый векторный объект, щелкнув на нем.

3. Если вы хотите перенести на выбранный объект параметры заливки из дру-
гого объекта документа, сделайте следующее. Щелкните на кнопке (13] пане-
ли свойств, придав указателю вид жирной черной стрелки. Кончик этой
стрелки поместите в область объекта-образца и сделайте щелчок мышью, за-
вершив на этом выполнение данной инструкции.

4. В списке [2] панели свойств выберите режим заливки шаблоном и требуемый
тип шаблона (см. рис. 4.36).
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5. Задайте образец шаблона, используемый для заливки (список [3]).

6. При работе с двухцветным шаблоном определите цвета его раскраски одним
из двух способов:

• перетаскиванием мышью цветовых образцов из рабочей цветовой палитры на
квадратные маркеры управляющей конструкции интерактивного инструмента;

• выбором цветов в списках [4] и [5] панели свойств.

7. Настройте другие параметры шаблонной заливки, используя для этого один
из трех способов:

• перемещением мышью маркеров управляющей конструкции инструмента,
задающих геометрические параметры шаблона, копиями которого запол-
няется область заливки объекта;

• с помощью инструментов панели свойств;

• с использованием диалогового окна Pattern Fill (Заливка шаблоном)
(кнопка [1]), которое относится к рабочему инструменту Fill (Заливка).

Инструмент Fill

Рабочий инструмент Fill (Заливка) обладает наибольшими возможностями

по выполнению шаблонной заливки, которые реализуются с помощью диалого-
вого окна Pattern Fill (Заливка шаблоном) (см. рис. 4.37).

2-сЫог

Full color

Bitmap

Load.,.

--Size - — rsf

Width: Пя°о"тгп

Height; 31, Omm -«<J

Row or column offset —
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Г~ Transform fill with
,' - object ' ' ••>.""

Рис. 4.37. Диалоговое окно Pattern Fill
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Порядок заливки

1. Чтобы выбрать параметры заливки шаблоном для их использования в теку-
щем документе по умолчанию, сделайте следующее. С помощью рабочего
инструмента Pick (Выбор) отмените все выделения в документе, щелкнув
в его свободной области. Щелчком на кнопке рабочего инструмента Fill
(Заливка) откройте его дополнительную панель, на которой щелкните на
кнопке Pattern Fill Dialog (третья слева). При этом на экране откроется па-
нель Two-Color Bitmap Pattern (Двухцветный растровый шаблон) с предупре-
ждающим сообщением о вступлении в силу новых параметров шаблонной
заливки для графических объектов (установлен флажок Graphic (Графика)),
которую следует закрыть щелчком на кнопке подтверждения ОК. В результа-
те откроется диалоговое окно Pattern Fill (Заливка шаблоном) с параметрами
настройки (см. рис. 4.37).

2. Для заливки шаблоном некоторого векторного объекта выделите этог объект ин-
струментом Pick (Выбор), щелчком на кнопке инструмента FiB откройте его до-
полнительную панель, на которой щелкните на кнопке Pattern Fill Dialog.
При этом на экране откроется диалоговое окно Pattern Ffll (Заливка шаблоном)

3. Задайте в диалоговом окне Pattern Fill следующие параметры шаблонной за-
ливки:

• в верхней части окна — один из трех типов шаблона: двухцветный (пере-
ключатель 2-color), многоцветный (переключатель Full color) или растро-
вый (переключатель Bitmap), а также используемый образец шаблона
(раскрывающийся список шаблонов заданного типа и кнопка Load);

• в средней части окна — относительные координаты базового элемента
шаблона (поля х и у), а также его ширину и высоту (поля Width и Height);

• в нижней части окна: углы наклона и поворота данного элемента (поля
Skew и Rotate); относительное смещение рядов или колонок мозаичных
элементов относительно друг друга (параметры в области Row or column
offset); режим трансформации области заливки вместе с объектом (флажок
Transform fill with object); режим зеркального разворота соседних элемен-
тов мозаичного узора (флажок Mirror Fill).

4. Закройте окно Pattern Fill щелчком на кнопке подтверждения ОК.

Заливка текстурой
Заливка текстурой (текстурная заливка) отличается от заливки шаблоном лишь
тем, что мозаичный узор, которым заполняется внутренняя область векторного
объекта, формируется на базе регулируемого растрового изображения, называе-
мого текстурой.

Текстура характеризуется следующими двумя свойствами:

О возможностью регулировки параметров элементов, из которых она состоит;
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П запретом на создание совершенно новой текстуры или на загрузку текстуры
из отдельного файла (допускается лишь выбор готовых текстур из их библио-
тек, а также формирование новых образцов текстур на базе существующих).

В CorelDRAW 12 заливка указанного типа выполняется с помощью двух рабочих
инструментов: Interactive Fill (Интерактивная заливка) и Fill (Заливка).

Инструмент Interactive Fill

Интерактивный рабочий инструмент Interactive Fill используется чаще всего

при выполнении текстурной заливки. Это связано с удобством настройки пара-
метров заливки, которая производится с помощью управляющей конструкции
инструмента и элементов управления панели свойств.

Данный инструмент имеет следующие ограничения на выполнение текстурной
заливки по сравнению с инструментом Fill (Заливка):

О не регулирует параметры элементов текстуры, выбранной для заливки;

Примечание

Чтобы обойти указанное ограничение, достаточно выполнить настройку пара-
метров заливки в диалоговом окне Texture Fill (Заливка текстурой)
(см. рис. 4.39), которое можно открыть первой слева кнопкой панели свойств.

П не допускается заливка отдельных текстовых символов, выделенных рабочим
инструментом Text (Текст);

О инструмент Interactive Fill не рекомендуется использовать для задания пара-
метров заливки по умолчанию, поскольку изменение любого параметра на
панели свойств приводит к открытию на экране панели Fill (Заливка), бло-
кирующей дальнейшие регулировки.

На рис. 4.38 показан пример выполнения заливки текстурами с помощью рабо-
чего инструмента Interactive Fill (Интерактивная заливка) и представлены четы-
ре векторных объекта прямоугольной формы, при заливке которых использова-
лись различные текстуры. Вверху изображена панель свойств с параметрами
заливки для выделенного объекта (он крайний справа), на котором находится
управляющая конструкция данного инструмента.

• 5 6 7 8 9

Рис. 4.38. Пример выполнения текстурной заливки с использованием
инструмента Interactive Fill
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Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Interactive Fill в режиме текстурной
заливки (их номера, приведенные на рисунке, даны в квадратных скобках):

D [1] — кнопка Edit Fill, открывающая диалоговое окно Texture Fill (Заливка
текстурой) для выбора параметров заливки текстурой;

П [2] — раскрывающийся список Fill Type, в котором производится выбор за-
данного типа заливки, представленного пунктом Texture Fill;

П [3] — список Texture Library, используемый для выбора одной из библиотек
текстур;

П [4] — список Fill Dropdown, предназначенный для выбора рабочего образца
текстуры, входящей в заданную библиотеку текстур;

П [5] — кнопка Transform Fill With Object, подключающая режим трансформа-
ции изображения области заливки вместе с объектом;

3 [6] — кнопка Mirror Fill Tiles, производящая зеркальный разворот соседних
элементов мозаичного узора, которым выполняется заливка объекта;

П [7] — кнопка Regenerate Texture, случайным образом автоматически изме-
няющая цветовые параметры текстуры;

П [8] — кнопка Texture Options Dialog\Options, открывающая диалоговое окно
для задания параметров растра изображения текстуры;

П [9] — кнопка Copy Fill Properties, подключающая режим передачи параметров
заливки выделенному объекту от другого объекта документа.

Порядок заливки

1. Выберите рабочий инструмент Interactive Fill (Интерактивная заливка).

2. Выделите в документе требуемый векторный объект, щелкнув на нем.

3. Если вы хотите перенести на выбранный объект параметры заливки из дру-
гого объекта документа, выполните следующее. Щелкните на кнопке [9] па-
нели свойств, придав указателю вид жирной черной стрелки. Кончик этой
стрелки поместите в область объекта-образца и сделайте щелчок мышью, за-
вершив на этом выполнение данной инструкции.

4. На панели свойств задайте следующие параметры (см. рис. 4,38):

• режим заливки текстурой (пункт Texture Fill в списке [2]);

• библиотеку текстур (список [3]);

• рабочий образец текстуры (список [4]).

5. Настройте параметры текстурной заливки, используя для этого один из трех
способов:

• перетаскиванием мышью маркеров управляющей конструкции инстру-
мента, копиями которой заполняется область заливки;

• с помощью элементов управления панели свойств;

• с использованием диалогового окна Texture Fill (Заливка текстурой)
(кнопка [1]), которое относится к рабочему инструменту Fill (Заливка).
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Инструмент Fill

Рабочий инструмент Fill (Заливка) обладает наибольшими возможностями
по выполнению текстурной заливки, которые реализуются с помощью диалого-
вого окна Texture Fill (Заливка текстурой) (см. рис. 4.39).

Texture library;

Texturejig!:...

Fold of Silk
Ivy on a Wall
Lens Flare
Mask
Midnight Velvet
Moss

Style'Narne; Neon Spandex —

Texture #: 27695

Sofboess%: 10°
.--ТП-Г--1-Т.Г-.

Density %:

Brightness ±%: °

Lower sky::̂

Upper sky:'

t Atmosphere:

Lower cloud;

Upper cloud:

Preview

Options.,,- Tiling.. "QK>: Cancel • Help

Рис. 4.39. Диалоговое окно Texture Fill

Порядок заливки

1. Чтобы выбрать параметры заливки текстурой для их использования в теку-
щем документе по умолчанию, сделайте следующее. С помощью рабочего
инструмента Pick (Выбор) отмените все выделения в документе, щелкнув
в его свободной области. Щелчком на кнопке рабочего инструмента Fill (За-
ливка) откройте его дополнительную панель, на которой щелкните на кноп-
ке Texture Fill Dialog (четвертая слева). При этом на экране откроется панель
Texture Fill (Заливка текстурой) с предупреждающим сообщением о вступле-
нии в силу новых параметров текстурной заливки для графических объектов
(установлен флажок Graphic (Графика)), которую следует закрыть щелчком
на кнопке подтверждения ОК. В результате откроется диалоговое окно
Texture Fill с параметрами настройки (см. рис. 4.39).

2. Для заливки текстурой некоторого объекта выделите этот объект инструмен-
том Pick, щелчком на кнопке инструмента Fill откройте его дополнительную
панель, на которой щелкните на кнопке Texture Fill Dialog. При этом на эк-
ране откроется диалоговое окно Texture Fill.
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3. Задайте в этом окне следующие параметры текстурной заливки:

• библиотеку текстур (раскрывающийся список Texture Library);

• образеи текстуры (прокручивающийся список Texture list);

• параметры растра текстуры (кнопка Options);

• геометрические параметры мозаичного элемента текстуры (кнопка Tiling);

• параметры оформления текстуры (элементы настройки в правой части
окна).

4. Закройте окно Texture Fill щелчком на кнопке подтверждения ОК.

Заливка узором PostScript
Заливкой узором PostScript называется операция оформления внутренней области
векторного объекта мозаичным узором, сформированным с помощью языки
PostScript. Чтобы этот узор отобразить на экране, необходимо установить галоч-
ку в названии команды Enhanced (Улучшенный) меню View (Вид), а чтобы рас-
печатать — использовать принтер типа PostSctipt.

Рассматриваемый тип заливки обладает двумя преимуществами по сравнению
с заливками других типов:

[3 формируемый узор может иметь мелкий и вычурный рисунок;

О мозаичные элементы узора могут располагаться на прозрачном фоне, что
не предусмотрено в заливках шаблонами и текстурами.

Для выполнения заливки узором PostScript используют два рабочих инструмен-
та: Interactive Fill (Интерактивная заливка) и Fill (Запивка).

Инструмент Interactive Fill

Интерактивный рабочий инструмент Interactive Fill используется чаще всего при

выполнении заливки узором PostScript. Это связано с удобством настройки парамет-
ров заливки, которая производится с помощью элементов управления панели
свойств (в данном случае управляющая конструкция инструмента отсутствует).

Данный инструмент имеет ряд ограничений на выполнение заливки указанного
типа по сравнению с инструментом Fill (Заливка):

G не регулирует параметры узора, выбранного для заливки;

Примечание

Чтобы это ограничение обойти, достаточно выполнить настройку параметров
заливки в диалоговом окне PostScript Texture (Текстура PostScript)
(см. рис. 4.41), которое можно открыть первой слева кнопкой панели свойств,

П не допускается заливка отдельных текстовых символов, выделенных рабочим
инструментом Text (Текст);

83ак. 250
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П инструмент Interactive Fill не рекомендуется использовать для задания пара-
метров заливки по умолчанию, поскольку изменение любого параметра на
панели свойств приводит к открытию на экране панели Fill (Заливка), бло-
кирующей дальнейшие регулировки.

На рис. 4.40 показан пример выполнения заливки узорами PostScript с помощью
инструмента Interactive Fill (Интерактивная заливка) и представлены четыре
векторных объекта прямоугольной формы, при заливке которых использовались
различные узоры. Вверху изображена панель свойств с параметрами заливки для
выделенного объекта (он крайний справа).

1 2 3 4

-Postscript Fill

Рис. 4.40. Пример выполнения заливки узорами PostScript
с использованием инструмента Interactive Fill

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования при работе с инструментом Interactive Fill в режиме заливки узором
PostScript (их номера, приведенные на рисунке, даны в квадратных скобках):

О [1] — кнопка Edit Fill, открывающая диалоговое окно PostScript Texture
(Текстура PostScript) для выбора параметров заливки узором PostScript;

О [2] — раскрывающийся список Fill Type, используемый для выбора заданного
типа заливки, представленного пунктом PostScript Fill;

П [3] — список PostScript Fill Textures, в котором производится выбор рабочего
узора PostScript, который будет использован при заливке;

П [4] — кнопка Copy Fill Properties, подключающая режим передачи параметров
заливки выделенному объекту от другого объекта документа.

Порядок заливки

1. Выберите рабочий инструмент Interactive Fill (Интерактивная заливка).

2. Выделите в документе требуемый векторный объект, щелкнув на нем.

3. Если вы хотите перенести на выбранный объект параметры заливки из дру-
гого объекта документа, сделайте следующее. Щелкните на кнопке [4] пане-
ли свойств, придав указателю вид жирной черной стрелки. Кончик этой
стрелки поместите в область объекта-образца и сделайте щелчок мышью, за-
вершив на этом выполнение данной инструкции.
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4. На панели свойств задайте следующие параметры (см. рис. 4.40):

• режим заливки узором PostScript (пункт PostScript Fill в списке [2]);

• рабочий образен узора (список [3]).

5. Чтобы настроить параметры выбранного узора, откройте диалоговое окно
PostScript Texture (кнопка [1]) и выполните в нем необходимые настройки.

Инструмент Fill

Рабочий инструмент Fill (Заливка) обладает наибольшими возможностями

по выполнению заливки узором PostScript, которые реализуются с помощью
диалогового окна PostScript Texture (Текстура PostScript) (см. рис. 4,41).

PostScript Texture

Impact
Landscape
Leaves
Mesh
Motifs
Octagons
Patio

[Rectangles

Рис. 4.41. Диалоговое окно PostScript Texture

Порядок заливки

l. Чтобы выбрать параметры заливки узором PostScript для их использования
в текущем документе по умолчанию, сделайте следующее. С помощью рабо-
чего инструмента Pick (Выбор) отмените все выделения в документе, щелк-
нув в его свободной области. Щелчком на кнопке рабочего инструмента Fill
(Заливка) откройте его дополнительную панель, на которой щелкните на
кнопке PostScript Fill Dialog (пятая слева). При этом на экране откроется па-
нель PostScript Texture (Текстура PostScript) с предупреждающим сообщени-
ем о вступлении в силу новых параметров заливки узором PostScript для гра-
фических объектов (установлен флажок Graphic (Графика)), которую следует
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закрыть щелчком на кнопке подтверждения ОК. В результате откроется диа-
логовое окно PostScript Texture с параметрами настройки (см. рис. 4.41).

2. Для заливки узором PostScript некоторого объекта выделите этот объект ин-
струментом Pick, щелчком на кнопке инструмента Fill откройте его дополни-
тельную панель, на которой щелкните на кнопке PostScript Fill Dialog. При
этом на экране откроется диалоговое окно PostScript Texture.

3. Задайте в этом окне следующие параметры заливки узором PostScript:

• рабочий образец узора PostScript (прокручивающийся список в левом
верхнем углу);

• режим отображения выбранного узора в окне просмотра справа (флажок
Preview Fill);

• параметры настройки узора (элементы управления в нижней части окна).

4. Закройте окно PostScript Texture щелчком на кнопке подтверждения ОК.

Заливка по сетке
В CorelDRAW 12 заливка по сетке выполняется с помощью интерактивного ра-

бочего инструмента зШ Interactive Mesh Fill (Интерактивная заливка по сетке).

Суть такой заливки состоит в следующем. На векторный объект накладывается
управляемая сетка Безье, с помощью которой производится раскраска участков,
прилегающих к выбранным узелкам, а также автоматическое формирование ме-
жду узелками градиентных оттенков.

Сетка позволит вам не только выполнить градиентную заливку объекта по лю-
бому заданному вами закону, но и в дальнейшем отредактировать изображение
заливки. Ее можно регулировать точно так же, как это делается при обработке
контуров Безье рабочим инструментом Shape (Форма) (см. разд. "Обработка линии
и фигур"настоящей главы).

Параметры заливки по сетке задаются тремя способами:

О путем манипуляции узелками и контрольными точками сетки;

О с помощью элементов управления панели свойств;

П с использованием рабочей цветовой палитры (раскраска мест расположения
выделенных узелков).

На рис. 4.42 показан пример заливки по сетке объекта эллиптической формы
инструментом Interactive Mesh Fill. Вверху изображена панель свойств.

Поясним назначение элементов упрааления панели свойств, доступных для ис-
пользования при работе с инструментом Interactive Mesh Fill (их номера, приве-
денные на рисунке, даны в квадратных скобках):

П [1] — два поля (со счетчиками) Grid Size, в которых задаются числа ячеек
в сетке Безье по горизонтали и вертикали;

О [2] — кнопка Add Intersection, подключающая режим вставки (в месте щелчка
мышью) двух новых ортогональных разделительных линий сетки;
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10 11

Рис. 4.42. Пример заливки по сетке

О [3] — кнопка Delete Node(s), удаляющая в сетке выделенные узелки вместе
с линиями, на которых они находятся;

О [4] — кнопка Convert Curve To Line, преобразующая криволинейные сегмен-
ты сетки, примыкающие слева и снизу к выделенному узелку, в прямоли-
нейные сегменты;

3 |5] — кнопка Convert Line To Curve, преобразующая прямолинейные сегмен-
ты сетки, примыкающие слева и снизу к выделенному узелку, в криволиней-
ные сегменты;

П [6] — кнопка Make Node A Cusp, преобразующая выделенный узелок сетки
в угловой;

П [7] — кнопка Make Node Smooth, преобразующая данный узелок в сглажен-
ный узелок;

П [8| — кнопка Make Node Symmetrical, преобразующая узелок в симметричный;

П [91 — ползунок Curve Smoothness, регулирующий уровень сглаживания линии
в местах расположения выделенных узелков;

(3 [10] — кнопка Copy Mesh Fill properties from, подключающая режим переноса
на выделенный объект параметров заливки по сетке другого объекта до-
кумента;

П [11] — кнопка Clear Mesh, удаляющая из объекта заливку данного типа.

Порядок заливки
1. Отобразите в требуемом масштабе ту область документа, где находится тре-

буемый векторный объект.

2. С помощью рабочего инструмента Pick (Выбор) отмените все выделения
в документе, щелкнув в его свободной области.

3. Выберите рабочий инструмент Interactive Mesh Fill (Интерактивная заливка
по сетке).

4. Задайте в полях [1] панели свойств требуемое число ячеек в сетке Безье по
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горизонтали и вертикали (см. рис. 4.42).

5. Сформируйте сетку, щелкнув мышью на выбранном объекте.

6. Если вы хотите перенести на данный объект параметры заливки по сетке из
другого объекта документа, сделайте следующее. Щелкните на кнопке [10]
панели свойств, придав указателю вид жирной черной стрелки. Кончик этой
стрелки поместите в область объекта-образца и сделайте щелчок мышью, за-
вершив на этом выполнение данной инструкции.

7. Отрегулируйте параметры сетки с помощью мыши, а также инструментов па-
нели свойств. В частности, с помощью мыши вы можете делать следующее:

• выделять узелки в сетке (последовательными щелчками мыши при нажа-
той клавише <Shift>);

• перемещать узелки и контрольные точки;

• удалять узелки (двойными щелчками мыши);

• отмечать места вставки новых разделительных линий сетки.

8. Выполните градиентную заливку области объекта. Для этого последовательно
выделяйте по одному или по несколько узелков сетки и раскрашивайте места
их расположения щелчками мыши в соответствующих ячейках рабочей цве-
товой палитры.

Обводка
Под обводкой понимается операция оформления следа от контура векторного
объекта (линии обводки), состоящая в задании геометрических параметров
этого следа и его раскраски. В CorelDRAW 12 применяются лишь равномерные
обводки, когда линия обводки объекта раскрашивается каким-то одним цветом.

Примечание

Если вы хотите оформить линию обводки градиентным или мозаичным узором,
то для этого ее необходимо преобразовать в область заливки, допускающей
такое оформление (см- разд. Заливка" настоящей главы). Данная операция
преобразования выполняется командой Arrange > Convert Outline To Object
(Расположить > Преобразовать контур в объект).

В зависимости от того, какие параметры линии обводки должны быть выбраны,
используются те или иные средства программы.

Толщина линии обводки задается с помощью следующих средств CorelDRAW 12:

О панели свойств при выборе рабочего инструмента Pick (Выбор);

П диалогового окна Outline Pen (Контурное перо), для раскрытия которого
нужно щелкнуть на кнопке Outline Pen Dialog (Диалог "Контурное перо"),
расположенной первой слева на дополнительной панели рабочего инстру-

мента Outline (Контур);
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О восьми кнопок управления (с изображениями отрезков прямых различной
толщины), расположенных справа на дополнительной панели инструмента
Outline.

Стиль оформления и наконечники линии обводки задаются с использованием сле-
дующих средств:

П панели свойств при выборе рабочего инструмента Pick при условии обработ-
ки им объекта с контуром типа Безье;

О диалогового окна Outline Pen, для раскрытия которого нужно щелкнуть на
кнопке Outline Pen Dialog, расположенной на дополнительной панели рабо-
чего инструмента Outline.

Другие геометрические параметры линии обводки могут быть заданы в диалого-
вом окне Outline Pen, относящемся к инструменту Outline.

Цвет линии обводки задается с помощью следующих средств:

П рабочей цветовой палитры;

О диалогового окна Outline Color (Цвет обводки), для раскрытия которого нуж-
но щелкнуть на кнопке Outline Color Dialog (Диалог "Цвет обводки") (вторая
слева на дополнительной панели инструмента Outline);

О диалогового окна Outline Pen (Контурное перо), для раскрытия которого
нужно щелкнуть на кнопке Outline Pen Dialog (первая слева на дополнитель-
ной панели инструмента Outline);

Outline Pen

Color:

Width:

ZJ Iooints

Style:

Edit Style.,,

-Corners-" ™"]~ Line taps ~

- Arrows

Options * ] Options

Calligraphy

Angle;

Default

Behind Fill I Scale with image

• Cancel Help

Рис. 4.43. Диалоговое окно Outline Pen
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П рабочего инструмента Щ- Painthucket (Ведро с краской) совместно с рабочим

инструментом Eyedropper (Пипетка);

П докеров Color (Цвет) и Color Styles (Цветовые стили).

Единственным средством программы, допускающим задание всех параметров
оформления линии обводки, является диалоговое окно Outline Pen (Контурное
перо), относящееся к рабочему инструменту Outline (Контур).

На рис. 4.43 показано диалоговое окно Outline Pen в режиме выбора профиля
линии с помощью мыши и интерактивного регулятора Nib shape (Форма пера),
находящегося внизу справа. В окне этого регулятора вы видите крестообразную
метку указателя мыши и текущий профиль, имеюший вид черного прямоуголь-
ника заданных наклона и толщины.

Опишем порядок выполнения отдельных операций, предназначенных для
оформления линий обводки.

Выбор толщины линии обводки
1. Чтобы выбрать толщину линии обводки для ее использования в текущем доку-

менте по умолчанию, сделайте следующее. Выберите рабочий инструмент Pick
(Выбор) и отмените им все выделения в документе, щелкнув в его свободной
области. Щелчком на кнопке рабочего инструмента Outline (Контур) откройте
его дополнительную панель. На этой панели щелкните на одной из восьми
кнопок с изображениями линий, находящихся справа, если вас устраивает
толщина линии, задаваемая выбранной кнопкой. Если же требуемая толщина
линии не представлена ни на одной из кнопок, щелкните на кнопке Outline
Pen Dialog (первая слева), При этом на экране откроется панель Outline Pen
(Контурное перо) с предупреждающим сообщением о вступлении в силу новых
параметров обводки для графических объектов документа (установлен флажок
Graphic (Графика)), которую следует закрыть щелчком на кнопке подтвержде-
ния ОК. Если перед этим была нажата кнопка Outline Pen Dialog, то на экране
откроется диалоговое окно Outline Pen (Контурное перо), в котором толщину
линии можно задать с помощью поля Width (см. рис. 4.43).

2. Для изменения толщины линии обводки в некотором векторном объекте вы-
делите данный объект инструментом Pick (Выбор), после чего выберите один
из двух вариантов действий:

• откройте список Outline Width, находящийся в правой части панели
свойств, и выберите в нем нужную толщину линии обводки;

• щелчком на кнопке инструмента Outline откройте его дополнительную
панель. На этой панели сделайте следующее: щелкните на одной из вось-
ми кнопок с изображениями линий, находящихся справа, если вас уст-
раивает толщина линии, задаваемая выбранной кнопкой; в противном
случае щелкните на первой слева кнопке Outline Pen Dialog и в открыв-
шемся диалоговом окне Outline Pen задайте толщину линии в поле Width,
после чего закройте окно щелчком на кнопке ОК.
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Выбор стиля оформления линии обводки
и ее наконечников
1. Чтобы выбрать стиль оформления или наконечники линии обводки для их

использования в текущем документе по умолчанию, выполните следующее.
С помощью рабочего инструмента Pick (Выбор) отмените все выделения
в документе, щелкнув в его свободной области. Откройте дополнительную
панель рабочего инструмента Outline (Контур) и щелкните на кнопке Outline
Pen Dialog (первая слева). При этом на экране откроется панель Outline Pen
(Контурное перо) с предупреждающим сообщением о вступлении в силу но-
вых параметров обводки для графических объектов документа (установлен
флажок Graphic (Графика)), которую следует закрыть щелчком на кнопке
ОК. В результате на экране откроется диалоговое окно Outline Pen, в кото-
ром стиль оформления линии можно выбрать в раскрывающемся списке
Style (Стиль), а головной и хвостовой наконечники — в списках их образцов,
находящихся в области Arrows (Стрелки).

2, Для изменения стиля оформления или наконечников линии обводки в неко-
тором векторном объекте документа выделите данный объект инструментом
Pick (Выбор), после чего выполните один из двух вариантов действий:

• если контур объекта представляет собой кривую Безье, то выберите ука-
занные параметры в списках Start Arrowhead Selector, Outline Style
Selector и End Arrowhead Selector на панели свойств;

• откройте дополнительную панель инструмента Outline (Контур), щелкните
на кнопке Outline Pen Dialog и в открывшемся диалоговом окне Outline
Pen (Контурное перо) выберите стиль оформления линии (список Stjle
(Стиль)) или головной и хвостовой наконечники (два списка в области
Arrows), после чего закройте окно щелчком на кнопке ОК.

Выбор цвета линии обводки
Чтобы выбрать цвет линии обводки для использования в текущем документе
по умолчанию, выполните следующие действия. С помощью рабочего инст-
румента Pick (Выбор) отмените все выделения в документе, щелкнув в его
свободной области. Щелкните правой кнопкой мыши на выбранном цвето-
вом образце рабочей цветовой палитры либо откройте дополнительную па-
нель рабочего инструмента Outline (Контур) и щелкните на кнопке Outline
Color Dialog (Диалог "Цвет обводки") (вторая слева). В результате на экране
раскроется панель Outline Color (Цвет обводки) с предупреждающим сооб-
щением о вступлении в силу нового цвета линии обводки для графических
объектов документа (установлен флажок Graphic (Графика)), которую следует
закрыть щелчком на кнопке ОК. Если перед этим была нажата кнопка
Outline Color Dialog, то на экране откроется диалоговое окно Outline Color
(Цвет обводки) (такое же, как окно Uniform Fill (Равномерная заливка), изо-
браженное на рис. 4.31), в котором можно выбрать цвет линии обводки.
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2. Для изменения цвета линии обводки некоторого векторного объекта выдели-
те данный объект с помощью инструмента Pick и выберите один из следую-
щих вариантов действий:

• щелкните правой кнопкой мыши на выбранном образце цвета в рабочей
цветовой палитре (при работе с цветовыми оттенками данного образца
необходимо предварительно открыть левой кнопкой дополнительную па-
нель рабочей палитры либо выполнить необходимое количество последо-
вательных щелчков правой кнопкой мыши при нажатой клавише <Ctrl>);

• откройте дополнительную панель рабочего инструмента Outline (Контур),
щелкните на кнопке Outline Color Dialog (вторая слева) и в открывшемся
диалоговом окне Outline Color (Цвет обводки) выберите нужный цвет об-
водки, после чего закройте окно щелчком на кнопке ОК;

• откройте дополнительную панель инструмента Outline (Контур), щелкните
на кнопке Outline Pen Dialog (первая слева) и в открывшемся диалоговом
окне Outline Pen (Контурное перо) выберите нужный цвет обводки (спи-
сок Color), после чего закройте окно щелчком на кнопке ОК;

• выберите рабочий инструмент Eyedropper (Пипетка), щелкните в том месте
документа, пиксел которого раскрашен требуемым цветом, выберите ра-
бочий инструмент Paintbucket (Ведро с краской), поместите указатель на
контур заданного объекта (указатель примет вид ковша с рамочкой справа
внизу от него) и щелкните кнопкой мыши. В результате контур раскра-
сится в выбранный цвет;

• откройте докер Color (Цвет) с помощью одноименной команды подменю
Dockers (Докеры) меню Window (Окно); перейдите на одну из трех вкла-
док докера, синтезировав или выбрав там требуемый цвет, после чего
щелкните на кнопке Outline (Обводка) внизу докера;

• откройте докер Color Styles (Цветовые стили), выберите в его рабочем ок-
не нужный образец цвета, относящийся к некоторому цветовому стилю,
и перетащите его мышью на контур обрабатываемого объекта.

Выбор произвольных параметров обводки
1. Чтобы задать любые параметры линии обводки для их использования в те-

кущем документе по умолчанию, сделайте следующее. С помощью рабочего
инструмента Pick (Выбор) отмените все выделения в документе, щелкнув
в его свободной области. Откройте дополнительную панель рабочего инстру-
мента Outline (Контур) и щелкните на кнопке Outline Pen Dialog (первая сле-
ва). При этом на экране откроется панель Outline Pen (Контурное перо)
с предупреждающим сообщением о вступлении в силу новых параметров об-
водки для графических объектов документа (установлен флажок Graphic
(Графика)), которую следует закрыть щелчком на кнопке ОК. В результате
на экране откроется диалоговое окно Outline Pen (Контурное перо)
(см. рис. 4.43).
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2. Для изменения любых параметров линии обводки в некотором векторном
объекте документа выполните следующее. Выделите этот объект инструмен-
том Pick, откройте дополнительную панель инструмента Outline и щелкните
на кнопке Outline Pen Dialog, открыв диалоговое окно Outline Pen

3. В окне Outline Pen (Контурное перо) задайте необходимые параметры:

• цвет линии обводки (раскрывающийся список цветовых образцов Color);

Примечание

Если в раскрывшемся списке Color щелкнуть внизу на надписи Other (Другие), то
будет открыто диалоговое окно Select Color (Выбрать цвет), которое ничем не
отличается от окон Outline Color (Цвет обводки) и Uniform Color (Равномерная
заливка). В нем вы можете выбрать любой цвет для раскраски линии обводки.

• толщину линии обводки в поле Width (Ширина);

• стиль оформления линии обводки (список Style);

• головной и хвостовой наконечники в этой линии, если она разомкнута
(область Arrows);

• форма изгиба линии (переключатели Corners);

• форма концов линии (переключатели Line caps);

• профиль линии, который можно задать двумя способами: с помощью
мыши (интерактивный регулятор Nib shape) и вводом числовых значений
в два поля: Stretch (коэффициент пропорциональности профиля) и Angle
(угол наклона);

• при необходимости — режим расположения линии обводки за областью
заливки (флажок Behind fill);

• при необходимости — режим масштабирования линии обводки вместе
с графическим объектом (флажок Scale with image);

4. Закройте окно Outline Реп щелчком на кнопке подтверждения ОК.

Коррекция и цветовая обработка
Для тоновой и цветовой коррекции векторных изображений допускается ис-
пользовать всего четыре команды из одиннадцати, составляющих подменю ко-
манд коррекции Adjust (Коррекция) меню Effects (Эффекты) и предназначенных
для обработки растровых изображений. К ним относятся:

О две команды тоновой коррекции: Brightness/Contrast/Intensity (Яркость/
Контрастность/Интенсивность) и Gamma (Гамма) (см. разд. "Тоновая коррек-
ция" гл. 5)',

G две команды цветовой коррекции: Color Balance (Цветовой баланс) и
Hue/Saturation/Lightness (Оттенок/Насыщенность/Светлота) (см. разд. "Цве-
товая коррекция " гл. 5).
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Действие указанных команд на векторное изображение будет таким же, что и на
растровое.

Для цветовой обработки изображений векторного типа используются те же две
команды подменю Transform (Преобразовать) меню Effects (Эффекты), что и для
растровых, а именно: Invert (Инвертировать) и Posterize (Постеризовать)
Сем. разд. "Создание эффектов"гл. 5, подразд. "Подменю Transform").

Следует учесть, что действие этих команд на векторное изображение будет не-
сколько иным, чем на растровое. В частности, команда Invert, создающая в изо-
бражении формата CMYK эффект инверсии, не будет воздействовать на состав-
ное изображение, находящееся в четвертом цветовом канале. Это сделано для
того, чтобы изображение CMYK-формата существенно не затемнялось в резуль-
тате его обработки командой инверсии.

Команда Posterize, создающая эффект плакатной живописи за счет уменьшения
количества цветовых оттенков, также работает по-другому. Она уменьшает чис-
ло оттенков не в области какого-то одного векторного объекта (как при обра-
ботке растрового изображения), а для группы объектов с равномерной заливкой.
Это означает следующее. Если вы выделили несколько объектов, отличающихся
между собой по раскраске, то в результате выполнения команды постеризации
будет уменьшено количество цветов, в которые раскрашены отдельные объекты.

Наиболее выразительно действие этой команды проявляется в отношении ком-
бинированного объекта с эффектом перехода, в котором раскраска отдельных
элементов плавно изменяется от одного базового элемента к другому (см. разд.
"Создание эффектов" настоящей главы, подразд. "Переход"). Однако для того чтобы
применить команду Posterize к такому объекту, необходимо его предварительно
обработать командой Arrange > Break Apart (Расположить > Разъединить), разбив
на отдельные элементы, из которых промежуточные элементы будут составлять
групповой объект.

В заключение заметим, что в программе не предусмотрено преобразование цве-
товых форматов для векторных объектов документа.

Регулировка прозрачности
В CorelDRAW 12 регулировка прозрачности векторных объектов производится
тремя способами:

П рабочим инструментом 'Щ Eraser (Ластик), делающим полностью прозрач-

ными (пустыми) те участки области обрабатываемого объекта, на которые он
воздействует (см. разд. "Обработка линий и фигур" настоящей главы)',

командой Arrange > Combine (Расположить > Скомбинировать), объединяю-
щей группу выделенных объектов в один комбинированный объект, в кото-
ром образуются пустые участки в тех местах, где четное количество исходных
объектов накладывалось друг на друга (см. разд. "Объединение объектов" данной
главы)',



Обработка векторных объектов 237

П интерактивным рабочим инструментом .§? Interactive Transparency (Интер-

активная прозрачность), позволяющим регулировать прозрачность вектор-
ного объекта по равномерному и градиентному законам, а также с помощью
шаблонов и текстур. Данная операция выполняется почти так же, как залив-
ка векторного объекта рабочим инструментом Interactive Fill (Интерактивная
заливка) (см. разд. "Заливка" настоящей главы). Отличие состоит лишь в том,
что формируемое изображение градиентного или мозаичного узора использу-
ется в качестве полутоновой маски, регулирующей прозрачность обрабаты-
ваемого объекта.

Примечание

Инструмент Interactive Transparency позволяет также регулировать прозрач-
ность растровых изображений (см. разд. "Регулировка прозрачности" гл. 5).
Порядок работы этим инструментом, а также его возможности по регулировке
прозрачности не зависят от типа обрабатываемого объекта.

При регулировке прозрачности объекта (произвольного типа) инструментом
Interactive Transparency вы можете выбрать один из 19 режимов смешения цве-
тов раскраски данного объекта и фонового изображения, на котором этот объ-
ект находится. Список таких режимов, имеющий название Transparency
Operation (Операция прозрачности), расположен на панели свойств при условии
выбора данного инструмента.

Перечислим режимы смешения цветов, предусмотренные в CorelDRAW 12:

О Normal (Обычный) — если наносимое изображение непрозрачно, то отобра-
жается только оно, в противном случае — смесь наносимого и фонового
изображений, зависящая от плотности слоя верхнего изображения (данный
режим используется в программе по умолчанию);

О Add (Добавление) — происходит суммирование значений яркости соответст-
вующих пикселов наносимого и фонового изображений (обработанное изо-
бражение становится более светлым, чем любое из исходных);

О Subtract (Вычитание) — величины яркости соответствующих пикселов верх-
него и фонового изображений суммируются, после чего из полученной вели-
чины вычитается число 255 (результирующее изображение становится более
темным, чем любое из смешиваемых);

П Difference (Разница) — яркость пиксела обработанного изображения вычисля-
ется как разность между большим и меньшим значениями соответствуют их
пикселов наносимого и фонового изображений;

П Multiply (Умножение) — цвет пиксела результирующего изображения вычис-
ляется путем перемножения значений яркости соответствующих пикселов
наносимого и фонового изображений в каждом из их цветовых каналов и де-
ления полученного результата на 255 (конечное изображение всегда будет
более темным, чем исходные);
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О Divide (Деление) — значения яркости соответствующих пикселов фонового и
наносимого изображений делятся первое на второе, а полученный результат
умножается на 255;

О If Lighter (Если светлее) — значения яркости соответствующих пикселов на-
носимого и фонового изображений сравниваются между собой в каждом из
их цветовых каналов, и выбирается наибольшая из этих величин, которая
присваивается пикселу обработанного изображения;

О If Darker (Если темнее) — отличается от предыдущего режима тем, что из
двух значений яркости соответствующих пикселов канальных изображений
выбирается наименьшее;

П Texturize (Текстура) — верхнее цветное изображение обесцвечивается, после
чего происходит перемножение значений яркости соответствующих пикселов
данного изображения и фонового;

О Hue (Цветовой тон) — при вычислении цветовых параметров результирую-
щего изображения оно представляется в формате цветовой модели HSB (Н -
цветовой тон, S — насыщенность и В — яркость), при этом значения цвето-
вого тона конечного изображения берутся из наносимого изображения, а ве-
личины насыщенности и яркости — из фонового;

О Saturation (Насыщенность) — отличается от предыдущего режима тем, что
значения насыщенности обработанного изображения берутся из наносимого,
а значения цветового тона и яркости — из фонового;

О Lightness (Светлота) — отличается от двух предыдущих режимов тем, что
здесь из наносимого изображения берутся значения яркости, а из фоново-
го — цветового тона и насыщенности;

П Invert (Инверсия) — происходит инвертирование цветов наносимого изобра-
жения (они заменяются на дополнительные), в которые раскрашивается ре-
зультирующее изображение;

П And (И) — значения яркостей исходных изображений представляются в дво-
ичной системе счисления, после чего для них выполняется операция логиче-
ского умножения;

П Or (Или) — отличается от предыдущего режима тем, что здесь используется
операция логического сложения;

П Хог (Исключающее или) — отличается от двух предыдущих режимов тем, что
в данном случае применяется логическая операция исключающего "или";

П Red (Красный) — для результирующего изображения значения яркости
в первом по порядку цветовом канале берутся из наносимого изображения,
а в остальных каналах — из фонового;

О Green (Зеленый) — для конечного изображения значения яркости во втором
цветовом канале берутся из наносимого изображения, а в остальных кана-
лах — из фонового;

П Blue (Синий) - для результирующего изображения значения яркости
в третьем цветовом канале берутся из наносимого изображения, а в осталь-
ных — из фонового.
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Рассмотрим порядок регулировки прозрачности векторных объектов рабочим
инструментом Interactive Transparency (Интерактивная прозрачность).

Равномерная регулировка прозрачности
На рис. 4.44 показан пример равномерной регулировки прозрачности четырех
прямоугольников белого цвета, расположенных на темном фоне, с помощью

Interactive Transparency (Интерактивная прозрачность). Вверхуинструмента

изображена панель свойств с параметрами прозрачности для выделенного пря-
моугольника (крайний справа).

Рис. 4.44. Пример равномерной регулировки прозрачности
инструментом Interactive Transparency

Поясним назначение элементов управления панели свойств, доступных при ра-
боте с инструментом Interactive Transparency в режиме равномерной регулиров-
ки прозрачности (их номера, приведенные на рисунке, указаны в квадратных
скобках):

G [1] — кнопка Edit Transparency, открывающая диалоговое окно Uniform
Transparency (Равномерная прозрачность) для задания уровня прозрачности
объекта;

Примечание

Проверка показала, что указанный выше режим не функционирует. Иными сло-
вами, цвет, выбранный в окне Uniform Transparency, не влияет на уровень
прозрачности объекта.

О [2] — раскрывающийся список Transparency Type, используемый для выбора
заданного типа регулировки прозрачности, представленного пунктом
Uniform;

П [3] — список Transparency Operation, в котором производится выбор одного
из 19 режимов смешения цветов при наложении обрабатываемого объекта на
фоновый объект;

О [4] — ползунок Starting Transparency, регулирующий уровень прозрачности
объекта;
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О [5] — список Transparency Target, в котором производится выбор областей
векторного объекта, подверженных регулировке прозрачности: область за-
ливки (пункт Fill), область обводки (Outline) или обе эти области (All);

П [6] — кнопка Freeze, преобразующая обрабатываемый прозрачный объект
в непрозрачное растровое изображение, которое имеет ту же раскраску, что
и исходный объект, расположенный на некотором фоне;

П [7] — кнопка Copy Transparency Properties, подключающая режим переноса
на выделенный объект параметров прозрачности из другого объекта до-
кумента;

О [8] -• кнопка Clear Transparency, отменяющая прозрачность выбранного
объекта.

Порядок работы
1. Выберите рабочий инструмент Interactive Transparency (Интерактивная про-

зрачность).

2. Выделите в документе требуемый векторный объект, щелкнув на нем кноп-
кой мыши.

3. Если вы хотите перенести на выбранный объект параметры прозрачности из
другого объекта документа, сделайте следующее. Щелкните на кнопке [7J
панели свойств, придав указателю вид жирной черной стрелки. Кончик этой
стрелки поместите в область объекта-образца и щелкните кнопкой мыши,
завершив на этом выполнение данной инструкции.

4. На панели свойств задайте следующие параметры (см. рис. 4.44):

• режим равномерной регулировки прозрачности (пункт Uniform в списке [2]);

• режим смешения цветов выбранного и фонового объектов (список [3]);

• уровень прозрачности объекта (ползунок [4]);

• область векторного объекта, подверженную регулировке прозрачности
(список [5]).

5. Если необходимо, преобразуйте обрабатываемый прозрачный объект, распо-
ложенный на некотором фоне, в непрозрачное растровое изображение,
имеющее ту же раскраску (кнопка [6]).

Градиентная регулировка прозрачности
На рис. 4.45 показан пример градиентной регулировки прозрачности четырех
прямоугольников белого цвета, расположенных на темном фоне, с помощью
рабочего инструмента Interactive Transparency (Интерактивная прозрач-
ность). Вверху изображена панель свойств с параметрами прозрачности для вы-
деленного прямоугольника (крайний справа), на котором находится управляю-
щая конструкция данного инструмента.
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Рис. 4.45. Пример градиентной регулировки прозрачности
инструментом Interactive Transparency

Поясним назначение элементов упрааления панели свойств, доступных при рабо-
те с инструментом Interactive Transparency в режиме градиентной регулировки
прозрачности (их номера, приведенные на рисунке, даны в квадратных скобках):

П [1] — кнопка Edit Transparency, открывающая диалоговое окно Fountain
Transparency (Градиентная прозрачность) для задания параметров прозрачно-
сти объекта с регулировкой ее по градиентному закону;

Диалоговое окно Fountain Transparency (Градиентная прозрачность) полно-
стью идентично окну Fountain Fill (Градиентная заливка), которое используется
для настройки параметров градиентной заливки при работе с рабочим инстру-
ментом Fill (Заливка). (См. рази. "Заливка" настоящей главы, подразд. "Гради-
ентная заливка".)

П [2] — раскрывающийся список Transparency Type, в котором производится
выбор одного из четырех типов градиентов, используемых при регулировке
прозрачности: линейный (пункт Linear), радиальный (Radial), конический
(Conical) или квадратный (Square);

£} [3j — список Transparency Operation, в котором производится выбор одною
из 19 режимов смешения цветов при наложении обрабатываемого объекта на
фоновый;

О [4] — ползунок Transparency Midpoint, регулирующий уровень прозрачности
объекта в месте расположения активного квадратного маркера управляющей
конструкции интерактивного инструмента;

О [5] — два поля (со счетчиками) Fountain Transparency Angle and Edge Pad,
верхнее из которых задает угол наклона оси градиентных переходов к гори-
зонтальной оси координат, а нижнее — величину смешения границ перехо-
дов от краев объекта;

3 [6] — список Transparency Target, в котором производится выбор областей
векторного объекта, подверженных регулировке прозрачности: область за-
ливки (пункт Fill), область обводки (Outline) или обе эти области (All);

П (у] — кнопка Freeze, преобразующая обрабатываемый прозрачный объект
в непрозрачное растровое изображение, которое имеет ту же раскраску, что
и исходный объект, расположенный на некотором фоне;
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G [8] — кнопка Copy Transparency Properties, подключающая режим переноса на
выделенный объект параметров прозрачности из другого объекта документа;

О [9] — кнопка Clear Transparency, отменяющая прозрачность выбранного объекта.

Порядок работы
1. Выберите рабочий инструмент Interactive Transparency (Интерактивная про-

зрачность).

2. Выделите в документе требуемый векторный объект, щелкнув на нем.

3. Если вы хотите перенести на выбранный объект параметры прозрачности из
другого объекта документа, сделайте следующее. Щелкните на кнопке [8]
панели свойств, придав указателю вид жирной черной стрелки. Кончик этой
стрелки поместите в область объекта-образца и выполните щелчок мышью,
завершив на этом выполнение данной инструкции.

4. На панели свойств задайте следующие параметры (см. рис. 4,45):

• режим градиентной регулировки прозрачности и тип градиента (спи-
сок [2]);

• режим смещения цветов выбранного и фонового объектов (список [3]);

• область векторного объекта, подверженную регулировке прозрачности
(список [6]).

5. Выберите базовые (начальный и конечный) уровни прозрачности одним из
двух способов:

• перетаскиванием мышью цветовых образцов из рабочей цветовой палитры
на квадратные маркеры управляющей конструкции интерактивного инст-
румента, которые будут преобразованы в соответствующие оттенки серого
цвета (черный цвет определяет полную прозрачность прилегающих к мар-
керу пикселов объекта, а белый — их полную непрозрачность);

• с помощью ползунка [4] при последовательном выборе указанных марке-
ров щелчками мыши.

6. Настройте геометрические параметры тонового градиентного изображения,
определяющего прозрачность объекта. Данную операцию можно выполнить
тремя способами:

• перетаскиванием мышью квадратных маркеров управляющей конструкции
инструмента (они определяют в объекте положение начальной и конечной
границ градиентных переходов), а также ползунка, расположенного между
ними (задает положение средней точки области объекта, которая будет
иметь усредненный уровень прозрачности);

• с помощью панели свойств (поля [5]);

• с использованием диалогового окна Fountain Тгалзрагепсу (Градиентная
прозрачность) (кнопка [I]), которое предоставляет наибольшие возмож-
ности в настройке параметров градиентной регулировки прозрачности.
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1. Если необходимо, преобразуйте обрабатываемый прозрачный объект, распо-
ложенный на некотором фоне, в непрозрачное растровое изображение,
имеющее ту же раскраску (кнопка [7]).

Регулировка прозрачности шаблоном
На рис. 4.46 представлен пример регулировки прозрачности шаблонами четырех
прямоугольников белого цвета, расположенных на темном фоне, с помощью

рабочего инструмента Interactive Transparency (Интерактивная прозрач-

ность). Вверху изображена панель свойств с параметрами прозрачности для вы-
деленного прямоугольника (крайний справа), на котором находится управляю-
щая конструкция данного инструмента.
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Рис. 4.46. Пример шаблонной регулировки прозрачности
инструментом Interactive Transparency

Поясним назначение элементов управления панели свойств, доступных при рабо-
те с инструментом Interactive Transparency в режиме шаблонной регулировки про-
зрачности (их номера, приведенные на рисунке, даны в квадратных скобках):

П [1] - кнопка Edit Transparency, открывающая диалоговое окно Pattern
Transparency (Шаблонная прозрачность) для задания параметров прозрачно-
сти объекта с регулировкой ее шаблоном;

Примечание

Диалоговое окно Pattern Transparency (Шаблонная прозрачность) полностью
идентично окну Pattern Fill (Заливка шаблоном), которое используется для на-
стройки параметров шаблонной заливки при работе с рабочим инструментом
Fill (Заливка). (См. разд. "Запивка" настоящей главы, подразд. "Заливка шаб-
лоном".)

[2] — раскрывающийся список Transparency Type, используемый для выбора
одной из трех разновидностей заданного типа регулировки прозрачности:
двухцветным шаблоном (пункт Two Color Pattern), многоцветным шаблоном
(Full Color Pattern) или растровым шаблоном (Bitmap Pattern);

[3] — список Transparency Operation, в котором производится выбор одного
из 19 режимов смешения цветов (см. ранее) при наложении обрабатываемою
объекта на фоновый;
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П [4] — список First Transparency Picker, предназначенный для выбора рабо-
чего образца шаблона заданного типа;

П [5] — ползунок Starting Transparency, регулирующий уровень прозрачности
объекта в области светлых тонов используемого шаблона;

О [6] — ползунок Ending Transparency, производящий соответствующую регули-
ровку в области темных тонов шаблона;

П [7| — список Transparency Target, в котором производится выбор областей
векторного объекта, подверженных регулировке прозрачности: область за-
ливки (пункт Fill), область обводки (Outline) или обе эти области (АН);

П [8] — кнопка Mirror Fill Tiles, выполняющая зеркальный разворот соседних
элементов мозаичного узора, используемого для регулировки прозрачности
объекта;

П [9] — кнопка Create Pattern, подключающая режим формирования нового
образца двухцветного или многоцветного шаблона;

О [10] — кнопка Freeze, преобразующая обрабатываемый прозрачный объект
в непрозрачное растровое изображение, которое имеет ту же раскраску, что и
исходный объект, расположенный на некотором фоне;

П [11] — кнопка Copy Transparency Properties, задающая режим переноса на
выделенный объект параметров прозрачности из другого объекта документа;

П [12] — кнопка Clear Transparency, отменяющая прозрачность выбранного
объекта.

Порядок работы
1. Выберите рабочий инструмент Interactive Transparency (Интерактивная про-

зрачность).

2. Выделите в документе требуемый векторный объект, щелкнув на нем.

3. Если вы хотите перенести на выбранный объект параметры прозрачности из
другого объекта документа, выполните следующее. Щелкните на кнопке [И]
панели свойств, придав указателю вид жирной черной стрелки. Кончик этой
стрелки поместите в область объекта-образиа и щелкните кнопкой мыши,
завершив на этом выполнение данной инструкции.

4. На панели свойств задайте следующие параметры (см. рис. 4.46):

• режим регулировки прозрачности шаблоном и тип шаблона (список [2]);

• рабочий шаблон, используемый для регулировки прозрачности (спи-
сок [4]);

• режим смешения цветов выбранного и фонового объектов (список [3|);

• область векторного объекта, подверженную регулировке прозрачности
(список [7J).

5. Определите базовые (начальный и конечный) уровни прозрачности, пред-
ставляющие собой коэффициенты прозрачности объекта для самых светлых
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(ползунок [5]) и самых темных (ползунок [6]) участков тонового мозаичного
изображения.

6. Настройте геометрические параметры шаблона, из копий которого сформи-
ровано данное изображение, воспользовавшись одним из двух способов:

• перетаскиванием мышью маркеров управляющей конструкции инст-
румента;

• с использованием диалогового окна Pattern Transparency (Шаблонная
прозрачность) (кнопка [1]).

7. Если необходимо, преобразуйте обрабатываемый прозрачный объект, распо-
ложенный на некотором фоне, в непрозрачное растровое изображение,
имеющее ту же раскраску (кнопка [10]).

Регулировка прозрачности текстурой
На рис. 4.47 показан пример регулировки прозрачности текстурами четырех
прямоугольников белого цвета, расположенных на темном фоне, с помощью

рабочего инструмента Interactive Transparency (Интерактивная прозрач-

ность). Вверху изображена панель свойств с параметрами прозрачности для вы-
деленного прямоугольника (крайний справа), на котором находится управляю-
щая конструкция данного инструмента.

Рис. 4.47. Пример текстурной регулировки прозрачности
инструментом Interactive Transparency

Поясним назначение элементов управления панели свойств, доступных при работе
с инструментом Interactive Transparency в режиме текстурной регулировки прозрач-
ности (их номера, приведенные на рисунке, указаны в квадратных скобках):

П [1] - кнопка Edit Transparency, открывающая диалоговое окно Texture
Transparency (Текстурная прозрачность) для задания параметров прозрачно-
сти объекта с регулировкой ее текстурой;

^"Примечание

Диалоговое окно Texture Transparency полностью идентично окну Texture Fill
(Заливка текстурой), которое используется для настройки параметров текстур-
ной заливки при работе с рабочим инструментом Fill (Заливка). (См. разд. За-
пивка" данной главы, подразд. "Заливка текстурой".)
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П [2] — раскрывающийся список Transparency Type, в котором производится
выбор заданного типа регулировки прозрачности, представленного пунктом
Texture;

П [3] — список Transparency Operation, в котором производится выбор одного
из 19 режимов смешения цветов при наложении обрабатываемого объекта на
фоновый;

О [4] — список Texture Library, предназначенный для выбора библиотеки текстур;

П [5] — список First Transparency Picker, используемый для выбора рабочего
образца текстуры из заданной библиотеки образцов;

П [6] — ползунок Starting Transparency, регулирующий уровень прозрачности
объекта в области светлых тонов текстуры;

Q [7] — ползунок Ending Transparency, производящий соответствующую регули-
ровку в области темных тонов;

П [8] — список Transparency Target, в котором производится выбор областей
векторного объекта, подверженных регулировке прозрачности: область за-
ливки (пункт Fill), область обводки (Outline) или обе эти области (All);

П [9] — кнопка Freeze, преобразующая обрабатываемый прозрачный объект
в непрозрачное растровое изображение, которое имеет ту же раскраску, что
и исходный объект, расположенный на некотором фоне;

О [10] — кнопка Mirror Fill Tiles, выполняющая зеркальный разворот соседних
элементов мозаичного узора, используемого для регулировки прозрачности
объекта;

П [11] — кнопка Copy Transparency Properties, подключающая режим переноса на
выделенный объект параметров прозрачности из другого объекта документа:

О [12] — кнопка Clear Transparency, отменяющая прозрачность объекта.

Порядок работы
1. Выберите рабочий инструмент Interactive Transparency (Интерактивная про-

зрачность).

2. Выделите в документе требуемый векторный объект, щелкнув на нем.

3. Если вы хотите перенести на выбранный объект параметры прозрачности из
другого объекта документа, сделайте следующее. Щелкните на кнопке [11]
панели свойств, придав указателю вид жирной черной стрелки. Кончик этой
стрелки поместите в область объекта-образца и сделайте щелчок мышью, за-
вершив на этом выполнение данной инструкции.

4. На панели свойств задайте следующие параметры (см. рис. 4.47):

• режим регулировки прозрачности текстурой (пункт Texture в списке [2]);

• библиотеку текстур (список [4J) и рабочий образец текстуры (список [5]);
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• режим смешения цветов выбранного и фонового объектов (список [3]);

• область векторного объекта, подверженную регулировке прозрачности
(список [8]).

5. Определите базовые (начальный и конечный) уровни прозрачности, пред-
ставляющие собой коэффициенты прозрачности объекта для самых светлых
(ползунок [6]) и самых темных (ползунок [7]) участков тонового мозаичного
изображения, регулирующего прозрачность объекта.

6. Настройте геометрические параметры текстуры одним из двух способов:

• перетаскиванием мышью маркеров управляющей конструкции инст
румента;

• с использованием диалогового окна Texture Transparency (Текстурная про-
зрачность) (кнопка [1]).

7. Если необходимо, преобразуйте обрабатываемый прозрачный объект, распо-
ложенный на некотором фоне, в непрозрачное растровое изображение,
имеющее ту же раскраску (кнопка [9]).

Объединение объектов
Под объединением объектов понимается некоторая операция по созданию нового
объекта векторной графики в результате определенного взаимодействия исход-
ных векторных объектов, выбранных в документе. В CorelDRAW 12 допускается
выполнять следующие семь операций объединения: комбинирование (combine),
слияние (weld), обрезка (trim), пересечение (intersect), упрощение (simplify), "перед-
ний минус задний" (front minus back) и "задний минус передний" (back minus front).

Для этой цели используются следующие средства программы:

G докер Shaping (Обработка форм);

О команда Combine (Скомбинировать) меню Arrange (Расположить);

П семь команд, составляющих подменю Shaping меню Arrange.

Опишем перечисленные выше операции объединения объектов.

Операция комбинирования
Из группы выделенных в документе перекрывающихся векторных объектов фор-
мируется новый объект, в котором области перекрытия четного количества исход-
ных объектов становятся прозрачными. Раскраска результирующего объекта сов-
падает с раскраской самого нижнего из исходных объектов. Данная операция
выполняется командой Arrange > Combine (Расположить > Скомбинировать).
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Операция слияния
Существуют две разновидности операции слияния, которые выполняются раз-
личными средствами CorelDRAW 12. Рассмотрим их.

П Из группы выделенных в документе объектов формируется новый объект,
область которого совпадает с областями всех исходных объектов, а раскраска
передается ему от самого нижнего из этих объектов. Данная операция вы-
полняется командой Arrange > Shaping > Weld (Расположить > Обработка
форм > Слияние).

О Из группы выделенных объектов формируется новый объект, область кото-
рого совпадает с областями всех этих объектов, а раскраска передается ему от
целевого объекта, входящего в эту группу, который выбирается в дальней-
шем. Данная операция выполняется с помощью докера Shaping (Обработка
форм), открываемого командой Arrange t Shaping > Shaping (Расположить > Обра-
ботка форм > Обработка форм). В этом докере вы должны выполнить сле-
дующие действия.

1. Выберите в верхнем списке пункт Weld (Слияние).

2. Определитесь в отношении двух флажков, задающих режимы сохранения
исходных объектов: нецелевых (верхний флажок Source Object(s)) и целе-
вых (нижний флажок Target Object(s)).

3. Щелкните на кнопке Weld To (Слить с), отобразив рядом со стрелкой
указателя значок, схематически представляющий выполняемую операцию.

4. Подведите указатель к тому объекту из группы выделенных объектов, ко-
торый будет использован в качестве целевого, и сделайте щелчок мышью.

Операция обрезки
Существуют два вида операции обрезки, которые выполняются различными
средствами программы.

П В результате обработки группы выделенных перекрывающихся объектов изме-
няется лишь самый нижний объект, из которого удаляются области перекры-
тия с остальными объектами этой группы. Данная операция выполняется ко-
мандой Arrange > Shaping » Trim (Расположить > Обработка форм > Обрезка).

П Из всей группы выделенных перекрывающихся объектов остается лишь часть
того объекта, который в дальнейшем выбирается в качестве целевого. Из этого
объекта будут удалены области перекрытия с другими объектами группы.
Данная операция выполняется с помощью докера Shaping (Обработка
форм), открываемого командой Arrange > Shaping > Shaping (Расположить >
Обработка форм > Обработка форм). В верхнем списке докера вы должны
выбрать пункт Trim (Обрезка), определиться в отношении двух флажков
Source Object(s) и Target Object(s). задающих режимы сохранения исходных
объектов, щелкнуть на кнопке Trim, подвести указатель к объекту группы,
выбираемому в качестве целевого, и щелкнуть кнопкой мыши.
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Операция пересечения
Существуют две разновидности операции пересечения, которые выполняются
различными средствами CorelDRAW 12. Рассмотрим их.

П В результате обработки группы выделенных перекрывающихся объектов вес
эти объекты остаются неизменными, при этом формируется новый объект, ат-
рибуты оформления которого будут теми же, что у самого нижнего объекта, а
его область будет совпадать с областью перекрытия нижнего объекта всеми ос
тальными объектами группы. Данная операция выполняется командой
Arrange » Shaping * Intersect (Расположить > Обработка форм > Пересечение).

П Из всей группы выделенных перекрывающихся объектов остаются части лишь
тех объектов, которые не относятся к выбираемому в дальнейшем целевому
объекту группы. Области этих новых объектов совпадают с областями пере-
крытия соответствующих исходных объектов с целевым объектом, а атрибуты
оформления передаются им от целевого объекта. Данная операция выполняет-
ся с помощью докера Shaping (Обработка форм), открываемого командой
Arrange > Shaping > Shaping (Расположить > Обработка форм * Обработка форм).
В верхнем списке докера вы должны выбрать пункт Intersect (Пересечение),
определиться в отношении двух флажков Source Object(s) и Target Object(s).
задающих режимы сохранения исходных объектов, щелкнуть на кнопка
Intersect With (Пересечь с), подвести указатель к объекту группы, выбираемому
в качестве целевого, и щелкнуть мышью.

Операция упрощения
Из группы выделенных перекрывающихся объектов удаляются те части, кото-
рых не видны на экране в связи с наложением на них других объектов группы.
Данная операция может быть выполнена двумя способами:

П командой Arrange > Shaping > Simplify (Расположить > Обработка форм ^
Упрощение);

П с помощью докера Shaping, открываемого командой Arrange»Shaping ¥
Shaping, в верхнем списке которого вы должны выбрать пункт Simplify (Уп-
рощение) и щелкнуть на кнопке Apply (Применить).

Операция "передний минус задний"
Из всей группы выделенных перекрывающихся объектов остаются только те
части верхнего объекта, под которыми отсутствуют другие объекты группы.
Данную операцию можно выполнить двумя способами:

3 командой Arrange > Shaping > Front Minus Back (Расположить > Обработка
форм > Передний минус задний);

П с помощью докера Shaping, открываемого командой Arrange > Shaping > Shaping,
в верхнем списке которого вы должны выбрать пункт Front Minus Back (Пе-
редний минус задний) и щелкнуть на кнопке Apply (Применить).
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Операция "задний минус передний"
Из всей группы выделенных перекрывающихся объектов остаются только те
части самого нижнего объекта, которые видны на экране. Данная операция мо-
жет быть выполнена двумя способами:

О командой Arrange > Shaping t Back Minus Front (Расположить > Обработка
форм > Задний минус передний);

G с помощью докера Shaping, открываемого командой Arrange » Shaping » Shaping,
в верхнем списке которого вы должны выбрать пункт Back Minus Front (Зад-
ний минус передний) и щелкнуть на кнопке Apply (Применить).

На рис. 4.48 показан пример выполнения различных операций объединения в от-
ношении двух векторных объектов прямоугольной и эллиптической форм. Справа
изображен докер Shaping (Обработка форм) в режиме операции слияния, которая
была ранее выполнена для выделенного объекта. Объекты под номером 6 были ис-
кусственно отделены друг от друга мышью, чтобы продемонстрировать особенность
операции упрощения, в результате выполнения которой они были созданы.

Рис. 4.48. Пример объединения объектов. 1 —исходные объекты;
• результат комбинирования объектов; 3 — результат слияния объектов;
— результат обрезки объектов; 5 — результат пересечения объектов;

6 — результат упрощения объектов; 7 — результат выполнения
операции "передний минус задний"; 8 — результат выполнения

операции "задний минус передний"

Трансформация объектов
Под трансформацией векторного объекта понимается изменение его формы или
ориентации в документе путем выполнения двух групп операций:

П масштабирование (изменение размеров), поворот, наклон и зеркальные раз-
вороты (по горизонтали и вертикали) объекта;
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О различные операции обработки контура объекта.

Операции трансформации, входящие в первую группу, выполняются с помощью
следующих средств CorelDRAW 12:

П рабочих инструментов '.%• Pick (Выбор) и '$&• Free Transform (Произвольная

трансформация);

П панели свойств при работе с данными инструментами;

О панели инструментов Transform (Трансформация);

О докера Transformation (Трансформация) .

Чтобы восстановить объект, трансформированный одним из перечисленных вы
ше средств, необходимо выполнить команду Arrange > Clear Transformations»
(Расположить > Отменить трансформации).

Операции трансформации из второй группы выполняются с использованием
трех рабочих инструментов;

Shape (Форма) — редактирование контуров Безье векторных графиче-

ских объектов (см. разд. "Обработка линий и фигур" настоящей главы);

~1 Interactive Distortion (Интерактивное искажение) — создание эффекта

искажения (см. разд. "Создание эффектов " данной главы, подразд. "Искажение ")\

Interactive Envelope (Интерактивная оболочка) — создание эффекта обо

ломки (см. разд. "Создание эффектов" настоящей главы, подраздел "Оболочка").

Рассмотрим особенности использования различных средств программы при вы-
полнении масштабирования, поворота, наклона и зеркальных разворотов объек-
тов документа.

Инструмент Pick

Рабочий инструмент Pick (Выбор) позволяет выполнять следующие опера-

ции трансформации:

П масштабирование объекта (пропорциональное и непропорциональное);

ГЗ поворот объекта относительно центра вращения, положение которого можно
регулировать;

П наклон объекта по горизонтали и вертикали, вызванный наклоном противо-
положных сторон воображаемой прямоугольной рамки, охватывающей этот
объект;

П зеркальные развороты объекта по горизонтали и вертикали.

Первые три операции применяются как в интерактивном режиме (с помощью
выделяющих маркеров и мыши), так и с использованием элементов управлении
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панели свойств, расположенных в левой ее части. Четвертая операция возможна
лишь с помощью панели свойств (две кнопки Mirror Buttons (Кнопки зеркаль-
ных разворотов) в ее центре).

Конкретные операции трансформации, доступные для выполнения в интерак-
тивном режиме, определяются формой маркеров, окружающих выделенный
объект. Если маркеры имеют вид черных квадратиков, то с их помощью объект
можно масштабировать, а с использованием крестообразной метки его геомет-
рического центра — перемещать.

Если же маркеры имеют вид двунаправленных стрелок, то объект можно повер-
нуть или наклонить, а также изменить положение центра вращения, метка кото-
рого имеет вид окружности с точкой посредине. Переход от одного режима
трансформации объекта к другому производится щелчком мыши в иентре объ-
екта, в результате которого формы маркеров изменятся.

Более подробную информацию о трансформации объектов произвольных типов
инструментом Pick (Выбор) вы можете получить в разд. "Общие операции" гл. 5,
подразд. "Трансформация".

Инструмент Free Transform

Рабочий инструмент Free Transform (Произвольная трансформация) позволя-

ет выполнять в интерактивном режиме операции поворота, зеркального разворота,
масштабирования и наклона объекта. Тип будущей операции трансформации вы-
бирается с помощью четырех кнопок панели свойств, расположенных слева. Ре-
зультат заданной трансформации объекта зависит от двух составляющих:

О от исходного положения указателя по отношению к объекту, которое фикси-
руется пользователем в момент нажатия кнопки мыши;

О от конечного положения указателя, определяемого в момент отпуска кнопки
мыши.

В отличие от рабочего инструмента Pick (Выбор), инструмент Free Transform
позволяет регулировать ось (или опорную точку) трансформации при выполне-
нии всех перечисленных операций, а не только операции поворота. Перед при-
менением инструмента Free Transform объект трансформации следует выделить
инструментом Pick.

В процессе трансформации объекта инструментом Free Transform панель
свойств практически не используется, за исключением четырех левых кнопок,
предназначенных для выбора типа трансформации. Вместе с тем, на этой пане-
ли находятся элементы управления, с помощью которых вы можете выполнять
различные операции трансформации без непосредственного участия инструмен-
та Free Transform (выбор этого инструмента необходим лишь для перевода пане-
ли свойств в данное состояние). При этом панель свойств будет иметь почти
такой же вид, как и панель инструментов Transform (Трансформация), за ис-
ключением первых четырех кнопок, которые на последней панели инструментов
отсутствуют (см. разд. "Панели инструментов"гл. 2, подразд. "Дополнительные панели").
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На рис. 4.49 показан пример поворота обт>екта треугольной формы с помощью
рабочего инструмента Free Transform (Произвольная трансформация). Вверху изо-
бражена панель свойств, а справа — докер Transformation (Трансформация), яв-
ляющийся альтернативным средством трансформации объектов в CorelDRAW 12.

На этом рисунке вы видите: исходный объект (с заливкой), контур трансформи
руемого объекта, ось поворота (пунктирная линия) и крестообразную метку те-
кущего положения указателя. Начальная точка оси поворота задается положени
ем указателя в момент нажатия кнопки мыши, а регулируется текущим его
положением.

1 2 3 4 5 6 7 8 9 10 11 12 13 14

Рис. 4.49. Пример поворота объекта инструментом Free Transform

Поясним назначение элементов управления панели свойств, доступных при ра-
боте с инструментом Free Transform (их номера, приведенные на рисунке, ука-
заны в квадратных скобках):

П [1] — кнопка Free Rotation Tool, задающая режим произвольного поворота
выделенного объекта;

П [2] — кнопка Free Angle Reflection Tool, подключающая режим произвольного
зеркального разворота данного объекта;

О [3] — кнопка Free Scale Tool, активизирующая режим произвольного мас-
штабирования выбранного объекта;

П [4] — кнопка Free Skew Tool, задающая режим произвольного наклона;

О [5] — два поля Object(s) Position, в которых указываются координаты геомет-
рического центра объекта;

G [6] — два поля Object(s) Size, определяющие размеры объекта;

П [7] — два поля Scale Factor, в которых задаются коэффициенты масштабиро
вания объекта по горизонтали и вертикали;

О [8] — кнопка Nonproportional Scaling/Sizing Ratio, подключающая режим не-
пропорционального масштабирования;
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П [9] — две кнопки Mirror Buttons, выполняющие зеркальный разворот объекта
по горизонтали и вертикали;

О [10] — поле Angle of Rotation, в котором указывается угол поворота объекта;

О [II] — два поля Center of Rotation Position, предназначенные для задания ко-
ординат центра вращения объекта;

П [12] — два поля Skew Angle, определяющие углы наклона вертикальных
и горизонтальных сторон прямоугольной выделяющей рамки объекта;

П [13] — кнопка Apply To Duplicate, формирующая копию выбранного объекта
с заданными параметрами трансформации;

П [14] — кнопка Relative to Object, подключающая режим задания координат
объекта и центра его вращения в относительных единицах (по отношению
к его исходному положению).

Докер Transformation
Докер Transformation (Трансформация) (см. рис. 4.49) предназначен для пере-
мещения, масштабирования, поворота, наклона и зеркальных разворотов объек-
та путем задания численных значений параметров его трансформации или коор-
динат. В качестве трансформируемого объекта докер позволяет использовать как
выделенный в документе объект, так и его сформированную копию.

С помощью докера Transformation вы можете очень просто создать серию объектов-
копий, одинаково трансформированных относительно друг друга. Для этого
достаточно выделить исходный объект, задать для него параметры трансформа-
ции на соответствующей вкладке докера и несколько раз щелкнуть на кнопке
Apply To Duplicate (Применить к копии).

Докер Transformation (Трансформация) состоит из пяти вкладок, на каждой из
которых расположены параметры настройки для соответствующей операции
трансформации. Для открытия докера используется пять команд, составляющих
подменю Transformations (Трансформации) меню Arrange (Расположить). Каждая
из них открывает докер на соответствующей вкладке.

Если докер Transformation открыт, то перейти на любую его вкладку можно
с помощью следующих пяти кнопок, расположенных вверху: Position (Положе-
ние), Rotate (Поворот), Scale and Mirror (Масштаб и зеркальный разворот), Size
(Размер) и Skew (Наклон). При нажатии одной из этих кнопок будет открыта
соответствующая вкладка докера с параметрами трансформации.

В нижней части любой вкладки докера Transformation находится девять неболь-
ших квадратных окошек, восемь из которых расположено в углах и серединах
сторон квадрата, а одно — в центре. Они предназначены для ввода точки отсче-
та, используемой при трансформации или перемещении объекта. Реализуется
это путем установки метки в соответствующем окошке.

Внизу докера Transformation расположены две кнопки управления: Apply (При-
менить) и Apply To Duplicate (Применить к копии). При щелчке на первой
кнопке произойдет трансформация выделенного в документе объекта, а при
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щелчке на второй кнопке будет сформирована трансформированная копия ис-
ходного объекта, которая при этом выделится.

Перечислим другие параметры, которые можно задавать на различных вкладках
докера Transformation:

О на вкладке Position (Положение):

• новые координаты (абсолютные или относительные) выбранной точки от-
счета объекта (два поля Position);

• режим вычисления относительности координат (флажок Relative Position);

О на вкладке Rotate (Поворот):

• угол поворота объекта (поле Angle);

• координаты центра вращения (два поля Center);

• режим вычисления относительности координат (флажок Relative Center);

П на вкладке Scale and Mirror (Масштаб и зеркальный разворот):

• коэффициенты масштабирования объекта (два поля Scale);

• режим непропорционального .масштабирования (флажок Non-proportional);

• режимы зеркального разворота по горизонтали и вертикали (две кнопки
Mirror);

П на вкладке Size (Размер):

• размеры объекта по горизонтали и вертикали (два поля Size);

• режим непропорционального изменения размеров объекта (флажок Non-
proportional);

П на вкладке Skew (Наклон):

• углы наклона объекта по горизонтали и вертикали (два поля Skew);

• режим использования при наклоне опорной точки (флажок Use Anchor Point).

Создание эффектов
Программа CorelDRAW 12 представляет пользователю широкие возможности по
созданию художественных эффектов в объектах векторной графики. Всего таких
эффектов — девять: переход (blend), контур (contour), искажение (distortion), обо-
лочка (envelope), выдавливание (extrude), тень (drop shadow), линза (lens), пер-
спектива (perspective) и PowerCIip. Первые шесть из них формируются интерак-
тивными рабочими инструментами, расположенными в десятой ячейке блока
инструментов программы, а остальные три — с помощью соответствующих ко-
манд меню Effects (Эффекты).

Эффекты векторной графики, создаваемые в CorelDRAW 12, характеризуются
следующими особенностями:

П их набор шире, чем в любой другой существующей программе векторной
графики;
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О в процессе создания эффектов тени, линзы и PowerClip могут использоваться
или создаваться дополнительные растровые изображения;

П в CorelDRAW 12 не предусмотрено создание ряда эффектов, доступных для
других программ векторной графики, в частности эффектов штриховки и мо-
заики, формируемых в Adobe Illustrator.

Примечание

Некоторые их эффектов, отсутствующих в рассматриваемой программе, могут
быть созданы программой трассировки CorelTRACE 12, входящей в состав
графического пакета CorelDRAW Graphic Suite 12 (см. разд. "Программа трас-
сировки CorelTRACE 12" гл. 10).

В CorelDRAW 12 можно не только создавать эффекты в отдельных векторных
объектах, но -и переносить эффекты из одних объектов на другие (не имеющие
данных эффектов). Такие операции выполняются в программе с помощью
команд, составляющих подменю Copy Effect (Копировать эффект) и Clone Effect
(Клонировать эффект) меню Effects (Э(]кректы). (См. разд. "Команды меню Effects"гл. 9.)

В частности, подменю Copy Effect (Копировать эффект) содержит девять ко-
манд, позволяющих скопировать перечисленные эффекты с одних объектов до-
кумента на другие. В подменю Clone Effect (Клонировать эффект) входят четыре
команды по клонированию эффектов перехода, контура, выдавливания и тени.
Использование команд копирования и клонирования эффектов позволяет уско-
рить процесс создания однотипных эффектов для групп объектов документа.

Примечание

Под клонированием понимается такая операция копирования эффекта из одно-
го объекта документа на другой, при которой сохраняется полная зависимость
параметров эффекта-копии от эффекта-оригинала.

Опишем эффекты векторной графики, создаваемые в CorelDRAW 12.

Переход
Эффект перехода состоит в следующем. Из двух исходных векторных объектов,
расположенных на некотором расстоянии друг от друга, формируется комбини-
рованный объект (объект перехода), состоящий из двух базовых элементов и
группы промежуточных. В качестве базовых элементов используются исходные
объекты, а промежуточные элементы, формируемые программой автоматически,
обладают следующими свойствами: их геометрические и цветовые параметры
плавно изменяются при переходе от одного базового элемента к другому.

Данный эффект создается интерактивным рабочим инструментом Interactive

Blend (Интерактивный переход) (см. разд. "Блок инструментов" гл. 2). Параметры
эффекта регулируются с помощью управляющей конструкции инструмента,
а также элементов управления панели свойств. Альтернативным средством
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настройки параметров эффекта является докер Blend (Переход), открываемый
одноименной командой подменю Dockers (Докеры) меню Window (Окно).

На рис. 4.50 представлены два объекта перехода, отличающиеся между собой
параметрами настройки. Правый объект выделен, на нем расположена управ-
ляющая конструкция инструмента Interactive Blend. Вверху изображена панель
свойств с параметрами эффекта перехода для выделенного объекта. Слева рас-
положен открытый список со стилями оформления эффекта и визуальным ин-
дикатором для выбранного эффекта.
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Визуальный индикатор эффекта

Рис. 4.50. Пример создания эффекта перехода

Поясним назначение элементов управления панели свойств, доступных при ра-
боте с инструментом Interactive Blend (их номера, приведенные на рисунке,
даны в квадратных скобках):

П [1] — раскрывающийся список Preset List, предназначенный для выбора сти-
ля оформления эффекта перехода; данный стиль представляет собой набор
параметров эффекта, сохраненный в файле под определенным именем вместе
с изображением некоторого объекта с эффектом, используемым в качестве
его визуального индикатора;

П [2] — кнопка Add Preset, создающая новый стиль оформления эффекта перехода;

П [3] — кнопка Delete Preset, удаляющая выбранный стиль оформления эффек-
та, созданный ранее пользователем, при условии отсутствия в документе вы-
деленных объектов;

П [4] — два поля Object(s) Position, в которых указываются координаты геомет-
рического центра объекта перехода;

П [5] — два поля Object(s) Size, используемые для задания размеров объекта;

О [6] — поле (со счетчиками) Number of Steps, определяющее количество про-
межуточных элементов в объекте перехода;

П [7] — поле (со счетчиками) Blend Direction, в котором указывается угол пово-
рота последнего из промежуточных элементов объекта перехода относитель-
но конечного элемента (базового);

[8] — кнопка Loop Blend, подключающая режим расположения промежуточ-П
ных элементов перехода по дуге;

9 Зак. 250



258 __ Глава 4

П [9] — кнопка Direct Blend, задающая направление изменения в цветовом
круге оттенков, которыми раскрашиваются промежуточные элементы объек-
та перехода, по отрезку прямой между цветами раскраски исходного и ко-
нечного элементов данного объекта;

О [10] — кнопка Clockwise Blend, определяющая направление изменения цвето-
вых оттенков в цветовом круге по часовой стрелке;

П [II ] — кнопка Counterclockwise Blend, задающая направление изменения дан-
ных цветовых оттенков против часовой стрелки;

О [12] — кнопка Object and Color Acceleration, открывающая дополнительную
панель управления с двумя ползунками, которые регулируют изменение ша-
гов (интервалов) между соседними элементами объекта перехода, а также
между цветовыми оттенками, в которые они раскрашены;

П [13] — кнопка Accelerate Sizing for Blend, ускоряющая изменение формы
промежуточных элементов при их приближении к базовым элементам;

П [14] — кнопка Miscellaneous Blend Options, открывающая панель управления
для задания дополнительных параметров, влияющих на эффект перехода;

О [15] — кнопка Start and End Object Properties, раскрывающая командную па-
нель для выбора новых базовых элементов объекта перехода или выделения
имеющихся;

О [16] — кнопка Path Properties, открывающая командную панель для выбора
новой направляющей объекта перехода;

П [17] — кнопка Copy Blend Properties, выполняющая перенос на выделенный-
объект перехода параметров другого объекта документа, содержащего эффект
перехода;

П [18] — кнопка Clear Blend, удаляющая эффект перехода из выбранного объекта.

Порядок создания эффекта
1. Создайте два векторных объекта, которые будут использованы в качестве ба-

зовых элементов объекта перехода.

2. Выделите эти объекты рабочим инструментом Pick (Выбор).

3. Выберите рабочий инструмент Interactive Blend (Интерактивный переход).

4. В списке [1] панели свойств (см. рис. 4.50) укажите требуемый стиль оформ-
ления эффекта перехода, сформировав объект перехода с заданным количе-
ством промежуточных элементов. При этом на объекте появится упраатяю-
щая конструкция интерактивного инструмента, состоящая из двух белых
квадратных маркеров, соединенных пунктирной стрелкой (она указывает на-
правление расположения элементов в объекте перехода) с двумя ползунками
треугольной формы. Если этот эффект вас полностью устраивает, завершите
на этом выполнение настоящей инструкции, в противном случае перейдите
к следующему ее шагу.
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5. Если вы хотите перенести на созданный объект перехода параметры анало-
гичного эффекта из другого объекта документа, щелкните на кнопке [17],
придав указателю вид жирной черной стрелки. Кончик этой стрелки помес-
тите на один из промежуточных элементов объекта перехода, используемого
в качестве образца, и щелкните мышью. На этом завершается выполнение
данной инструкции.

6. Выберите требуемое число промежуточных элементов в объекте перехода
(поле [6]).

7. С помощью управляющей конструкции инструмента Interactive Blend вы
можете настроить следующие параметры объекта перехода:

• положение его базовых элементов. Для этого установите указатель на со
ответствующем квадратном маркере, нажмите кнопку мыши и перетащи
те указатель в нужное место документа, после чего отпустите кнопку
мыши;

• раскраску областей заливки и обводки базового элемента. Для этого ус-
тановите указатель на выбранном образце цвета рабочей цветовой палит-
ры, нажмите кнопку мыши и переместите указатель в область выбран-
ного базового элемента или на его контур, отпустив кнопку при
появлении рядом со стрелкой указателя цветного квадратика (при залив-
ке) или квадратной рамки (при обводке);

• шаги (промежутки) между соседними элементами объекта перехода (ре-
гулируются верхним ползунком) или между цветовыми оттенками, в ко-
торые они раскрашены (нижним ползунком). Чем больше (меньше) рас-
стояние между верхним ползунком и некоторым базовым элементом, тем
большими (меньшими) будут интервалы между элементами в этой облас-
ти. С увеличением (уменьшением) расстояния между нижним ползунком
и базовым элементом слабее (сильнее) будут изменяться цвета раскраски
элементов объекта перехода, находящихся в данной области.

8. Отрегулируйте другие параметры объекта перехода, используя для этого ин-
струменты панели свойств, а также контекстное меню, открываемое правой
кнопкой мыши при установке указателя на объекте перехода. С помощью
данного меню или командной панели, открываемой кнопкой [16] панели
свойств, можно выполнить следующие операции:

• заменить базовые элементы объекта перехода на другие (команды New
Start и New End);

• расположить элементы объекта вдоль произвольного векторного контура,
который должен быть предварительно сформирован (команда New Path),

9. Чтобы зафиксировать текущие параметры эффекта для их последующего
использования, создайте новый стиль оформления эффекта перехода (кноп-
ка [2]).

10. Если вы хотите отменить созданный эффект, щелкните на кнопке [18] или
выполните команду Effects > Clear Effect (Эффекты > Удалить эффект).
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Контур
Эффект контура состоит в следующем. Внутренняя или наружная область
векторного объекта с равномерной или градиентной заливкой разбивается
на одинаковые по ширине полоски (витки), отделенные контурными линиями
с толщиной линии обводки объекта. При этом происходит плавный переход для
цветов заливки и обводки этих полосок между исходными цветами объекта и
конечными цветами, заданными пользователем.

Допускается создание трех разновидностей эффекта контура:

П "К центру" (То center) — витки равномерно заполняют всю внутреннюю об-
ласть объекта;

П "Вовнутрь" (Inside) — заданное количество витков заполняет часть внутрен-
ней области объекта, примыкающую к его контуру;

П "Наружу" (Outside) — заданное количество витков располагается снаружи от
объекта, примыкая к его контуру.

Эффект контура создается интерактивным рабочим инструментом

Interactive Contour (Интерактивный контур) (см. разд. "Блок инструментов" гл. 2).
Параметры эффекта регулируются с помощью управляющей конструкции инст-
румента, а также элементов управления панели свойств. Альтернативным сред-
ством настройки параметров эффекта является докер Contour (Контур), откры-
ваемый одноименной командой подменю Dockers (Докеры) меню Window
(Окно).

На рис. 4.51 показаны два прямоугольных объекта с эффектом контура, отли-
чающиеся между собой параметрами настройки. Правый объект выделен, на нем
находится управляющая конструкция инструмента Interactive Contour. Вверху
изображена панель свойств с параметрами эффекта для выделенного объекта.
Слева расположен открытый список со стилями оформления эффекта контура и
визуальным индикатором для выбранного эффекта.
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Рис. 4.51. Пример создания эффекта контура
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Поясним назначение элементов управления панели свойств, доступных при ра-
боте с инструментом Interactive Contour (их номера, приведенные на рисунке,
даны в квадратных скобках):

О [1] — раскрывающийся список Preset List, предназначенный для выбора сти-
ля оформления эффекта контура; данный стиль представляет собой набор
параметров эффекта, сохраненный в файле под определенным именем вместе
с изображением некоторого объекта с эффектом, используемым в качестве
его визуального индикатора;

П [2] — кнопка Add Preset, создающая новый стиль оформления эффекта кон-
тура;

П [3] — кнопка Delete Preset, удаляющая текущий стиль оформления эффекта, дос-
тупная для использования при отсутствии в документе выделенных объектов;

G [4] — два поля Object(s) Position, в которых указываются координаты геомет-
рического центра объекта;

d [5] — два поля Object(s) Size, определяющие размеры объекта;

П [6] — кнопка То center, выбирающая тип эффекта контура "К центру";

О [7] — кнопка Inside, выбирающая тип эффекта контура "Вовнутрь";

О [8] — кнопка Outside, выбирающая тип эффекта контура "Наружу";

О [9] — поле (со счетчиками) Contour Steps, в котором задается число витков
контурной линии для эффектов типа "Вовнутрь" и "Наружу";

О [10] — поле (со счетчиками) Contour Offset, определяющее величину шага
(промежутка) между соседними витками;

П [11] — кнопка Linear Contour Colors, задающая направление изменения цвето-
вых оттенков в цветовом круге по отрезку прямой между исходным и конеч-
ным цветами раскраски контурной линии и промежутков между ее витками;

О [12) — кнопка Clockwise Contour Colors, определяющая направление измене-
ния цветовых оттенков в цветовом круге по часовой стрелке;

П [13] — кнопка Counterclockwise Contour Colors, задающая данное направление
против часовой стрелки;

П [14] — раскрывающийся список образцов цветов Outline Color, в котором
производится выбор конечного цвета раскраски контурной линии;

О [15] — список образцов цветов Fill Color, предназначенный для выбора ко-
нечного цвета равномерной заливки промежутков между витками контурной
линии либо первого конечного цвета для градиентной заливки;

П [16] — список образцов цветов End Fountain Fill Color, используемый для вы-
бора второго конечного цвета для градиентной заливки промежутков между
витками;

О [17] — кнопка Object and Color Acceleration, открывающая дополнительную
панель управления с двумя ползунками, задающими изменение шагов между
соседними витками, а также между цветовыми оттенками, в которые они
раскрашены;
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G [18] — кнопка Copy Contour Properties, выполняющая перенос на выделен-
ный объект параметров эффекта контура из другого объекта документа;

О [19] — кнопка Clear Contour, удаляющая эффект контура из выбранного объекта.

Порядок создания эффекта
1. Создайте требуемый векторный объект и выделите его рабочим инструмен-

том Pick (Выбор).

2. Выберите рабочий инструмент Interactive Contour (Интерактивный контур).

3. Если вы хотите перенести на созданный объект параметры эффекта контура
из другого объекта документа, щелкните на кнопке [18] панели свойств, при-
дав указателю вид жирной черной стрелки. Кончик этой стрелки поместите
в область объекта-образца и щелкните кнопкой мыши. На этом выполнение
данной инструкции завершается.

4. В списке [1] панели свойств (см. рис. 4.51) выберите требуемый стиль
оформления эффекта, создав в выделенном объекте эффект контура. Если
этот эффект вас полностью устраивает, то завершите на этом выполнение
настоящей инструкции, в противном случае перейдите к следующему пункту.

5. Настройте параметры эффекта с помощью инструментов панели свойств или
управляющей конструкции интерактивного инструмента Interactive Contour
(она имеет вид двух маркеров: квадратного и ромбического, соединенных
стрелкой с ползунком). Данная конструкция позволяет регулировать сле-
дующие параметры:

• тип эффекта контура или число формируемых витков (при сохранении про-
межутков между ними) — перетаскиванием мышью квадратного маркера;

• конечный цвет обводки витков объекта — перетаскиванием мышью образца
цвета из рабочей цветовой палитры в область ромбического маркера;

• конечный цвет заливки витков — перетаскиванием образца цвета в об-
ласть квадратного маркера;

• количество витков (при сохранении их суммарной ширины) — изменени-
ем положения ползунка.

6. Чтобы зафиксировать текущие параметры эффекта для их последующего ис-
пользования, создайте новый стиль оформления эффекта контура (кнопка [2]).

7. Если вы хотите отменить созданный эффект, щелкните на кнопке [19] или
выполните команду Effects > Clear Effect (Эффекты » Удалить эффект).

Искажение
Эффект искажения состоит в следующем. Происходит искажение формы век-
торного объекта по закону, определяемому выбранным типом искажения, и
с параметрами, заданными пользователем. Предусмотрены три разновидности
эффекта искажения (типов искажения): Push and Pull (Выпуклость и вогну-
тость), Zipper (Зигзаг) и Twister (Скручивание) (см. рис. 4.52).
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Данный эффект создается интерактивным рабочим инструментом Interactive
Distortion (Интерактивное искажение) (см. разд. "Блок инструментов" гл. 2). Пара-
метры эффекта регулируются с помощью управляющей конструкции инстру-
мента и элементов управления панели свойств.

На рис. 4.52 показаны три прямоугольных объекта, для каждого из которых был
создан эффект искажения определенного типа: для левого объекта — Push and
Pull, для среднего — Zipper и для правого — Twister. Последний объект здесь
выделен и на нем находится управляющая конструкция инструмента Interactive
Distortion. Вверху изображена панель свойств с параметрами эффекта для выде-
ленного объекта. Слева вы видите открытый список со стилями оформления
эффекта искажения и визуальным индикатором для выбранного эффекта.
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Рис. 4.52. Пример создания эффекта искажения

Поясним назначение элементов управления панели свойств, доступных при ра-
боте с инструментом Interactive Distortion (их номера, приведенные на рисунке,
даны в квадратных скобках):

П [1] — раскрывающийся список Preset List, предназначенный для выбора сти-
ля оформления эффекта искажения; данный стиль представляет собой набор
параметров эффекта, сохраненный в файле под определенным именем вместе
с изображением некоторого объекта с эффектом, используемым в качестве
его визуального индикатора;

П [2] — кнопка Add Preset, создающая новый стиль оформления эффекта ис-
кажения;

О [3] — кнопка Delete Preset, удаляющая текущий стиль оформления эффек-
та, доступная для использования при отсутствии в документе выделенных
объектов;

П 14] — кнопка Push and Pull Distortion, подключающая режим создания иска-
жения типа Push and Pull;

П [5] — кнопка Zipper Distortion, задающая режим создания искажения типа
Zipper;
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О [6] — кнопка Twister Distortion, активизирующая режим создания искажения
типа Twister;

П [7] — кнопка Add New Distortion, добавляющая к искаженному объекту новое
искажение;

П [8] — элементы настройки параметров искажения конкретного выбранного
типа;

П [9] — кнопка Center Distortion, выполняющая центрирование созданного ис-
кажения путем размещения центра искажения объекта в его геометрическом
центре;

G [10] — кнопка Convert To Curve, преобразующая контур обрабатываемого
объекта в кривую Безье;

G [И] — кнопка Copy Distortion Properties, выполняющая перенос на выделен-
ный объект параметров искажений из другого объекта документа;

П [12] — кнопка Clear Distortion, удаляющая эффект искажения из выбранного
объекта.

Порядок создания эффекта
1. Создайте требуемый векторный объект и выделите его рабочим инструмен-

том Pick (Выбор).

2. Выберите рабочий инструмент Interactive Distortion (Интерактивное искаже-
ние).

3. Если вы хотите перенести на созданный объект параметры эффекта искаже-
ния из другого объекта документа, щелкните на кнопке [И] панели свойств,
придав указателю вид жирной черной стрелки. Кончик этой стрелки помес-
тите в область объекта-образца и щелкните кнопкой мыши. На этом выпол-
нение данной инструкции завершается.

4. Выберите в списке [1] панели свойств (см. рис. 4.52) требуемый стиль
оформления эффекта, создав в выделенном объекте эффект искажения.
Если этот эффект вас полностью устраивает, то завершите на этом выпол-
нение настоящей инструкции, в противном случае перейдите к следующе-
му ее шагу.

5. На панели свойств укажите тип искажения — Push and Pull, Zipper или
Twister (кнопки [4] — [6]).

6. Отрегулируйте уровень и параметры искажения с помощью маркеров управ-
ляющей конструкции интерактивного инструмента, а также тех инструментов
[8] панели свойств, которые зависят от выбранного типа эффекта.

7. Если вы хотите создать в объекте еще одно искажение, щелкните на кноп-
ке [7] и повторите предыдущий шаг инструкции.

8. Чтобы зафиксировать текущие параметры эффекта для их последующего
использования, создайте новый стиль оформления эффекта искажения
(кнопка [2]).
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9. Если вы хотите отменить созданный эффект, щелкните на кнопке [12] или
выполните команду Effects > Clear Effect (Эффекты > Удалить эффект), за-
вершив на этом выполнение данной инструкции.

10. Для последующего редактирования формы обработанного объекта рабочим
инструментом Shape (Форма), преобразуйте его контур в кривую Безье
(кнопка [10]).

Оболочка
Эффект оболочки состоит в следующем. Векторный объект (индивидуальный
или групповой) помещается в некоторую оболочку, которая подвергается опре-
деленной трансформации. Это приводит к искажению формы объекта, находя-
щегося внутри ее. Данный эффект чаше всего применяют к групповым объек-
там, а также к блокам художественного и обычного текста. В отношении
обычного текста следует заметить, что оболочка воздействует не на сам текст,
а на рамку, в которой он находится.

Рассматриваемый эффект создается интерактивным рабочим инструментом

Interactive Envelope (Интерактивная оболочка) (см. разд. "Блок инструментов"
гл. 2). Параметры эффекта регулируются с помощью управляющих маркеров
(узелков), расположенных вдоль контура оболочки и элементов управления па-
нели свойств. Альтернативным средством настройки параметров эффекта обо-
лочки является докер Envelope (Оболочка), открываемый одноименной коман-
дой подменю Dockers (Докеры) меню Window (Окно).

В отличие от панели свойств, докер Envelope (Оболочка) представляет доступ
к набору образцов стандартных форм оболочек, предусмотренных в программе.
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Рис. 4.53. Пример создания эффекта оболочки

На рис. 4.53 показаны два образца художественного текста с эффектом оболоч-
ки, отличающиеся между собой параметрами настройки. Правый объект выде-
лен и изображен вместе с контуром оболочки, содержащим восемь управляю-
щих маркеров (квадратные рамочки). Этот контур в данном случае выполняет
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функцию управляющей конструкции инструмента Interactive Envelope. Вверху
изображена панель свойств с параметрами эффекта для выделенного объекта.
Слева расположен открытый список со стилями оформления эффекта оболочки
и визуальным индикатором для выбранного эффекта.

Поясним назначение элементов управления панели свойств, доступных при ра-
боте с инструментом Interactive Envelope (их номера, приведенные на рисунке,
даны в квадратных скобках):

П [1] — раскрывающийся список Preset List, предназначенный для выбора сти-
ля оформления эффекта оболочки; данный стиль представляет собой набор
параметров эффекта, сохраненный в файле под определенным именем вместе
с изображением некоторого объекта с эффектом, используемым в качестве
его визуального индикатора;

П [2] — кнопка Add Preset, создающая новый стиль оформления эффекта обо-
лочки;

П [3] — кнопка Delete Preset, удаляющая текущий стиль оформления эффек-
та, доступная для использования при отсутствии в документе выделенных
объектов;

П [4] — кнопка Add Nodes, добавляющая к оболочке произвольной формы но-
вый узелок в месте, отмеченном щелчком мыши;

G [5] — кнопка Delete Nodes, удаляющая выделенные узелки;

П [6] — кнопка Convert Curve To Line, преобразующая криволинейный сегмент
оболочки, примыкающий слева к выделенному узелку, в прямолинейный
сегмент;

П [7] — кнопка Convert Line To Curve, преобразующая прямолинейный сегмент
оболочки, примыкающий слева к выбранному узелку, в криволинейный
сегмент;

П [8] — кнопка Make Node a Cusp, преобразующая выделенный узелок в уг-
ловой;

О [9] — кнопка Make Node Smooth, преобразующая выбранный узелок в сгла-
женный;

О [10] — кнопка Make Node Symmetrical, преобразующая данный узелок в сим-
метричный;

П [11] — кнопка Envelope Straight Line Mode, задающая оболочку с прямоли-
нейными участками;

П [12] — кнопка Envelope Single Arc Mode, выбирающая оболочку с дугообраз-
ными участками, имеющими одинарные изгибы;

О [13] — кнопка Envelope Double Arc Mode, задающая оболочку с дугообразны-
ми участками, имеющими двойные изгибы;

П [14] — кнопка Envelope Unconstrained Mode, подключающая режим формиро-
вания оболочки произвольной формы с контуром Безье, которое будет вы-
полняться с помощью мыши и кнопок управления [4] — [10];



Обработка векторных объектов 267

G [15] — кнопка Add New Envelope, добавляющая к объекту в оболочке новую
оболочку;

О [16] — список Mapping Mode, используемый для выбора одного из четырех
вариантов трансформации содержимого оболочки;

П [17] — кнопка Keep Lines, подключающая режим сохранения неизменными
прямолинейных участков контура объекта, находящегося внутри оболочки;

G [18] — кнопка Convert To Curves, преобразующая контур объекта, располо-*
женного внутри оболочки, в кривую Безье;

G [19] — кнопка Copy Envelope Properties, выполняющая перенос на выделен-
ный объект параметров эффекта оболочки из другого объекта документа;

О [20] — кнопка Create Envelope From, формирующая оболочку из другого век-
торного объекта документа с одновременной вставкой в нее обрабатываемою
объекта;

О [21] — кнопка Clear Envelope, удаляющая оболочку из выбранного объекта.

Порядок создания эффекта
1. Создайте требуемый векторный объект и выделите его рабочим инструмен-

том Pick (Выбор).

2. Выберите рабочий инструмент Interactive Envelope (Интерактивная оболоч-
ка), заключив выделенный объект в оболочку. При этом вокруг объекта поя-
вится прямоугольная пунктирная рамка красного цвета с восемью маркера-
ми. С их помощью вы можете редактировать оболочку в интерактивном
режиме, регулируя параметры искажения объекта, находящегося внутри.

3. Если вы хотите перенести на созданный объект параметры эффекта оболоч-
ки из другого объекта документа, щелкните на кнопке [19] панели свойств,
придав указателю вид жирной черной стрелки. Кончик этой стрелки помес-
тите в область объекта-образца и щелкните мышью. На этом выполнение
данной инструкции завершается.

4. Если вы собираетесь использовать образцы стандартных форм оболочек, от-
кройте докер Envelope (Оболочка), выполнив одноименную команду подме-
ню Dockers (Докеры) меню Window (Окно).

5. В списке [1] панели свойств (см. рис. 4.53) укажите требуемый стиль оформ-
ления эффекта, создав в выделенном объекте эффект оболочки. Если этот
эффект вас полностью устраивает, то завершите на этом выполнение на-
стоящей инструкции, в противном случае перейдите к следующему ее шагу.

6. Чтобы вставить обрабатываемый объект в оболочку, выбранную из библиоте-
ки образцов стандартных оболочек (кнопка Add Preset докера) или сформи-
рованную из другого векторного объекта (кнопка [20] панели свойств), по-
местите указатель на один из управляющих маркеров оболочки, нажмите
кнопку мыши и немного подвигайте маркер в ту или другую сторону, пока
форма объекта не изменится под воздействием оболочки.
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7. Выберите на панели свойств нужный вариант трансформации содержимого
оболочки (список [16]) и определитесь в отношении режима сохранения
прямолинейных участков контура обрабатываемого объекта (кнопка [17]).

8. Отрегулируйте форму оболочки, используя для этого соответствующие кнопки
панели свойств или докера Envelope, а также маркеры на контуре оболочки.

9. Чтобы поместить обрабатываемый объект еще в одну оболочку, щелкните
на кнопке [15], после чего повторите шаги 5-8 инструкции.

10. Чтобы зафиксировать текущие параметры эффекта для их последующего
использования, создайте новый стиль оформления эффекта оболочки
(кнопка [2]).

11. Если вы хотите отменить созданный эффект, щелкните на кнопке [21] или
выполните команду Effects > Clear Effect (Эффекты > Удалить эффект), за-
вершив на этом выполнение данной инструкции.

12. Для последующего редактирования формы обработанного объекта рабочим
инструментом Shape (Форма), преобразуйте его контур в кривую Безье
(кнопка [18]).

Выдавливание
Эффект выдавливания состоит в следующем. Имитируется вид в перспективе
объемного объекта, полученного в результате добавления некоторой толщины
к исходному векторному объекту документа, имеющему плоскую форму.

Данный эффект характеризуется следующими свойствами:

П объект обработки имеет всего одну точку схода, определяющую вид объем-
ного объекта в перспективе, которая отображается на экране в виде кресто-
образной метки, доступной для регулирования;

О поверхность объекта может иметь заливку любого типа (за исключением за-
ливки по сетке), узор которой остается неизменным для всех граней объекта
и может лишь смешаться для отдельной грани.

Примечание

В точке схода все прямые линии, являющиеся продолжением ребер боковых
граней объемного объекта, сходятся.

Рассматриваемый эффект создается интерактивным рабочим инструментом

Interactive Extrude (Интерактивное выдавливание) (см. разд. "Блок инструментов"
гл. 2). Параметры эффекта регулируются с помощью управляющей конструкции
инструмента и элементов управления панели свойств. В качестве альтернатив-
ного средства настройки параметров эффекта выдавливания предусмотрен докер
Extrude (Выдавливание), открываемый одноименной командой подменю Dockers
(Докеры) меню Window (Окно). Проверка показала, что данный докер не рабо-
тает (все его элементы настройки оказались заблокированными).



Обработка векторных объектов 269

На рис. 4.54 представлен образец художественного текста с эффектом выдавли-
вания. Этот объект выделен, на нем находится управляющая конструкция инст-
румента Interactive Extrude. Вверху изображена панель свойств с параметрами
эффекта для выделенного объекта. Слева находится открытый список со стиля--
ми оформления эффекта выдавливания и визуальным индикатором для выбран-
ного эффекта.

9 10 11 1213 1415

Визуальный индикатор эффекта

Рис. 4.54. Пример создания эффекта выдавливания

Поясним назначение элементов управления панели свойств, доступных при ра-
боте с инструментом Interactive Extrude (их номера, приведенные на рисунке,
даны в квадратных скобках):

П [11 — раскрывающийся список Preset List, предназначенный для выбора сти-
ля оформления эффекта выдавливания; данный стиль предстаачяет собой
набор параметров эффекта, сохраненный в файле под определенным именем
вместе с изображением некоторого объекта с эффектом, используемым в ка-
честве его визуального индикатора;

П [2] — кнопка Add Preset, создающая новый стиль оформления эффекта вы-
давливания;

П [3] — кнопка Delete Preset, удаляющая текущий стиль оформления эффекта,
доступная для использования при отсутствии в документе выделенных объек-
тов;

П [4] — два поля Object(s) Position, в которых указываются координаты геомет-
рического центра объекта;

П [5] — раскрывающийся список Extrusion Type, позволяющий выбрать одну из
шести разновидностей эффекта выдавливания, схематически представленных

в списке;

р [6] — поле (со счетчиками) Depth, определяющее глубину выдавливания;

р [7] — два поля (со счетчиками) Vanishing Point Coordinate, в которых задают-
ся координаты точки схода объекта выдавливания;
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П [8] — список Vanishing Point Properties, используемый для выбора одного из
следующих четырех режимов работы с точкой схода эффекта выдавливания:

• привязка точки схода к объекту (пункт VP Locked To Object);

• привязка данной точки к странице документа (VP Locked To Page);

• копирование точки схода из другого объекта выдавливания (Copy VP
From);

• использование общей точки схода для нескольких объектов с эффектом
выдавливания (Shared Vanishing Point);

П [9] — кнопка VP Object/VP Page, при нажатии которой задается режим ото-
бражения координат точки схода относительно начала координат текущей
страницы документа, а при отпуске — относительно геометрического центра
объекта;

О [10] - кнопка Extrude Rotation, открывающая дополнительную панель
управления для ориентации в пространстве объекта выдавливания, выпол-
няемой с помощью мыши;

П [11] — кнопка Color, открывающая панель управления для задания парамет-
ров раскраски объекта выдавливания;

О [12] -— кнопка Bevels, открывающая панель управления для выбора парамет-
ров скоса граней объекта выдавливания;

П [13] — кнопка Lighting, открывающая панель управления для настройки па-
раметров освещения объекта выдавливания дополнительными источниками
света;

О [14] — кнопка Copy Extrude Properties, выполняющая перенос на выделен-
ный объект параметров эффекта выдавливания из другого объекта документа;

О [15] — кнопка Clear Extrude, удаляющая эффект выдавливания из выбран-
ного объекта.

Порядок создания эффекта
1. Создайте требуемый векторный объект и выделите его рабочим инструмен-

том Pick (Выбор).

2. Выберите рабочий инструмент Interactive Extrude (Интерактивное выдавли-
вание).

3. Если вы хотите перенести на созданный объект параметры эффекта выдавли-
вания из другого объекта документа, щелкните на кнопке [14] панели
свойств, придав указателю вид жирной черной стрелки. Кончик этой стрелки
поместите в область объекта-образца и щелкните мышью. На этом выполне-
ние данной инструкции завершается.

4. Выберите в списке [1] панели свойств (см. рис. 4.54) требуемый стиль
оформления эффекта, создав в выделенном объекте эффект выдавливания.
В результате объект обработки приобретет объемную форму. Вокруг него
появится вспомогательный каркас в виде ребер параллелепипеда, а сверху
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расположится управляющая конструкция интерактивного инструмента
Interactive Extrude (она имеет вид пунктирной стрелки с ползунком, упи-
рающейся своим концом в точку схода, отмеченную крестиком). Если создан-
ный эффект вас полностью устраивает, то завершите на этом выполнение на-
стоящей инструкции, в противном случае перейдите к следующему ее шагу.

5. С помощью управляющей конструкции инструмента Interactive Extrude вы
можете настроить следующие параметры объекта выдавливания:

• положение точки наблюдения за объектом. Для этого поместите указатель
на крестообразную метку точки схода и переместите ее мышью (при на-
жатой ее кнопке) в другое место документа;

• толщину объекта (глубину выдавливания). Для этого отрегулируйте мы-
шью положение ползунка, расположенного на пунктирной стрелке;

• положение объекта в пространстве. Для этого щелкните на объекте мы-
шью. При этом вокруг него появится окружность в виде пунктирной ли-
нии зеленого цвета с четырьмя засечками, а указатель примет вид одной
или двух ортогональных орбит. Чтобы повернуть объект в плоскости окна
документа (или в пространстве), установите указатель на одну из засечек
(внутри окружности с засечками), нажмите кнопку мыши и переместите
его в нужном направлении, после чего отпустите кнопку мыши. Для вы-
хода из данного режима регулировки щелкните мышью.

6. Отрегулируйте другие параметры эффекта выдавливания., используя различ-
ные инструменты панели свойств.

7. Чтобы зафиксировать текущие параметры эффекта для их последующего ис-
пользования, создайте новый стиль оформления эффекта выдавливания
(кнопка [2]).

8. Если вы хотите отменить созданный эффект, щелкните на кнопке [15] или
выполните команду Effects > Clear Effect (Эффекты » Удалить эффект).

Тень
Эффект тени состоит в следующем. Имитируется тень от объекта (любого типа)
на плоской поверхности, расположенной к нему под некоторым углом, при ос-
вещении объекта источником света. Предусмотрено пять разновидностей эф-
фекта тени (типов тени), которые определяют положение плоскости, на кото-
рую объект отбрасывает тень; Flat (Сзади), Bottom (Снизу), Тор (Сверху), Left
(Слева) и Right (Справа).

Данный эффект создается интерактивным рабочим инструментом Interactive

Drop Shadow (Интерактивная тень от объекта) (см. разд. "Блок инструментов"
гл. 2). Параметры эффекта регулируются с помощью упраатяющей конструкции
инструмента и элементов управления панели свойств.

На рис. 4.55 показан пример создания эффекта тени для четырех одинако-
вых образцов художественного текста, отличающихся между собой параметрами



272 Глава 4

настройки. Правый нижний объект выделен, на нем расположена управляющая
конструкция инструмента Interactive Drop Shadow. Вверху изображена панель
свойств с параметрами эффекта тени для выделенного объекта. Слева вы видите
открытый список со стилями оформления эффекта и визуальным индикатором
для выбранного эффекта.

г з 1314

Визуальный индикатор эффекта

Рис. 4.55. Пример создания эффекта тени

Поясним назначение элементов управления панели свойств, доступных при ра-
боте с инструментом Interactive Drop Shadow (их номера, приведенные на ри-
сунке, даны в квадратных скобках):

П [1] — раскрывающийся список Preset List, предназначенный для выбора сти-
ля оформления эффекта тени; данный стиль представляет собой набор пара-
метров эффекта, сохраненный в файле под определенным именем вместе
с изображением некоторого объекта с эффектом, используемым в качестве
его визуального индикатора;

О [2] — кнопка Add Preset, создающая новый стиль оформления эффекта тени;

П [3] — кнопка Delete Preset, удаляющая текущий стиль оформления эффекта,
доступная для использования при отсутствии в документе выделенных объектов;

П [4] — два поля Drop Shadow Offset, в которых указываются координаты гео-
метрического центра тени по отношению к центру объекта (недоступны для
эффекта тени, тип которой отличен от Flat);

[5] — ползунок Drop Shadow Angle, регулирующий угол наклона изображения
тени относительно объекта (недоступен для эффекта тени типа Flat);

[6] — ползунок Drop Shadow Opacity, задающий уровень непрозрачности
данного изображения;

[7] — ползунок Drop Shadow Feathering, определяющий уровень размытия
краев тени;

[8] — кнопка Drop Shadow Feathering Direction, открывающая дополнитель-
ную панель управления для выбора одного из четырех возможных направле-
ний размытия краев тени;

О
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О [9] — кнопка Drop Shadow Feathering Edges, открывающая панель управления
для выбора одного из четырех вариантов формы размытых краев тени;

П [10] — ползунок Drop Shadow Fade, регулирующий уровень прозрачности
изображения тени в области, удаленной от объекта (недоступен для эффекта
тени типа Flat);

П [11] — ползунок Drop Shadow Stretch, определяющий коэффициент удлине-
ния тени (недоступен для эффекта тени типа Flat);

D [12] — раскрывающийся список цветовых образцов Drop Shadow Color, ис-
пользуемый для выбора цвета тени;

О [13] — кнопка Copy Drop Shadow Properties, выполняющая перенос на выде-
ленный объект параметров тени из другого объекта документа;

П [14] — кнопка Clear Drop Shadow, удаляющая эффект тени из выбранного
объекта.

Порядок создания эффекта
1. Создайте требуемый объект (он может быть любого типа) и выделите его ра-

бочим инструментом Pick (Выбор).

2. Выберите рабочий инструмент Interactive Drop Shadow (Интерактивная тень
от объекта).

3. Если вы хотите перенести на созданный объект параметры эффекта тени из
другого объекта документа, щелкните на кнопке [13] панели свойств, придав
указателю вид жирной черной стрелки. Кончик этой стрелки поместите в об-
ласть объекта-образца и щелкните кнопкой мыши. На этом выполнение дан-
ной инструкции завершается.

4. В списке [1] панели свойств (см. рис. 4.55) укажите требуемый стиль оформле-
ния эффекта, создав в выделенном объекте эффект тени. При этом на экране
появится управляющая конструкция интерактивного инструмента (два квад-
ратных маркера, между которыми расположена стрелка с ползунком). Если
созданный эффект вас полностью устраивает, завершите на этом выполнение
настоящей инструкции, в противном случае перейдите к следующему ее шагу.

5. С помощью управляющей конструкции инструмента Interactive Drop Shadow
вы можете настроить следующие параметры объекта с тенью:

• тип тени, расположив мышью белый маркер, находящийся в области ис-
ходного объекта, вдоль одной из его сторон или в центре;

• цвет области заливки или обводки объекта, выбрав образец цвета в рабо-
чей цветовой палитре и переместив его мышью во внутреннюю область
объекта или на его контур;

• положение тени относительно объекта, перетащив мышью маркер, на ко-
торый указывает стрелка ползунка;

• цвет тени, поместив в область данного маркера цветовой образец, вы-
бранный в цветовой палитре;
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• плотность (уровень непрозрачности) тени, отрегулировав положение пол-
зунка мышью.

6. Задайте другие параметры тени, используя различные инструменты панели
свойств. При выборе типа тени некоторые инструменты не будут доступны-
ми для использования (в частности, для типа Flat (Сзади) не используются
ползунки [5], [10] и [11], а для остальных типов тени — поля [4]).

7. Чтобы зафиксировать текущие параметры эффекта для их последующего
использования, создайте новый стиль оформления эффекта тени (кноп-
ка [2]).

8. Если вы хотите отменить созданный эффект, щелкните на кнопке [14] или
выполните команду Effects > Clear Effect (Эффекты > Удалить эффект).

Линза
Эффект линзы состоит в следующем. На фоновый объект произвольного типа
накладывается векторный объект (с замкнутым или разомкнутым контуром), вы-
полняющий функцию линзы. В области объекта-линзы выполняется обработка
фонового объекта, определяемая выбранной разновидностью данного эффекта
(типом линзы), а также заданными ее параметрами. Предусмотрено 11 типов линз.

Рассматриваемый эффект создается с помощью докера Lens (Линза), открывае-
мого командой Effects > Lens (Эффекты > Линза).

На рис, 4.56 показан пример создания эффекта линзы типа Magnify (Увеличе-
ние) в области растрового изображения, имеющей круглую форму. Справа изо-
бражен докер Lens.

Magnify

Amount:

\ Frozen

I Viewpoint

Рис. 4.56. Пример создания эффекта линзы
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Порядок создания эффекта
1. Создайте в документе или импортируйте в него объект произвольного типа,

отобразив его в нужном масштабе.

2. Сформируйте векторный объект требуемой формы, который будет использо-
ван в качестве линзы.

3. Расположите второй созданный объект поверх первого (в месте обработки) и
выделите его рабочим инструментом Pick (Выбор).

4. Откройте докер Lens (Линза) (см. рис. 4.56), выполнив команду Effects > Lens
(Эффекты > Линза).

5. Откройте список вверху докера и выберите в нем нужный тип линзы. В этом
списке представлены следующие 12 вариантов выбора, определяющие харак-
тер обработки фонового объекта в области линзы:

• No Lens Effect (Эффект линзы отсутствует);

• Brighten (Повышение яркости);

• Color Add (Добавление цвета);

• Color Limit (Цветовое ограничение);

• Custom Color Map (Заданная цветовая обработка);

• Fish Eye (Рыбий глаз);

• Heat Map (Тепловая карта);

• Invert (Негатив);

• Magnify (Увеличение);

• Tinted Grayscale (Оттенки выбранного цвета);

• Transparency (Прозрачность);

• Wireframe (Каркас).

6. Настройте параметры создаваемого эффекта с помощью элементов управле-
ния докера Lens, являющихся уникальными для выбранного типа линзы.
Свои действия контролируйте по виду результирующего изображения, нахо-
дящегося в окне просмотра докера.

1. Определитесь в отношении трех параметров, не зависящих от разновидности
эффекта линзы:

• режима фиксации изображения, находящегося в области линзы; при ко-
тором происходит его перемещение и трансформация вместе с линзой
(при установленном флажке Frozen (Заморозить));

• режима смещения точки наблюдения сквозь линзу за фоновым объектом,
расположенным на некотором расстоянии от нее, относительно ее гео-
метрического центра (при установленном флажке Viewpoint (Точка на-
блюдения)), а также величины этого смещения (кнопка Edit (Правка) и
маркер в виде перекрестия);
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• режима отсутствия эффекта линзы в тех ее участках, в которых нет фоно-
вого объекта (при установленном флажке Remove Face (Удалить в пустой
области)).

8. Щелкните в докере Lens на кнопке подтверждения Apply (Применить).

Перспектива
Эффект перспективы состоит в следующем. Имитируется вид плоского вектор-
ного объекта, который определенным образом повернули в пространстве и на-
блюдают с некоторой точки. С помощью четырех маркеров, расположенных на
вершинах выделяющей области четырехугольной формы (в исходном состоя-
нии — прямоугольной), а также двух крестообразных меток точек схода выпол-
няется регулировка параметров данного эффекта.

Примечание

Точкой схода для эффекта перспективы называется такая точка на текущей
странице документа, к которой сходятся прямые линии, являющиеся продол-
жением противоположных сторон четырехугольной рамки, охватывающей объ-
ект с данным эффектом.

Рассматриваемый эффект создается с помощью команды Add Perspective (Доба-
вить перспективу) меню Effects (Эффекты).

На рис. 4.57 показан пример создания эффекта перспективы для объекта,
имеющего форму спирали. Слева изображен исходный объект, а справа — обра-
батываемый после выполнения указанной команды в момент перемещения мы-
шью метки точки схода, находящейся справа.

Рис. 4.57. Пример создания эффекта перспективы
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Порядок создания эффекта
1. Создайте требуемый векторный объект и выделите его рабочим инструмен-

том Pick (Выбор).

2. Выполните команду Effects > Add Perspective (Эффекты > Добавить перспек-
тиву). При этом произойдет выбор рабочего инструмента Shape (Форма),
а сам объект покроется сеткой прямоугольной формы с четырьмя маркерами
в ее вершинах, состоящей из пунктирных линий красного цвета.

3. Отрегулируйте в интерактивном режиме параметры эффекта перспективы
путем перетаскивания мышью этих маркеров, а также крестообразных меток
двух точек схода, если они видны на экране (входят в область обработки ра-
бочего окна документа).

4. Чтобы выйти из режима создания эффекта перспективы, выберите любой
другой рабочий инструмент.

5. Если вы хотите повторно обработать объект, содержащий эффект перспекти-
вы, выделите его инструментом Pick, после чего выберите инструмент Shape.
В результате произойдет переход в режим настройки параметров объекта,
а сам объект покроется красной пунктирной сеткой. Выполните регулировку
мышью маркеров и меток точек.

6. Для отмены эффекта перспективы, имеющегося в выбранном объекте, следу-
ет выполнить команду Effects > Clear Effect (Эффекты > Удалить эффект).

PowerClip
Эффект PowerClip состоит в следующем. Объект произвольного типа помешает-
ся в область расположения векторного объекта (с замкнутым или разомкнутым
контуром), исполняющего роль контейнера. В результате первый объект стано-
вится видимым лишь во внутренней области второго объекта.

Данный эффект создается с помощью команды Place Inside Container (Помес-
тить внутрь контейнера), входящей в подменю PowerClip меню Effects (Эф-
фекты).

На рис. 4.58 показан пример создания эффекта PowerClip. Контейнером служит
образец художественного текста (слева вверху). В него помещается импортиро-
ванное в документ растровое изображение (слева внизу). Результат обработки
представлен на рисунке справа.

Порядок создания эффекта
1. Создайте и отобразите на экране векторный объект, который будет исполъ-

зован качестве контейнера.

1. Создайте или импортируйте в документ фоновый объект (он может быть лю-
бого типа), который будет вставляться в контейнер.

3. Расположите второй объект в свободном месте документа и выделите его ра-
бочим инструментом Pick (Выбор).
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Рис. 4.58. Пример создания эффекта PowerClip

4. Выполните команду Place Inside Container (Поместить внутрь контейнера),
входящую в подменю PowerClip меню Effects (Эффекты). При этом указатель
примет вид жирной стрелки, кончик которой поместите в область объекта-
контейнера и щелкните мышью. В результате фоновый объект переместится
внутрь объекта-контейнера и отобразится в его внутренней области. При
этом геометрические центры этих объектов совместятся.

5. Чтобы трансформировать фоновый объект или изменить его положение от-
носительно контейнера, выполните команду Edit Contents (Редактировать со-
держимое) подменю PowerClip. При этом на экране отобразятся фоновый
объект и контур объекта-контейнера. С помощью мыши и выделяющих мар-
керов вы можете переместить фоновый объект или трансформировать его.
Для выхода из режима редактирования выполните команду Finish Editing This
Level (Завершить редактирование этого уровня) того же подменю.

6. Для отмены эффекта PowerClip, имеющегося в выбранном объекте, выполните
команду Extract Contents (Извлечь содержимое) подменю PowerClip. В результате
оба объекта отделятся друг от друга и полностью отобразятся на экране.

Создание образцов и шаблонов
В этом разделе рассматриваются операции создания в CorelDRAW 12 различных
элементов оформления, к числу которых относятся:

О контурные образцы, представляющие собой стили оформления линий, нако-
нечники стрелок и текстовые символы;

П двухцветные и многоцветные шаблоны для заливки;

О образцы изображений, используемые для наложения на контуры векторных
объектов, а также для распыления вдоль них.
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Контурные образцы
Контурным образцом будем называть такой векторный объект, атрибуты заливки
и обводки которого не используются при формировании на его основе других
объектов. Рассмотрим порядок создания и обработки различных контурных об-
разцов (стилей оформления линий, наконечников стрелок и текстовых символов)

Обработка стиля оформления линии
1. Выделите произвольный векторный объект рабочим инструментом Pick

(Выбор).

2. Щелчком на кнопке рабочего инструмента Outline (Контур) откройте его до-
полнительную панель, где щелкните на кнопке Outline Pen Dialog (первая
слева), открыв диалоговое окно Outline Pen (Контурное перо) (см. рис. 4.43).

3. Откройте список Style, содержащий стили оформления линий, и выберите
тот стиль, который будет использован в качестве образца.

4. Щелчком на кнопке Edit Style (Редактировать стиль), расположенной под спи-
ском, откройте диалоговое окно Edit Line Style (Редактировать стиль линий).

5. Отредактируйте в этом окне выбранный стиль. Для этого задайте длину по-
вторяющегося участка линии, переместив ползунок в нужное место на ли-
нейной диаграмме. С помощью последовательных щелчков мыши выделите
на данном участке черным цветом те точки или штрихи, которые будут рас-
крашены в документе. Свои действия можете контролировать в окне про-
смотра, расположенном внизу справа.

6. Для формирования нового стиля щелкните на кнопке Add (Добавить), а для
замены текущего стиля сделайте щелчок на кнопке Replace (Заменить).

7. Закройте окно Outline Pen щелчком на кнопке подтверждения ОК.

Обработка наконечника стрелки
1. Выделите произвольный векторный объект рабочим инструментом Pick (Вы-

бор).

2. Откройте диалоговое окно Outline Pen (Контурное перо) рабочего инстру-
мента Outline (Контур).

3. Откройте один из двух списков с наконечниками, находящихся в правом
верхнем углу окна, и выберите в нем образец для обработки.

4. Щелчком на кнопке Options (Параметры), находящейся под данным спи-
ском, откройте контекстное меню и выберите команду New (Новый), если
будете создавать новый наконечник, или команду Edit (Правка) для редакти-
рования выбранного наконечника. В любом случае откроется диалоговое
окно Edit Arrowhead (Редактировать наконечник стрелки), предназначенное
для обработки текущего наконечника.

5. Отредактируйте данный наконечник путем его перемещения и масштабиро-
вания мышью с помощью маркеров (в форме черных и белых квадратиков},
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а также посредством зеркальных разворотов наконечника и его центровки
относительно осей координат. С помощью кнопок управления и одного
флажка диалогового окна можно выполнять следующие операции:

• разворачивать наконечник по горизонтали (кнопка Reflect in X) и верти-
кали (кнопка Reflect in Y);

• выполнять его центровку по горизонтали (кнопка Center in X) и вертика-
ли (кнопка Center in Y);

• увеличивать в четыре раза масштаб отображения наконечника в рабочем
окне диалогового окна (флажок 4Х zoom).

6. Чтобы ввести сформированный наконечник в список наконечников, щелк-
ните на кнопке ОК.

7. Закройте окно Outline Pen щелчком на кнопке подтверждения ОК.

Создание наконечника стрелки из объекта документа
1. Создайте в документе контурный векторный объект, из которого будет

сформирован наконечник. Если наконечник должен состоять из нескольких
контуров, то объедините их командой Arrange > Combine (Располо-
жить > Скомбинировать).

2. Выделите данный объект рабочим инструментом Pick (Выбор).

3. Выполните команду Tools > Create v Arrow (Инструменты > Создать > Стрелка).
При этом на экране откроется панель с предупреждающим сообщением
о формировании наконечника стрелки из выделенного объекта, которую сле-
дует закрыть щелчком на кнопке ОК.

Создание нового текстового символа
1. Создайте векторный объект с одним или несколькими замкнутыми контура-

ми, из которого будет сформирован текстовый символ. Если символ должен
состоять из нескольких контуров, то объедините их командой
Arrange > Combine (Расположить > Скомбинировать).

2. Выделите данный объект рабочим инструментом Pick (Выбор).

3. Выполните команду Tools > Create V Character (Инструменты * Создать * Символ).
При этом на экране откроется диалоговое окно Insert Character (Вставить
символ) со списком всех текстовых штифтов, доступных для использования
в CorelDRAW 12.

4. Выполните одно из двух действий:

• выберите в этом списке название нужного шрифта, в файл которого будет
выводиться новый символ;

• сформируйте новый файл шрифта, введя с клавиатуры его название в по-
ле, расположенное над списком.

5. Закройте окно Create Symbol щелчком на кнопке подтверждения ОК.



Обработка векторных объектов _ 281

Шаблоны для заливки
Рассмотрим порядок создания двухцветного или многоцветного шаблона.

1. Сформируйте в документе некоторое изображение из объектов произвольных
типов, расположив их в той прямоугольной области документа, которая будет
использована в качестве шаблона.

2. Выполните команду Tools > Create > Pattern (Инструменты ^ Создать > Шаблон),
открыв ее диалоговое окно Create Pattern (Создать шаблон).

3. Чтобы сформировать двухцветный шаблон, выберите переключатель Two
color и задайте нужный уровень разрешения изображения шаблона: низкий
(переключатель Low), средний (Medium) или высокий (High).

4. Для формирования многоцветного шаблона выберите переключатель Full color.

5. Закройте окно Create Pattern, щелкнув на кнопке ОК. При этом указатель при-
мет вид двух ортогональных прямых. Поместите указатель в исходную точку
прямоугольной области документа, содержащей изображение шаблона, нажмите
кнопку мыши и выделите эту область, после чего отпустите кнопку мыши.
На экране появится панель с предупреждающим сообщением о формировании
шаблона из выделенной области, которую следует закрыть щелчком на кнопке
ОК. Если вы формируете многоцветный шаблон (выбран переключатель Full
color), то откроется диалоговое окно Save Vector Pattern (Сохранить векторный
шаблон), в котором следует ввести имя файла шаблона, имеющего векторный
формат PAT, затем щелкнуть на кнопке подтверждения Save (Сохранить).

Все многоцветные векторные шаблоны, формируемые в процессе установки
CorelDRAW 12, хранятся в папке CustomVPatterns. Шаблон данного типа, фор-
мируемый пользователем, также следует помещать в эту же папку. Только
в этом случае к нему будет обеспечен доступ через панель свойств при работе
с рабочим инструментом Interactive Fill (Интерактивная заливка).

Образцы изображений
Опишем порядок создания образцов изображений, используемых для наложения
на контуры векторных объектов документа, а также наборов образцов для их рас-
пыления вдоль контуров. Напомним, что операции наложения и распыления вы-
полняются инструментами Brush (Художественная кисть) и Sprayer (Распылитель),

входящими в состав рабочего инструмента Artistic Media (Комплект художни-

ка) (см. разд. "Наложение и распыление изображений" настоящей главы).

Создание образца изображения для наложения
1. Создайте в документе векторное изображение, которое будет использовано

в качестве нового образца для наложения.

2. Выделите это изображение рабочим инструментом Pick (Выбор).
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3. Чтобы сформировать образец изображения для наложения без использования
докера Artistic Media (Комплект художника), выполните следующее. Выбери-
те рабочий инструмент Artistic Media > Brush (Комплект художника >
Художественная кисть) и щелкните на кнопке Save Artistic Media stroke панели
свойств (вторая справа). В открывшемся диалоговом окне Сохранение задайте
имя файла изображения (с расширением стх), выберите для него папку (по
умолчанию здесь используется папка CustomMediaStrokes) и сделайте щелчок
на кнопке Сохранить. В результате этот образец изображения будет представ-
лен в списке Brush Stroke List новой строкой, содержащей его миниатюру.

4. Для создания образца изображения для наложения с помощью докера Artistic
Media сделайте следующее. Откройте данный докер и щелкните внизу него
на кнопке Save (Сохранить), отобразив на экране диалоговое окно Create
a new stroke (Создать новый штрих). Выберите в этом окне переключатель
Brushes (Кисти) и щелкните на кнопке ОК. При этом откроется диалоговое

. окно Сохранение, в котором задайте имя файла изображения, выберите пап-
ку и сделайте щелчок на кнопке Сохранить.

Создание набора образцов изображений для распыления

1. Создайте в документе и отобразите на экране группу векторных изображе-
ний, которые будут использованы в качестве нового набора образцов для
распыления.

2. Выберите инструмент Artistic Media > Sprayer (Комплект художника *
Распылитель).

3. Откройте на панели свойств список Spraylist File List с наборами образцов
изображений для распыления и выберите в нем пункт New Spraylist (Новый
список образцов).

4. Сформируйте новый набор образцов изображений для распыления, последо-
вательно выделяя в документе созданные ранее изображения и щелкая на
кнопке Add to Spraylist (Добавить в список образцов). В результате этот на-
бор будет представлен в списке Spraylist File List новой строкой, содержащей
миниатюры его изображений.

5. Если вы хотите сохранить созданный набор образцов для распыления в фай-
ле, щелкните на кнопке Save Artistic Media stroke (если она будет доступна),
которая расположена справа от списка Spraylist File List. В открывшемся
диалоговом окне Сохранение укажите имя файла (с расширением cdr), выбе-
рите для него папку (по умолчанию здесь используется та же папка
CustomMediaStrokes, что и для хранения образцов для наложения) и щелкни-
те на кнопке подтверждения Сохранить.

^—-—— " —™—х^
Примечание

Докер Artistic Media (Комплект художника) не рекомендуется использовать для
формирования образцов изображений для распыления, поскольку с его помощью
можно сохранить в файле всего лишь один такой образец, а не набор образцов.
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Обработка
растровых изображений
Программа CorelDRAW 12 обладает очень широкими возможностями обработки
растровых изображений. Перечислим ее функции в данной области:

П импорт, сканирование и экспорт изображений;

П преобразование объектов любых типов в растровые;

П перемещение и трансформация изображения;

П изменение размеров и разрешения изображения;

О наращивание растровой подложки изображения;

П формирование текстовой оборки;

О разрезка изображения на отдельные части;

О тоновая и цветовая коррекция изображения;

П создание художественных и корректирующих эффектов;

П регулировка прозрачности;

О преобразование цветовых форматов;

П работа с цветовыми профилями;

СЗ вставка в документ изображения через связь с его файлом;

G кадрирование и обрезка изображения;

О вставка изображения в векторный объект, выполняющий функцию контей-
нера (см. разд. "Создание эффектов"гл. 4, подразд. "PowerCIip");

П обработка растрового изображения другими графическими программами.

Чтобы объективно оценить указанные возможности CorelDRAW 12, отметим
функции обработки растровых изображений, которые в этой программе отсутст-
вуют, но имеются в других графических и издательских программах (они указа-
ны в скобках):

П трассировка изображения непосредственно в программе (FreeHand),
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О вставка изображения из файла в документ на место другого изображения
с сохранением его параметров трансформации (QuarkXPress);

П создание новых изображений, а также обработка выделенных частей сущест-
вующих изображений (эти функции свойственны лишь программам растро-
вой графики).

Для работы с растровыми изображениями используются следующие средства
CorelDRAW 12:

П четыре команды меню File (Файл):

• Import (Импорт) и Export (Экспорт) — импорт и экспорт растровых изо-
бражений;

• Select Source (Подключить источник) и Acquire (Получить), входящие
в подменю Acquire Image (Получить изображение), — сканирование изо-
бражений;

П команды меню Bitmaps (Растровая графика);

О рабочие инструменты:

Pick (Выбор) — выделение и трансформация изображения;

Shape (Форма) — обработка обтравочного контура;

Knife (Нож) — разрезка изображения на части;

Eraser (Ластик) — формирование прозрачных участков в изображении;

Free Transform (Произвольная трансформация) — трансформация

изображения;

Interactive Transparency (Интерактивная прозрачность) — регулировка

прозрачности изображения;

П панель свойств — настройка параметров выполняемых операций;

О докер Bitmap Color Mask (Растровая цветовая маска) — наложение на изо-
бражение цветовой маски;

П докер Transformation (Трансформация) — трансформация изображения.

При выделении изображения инструментом Pick на панели свойств отобража-
ются инструменты, с помощью которых можно выполнить наиболее распро-
страненные операции обработки изображения (рис. 5.1).

1 2 3 4 5 6 7 8 9 1 0 1 1 1 2
т

и: 1Ш54тт ̂  27.347 mm i ШС' % m'\ о тГ n
y:'16U44nun • $'Т7.Э4Эгпт I '

Рис. 5.1. Панель свойств при выделении растрового изображения
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Поясним назначение элементов управления панели свойств в режиме обработки
растрового изображения (их номера, приведенные на рисунке, указаны в квад-
ратных скобках):

О [1] — два поля Object(s) Position, используемые для задания координат гео-
метрического центра изображения;

П [2] — два поля Object(s) Size, предназначенные для задания размеров изо-
бражения;

О [3] — два поля Scale Factor, в которых указываются коэффициенты масшта
бирования изображения по горизонтали и вертикали;

О [4| — кнопка Nonproportional Scaling/Sizing Ratio, задающая режим непро
порционального масштабирования;

О [5] — поле Angle of Rotation, в котором указывается угол поворота изображения;

П [6] — две кнопки Mirror Buttons, предназначенные для зеркального разворо-
та изображения по горизонтали и вертикали;

П [7] — кнопка Edit Bitmap, загружающая изображение в программу растровой
графики Corel PHOTO-PAINT 12 для его обработки;

О |8] — кнопка Crop Bitmap, вызывающая команду Crop Bitmap (Обрезать
растр) меню Bitmaps (Растровая графика) для обрезки растровой подложки
изображения;

О [9] - кнопка Trace Bitmap, загружающая изображение в программу
CorelTRACE 12 для его трассировки;

О [10] — кнопка Re samples the Bitmap, вызывающая команду Resample (Изме-
нить параметры изображения) меню Bitmaps (Растровая графика) для задания
новых размеров и разрешения изображения;

О [11] — кнопка Bitmap Color Mask Docker Window, открывающая докер Bitmap
Color Mask (Растровая цветовая маска) для наложения цветовой маски на
изображение;

О [ 1 2 ] — кнопка Wrap Paragraph Text, открывающая дополнительную панель
с параметрами настройки текстовой оборки вокруг изображения.

Общие операции
К числу общих операций обработки растровых изображений отнесем следующие:

О растрирование, представляющее собой преобразование любых выбранных
объектов документа в растровое изображение;

О трансформация изображения (масштабирование, поворот, наклон и зеркаль-
ные развороты);

О изменение размеров и разрешения изображения;

П увеличение размеров растровой подложки;

СП обработка обтравочного контура изображения (встроенного или наложенного);
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П разрезка изображения на отдельные части;

П обрезка изображения;

D изменение связи, установленной с файлом изображения;

П применение к изображению цветового профиля;

CJ обработка изображения другими программами.

Операции перемещения в документе любых объектов, в том числе и растровых
изображений, рассматриваются в разд. "Перемещение объектов"гл. 7.

Растрирование
В CorelDRAW 12 растрированием называется операция преобразования одного
или нескольких выбранных объектов документа в их растровое изображение.
В программе допускается Растрировать объекты следующих типов: векторные,
растровые (внедренные в тело документа), текстовые и OLE-объекты.

Потребность в операции растрирования может возникнуть у вас в следующих
случаях:

П для создания художественного эффекта, свойственного лишь растровому
изображению;

О для настройки параметров изображения перед его сохранением в файле рас-
трового формата;

П для уменьшения количества растровых файлов, которые будут использовать-
ся в электронном документе HTML-формата;

П для сохранения атрибутов форматирования текстовой информации при фор-
мировании электронного докуменга.

Чтобы сформировать растровое изображение из некоторых объектов документа, дос-
таточно эти объекты выделить и выполнить команду Convert to Bitmap (Преобразо-
вать в растр) меню Bitmaps (Растровая графика), настроив параметры команды
в открывшемся диалоговом окне (рис. 5.2). В результате сформируется растровая
подложка прямоугольной формы (белая или прозрачная), содержащая изображение
исходных объектов и имеющая те же размеры, что и область охвата этих объектов.

Т. |Р1Ж'

Conveit to Bitmap

Color: ; RGB Color (24-Ы(1

Resolution: 1300dpi

"•/ Anti-aliasing

V Transparent Background

p" Apply ICC Profile

Projected uncompressed fiie size: 101 178 bytes

Рис. 5.2. Диалоговое окно команды Convert to Bitmap
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Порядок работы
1. Выделите рабочим инструментом Pick (Выбор) группу объектов, которые не-

обходимо преобразовать в растровое изображение.

2. Выполните команду Bitmaps > Convert to Bitmap (Растровая графика >
Преобразовать в растр), открыв диалоговое окно Convert to Bitmap (Преобра-
зовать в растр).

3. Выберите в списке Color (Цвет) цветовой формат будущего растрового изо-
бражения из следующих возможных вариантов:

• Black and White (1-bit) — черно-белый формат;

• 16 Colors (4-bit) — формат палитровых цветов (4 бит);

• Grayscale (8-bit) — формат оттенков серого;

• Paletted (8-bit) — формат палитровых цветов (8 бит);

• RGB Color (24-bit) - формат RGB;

• CMYK Color (32-bit) - формат CMYK.

4. Задайте в списке с редактируемым полем Resolution (Разрешение) разреше-
ние растровой подложки, на которой будет сформировано изображение.

5. Подключите требуемые режимы формирования растрового изображения, ус-
тановив соответствующие флажки из следующего их набора:

• Anti-aliasing — сглаживание краевых пикселов;

• Dithered — передача цветовых оттенков;

• Transparent Background — формирование прозрачной подложки;

• Apply ICC Profile — использование цветового профиля для цветоделения,
заданного в программе.

6. Щелкните на кнопке ОК.

Трансформация
Трансформация растрового изображения представляет собой изменение формы
или ориентации в документе растровой подложки, на которой это изображение
находится. В отличие от векторного объекта, форма которого может изменяться
произвольным образом путем регулировки его контура инструментом Shape
(Форма), в растровом изображении такая возможность отсутствует. Для него
можно выполнять лишь следующие операции трансформации:

П масштабирование (изменение размеров) изображения, находящегося в доку-
менте или в процессе его импорта;

О поворот изображения относительно центра вращения, положение которого
регулируется;

П наклон изображения, вызванный наклоном противоположных краев растро-
вой подложки;

П зеркальные развороты изображения по горизонтали и вертикали.



288 Глава 5

Все эти операции применимы к любым растровым изображениям, как внедрен-
ным в документ, так и связанным с ним. Для их выполнения используются сле-
дующие средства CorelDRAW 12:

рабочие инструменты Pick (Выбор) и $Ь, Free Transform (Произвольная

трансформация) с возможным использованием панели свойств;

П докер Transformation (Трансформация), открываемый любой командой под-
меню Transformations (Трансформации) меню Arrange (Расположить).

Опишем операции трансформации растрового объекта с помощью инструмента
Pick. Работа с инструментом Free Transform и докером Transformation рассмот-
рена в разд. "Трансформация объектов" гл. 4 применительно к векторным объек-
там (для растровых изображений порядок работы будет тем же).

Масштабирование изображения,
находящегося в документе
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Для пропорционального масштабирования изображения выберите один из двух
вариантов действий:

• поместите указатель на одном из угловых выделяющих маркеров изобра-
жения, нажмите кнопку мыши и перетащите маркер по диагонали в на-
правлении к противоположному маркеру (при уменьшении размеров изо-
бражения) либо от него (при увеличении его размеров); для выполнения
симметричного масштабирования изображения относительно его геомет-
рического центра необходимо перемещать указанный маркер при нажатой
клавише <Shift>;

• отключите на панели свойств режим непропорционального масштабиро-
вания (кнопка Nonproportional Scaling/Sizing Ratio), задайте там один из
размеров объекта (два поля Objcct(s) Size) либо его масштаб по горизон-
тали, либо по вертикали (два поля Scale Factor), затем нажмите клавишу
Enter (положение центра изображения останется при этом неизменным).

3. Для непропорционального масштабирования выполните один из двух вариан-
тов действий:

• поместите указатель на одном из боковых маркеров изображения, нажми-
те кнопку мыши и перетащите маркер по горизонтали или вертикали
в направлении к противоположному маркеру (при уменьшении размеров
изображения) либо от него (при увеличении размеров); для выполнения
симметричного масштабирования необходимо перемещать маркер при
нажатой клавише <Shift>;

• задайте на панели свойств режим непропорционального масштабирования
(Nonproportional Scaling/Sizing Ratio), выберите новые размеры объекта
(Object(s) Size) либо его масштабы (Scale Factor), после чего нажмите
клавишу Enter (положение центра изображения останется при этом неиз-
менным).
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На рис. 5.3 показан пример непропорционального симметричного масштабирова-
ния растрового изображения путем регулировки его бокового маркера инструмен-
том Pick при нажатой клавише <Shift>. Здесь представлены три фазы
выполнения данной операции: начальная (слева), промежуточная (в центре) и ко-
нечная (справа). Обратите внимание, что в процессе масштабирования изображе-
ния на экране отображается прямоугольник серого цвета, который характеризует
будущие размеры изображения, если в данный момент отпустить кнопку мыши.

Рис. 5.3. Пример масштабирования растрового изображения

Масштабирование импортируемого изображения
1. Выполните команду File > Import (Файл > Импорт), открыв ее диалоговое окно

2. Настройте необходимые параметры импорта растрового изображения и
щелкните на кнопке Import (Импорт). В результате будет выбран рабочий
инструмент Pick, а указатель примет форму уголка с названием импортируе-
мого файла.

3. Для пропорционального масштабирования импортируемого изображения
поместите указатель (вершину его уголка) в исходную точку документа, на-
жмите кнопку мыши и перетащите указатель по диагонали в конечную точ-
ку, после чего отпустите кнопку мыши.

4. Для непропорционального масштабирования поместите указатель в исходную
точку документа, нажмите кнопку мыши, нажмите клавишу <АИ> и перета-
щите указатель по диагонали в конечную точку, отпустив затем кнопку мы-
ши и клавишу.

Поворот изображения
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

1. Для поворота изображения относительно его геометрического центра выбе-
рите один из двух вариантов действий:

• задайте на панели свойств угол поворота выбранного объекта против ча-
совой стрелки (поле Angle of Rotation) и нажмите клавишу Enter;

ЮЗак. 250
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• щелкните в области изображения, переведя его в режим поворота и на-
клона (выделяющие маркеры примут вид двунаправленных стрелок), по-
местите указатель на одном из угловых маркеров, нажмите кнопку мыши
и поверните объект на некоторый угол, после чего кнопку отпустите.

3. Для поворота изображения относительно произвольной точки области доку-
мента сделайте следующее. Щелкните на изображении, переведя его в режим
поворота и наклона, и переместите мышью метку центра вращения, находя-
щуюся в центре изображения, в нужное место документа. Выполните одно из
двух действий:

• задайте на панели свойств угол поворота изображения (поле Angle of
Rotation) и нажмите клавишу Enter;

• установите указатель на одном из угловых маркеров, нажмите кнопку
мыши и поверните изображение на требуемый угол.

На рис. 5.4 показан пример поворота инструментом Pick растрового изображе-
ния относительно его центра и представлены три фазы выполнения данной
операции: начальная (слева), промежуточная (в центре) и конечная (справа).
Обратите внимание, что в процессе поворота объекта на экране отображается
прямоугольник серого цвета, который характеризует будущее положение изо-
бражения в документе, если в данный момент отпустить кнопку мыши.

Рис. 5.4. Пример поворота растрового изображения

Наклон изображения
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Щелкните на изображении еще раз, переведя его в режим поворота и накло-
на (маркеры примут вид двунаправленных стрелок).

3. Чтобы наклонить вертикальные (горизонтальные) края прямоугольной об-
ласти изображения, установите указатель на одном из боковых маркеров,
расположенных вдоль горизонтальных (вертикальных) краев изображения,
нажмите кнопку мыши и перетащите маркер на некоторое расстояние aieso



Обработка растровых изображений 291

или вправо (вверх или вниз), после чего отпустите кнопку мыши. Если вы
хотите выполнить симметричный наклон изображения относительно его гео-
метрического центра, необходимо перемещать указанный маркер при нажа-
той клавише <Alt>.

На рис. 5,5 показан пример наклона растрового изображения инструментом Pick
и представлены три фазы выполнения данной операции: начальная (слева),,
промежуточная (в центре) и конечная (справа). Обратите внимание, что в про-
цессе наклона изображения на экране отображается прямоугольник серого цве
та, который характеризует будущую форму изображения, если в данный момент
отпустить кнопку мыши.

Рис. 5.5. Пример наклона растрового изображения

Зеркальный разворот изображения
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Для выполнения разворота изображения по горизонтали (вертикали) относи
тельно его центра щелкните на верхней (нижней) кнопке зеркального разво
рота, расположенной на панели свойств (две кнопки Mirror Buttons (Кнопки
зеркальных разворотов)).

Рис. 5.6, Пример зеркальных разворотов растрового изображения
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На рис. 5.6 показан пример зеркальных разворотов растрового изображения.
Слева находится исходное изображение, в центре — изображение, развернутое
по горизонтали, и справа — развернутое по вертикали.

Изменение размеров и разрешения
Для произвольного изменения размеров и разрешения растрового изображения
используется команда Resample (Изменить параметры изображения) меню
Bitmaps (Растровая графика), доступ к которой имеется также на панели свойств
при условии выбора изображения рабочим инструментом Pick (Выбор) (кнопка
Resamples the Bitmap).

Потребность в указанной операции может у вас возникнуть в следующих случаях:

О для уменьшения количества пикселов в изображении с целью сокращения
его файлового размера;

П для увеличения числа пикселов в изображении с целью компенсации сниже-
ния его качества при возрастании размеров;

О для масштабирования изображения при сохранении в нем числа пикселов.

Данная операция может выполняться лишь по отношению к изображениям,
внедренным в документ.

Resample :

Image size

Width:

. Height:

Resolution

H orizontal;

Vertical:

Original image

New image si;

28,5 j 14,266 -̂  ;i50 m-^.%' ^millimeters ^J

300 1 300 м. dpi Г .' I'-i-V^'Wil ••>

300 [ЭОО .*« dpi

size: 136 000 bytes V. "
:-/ Maintain aspect ratio

e: 34400biJtes
f Maintain original jize

OK Cancel Help Reset

Рис. 5.7. Диалоговое окно команды Resample

^ Примечание

Существует одна особенность использования команды Resample примени-
тельно к выбранному изображению с непропорциональным масштабировани-
ем. Она состоит в том, что в диалоговом окне команды указываются фактиче-
ские размер и разрешение данного изображения лишь в горизонтальном
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направлении. Что касается вертикального направления, то для него выводятся
расчетные аналогичные параметры из условия пропорционального масштаби-
рования изображения.

На рис. 5.7 представлено одноименное диалоговое окно команды Resample.

Порядок работы
1. Выделите изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Resample (Растровая графика > Изменить пара-
метры изображения), открыв ее одноименное диалоговое окно.

3. Откройте список, находящийся в правом верхнем углу окна, и выберите
в нем нужные единицы измерения. Если вы собираетесь регулировать разме-
ры изображения, то задайте пункт millimeters (миллиметры) или centimeters
(сантиметры).

4. Определитесь в отношении следующих флажков, с помощью которых можно
подключить соответствующие режимы изменения параметров растрового
изображения:

• Identical values — режим задания одинаковых значений разрешения изо-
бражения по горизонтали и вертикали;

• Anti-alias — режим сглаживания краевых пикселов изображения при из-
менении в нем общего числа пикселов;

• Maintain aspect ratio — режим сохранения исходной пропорции размеров
изображения;

• Maintain original size— режим сохранения первоначальных чисел пиксе-
лов в изображении по горизонтали и вертикали.

5. Введите новый размер изображения по горизонтали в одно из двух полей
Width (Ширина), левое из которых используется для ввода размера в задан-
ных абсолютных единицах, а правое — в относительных (процентах).

6. Укажите новый размер изображения по вертикали (два поля Height (Высота)).

7. Задайте новые значения разрешения изображения в количестве точек на
дюйм (поля Horizontal (По горизонтали) и Vertical (По вертикали)).

8. Щелкните на кнопке подтверждения ОК.

Увеличение размеров подложки
В ряде случаев у вас может возникнуть потребность в увеличении размеров
(наращивании) подложки некоторого растрового изображения, содержащегося
в документе. К числу таких случаев относятся следующие:

О устранение возможной обрезки краев изображения при выполнении опера-
ции его растрирования;

О формирование рамки вокруг изображения;
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П увеличение области обработки изображения с целью создания в нем требуе-
мого художественного эффекта.

Если перед выполнением операции растрирования установить галочку слева от
названия команды Auto Inflate Bitmap (Автоматически нарастить подложку)
подменю Inflate Bitmap (Нарастить подложку) меню Bitmaps (Растровая графи-
ка), то в процессе преобразования векторного изображения в растровое про-
изойдет незначительное увеличение размеров подложки. Это позволит предот-
вратить возможные искажения изображения по его краям.

Для произвольного увеличения размеров растровой подложки используется
команда Manually Inflate Bitmap (Вручную нарастить подложку), входящая в то
же подменю. Она позволяет равномерно увеличить размеры подложки выбран-
ного изображения по ширине или высоте с сохранением ее разрешения. Увели-
чение размеров подложки данной командой возможно лишь для внедренных
в документ растровых изображений.

Примечание

Если вам необходимо сместить изображение относительно центра подложки, то
это можно сделать следующим образом. Вначале равномерно увеличьте подлож-
ку командой Manually Inflate Bitmap, затем выполните кадрирование изображе-
ния с помощью наложенного обтравочного контура и обрежьте изображение.

Порядок работы
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Inflate Bitmap > Manually Inflate Bitmap (Рас-
тровая графика > Нарастить подложку > Вручную нарастить подложку),
открыв ее диалоговое окно Inflate Bitmap.

3. Определитесь в отношении флажка Maintain aspect ratio (Сохранить пропор-
цию), при установке которого будет сохранена первоначальная пропорция
размеров подложки.

4. Задайте новые размеры подложки по ширине (два поля Width) и высоте (два
поля Height). Эти размеры вы можете задать в пикселах (область Inflate to
(Нарастить к)) или в процентах по отношению к исходным значениям (об-
ласть Inflate by).

5. Щелкните на кнопке подтверждения ОК.

Работа с обтравочными контурами
В CorelDRAW J2 предусмотрена обработка так называемых обтравочных контуров,
содержащихся в растровых изображениях. Обтравочный контур представляет собой
векторный контур типа Безье, который выполняет в изображении две функции:

О делает невидимым ту часть изображения, которая находится снаружи (или
внутри) от него;
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задает область изображения, вокруг которой может быть сформирована текстовая
оборка (см. разд. "Обработка обычного текста " гл. 6, подразд. "Текстовые оборки ").

^^ Примечание

В ряде издательских программ предусмотрена функция кадрирования, позво-
ляющая сформировать прямоугольную область, внутри которой выполняется пере-
мещение изображения, отображаемого в данной области. Хотя в CorelDRAW 12
специальная срункция кадрирования отсутствует, однако с помощью обтравочно-
го контура вы сможете отобразить любую произвольную область изображения.

Обтравочные контуры бывают двух типов: встроенные и наложенные. Встроен-
ный обтравочный контур формируется в программе растровой графики в про-
цессе создания изображения и сохраняется в векторном файловом формате EPS,
основанном на языке PostScript.

Наложенный обтравочный контур создается непосредственно в документе
CorelDRAW 12 из контура прямоугольной формы, расположенного по перимет-
ру изображения, на четырех вершинах которого находится по узелку.

Существует одна важная особенность импорта в документ EPS-изображения со
встроенным обтравочным контуром. Она состоит в том, что в списке допусти-
мых файловых форматов Files of type (Типы файлов) диалогового окна команды
Import (Импорт) CorelDRAW 12 должен быть выбран пункт PS, PRN, EPS -
PostScript Interpreted (назовем такой режим импорта основным). Только в этом
случае встроенный контур будет загружен в документ вместе с изображением.

Если же в этом списке задан один из двух пунктов: EPS - Encapsulated
PostScript или All File Formats (Все файловые форматы), то вместо встроенного
контура появится наложенный контур в виде прямоугольной рамки, окаймляю-
щей изображение (назовем такой режим дополнительным). При этом само изо-
бражение, отображаемое в документе, будет иметь низкое качество.

На рис. 5.8 слева представлено EPS-изображение со встроенным обтравочным
контуром, импортированное в документ в дополнительном режиме, а справа -
в основном режиме.

Рис. 5.8. Пример импорта EPS-изображения с обтравочным контуром в двух режимах
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При выполнении операции импорта в основном режиме на экране откроется
диалоговое окно Import PostScript, в котором вы должны выбрать параметры,
используемые при преобразовании импортируемого изображения из EPS-
формата в растровый формат. В частности, ползунок VM Size позволяет задать
файловый объем импортируемого изображения, а два переключателя — режим
представления текстовой информации: в виде кривых (переключатель Curves)
или текстовых символов (Text).

Изображение формата EPS можно импортировать в документ лишь в режиме
его внедрения. Это означает, что встроенные обтравочные контуры могут ис-
пользоваться только для EPS-изображений, внедренных в тело документа.
Наложенные контуры можно создавать как для внедренных изображений, так и
для связанных.

Любой обтравочный контур является кривой Безье, поэтому его можно редакти-
ровать с помощью узелков и контрольных точек. Форма встроенного контура,
а также расположение на нем узелков могут быть любыми.

Обрабатываемый обтравочный контур имеет вид синей линии, на которой рас-
положены узелки (маркеры) в форме небольших квадратных рамок. При выде-
лении узелка он увеличивается в размерах и отображается более отчетливо.

В CorelDRAW 12 обтравочные контуры растровых изображений можно обраба-
тывать двумя рабочими инструментами:

Л

Л

л Shape (Форма), позволяющим редактировать контур по методу Безье;

Eraser (Ластик), выполняющим косвенную обработку существующего

обтравочного контура или создающим новые такие контуры путем непосред-
ственного воздействия на само изображение, образуя в нем новые прозрач-
ные участки или расширяя имеющиеся.

На рис. 5.9 изображена панель свойств в режиме обработки обтравочного кон-
тура инструментом Shape. Здесь отмечены только те инструменты, которые мо-
гут использоваться при работе с данным контуром.

1 2 3 4 5 6 7 8 9 1 0

Рис. 5.9. Панель свойств в режиме обработки обтравочного контура.
1 — добавление узелка; 2 — удаление выделенного узелка;

3 — преобразование кривой в прямую; 4 — преобразование прямой в кривую;
5 — преобразование узелка в угловой; 6 — преобразование узелка в сглаженный;

7 — преобразование узелка в симметричный; 8 — режим перемещения
и масштабирования узелков; 9 — режим поворота и наклона узелков;

10 — режим эластичной кривой

На рис. 5.10 представлен пример обработки наложенного обтравочного контура
инструментами Shape и Eraser.
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Рис. 5.10. Пример обработки обтравочного контура различными инструментами.
1 — исходное изображение; 2 — изображение в процессе обработки

инструментом Shape; 3 — изображение в процессе обработки инструментом Eraser;
4 — изображение после обработки инструментом Eraser

и последующего выбора инструмента Shape

Порядок работы с инструментом Shape
1. Отобразите требуемое растровое изображение в нужном масштабе и выделите

его рабочим инструментом Pick (Выбор),

2. Выберите рабочий инструмент Shape (Форма).

3. Выполните обработку обтравочного контура в следующей последовательности:

• добавьте в нужных местах контура новые узелки, установив в каждом из
них указатель и сделав двойной щелчок мышью;

• удалите лишние узелки, поместив на каждом из них указатель и выполнив
двойной щелчок мышью;

• отрегулируйте форму контура путем перемещения мышью его узел кои
и контрольных точек, а также используя соответствующие инструменты
панели свойств.

Порядок работы с инструментом Eraser
1. Отобразите требуемое изображение в нужном масштабе и выделите его инст-

рументом Pick (Выбор).

2. Выберите рабочий инструмент Eraser (Ластик).
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3. Задайте на панели свойств толщину ластика (поле Erase Thickness), его фор-
му (переключатель Circle/Square) и режим удаления лишних узелков (кнопка
Auto-Reduce On Erase).

4. Выполните обработку изображения (при нажатой кнопке мыши), удалив из
него лишние области.

Knife (Нож), С его

Разрезка изображения на части

Данная операция выполняется рабочим инструментом

помощью вы можете разрезать любое растровое изображение (внедренное или
связанное) на отдельные части по заданный траектории. Эти части могут быть
обработаны в дальнейшем как независимые изображения.

Следует отметить одну важную особенность данной операции, объясняющую ее
физику. Фактически здесь растровое изображение не разрезается (это невоз-
можно было бы сделать в программе векторной графики), а выполняется сле-
дующая его обработка. Создается копия исходного изображения, которая накла-
дывается на оригинал, после чего производится автоматическая обработка
программой наложенных обтравомных контуров этих изображений таким обра-
зом, что видимые их части дополняют друг друга по линии разреза, которую вы
формируете.

Порядок работы
1. Отобразите требуемое растровое изображение в нужном масштабе (выделять

его не обязательно).

2. Выберите рабочий инструмент Knife (Нож).

3. Задайте на панели свойств режим разрезки изображения на независимые
части, отжав первую слева кнопку (Leave As One Object) и нажав вторую
(Auto-Close On Cut).

4. Если линия разреза изображения должна быть прямой, поместите указа-
тель, имеющий вид наклоненного ножа, в исходную точку разреза, нахо-
дящуюся на границе изображения, и, как только нож расположится верти-
кально, щелкните кнопкой мыши. Затем переместите указатель к конечную
точку разреза на границе изображения и при повторном изменении его
формы сделайте еще один щелчок. В результате данное изображение будет
разделено на две независимых части по отрезку прямой, проходящей через
эти две точки.

5. Если линия разреза должна иметь произвольную форму, нажмите в исход-
ной точке разреза кнопку мыши, переместите указатель по нужной вам
траектории в конечную точку, после чего отпустите кнопку мыши. При
этом будет сформирована линия разреза, совпадающая с траекторией пере-
мещения указателя.
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Обрезка изображения
Обрезка растрового изображения представляет собой операцию по удалению тех
прямоугольных частей его подложки, которые невидимы на экране и соприка-
саются снаружи с выступающими частями области обтравочного контура. Дан-
ная операция может быть выполнена лишь в отношении внедренного в доку-
мент изображения.

Операция обрезки выполняется в двух случаях:

П для уменьшения файлового размера документа, в котором находится данное
изображение;

П для уменьшения размера файла, в котором изображение будет сохранено
в режиме экспорта.

Обрезка изображения выполняется с помощью команды Crop Bitmap (Обрезать
растр) меню Bitmaps (Растровая графика), доступ к которой имеется также на
панели свойств при условии выбора данного изображения рабочим инструмен-
том Pick (Выбор) (кнопка Resamples the Bitmap).

Порядок работы
1. Выделите требуемое растровое изображение рабочим инструментом Pick

(Выбор).

2. Выберите рабочий инструмент Shape (Форма).

3. Отредактируйте обтравочный контур таким образом, чтобы хотя бы одна вы-
ступающая часть видимой области изображения находилась внутри исходной
прямоугольной области изображения (только в этом случае может быть вы-
полнена обрезка).

4. Выполните команду Bitmaps > Crop Bitmap (Растровая графика > Обрезать растр),

Изменение связей
Документ CorelDRAW 12 может содержать объекты различных типов, одни из них
находятся непосредственно в документе, а другие связаны с ним. В последнем
случае между документом и файлами объектов устанавливаются связи. Для свя-
занных объектов предусмотрены две операции: внедрение объекта в тело доку-
мента и обновление его связи.

Если объект предстаачяет собой растровое изображение, то первая операция
выполняется с помощью команды Break Link (Разорвать связь) меню Bitmaps
(Растровая графика), а вторая — командой Update From Link (Обновить связь)
того же меню. Для связанных OLE-объектов используются другие команды.

Потребность в изменении связей с файлами растровых изображений может воз-
никнуть у вас в следующих случаях:

О для уменьшения количества файлов, в которых хранится растровые изобра-
жения документа, путем внедрения в документ некоторых из них;
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П для повышения качества копии низкого разрешения связанного изображе-
ния, отображаемой в документе (после импорта данного изображения будет
вставлена в документ копия низкого качества, которая затем может быть
улучшена путем обновления связи);

G для восстановления связи с исходным изображением, которая была изменена
пользователем после импорта изображения в документ (файл изображения
был перенесен в другое место или изменено его название);

О для обновления в документе копии связанного изображения после измене-
ния пользователем оригинала, хранящегося в файле (в CorelDRAW 12 отсут-
ствует автоматическое обновление копий связанных изображений).

Порядок выполнения команд Break Link и Update From Link зависит от режима
связи с изображением. Если в процессе импорта данного изображения в диало-
говом окне команды Import (Импорт) был установлен флажок Link bitmap
externally (Связать с растровым файлом), при этом исходные изображения не
были изменены, то эти команды будут выполняться автоматически, без откры-
тия диалоговых окон.

Если же связь осуществлялась через открытый интерфейс допечатной подготов-
ки, задаваемый с помощью флажка Link to high resolution file for output using OPI
(Связать с файлом высокого разрешения через OPI), то при выполнении любой
из указанных команд откроется диалоговое окно Locate External Bitmap (Опре-
делить внешний растровый файл), в котором вы должны будете выбрать назва-
ние нужного файла с изображением.

Применение цветового профиля
Цветовой профиль может быть применен к любому внедренному в документ рас-
тровому изображению, имеющему доступный цветовой формат (см. разд. "Цвето-
вое управление" га, 3). Для этой цели используется команда Apply ICC Profile
(Применить профиль ICC) подменю Mode (Режим) меню Bitmaps (Растровая
графика). В одноименном диалоговом окне этой команды вы можете выбрать
любой цветовой профиль, имеющийся в программе, и применить его к выде-
ленному изображению.

Как известно, набор цветовых профилей формируется пользователем в процессе
установки программы. Вместе с тем, его можно постоянно пополнять в процес-
се импорта изображений путем извлечения профилей из файлов, в которых они
хранятся вместе с изображениями.

Если в файле импортируемого изображения имеется собственный цветовой
профиль, то в процессе выполнения операции импорта он может быть приме-
нен к изображению (см. разд. "Импорт и экспорт информации" гл. 7). При этом ко-
манда Apply ICC Profile вам не понадобится.

Необходимость в использовании этой команды может возникнуть у вас в сле-
дующих трех случаях:

О при отсутствии в файле импортируемого изображения внедренного цветового
профиля;
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П при импорте в документ изображения с отключенным режимом применения
имеющегося профиля;

П при загрузке в документ сканированного изображения.

Если выбранный цветовой профиль соответствует тому цветовому пространству,
в котором изображение представлено, то при его применении произойдет пере-
ход во внутреннее цветовое пространство CorelDRAW 12, задаваемое для модели
RGB. При этом цветовые искажения в изображении будут отсутствовать. При
неправильном выборе профиля или его отсутствии изображение исказится из-за
несоответствия его исходного цветового пространства тому, в котором изобра-
жение используется.

Обработка другими программами
Известно, что не все операции обработки растровых изображений, содержащих-
ся в документе, могут быть выполнены в программе CorelDRAW 12. Поэтому
разработчики предусмотрели возможность их обработки в других программах
(специализированных), входящих в состав графического пакета CorelDRAW
Graphic Suite 12. Это — программа растровой графики Corel PHOTO-PAINT 12
и программа трассировки CorelTRACE 12, формирующая из исходного растро-
вого изображения его векторную копию (см. разд. "Программа трассировки
CorelTRACE 12" гл. 10).

С помощью этих программ вы можете выполнить практически любую обработку
растрового изображения, внедренного в документ. Для этого достаточно выде-
лить требуемое изображение инструментом Pick (Выбор) и выполнить одну и;;
двух команд меню Bitmaps (Растровая графика): Edit Bitmap (Редактировать
растр) или Trace Bitmap (Трассировать растр). Первая из них используется для
обработки изображения в программе Corel PHOTO-PAINT 12, а вторая — для
его трассировки в CorelTRACE 12. Доступ к этим командам имеется также через
панель свойств (кнопки Edit Bitmap и Trace Bitmap).

При выполнении любой из указанных команд запускается соответствующая
программа и в нее загружается выделенное изображение. После завершения об-
работки дополнительная программа закрывается, а обработанное в ней изобра-
жение помещается на свое прежнее место в документе.

В частности, для выхода из программы Corel PHOTO-PAINT 12 вы должны вы-
полнить в ней команду File > Exit (Файл ^ Выход). При этом на экране откроется
диалоговое окно с предупреждением о необходимости сохранения изображения,
в котором необходимо щелкнуть на кнопке подтверждения. Для завершения
работы в программе CorelTRACE 12 также следует выполнить аналогичную ко-
манду и подтвердить сохранение трассированного изображения. В результате
данная программа закроется, а созданное в ней векторное изображение (оно
будет сгруппировано) расположится в документе CorelDRAW 12 поверх исход-
ного растрового изображения.
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Преобразование
цветовых форматов
В документах CorelDRAW 12 растровые изображения могут быть представлены
в семи цветовых форматах: черно-белом, оттенков серого, дуплексном, палитро-
вых цветов, а также цветовых моделей RGB, Lab и CMYK (см. разд. "Цветовые
форматы"гл. 3).

Необходимость преобразования цветового формата изображения может возник-
нуть в следующих случаях:

П! для создания художественного эффекта путем преобразования цветового
формата;

О для использования команд фильтрации с целью создания художественных
эффектов;

П для уменьшения файлового размера документа, содержащего обрабатываемое
изображение;

П для экспорта изображения в требуемом цветовом формате.

Для преобразования цветового формата растровых изображений используется
семь команд, входящих в подменю Mode (Режим) меню Bitmaps (Растровая гра-
фика). При этом обрабатываемое изображение должно быть внедрено в тело
документа. Рассмотрим эти команды.

Команда Black and White (1-bit)
Команда Black and White (1-bit) (Черно-белый (1 бит)) входит в подменю Mode
меню Bitmaps. Преобразует исходный цветовой формат выбранного изображе-
ния в черно-белый формат, в котором каждый пиксел может быть раскрашен
лишь черным или белым цветом. Команда может использоваться в двух случаях:

О для создания художественного эффекта;

О для уменьшения его файлового размера изображения.

На рис. 5.И изображено диалоговое окно Convert to I bit (Преобразовать
в 1 бит), в котором производится настройка параметров команды. Это окно со-
держит одно или два окна просмотра в зависимости от состояния кнопки
управления, находящейся в левом верхнем углу.

Обработанное командой изображение допускает дополнительную обработку
с помощью рабочей цветовой палитры. В результате черные и белые пикселы
изображения могут быть раскрашены в любые цвета, а белые пикселы сдела-
ны прозрачными. Раскраска белых пикселов производится щелчком левой
кнопки мыши на выбранной ячейке цветовой палитры, а черных — щелчком
правой кнопки мыши.
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Convert to I Bit

vlft* '-tif •'•:;•''-.-. - v - ' - J

Preview Reset Cared Help

Рис. S.11. Диалоговое окно команды Black and White (1-bit)

Порядок работы
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps»Mode > Black and White (1-bit) (Растровая
графика > Режим > Черно-белый (1 бит)), открыв диалоговое окно Convert
to I Bit.

3. Перейдите в режим просмотра результирующего изображения в окне коман-
ды, нажав кнопку Preview (Просмотр).

4. Выберите в списке Conversion (Преобразование) один из семи возможных
способов преобразования пикселов исходного изображения в черно-белые.

5. В зависимости от используемого способа преобразования пикселов выполни-
те настройку других параметров команды:

• для любого способа преобразования — плотность покрытия области изо-
бражения темными пикселами (ползунок Options Intensity);

• только для способа Halftone (Полутона): форма элементов растра (список
Screen type); угол наклона растра (degrees); линиатура растра (lines per).

6. Щелкните на кнопке подтверждения ОК.



304 Глава 5

Команда Duotone (8-bit)
Команда Duotone (8-bit) (Дуплекс (8 бит)) входит в подменю Mode (Режим) меню
Bitmaps (Растровая графика). Преобразует исходный цветовой формат выбранного
изображения в дуплексный формат путем обесцвечивания изображения с после-
дующей его раскраской оттенками нескольких цветов (от одного до четырех), вы-
бранных пользователем. Команда может использоваться в двух случаях:

П для создания художественного эффекта;

П для раскраски изображения стандартными цветами, которые будут выведены
в режиме цветоделения на отдельные пленки для изготовления печатных от-
тисков.

Настройка параметров команды производится в диалоговом окне Duotone (Дуп-
лекс), содержащем одно или два окна просмотра в зависимости от состояния
кнопки управления, находящейся в левом верхнем углу (рис. 5.12).

Curves overprint |

Type: JDuotone j-J

PAN7OME Process Cyan С

NuU

Load

[v Show All

Save

Reset Cancel Help

Рис. 5.12. Диалоговое окно команды Duotone {6-bit)
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Порядок работы
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Mode > Duotone (8-bit) (Растровая графика t
Режим * Дуплекс (8 бит)), открыв диалоговое окно Duotone (Дуплекс) на
вкладке Curves (Кривые).

3. Перейдите в режим просмотра результирующего изображения в окне коман-
ды, нажав кнопку с изображением замка (вторая слева внизу).

4. Откройте список Туре (Тип) и выберите в нем количество цветов, которые
будут использоваться для раскрашивания изображения: один (пункт
Monotone), два (Duotone), три (Tritone) или четыре (Quadtone).

5. Используя дополнительное окно Select Color (Выбрать цвет), задайте цвета
раскраски изображения. Для этого сделайте двойной щелчок в соответст-
вующей строке списка используемых цветовых образцов, расположенного
под списком Туре.

6. Для каждого из выбранных цветов сформируйте в рабочей области окна, на-
ходящейся справа, кривую дуплекса, задающую зависимость между интен-
сивностью раскраски пикселов изображения и уровнем в них черного цвета,

7. Откройте вкладку Overprint (Печать поверх) и выберите на ней вспомога-
тельные образцы цветов для раскраски ими на экране тех участков изобра-
жения, в которых происходит смешение цветов.

8. Щелкните на кнопке подтверждения ОК.

Команда Paletted (8-bit)
Команда Paletted (8-bit) (Палитровые (8 бит)) входит в подменю Mode (Режим)
меню Bitmaps (Растровая графика). Преобразует исходный цветовой формат вы-
бранного изображения в формат палитровых цветов. Команда может использо-
ваться в двух случаях:

О для уменьшения файлового размера изображения;

П для создания цветового эффекта посредством его раскраски фиксированным
набором цветов (не более 256-ти).

Настройка параметров команды производится в диалоговом окне Convert ito
Paletted (Преобразовать в палитровые), содержащем одно или два окна про-
смотра в зависимости от состояния кнопки управления, находящейся в левом
верхнем углу (рис. 5.13).

Порядок работы
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Mode V Paletted (8-bit) (Растровая графи-
ка > Режим»Палитровые (8 бит)), открыв диалоговое окно Convert to
Paletted на вкладке Options (Параметры).
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Convert to Paletted

Options I Range Sensitivity | Processed Palette |

Smoothing: I" ' ' ' ' | ' ' ' ' 1

Palette; >• [optimized

Dithering: | Stuck)

Dither Intensity,

Colors:

\ч/ color range sensitivity to:

' i | • i . . i . | |0

Open...

r-_

Reset I
Presets: | Default

Preview Reset: OK Cancel Help

Рис. 5.13. Диалоговое окно команды Paletted (8-bit)

3. Перейдите в режим просмотра результирующего изображения в окне коман-
ды, нажав кнопку Preview (Просмотр).

4. Откройте список Presets (Заготовки) и выберите в нем стиль оформления
изображения в формате палитровых цветов. Если он вас полностью устраива-
ет, щелкните на кнопке подтверждения ОК, завершив выполнение данной
инструкции, в противном случае перейдите к следующему ее шагу.

5. Выберите на вкладке Options следующие параметры:

• табличную цветовую палитру (раскрывающийся список Palette);

• уровень сглаживания цветовых оттенков в изображении (ползунок
Smoothing);

• способ предсташшния оттенков в изображении, позволяющий повысить
его качество при небольшом количестве используемых цветов (список
Dithering);

• уровень обработки изображения выбранным способом представления от-
тенков (ползунок Dither Intensity);
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• для цветовой палитры Adaptive (Адаптивная) или Optimized (Оптимизиро-
ванная) — количество цветовых образцов (поле Colors);

• только для палитры Optimized — режим цветового предпочтения (флажок
Color range sensitivity to) и базовый цвет, оттенки которого будут исполь-
зованы для коррекции цветовой палитры (инструмент-пипетка и список
образцов цветов справа).

6. В случае выбора цветовой палитры Optimized и установки флажка Color range
sensitivity to перейдите на вкладку Range sensitivity (Чувствительность диапа-
зона) и настройте параметры, откорректировав эту палитру оттенками базо-
вого цвета.

1. Если вы хотите откорректировать цветовые образцы используемой палитры
в ручном режиме, перейдите на вкладку Processed Palette (Рабочая палитра) и
выполните такую коррекцию с помощью кнопки Edit (Правка).

8. Если выбранные параметры предполагается в дальнейшем использовать для
обработки других изображений, создайте новый стиль оформления изобра-
жения (кнопка со знаком "+" справа от списка Presets).

9. Щелкните на кнопке подтверждения ОК.

Другие команды
Рассмотрим четыре оставшиеся команды преобразования цветовых форматов,
входящие в подменю Mode (Режим) меню Bitmaps (Растровая графика).

Grayscale (8-bit)
Команда Grayscale (8-bit) (Оттенки серого (8 бит)) преобразует исходный цвето-
вой формат выбранного изображения в формат оттенков серого. Используется
для обесцвечивания изображения и уменьшения его размера. Параметры на-
стройки команды отсутствуют.

RGB Color (24-bit)
Команда RGB Color (24-bit) (Модель RGB (24 бита)) преобразует исходный цве-
товой формат выбранного изображения в формат цветовой модели RGB. Пара-
метры настройки команды отсутствуют.

Lab Color (24-bit)
Команда Lab Color (24-bit) (Модель Lab (24 бита)) преобразует исходный цвето-
вой формат выбранного изображения в формат цветовой модели Lab. Парамет-
ры настройки команды отсутствуют.

CMYK Color (32-bit)
Команда CMYK Color (32-bit) (Модель CMYK (32 бита)) преобразует ИСХОДНЬЕЙ
цветовой формат выбранного изображения в формат цветовой модели CMYK.
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В процессе преобразования формата используется цветовой профиль для цвето-
деления, заданный в программе (см. разд. "Цветовое управление" гл. 3). Параметры
настройки команды отсутствуют.

Регулировка прозрачности

В CorelDRAW 12 предусмотрено пять способов регулировки прозрачности рас-
трового изображения:

с помощью рабочего инструмента Eraser (Ластик), делающего полно-

стью прозрачными те участки выбранного растрового изображения, на кото-
рые этот инструмент воздействует (см. разд. "Обработка линий и фигур"гл. 4)\

П с использованием рабочего инструмента Interactive Transparency (Интер-

активная прозрачность), позволяющего регулировать прозрачность растро-
вого изображения точно так же, как и векторного (см. разд. "Регулировка
прозрачности"гл. 4)\

путем редактирования обтравочного контура изображения (см. разд. "Общие
операции"данной главы, подразд. "Работа с обтравочными контурами")',

с помощью докера Bitmap Color Mask (Растровая цветовая маска), выпол-
няющего наложение на изображение цветовой маски;

для изображения черно-белого цветового формата — щелчком левой кноп-
кой мыши на образце прозрачной области в рабочей цветовой палитре, де-
лающим прозрачными белые пикселы изображения.

Регулировка прозрачности
докером Bitmap Color Mask
Рассмотрим операцию регулировки прозрачности растрового изображения доке-
ром Bitmap Color Mask (Растровая цветовая маска), который открывается одно-
именной командой меню Bitmaps (Растровая графика). С его помощью вы мо-
жете сделать прозрачными или, наоборот, видимыми отдельные участки
растрового изображения, имеющие заданные цветовые оттенки. Создание цве-
товой маски возможно лишь для растровых изображений, внедренных в тело
документа.

На рис. 5.14 показан пример удаления белого фона из изображения докером
Bitmap Color Mask. Вверху представлено исходное изображение, а внизу его вы-
деленная копия в процессе обработки. Справа изображен докер с параметрами,
которые использовались при обработке данного изображения.
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J

Bitmap Color Mask;

•> Hide Colors

'• ShowCcJois

Т oler апсе:

Рис. 5.14. Пример наложения цветовой маски на растровое изображение

Порядок работы
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор) и

отобразите его на экране в нужном масштабе.

2. Выполните команду Bitmaps > Bitmap Color Mask (Растровая графи-
ка > Растровая цветовая маска), открыв одноименный докер.

3. Если нужная вам цветовая маска существует, загрузите ее из файла
(с расширением ini), щелкнув на кнопке со значком изогнутой стрелки (она
первая справа). Если маска вас полностью устраивает, щелкните на кнопке
Apply (Применить), завершив на этом выполнение данной инструкции,
в противном случае перейдите к следующему ее шагу.

4. Выберите один из двух режимов работы с цветовой маской: скрытие участков
изображения с заданными цветовыми оттенками (переключатель Hide Colors
(Спрятать цвета)) или их отображение (переключатель Show Colors (Показать
цвета)).

5. Задайте образцы цветов с диапазонами цветовых оттенков, из которых будет
формироваться маска, для каждого из которых выполните следующие действия:

• выделите мышью в рабочем окне докера, находящемся справа, свободную
строку списка цветовых образцов;
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• выберите цвет текущего образца, используя инструмент-пипетку Color
Selector (Цветовой селектор) и обрабатываемое изображение или диалого-
вое окно Select Color (Выбрать цвет), открываемое кнопкой Edit Color
(Редактировать цвет);

• задайте с помощью ползунка Tolerance (Допуск) допустимый диапазон от-
тенков для данного образца;

• установите метку в левом окошке текущей строки списка, если она там
отсутствует.

6. Щелкните на кнопке Apply, наложив цветовую маску на изображение. Если
полученный результат вас не устраивает, удалите маску щелчком на кнопке со
значком мусорной корзины и вернитесь к предыдущему пункту инструкции.

7. Если созданная вами цветовая маска будет использоваться в дальнейшем при
обработке других изображений, сохраните ее в файле, щелкнув на кнопке
с изображением дискеты.

8. Закройте докер Bitmap Color Mask.

Тоновая коррекция
В CorelDRAW 12 тоновая коррекция растровых изображений выполняется с по-
мощью следующих шести команд подменю Adjust (Коррекция) меню Effects
(Эффекты):

П Contrast Enhancement (Повышение контрастности);

П Local Equalization (Локальное выравнивание);

П Tone Curve (Тоновая кривая);

О Auto Equalize (Автоматически выровнять);

П Brightness/Contrast/Intensity (Яркость/Контрастность/Интенсивность);

О Gamma (Гамма).

^ Примечание

Команды Brightness/Contrast/Intensity и Gamma могут также использоваться и
для коррекции векторных изображений.

Указанные команды являются точными копиями соответствующих команд
программы растровой графики Corel PHOTO-PAINT 12 (там их на три больше).
Они допускают обработку изображений следующих цветовых форматов: оттен-
ков серого, дуплексный, палитровых цветов, CMYK, Lab и RGB.

Работа с командами тоновой коррекции выполняется в окне коррекции и эф-
фектов (см. разд. "Диалоговые окна" гл. 2). При настройке параметров команды вы
можете контролировать свои действия по виду результирующего изображения,
находящегося в окне просмотра данного окна или в самом документе.
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Для обновления изображения в соответствии с новыми значениями параметров,
выполните одно из двух действий:

П после ввода новых значений параметров щелкните на кнопке Preview (Про-
смотр), расположенной в левом нижнем углу окна;

П перед выполнением операции настройки параметров нажмите кнопку с изо-
бражением замка, находящуюся справа от кнопки Preview, задав режим авто-
матического обновления изображения после очередного изменения парамет-
ров команды.

Команда Contrast Enhancement
Команда тоновой коррекции Contrast Enhancement (Повышение контрастности)
входит в подменю Adjust (Коррекция) меню Effects (Эффекты). Позволяет вы-
полнять как общую коррекцию выбранного изображения, так и коррекцию
в каждом из его цветовых каналов.

На рис. 5.15 показано диалоговое окно команды Contrast Enhancement с пара-
метрами, которые использовались при обработке изображения, представленного
слева.

Contrast Enhancement

'Eyedropper Затйпд —

;• Set input values

. Set output values

Channel •

j RGB Channels

Г" Auto-adjust Options

•Histogram Display Clipping •

Input Value Clipping 1 159 «

X7

: • Gamma Adjustment

v Automatically j [I

Ifs
Рис. 5.15. Обрабатываемое изображение

и диалоговое окно команды Contrast Enhancement

Порядок работы
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Effects > Adjust > Contrast Enhancement (Эффекты fr
Коррекция > Повышение контрастности), открыв окно коррекции и эффек
тов с параметрами команды.
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3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset (Сброс)).

4. Выберите в списке Channel (Канал) пункт с названием того цветового канала
(или всех каналов), в котором будет выполняться тоновая коррекция.

5. Выберите два первых пороговых уровня яркости (нижний и верхний), при
которых пикселы исходного изображения, не входящие в допустимый тоно-
вый диапазон, станут соответственно черными и белыми. Это можно выпол-
нить тремя способами:

• используя два ползунка, которые расположены вдоль верхней границы
гистограммы (она находятся в правой части окна команды);

• с помощью двух полей, расположенных над гистограммой;

• используя два инструмента-пипетки, находящиеся в левом верхнем углу
окна, при выбранном переключателе Set input values (Установить входные
значения). Работа происходит следующим образом: для задания нижнего
(верхнего) порога яркости необходимо нажать левую (правую) кнопку
с изображением пипетки, установить указатель на выбранном пикселе
изображения и щелкнуть кнопкой мыши.

6. Задайте два вторых пороговых уровня яркости, определяющие конечные зна-
чения яркости тех пикселов изображения, которые до обработки были абсо-
лютно черными и белыми. Это вы можете сделать также тремя способами:

• с помощью двух ползунков, расположенных вдоль тоновой шкалы, нахо-
дящейся под гистограммой;

• используя два поля, находящиеся под тоновой шкалой;

• с помощью двух инструментов-пипеток при выбранном переключателе
Set output values (Установить выходные значения).

7. Используя ползунок Gamma Adjustment (Настройка параметра гамма), вы-
полните тоновую коррекцию в неконтрастных участках изображения, при-
нимая во внимание следующее: при единичном значении параметра коррек-
ция отсутствует, при меньших его значениях изображение в области
полутонов становится темнее, а при больших — светлее.

8. Повторите шаги 4—7 инструкции для всех канальных изображений, подвер-
женных коррекции.

9. Определитесь в отношении флажка Auto-adjust (Автоматическая коррекция),
при установке которого задается режим автоматической коррекции, который
состоит в следующем. Перед формированием результирующего изображения
будет выполнена следующая вспомогательная операция: самые темные пик-
селы изображения станут черными, самые светлые — белыми, а величины
яркости остальных пикселов будут равномерно перераспределены по всему
тоновому диапазону. Если данный режим включен, откройте щелчком на
кнопке Options (Параметры) окно Auto-adjust Range (Диапазон автомати-
ческой коррекции) и задайте в нем параметры Black limit to (Порог черного)
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и White limit to (Порог белого). Они определяют процентные количества са-
мых темных и самых светлых пикселов изображения, которые не будут при-
ниматься во внимание при выполнении указанной операции.

10. Определитесь в отношении флажка Automatically (Автоматически), при ус-
тановке которого масштаб гистограммы по вертикали будет автоматически
изменяться таким образом, чтобы основная часть гистограммы полностью
заполняла отведенную для нее область.

П. Щелкните на кнопке подтверждения ОК.

^f Примечание

Если в окне рассматриваемой команды не делать никаких регулировок, за ис-
ключением установки флажка Auto-adjust и настройки параметров в дополни-
тельном окне Auto-adjust Range, то тогда данная команда будет выполнять ав-
томатическую тоновую коррекцию изображения, что свойственно команде Auto
Equalize (Автоматически выровнять).

Команда Local Equalization
Команда тоновой коррекции Local Equalization (Локальное выравнивание) вхо-
дит в подменю Adjust (Коррекция) меню Effects (Эффекты). Подчеркивает гра-
ницы контрастных участков изображения, а также выделяет мелкие детали
в светлых и темных областях изображения.

На рис. 5.16 показано диалоговое окно команды Local Equalization с параметрами,
которые использовались при обработке изображения, представленного слева.

Height: ' ; . , , . ! , , < > . , i».,i , , . . , , . , , , . . . м.м - . , |н

Help

Рис. 5.16. Обрабатываемое изображение
и диалоговое окно команды Local Equalization

Порядок работы
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Effects > Adjust > Local Equalization (Эффекты > Коррекция >
Локальное выравнивание), открыв окно коррекции и эффектов с параметра-
ми команды.
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3. Если вы не будете использовать параметры, которые задавались при обра-
ботке командой предшествующего изображения, установите параметры по
умолчанию (кнопка Reset).

4. Используя ползунки Width (Ширина) и Height (Высота) (с диапазонами зна-
чений от 5 до 255), выберите ширину и высоту выделяемых командой при-
граничных участков.

5. Щелкните на кнопке подтверждения ОК.

Команда Tone Curve
Команда тоновой коррекции Tone Curve (Тоновая кривая) входит в подменю
Adjust (Коррекция) меню Effects (Эффекты). Позволяет выполнять как общую
коррекцию выбранного изображения, так и коррекцию в каждом из его цвето-
вых каналов. Отличается от команды Contrast Enhancement (Повышение контра-
стности) тем, что тоновая регулировка пикселов изображения может выполнять-
ся по любому закону, задаваемому графически.

На рис. 5.17 показано диалоговое окно команды Tone Curve с параметрами, ко-
торые использовались при обработке изображения, представленного слева.

Рис. 5.17. Обрабатываемое изображение
и диалоговое окно команды Tone Curve

Порядок работы
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Effects > Adjust > Tone Curve (Эффекты > Коррекция >
Тоновая кривая), открыв окно коррекции и эффектов с параметрами команды.

3. Выберите в списке Channel (Канал) пункт с названием того цветового канала
(или всех каналов), в котором будет выполняться тоновая коррекция.
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4. Если набор тоновый кривых, который вам необходим, существует, то загру-
зите его из файла (с расширением crv), щелкнув на кнопке со значком изо-
гнутой стрелки. Если эти кривые вас устраивают, завершите работу с коман-
дой, щелкнув на кнопке подтверждения ОК. Во всех остальных случаях
перейдите к следующему шагу инструкции.

5. Если вам необходимо выровнять уровни яркости пикселов выбранного цве-
тового канала во всем тоновом диапазоне, сделайте следующее. Щелчком на
кнопке Options (Параметры) откройте диалоговое окно Auto-adjust Range
(Диапазон автоматической коррекции), задайте в нем параметры Black limit
to (Порог черного) и White Limit to (Порог белого), определяющие долю са-
мых темных и самых светлых пикселов изображения, которые не будут при-
ниматься во внимание, после чего щелкните на кнопке ОК. Щелчком на
кнопке Balance (Баланс) сформируйте тоновую кривую, по которой будет
выполняться балансировка уровней яркости пикселов изображения. Завер-
шите работу с командой, щелкнув на кнопке ОК.

6. Задайте режим построения тоновой кривой, шелкнув на одной из четырем
кнопок, входящих в группу Curve Style (Стиль кривой):

• первая слева кнопка — кривая рисуется по контрольным точкам и состо-
ит из криволинейных участков (положение точек задается с помощью
щелчков мыши и последующего их перемещения);

• вторая кнопка — кривая также рисуется по контрольным точкам, но со-
стоит из прямолинейных участков;

• третья кнопка — кривая рисуется от руки (при нажатой кнопке мыши);

• четвертая кнопка — кривая имеет форму гамм а-функции, используемой
при тоновой коррекции изображения в области полутонов.

7. Сформируйте тоновую кривую в рабочей области окна команды, располо-
женной справа.

8. В случае необходимости откорректируйте форму кривой, используя следую-
щие элементы управления окна команды:

• кнопку Null (Обнуление), создающую прямолинейный отрезок под уг-
лом 45°, при котором тоновая коррекция отсутствует;

• две кнопки с изображениями двунаправленных стрелок, выполняю-
щие зеркальные развороты кривой по горизонтали и вертикали;

• кнопку Smooth (Сглаживание), предназначенную для сглаживания неров-
ностей в кривой, нарисованной от руки (появляется на экране при выбо-
ре третьей кнопки в группе Curve Style);

• поле Gamma Value (Значение гамма), в котором задается параметр гамма-
функции (появляется при выборе четвертой кнопки в группе Curve Style).

9. Повторите шаги 3—8 инструкции для всех канальных изображений, подвер-
женных коррекции.
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10. Если вы создали несколько тоновых кривых, отобразите их все в окне
команды, установив флажок Display All (Отобразить все).

11. Если созданные вами кривые предполагается в дальнейшем использовать
для коррекции других изображений, сохраните их в файле, щелкнув на
кнопке с изображением дискеты.

12. Щелкните на кнопке подтверждения ОК.

Команда Auto Equalize
Команда тоновой коррекции Auto Equalize (Автоматически выровнять) входит
в подменю Adjust (Коррекция) меню Effects (Эффекты). Выполняет коррекцию
выбранного изображения в автоматическом режиме, которая состоит в следую-
щем. Самые темные и самые светлые пикселы изображения (за исключением тех,
которые попадают в диапазоны отсечения, задаваемые в диалоговом окне коман-
ды Contrast Enhancement (Повышение контрастности)), делаются соответственно
черными и белыми, а уровни яркости остальных пикселов равномерно перерас-
пределяются по всему тоновому диапазону. Параметры команды отсутствуют.

Порядок работы
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Effects > Adjust > Auto Equalize (Эффекты > Коррекция >
Автоматически выровнять).

Команда Brightness/Contrast/Intensity
Команда тоновой коррекции Brightness/Contrast/Intensity (Яркость/Контрастность/
Интенсивность) входит в подменю Adjust (Коррекция) меню Effects (Эффекты).
Выполняет коррекцию выбранного изображения с помощью трех параметров.
Первый из них (Brightness), регулирует яркость пикселов изображения, вто-
рой (Contrast) — контрастность, а третий (Intensity) — также контрастность, но
лишь в светлых и темных областях изображения.

Порядок работы
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Effects > Adjust » Brightness/Contrast/Intensity (Эффекты >
Коррекция * Яркость-Контрастность-Интенсивность), открыв окно коррек-
ции и эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке командой предшествующего изображения, установите параметры по
умолчанию (кнопка Reset).

4. С помощью ползунков Brightness, Contrast и Intensity (с диапазонами значе-
ний от —100 до 100) отрегулируйте параметры команды в порядке их распо-
ложения в диалоговом окне.

5. Щелкните на кнопке подтверждения ОК.
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Команда Gamma
Команда тоновой коррекции Gamma (Гамма) входит в подменю Adjust (Коррек-
ция) меню Effects (Эффекты). Позволяет регулировать отображение отдельных
деталей на неконтрастных участках выбранного изображения без изменения
уровней его светлых и темных тонов.

Порядок работы
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Effects > Adjust > Gamma (Эффекты > Коррекция > Гамма),
открыв окно коррекции и эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке командой предшествующего изображения, установите параметры по
умолчанию (кнопка Reset).

4. Используя ползунок Gamma Value (Значение гамма) (с диапазоном значений
от 0,1 до 10), отрегулируйте гамма-параметр. При единичном значении этого
параметра тоновая коррекция отсутствует, при меньших значениях изобра-
жение в области полутонов становится темнее, а при больших — светлее.

5. Щелкните на кнопке подтверждения ОК.

Цветовая коррекция
Цветовая коррекция растровых изображений выполняется в CorelDRAW 12
с помощью следующих семи команд подменю Adjust (Коррекция) меню Effects
(Эффекты):

П Sample/Target Balance (Исходный/Конечный баланс);

О Color Balance (Цветовой баланс);

П Hue/Saturation/Lightness (Оттенок/Насыщенность/Светлота);

П Selective Color (Выборочная коррекция цвета);

П Replace Colors (Заменить цвета);

П Desaturate (Обесцветить);

П Channel Mixer (Смешение каналов).

^ Примечание

Команды Color Balance (Цветовой баланс) и Hue/Saturation/Lightness (Отте-
нок/Насыщенность/Светлота) могут также использоваться и для коррекции век-
торных изображений.

Указанные команды являются точными копиями соответствующих команд про-
граммы растровой графики Corel PHOTO-PAINT 12 (там их на одну больше). Для
каждой из них допускаются свои цветовые форматы обрабатываемых изображений.
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Работа с командами цветовой коррекции выполняется в окне коррекции и эф-
фектов (см. разд. "Диалоговые окна" гл. 2). При настройке параметров команды вы
можете контролировать свои действия по виду результирующего изображения,
находящегося в окне просмотра данного окна или в самом документе.

Для обновления изображения в соответствии с новыми значениями параметров
выполните одно из двух действий:

П после ввода новых значений параметров щелкните на кнопке Preview (Про-
смотр), расположенной в левом нижнем углу окна;

О перед выполнением операции настройки параметров нажмите кнопку с изо-
бражением замка, находящуюся справа от кнопки Preview, задав режим авто-
матического обновления изображения после очередного изменения парамет-
ров команды.

Команда Sample/Target Balance
Команда цветовой коррекции Sample/Target Balance (Исходный/Конечный ба-
ланс) входит в подменю Adjust (Коррекция) меню Effects (Эффекты). Допускает
обработку изображений следующих цветовых форматов: оттенков серого, дуп-
лексный, палитровых цветов, CMYK, Lab и RGB.

Корректирует выбранное изображение по трем базовым точкам, находящимся
в областях теней, полутонов и светов. Для каждой из этих точек пользователь
задает свое корректирующее воздействие, определяемое исходным и конечным
цветами раскраски пикселов. Команда допускает как общую цветовую коррек-
цию изображения, так и коррекцию в одном из его цветовых каналов.

На рис. 5.18 показано диалоговое окно команды Sample/Target Balance с параметра-
ми, которые использовались при обработке изображения, предсташтеиного слева.

Sam pie/!• г get Balan с е

Channel. JRiaBC-iannels T]

IV Always adjust al channels

Target

32: 56

Clipping: Г

s 112J182 [252J237

% V dp Automatically

Рис. 5.18. Обрабатываемое изображение
и диалоговое окно команды Sample/Target Balance
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Порядок работы
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Effects »Adjust > Sample/Target Balance (Эффекты >
Коррекция > Исходный/Конечный баланс), открыв окно коррекции и эф-
фектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Выберите в списке Channel (Канал) пункт с названием того цветового канала
(или всех каналов), в котором будет выполняться цветовая коррекция.

5. Определитесь в отношении флажка Always adjust all channels (Корректировать
все каналы), при установке которого будет зафиксирован тот цветовой канал,
который был до этого выбран в списке Channel (последующая смена канал он
не будет подключать его для выполнения в нем коррекции).

6. С помощью трех инструментов-пи пето к, находящихся слева, выберите в изо-
бражении три базовых пиксела, выполнив для этого следующие действия
Нажмите верхнюю кнопку с изображением пипетки, установите указатель на
некотором пикселе в области теней исходного изображения и щелкните
кнопкой мыши. Повторите данную процедуру для областей полутонов (сред-
няя кнопка) и светов (нижняя). При этом шесть цветовых образцов прямо-
угольной формы, находящиеся справа от инструментов-пипеток, раскрасятся
в цвета выбранных вами пикселов (в левой области Sample расположены об-
разцы цветов для базовых точек исходного изображения, а в правой области
Target — для результирующего).

7. Откорректируйте цветовые образцы, находящиеся в области Target, для каж-
дого из которых откройте диалоговое окно Select Color (Выбрать цвет) щелч-
ком на образце и измените в нем цвет соответствующей базовой точки.

8. Определитесь в отношении флажка Clip Automatically (Обрезать автоматиче-
ски), при установке которого масштаб гистограммы по вертикали будет ав-
томатически изменяться таким образом, чтобы основная часть гистограммы
полностью заполняла отведенную для нее область.

9. Щелкните на кнопке подтверждения ОК.

Команда Color Balance
Команда цветовой коррекции Color Balance (Цветовой баланс) входит в подме-
ню Adjust (Коррекция) меню Effects (Эффекты). Допускает обработку изображе-
ний следующих цветовых форматов: дуплексный, палитровых цветов, CMYK,
Lab и RGB.

Выполняет коррекцию выбранного изображения путем регулировки в нем цве-
тового баланса, то есть соотношения цветовых компонентов. Допускает коррек-
цию как во всем тоновом диапазоне изображения, так и в отдельных его частях



320 Глава 5

(областях теней, полутонов и светов). Регулирует цветовой баланс с помощью
трех ползунков, задающих соотношение между тремя парами дополняющих друг
друга цветов в цветовом круге (эти цвета являются базовыми для цветовых мо-
делей CMYK и RGB).

Порядок работы
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Effects > Adjust > Color Balance (Эффекты > Коррекция >
Цветовой баланс), открыв окно коррекции и эффектов с параметрами
команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя флажки Shadows (Тени), Midtones (Полутона) и Highlights (Света),
укажите области тонов изображения, в которых будет выполняться цветовая
коррекция. Для выполнения коррекции во всем тоновом диапазоне необхо-
димо установить все флажки.

5. Определитесь в отношении флажка Preserve luminatcy (Сохранить яркость
тонов), при установке которого будет обеспечена неизменность тоновых ха-
рактеристик изображения при выполнении цветовой коррекции.

6. Откорректируйте изображение с помощью трех ползунков: Cyan-Red (Голубой-
Красный), Magenta-Green (Пурпурный-Зеленый) и Yellow-Blue (Желтый-
Синий) (с диапазонами значений от —100 до 100). Приближение ползунка
к одному из его краев означает увеличение в изображении соответствующей
цветовой составляющей, указанной в его названии.

7. Щелкните на кнопке подтверждения ОК.

Команда Hue/Saturation/Lightness
Команда цветовой коррекции Hue/Saturation/Lightness (Оттенок/Насыщенность/
Светлота) входит в подменю Adjust (Коррекция) меню Effects (Эффекты). До-
пускает обработку изображений следующих цветовых форматов: дуплексный,
палитровых цветов, CMYK, Lab и RGB.

Позволяет выполнить коррекцию выбранного изображения как во всем его цве-
товом спектре, так и в отдельных диапазонах, относящихся к шести основным
цветам цветового круга (красному, желтому, зеленому, голубому, синему и пур-
пурному), а также к серому пвету. Коррекция выполняется с помощью трех па-
раметров, являющихся базовыми для цветовой модели HLS: цветовой тон (Hue),
светлота (Lightness) и насыщенность (Saturation).

На рис. 5.19 представлено диалоговое окно команды Hue/Saturation/Lightness.



Обработка растровых изображений 321

Н ue/S atuiation/Liqhtness

Channels

fted Yellow Green

Saturation:

Lightness:

Preview

Blue Magenta Grayscale

Before

After

Cancel Hdp

Рис. 5.19. Диалоговое окно команды Hue/Saturation/Lightness

Порядок работы
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Effects > Adjust > Ние/Saturalion/Lightness (Эффекты >
Коррекция > Оттенок/Насыщенность/Светлота), открыв окно коррекции и
эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Задайте цветовой диапазон, в котором будет выполняться коррекция, с по-
мощью одного из восьми переключателей: Master (Все цвета), Red (Крас-
ный), Yellow (Желтый), Green (Зеленый), Cyan (Голубой), Blue (Синий],
Magenta (Пурпурный) или Grayscale (Оттенки серого).

5. С помощью ползунка Hue (Цветовой тон) (с диапазоном значений от —180°
до 180°), а также ползунков Saturation (Насыщенность) и Lightness (Светлота)
(с диапазоном значений от —100 до 100 %) выполните цветовую коррекцию
изображения в заданном вами диапазоне цветов.

6. Повторите шаги 4 и 5 инструкции для всех цветовых диапазонов, в которых
будет выполняться коррекция.

7. Щелкните на кнопке подтверждения ОК.

Команда Selective Color
Команда цветовой коррекции Selective Color (Выборочная коррекция цвета)
входит в подменю Adjust (Коррекция) меню Effects (Эффекты). Допускает обра-
ботку изображений следующих цветовых форматов: оттенков серого, дуплекс-
ный, палитровых цветов, CMYK, Lab и RGB.

II Зак. 250
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Данная команда отличается от предыдущей тем, что выполняет коррекцию
только для отдельных цветовых диапазонов изображения, относящихся к базо-
вым цветам цветовых моделей RGB и CMYK, а также для трех диапазонов се-
рых оттенков. Величина корректирующего воздействия задается с помошью
четырех параметров, соответствующих цветовым компонентам модели CMYK.

На рис. 5.20 показано диалоговое окно команды Selective Color.
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Рис. 5.20. Диалоговое окно команды Selective Color

Порядок работы
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Effects > Adjust > Selective Color (Эффекты > Коррекция >
Выборочная коррекция цвета), открыв окно коррекции и эффектов с пара-
метрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке командой предшествующего изображения, установите параметры по
умолчанию (кнопка Reset).

4. Задайте режим внесения корректирующих воздействий с помошью одного из
двух переключателей, находящихся в области Adjustment percentage (Уровень
коррекции):

• Relative (Относительный), когда величина приращения регулируемой цве-
товой составляюшей определяется ее исходной величиной и выбранным
значением соответствующего ползунка;

• Absolute (Абсолютный), когда величина приращения данного компонента
определяется только текущим значением ползунка.
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5. Выберите цветовой диапазон, в котором будет выполняться коррекция, с помощью
одного из девяти переключателей, находящихся внизу окна: Reds (Красные),
Yellows (Желтые), Greens (Зеленые), Cyans (Голубые), Blues (Синие), Magenta (Пур-
пурные), Shadows (Тени), Midloncs (Полутона) или Highlights (Света).

6. Используя ползунки Cyan (Голубой), Magenta (Пурпурный), Yellow (Желтый)
и Black (Черный) (с диапазоном значений от —100 до 100 %), выполните цве-
товую коррекцию изображения в выбранном диапазоне.

7. Повторите шаги 5 и б инструкции для всех цветовых диапазонов, в которых
будет выполняться коррекция.

8. Щелкните на кнопке подтверждения ОК.

Команда Replace Colors
Команда цветовой коррекции Replace Colors (Заменить цвета) входит в подменю
Adjust (Коррекция) меню Effects (Эффекты). Допускает обработку изображений
следующих цветовых форматов: оттенков серого, дуплексный, палитровых цве-
тов, CMYK, Lab и RGB.

Позволяет выделить участки изображения с заданными цветовыми оттенками
пикселов и раскрасить их в любой другой цвет, выбранный пользователем.

На рис. 5.21 показано диалоговое окно команды Replace Colors с параметрами,
которые использовались при обработке изображения, представленного слева.

Replace Color в

а Cancel Hi

Рис. 5.21. Обрабатываемое изображение
и диалоговое окно команды Replace Colors

Порядок работы
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Effects > Adjust > Replace Colors (Эффекты > Коррекция ^
Заменить цвета), открыв окно коррекции и эффектов с параметрами команды
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3. Выберите старый цвет, оттенки которого будут заменены. Эту операцию
можно выполнить одним из двух способов:

• с помощью раскрывающегося списка цветовых образцов Old color (Ста-
рый цвет), расположенного в левом верхнем углу окна команды;

• выбором инструмента-пипетки, находящегося справа от данного списка,
с последующим щелчком мыши на пикселе изображения, имеющем тре-
буемую раскраску.

4. Задайте новый цвет, которым будет заменен старый, используя один из трех
способов:

• с помощью списка цветовых образцов New color (Новый цвет), располо-
женного под списком Old color;

• выбором инструмента-пипетки, находящегося справа от указанного спи-
ска;

• используя ползунок Hue (Цветовой тон) (с диапазоном значений от —180°
до 180°), а также ползунки Saturation (Насыщенность) и Lightness (Свет-
лота) (с диапазонами значений от -100 до 100 %), которые задают откло-
нения значений цветовых параметров нового цвета от старого в формате
цветовой модели HLS.

5. С помощью ползунка Range (Диапазон) (с диапазоном значений от 0 до 100)
отрегулируйте диапазон цветовых оттенков, которые будут заменяться в изо-
бражении, контролируя свои действия по цветовой маске изображения,
находящейся справа (обрабатываемые участки изображения отображаются
в маске светлыми оттенками).

6. Определитесь в отношении флажка Ignore grayscale (Игнорировать оттенки
серого), при установке которого в участках изображения, раскрашенных от-
тенками серого цвета, замена цветов не производится.

7. Определитесь в отношении флажка Single destination color (Один целевой
цвет), при установке которого выбранные в изображении оттенки будут за-
менены соответствующими оттенками нового цвета, а при снятии — чистым
выбранным цветом.

8. Щелкните на кнопке подтверждения ОК.

Команда Desaturate
Команда цветовой коррекции Desaturate (Обесцветить) входит в подменю Adjust
(Коррекция) меню Effects (Эффекты)- Допускает обработку изображений сле-
дующих цветовых форматов: оттенков серого, дуплексный, палитровых цветов,
CMYK, Lab и RGB.

Удаляет из выбранного изображения все цвета, представляя его в оттенках
серого цвета и сохраняя исходный цветовой формат. Параметры команды
отсутствуют.
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Порядок работы
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор),

2. Выполните команду Effects > Adjust > Desaturate (Эффекты > Коррекция >
Обесцветить).

Команда Channel Mixer
Команда цветовой коррекции Channel Mixer (Смешение каналов) входит в под-
меню Adjust (Коррекция) меню Effects (Эффекты). Допускает обработку изобра-
жений следующих цветовых форматов: CMYK, Lab и RGB.

Корректирует выбранное изображение путем смешения в заданных пропорциях
значений канальных яркостей пикселов исходного изображения при вычислении
канальных яркостей соответствующих пикселов результирующего изображения.

Порядок работы
1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Effects > Adjust t Channel Mixer (Эффекты > Коррекция >
Смешение каналов), открыв окно коррекции и эффектов с параметрами
команды.

3. При наличии у вас файла (с расширением cha) с требуемыми параметрами
коррекции для данной команды, загрузите его, щелкнув на кнопке со значком
изогнутой стрелки, после чего перейдите к последнему шагу инструкции.

4. Выберите в списке Color Model (Цветовая модель) одну из трех цветовых
моделей: RGB, CMYK или Lab, в которой будет представлено изображение
в окне команды с целью регулировки базовых цветовых параметров.

5. Определитесь в отношении флажка Preview output channel only (Просмотр
только выходного канала), при установке которого задается режим отобра-
жения результирующего изображения, относящегося к заданному цветовому
каналу.

6. Выберите в списке Output Channel (Выходной канал) тот цветовой канал,
для которого будет сформировано результирующее изображение.

7. Используя ползунки с названиями цветовых каналов (с диапазонами значе-
ний от -200 до 200), задайте коэффициенты долевых участий исходных ка-
нальных изображений в формировании результирующего изображения для
выбранного канала.

8. Повторите шаги 6 и 7 инструкции для всех регулируемых цветовых каналоп.

9. Если выбранные параметры команды предполагается в дальнейшем исполь-
зовать при обработке других изображений, сохраните их в отдельном файле
(кнопка с изображением дискеты).

10. Щелкните на кнопке подтверждения ОК.
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Создание эффектов
В программе CorelDRAW 12 предусмотрены широкие возможности создания
различных эффектов в растровых изображениях. Они реализуются с помощью
тех же команд, что и в программе растровой графики Corel PHOTO-PAINT 12.
Общее их число в CorelDRAW 12 составляет 79.

Все команды создания эффектов в растровой графике расположены в двух меню
программы: Effects (Эффекты) и Bitmaps (Растровая графика), где они сгруппи-
рованы в отдельные подменю по функциональному признаку.

Используя команды меню Effects CorelDRAW 12, вы можете создавать:

О эффекты коррекции и цветовой обработки (подменю Transform (Преобразо-
вать)) — 3 команды;

О эффект коррекции (подменю Correction (Коррекция)) - одна команда
фильтрации.

С помощью команд меню Bitmaps можно создавать:

П эффекты трансформации в пространстве подложки с изображени-
ем (подменю 3D Effects (Трехмерные эффекты» — 7 команд фильтрации;

П эффекты рисования с использованием различных методов живописи и гра-
фики (подменю Art Strokes (Художественные штрихи)) — 14 команд фильт-
рации;

П эффекты коррекции и размытия (подменю Blur (Размытие)) — 9 команд
фильтрации;

П эффект коррекции (подменю Camera (Камера)) — одна команда фильтрации;

П эффекты цветовой обработки (подменю Color Transform (Преобразование
цвета)) — 4 команды фильтрации;

П1 эффекты формирования контурных изображений (подменю Contour (Кон-
тур)) — 3 команды фильтрации;

П эффекты составления изображений из отдельных элементов (подменю
Creative (Формирование)) — 14 команд фильтрации;

О эффекты искажений (подменю Distort (Искажение)) — 10 команд фильтрации:

П эффекты устранения и добавления шума (подменю Noise (Шум)) — 6 команд
фильтрации;

О эффекты повышения резкости (подменю Sharpen (Резкость)) - 5 команд
фильтрации;

П эффекты создания и чтения водяных знаков (подменю Plug-Ins (Дополне-
ния)) — две специальные команды фильтрации.

Следует отметить, что в CorelDRAW 12 реализованы не все возможности про-
граммы растровой графики Corel PHOTO-PAINT 12 по созданию эффектов
в растровых изображениях. Перечислим те ограничения, которые имеются:

О любой эффект можно создавать лишь для всего выбранного изображения, а не
для некоторой его части, выделение которой в CorelDRAW 12 не предусмотрено;
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П в программе не допускается регулировка уровня воздействия на изображение
команды, создающей эффект, после ее выполнения;

D в подменю Transform (Преобразовать) CorelDRAW 12 отсутствует команда
Threshold (Порог), имеющаяся в Corel PHOTO-PAINT 12, хотя ее действие
можно смоделировать командой Black and White (1-bit) (Черно-белый
(1 бит)) подменю Mode (Режим) меню Bitmaps (Растровая графика);

П в CorelDRAW 12 отсутствуют следующие команды фильтрации, входящие
в состав Corel PHOTO-PAINT 12:

• четыре команды подменю 3D Effects (Трехмерные эффекты);

• одна команда подменю Art Strokes (Художественные штрихи);

• две команды подменю Blur (Размытие);

• три команды подменю Camera (Камера);

• четыре команды, составляющие подменю Custom (Заказные);

• две команды подменю Distort (Искажение);

• две команды подменю Noise (Шум);

• двенадцать команд, составляющие подменю Texture (Текстура).

Работа с командами создания эффектов в растровых изображениях выполняется
с помощью окна коррекции и эффектов (см. разд. "Диалоговые окна" гл. 2). На-
помним вам, что это окно характеризуется следующими двумя свойствами:

П возможностью перехода от одной команды создания эффекта или коррекции
к другой команде в режиме предварительного просмотра;

П тремя вариантами раскрытия окна (с одним или двумя окнами просмотра
или без них).

При настройке параметров команды вы можете контролировать свои действия
по виду результирующего изображения, находящегося в окне просмотра данного
окна или в самом документе.

Для обновления изображения в соответствии с новыми значениями параметров,
выполните одно из двух действий:

П после ввода новых значений параметров щелкните на кнопке Preview (Про-
смотр), расположенной в левом нижнем углу окна;

П перед выполнением операции настройки параметров нажмите кнопку с изо-
бражением замка, находящуюся справа от кнопки Preview, задав режим авто-
матического обновления изображения после очередного изменения парамет-
ров команды.

Подменю Transform
Подменю Transform (Преобразовать) меню Effects (Эффекты) включает три ко-
манды: Delnterlace, Invert и Posterize. Первая из них используется для коррек-
ции растровых изображений, а остальные две — для цветовой обработки изо-
бражений любых типов.
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Команда Delnterlace
Команда Delnterlace (Устранить дефекты видео) входит в подменю Transform
меню Effects. Допускает обработку изображений следующих цветовых форматов:
оттенков серого, CMYK, Lab и RGB.

Создает эффект коррекции четных или нечетных строк пикселов растрового
изображения. Такая коррекция может понадобиться для изображения, сфото-
графированного с экрана телевизора или монитора, у которого некоторые стро-
ки были утеряны из-за малого времени съемки.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Effects > Transform > Delnterlace (Эффекты t Преобразовать ^
Устранить дефекты видео), открыв окно коррекции и эффектов с параметра-
ми команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке командой предшествующего изображения, установите параметры по
умолчанию (кнопка Reset (Сброс)).

4. Выберите для коррекции четные или нечетные строки изображения с помо-
щью одного из двух переключателей, находящихся в левой части окна: Even
Lines (Четные строки) или Odd Lines (Нечетные строки).

5. Задайте способ коррекции с помощью одного из двух переключателей, рас-
положенных в правой части окна:

• Duplication (Удвоение строк) — выбранные строки заполняются содержи-
мым предшествующих строк;

• Interpolation (Интерполяция) — параметры пикселов текущей строки вы-
числяются путем усреднения параметров соответствующих пикселов со-
седних строк.

6. Щелкните на кнопке подтверждения ОК.

Команда Invert
Команда Invert (Инвертировать) входит в подменю Transform (Преобразовать)
меню Effects (Эффекты). Допускает обработку изображений следующих цвето-
вых форматов: черно-белый, оттенков серого, дуплексный, палитровых цветов,
CMYK, Lab и RGB.

Создает эффект инверсии изображения, состоящий в изменении исходных зна-
чений яркости пикселов канальных изображений (X) на дополнительные
(255—X). Вид изображения после обработки зависит от его цветового формата.
В частности, инвертированное изображение формата CMYK будет выглядеть
намного темнее, чем аналогичное изображение формата RGB. Параметры
команды отсутствуют.
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Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Effects > Transform > Invert (Эффекты > Преобразовать >
Инвертировать).

Команда Posterize
Команда Posterize (Постеризовать) входит в подменю Transform (Преобразовать)
меню Effects (Эффекты). Допускает обработку изображений следующих цветовых
форматов: оттенков серого, дуплексный, палитровых цветов, CMYK, Lab и RGB.

Создает эффект плакатной живописи, состоящий в ограничении количества
цветовых оттенков, используемых в изображении. Эффект формируется сле-
дующим образом: каждому пикселу изображения присваивается наиболее близ-
кое фиксированное значение (тоновый уровень). Для этого весь тоновый диапа-
зон изображения разбивается на заданное число равных поддиапазонов, каждый
из которых характеризует определенный тоновый уровень.

На рис. 5.22 показано диалоговое окно команды Posterize с параметрами, кото-
рые использовались при обработке изображения, представленного слева.

Level:

Reset OK Cancel Help

Рис. 5.22. Обрабатываемое изображение
и диалоговое окно команды Posterize

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Effects t Transform ^ Posterize (Эффекты > Преобразовать *
Постеризовать), открыв окно коррекции и эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Выберите число тоновых уровней в канальных изображениях, используя пол-
зунок Level (Уровень) (с диапазоном значений от 2 до 32).

5. Щелкните на кнопке подтверждения ОК.
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Подменю Correction
Подменю Correction (Коррекция) меню Effects (Эффекты) содержит всего одну
команду фильтрации, предназначенную для коррекции растровых изображений.

Команда Dust and Scratch
Команда фильтрации Dust and Scratch (Пылинки и царапины) входит в подме-
ню Correction меню Effects. Допускает обработку изображений следующих цве-
товых форматов: оттенков серого, CMYK, Lab и RGB.

Создает корректирующий эффект, состоящий в устранении изъянов в изобра-
жении типа пылинок и царапин путем раскраски бракованных пикселов цвета-
ми соседних пикселов.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Effects > Correction > Dust and Scratch (Эффекты > Кор-
рекция > Пылинки и царапины), открыв окно коррекции и эффектов с пара-
метрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Выберите максимальный размер пылинок и царапин, которые должны быть
устранены, используя ползунок Radius (Радиус) (с диапазоном значений
от I до 20 пикселов).

5. С помощью ползунка Threshold (Порог) (с диапазоном значений от 0 до 255)
отрегулируйте допустимую величину перепада уровня яркости в цветовых
каналах изображения для пылинок или царапин по отношению к окружаю-
щим пикселам.

6. Щелкните на кнопке подтверждения ОК.

Подменю 3D Effects
Подменю 3D Effects (Трехмерные эффекты) меню Bitmaps (Растровая графика)
включает семь команд фильтрации. Они предназначены для создания в растро-
вых изображениях художественных эффектов, имитирующих трансформацию
в пространстве подложки, на которой находится изображение.

Команда 3D Rotate
Команда фильтрации 3D Rotate (Трехмерное вращение) входит в подменю
3D Effects меню Bitmaps. Допускает обработку изображений следующих цве-
товых форматов: оттенков серого, дуплексный, палитровых цветов, CMYK,
Lab и RGB.
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Создает эффект видимости изображения, нанесенного на лицевую грань куба,
который повернули на некоторый угол в пространстве при сохранении положе-
ния его геометрического центра.

На рис. 5.23 показано диалоговое окно команды 3D Rotate с параметрами, ко-
торые использовались при обработке изображения, представленного слева.

•
Vertical: 9

Best fit

Horizontal: 14 "

Reset Cancel Help

Рис. 5.23. Обрабатываемое изображение и диалоговое окно команды 3D Rotate

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > 3D Effects > 3D Rotate (Растровая графика > Трех-
мерные эффекты * Трехмерное вращение), открыв окно коррекции и эффек-
тов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Задайте положение в пространстве лицевой грани куба, на которую нанесено
изображение. Используйте интерактивную управляющую конструкцию, на-
ходящуюся слева, или поля со счетчиками Vertical (По вертикали) и
Horizontal (По горизонтали).

5. Установите флажок Best fit (Наилучшее расположение), чтобы результирую-
щее изображение имело максимально возможный масштаб, находясь при
этом в области исходного изображения.

6. Щелкните на кнопке подтверждения ОК.

Команда Cylinder
Команда фильтрации Cylinder (Цилиндр) входит и подменю 3D Effects (Трех-
мерные эффекты) меню Bitmaps (Растровая графика). Допускает обработку изо-
бражений следующих цветовых форматов: оттенков серого, дуплексный, палит-
ровых цветов, CMYK, Lab и RGB.
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Создает эффект искривления изображения, которое нанесли на внутреннюю
или наружную поверхность цилиндра, расположенного горизонтально или вер-
тикально.

На рис. 5.24 показано диалоговое окно команды Cylinder с параметрами, кото-
рые использовались при обработке изображения, представленного слева.

' Cylinder Modes

••* Horizontal

'" Vertical

Percentage; \ ~ ,

Reset Cancel Help

Рис. 5.24. Обрабатываемое изображение и диалоговое окно команды Cylinder

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > 3D Effects > Cylinder (Растровая графика >
Трехмерные эффекты > Цилиндр), открыв окно коррекции и эффектов с па-
раметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Выберите требуемое положение цилиндра, на поверхность которого будет
нанесено изображение, используя один из двух переключателей: Horizontal
(Горизонтальное) или Vertical (Вертикальное).

5. С помощью ползунка Percentage (Процент) (с диапазоном значений от —100
до 100 %) задайте тип искажений и их уровень. При положительном значе-
нии данного параметра изображение наносится на наружную поверхность
цилиндра (искажение выпуклого типа), а при отрицательном — на внутрен-
нюю поверхность (искажение вогнутого типа).

6. Щелкните на кнопке подтверждения ОК.

Команда Emboss
Команда фильтрации Emboss (Рельеф) входит в подменю 3D Effects (Трехмер-
ные эффекты) меню Bitmaps (Растровая графика). Допускает обработку изобра-
жений следующих цветовых форматов: оттенков серого, CMYK, Lab и RGB.
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Создает эффект имитации рельефного изображения, изготовленного из метал-
лической пластины заданного цвета методом чеканки или штамповки.

На рис. 5.25 показано диалоговое окно команды Emboss с параметрами, которые
использовались при обработке изображения, представленного слева.

Depth: j

Level: |

Direction:

100

Emboss color —

. " Original color

• Gray

' " Black

'"" Other

Ш Reset Carcel Help

Рис. 5.25. Обрабатываемое изображение
и диалоговое окно команды Emboss

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > 3D Effects t Emboss (Растровая графика ••
Трехмерные эффекты * Рельеф), открыв окно коррекции и эффектов с пара-
метрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Выберите цвет раскраски металлической пластины с помощью одного из че-
тырех переключателей, находящихся справа:

• Original color — первоначальная раскраска изображения;

• Gray — серый цвет;

• Black — черный цвет;

• Other — произвольный цвет, выбираемый с помощью раскрывающегося
списка цветовых образцов или инструмента-пипетки.

5. Используя ползунок Level (Уровень) (с диапазоном значений от 1 до 500),
установите начальное значение уровня цветовой насыщенности контуров
рельефного изображения.

6. С помощью ползунка Depth (Глубина) (с диапазоном значений от 1 до 20)
выберите высоту рельефа поверхности изображения.
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7. Используя круговой ползунок Direction (Направление) (с диапазоном значе-
ний от 0° до 360°), задайте угол наклона лучей света, освещающих рельефное
изображение.

8. Отрегулируйте ползунок Level.

9. Щелкните на кнопке подтверждения ОК.

Команда Page Curl
Команда фильтрации Page Curl (Закручивание угла страницы) входит в подменю
3D Effects (Трехмерные эффекты) меню Bitmaps (Растровая графика). Допускает
обработку изображений следующих цветовых форматов: оттенков серого,
CMYK, Lab и RGB.

Создает эффект видимости изображения, нанесенного на лист бумаги, один из
углов которого скручен и имеет форму завитка.

На рис. 5.26 показано диалоговое окно команды Page Curl с параметрами, кото-
рые использовались при обработке изображения, представленного слева.

Рис, 5.26. Обрабатываемое изображение
и диалоговое окно команды Page Curl

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > 3D Effects > Page Curl (Растровая графика > Трех-
мерные эффекты > Закручивание угла страницы), открыв окно коррекции и
эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Укажите угол листа, который должен быть скручен (левый кнопочный пере-
ключатель на четыре положения).
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5. Задайте направление скручивания, используя один из двух переключателей
в области Direction (Направление): Vertical (Вертикальное) или Horizontal
(Горизонтальное).

6. Выберите сорт бумаги с помощью одного из двух переключателей в области
Paper (Бумага):

• Opaque — плотная бумага;

• Transparent — тонкая бумага, при которой сквозь скрученный угол про-
сматривается изображение.

7. Задайте цвет тыльной стороны бумаги (раскрывающийся список цветовых
образцов Curl (Завиток) и инструмент-пипетка справа от него).

8. Выберите цвет фона, видимого в области завитка (список цветовых образ-
цов Background (Фон) и инструмент-пипетка справа).

9. Используя ползунки Width (Ширина) и Height (Высота) (с диапазонами зна-
чений от I до 100 %), отрегулируйте ширину и высоту завитка.

10. Щелкните на кнопке подтверждения ОК.

Команда Perspective
Команда фильтрации Perspective (Перспектива) входит в подменю 3D Effects
(Трехмерные эффекты) меню Bitmaps (Растровая графика). Допускает обработку
изображений следующих цветовых форматов: оттенков серого, дуплексный, па-
литровых цветов, CMYK, Lab и RGB.

Создает два эффекта искажения изображения, вызванного трансформацией
подложки, на которой оно находится: "перспектива" и "наклон". Для эффекта
перспективы подложка принимает форму произвольного четырехугольника,
а для эффекта наклона — форму параллелограмма.

На рис. 5.27 показано диалоговое окно команды Perspective с параметрами, ко-
торые использовались при обработке изображения, представленного слева (эф-
фект перспективы).

Perspective

•Туре —

* Perspective

Shear

v Best fit

Reset Cancel Help

Рис. 5.27. Обрабатываемое изображение и диалоговое окно команды Perspective
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Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > 3D Effects t Perspective (Растровая графика >
Трехмерные эффекты * Перспектива), открыв окно коррекции и эффектов
с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Выберите название создаваемого эффекта искажения с помощью одного из
двух переключателей: Perspective (Перспектива) или Shear (Наклон).

5. Отрегулируйте положение маркеров интерактивной управляющей конструкции,
находящейся слева, задав с их помощью параметры искаженного изображения.

6. Установите флажок Best fit (Наилучшее расположение), обеспечив заполне-
ние результирующим изображением области исходного изображения по ши-
рине или высоте.

7. Щелкните на кнопке подтверждения ОК.

Команда Pinch/Punch
Команда фильтрации Pinch/Punch (Вдавить/Выдавить) входит в подменю
3D Effects (Трехмерные эффекты) меню Bitmaps (Растровая графика). Допускает
обработку изображений следующих цветовых форматов: оттенков серого, дуп-
лексный, палитровых цветов, CMYK, Lab и RGB.

Рис. 5.28. Диалоговое окно команды Pinch/Punch в развернутом состоянии
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Создает эффект искривления изображения, нанесенного на подложку, которую
покоробили, сделав вогнутой или выпуклой. Масштаб изображения увеличива-
ется или уменьшается по направлению к центру искажений, положение кото-
рого регулируется.

На рис. 5.28 представлено диалоговое окно команды Pinch/Punch, находящееся
в развернутом состоянии. Необходимость такого состояния окна вызвана тем,
что только в нем можно установить крестообразную метку центра искажений.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > 3D Effects > Pinch/Punch (Растровая графика >
Трехмерные эффекты * Вдавить/Выдавить), открыв окно коррекции и эф-
фектов с параметрами команды.

3. Если данное окно находится в свернутом состоянии, то откройте его полно-
стью, щелкнув на одной из двух кнопок, расположенных в левом верхнем уг-
лу. Это необходимо сделать для установки метки центра искажений.

4. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

5. Отметьте положение центра искажений. Для этого нажмите мышью кнопку
с крестиком и стрелкой, расположенную слева, установите указатель в нуж-
ном месте изображения, находящегося в окне просмотра (при двух окнах -
в левом окне), и щелкните мышью.

6. Используя ползунок Pinch/Punch (Вдавить/Выдавить) (с диапазоном значе-
ний от —100 до 100 %), задайте тип искажений и отрегулируйте их величину,
При положительном значении данного параметра искажения будут вогнутою
типа, а при отрицательном — выпуклого.

7. Щелкните на кнопке подтверждения ОК.

Команда Sphere
Команда фильтрации Sphere (Сфера) входит в подменю 3D Effects (Трехмерные
эффекты) меню Bitmaps (Растровая графика). Допускает обработку изображений
следующих цветовых форматов: оттенков серого, дуплексный, палитровых цве-
тов, CMYK, Lab и RGB.

Создает эффект искривления изображения, нанесенного на внутреннюю или
наружную поверхность сферы или эллипсоида. Масштаб изображения увеличи-
вается или уменьшается по направлению к центру искажений, положение кото-
рого регулируется. Данная команда отличается от команды Pinch/Punch (Вда-
вить/Выдавить) тем, что допускает большие искажения.

На рис. 5.29 представлено диалоговое окно команды Sphere, находящееся в раз-
вернутом состоянии. Необходимость такого состояния окна вызвана тем, что
только в нем можно установить крестообразную метку центра искажений.
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** Cancel Help

Рис. 5.29. Диалоговое окно команды Sphere в развернутом состоянии

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > 3D Effects > Sphere (Растровая графика >
Трехмерные эффекты » Сфера), открыв окно коррекции и эффектов с пара-
метрами команды.

3. Если данное окно находится в свернутом состоянии, то откройте его полно-
стью, щелкнув на одной из двух кнопок, расположенных в левом верхнем уг-
лу. Это необходимо сделать для установки метки центра искажений.

4. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

5. Отметьте положение центра искажений. Для этого нажмите кнопку с крести-
ком и стрелкой, расположенную справа, установите указатель в нужном месте
изображения, находящегося в окне просмотра, и щелкните кнопкой мыши.

6. Используя ползунок Percentage (Процент) (с диапазоном значений от —100
до 100 %), выберите тип искажений и отрегулируйте их величину. При по-
ложительном значении данного параметра искажения будут выпуклого типа,
а при отрицательном — вогнутого.

7. Щелкните на кнопке подтверждения ОК.
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Подменю Art Strokes
Подменю Art Strokes (Художественные штрихи) меню Bitmaps (Растровая гра-
фика) содержит 14 команд фильтрации. Они предназначены для создания в рас-
тровых изображениях художественных эффектов, имитирующих рисование
с использованием различных методов живописи и графики.

Команда Charcoal
Команда фильтрации Charcoal (Уголь) входит в подменю Art Strokes меню
Bitmaps. Допускает обработку изображений следующих цветовых форматов: от-
тенков серого, CMYK, Lab и RGB.

Создает эффект имитации черно-белого рисунка, сделанного куском угля на
серой бумаге.

На рис. 5.30 показано диалоговое окно команды Charcoal с параметрами, кото-
рые использовались при обработке изображения, представленного слева.

Рис. 5.30. Обрабатываемое изображение
и диалоговое окно команды Charcoal

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Art Strokes > Charcoal (Растровая графика >
Художественные штрихи > Уголь), открыв окно коррекции и эффектов с ш-
раметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунок Edge (Край) (с диапазоном значений от 1 до 10), выбе-
рите толщину линий обводки краев изображения, а также уровень черного
цвета в них.



340 Глава 5

5. С помощью ползунка Size (Размер) (с диапазоном значений от 0 до 10) от-
регулируйте степень прорисовки изображения в областях полутонов и теней.

6. Щелкните на кнопке подтверждения ОК.

Команда Conte Crayon
Команда фильтрации Conte. Crayon (Размножить карандаш) входит в подменю
Art Strokes (Художественные штрихи) меню Bitmaps (Растровая графика). До-
пускает обработку изображений следующих цветовых форматов: оттенков серо-
го, CMYK, Lab и RGB.

Создает эффект имитации цветного или полутонового штрихового рисунка,
сделанного цветными карандашами. Формирование полутонового рисунка про-
изводится выбранными карандашами, входящими в состав пяти стандартных
образцов.

На рис. 5.31 показано диалоговое окно команды Conte Crayon с параметрами,
которые использовались при обработке изображения, представленного слева.
В данном случае был создан цветной штриховой рисунок.

Рис. 5.31. Обрабатываемое изображение
и диалоговое окно команды Conte Crayon

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Art Strokes > Conte Crayon (Растровая графи-
ка > Художественные штрихи » Размножить карандаш), открыв окно коррек-
ции и эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Если вы будете формировать цветной рисунок, то снимите все флажки в об-
ласти Conte Colors (Цветные карандаши), а если полутоновый, то установите
флажки возле требуемых образцов цветов.



Обработка растровых изображений 341

5. Для полутонового рисунка выберите цвет бумаги, на которой он будет вы-
полняться, используя для этого раскрывающийся список цветовых образцов
Paper Color (Цвет бумаги) или инструмент-пипетку справа от него.

6. С помощью ползунка Pressure (Давление) (с диапазоном значений от 1
до 100) выберите толщину и плотность карандашных линий.

7. Используя ползунок Texture (Текстура) (с диапазоном значений от 0 до 101,
отрегулируйте степень прорисовки в изображении мелких деталей.

8. Щелкните на кнопке подтверждения ОК.

Команда Crayon
Команда фильтрации Crayon (Цветной карандаш) входит в подменю Art Strokes
(Художественные штрихи) меню Bitmaps (Растровая графика). Допускает обра-
ботку изображений следующих цветовых форматов: оттенков серого, CMYK,
Lab и RGB.

Создает эффект имитации рисунка, выполненного цветными мелками или мяг-
кими карандашами.

На рис. 5.32 показано диалоговое окно команды Crayon с параметрами, которые
использовались при обработке изображения, представленного слева.

Рис. 5.32. Обрабатываемое изображение и диалоговое окно команды Crayon

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Art Strokes > Crayon (Растровая графика *
Художественные штрихи > Цветной карандаш), открыв окно коррекции и
эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).
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4. С помощью ползунка Outline (Обводка) (с диапазоном значений от 0 до 50)
задайте толщину линий обводки краев изображения и уровень в них черного
цвета.

5. Используя ползунок Size (Размер) (с диапазоном значений от 1 до 20), отре-
гулируйте степень прорисовки в изображении неконтрастных участков.

6. Щелкните на кнопке подтверждения ОК.

Команда Cubist
Команда фильтрации Cubist (Кубист) входит в подменю Art Strokes (Художест-
венные штрихи) меню Bitmaps (Растровая графика). Допускает обработку изо-
бражений следующих цветовых форматов: оттенков серого, CMYK, Lab и RGB.

Создает эффект имитации изображения, нарисованного красками с использова-
нием техники кубизма. Результирующее изображение формируется из случай-
ных цветных фрагментов неправильной формы, промежутки между которыми
заполняются выбранным цветом. Раскраска этих фрагментов зависит от цвето-
вых оттенков пикселов исходного изображения.

На рис. 5.33 показано диалоговое окно команды Cubist с параметрами, которые
использовались при обработке изображения, представленного слева.

Reset •> Cancel Help

Рис. 5.33. Обрабатываемое изображение
и диалоговое окно команды Cubist

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Art Strokes * Cubist (Растровая графика >
Художественные штрихи > Кубист), открыв окно коррекции и эффектов с па-
раметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).
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4. Используя ползунок Size (Размер) (с диапазоном значений от 1 до 20), выбе-
рите размеры мазков, наносимых на холст кистью.

5. С помощью ползунка Brightness (Яркость) (с диапазоном значений от 1
до 100) отрегулируйте яркость изображения.

6. Выберите двет холста, на который будет наноситься изображение, используя
для этого раскрывающийся список цветовых образцов Paper Color (Цвет бу-
маги) или инструмент-пипетку справа от него.

7. Щелкните на кнопке подтверждения ОК.

Команда Impressionist
Команда фильтрации Impressionist (Импрессионист) входит в подменю Art
Strokes (Художественные штрихи) меню Bitmaps (Растровая графика). Допускает
обработку изображений следующих цветовых форматов: оттенков серого,
CMYK, Lab и RGB.

Создает эффект имитации изображения, нарисованного краской с использова-
нием техники живописи под названием импрессионизм.

На рис. 5.34 показано диалоговое окно команды Impressionist с параметрами,
которые использовались при обработке изображения, представленного слева.

Impressionist

tnj a,

г Style -

Strokes

Dabs

-Technique^

Dab Size:

Coloration:

Brightness: 50

Reset Help

Рис, 5.34. Обрабатываемое изображение
и диалоговое окно команды Impressionist

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Art Strokes > Impressionist (Растровая графика >
Художественные штрихи > Импрессионист), открыв окно коррекции и эф-
фектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).
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4. Выберите стиль рисования, активизировав один из двух переключателей, на-
ходящихся слева:

• Strokes (Штрихи) — стиль рисования небольшими штрихами со случай-
ными формой, раскраской, размерами и положением штрихов:

• Dabs (Мазки) — стиль рисования крупными мазками, имеющими мень-
ший разброс положения, чем для штрихов.

5. Используя ползунок Stroke (Штрих) (с диапазоном значений от 1 до 100) или
ползунок Dab Size (Размер мазка) (с диапазоном значений от 0 до 30), задай-
те средний размер штриха или мазка.

6. С помощью ползунка Coloration (Цветовой диапазон) (с диапазоном значе-
ний от 0 до 100) выберите диапазон возможного отклонения цвета раскраски
штриха (мазка) от цвета соответствующего пиксела исходного изображения.

7. Используя ползунок Brightness (Яркость) (с диапазоном значений от 1
до 100), отрегулируйте уровень яркости изображения.

8. Щелкните на кнопке подтверждения ОК.

Команда Palette Knife
Команда фильтрации Palette Knife (Шпатель) входит в подменю Art Strokes (Худо-
жественные штрихи) меню Bitmaps (Растровая графика). Допускает обработку изо-
бражений следующих цветовых форматов: оттенков серого, CMYK, Lab и RGB.

Создает эффект имитации изображения, нарисованного масляными красками
с использованием шпателя (нож, предназначенный для очистки холста от крас-
ки). Результирующее изображение формируется в виде нанесенных друг на
друга мазков густой краски, цвет и наклон которых определяется раскраской
исходного изображения.

На рис. 5.35 показано диалоговое окно команды Palette Knife с параметрами,
которые использовались при обработке изображения, представленного слева.

Palette Knife

BiadeSize;

Soft Edge;
Angle; _..

Рис. 5.35. Обрабатываемое изображение
и диалоговое окно команды Palette Knife
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Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Art Strokes > Palette Knife (Растровая графи-
ка > Художественные штрихи > Шпатель), открыв окно коррекции и эффек-
тов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунок Blade Size (Размер штриха) (с диапазоном значений от 1
до 50), выберите размер штриха, от которого зависит степень прорисовки
в изображении мелких деталей.

5. С помощью ползунка Soft Edge (Мягкость краски) (с диапазоном значений
от 0 до 10) задайте уровень затенения штрихов в изображении, зависящий
от мягкости краски, наносимой шпателем.

6. Отрегулируйте круговым ползунком Angle (Угол) (с диапазоном значений
от 0° до 360°) угол наклона лучей света, падающих на изображение.

7. Щелкните на кнопке подтверждения ОК.

Команда Pastels
Команда фильтрации Pastels (Пастель) входит в подменю Art Strokes (Художест-
венные штрихи) меню Bitmaps (Растровая графика). Допускает обработку изо-
бражений следующих цветовых форматов: оттенков серого, CMYK, Lab и RGB.

Создает эффект имитации рисунка, выполненного кистью путем нанесения на
бумагу небольших мазков пастельной краски.

На рис. 5.36 показано диалоговое окно команды Pastels с параметрами, которые
использовались при обработке изображения, представленного слепа.

Pastel Type

',• Soft
Stroke Size:

Hue Variation;

i Reset i Cancel He!p

Рис. 5.36. Обрабатываемое изображение
и диалоговое окно команды Pastels
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Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Art Strokes > Pastels (Растровая графика »
Художественные штрихи > Пастель), открыв окно коррекции и эффектов
с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Определите сорт бумаги, на которой будет рисоваться изображение, с помо-
щью одного из двух переключателей, находящихся слева:

• Soft (Мягкая) — обычная бумага, хорошо впитывающая мокрую краску
(пятна краски небольшие, э их цвет — насыщенный);

• Oil (Масло) — бумага, пропитанная маслом, на которой краска растекает-
ся во все стороны (пятна более крупные и размытые по краям, а их цвет
менее насыщен).

5. Используя ползунок Stroke Size (Размер штриха) (с диапазоном значений
от 1 до 20), задайте размеры мазков.

6. С помощью ползунка Hue Variation (Диапазон оттенков) (с диапазоном зна-
чений от 0 до 100) выберите цветовой диапазон, в котором будет варьиро-
ваться цвет мазка по отношению к цвету раскраски соответствующего пиксе-
ла исходного изображения.

7. Щелкните на кнопке подтверждения ОК.

Команда Pen and Ink
Команда фильтрации Pen and Ink (Перо и чернила) входит в подменю Art
Strokes (Художественные штрихи) меню Bitmaps (Растровая графика), Допускает
обработку изображений следующих цветовых форматов: оттенков серого,
CMYK, Lab и RGB.

Рис. 5.37. Обрабатываемое изображение и диалоговое окно команды Pen and Ink
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Создает эффект имитации графического изображения, нарисованного на белой
бумаге перьевой ручкой, смоченной в черной туши, с помощью техники рисо-
вания перекрестными штрихами или точками.

На рис. 5.37 показано диалоговое окно команды Pen and Ink с параметрами, ко-
торые использовались при обработке изображения, предсташшнного слева.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Art Strokes > Pen and Ink (Растровая графика >
Художественные штрихи ^ Перо и чернила), открыв окно коррекции и эф-
фектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. С помощью одного из двух переключателей, находящихся слева, выберите
стиль рисования:

• Crosshatch (Перекрестные штрихи) — стиль рисования перекрестными
штрихами;

• Stippling (Точки) — стиль рисования точками.

5. Используя ползунок Density (Плотность) (с диапазоном значений от I
до 100), выберите плотность расположения штриховых линий или точек в ре-
зультирующем изображении.

6. С помощью ползунка Ink Pools (Количество чернил) (с диапазоном значений
от 0 до 100) отрегулируйте толщину линий или точек.

7. Щелкните на кнопке подтверждения ОК.

Команда Pointillist
Команда фильтрации Pointillist (Пуантилист) входит в подменю Art Strokes
(Художественные штрихи) меню Bitmaps (Растровая графика). Допускает об-
работку изображений следующих цветовых форматов: оттенков серого, CMYK,
Lab и RGB.

Создает эффект имитации изображения, нарисованного красками с использо-
ванием известного метода живописи под названием пуантилизм. Результи-
рующее изображение формируется из отдельных фрагментов в форме крупны;
точек, которые раскрашиваются усредненными цветами пикселов исходного
изображения.

На рис. 5.38 показано диалоговое окно команды Pointillist с параметрами, кото-
рые использовались при обработке изображения, представленного слева.
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Рис. 5.38. Обрабатываемое изображение
и диалоговое окно команды Pointillist

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Art Strokes > Pointillist (Растровая графика >
Художественные штрихи > Пуантилист), открыв окно коррекции и эффектов
с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунок Size (Размер) (с диапазоном значений от I до 10), выбе-
рите размер точек, из которых будет сформировано изображение.

5. С помощью ползунка Brightness (Яркость) (с диапазоном значений от 1 до 100)
отрегулируйте уровень яркости изображения.

6. Щелкните на кнопке подтверждения ОК.

Команда Scraperboard
Команда фильтрации Scraperboard (Скребок) входит в подменю Art Strokes
(Художественные штрихи) меню Bitmaps (Растровая графика). Допускает об-
работку изображений следующих цветовых форматов: оттенков серого, CMYK,
Lab и RGB.

Создает два эффекта, первый из которых состоит в формировании изображения
путем снятия скребком слоя черной краски, нанесенного на исходное цветное
изображение, а второй — нанесенного на белое основание.

На рис. 5.39 показано диалоговое окно команды Scraperboard с параметрами,
которые использовались при обработке изображения, представленного слева.
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Рис. 5.39. Обрабатываемое изображение и диалоговое окно команды Scraperboard

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Art Strokes > Scraperboard (Растровая графика >
Художественные штрихи > Скребок), открыв окно коррекции и эффектов
с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. С помощью одного из двух переключателей, находящихся слева, выберите
эффект, который будет создаваться командой:

• Color (Цветное) — под слоем черной краски находится исходное цветное
изображение;

• White (Белое) — под слоем черной краски находится белое основание,

5. Используя ползунок Density (Плотность) (с диапазоном значений от 1 до 40),
задайте плотность царапин, наносимых скребком.

6. С помощью ползунка Size (Размер) (с диапазоном значений от 1 до 50) от-
регулируйте толщину царапин.

7. Щелкните на кнопке подтверждения ОК.

Команда Sketch Pad
Команда фильтрации Sketch Pad (Блокнот для эскизов) входит в подменю Art
Strokes (Художественные штрихи) меню Bitmaps (Растровая графика). Допускает
обработку изображений следующих цветовых форматов: оттенков серого,
CMYK, Lab и RGB.

Создает эффект имитации эскизного рисунка, выполненного черным каранда-
шом или цветными карандашами, который характеризуется прорисовкой мелких
деталей и выделением контурных линий.
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На рис. 5.40 показано диалоговое окно команды Sketch Pad с параметрами, ко-
торые использовались при обработке изображения, представленного слева.
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Рис. 5.40. Обрабатываемое изображение и диалоговое окно команды Sketch Pad

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Art Strokes t Sketch Pad (Растровая графика >
Художественные штрихи > Блокнот для эскизов), открыв окно коррекции и
эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Выберите тип карандашей, которыми будет выполняться рисунок, с помо-
щью одного из двух переключателей, находящихся слева: Graphite (Черный)
или Color (Цветные).

5. Используя ползунок Style (Стиль) (с диапазоном значений от 1 до 50), отре-
гулируйте качество рисунка.

6. С помощью ползунка Lead (Графит) для простого карандаша или ползунка
Pressure (Давление) для цветных карандашей (с диапазонами значений от 1
до 100) задайте уровень мягкосги грифелей.

7- Используя ползунок Outline (Контур) (с диапазоном значений от 0 до 100),
выберите толщину и насыщенность контурных линий в рисунке.

8. Щелкните на кнопке подтверждения ОК.

Команда Watercolor
Команда фильтрации Watercolor (Акварель) входит в подменю Art Strokes (Ху-
дожественные штрихи) меню Bitmaps (Растровая графика). Допускает обра-
ботку изображений следующих цветовых форматов: оттенков серого, CMYK,
Lab и RGB.
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Создает эффект имитации изображения, раскрашенного жидкими акварельными
красками, контуры которого были предварительно очерчены черной перьевой
ручкой. В обработанном изображении появляются небольшие пятна, выступаю-
щие за границы контуров, которые характерны для акварельного рисунка, вы-
полненного мокрой кистью.

На рис. 5.41 показано диалоговое окно команды Watercolor с параметрами, ко-
торые использовались при обработке изображения, представленного слева.
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Рис. 5.41. Обрабатываемое изображение и диалоговое окно команды Watercolor

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps» Art Strokes * Watercolor (Растровая графика >
Художественные штрихи > Акварель), открыв окно коррекции и эффектов
с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунок Brush Size (Размер кисти) (с диапазоном значений от I
до IO), выберите размер кисти, которой будет создан акварельный рисунок.

5. С помощью ползунка Granulation (Зернистость) (с диапазоном значений от I
до 100) задайте уровень зернистости бумаги.

6. Используя ползунок Water Amount (Количество воды) (с диапазоном значе-
ний от 1 до 100), отрегулируйте степень разбавленности краски водой.

1'. С помощью ползунка Bleed (Растекание) (с диапазоном значений от 1 до 100)
задайте уровень растекания краски по бумаге.

8. Используя ползунок Brightness (Яркость) (с диапазоном значений от 1 до
100), выберите яркость изображения.

9. Щелкните на кнопке подтверждения ОК.



352 Глава 5

Команда Water Marker
Команда фильтрации Water Marker (Водяной маркер) входит в подменю Art
Strokes (Художественные штрихи) меню Bitmaps (Растровая графика). Допускает
обработку изображений следующих цветовых форматов: оттенков серого,
CMYK, Lab и RGB.

Создает эффект имитации рисунка, выполненного акварельными красками пу-
тем нанесения на бумагу крупных мазков кисти.

На рис, 5.42 показано диалоговое окно команды Water Marker с параметрами,
которые использовались при обработке изображения, представленного слева.
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Рис. 5.42. Обрабатываемое изображение и диалоговое окно команды Water Marker

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Art Strokes > Water Marker (Растровая графи-
ка * Художественные штрихи > Водяной маркер), открыв окно коррекции и
эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Задайте способ формирования мазков с помощью одного из трех переключа-
телей, находящихся слева: Default (По умолчанию), Order (Упорядоченный)
или Random (Случайный).

5. Используя ползунок Size (Размер) (с диапазоном значений от 1 до 50), отре-
гулируйте размеры мазков, из которых состоит изображение.

6. С помощью ползунка Color Variation (Цветовой диапазон) (с диапазоном
значений от 1 до 50) задайте диапазон возможного отклонения цвета рас-
краски мазка от цвета соответствующего пиксела исходного изображения.

7. Щелкните на кнопке подтверждения ОК.
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Команда Wave Paper
Команда фильтрации Wave Paper (Шероховатая бумага) входит в подменю Art
Strokes (Художественные штрихи) меню Bitmaps (Растровая графика). Допускает
обработку изображений следующих цветовых форматов: оттенков серого,,
CMYK, Lab и RGB.

Создает эффект имитации рисунка, выполненного мягкими карандашами или
мелками (черным или цветными) на шероховатой белой бумаге.

На рис. 5.43 показано диалоговое окно команды Wave Paper с параметрами, ко-
торые использовались при обработке изображения, представленного слева.

Рис. 5.43. Обрабатываемое изображение
и диалоговое окно команды Wave Paper

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Art Strokes > Wave Paper (Растровая графика >
Художественные штрихи > Шероховатая бумага), открыв окно коррекции
и эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Выберите инструменты рисования с помощью одного из двух переключате-
лей, находящихся слева:

• Color (Цветной) — цветные карандаши;

• Black and White (Черно-белый) — простой карандаш.

5. Используя ползунок Brush Pressure (Нажим карандаша) (с диапазоном зна-
чений от 1 до 20), отрегулируйте нажим карандашей на бумагу.

6. Щелкните на кнопке подтверждения ОК.

12 Зак. 250
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Подменю Blur
Подменю Blur (Размытие) меню Bitmaps (Растровая графика) включает девять
команд фильтрации. Они предназначены для создания в растровых изображени-
ях эффектов, связанных с их коррекцией и размытием.

Команда Directional Smooth
Команда фильтрации Directional Smooth (Направленное сглаживание) входит
в подменю Blur меню Bitmaps. Допускает обработку изображений следующих
цветовых форматов: оттенков серого, CMYK, Lab и RGB.

Создает эффект размытия границ в изображении путем усреднения цветовых
параметров соседних пикселов. Чем больше эти пикселы отличаются между со-
бой по яркости или раскраске, тем сильнее они будут размыты.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Blur > Directional Smooth (Растровая графика >
Размытие » Направленное сглаживание), открыв окно коррекции и эффектов
с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунок Percentage (Процент) (с диапазоном значений от О
до 100 %), задайте уровень размытия изображения.

5. Щелкните на кнопке подтверждения ОК.

Команда Gaussian Blur
Команда фильтрации Gaussian Blur (По Гауссу) входит в подменю Blur (Размы-
тие) меню Bitmaps (Растровая графика). Допускает обработку изображений сле-
дующих цветовых форматов: оттенков серого, CMYK, Lab и RGB.

Создает эффект размытия изображения, в результате которого в нем снижается
уровень шума. В качестве функции усреднения используется кривая Гаусса, за-
дающая нормальный закон распределения.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Blur > Gaussian Blur (Растровая графика >
Размытие > По Гауссу), открыв окно коррекции и эффектов с параметрами
команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).
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4. С помощью ползунка Radius (Радиус) (с диапазоном значений от 0,1
до 250 пикселов) выберите число соседних пикселов, цветовые параметры
которых учитываются (с помощью кривой Гаусса) при вычислении парамет-
ров текущего пиксела. От этой величины напрямую зависит уровень размы-
тия изображения.

5. Щелкните на кнопке подтверждения ОК.

Команда Jaggy Despeckle
Команда фильтрации Jaggy Despeckle (Подчистка) входит в подменю Blur (Раз-
мытие) меню Bitmaps (Растровая графика). Допускает обработку изображений
следующих цветовых форматов: оттенков серого, дуплексный, палитровых цве-
тов, CMYK, Lab и RGB.

Создает эффект небольшого размытия изображения, приводящий к сглажива-
нию зубцов в контурных линиях. Допускается раздельная регулировка уровней
размытия изображения по горизонтали и вертикали.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Blur > Jaggy Despeckle (Растровая графика ¥
Размытие > Подчистка), открыв окно коррекции и эффектов с параметрами
команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Определитесь в отношении флажка Symmetric (Симметрия), при установке
которого задается режим ввода одинаковых значений для следующих по по-
рядку параметров.

5. Используя ползунки Width (Ширина) и Height (Высота) (с диапазонами значе-
ний от 1 до 5), выберите уровни размытия изображения по ширине и высоте.

6. Щелкните на кнопке подтверждения ОК.

Команда Low Pass
Команда фильтрации Low Pass (Края) входит в подменю Blur (Размытие) меню
Bitmaps (Растровая графика). Допускает обработку изображений следующих цветовых
форматов: оттенков серого, дуплексный, палитровых цветов, CMYK, Lab и RGB.

Создает эффект размытия, который сглаживает в изображении резкие края и
удаляет мелкие неоднородности.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Blur » Low Pass (Растровая графика » Размытие >
Края), открыв окно коррекции и эффектов с параметрами команды.
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3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. С помощью ползунка Radius (Радиус) (с диапазоном значений от 1 до
20 пикселов) выберите число соседних пикселов, параметры которых будут
учитываться при вычислении параметра текущего пиксела.

5. Используя ползунок Percentage (Процент) (с диапазоном значений от О
до 100 %), отрегулируйте уровень размытия изображения.

6. Щелкните на кнопке подтверждения ОК.

Команда Motion Blur
Команда фильтрации Motion Blur (Движением) входит в подменю Blur (Размы-
тие) меню Bitmaps (Растровая графика). Допускает обработку изображений сле-
дующих цветовых форматов: оттенков серого, CMYK, Lab и RGB.

Создает эффект размытия изображения путем усреднения в заданном направле-
нии цветовых параметров соседних пикселов. В результате возникает иллюзия
движения изображения в данном направлении.

На рис. 5.44 показано диалоговое окно команды Motion Blur с параметрами,
которые использовались при обработке изображения, представленного слева.

• Ignore pixels outside rnage

Г Use paper cdor

' Sample nearest edge pixet

Рис. 5.44. Обрабатываемое изображение и диалоговое окно команды Motion Blur

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Blur >• Motion Blur (Растровая графика >
Размытие t Движением), открыв окно коррекции и эффектов с параметрами
команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).
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4. С помошью ползунка Distance (Расстояние) (с диапазоном значений от 1 до
999 пикселов) задайте число соседних пикселов, цветовые параметры кото-
рых будут усреднены в выбранном направлении при определении параметра
текущего пиксела.

5. Задайте круговым ползунком Direction (Напрашгение) (с диапазоном значений
от 0° до 360°) направление, вдоль которого будет размываться изображение.

6. Задайте режим обработки краевых пикселов изображения с помощью одного
из трех переключателей, находящихся справа:

• Ignore pixels outside image (Игнорировать наружные пикселы) -
не учитывать пикселы, находящиеся снаружи от области исходного изо-
бражения;

• Use paper color (Использовать цвет подложки) — окрашивать краевые
пикселы цветом подложки;

• Sample nearest edge pixel (Использовать краевые пикселы) — учитывать
пикселы, примыкающие изнутри к краям области изображения.

7. Щелкните на кнопке подтверждения ОК.

Команда Radial Blur
Команда фильтрации Radial Blur (Радиальное) входит в подменю Blur (Размы-
тие) меню Bitmaps (Растровая графика). Допускает обработку изображений сле-
дующих цветовых форматов: оттенков серого, дуплексный, палитровых цветов,
CMYK, Lab и RGB.

Amount:

Reset OK Cancel Help

Рис. 5.45. Диалоговое окно команды Radial Blur в развернутом состоянии
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Создает эффект размытия изображения путем усреднения цветовых параметров
соседних пикселов, находящихся на одинаковом расстоянии от центра размы-
тия, положение которого регулируется. Уровень размытия пикселов возрастает
с увеличением расстояния до этого центра (в нем размытость отсутствует).

На рис. 5.45 показано диалоговое окно команды Radial Blur, находящееся в раз-
вернутом состоянии. Необходимость такого состояния окна вызвана тем, что
только в нем можно установить крестообразную метку центра размытия.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Blur > Radial Blur (Растровая графика >
Размытие > Радиальное), открыв окно коррекции и эффектов с параметрами
команды.

3. Если данное окно находится в свернутом состоянии, то откройте его полно-
стью, щелкнув на одной из двух кнопок, расположенных в левом верхнем уг-
лу. Это необходимо сделать для установки метки центра размытия.

4. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

5. Отметьте положение центра размытия. Для этого нажмите мышью кнопку
с крестиком и стрелкой, расположенную справа, установите указатель в нуж-
ном месте изображения, находящегося в окне просмотра (при двух окнах -
в левом окне), и щелкните мышью.

6. Используя ползунок Amount (Уровень) (с диапазоном значений от 1 до 100),
выберите уровень радиального размытия.

7. Щелкните на кнопке подтверждения ОК.

Команда Smooth
Команда фильтрации Smooth (Сглаживание) входит в подменю Blur (Размытие)
меню Bitmaps (Растровая графика). Допускает обработку изображений следую-
щих цветовых форматов: оттенков серого, CMYK, Lab и RGB.

Создает эффект небольшого размытия изображения путем усреднения цветовых
параметров соседних пикселов, что приводит к снижению уровня шума в изо-
бражении.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Blur > Smooth (Растровая графика * Размытие >
Сглаживание), открыв окно коррекции и эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).
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4. С помощью ползунка Percentage (Процент) (с диапазоном значений or О
до 100 %) выберите уровень размытия изображения.

5. Щелкните на кнопке подтверждения ОК.

Команда Soften
Команда фильтрации Soften (Смягчение) входит в подменю Blur (Размытие) ме-
ню Bitmaps (Растровая графика). Допускает обработку изображений следующих
цветовых форматов: оттенков серого, дуплексный, палитровых цветов, CMYK,
Lab и RGB.

Создает эффект небольшого размытия изображения, снижающий в нем уровень
шума.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Blur > Soften (Растровая графика > Размытие >
Смягчение), открыв окно коррекции и эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунок Percentage (Процент) (с диапазоном значений от 1
до 100 %), задайте уровень размытия изображения.

5. Щелкните на кнопке подтверждения ОК.

Команда Zoom
Команда фильтрации Zoom (Наплыв) входит в подменю Blur (Размытие) меню Bitmaps
(Растровая графика). Допускает обработку изображений следующих цветовых форма-
тов: оттенков серого, дуплексный, палитровых цветов, CMYK, Lab и RGB.

Создает эффект размытия изображения путем усреднения цветовых параметров
соседних пикселов, расположенных вдоль радиуса, исходящего из центра раз-
мытия, положение которого регулируется. Уровень размытия пикселов возраста-
ет с увеличением расстояния до этого центра (в нем размытость отсутствует).

На рис. 5.46 представлено диалоговое окно команды Zoom, находящееся в раз-
вернутом состоянии. Необходимость такого состояния окна вызвана тем, что
только в нем можно установить крестообразную метку центра размытия.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps v Blur > Zoom (Растровая графика > Размытие \>
Наплыв), открыв окно коррекции и эффектов с параметрами команды.

3. Если данное окно находится в свернутом состоянии, то откройте его полно-
стью, щелкнув на одной из двух кнопок, расположенных в левом верхнем уг-
лу. Это необходимо сделать для установки метки центра размытия.
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Amount:

Reset p| Cancel Heip

Рис. 5.46. Диалоговое окно команды Zoom в развернутом состоянии

4. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

5. Отметьте положение центра размытия. Для этого нажмите мышью кнопку
с крестиком и стрелкой, расположенную справа, установите указатель в нуж-
ном месте изображения, находящегося в окне просмотра (при двух окнах -
в левом окне), и щелкните мышью.

6. С помощью ползунка Amount (Уровень) (с диапазоном значений от 1 до 100)
выберите уровень размытия изображения.

7. Щелкните на кнопке подтверждения ОК.

Подменю Camera
Подменю Camera (Камера) меню Bitmaps (Растровая графика) содержит всего
одну команду фильтрации, предназначенную для коррекции растровых изобра-
жений.

Команда Diffuse
Команда фильтрации Diffuse (Диффузия) входит в подменю Camera меню
Bitmaps. Допускает обработку изображений следующих цветовых форматов: от-
тенков серого, CMYK, Lab и RGB.

Создает корректирующий эффект, состоящий в устранении в изображении шу-
ма за счет незначительного размытия его пикселов.
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Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Camera * Diffuse (Растровая графика * Камера >
Диффузия), открыв окно коррекции и эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунок Level (Уровень) (с диапазоном значений от 1 до 100),
задайте уровень размытия изображения.

5. Щелкните на кнопке подтверждения ОК.

Подменю Color Transform
Подменю Color Transform (Преобразование цвета) меню Bitmaps (Растровая гра-
фика) включает четыре команды фильтрации. Они предназначены для создания
в растровых изображениях художественных эффектов, связанных с их цветовой
обработкой.

Команда Bit Planes
Команда фильтрации Bit Planes (Градиентный анализ) входит в Подменю Color
Transform меню Bitmaps. Допускает обработку изображений следующих цветовых
форматов: оттенков серого, дуплексный, палитровых цветов, CMYK, Lab и RGB.

Создает следующий цветовой эффект. В каждом канальном изображении пиксе-
лам присваиваются минимальные или максимальные значения яркости в зави-
симости от того, в какой по порядку тоновый диапазон они попадают: четный
или нечетный. Разбивка на такие диапазоны производится в зависимости от па-
раметров настройки каналов, задаваемых пользователем. Чем меньше величина
параметра, относящегося к некоторому цветовому каналу, чем больше в этом
канале будет тоновых диапазонов.

На рис. 5.47 показано диалоговое окно команды Bit Planes с параметрами, кото-
рые использовались при обработке изображения, представленного слева.

V Apply to аВ planes

Reset OK Cancel Help

Рис. 5.47. Обрабатываемое изображение и диалоговое окно команды Bit Planes
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Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Color Transform > Bit Planes (Растровая графика >
Преобразование цвета > Градиентный анализ), открыв окно коррекции и эф-
фектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Определитесь в отношении флажка Apply to all planes (Применить ко всем
каналам), при установке которого задается режим ввода одинаковых значе-
ний для следующих по порядку параметров.

5. Используя ползунки Red (Красный), Green (Зеленый) и Blue (Синий)
(с диапазонами значений от 0 до 7), отрегулируйте число тоновых диапазонов
в каждом цветовом канале. Если изображение представлено в CMYK-формате,
то для него обработка производится в первых трех цветовых каначах.

6. Щелкните на кнопке подтверждения ОК.

Команда Halftone
Команда фильтрации Halftone (Полутона) входит в подменю Color Transform
(Преобразование цвета) меню Bitmaps (Растровая графика). Допускает обра-
ботку изображений следующих цветовых форматов: оттенков серого, CMYK,
Lab и RGB.

Создает эффект имитации цветного растрированного изображения, которое от-
личается от обычного типографского оттиска тем, что точки растра имеют на-
много большие размеры, чем при печати, и видны невооруженным глазом.

На рис. 5.48 показано диалоговое окно команды Halftone с параметрами, кото-
рые использова!тись при обработке изображения, представленного слева.

Рис. 5.48. Обрабатываемое изображение и диалоговое окно команды Halftone
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Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Color Transform > Halftone (Растровая графика >
Преобразование цвета > Полутона), открыв окно коррекции и эффектов
с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. С помощью ползунка Max dot radius (Максимальный радиус точки)
(с диапазоном значений от 2 до 10 пикселов) выберите максимальный размер
элемента растра.

5. Используя ползунки Cyan (Голубой), Magenta (Пурпурный). Yellow (Желтый)
и Black (Черный) (с диапазонами значений от 0° до 360°), задайте углы на-
клона растра во всех цветовых каналах.

6. Щелкните на кнопке подтверждения ОК.

Команда Psychedelic
Команда фильтрации Psychedelic (Психоделика) входит в подменю Color
Transform (Преобразование цвета) меню Bitmaps (Растровая графика). Допускает
обработку изображений следующих цветовых форматов: оттенков серого,
CMYK, Lab и RGB.

Создает эффект раскраски изображения и яркие и непредсказуемые цвета, кото-
рые варьируются в широких пределах в зависимости от одного параметра. В ос-
нове данного эффекта лежит тот же способ обработки канальных изображений,
что и для команды Bit Planes (Градиентный анализ).

На рис. 5.49 показано диалоговое окно команды Psychedelic с параметрами, ко-
торые использовались при обработке изображения, предсташтенного слева.

Рис. 5.49. Обрабатываемое изображение и диалоговое окно команды Psychedelic
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Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Color Transform » Psychedelic (Растровая графи-
ка > Преобразование цвета > Психоделика), открыв окно коррекции и эффек-
тов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. С помощью ползунка Level (Уровень) (с диапазоном значений от 0 до 255)
выберите число тоновых диапазонов, от которого зависит создаваемый цве-
товой эффект.

5. Щелкните на кнопке подтверждения ОК.

Команда Solarize
Команда фильтрации Solarize (Соляризация) входит в подменю Color Transform
(Преобразование цвета) меню Bitmaps (Растровая графика). Допускает обработку
изображений следующих цветовых форматов: оттенков серого, дуплексный, па-
литровых цветов, CMYK, Lab и RGB.

Создает эффект соляризации, возникающий при кратковременной засветке фо-
тографического изображения ярким светом в процессе его проявления.
Для каждого пиксела канального изображения исходная величина яркости (обо-
значим ее X) сохраняется, если она была меньше 128-ми, либо, в противном
случае, изменяется на дополнительную величину (255—X).

На рис. 5.50 показано диалоговое окно команды Solarize с параметрами, кото-
рые использовались при обработке изображения, представленного слева.

Level:

Reset OK Cancel Help

Рис. 5.50. Обрабатываемое изображение
и диалоговое окно команды Solarize
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Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Color Transform > Solarize (Растровая графи-
ка >• Преобразование цвета » Соляризация), открыв окно коррекции и эффек-
тов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунок Level (Уровень) (с диапазоном значений от 0 до 255),
выберите яркость результирующего изображения.

5. Щелкните на кнопке подтверждения ОК.

Подменю Contour
Подменю Contour (Контур) меню Bitmaps (Растровая графика) содержит три
команды фильтрации. Они предназначены для создания в растровых изображе-
ниях художественных эффектов, связанных с формированием контурных изо-
бражений.

Команда Edge Detect
Команда фильтрации Edge Detect (Определение краев) входит в подменю
Contour меню Bitmaps. Допускает обработку изображений следующих цветовых
форматов: оттенков серого, CMYK, Lab и RGB.

Выполняет обводку краев изображения тонкими цветными линиями и раскраску
однородных фоновых областей заданным фоновым цветом.

На рис, 5.51 показано диалоговое окно команды Edge Detect с параметрами,
которые использовались при обработке изображения, представленного слева.

Sensfrivity:

Other -г У

Cancel Help

Рис. 5.51. Обрабатываемое изображение
и диалоговое окно команды Edge Detect
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Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Contour > Edge Detect (Растровая графика >
Контур > Определение краев), открыв окно коррекции и эффектов с пара-
метрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Задайте цвет фона с помощью одного из трех переключателей, расположен-
ных в ряд:

• White (Белый) — белый цвет фона;

• Black (Черный) — черный цвет фона;

• Other (Другой) — произвольный цвет фона, выбираемый с помощью рас-
крывающегося списка цветовых образцов или инструмента-пипетки.

5. Используя ползунок Sensitivity (Чувствительность) (с диапазоном значений
от 1 до 10), выберите порог обнаружения краев в изображении, которые бу-
дут обводиться линиями.

6. Щелкните на кнопке подтверждения ОК.

Команда Find Edges
Команда фильтрации Find Edges (Поиск краев) входит в подменю Contour (Кон-
тур) меню Bitmaps (Растровая графика). Допускает обработку изображений сле-
дующих цветовых форматов: оттенков серого, дуплексный, палитровых цветов.
CMYK, Lab и RGB.

Создает эффект имитации рисунка, сделанного цветными карандашами на
кальке, которую наложили на исходное изображение с целью обводки его кон-
туров. В результате обработки изображения границы областей с близкими цве-
товыми оттенками обводятся линиями, раскрашенными усредненными насы-
щенными цветами.

Find Edges

tn s а ]

Edge Type: "* Soft Г Solid Level; 40 i

Reset Cancel | Help

Рис. 5.52. Обрабатываемое изображение и диалоговое окно команды Find Edges
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На рис. 5.52 показано диалоговое окно команды Find Edges с параметрами, ко-
торые использовались при обработке изображения, представленного слева.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Contour »Find Edges (Растровая графика *
Контур > Поиск краев), открыв окно коррекции и эффектов с параметрами
команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Задайте режим рисования контурных линий с помощью одного из двух пере-
ключателей:

• Soft (Мягкие) — режим рисования тонких и неконтрастных линий;

* Solid (Выделенные) — режим рисования толстых и насыщенных линий.

5. Используя ползунок Level (Уровень) (с диапазоном значений от I до 100),
выберите плотность линий в изображении и их цветовую насыщенность.

6. Щелкните на кнопке подтверждения ОК.

Команда Trace Contour
Команда фильтрации Trace Contour (Трассировка контура) входит в подменю
Contour (Контур) меню Bitmaps (Растровая графика). Допускает обработку изо-
бражений следующих цветовых форматов: оттенков серого, дуплексный, палит-
ровых цветов, CMYK, Lab и RGB.

Создает следующий эффект. Для каждого канального изображения очерчиваюг-
ся тонкие контурные линии вокруг областей, яркость пикселов которых выше
или ниже заданного порогового уровня, с последующим удалением исходного
содержимого этих областей. В результате совмещения цветовых каналов форми-
руется контурное изображение в виде разноцветных линий.

На рис. 5.53 показано диалоговое окно команды Trace Contour с параметрами,
которые использовались при обработке изображения, представленного слева.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Contour»Trace Contour (Растровая графи-
ка >• Контур} Трассировка контура), открыв окно коррекции и эффектов
с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).
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Рис. 5.53. Обрабатываемое изображение
и диалоговое окно команды Trace Contour

4. Задайте режим обводки с помощью одного из двух переключателей:

• Lower (Снизу) — обводка более темных областей по сравнению с порого-
вым значением яркости пикселов;

• Upper (Сверху) — обводка более светлых областей по сравнению с данным
пороговым значением.

5. Используя ползунок Level (Уровень) (с диапазоном значений от 1 до 100),
отрегулируйте пороговое значение яркости пикселов канальных изображе-
ний, в зависимости от которого выполняется обводка.

6. Щелкните на кнопке подтверждения ОК.

Подменю Creative
Подменю Creative (Формирование) меню Bitmaps (Растровая графика) включает
14 команд фильтрации. Они предназначены для создания в растровых изобра-
жениях художественных эффектов, имитирующих составление изображения из
отдельных элементов либо некоторое воздействие на изображение со стороны
пользователя.

Команда Crafts
Команда фильтрации Crafts (Плитки) входит в подменю Creative меню Bitmaps.
Допускает обработку изображений следующих цветовых форматов: оттенков се-
рого, дуплексный, палитровых цветов, CMYK, Lab и RGB.

Создает эффект формирования изображения из разноцветных мозаичных
элементов, имеющих заданные природу и форму (фигурок, шестеренок, шари-
ков и т. п.).

На рис. 5.54 показано диалоговое окно команды Crafts с параметрами, которые
использовались при обработке изображения, представленного слева.
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Рис. 5.54. Обрабатываемое изображение и диалоговое окно команды Crafts

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Creative t Crafts (Растровая графика > Форми-
рование > Плитки), открыв окно коррекции и эффектов с параметрами
команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Откройте список Style (Стиль) и выберите в нем тип мозаичных элементов,
из которых будет составляться изображение: Puzzle (Головоломка), Gears
(Шестеренки), Marbles (Мраморные шарики), Candy (Леденцы), Ceramic Tile
(Керамические плитки) или Poker Chips (Фишки для покера).

5. Используя ползунок Size (Размер) (с диапазоном значений от 1 до 40), задай-
те размер этих элементов.

6. С помощью ползунка Complete (Заполнение) (с диапазоном значений от О
до 100 %) выберите коэффициент заполнения данными элементами области
формирования изображения, имеющей черный фон.

7. Используя ползунок Brightness (Яркость) (с диапазоном значений от 1
до 100), отрегулируйте яркость мозаичных элементов.

8. Задайте круговым ползунком Rotation (Поворот) (с диапазоном значений
от 0е до 360°) угол разворота мозаичных элементов.

9. Щелкните на кнопке подтверждения ОК.

Команда Crystalize
Команда фильтрации Crystalize (Кристаллы) входит в подменю Creative (Фор-
мирование) меню Bitmaps (Растровая графика). Допускает обработку изображе-
ний следующих цветовых форматов: оттенков серого, дуплексный, палитровых
цветов, CMYK, Lab и RGB.
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Создает эффект видимости кристалла с разноцветными гранями, напоминаю-
щего исходное изображение. Грани кристалла представляют собой многоуголь-
ники близких размеров, параметры которых варьируются случайным образом.

На рис. 5.55 показано диалоговое окно команды Crystalize с параметрами, кото-
рые использовались при обработке изображения, представленного слева.

Рис. 5.55. Обрабатываемое изображение и диалоговое окно команды Crystalize

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Creative > Crystalize (Растровая графика »
Формирование > Кристаллы), открыв окно коррекции и эффектов с парамет-
рами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунок Size (Размер) (с диапазоном значений от 1 до 100), вы-
берите размер цветных многоугольников, из которых формируется результи-
рующее изображение.

5. Щелкните на кнопке подтверждения ОК.

Команда Fabric
Команда фильтрации Fabric (Ткань) входит в подменю Creative (Формирование)
меню Bitmaps (Растровая графика). Допускает обработку изображений следую-
щих цветовых форматов: оттенков серого, дуплексный, палитровых цветов.
CMYK, Lab и RGB.

Создает эффект формирования изображения из отдельных элементов ткани
(заплат, шнурков, лент и т. п.) или вышивки.

На рис. 5.56 показано диалоговое окно команды Fabric с параметрами, которые
использовались при обработке изображения, представленного слева.
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Рис. 5.56. Обрабатываемое изображение и диалоговое окно команды Fabric

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Creative V Fabric (Растровая графика *
Формирование > Ткань), открыв окно коррекции и эффектов с параметрами
команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Откройте список Style (Стиль) и выберите в нем название ткани, из образцов
которой будет составляться изображение: Needlepoint (Вышивка), Rug
Hooking (Коврик из заплат), Quilt (Стеганое одеяло), Strings (Шнурки),
Ribbons (Ленты) или Tissue Collage (Лоскутки ткани).

5. С помощью ползунка Size (Размер) (с диапазоном значений от 1 до 50) за-
дайте размер одного образца ткани.

6. Используя ползунок Complete (Заполнение) (с диапазоном значений от 0 до
100 %), выберите коэффициент заполнения образцами ткани области форми-
рования изображения, имеющей черный фон.

7. С помощью ползунка Brightness (Яркость) (с диапазоном значений от 1
до 100) отрегулируйте яркость результирующего изображения.

8. Задайте круговым ползунком Rotation (Поворот) (с диапазоном значений
от 0е до 360°) угол разворота образцов ткани.

9. Щелкните на кнопке подтверждения ОК.

Команда Frame
Команда фильтрации Frame (Рамка) входит в подменю Creative (Формирование)
меню Bitmaps (Растровая графика). Допускает обработку изображений следую-
щих цветовых форматов: оттенков серого, дуплексный, палитровых цветов,
CMYK, Lab и RGB.
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Помещает обрабатываемое изображение в рамку, изображение которой хранится
в выбранном файле, а параметры регулируются пользователем.

На рис. 5.57 показано диалоговое окно команды Frame с параметрами, которые
использовались при обработке изображения, представленного слева.
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Рис. 5.57. Обрабатываемое изображение и диалоговое окно команды Frame

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps » Creative > Frame (Растровая графика > Форми-
рование > Рамка), открыв окно коррекции и эффектов с параметрами
команды.

3. Если вам необходимо сместить центр рамки по отношению к центру обраба-
тываемого изображения и данное окно находится в свернутом состоянии, то
откройте его полностью. Для этого щелкните на одной из двух кнопок, нахо-
дящихся в левом верхнем углу.

4. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

5. Выберите в списке Presets (Заготовки) внизу окна стиль оформления рамки,
который будет использован в качестве базового. Если данный стиль вас пол-
ностью устраивает, завершите на этом работу, щелкнув на кнопке подтвер-
ждения ОК, в противном случае перейдите к следующему шагу инструкции.

6. На вкладке Select (Выбор) окна команды выберите в списке подключенных
файлов с изображениями рамок нужный файл (поле Select Frame), отобразив
выбранную рамку в окне просмотра слева. Если требуемый файл в списке
отсутствует, загрузите его с помощью кнопки со значком изогнутой стрелки.
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7. На вкладке Modify (Изменение) настройте те параметры рамки, которые вам
необходимы:

• цвет рамки, используя раскрывающийся список цветовых образцов Color
(Цвет) и инструмент-пипетку справа от него;

• уровень непрозрачности рамки, используя ползунок Opacity (Непрозрач-
ность) (с диапазоном значений от 0 до 100 %);

• уровень размытости краев рамки, применяя ползунок Blur/Feather (Раз-
мытость) (с диапазоном значений от 0 до 100 %);

• один из трех режимов смещения цветов рамки и исходного изображения:
Normal (Обычный), Add (Добавление) или Multiply (Умножение), исполь-
зуя список Blend (Смешение);

• размеры внутренней области рамки, используя ползунки Horizontal
(По горизонтали) и Vertical (По вертикали) (с диапазонами значений от 1
до 140);

• угол наклона рамки, используя круговой ползунок Rotate (Поворот)
(с диапазоном значений от 0° до 360°);

• режим зеркального разворота рамки, используя две кнопки Flip (Разворот):;

• положение центра рамки, для чего необходимо нажать мышью кнопку
Align (Переместить центр) и установить крестообразную метку центра
рамки в нужном месте изображения, находящемся в окне просмотра.

8. Если вы собираетесь использовать выбранные параметры в дальнейшем, со-
храните их в качестве нового стиля оформления рамки (кнопка со знаком
"+" внизу справа).

9. Щелкните на кнопке подтверждения ОК.

Команда Glass Block
Команда фильтрации Glass Block (Рифленое стекло) входит в подменю Creative
(Формирование) меню Bitmaps (Растровая графика). Допускает обработку изо-
бражений следующих цветовых форматов: оттенков серого, дуплексный, палит-
ровых цветов, CMYK, Lab и RGB.

Создает эффект видимости изображения сквозь толстое рифленое стекло, состоя-
щее из прямоугольных блоков с различными коэффициентами преломления.

На рис. 5.58 показано диалоговое окно команды Glass Block с параметрами, ко-
торые использовались при обработке изображения, представленного слева.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Creative > Glass Block (Растровая графика >
Формирование > Рифленое стекло), открыв окно коррекции и эффектов
с параметрами команды.
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Рис. 5.58. Обрабатываемое изображение и диалоговое окно команды Glass Block

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунки Block width (Ширина блока) и Block height (Высота бло-
ка) (с диапазонами значений от I до 100), задайте ширину и высоту стеклян-
ных блоков.

5. Щелкните на кнопке подтверждения ОК.

Команда Kid's Play
Команда фильтрации Kid's Play (Игры) входит в подменю Creative (Формирова-
ние) меню Bitmaps (Растровая графика). Допускает обработку изображений сле-
дующих цветовых форматов: оттенков серого, дуплексный, палитровых цветов.
CMYK, Lab и RGB.

Создает эффект имитации изображения, составленного из элементов детского
конструктора или нарисованного ребенком.

Рис. 5.59. Обрабатываемое изображение и диалоговое окно команды Kid's Play
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На рис. 5.59 показано диалоговое окно команды Kid's Play с параметрами, кото-
рые использовались при обработке изображения, представленного слева.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Creative > Kid's Play (Растровая графика >
Формирование > Игры), открыв окно коррекции и эффектов с параметрами
команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Выберите в списке Game (Игра) один из четырех способов создания изобра-
жения: Lite Pegs (Колышки), Building Blocks (Кубики), Finger Paint (Палеи
в краске) или Paint By Numbers (Раскраска).

5. С помощью ползунка Size (Размер) (сдиапазоном значений от 1 до 25) за-
дайте размер мозаичных элементов для первых трех эффектов или величину
управляющего параметра для четвертого эффекта.

6. Для первых трех эффектов выберите следующие параметры:

• коэффициент заполнения элементами области формирования изображе-
ния, используя ползунок Complete (Заполнение) (с диапазоном значений
от 0 до 100 %);

* угол разворота элементов, применив круговой ползунок Rotation (Пово-
рот) (с диапазоном значений от 0° до 360°).

7. С помощью ползунка Brightness (Яркость) (с диапазоном значений от 1
до 100) отрегулируйте яркость результирующего изображения.

8. Щелкните на кнопке подтверждения ОК.

Команда Mosaic
Команда фильтрации Mosaic (Мозаика) входит в подменю Creative (Формиро-
вание) меню Bitmaps (Растровая графика). Допускает обработку изображений
следующих цветовых форматов: оттенков серого, дуплексный, палитровых цве-
тов, CMYK, Lab и RGB.

Создает эффект формирования изображения из небольших квадратных кусочков
цветного стекла с неровными гранями, которые уложили на плоском основании
заданного цвета.

На рис. 5.60 показано диалоговое окно команды Mosaic с параметрами, которые
использовались при обработке изображения, представленного слева.
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Рис. 5.60. Обрабатываемое изображение и диалоговое окно команды Mosaic

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Creative > Mosaic (Растровая графика >
Формирование k Мозаика), открыв окно коррекции и эффектов с парамет-
рами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунок Size (Размер) (с диапазоном значений от 1 до 20), задай-
те размер мозаичных элементов.

5. Выберите цвет фона, используя для этого раскрывающийся список цветовых
образцов Background Color (Цвет фона) или инструмент-пипетку справа от
него.

6. Если вам необходимо сформировать рамку овальной формы, цвет которой
совпадает с фоновым, установите флажок Vignette (Виньетка).

7. Щелкните на кнопке подтверждения ОК.

Команда Particles
Команда фильтрации Particles (Частицы) входит в подменю Creative (Формиро-
вание) меню Bitmaps (Растровая графика). Допускает обработку изображений
следующих цветовых форматов: отгенков серого, дуплексный, палитровых цве-
тов, CMYK, Lab и RGB.

Создает эффект наложения на изображение разноцветных звездочек или пу-
зырьков, параметры которых регулируются.

На рис. 5.61 показано диалоговое окно команды Particles с параметрами, кото-
рые использовались при обработке изображения, представленного слева.
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Рис. 5.61. Обрабатываемое изображение
и диалоговое окно команды Particles

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Creative »Particles (Растровая графика t
Формирование > Частицы), открыв окно коррекции и эффектов с параметра-
ми команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Задайте тип элементов наложения с помощью одного из двух переключате-
лей, находящихся слева: Stars (Звездочки) или Bubbles (Пузырьки).

5. Настройте параметров элементов наложения заданного типа:

• размер элемента, используя ползунок Size (Размер) (с диапазоном значе-
ний от 1 до 20);

• плотность расположения элементов в области изображения, применив
ползунок Density (Плотность) (с диапазоном значений от 1 до 5);

• цветовой диапазон, в котором случайным образом выбирается раскраска
элементов, с помощью ползунка Coloration (Цветовой диапазон)
(с диапазоном значений от 0 до 100);

• уровень прозрачности, используя ползунок Transparency (Прозрачность)
(с диапазоном значений от 0 до 100),

6. С помощью кругового ползунка Angle (Угол) (с диапазоном значений от 0°
до 360°) отрегулируйте угол наклона лучей света, освещающих изображение,
покрытое слоем звездочек или пузырьков.

7. Щелкните на кнопке подтверждения ОК.
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Команда Scatter
Команда фильтрации Scatter (Разброс) входит в подменю Creative (Формирова-
ние) меню Bitmaps (Растровая графика). Допускает обработку изображений сле-
дующих цветовых форматов: оттенков серого, дуплексный, палитровых цветов,
CMYK, Lab и RGB.

Создает эффект видимости изображения сквозь тонкое стекло, имеющее шеро-
ховатую поверхность. Данный эффект формируется путем случайного смещения
пикселов изображения относительно своего исходного положения.

На рис. 5.62 показано диалоговое окно команды Scatter с параметрами, которые
использовались при обработке изображения, представленного слева.

Рис. 5.62. Обрабатываемое изображение и диалоговое окно команды Scatter

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Creative > Scatter (Растровая графика >
Формирование ^ Разброс), открыв окно коррекции и эффектов с параметра-
ми команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунки Horizontal (По горизонтали) и Vertical (По вертикали)
(с диапазонами значений от 1 до 100), задайте диапазоны случайного смеще-
ния пикселов изображения по горизонтали и вертикали.

5. Щелкните на кнопке подтверждения ОК.

Команда Smoked Glass
Команда фильтрации Smoked Grass (Дымчатое стекло) входит в подменю
Creative (Формирование) меню Bitmaps (Растровая графика). Допускает обра-
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ботку изображений следующих цветовых форматов: оттенков серого, дуплекс-
ный, палитровых цветов, CMYK, Lab и RGB.

Создает эффект видимости изображения сквозь цветное стекло, окраску, про-
зрачность и рассеивание которого можно регулировать.

На рис. 5.63 показано диалоговое окно команды Smoked Glass с параметрами,
которые использовались при обработке изображения, представленного слева.

Рис. 5.63. Обрабатываемое изображение
и диалоговое окно команды Smoked Glass

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Creative * Smoked Glass (Растровая графи-
ка * Формирование » Дымчатое стекло), открыв окно коррекции и эффектов
с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Задайте цвет стекла, используя для этого раскрывающийся список цветовых
образцов Color (Цвет) или инструмент-пипетку справа от него.

5. С помощью ползунка Tint (Оттенок) (с диапазоном значений от 0 до 300)
выберите уровень непрозрачности стекла.

6. Используя ползунок Blurring (Размытость) (с диапазоном значений от 0 до 100),
отрегулируйте уровень размытия изображения.

7. Щелкните на кнопке подтверждения ОК.

Команда Stained Glass
Команда фильтрации Stained Glass (Витраж) входит в подменю Creative (Фор-
мирование) меню Bitmaps (Растровая графика). Допускает обработку изображений
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следующих цветовых форматов: оттенков серого, дуплексный, палитровых цве-
тов, CMYK, Lab и RGB.

Создает эффект имитации витража, представляющего собой изображение, со-
ставленное из небольших фрагментов цветных стекол, которое наблюдается на
просвет.

На рис. 5.64 показано диалоговое окно команды Stained Glass с параметрами,
которые использовались при обработке изображения, представленного слева.

Light Intensity: |
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Рис. 5.64. Обрабатываемое изображение и диалоговое окно команды Stained Glass

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Creative > Stained Glass (Растровая графи-
ка > Формирование > Витраж), открыв окно коррекции и эффектов с пара-
метрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунок Size (Размер) (с диапазоном значений от I до 100), вы-
берите размер мозаичных элементов.

5. Задайте толщину швов между элементами (поле Solder Width).

6. Выберите цвет швов, используя для этого раскрывающийся список цветовых
образцов Solder Color (Цвет шва) или инструмент-пипетку.

7. С помощью ползунка Light Intensity (Интенсивность света) (с диапазоном
значений от 0 до 10) отрегулируйте яркость источника, которым подсвечива-
ется изображение.

S. Если необходимо создать эффект рельефности витража, установите флажок
3D Lighting (Объемное освещение).

9. Щелкните на кнопке подтверждения ОК.
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Команда Vignette
Команда фильтрации Vignette (Виньетка) входит в подменю Creative (Формиро-
вание) меню Bitmaps (Растровая графика). Допускает обработку изображений
следующих цветовых форматов: оттенков серого, CMYK, Lab и RGB.

Создает эффект наложения на изображение рамки выбранной стандартной
формы, цвет и параметры которой можно регулировать.

На рис. 5.65 показано диалоговое окно команды Vignette с параметрами, кото-
рые использовались при обработке изображения, представленного слева.
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Рис. 5.65. Обрабатываемое изображение и диалоговое окно команды Vignette

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Creative > Vignette (Растровая графика >
Формирование »• Виньетка), открыв окно коррекции и эффектов с парамет-
рами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

Выберите цвет рамки с помощью одного из трех переключателей, находя-
щихся в области Color (Цвет):

• Black — черный цвет;

• White — белый цвет;

• Other — произвольный цвет, выбираемый с помощью раскрывающегося
списка цветовых образцов или инструмента-пипетки.

5. Задайте форму рамки, используя один из четырех переключателей, находя-
щихся в области Shape (Форма): Ellipse (Эллипс), Circle (Круг), Rectangle
(Прямоугольник) или Square (Квадрат).

6. С помощью ползунка Offset (Смещение) (с диапазоном значений от 0 до 14(3)
выберите размеры внутренней области рамки.

I
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7. Используя ползунок Fade (Размытость) (с диапазоном значений от 0 до 100),
отрегулируйте уровень размытости краев рамки.

8. Щелкните на кнопке подтверждения ОК.

Команда Vortex
Команда фильтрации Vortex (Вихрь) входит в подменю Creative (Формирование)
меню Bitmaps (Растровая графика). Допускает обработку изображений следую-
щих цветовых форматов: оттенков серого, дуплексный, палитровых цветов,
CMYK, Lab и RGB.

Создает эффект имитации изображения, которое размазали мокрой кистью, пе-
ремешаемой по круговым траекториям относительно некоторого центра, вы-
бранного пользователем.

На рис. 5.66 представлено диалоговое окно команды Vortex, находящееся в раз-
вернутом состоянии. Необходимость такого состояния окна вызвана тем, что
только в нем можно установить крестообразную метку центра искажений.

Style; Inner Direction: 180

Outer Direction; v*-- l 180

Рис. 5.66. Диалоговое окно команды Vortex в развернутом состоянии

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Creative > Vortex (Растровая графика >
Формирование > Вихрь), открыв окно коррекции и эффектов с параметрами
команды.
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3. Если данное окно находится в свернутом состоянии, то откройте его полно-
стью, шелкнув на одной из двух кнопок, расположенных в левом верхнем уг-
лу. Это необходимо сделать для установки метки центра искажений.

4. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

5. Отметьте положение центра искажений. Для этого нажмите мышью кнопку
с крестиком и стрелкой, расположенную слева, установите указатель в нуж-
ном месте изображения, находящегося в окне просмотра (при двух окнах -
в левом окне), и щелкните мышью,

6. Выберите в списке Style (Стиль) размер кисти и форму наносимых ею маз-
ков, которые задаются с помощью следующих четырех пунктов: Brushed
(Размазанные), Layered (Прослойками), Thick (Толстые) и Thin (Тонкие),

7. Используя ползунок Size (Размер) (с диапазоном значений от 1 до 50), отрегу-
лируйте величину мазков, определяющих уровень искажений в изображении.

8. С помощью круговых ползунков Inner Direction (Внутреннее направление) и
Outer Direction (Наружное направление) (с диапазонами значений от 0е

до 360°) задайте направления перемещения пикселов изображения в ближней
и дальней областях изображения по отношению к центру искажений.

9. Щелкните на кнопке подтверждения ОК.

Команда Weather
Команда фильтрации Weather (Погода) входит в подменю Creative (Формирова-
ние) меню Bitmaps (Растровая графика). Допускает обработку изображений сле-
дующих цветовых форматов: оттенков серого, дуплексный, палитропых цветов,
CMYK, Lab и RGB.

Создает эффект видимости изображения сквозь слой снега, дождя или тумана.

На рис. 5.67 показано диалоговое окно команды Weather с параметрами, кото-
рые использовались при обработке изображения, представленного слева.

< Ж _ _ _ _ - Cancel I help

Рис. 5.67. Обрабатываемое изображение и диалоговое окно команды Weather
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Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Creative > Weather (Растровая графика >
Формирование > Погода), открыв окно коррекции и эффектов с параметрами
команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Задайте вид осадков с помощью одного из трех переключателей, находящих-
ся слева: Snow (Снег), Rain (Дождь) или Fog (Туман).

5. Используя ползунок Strength (Интенсивность) (с диапазоном значений от 1
до 100), выберите интенсивность осадков.

6. С помощью ползунка Size (Размер) (с диапазоном значений от 1 до 10) за-
дайте минимальный размер элемента осадков.

7. Для осадков в виде дождя укажите направление, под которым капли дождя
падают на изображение, используя для этого круговой ползунок Direction
(Направление) (с диапазоном значений от 0е до 360°).

8. Выберите устраивающий вас вариант обработки изображения (кнопка
Randomize).

9. Щелкните на кнопке подтверждения ОК.

Подменю Distort
Подменю Distort (Искажение) меню Bitmaps (Растровая графика) содержит
10 команд фильтрации. Они предназначены для создания в растровых изобра-
жениях художественных эффектов, имитирующих различные варианты искаже-
ния изображения.

Команда Blocks
Команда фильтрации Blocks (Блоки) входит в подменю Distort меню Bitmaps.
Допускает обработку изображений следующих цветовых форматов: оттенков се-
рого, дуплексный, палитровых цветов, CMYK, Lab и RGB.

Создает следующий эффект. Изображение разбивается на прямоугольные блоки
заданных размеров, которые случайным образом смещаются друг относительно
друга. При этом промежутки между блоками заполняются выбранным цветом
или исходным изображением.

На рис. 5.68 показано диалоговое окно команды Blocks с параметрами, которые
использовались при обработке изображения, представленного слева.
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Рис. 5,68. Обрабатываемое изображение
и диалоговое окно команды Blocks

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Distort > Blocks (Растровая графика > Искажение >
Блоки), открыв окно коррекции и эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Выберите в списке Undefined Areas (Освободившиеся области) вариант рас-
краски промежутков между прямоугольными блоками:

• Original Image (Исходное изображение) — промежутки заполняются ис-
ходным изображением;

• Inverse Image (Инверсное изображение) — промежутки заполняются ин-
вертированным исходным изображением;

• Black (Черный) — черный цвет раскраски промежутков;

• White (Белый) — белый цвет раскраски;

• Other (Другой) — произвольный цвет раскраски, выбираемый с помощью
раскрывающегося списка цветовых образцов или инструмента-пипетки.

5. Используя ползунки Block width (Ширина блока) и Block height (Высота бло-
ка) (с диапазонами значений от 1 до 100), задайте ширину и высоту блоков.

6. С помощью ползунка Max. Offset (Максимальное смещение) (с диапазоном
значений от 0 до 100 %} выберите допустимую величину относительного
смещения блоков.

7. Щелкните на кнопке подтверждения ОК.

133ак. 250
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Команда Displace
Команда фильтрации Displace (Замещение) входит в подменю Distort (Искаже-
ние) меню Bitmaps (Растровая графика). Допускает обработку изображений сле-
дующих цветовых форматов: оттенков серого, дуплексный, палитровых цветов,
CMYK, Lab и RGB.

Создает эффект искажения изображения путем смещения его пикселов на вели-
чину, определяемую в зависимости от параметров пикселов выбранного допол-
нительного изображения, называемого схемой искривления. В качестве такой
схемы может использоваться любое растровое изображение, хранящееся в файле
и имеющее цветовой формат оттенков серого, RGB или CMYK.

На рис. 5.69 показано диалоговое окно команды Displace с параметрами, кото-
рые использовались при обработке изображения, представленного слева.

pScalemode [ Undefined areas
(* Tile "Repeat Edges
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Рис. 5.69. Обрабатываемое изображение
и диалоговое окно команды Displace

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Distort > Displace (Растровая графика >
Искажение > Замещение), открыв окно коррекции и эффектов с параметрами
команды.

3. Загрузите требуемый файл со схемой искривления, используя для этого рас-
крывающийся список и кнопку со значком изогнутой стрелки, находящиеся
внизу справа. В папке Custom Date\ Displace, вложенной в основную папку
CorelDRAW 12. находится десять файлов схем искривления (с расширением
рсх), входящих в состав программы.

4. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).
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5. Задайте режим наложения схемы искривления на обрабатываемое изображе-
ние с помощью одного из двух переключателей, находящихся слева:

• Tile (Мозаика) — данное изображение покрывается мозаичным набором,
составленным из исходного изображения схемы искривления;

• Stretch to fit (Подогнать масштаб) — обрабатываемое изображение покры-
вается одним масштабированным изображением схемы искривления.

6. Выберите в списке Undefined areas (Освободившиеся области) режим обра-
ботки краевых областей изображения:

• Repeat Edges (Повторить края) — краевые области изображения заполня-
ются копиями граничных пикселов;

• Wrap Around (Вставить отсеченные фрагменты) — данные области запол-
няются пикселами, которые вышли за пределы изображения с противопо-
ложного края.

7. Используя ползунки Horizontal (По горизонтали) и Vertical (По вертикали)
(с диапазонами значений от 0 до 100), отрегулируйте уровни искажений по
горизонтали и вертикали.

8. Щелкните на кнопке подтверждения ОК.

Команда Offset
Команда фильтрации Offset (Смещение) входит в подменю Distort (Искажение)
меню Bitmaps (Растровая графика). Допускает обработку изображений следую-
щих цветовых форматов: оттенков серого, дуплексный, палитровых цветов,
CMYK, Lab и RGB.

Создает эффект смещения пикселов изображения по горизонтали и вертикали
на заданные относительные величины. Предусмотрен выбор различных вариан-
тов заполнения тех областей изображения, которые освободились в результате
смещения его пикселов.

На рис. 5.70 показано диалоговое окно команды Offset с параметрами, которые
использовались при обработке изображения, представленного слева.
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Рис. 5.70. Обрабатываемое изображение и диалоговое окно команды Offset
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Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Distort > Offset (Растровая графика > Искажение >
Смещение), открыв окно коррекции и эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Выберите в списке Undefined Areas (Освободившиеся области) режим запол-
нения свободных областей изображения:

• Wrap Around (Вставить отсеченные фрагменты) — освободившиеся облас-
ти изображения заполняются пикселами, которые вышли за пределы изо-
бражения с противоположного края;

• Repeat Edges (Повторить края) — данные области заполняются копиями
граничных пикселов;

• Color (Цвет) — указанные области раскрашиваются цветом, выбор кото-
рого производится с помощью списка цветовых образцов или инструмента-
пипетки.

5. Если вам необходимо задать величины смещения пикселов изображения
в относительных единицах, установите флажок Shift value as % of dimensions
(В относительных единицах).

6. Используя ползунки Horizontal (По горизонтали) и Vertical (По вертикали)
(с диапазонами значений от —100 до 100), выберите величины смещения
пикселов изображения по горизонтали и вертикали.

7. Щелкните на кнопке подтверждения ОК.

Команда Pixelate
Команда фильтрации Pixelate (Пикселизация) входит в подменю Distort (Иска-
жение) меню Bitmaps (Растровая графика). Допускает обработку изображений
следующих цветовых форматов: оттенков серого, CMYK, Lab и RGB.

Создает эффект формирования изображения из мозаичных элементов заданных
размеров в форме квадратов, прямоугольников или сегментов концентрических
колец. Эти элементы раскрашиваются усредненными цветами пикселов исходного
изображения и с выбранным уровнем непрозрачности накладываются на него.

На рис. 5.71 показано диалоговое окно команды Pixelate с параметрами, кото-
рые использовались при обработке изображения, представленного слева.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps У Distort > Pixelate (Растровая графика »
Искажение * Пикселизация), открыв окно коррекции и эффектов с парамет-
рами команды.
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Рис. 5.71. Обрабатываемое изображение и диалоговое окно команды Pixelate

3. Если вы собираетесь формировать результирующее изображение из элемен-
тов радиальной формы, центр которых должен быть смещен относительно
центра изображения, и при этом окно команды находится в свернутом со-
стоянии, то откройте его полностью. Это необходимо сделать для установки
метки указанного центра.

4. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

5. Задайте форму мозаичных элементов с помощью одного из трех переключа-
телей, находящихся слева:

• Square — квадратная форма элементов;

• Rectangular — прямоугольная форма элементов;

• Radial — радиальная форма элементов, имеющих вид сегментов концен-
трических колец.

6. Для элементов радиальной формы задайте положение центра их формирова-
ния. Для этого нажмите мышью кнопку с крестиком и стрелкой, расположен-
ную слева, установите указатель в нужном месте изображения, находящегося
в окне просмотра (при двух окнах — в левом окне), и щелкните мышью.
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1. Используя ползунки Width (Ширина) и Height (Высота) (с диапазонами зна-
чений от 1 до 100), задайте размеры мозаичных элементов.

8. С помощью ползунка Opacity (%) (Непрозрачность) (с диапазоном значений
от 1 до 100 %) отрегулируйте уровень непрозрачности этих элементов.

9. Щелкните на кнопке подтверждения ОК.

Команда Ripple
Команда фильтрации Ripple (Рябь) входит в подменю Distort (Искажение) меню
Bitmaps (Растровая графика). Допускает обработку изображений следующих цве-
товых форматов: оттенков серого, дуплексный, палитровых цветов, CMYK, Lab
и RGB.

Создает эффект видимости изображения сквозь толщу воды, на поверхности
которой имеются волны, идущие в одном или двух перпендикулярных направ-
лениях. Параметры этих волн регулируются в широких пределах.

На рис. 5.72 показано диалоговое окно команды Ripple с параметрами, которые
использовались при обработке изображения, представленного слева.

Рис. 5.72. Обрабатываемое изображение и диалоговое окно команды Ripple

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Distort > Ripple (Растровая графика > Искажение >
Рябь), открыв окно коррекции и эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).
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4. Определитесь в отношении того, чему отдать предпочтение: скорости обра-
ботки изображения (переключатель Speed) или качеству полученного ре-
зультата (переключатель Quality).

5. С помощью кругового ползунка Angle (Угол) (с диапазоном значений от 0°
до 360°) задайте угол наклона осей, вдоль которых формируются волны.

6. Используя ползунок Period (Период) (с диапазоном значений от 1 до 100),
выберите период волн.

7. С помощью первого по порядку ползунка Amplitude (Амплитуда) (с диапазо-
ном значений от 1 до 100) отрегулируйте амплитуду основной волны.

8. Если вы хотите создать вспомогательную волну, перпендикулярную основ-
ной, установите флажок Perpendicular Wave (Перпендикулярная волна) и за-
дайте амплитуду волны с помощью второго ползунка Amplitude (с диапазо-
ном значений от 1 до 100).

9. Определитесь в отношении флажка Distort ripple (Исказить рябь), при уста-
новке которого форма волн будет отличной от синусоиды.

10. Щелкните на кнопке подтверждения ОК.

Команда Swirl
Команда фильтрации Swirl (Завихрение) входит в подменю Distort (Искажение)
меню Bitmaps (Растровая графика). Допускает обработку изображений следую-
щих цветовых форматов: оттенков серого, дуплексный, палитровых цветов,
CMYK, Lab и RGB.

Создает эффект смещения пикселов изображения по концентрическим окруж-
ностям в заданном направлении относительно центра, положение которого ре-
гулируется. Угол поворота воображаемого радиуса, соединяющего перемещае-
мый пиксел с центром искажений, уменьшается с увеличением данного радиуса
и становится нулевым на границах изображения.

На рис. 5.73 показано диалоговое окно команды Swirl, находящееся в разверну-
том состоянии. Необходимость такого состояния окна вызвана тем, что только
в нем можно установить крестообразную метку центра смещения пикселов изо-
бражения.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Distort > Swirl (Растровая графика > Искажение >
Завихрение), открыв окно коррекции и эффектов с параметрами команды.

3. Если данное окно находится в свернутом состоянии, то откройте его полно-
стью, щелкнув на одной из двух кнопок, расположенных в левом верхнем уг-
лу. Это необходимо сделать для установки метки центра искажений.

4. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).
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-Direction--

> Clockwise

: Counter-Clockwise

Reset OK Cancel Help

Рис. 5.73. Диалоговое окно команды Swirl в развернутом состоянии

5. Определитесь в отношении того, чему отдать предпочтение: скорости обра-
ботки изображения (переключатель Speed) или качеству полученного резуль-
тата (переключатель Quality).

6. Задайте направление смещения пикселов изображения с помощью одного из
двух переключателей, находящихся слева: Clockwise (По часовой стрелке) или
Counter-Clockwise (В обратном направлении).

7. Отметьте положение центра искажений. Для этого нажмите мышью кнопку
с крестиком и стрелкой, расположенную слева, установите указатель в нуж-
ном месте изображения, находящегося в окне просмотра (при двух окнах -
в левом окне), и щелкните мышью.

8. Используя ползунок Whole Rotations (Целые обороты) (с диапазоном значе-
ний от 0 до 10) и ползунок Additional Degrees (Дополнительный поворот)
(с диапазоном значений от 0° до 359°), задайте угол поворота пикселов изо-
бражения, находящихся в непосредственной близости от центра искажений.

9. Щелкните на кнопке подтверждения ОК.
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Команда Tile
Команда фильтрации Tile (Мозаика) входит в подменю Distort (Искажение) ме-
ню Bitmaps (Растровая графика). Допускает обработку изображений следующих
цветовых форматов: оттенков серого, дуплексный, палитровых цветов, CMYK,
Lab и RGB.

Создает эффект заполнения области исходного изображения мозаичным узором,
составленным из заданного количества уменьшенных копий данного изображе-
ния (элементов мозаики). Допускается частичное перекрытие этих элементов,
которое возникает при их одновременном смешении по диагонали и увеличении
масштаба.

На рис. 5.74 показано диалоговое окно команды Tile с параметрами, которые
использовались при обработке изображения, представленного слева.

Horizontal tiles: |

Vertical tiles: |

Overlap (%): i

Reset 01 Cancel Help

Рис. 5.74. Обрабатываемое изображение и диалоговое окно команды Tile

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Distort > Tile (Растровая графика >
Искажение > Мозаика), открыв окно коррекции и эффектов с параметрами
команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунки Horizontal tiles (По горизонтали) и Vertical tiles
(По вертикали) (с диапазонами значений от 1 до 100), задайте число элемен-
тов мозаичного узора по горизонтали и вертикали.

5. С помощью ползунка Overlap (Перекрытие) (с диапазоном значений от 0 до
50 %) выберите относительную величину перекрытия данных элементов.

6. Щелкните на кнопке подтверждения ОК.
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Команда Wet Paint
Команда фильтрации Wet Paint (Жидкая краска) входит в подменю Distort (Ис-
кажение) меню Bitmaps (Растровая графика). Допускает обработку изображений
следующих цветовых форматов: оттенков серого, CMYK, Lab и RGB.

Создает эффект имитации в изображении подтеков мокрой краски, возникших
из-за того, что только что нарисованное изображение поставили вертикально.

f^ Примечание

Недостаток этой команды состоит в том, что в результате ее использования
происходит значительное смещение вверх обработанного изображения
(в предыдущих версиях программы CorelDRAW этот недостаток отсутствовал).

На рис. 5.75 показано диалоговое окно команды Wet Paint с параметрами, кото-
рые использовались при обработке изображения, представленного слева.

Рис. 5.75. Обрабатываемое изображение и диалоговое окно команды Wet Paint

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Distort > Wet Paint (Растровая графика >
Искажение > Жидкая краска), открыв окно коррекции и эффектов с пара-
метрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунок Wetness (Влажность) (с диапазоном значений от —50
до 50), отрегулируйте уровень влажности краски и ее тон.

5. С помощью ползунка Percent (Процент) (с диапазоном значений от 1
до 100 %) выберите величину подтеков в изображении краски, имеющей за-
данный уровень влажности.

6. Щелкните на кнопке подтверждения ОК.
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Команда Whirlpool
Команда фильтрации Whirlpool (Ворс) входит в подменю Distort (Искажение)
меню Bitmaps (Растровая графика). Допускает обработку изображений следую-
щих цветовых форматов: оттенков серого, дуплексный, палитровых цветов,
CMYK, Lab и RGB.

Создает необычный художественный эффект, который возникает в только что
нарисованном изображении при незначительном размазывании его каждого
участка с помощью вращательных движений кисти.

На рис. 5.76 показано диалоговое окно команды Whirlpool с параметрами, кото-
рые использовались при обработке изображения, представленного слева.

Рис. 5.76. Обрабатываемое изображение и диалоговое окно команды Whirlpool

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Distort » Whirlpool (Растровая графика >
Искажение > Ворс), открыв окно коррекции и эффектов с параметрами ко-
манды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Выберите в списке Style (Стиль) стиль оформления эффекта. Если данный
стиль вас полностью устраивает, завершите работу, щелкнув на кнопке под-
тверждения ОК, в противном случае перейдите к следующему шагу инструкции.

5. Выберите следующие параметры:

• промежутки между завитками, используя ползунок Spacing (Интервал)
(с диапазоном значений от 5 до 200);

• размер завитков, применяя ползунок Smear Length (Размер пятен)
(с диапазоном значений от 3 до 300);
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• форму завитков, используя ползунок Twist (Скручивание) (с диапазоном
значений от 0 до 90);

• уровень черного цвета в завитках, с помощью ползунка Streak Detail
(Прожилки) (с диапазоном значений от 0 до 100).

6. Если необходимо задать режим искривления краев в изображении, установи-
те флажок Warp (Искривление).

7. Если вы собираетесь использовать текущие параметры в дальнейшем, сохра-
ните их в качестве нового стиля оформления эффекта (кнопка со знаком "+"
справа).

8. Щелкните на кнопке подтверждения ОК.

Команда Wind
Команда фильтрации Wind (Ветер) входит в подменю Distort (Искажение) меню
Bitmaps (Растровая графика). Допускает обработку изображений следующих цве-
товых форматов: оттенков серого, дуплексный, палитровых цветов, CMYK, Lab
и RGB.

Создает эффект видимости изображения, подверженного воздействию порывов
ветра, которые отображаются в виде бликов от пролетающих частиц пыли.

На рис. 5.77 показано диалоговое окно команды Wind с параметрами, которые
использовались при обработке изображения, представленного слева.

Рис. 5.77. Обрабатываемое изображение и диалоговое окно команды Wind

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Distort > Wind (Растровая графика > Искажение >
Ветер), открыв окно коррекции и эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).
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4. Используя ползунок Strength (Сила ветра) (с диапазоном значений от О
до 100), задайте интенсивность бликов и их величину.

5. С помощью ползунка Opacity (Непрозрачность) (с диапазоном значений от 1
до 100) выберите уровень непрозрачности бликов.

6. Отрегулируйте угол наклона бликов круговым ползунком Angle (Угол)
(с диапазоном значений от 0е до 360°).

7. Щелкните на кнопке подтверждения ОК.

Подменю Noise
Подменю Noise (Шум) меню Bitmaps (Растровая графика) включает шесть ко-
манд фильтрации. Они предназначены для создания в растровых изображениях
эффектов, связанных с устранением или добавлением мелких неоднородностей
в виде зерен или шума.

Команда Add Noise
Команда фильтрации Add Noise (Добавить шум) входит в подменю Noise меню
Bitmaps. Допускает обработку изображений следующих цветовых форматов: от-
тенков серого, CMYK, Lab и RGB.

Создает эффект зернистости фотопленки или фотобумаги, используемой при
печати изображения. Эффект формируется за счет случайного изменения ярко-
сти или раскраски отдельных пикселов исходного изображения.

На рис. 5.78 показано диалоговое окно команды Add Noise с параметрами, кото-
рые использовались при обработке изображения, представленного слева.

Level:

Density: p i i i | j =

Color mode ~

'> Intensity ' Random

Reset Help

Рис. 5.78. Обрабатываемое изображение и диалоговое окно команды Add Noise

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Noise vAdd Noise (Растровая графика > Шум >
Добавить шум), открыв окно коррекции и эффектов с параметрами команды.
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3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Задайте функцию распределения, используемую при формировании элемен-
тов шума, с помошью одного из трех переключателей, находящихся слева:

• Gaussian (По Гауссу), задающий нормальный закон распределения;

• Spike (Выбросы), определяющий режим формирования элементов, суще-
ственно отличающихся по яркости от окружающих пикселов;

• Uniform (Равномерное), задающий равномерный закон распределения.

5. Выберите режим формирования элементов шума с помощью одного из трех
переключателей, расположенных в ряд:

• Intensity (Интенсивность) — изменением яркости пикселов изображения,
относящихся к элементам шума;

• Random (Случайно) — случайным выбором цвета раскраски элементов
шума;

• Single (В один цвет) — выбором цвета раскраски элементов шума в рас-
крывающемся списке цветовых образцов или с помощью инструмента-
пипетки.

6. Используя ползунок Level (Уровень) (с диапазоном значений от 0 до 100),
отрегулируйте уровень контрастности элементов шума.

7. С помощью ползунка Density (Плотность) (с диапазоном значений от О
до 100) задайте плотность элементов шума.

8. Щелкните на кнопке подтверждения ОК.

Команда Maximum
Команда фильтрации Maximum (Максимум) входит в подменю Noise (Шум) ме-
ню Bitmaps (Растровая графика). Допускает обработку изображений следующих
цветовых форматов: оттенков серого, CMYK, Lab и RGB.

Создает эффект повышения яркости пикселов изображения во всех его цвето-
вых каналах. Результирующее изображение становится более светлым и размы-
тым, чем исходное, при этом из него удаляется шум в виде небольших темных
пятнышек, находящихся на светлом фоне.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Noise * Maximum (Растровая графика > Шум >
Максимум), открыв окно коррекции и эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).
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4. Используя ползунок Radius (Радиус) (с диапазоном значений от 1 до 20 пик-
селов), задайте ширину зоны увеличения светлых областей в канальных изо-
бражениях.

5. С помощью ползунка Percentage (Процент) (с диапазоном значений от 1
до 100 %) выберите уровень осветления изображения.

6. Щелкните на кнопке подтверждения ОК.

Команда Median
Команда фильтрации Median (Медиана) входит в подменю Noise (Шум) меню
Bitmaps (Растровая графика). Допускает обработку изображений следующих цве-
товых форматов: оттенков серого, CMYK, Lab и RGB.

Создает эффект размытия изображения и устранения в нем шума путем усред-
нения цветов раскраски соседних пикселов.

На рис. 5.79 показано диалоговое окно команды Median с параметрами, которые
использовались при обработке изображения, представленного слева.

Рис. 5.79. Обрабатываемое изображение и диалоговое окно команды Median

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps k Noise ^ Median (Растровая графика > Шум >
Медиана), открыв окно коррекции и эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунок Radius (Радиус) (с диапазоном значений от 1 до
20 пикселов), отрегулируйте размеры фрагментов изображения, цветовые па-
раметры которых будут усреднены.

5. Щелкните на кнопке подтверждения ОК.
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Команда Minimum
Команда фильтрации Minimum (Минимум) входит в подменю Noise (Шум) меню
Bitmaps (Растровая графика). Допускает обработку изображений следующих цве-
товых форматов: оттенков серого, CMYK, Lab и RGB.

Создает эффект уменьшения яркости пикселов изображения во всех его цвето-
вых каналах. Результирующее изображение становится более темным и размы-
тым, при этом из него удаляется шум в виде небольших светлых пятнышек, на-
ходящихся на темном фоне.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps » Noise » Minimum (Растровая графика > Шум V
Минимум), открыв окно коррекции и эффектов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунок Radius (Радиус) (с диапазоном значений от 1
до 20 пикселов), задайте ширину зоны увеличения темных областей в ка-
нальных изображениях.

5. С помощью ползунка Percentage (Процент) (с диапазоном значений от 1
до 100 %) выберите уровень затемнения изображения.

6. Щелкните на кнопке подтверждения ОК.

Команда Remove Moire
Команда фильтрации Remove Moire (Удалить муар) входит в подменю Noise
(Шум) меню Bitmaps (Растровая графика). Допускает обработку изображений
следующих цветовых форматов: оттенков серого, CMYK, Lab и RGB.

Создает корректирующий эффект, состоящий в устранении паразитного растро-
вого узора (муара). Такой узор возникает при растровой печати из-за смещения
печатных форм или неправильно выбранных углов наклона растра.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Noise > Remove Moire (Растровая графика >
Шум » Удалить муар), открыв окно коррекции и эффектов с параметрами
команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Укажите требуемое качество обработки изображения, выбрав один из двух
переключателей: Speed (Скорость) или Quality (Качество).
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5. Используя ползунок Amount (Уровень) (с диапазоном значений от 0 до 10),
задайте уровень воздействия команды на изображение.

6. Выберите размеры результирующего изображения, указав в поле Output (Вы-
ход) его разрешение.

7. Щелкните на кнопке подтверждения ОК.

Команда Remove Noise
Команда фильтрации Remove Noise (Удалить шум) входит в подменю Noise
(Шум) меню Bitmaps (Растровая графика). Допускает обработку изображений
следующих цветовых форматов: оттенков серого, CMYK, Lab и RGB.

Создает корректирующий эффект, состоящий в удалении шума из изображения
без существенного увеличения его размытости.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Noise ^ Remove Noise (Растровая графика »
Шум » Удалить шум), открыв окно коррекции и эффектов с параметрами
команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, щелкните на кнопке Reset (Сброс),
установив параметры по умолчанию (при этом будет установлен флажок Auto
(Авто)).

4. Если качество коррекции изображения, заданное по умолчанию, вас не уст-
раивает, снимите флажок Auto и с помощью ползунка Threshold (Порог)
(с диапазоном значений от 0 до 255) задайте допустимую величину перепада
уровня яркости в цветовых каналах изображения для элементов шума, при
которой шум будет устраняться.

5. Щелкните на кнопке подтверждения ОК.

Подменю Sharpen
Подменю Sharpen (Резкость) меню Bitmaps (Растровая графика) содержит пять
команд фильтрации. Они предназначены для создания в растровых изображени-
ях эффектов, связанных с повышением в них резкости.

Команда Adaptive Unsharp
Команда фильтрации Adaptive Unsharp (Адаптивная резкость) входит в подменю
Sharpen меню Bitmaps. Допускает обработку изображений следующих цветовых
форматов: оттенков серого, дуплексный, палитровых цветов, CMYK, Lab и RGB.

Создает эффект повышения резкости на краях изображения за счет увеличения
контрастности тех его пикселов, которые существенно отличаются от соседних
по раскраске или яркости.
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Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Sharpen * Adaptive Un sharp (Растровая графика >
Резкость > Адаптивная резкость), открыв окно коррекции и эффектов с па-
раметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунок Percentage (Процент) (с диапазоном значений от 1
до 100 %), задайте уровень повышения резкости по краям контрастных уча-
стков изображения.

5. Щелкните на кнопке подтверждения ОК.

Команда Directional Sharpen
Команда фильтрации Directional Sharpen (Направленная резкость) входит в под-
меню Sharpen (Резкость) меню Bitmaps (Растровая графика). Допускает обработ-
ку изображений следующих цветовых форматов: оттенков серого, дуплексный,
палитровых цветов, CMYK, Lab и RGB.

Создает эффект повышения резкости контрастных участков изображения.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Sharpen > Directional Sharpen (Растровая гра-
фика > Резкость > Направленная резкость), открыв окно коррекции и эффек-
тов с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. С помощью ползунка Percentage (Процент) (с диапазоном значений от О
до 100 %} задайте уровень повышения резкости по краям контрастных участ-
ков изображения.

5. Щелкните на кнопке подтверждения ОК.

Команда High Pass
Команда фильтрации High Pass (Удаление мелких деталей) входит в подменю
Sharpen (Резкость) меню Bitmaps (Растровая графика). Допускает обработку
изображений следующих цветовых форматов: оттенков серого, дуплексный, па-
литровых цветов, CMYK, Lab и RGB.

Создает эффект выделения контрастных участков изображения путем покрытия
всего изображения серым цветом при одновременном повышении яркости его
приграничных пикселов.
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Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Sharpen > High Pass (Растровая графика >
Резкость > Удаление мелких деталей), открыв окно коррекции и эффектов
с параметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предыдущего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунок Radius (Радиус) (с диапазоном значений от 1 до
20 пикселов), выберите ширину приграничных участков, для которых будет
повышена яркость пикселов.

5. С помощью ползунка Percentage (Процент) (с диапазоном значений от 1
до 100 %) отрегулируйте уровень затенения изображения серым цветом.

6. Щелкните на кнопке подтверждения ОК.

Команда Sharpen
Команда фильтрации Sharpen (Повышение резкости) входит в подменю Sharpen
(Резкость) меню Bitmaps (Растровая графика). Допускает обработку изображе-
ний следующих цветовых форматов: оттенков серого, CMYK, Lab и RGB.

Создает эффект повышения резкости изображения за счет увеличения контра-
стности соседних пикселов, доступных для обработки.

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Sharpen > Sharpen (Растровая графика >
Резкость > Повышение резкости), открыв окно коррекции и эффектов с па-
раметрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунок Edge level (Краевой уровень) (с диапазоном значений
от 0 до 100 %), выберите уровень повышения резкости изображения.

5. С помощью ползунка Threshold (Порог) (с диапазоном значений от 0 до 25,5)
задайте допустимую величину перепада уровня яркости в цветовых кана-
лах изображения для соседних пикселов, которые будут обрабатываться
командой.

6. Если в результирующем изображении существенно исказились цвета, устано-
вите флажок Preserve Colors (Сохранять цвета) для устранения этого нежела-
тельного явления.

7. Щелкните на кнопке подтверждения ОК.
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Команда Unsharp Mask
Команда фильтрации Unsharp Mask (Контурная резкость) входит в подменю
Sharpen (Резкость) меню Bitmaps (Растровая графика). Допускает обработку изо-
бражений следующих цветовых форматов: оттенков серого, CMYK, Lab и RGB.

Создает эффект повышения резкости изображения путем сравнения исходного
изображения с его размытой копией, используемой в качестве маски, параметры
которой регулируются.

На рис. 5.80 показано диалоговое окно команды Unsharp Mask с параметрами,
которые использовались при обработке изображения, представленного слева.

Рис. 5.80. Обрабатываемое изображение и диалоговое окно команды Unsharp Mask

Порядок работы

1. Выделите требуемое изображение рабочим инструментом Pick (Выбор).

2. Выполните команду Bitmaps > Sharpen t Unsharp Mask (Растровая графика >
Резкость > Контурная резкость), открыв окно коррекции и эффектов с пара-
метрами команды.

3. Если вы не будете использовать параметры, которые задавались при обра-
ботке предшествующего изображения, установите параметры по умолчанию
(кнопка Reset).

4. Используя ползунок Radius (Радиус) (с диапазоном значений от 1 до 20 пикселов),
выберите уровень размытия маски, накладываемой на изображение.

5. С помощью ползунка Percentage (Процент) (с диапазоном значений от 1
до 500) задайте уровень повышения резкости для тех участков изображения,
которые подвержены регулировке.

6. Выполните следующие действия: используя ползунок Threshold (Порог)
(с диапазоном значений от 0 до 255), незначительно увеличьте величину
минимально допустимого различия между величинами яркости соседних пик-
селов, доступных для обработки, затем повторно настройте параметр Percentage.
Если результат стал лучше, продолжите регулировку этих двух параметров,
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в противном случае восстановите их предыдущие значения и перейдите
к следующему шагу инструкции.

7. Щелкните на кнопке подтверждения ОК.

Подменю Plug-Ins
Подменю Plug-Ins (Дополнения) меню Bitmaps (Растровая графика) включает
две дополнительные команды фильтрации, разработанные сторонними произво-
дителями.

Команда Embed Watermark
Команда фильтрации Embed Watermark (Вставить водяной знак) входит в под-
меню Digimarc (Цифровая метка), вложенное в подменю Plug-Ins меню Bitmaps.
Допускает обработку изображений следующих цветовых форматов: оттенков се-
рого, CMYK и RGB.

Внедряет в растровое изображение невидимый на экране водяной знак, пред-
ставляющий собой авторский код (идентификационный номер) разработчика.
Это делается для сохранения за разработчиком авторского права на данное изо-
бражение, а также для установления с ним контакта.

Порядок работы

1. Выполните команду Bitmaps * Plug-Ins > Digimarc > Embed Watermark (Растро-
вая графика > Дополнения > Цифровая метка ^ Вставить водяной знак), от-
крыв диалоговое окно Embed Watermark (Вставить водяной знак).

2. Задайте следующие параметры: Copyright Year(s) (Срок авторского права),
Target Output (Целевое назначение) и Watermark Durability (Стойкость водя-
ного знака).

3. Определитесь в отношении флажков Restricted Use (Ограниченное использо-
вание) и Adult Content (Только для взрослых), определяющих круг пользова-
телей, для которых предназначено данное изображение.

4. Если вы хотите, чтобы в процессе внедрения водяного знака осуществлялась
его проверка на чтение, установите флажок Verify (Проверка).

5. Щелкните на кнопке Personalize (Получить), открыв дополнительное диало-
говое окно Personalize Creator ГО (Получить идентификационный номер раз-
работчика).

6. Введите в поле параметра Creator ID (Идентификационный номер разработ-
чика) свой авторский код, если он у вас имеется, либо получите его в фирме
Digimarc Corporation, зарегистрировавшись на ее Web-сайте с помощью
кнопки Register (Регистрация).

7. Закройте окно Personalize Creator ID щелчком на кнопке ОК, после чего за-
кройте окно Embed Watermark щелчком на такой же кнопке.
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Команда Read Watermark
Команда фильтрации Read Watermark (Прочитать водяной знак) входит в под-
меню Digimarc (Цифровая метка), вложенное в подменю Plug-Ins (Дополнения)
меню Bitmaps (Растровая графика). Допускает обработку изображений следую-
щих цветовых форматов: оттенков серого, CMYK и RGB.

Данная команда используется для получения сведений о разработчике растро-
вого изображения, если в этом изображении имеется его персональный автор-
ский код (водяной знак).

Порядок работы

1. Выполните команду Bitmaps > Plug-Ins > Digimarc > Read Watermark (Растро-
вая графика ^Дополнения > Цифровая метка > Прочитать водяной знак), от-
крыв диалоговое окно Watermark Information (Информация о водяном знаке).

2. Ознакомьтесь с краткими сведениями о разработчике изображения в данном
окне.

3. Если вы хотите получить через Web более подробные сведения о разработчи-
ке в базе данных фирмы Digimarc Corporation, щелкните на кнопке Web
Lookup (Сведения из Web).

4. Закройте окно Watermark Information щелчком на кнопке ОК.
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Обработка текста
Любая программа векторной графики позволяет работать с текстовой информа-
цией. Но далеко не каждая из них обладает набором функций, свойственных
современной издательской программе, используемой при верстке документов.
Программа CorelDRAW 12 является таким исключением. Она обладает широки-
ми возможностями форматирования и оформления текстовой информации,
которая может быть представлена в документе двумя типами текста: обычным
и художественным.

Обычный текст (paragraph text) обрабатывается так же, как в любом текстовом
редакторе, допускающем его форматирование и редактирование. Художествен-
ный текст (artistic text) можно не только форматировать и редактировать, но и
обрабатывать как объект векторной графики.

Перечислим основные функции CorelDRAW 12 по обработке текстовой инфор-
мации:

О ввод в документ обычного текста при его расположении в прямоугольной
текстовой рамке, во внутренней области векторного объекта с замкнутым
контуром или вдоль любого векторного контура (на текстовой дорожке);

О импорт из файла в документ обычного текста при автоматическом формиро-
вании новых страниц документа и расположении текстового материала в свя-
занных между собой прямоугольных текстовых рамках;

О ввод художественного текста при его расположении в теле документа или на
дорожке;

П оформление текстовых символов, а также векторных объектов, внутри или на
контурах которых они находятся;

П для обычного текста — трансформация текстовых рамок; перетекание текста
между связанными рамками; формирование текстовых оборок;

О для художественного текста — трансформация, а также создание художест-
венных эффектов, доступных для объектов векторной графики;

О форматирование любого текста двумя способами:

• путем непосредственного изменения параметров форматирования;

• с помощью текстовых стилей;
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О автоматическая расстановка текстовых переносов (в том числе и для русских
текстов);

П поддержка арабских и азиатских языков, имеющих нестандартный порядок
следования текстовых символов;

П редактирование текста, к числу основных функций которого относятся:

• режим автозамены (для любых текстов);

• проверка и исправление орфографических ошибок (для любых текстов);

• проверка и исправление грамматических ошибок, а также замена в тексте
слов синонимами (для английских текстов);

• автоматический выбор языка по редактируемой текстовой надписи с ие-
лью его автоматической проверки правописания, а также при расстановке
текстовых переносов;

О преобразование текста в кривые;

П вставка в текст документа или непосредственно в документ символов текста,
хранящихся в файлах шрифтов.

Чтобы объективно оценить возможности CorelDRAW 12 по работе с текстовой
информацией, отметим теперь функции обработки текста, которые отсутствуют
в этой программе, но имеются в других современных графических и издатель-
ских программах (Adobe Illustrator, QuarkXPress, Adobe PageMaker и др.):

G вставка обычного текста во внутреннюю область разомкнутого векторного
контура;

П работа с текстом, имеющим вертикальную ориентацию строк (в CorelDRAW 12
такая возможность предусмотрена только для азиатских шрифтов);

П форматирование текстовых колонок для будущих текстовых рамок или при
вставке в документ новых страниц;

О режим балансировки текста по колонкам;

О управление висячими текстовыми строками;

П создание нумерованных списков;

О форматирование номеров страниц (сама нумерация страниц в CorelDRAW 12
предусмотрена);

П создание скользящих колонтитулов, содержимое которых зависит от тексто-
вой информации, находящейся на текущей странице документа;

П формирование отсылок, представляющих собой служебные надписи, указы-
вающие на те страницы документа, где находятся предыдущие или следую-
щие блоки текстового материала;

П автоматическое создание списков и предметных указателей;

П режимы проверки грамматики и работы со словарем синонимов для русских
текстов.
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Для работы с текстовой информацией используются следующие средсиза
CorelDRAW 12:

G команды Import (Импорт) и Export (Экспорт) меню File (Файл);

П команды меню Text (Текст);

рабочие инструменты Pick (Выбор), Text (Текст) и Shape
(Форма);

О панель свойств и панель инструментов Text:

П докеры Graphic and Text Styles (Графические и текстовые стили), Object
Properties (Свойства объекта) и Insert Character (Вставить символ).

Типы текста
В CorelDRAW 12 предусмотрена работа с текстами двух типов: обычными и ху-
дожественными. Обычный текст вводится в предварительно заданную область
документа, в которой он обрабатывается точно так же, как в любом текстовом
редакторе. В качестве такой области может использоваться:

С1 текстовая рамка документа, представляющая собой прямоугольную область,
которая формируется в теле документа;

О текстовая рамка объекта, создаваемая во внутренней области векторного
объекта, имеющего замкнутый контур;

О текстовая дорожка, представляющая собой произвольный векторный контур
(замкнутый или разомкнутый), вдоль которого располагается текст.

Художественный текст вводится непосредственно в тело документа (в месте
расположения текстового курсора) или помещается на текстовую дорожку.
Такой текст может обрабатываться с помошью обычных средств форматирова-
ния текстовой информации и средств обработки векторных объектов. Благодаря
этому вы можете создавать в нем самые разнообразные художественные эффек-
ты, доступные для объектов векторной графики.

Блок обычного текста, находящийся в рамке документа, или блок художествен-
ного текста, расположенный в теле документа, является текстовым объектом.
Если блок текста находится внутри векторного объекта (в рамке объекта) или на
его контуре (на дорожке), то и такой объект можно назвать текстовым, хотя
в ряде случаев мы будем рассматривать его как комбинированный объект, чтобы
подчеркнуть его двойственную природу.

Для обычного текста допускается выполнение следующих операций обработки:

G регулирование параметров форматирования текстовых символов и абзацев;

П трансформация текстовой рамки или дорожки;

О перемещение и поворот отдельных символов текста;

П раскраска и обводка символов с помошью средств оформления векторных
объектов;
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П автоматическое изменение размеров символов для полного заполнения ими
текстовой рамки или дорожки;

О перетекание текста между связанными текстовыми рамками и дорожками;

ГЗ формирование текстовых оборок;

G преобразование текстовых символов в кривые Безье.

На рис. 6.1 представлены два выделенных образца обычного текста, левый рас-
положен в трансформированной рамке документа, а правый — на дорожке. Об-
ратите внимание на два полых маркера прямоугольной формы, расположенных
над и под каждым из этих объектов. Они свидетельствуют о том, что объект со-
держит или может содержать блок обычного текста. Если текст не помещается
в своей рамке или на дорожке, то в нижнем маркере появляется значок черного
треугольника.
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Рис. 6.1. Примеры образцов текста обычного типа

Для художественного текста допускается выполнение следующих операций об-
работки:

П регулирование параметров форматирования текстовых символов и абзацев;

П трансформация всего текстового блока, а также отдельных его символов;

П раскраска и обводка символов с помощью средств оформления векторных
объектов;

П регулировка прозрачности текстовых символов;

G создание художественных эффектов, доступных для объектов векторной гра-
фики;

П преобразование текстовых символов в кривые Безье.

На рис. 6.2 изображены два выделенных образца художественного текста, левый
расположен в теле документа, а правый — на дорожке. Оба этих образца транс-
формированы: для левого был выполнен наклон, а для правого — вертикальное
масштабирование.

В CorelDRAW 12 допускается преобразование типов текста. Любой образец
обычного текста может быть трансформирован в образец художественного тек-
ста и наоборот. Если блок обычного текста находится в прямоугольной тексто-
вой рамке документа или блок художественного текста — в теле документа,
то операция преобразования выполняется путем применения к выбранному
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блоку команды Text » Convert (Текст ¥ Преобразовать). В зависимости от типа ис-
ходного текста название этой команды меняется: для обычного текста она называ-
ется Convert To Artistic Text (Преобразовать в художественный текст), а для худо-
жественного — Convert To Paragraph Text (Преобразовать в обычный текст).

.CorelDRAW 01 2 и-
универсальная

программа.

Рис. 6.2. Примеры образцов текста художественного типа

Если блок текста произвольного типа расположен на дорожке, то перед приме-
нением указанной команды этот блок следует отделить от дорожки с помощью
команды Arrange > Break Apart (Расположить * Разъединить).

И, наконец, если блок обычного текста размешен в текстовой рамке объекту,
то выполняются три действия. Вначале текст отделяется от векторного объекта,
в котором находится, командой Arrange > Break Apart, располагаясь в текстовой
рамке документа такой же формы. Затем эта рамка преобразуется в прямоуголь-
ную командой Effects \ Clear Effect (Эффекты > Удалить эффект) путем удаления
оболочки, придававшей ей первоначальную форму. После этого производится
непосредственное преобразование обычного текста в художественный с помо-
щью команды Text > Convert.

Используемые шрифты
В CorelDRAW 12 предусмотрена работа со шрифтами трех типов: True Type,
PostScript (или Туре 1) и Open Type (открытый тип).

Примечание

Шрифты открытого типа разработаны компаниями Adobe и Microsoft. Они унас-
ледовали преимущества шрифтов типа TrueType и PostScript благодаря ис-
пользованию Юникода для кодировки символов.

Тип шрифта может быть идентифицирован по его значку при выборе шрифта
в одном из двух списков:

О в списке Font List (Список шрифтов) на панели свойств в режиме работы
инструмента Text (Текст);
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П в списке Font (Шрифт) на вкладке Character (Символ) диалогового окна
Format Text (Форматировать текст) панели.

Существуют три варианта значка типа шрифта:

О две буквы "Т", наложенные со смещением друг на друга, — шрифт TrueType
(такие шрифты устанавливаются непосредственно в Windows);

О символы "Т1" -- шрифт типа PostScript (такие шрифты могут быть установ-
лены, в частности, с помощью диспетчера шрифтов Adobe Type Manager
Deluxe 4.1);

G буква "О"— шрифт открытого типа (несколько образцов таких шрифтов ус-
танавливается вместе с программой CorelDRAW 12).

К сожалению, многие шрифты, доступные в CorelDRAW 12, нельзя использо-
вать при работе с русскоязычным текстом (даже если эти шрифты и кирилличе-
ские). В списках шрифтов программы названия таких шрифтов представляются
серым цветом, а не черным, при выполнении одного из двух условий:

О в документе выделен блок русского текста;

Г\ произошло формирование новой текстовой рамки или установка в тело до-
кумента текстового курсора в случае, если основным языком программы яв-
ляется русский.

^ Примечание

Выбор основного языка производится с помощью команды Language (Язык)
подменю Writing Tools (Инструменты правописания) меню Text (Текст).

Ввод текста
В этом разделе описываются различные операции ввода обычного и художест-
венного текста в документ CorelDRAW 12.

Ввод обычного текста
Текст обычного типа можно вставлять в документ тремя способами: с клавиату-
ры, из другого текстового блока (через буфер обмена Windows), а также из тек-
стового файла (в режиме импорта).

Для ввода с клавиатуры обычного текста используется рабочий инструмент

Text (Текст). С его помощью вы можете вводить текст в любые текстовые рамки
и дорожки документа.

Если перед импортом текста, выполняемым командой File > Import
(Файл > Импорт), вы сформировали текстовую рамку и поместили в нее тексто-
вый курсор, то текст будет вставлен в нее. В противном случае CorelDRAW 12
автоматически создаст требуемое количество одинаковых по размеру прямо-
угольных текстовых рамок документа, связанных между собой, в которых и бу-
дет размешен текстовый материал.
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Примечание

Если в обрабатываемый документ загружен иностранный текст, для языка ко-
торого в Windows XP отсутствует кодовая таблица, то для правильного отобра-
жения такого текста вы сможете подключить требуемую таблицу непосредст-
венно в CorelDRAW 12. Данная операция выполняется с помощью команды
Encode (Кодировка) меню Text (Текст).

Рассмотрим различные варианты ввода и импорта в документ обычного текста.

Ввод обычного текста в новую рамку документа
1. Откройте документ на нужной странице, отобразив на экране в требуемом

масштабе ту область, где будет размещаться текст.

2. Выберите рабочий инструмент Pick (Выбор) и отмените им возможные выде-
ления объектов в документе, щелкнув мышью в свободном месте области до-
кумента.

3. Выберите рабочий инструмент Text (Текст).

4. Задайте режим использования стиля обычного текста по умолчанию (Default
Paragraph Text), щелкнув на нижней кнопке переключателя Default Style to
Edil (Редактировать стиль по умолчанию), находящегося в левом конце пане-
ли свойств.

5. Если параметры форматирования текста данным стилем, отображаемые па
панели свойств, вас не устраивают, при этом требуемые параметры будут ис-
пользоваться в текущем документе и при работе с другими текстами обыч-
ного типа, тогда откорректируйте существующие параметры. Каждый раз,
когда на экране будет появляться диалоговое окно Text Attributes (Атрибуты
текста) с предупреждающим сообщением о вступлении в силу новых пара-
метров стиля обычного текста по умолчанию (при установленном флажке
Paragraph Text (Обычный текст)), щелкайте мышью на кнопке подтвержде-
ния ОК (см. рис. 6.3).

6. Сформируйте прямоугольную текстовую рамку документа. Для этого устано-
вите указатель (он имеет вид перекрестия с буквой "А" внизу) в том месте
документа, где будет находиться левая верхняя вершина рамки, нажмите
кнопку мыши и перетащите указатель вниз и вправо в точку размещения
правой нижней вершины, после чего отпустите кнопку мыши. При этом
в левом верхнем углу области рамки появится текстовый курсор в виде вер-
тикальной черточки, положение которого определяет место ввода первого
текстового символа (см. рис. 6.4).

7. Если вам необходимо переместить текстовую рамку в другое место документа
или изменить ее размеры, сделайте это с помощью мыши и выделяющих
маркеров.

S. Для изменения параметров стиля по умолчанию только для того текста, ко-
торый будет введен в данную рамку, откорректируйте их на панели свойств.
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9. Введите в рамку текст с клавиатуры. Это можно сделать двумя способами:
непосредственно в документе или открыв диалоговое окно Edit Text (Редак-
тировать текст) с помощью крайней правой кнопки панели свойств.

Text Attributes

j Changing text properties when nothing is
] selected will modify the attributes used by the j

text tools when creating new objects. .
.

i CBck on the boxes below to choose which tools i
. will receive new default settings,

Artistic Text'

I v* Paragraph Text

Cancel

Рис. 6.З. Диалоговое окно Text Attributes

На рис. 6.4 зафиксированы три момента процесса ввода обычного текста в но-
вую рамку документа. Слева — момент завершения формирования рамки, по-
средине — момент отпуска кнопки мыши после создания рамки и справа —
момент завершения ввода текста в рамку.
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Рис. 6.4. Пример ввода обычного текста в новую рамку документа

Ввод обычного текста в новую рамку объекта
1. Откройте документ на нужной странице, сформируйте векторный объект

с замкнутым контуром, в область которого будет вводиться текст, и отобра-
зите его на экране в требуемом масштабе (выделять этот объект не обяза-
тельно).

2. Выберите рабочий инструмент Text (Текст).

3. Задайте режим использования стиля обычного текста по умолчанию (Default
Paragraph Text), щелкнув на нижней кнопке переключателя Default Style to
Edit, находящегося в левом конце панели свойств.
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4. Если параметры форматирования текста данным стилем, отображаемые на
панели свойств, вас не устраивают, при этом требуемые параметры будут ис-
пользоваться в текущем документе и при работе с другими текстами обыч-
ного типа, откорректируйте существующие параметры.

5. Поместите указатель (он имеет вид перекрестия с буквой "А" внизу) в любое
место контура созданного вами объекта и плавно его перемешайте внутрь
объекта до тех пор, пока он не примет вид латинской буквы "I" с небольшим
значком внизу в виде букв "АВ" внутри квадратной рамки. Как только такое
изменение формы указателя произойдет, щелкните кнопкой мыши.
В результате сформируется текстовая рамка по контуру векторного объекта
(она отобразится пунктирной линией), а вверху ее области появится тексто-
вый курсор (см. рис. 6.5).

6. Для изменения параметров стиля по умолчанию только для того текста, ко-
торый будет введен в данную рамку, откорректируйте их на панели свойств.

7. Введите в рамку текст с клавиатуры. Это можно сделать двумя способами:
непосредственно в документе или открыв диалоговое окно Edit Text (Редак-
тировать текст) с помощью крайней правой кнопки панели свойств.

8. Если вам необходимо переместить текстовую рамку в другое место документа
или изменить ее размеры, выполните это с помошью мыши и выделяющих
маркеров, предварительно выбрав рабочий инструмент Pick (Выбор).

На рис. 6.5 зафиксированы три момента процесса ввода обычного текста в но-
вую рамку объекта. Слева — момент установки указателя в нужном месте век-
торного объекта, посредине — момент формирования рамки щелчком мыши и
справа — момент завершения ввода текста в рамку.

\ rf CorelDRAW 121 \
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Рис. 6.5. Пример ввода обычного текста в новую рамку объекта

Ввод обычного текста на новую разомкнутую дорожку
1. Откройте документ на нужной странице и сформируйте разомкнутый век-

торный контур, который будет использован в качестве текстовой дорожки,
отобразив его в требуемом масштабе.

2. Выберите рабочий инструмент Text (Текст).

3. Задайте режим использования стиля обычного текста по умолчанию (Default
Paragraph Text), щелкнув на нижней кнопке переключателя Default Style to
Edit (Редактировать стиль по умолчанию), находящегося в левом конце пане-
ли свойств.
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4. Если параметры форматирования текста данным стилем, отображаемые на
панели свойств, вас не устраивают, при этом требуемые параметры будут ис-
пользоваться в текущем документе и при работе с другими текстами обыч-
ного типа, откорректируйте существующие параметры.

5. Сформируйте рядом с векторным контуром вспомогательную текстовую рам-
ку документа и введите в нее необходимый текст.

6. Выполните команду Text > Fit Text To Path (Текст » Разместить текст на до-
рожке). При этом указатель примет вид черной жирной стрелки, кончик ко-
торой поместите в любое место данного контура и щелкните кнопкой мыши.
В результате текст из области рамки переместится на дорожку и расположит-
ся с ее левого края, а сама рамка удалится с экрана (см. рис. 6.6).

7. С помощью панели свойств настройте параметры форматирования текстовой
надписи, находящейся на дорожке (см. разд. "Операции оформления" настоящей
главы, подразд. "Оформление текстовой дорожки").

CorelDRAW 12:

Рис. 6.6. Пример ввода обычного текста на новую разомкнутую дорожку

Ввод обычного текста на новую замкнутую дорожку
1. Откройте документ на нужной странице и сформируйте векторный объект

с замкнутым контуром, выполняющим функиию текстовой дорожки. Отобра-
зите этот объект в требуемом масштабе.

2. Выберите рабочий инструмент Text (Текст).



Обработка текста 417

3. Задайте режим использования стиля обычного текста по умолчанию (Default
Paragraph Text), щелкнув на нижней кнопке переключателя Default Style to
Edit, находящегося в левом конце панели свойств.

4. Если параметры форматирования текста данным стилем, отображаемые на
панели свойств, вас не устраивают, при этом требуемые параметры будут ис-
пользоваться в текущем документе и при работе с другими текстами обыч-
ного типа, откорректируйте существующие параметры.

5. Сформируйте в созданном векторном объекте текстовую рамку и введите
в нее требуемый текст.

6. Выполните команду Text > Fit Text To Path (Текст ^ Разместить текст на до-
рожке), переместив текст из внутренней области векторного объекта на его
контур (он расположится над объектом, по центру).

7. С помощью панели свойств настройте параметры форматирования текстовой
надписи, находящейся на дорожке.

Ввод обычного текста в существующую рамку
или на дорожку
1. Откройте документ на странице, где находится нужный вам текстовый блок,

находящийся в рамке или на дорожке. Отобразите его в требуемом масштабе.

2. С помощью рабочего инструмента Pick (Выбор) отмените возможные выде-
ления объектов в документе, щелкнув в свободном месте области документа

3. Выберите рабочий инструмент Text (Текст).

4. При вводе текста в область рамки поместите указатель, имеющий вид латин-
ской буквы "I", в место ввода нового текста и щелкните кнопкой мыши,
вставив в это место текстовый курсор. При вводе текста в блок, расположен-
ный на текстовой дорожке, поместите указатель между нужными текстовыми
символами и щелкните мышью, вставив текстовый курсор.

5. Введите текст с клавиатуры.

Импорт обычного текста
в новые рамки документа
1. Откройте документ на странице, где будет начинаться импортируемый текст,

полностью отобразив эту страницу на экране.

2. С помощью рабочего инструмента Pick (Выбор) отмените возможные выде-
ления объектов в документе, щелкнув в его свободной области.

3. Выполните команду File > Import (Файл V Импорт), открыв ее одноименное
диалоговое окно.

4. Выберите требуемый текстовый файл, хранящийся на диске, после чего
закройте окно щелчком на кнопке Import (Импорт). При этом откроется
дополнительное диалоговое окно Importing/Pasting Text (Импорт/Вставка
текста).

14 Зак. 250
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5. Подключите в этом окне один из трех режимов форматирования текстовой
информации:

• с сохранением всех шрифтов и параметров форматирования исходного
текста (верхний переключатель);

• с сохранением только параметров форматирования текста (средний пере-
ключатель);

• без сохранения шрифтов и параметров форматирования, тогда будут ис-
пользованы параметры стиля обычного текста по умолчанию CorelDRAW 12
(нижний переключатель).

п

1 .

1

Рис. 6.7. Пример импорта обычного текста в новые текстовые рамки документа

6. Закройте окно щелчком на кнопке ОК, в результате начнется процесс им-
порта в документ текстовой информации. По завершении этого процесса
указатель примет вид уголка с текстовой информацией, включающей назва-
ние текущего импортируемого файла, размеры рамки с текстом, находящим-
ся в данном файле, а также ваши возможные действия. Выберите один из
перечисленных ниже вариантов действий, в результате чего на текущей и по-
следующих страницах документа автоматически сформируются связанные
между собой текстовые рамки документа, содержащие импортированный
текст (рис. 6.7):

• нажмите клавишу <Enter>, расположив в центре документа рамку с тек-
стом без изменения ее масштаба;

• поместите указатель в то место документа, где будет располагаться левая
верхняя вершина текстовой рамки, и щелкните мышью, если стандартные
размеры текстовых рамок вас устраивают;
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• установите указатель в месте расположения левой верхней вершины рам-
ки с текстом, нажмите кнопку мыши и протяните указатель в правый
нижний угол страницы, задав требуемые размеры рамки при сохранении
их исходной пропорции или без такого сохранения (во втором случае
должна быть нажата клавиша <Alt>), после чего отпустите кнопку мыши.

Импорт обычного текста
в произвольные области документа
1. Сформируйте в нужных местах документа текстовые рамки и дорожки, в ко-

торые будет помещен импортируемый текстовый материал, а также устано-
вите между ними связи (см. разд. "Работа с обычным текстом"настоящей главы,
подразд. "Перетекание текста").

2. Откройте страницу документа, где находится первая по порядку (исходная)
текстовая рамка из группы связанных между собой рамок и дорожек.

3. С помощью рабочего инструмента Pick (Выбор) отмените возможные выде-
ления объектов в документе, щелкнув в его свободной области.

4. Выберите рабочий инструмент Text (Текст) и установите текстовый курсор
в область исходной рамки.

5. Выполните команду File > Import (Файл > Импорт), открыв ее одноименное
диалоговое окно.

6. Выберите требуемый текстовый файл, после чего закройте окно щелчком на
кнопке Import (Импорт), При этом откроется дополнительное диалоговое
окно Importing/Pasting Text (Импорт/Вставка текста), в котором подключите
один из трех режимов форматирования текстовой информации (см. шаг 5
инструкции, описанной ранее в подразделе "Импорт обычного текста в новые
рамки документа") и щелкните на кнопке ОК. В результате текст из выбран-
ного файла будет вставлен в выделенные для него области документа.

Импорт обычного текста
в существующий текстовый блок
1. Откройте документ на странице, где расположен необходимый блок обыч-

ного текста, находящийся в рамке или на дорожке.

2. С помощью рабочего инструмента Pick (Выбор) отмените возможные выде-
ления объектов в документе.

3. Выберите рабочий инструмент Text (Текст) и установите с его помощью тек-
стовый курсор в то место блока, куда будет импортироваться текст.

4. Выполните команду File > Import (Файл * Импорт), открыв ее диалоговое окно.

5. Выберите требуемый текстовый файл, после чего закройте окно щелчком на
кнопке Import. При этом откроется дополнительное диалоговое окно
Importing/Pasting Text, в котором подключите один из трех режимов форма-
тирования текстовой информации (см. шаг 5 инструкции, описанной ранее
в подразделе "Импорт обычного текста в новые рамки документа") и щелкните
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на кнопке ОК. В результате текст из выбранного файла будет вставлен в ука-
занное место существующего текстового блока.

Перенос обычного текста
из одной области документа в другую

1. Откройте документ на странице, где находится текстовый блок, из которого
текст будет переноситься в другое место документа.

2. Отмените рабочим инструментом Pick (Выбор) возможные выделения объ-
ектов в документе.

3. Выберите рабочий инструмент Text (Текст) и перейдите в режим редактиро-
вания текста, поместив текстовый курсор в место его расположения внутри
блока текста.

4. Если фрагмент текста, который вы собираетесь перенести в другое место
документа, находится в одной текстовой рамке или на одной дорожке, то
выделите его непосредственно в документе. В противном случае выделите
фрагмент текста в диалоговом окне Edit Text (Редактировать текст), в кото-
ром представлен весь текстовый материал, расположенный в нескольких
связанных между собой рамках. Данное окно открывается крайней правой
кнопкой панели свойств.

5. Поместите выделенный текст в буфер обмена Windows, выполнив для этого
следующие действия: с удалением переносимого текста из существующего
текстового материала примените команду Edit > Cut (Правка > Вырезать) или
комбинацию быстрых клавиш <Ctrl>+<X>; без удаления данного текста —
команду Edit»Сору (Правка > Копировать) или быстрые клавиши
<СЫ>+<С>. При работе с окном команды Edit Text можно использовать
только быстрые клавиши.

6. Перейдите на страницу документа, где будет располагаться текст из буфера
обмена.

7. Отмените инструментом Pick возможные выделения объектов в документе.

8. Выберите инструмент Text.

9. Сформируйте в документе новую текстовую рамку или дорожку либо выбе-
рите существующую. Перейдите в режим ввода текста, поместив текстовый
курсор в нужном месте рамки (дорожки).

10. Вставьте текст из буфера обмена с помощью команды Edit > Paste (Правка >
Вставить) или быстрых клавиш <Ctrl>+<V>.

Примечание

Таким образом вы можете переносить тексты различных типов, вставляя их
в текстовые блоки тех или иных типов.
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Изменение размещения обычного текста
В CorelDRAW 12 возможны различные варианты изменения размещения блока
обычного текста в документе. Перечислим эти варианты, указав порядок их реа-
лизации.

Разбивка рамки документа с текстом на несколько таких рамок

Каждая из результирующих рамок документа будет содержать один текстовый
абзац (при наличии в исходной рамке нескольких абзацев) или одну текстовую
строку (в случае одного абзаца). Данная операция выполняется в следующе^л
порядке.

L Выделите рамку документа с текстом рабочим инструментом Pick (Выбор).

2. Выполните команду Arrange V Break Apart (Текст > Разместить текст на до-
рожке).

Отделение текста от рамки объекта

Результирующий блок текста расположится в новой рамке документа такой же
формы, что и у исходного объекта. Данная операция выполняется в следующем
порядке.

1. Выберите рамку объекта с текстом инструментом Pick.

2. Выполните команду Arrange > Break Apart.

Отделение текста от дорожки

Результирующий блок текста расположится в новой прямоугольной текстовой
рамке документа. Данная операция выполняется в следующем порядке.

1. Выберите текстовую дорожку инструментом Pick (Выбор).

2. Выполните команду Arrange > Break Apart.

Перенос первого абзаца текста из рамки документа
на разомкнутую дорожку

При этом будут удалены остальные абзацы исходного текста. Данная операция
выполняется в следующем порядке.

1. Выделите рамку документа с текстом инструментом Pick.

2. Выполните команду Text > Fit Text To Path (Текст > Разместить текст на до-
рожке), придав указателю вид жирной черной стрелки.

3. Подведите указатель к разомкнутому векторному контуру и щелкните мышью.

Перенос первого абзаца текста из рамки объекта
на его замкнутый контур

При этом будут удалены остальные абзацы исходного текста. Данная операция
выполняется в следующем порядке.

1. Выберите рабочий инструмент Text (Текст).
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2. Установите текстовый курсор внутрь рамки.

3. Выполните команду Text > Fit Text To Path.

Ввод художественного текста

Для ввода в документ с клавиатуры текста художественного типа применя-

ется тот же рабочий инструмент Text (Текст), что и для ввода обычного текста.
С его помощью вы можете ввести текст прямо в тело документа или на тексто-
вую дорожку.

Ввести художественный текст в документ можно не только с клавиатуры, но и
из другого текстового блока (через буфер обмена), а также из текстового файла
в режиме импорта. В последнем случае необходимо перед выполнением коман-
ды File > Import (Файл > Импорт) поместить текстовый курсор в требуемое место
документа или текстовой дорожки.

Рассмотрим различные варианты ввода и импорта в документ художественного
текста.

Ввод художественного текста в тело документа
1. Отобразите на экране в требуемом масштабе область документа, где будет

размещаться текст.

2. С помощью рабочего инструмента Pick (Выбор) отмените возможные выде-
ления объектов в документе, щелкнув мышью в свободном месте области до-
кумента.

3. Выберите рабочий инструмент Text (Текст).

4. Задайте режим использования стиля художественного текста по умолчанию
(Default Artistic Text), щелкнув на верхней кнопке переключателя Default
Style to Edit (Редактировать стиль по умолчанию), находящегося в левом
конце панели свойств.

5. Если параметры форматирования текста данным стилем, отображаемые на
панели свойств, вас не устраивают, при этом требуемые параметры будут ис-
пользоваться в текущем документе и при работе с другими текстами художе-
ственного типа, откорректируйте существующие параметры. Каждый раз,
когда на экране будет открыто диалоговое окно Text Attributes (Атрибуты
текста) с предупреждающим сообщением о вступлении в силу новых пара-
метров стиля художественного текста по умолчанию (при установленном
флажке Artistic Text (Художественный текст)), щелкайте на кнопке подтвер-
ждения ОК.

6. Поместите указатель (он имеет вид перекрестия с буквой "А" внизу), в то
место документа, где будет вводиться текст, и щелкните мышью. В этом мес-
те появится текстовый курсор в виде вертикальной черточки, свидетельст-
вующий о переходе в режим ввода художественного текста.

7. Для изменения параметров стиля по умолчанию только для того текста, ко-
торый будет введен, откорректируйте их на панели свойств.
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8. Введите в документ текст с клавиатуры (см. рис. 6.8). Это можно сделать
двумя способами: непосредственно в документе или открыв диалоговое окно
Edit Text (Редактировать текст) с помощью крайней правой кнопки панели
свойств.

CorelDRAW 12I-

Рис, 6,8. Пример ввода художественного текста в тело документа

Ввод художественного текста
на новую дорожку (первый способ)
1. Откройте документ на нужной странице и сформируйте замкнутый или ра-

зомкнутый векторный контур, который будет использован в качестве тексто-
вой дорожки, отобразив его в требуемом масштабе (выделять этот контур не
обязательно).

2. Выберите рабочий инструмент Text (Текст).

3. Задайте режим использования стиля художественного текста по умолчанию
(Default Artistic Text), щелкнув на верхней кнопке переключателя Default
Style to Edit, находящегося в левом конце панели свойств.

4. Если параметры форматирования текста данным стилем, отображаемые на
панели свойств, вас не устраивают, при этом требуемые параметры будут ис-
пользоваться в текущем документе и при работе с другими текстами художе-
ственного типа, откорректируйте существующие параметры.

5. Поместите указатель (он имеет вид перекрестия с буквой "А" внизу) в том
месте созданного векторного контура, где будет начинаться ввод текста. Как
только указатель примет вид латинской буквы "I" с дополнительным значком
внизу, изображающим дорожку с буквой "А", щелкните кнопкой мыши. При
этом в месте щелчка появится текстовый курсор.

6. Для изменения параметров стиля по умолчанию только для того текста, ко-
торый будет введен на дорожку, откорректируйте их на панели свойств.

7. Введите текст с клавиатуры (см. рис. 6.9). Это можно сделать двумя способа-
ми: непосредственно в документе или открыв диалоговое окно Edit Text (Ре-
дактировать текст) с помошью крайней правой кнопки панели свойств. Если
текст вводится на разомкнутую дорожку, он будет перемещаться по дорожке
вправо (выключка слева), а если на замкнутую, то — равномерно влево и
вправо (выключка по центру).

8. Выберите рабочий инструмент Pick (Выбор).
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9. Используя панель свойств, настройте параметры форматирования текстовой
надписи, находящейся на дорожке (см. разд. "Операции оформления" настоящей
главы, подразд. "Оформление текстовой дорожки").

На рис. 6.9 зафиксированы три момента процесса ввода художественного текста
на новую замкнутую дорожку: слева — момент установки указателя в место вво-
да текста, посредине — момент ввода текстового курсора щелчком мыши и
справа — момент завершения ввода текста.

Рис. 6.9. Пример ввода художественного текста на новую замкнутую дорожку

Ввод художественного текста
на новую дорожку (второй способ)
1. Сформируйте в документе произвольный векторный контур, который будет

использован в качестве текстовой дорожки.

2. Выберите рабочий инструмент Text (Текст) и задайте режим использования
стиля художественного текста по умолчанию (Default Artistic Text), щелкнув
на верхней кнопке переключателя Default Style to Edit, находящегося в левом
конце панели свойств.

3. Введите требуемый художественный текст в тело документа, расположив его
рядом с векторным контуром.

4. Выполните команду Text > Fit Text To Path (Текст > Разместить текст на до-
рожке), придав указателю вид черной жирной стрелки, кончик которой по-
местите в любое место данного контура и щелкните кнопкой мыши.
В результате введенный текст переместится на дорожку, расположившись
с левого края дорожки, если она разомкнута, или по центру, если замкнута.

5. Настройте параметры форматирования текста дорожки с помощью элементов
управления панели свойств.

Ввод художественного текста
в существующий текстовый блок
1. Откройте документ на странице, где находится нужный блок художествен-

ного текста, отобразив его на экране в требуемом масштабе.

2. С помощью рабочего инструмента Pick (Выбор) отмените возможные выде-
ления объектов в документе.

3. Выберите рабочий инструмент Text (Текст).
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4. При вводе художественного текста в блок, расположенный в теле документа,
поместите указатель, имеющий вид латинской буквы "I", между теми его
символами, куда будет вводиться новый текст, и щелкните мышью. При этом
в данном месте появится текстовый курсор. При вводе текста в блок, нахо-
дящийся на текстовой дорожке, поместите указатель между нужными тексто-
выми символами и щелкните мышью, вставив туда текстовый курсор.

5. Введите текст с клавиатуры.

Импорт художественного текста
в тело документа или на новую дорожку
1. Откройте документ на странице, в область которой будет импортироваться

художественный текст.

2. Если текст будет импортироваться на текстовую дорожку, сформируйте ее.

3. Отмените рабочим инструментом Pick (Выбор) возможные выделения объек-
тов в документе, щелкнув в свободном месте документа.

4. Выберите рабочий инструмент Text (Текст).

5. Вставьте текстовый курсор в то место документа или текстовой дорожки, где
будет начинаться импортируемый текст.

6. Выполните команду File > Import (Файл > Импорт), открыв ее одноименное
диалоговое окно команды импорта.

7. Выберите требуемый текстовый файл, хранящийся на диске, затем закройте
окно щелчком на кнопке Import (Импорт). При этом откроется дополни-
тельное диалоговое окно Importing/Pasting Text (Импорт/Вставка текста).

8. Подключите в этом окне один из трех режимов форматирования текстовой
информации:

• с сохранением всех шрифтов и параметров форматирования исходного
текста (верхний переключатель);

• с сохранением только параметров форматирования текста (средний пере-
ключатель);

• без сохранения шрифтов и параметров форматирования, будут использо-
ваны параметры стиля обычного текста по умолчанию CorelDRAW 12
(нижний переключатель).

9. Закройте окно щелчком на кнопке ОК, в результате начнется процесс им-
порта в документ текстовой информации. По завершении данной операции
в выбранной области документа будет отображен импортированный текст.

Импорт художественного текста
в существующий текстовый блок
Данная операция будет выполняться точно так же, как и для обычного текста
(см. разд. "Ввод текста" данной главы, подразд. "Импорт обычного текста в сущест-
вующий текстовый блок").
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Перенос художественного текста
из одной области документа в другую

1. Откройте документ на странице, где находится текстовый блок, из которого
текст будет переноситься в другое место документа.

2. Отмените рабочим инструментом Pick (Выбор) возможные выделения объ-
ектов в документе.

3. Выберите рабочий инструмент Text (Текст) и перейдите в режим редактиро-
вания текста, поместив текстовый курсор в область его расположения.

4. Выделите мышью переносимый текстовый фрагмент.

5. Поместите выделенный текст в буфер обмена Windows, использовав для
этого команду Edit > Cut (Правка > Вырезать) или Edit > Сору (Правка >
Копировать).

6. Перейдите на страницу документа, где будет располагаться текст из буфера
обмена.

7. С помощью инструмента Pick отмените возможные выделения объектов
в документе.

8. Выберите инструмент Text.

9. Поместите текстовый курсор в нужном месте документа или на выбранной
текстовой дорожке, перейдя в режим ввода текста.

10. Вставьте текст из буфера обмена с помощью команды Edit > Paste (Правка >
Вставить).

Изменение размещения художественного текста
В CorelDRAW 12 возможны следующие варианты изменения размещения блока
художественного текста в документе. Перечислим эти варианты, указав порядок
их реализации.

Отделение текста от дорожки

Результирующий блок текста расположится в теле документа. Данная операция
выполняется в следующем порядке.

1. Выберите текстовую дорожку рабочим инструментом Pick (Выбор).

2. Выполните команду Arrange > Break Apart (Расположить * Разъединить).

Примечание

Для полного выравнивания текстовых символов, отделенных от дорожки, необ-
ходимо применить команду Text > Straighten Text (Текст > Выровнять текст),
а для выравнивания только по базовой линии— команду Align To Baseline
(Выровнять по базовой линии) меню Text (Текст).
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Перенос текста из тела документа на дорожку
Данная операция выполняется в следующем порядке.

1. Выделите блок текста инструментом Pick.

2. Выполните команду Text > Fit Text To Path (Текст > Разместить текст на до-
рожке), придав указателю вид жирной черной стрелки.

3. Подведите указатель к векторному контуру (замкнутому или разомкнутому) и
щелкните мышью.

Операции оформления

В этом разделе рассматриваются различные операции оформления текстовых
объектов.

Оформление символов обычного текста
Под оформлением текстовых символов будем понимать их раскраску (заливку и
обводку) и регулировку прозрачности. Опишем различные варианты оформле-
ния символов обычного текста, для которых регулировка прозрачности не до-
пускается.

Оформление символов обычного текста в рамке документа
1. Выделите требуемые символы обычного текста, используя для этого один из

трех вариантов действий:

• для выделения всех символов текстового блока выберите рабочий инст-
румент Pick (Выбор) и щелкните внутри рамки, где этот блок находится;

• для выделения группы последовательно расположенных символов выберите
рабочий инструмент Text (Текст) и отметьте им данную группу символов;

• для выделения группы символов, расположенных в произвольном порядке,
выберите рабочий инструмент Shape (Форма) и сделайте последовательные
щелчки на маркерах этих символов при нажатой клавише <Shift>.

2. Задайте параметры линий, которыми будут обводиться выбранные символы.
Если они совпадают с параметрами оформления линии по умолчанию, за ис-
ключением цвета, то выберите нужный цвет, щелкнув правой кнопкой мыши
в соответствующей ячейке рабочей цветовой палитры. В противном случае от-
кройте диалоговое окно Outline Pen (Контурное перо) рабочего инструмента
Outline (Контур) и выберите там цвет линии обводки (список цветовых обран
цов Color), ее толщину (поле Width), а также стиль оформления (список Style)

3. При выделении инструментом Pick всего текстового блока его символы
можно раскрасить, применив к ним заливку любого типа, за исключением
заливки по сетке. Данная операция выполняется рабочим инструментом
Interactive Fill (Интерактивная заливка) или Fill (Заливка). Равномерную зп-
ливку можете выполнить с помощью рабочей цветовой палитры, щелкнув
левой кнопкой мыши в нужном ее месте. (См. разд. "Заливка"гл. 4.)
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4. При выделении инструментом Text или Shape нескольких текстовых симво-
лов их равномерную зативку можно выполнить с помощью рабочей цветовой
палитры, а заливку произвольного типа — инструментом Fill (в данном слу-
чае инструмент Interactive Fill применять нельзя).

Оформление символов обычного текста в рамке объекта
1. Если вы хотите оформить все символы текста, находящегося в рамке объек-

та, выделите их рабочим инструментом Pick (Выбор), нажав для этого кла-
вишу <Ctrl> и щелкнув на одном из символов. Для выделения нескольких
соседних символов воспользуйтесь рабочим инструментом Text (Текст), а для
выделения символов, расположенных в произвольном порядке, — рабочим
инструментом Shape (Форма) и клавишей <Shift>.

2. Задайте параметры линий, которыми будут обводиться выбранные символы
текста. Если они совпадают с параметрами оформления линии по умолча-
нию, за исключением цвета, то выберите нужный цвет, щелкнув правой
кнопкой мыши в соответствующей ячейке рабочей цветовой палитры. В про-
тивном случае выполните настройку параметров в диалоговом окне Outline
Pen (Контурное перо) рабочего инструмента Outline (Контур).

3. При выделении инструментом Pick всего текстового блока его символы
можно раскрасить, применив к ним заливку требуемого типа с помощью ра-
бочего инструмента Interactive Fill (Интерактивная заливка) или Fill (Заливка)
(для равномерной заливки можно использовать рабочую цветовую палитру).

4. При выделении инструментом Text или Shape нескольких текстовых симво-
лов их равномерную заливку можно выполнить с помощью рабочей цветовой
палитры, а заливку произвольного типа — инструментом Fill.

Bitmap Pattern T : ~1» I ЕЙ М CTi *B ,13,202 mm

Рис. 6.10. Пример оформления блока обычного текста, находящегося в рамке объекта
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На рис. 6.10 представлен пример заливки шаблоном всех символов блока обыч-
ного текста, находящегося в рамке объекта эллиптической формы с градиентной
заливкой. В данном случае использовался инструмент Interactive Fill, управляю-
щая конструкция которого расположена в левой части рисунка. Вверху изобра-
жена панель свойств с параметрами данного инструмента.

Оформление символов обычного текста на дорожке
1. Для оформления всей текстовой надписи, находящейся на дорожке, выдели-

те ее, выбрав для этого рабочий инструмент Pick (Выбор) и щелкнув на од-
ном из ее символов при нажатой клавише <Ctrl>. Для выделения группы
символов следует воспользоваться рабочим инструментом Text (Текст) или
рабочим инструментом Shape (Форма) вместе с клавишей <Shift>.

2. Задайте параметры линий, которыми будут обводиться выбранные символы
текста. Если они совпадают с параметрами оформления линии по умолча-
нию, за исключением цвета, то выберите нужный цвет правой кнопкой мы-
ши в рабочей цветовой палитре. Если вам необходимо изменить и другие па-
раметры обводки, сделайте это в диалоговом окне Outline Pen (Контурное
перо) рабочего инструмента Outline (Контур).

3. При выделении инструментом Pick всей текстовой надписи ее символы
можно раскрасить, применив к ним заливку требуемого типа с помощью ра-
бочего инструмента Interactive Fill (Интерактивная заливка) или Fill (Заливка)
(для равномерной заливки можно использовать рабочую цветовую палитру),

•Texture Fill т Samples 9

€1
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-

Рис. 6.11. Пример оформления надписи обычного текста,
находящейся на дорожке
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4. При выделении инструментом Text или Shape нескольких текстовых симво-
лов их равномерную заливку можно выполнить с помощью рабочей цветовой
палитры, а заливку произвольного типа — инструментом Fill.

На рис. 6.11 показан пример заливки текстурой всех символов надписи обыч-
ного текста, находящейся на дорожке. В данном случае также использовался
инструмент Interactive Fill, слева изображена управляющая конструкция. Вверху
находится панель свойств с параметрами данного инструмента.

Оформление символов художественного текста
При оформлении символов художественного текста вы можете изменять не
только их раскраску, но и прозрачность, что недоступно для обычного текста.

Оформление символов художественного текста
в теле документа
1. Выделите требуемые символы художественного текста, используя для этого

один из трех вариантов действий:

• для выделения всех символов текстового блока выберите рабочий инстру-
мент Pick (Выбор) и щелкните на одном из них;

• для выделения группы последовательно расположенных символов выберите
рабочий инструмент Text (Текст) и отметьте им данную группу символов;

• для выделения группы символов, расположенных в произвольном порядке,
выберите рабочий инструмент Shape (Форма) и сделайте последовательные
щелчки на маркерах этих символов при нажатой клавише <Shift>.

2. Задайте параметры линий, которыми будут обводиться выбранные символы
текста. Если они совпадают с параметрами оформления линии по умолча-
нию, за исключением цвета, то выберите необходимый цвет, щелкнув правой
кнопкой мыши в соответствующей ячейке рабочей цветовой палитры. В про-
тивном случае выполните настройку параметров в диалоговом окне Outline
Реп (Контурное перо) рабочего инструмента Outline (Контур).

3. При выделении инструментом Pick всего текстового блока его символы
можно раскрасить, применив к ним заливку любого типа, за исключением
заливки по сетке. Данная операция выполняется рабочим инструментом
Interactive Fill (Интерактивная заливка) или Fill (Заливка). Равномерную за-
ливку можете выполнить с помощью рабочей цветовой палитры, щелкнув
левой кнопкой мыши в нужном ее месте. (См. разд. "Заливка"гл. 4.)

4. При выделении инструментом Text или Shape нескольких текстовых симво-
лов их равномерную заливку можно выполнить с помощью рабочей цветовой
палитры, а заливку произвольного типа — инструментом Fill (в данном слу-
чае инструмент Interactive Fill применять нельзя).

5. Отрегулируйте рабочим инструментом Interactive Transparency (Интерактив-
ная прозрачность) уровни прозрачности областей заливки и обводки всего
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текстового блока или его отдельных символов. В последнем случае вам необ-
ходимо предварительно выполнить один или несколько раз команду
Arrange > Break Apart (Расположить > Разъединить) и выделить нужные сим-
волы инструментом Pick при нажатой клавише <Shift>.

На рис. 6.12 показаны образцы художественного текста, оформленные заливка-
ми различных типов.

Рис. 6.12. Пример оформления символов художественного текста в теле документа

Оформление символов художественного текста на дорожке
1. Для оформления всей текстовой надписи, находящейся на дорожке, выдели-

те ее, выбрав для этого рабочий инструмент Pick (Выбор) и щелкнув на од-
ном из ее символов при нажатой клавише <Ctii>. Для выделения группы
символов следует воспользоваться рабочим инструментом Text (Текст) или
рабочим инструментом Shape (Форма) вместе с клавишей <Shift>.

2. Задайте параметры линий, которыми будут обводиться выбранные символы
текста. Если они совпадают с параметрами оформления линии по умолча-
нию, за исключением цвета, то выберите нужный цвет правой кнопкой мы-
ши в рабочей цветовой палитре. Если вам необходимо изменить и другие па-
раметры обводки, сделайте это в диалоговом окне Outline Pen (Контурное
перо) рабочего инструмента Outline (Контур).

3. При выделении инструментом Pick всей текстовой надписи ее символы мож-
но раскрасить, применив к ним заливку любого типа, за исключением залив-
ки по сетке. Данная операция выполняется рабочим инструментом Interactive
Fill (Интерактивная заливка) или Fill (Заливка). Равномерную заливку можете
выполнить с помощью рабочей цветовой палитры.

4. При выделении инструментом Text или Shape нескольких текстовых симво-
лов их равномерную заливку можно выполнить с помощью рабочей цветовой
палитры, а заливку произвольного типа — инструментом Fill
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5. Отрегулируйте рабочим инструментом Interactive Transparency (Интерактив-
ная прозрачность) уровни прозрачности областей заливки и обиодки всей
текстовой надписи или ее отдельных символов. В последнем случае вам не-
обходимо предварительно выполнить один или несколько раз команду
Arrange > Break Apart (Расположить f Разъединить) и выделить нужные сим-
волы инструментом Pick при нажатой клавише <Shift>.

Оформление текстовой рамки объекта
Под оформление текстовой рамки объекта будем понимать операцию оформле-
ния векторного объекта, выполняющего функцию текстовой рамки, без воздей-
ствия на тот текст, который внутри этого объекта находится или будет нахо-
диться в будущем.

Примечание

В CorelDRAW 12 не предусмотрено оформление текстовой рамки документа.

Порядок оформления
1. Выберите рабочий инструмент Pick (Выбор).

2. Поместите указатель на контуре (но не внутри) векторного объекта, содер-
жащего блок текста, и щелкните кнопкой мыши. Признаком правильного
выделения объекта является наличие на панели свойств списка Outline Width
(Толщина обводки), используемого для задания толщины обводки. Отсутст-
вие данного списка означает, что при выделении объекта кончик указателя
находился внутри него. В этом случае отмените выделение объекта щелчком
в свободной области документа и повторно выполните данную операцию.

3. Выполните заливку и обводку выбранного объекта, используемого в качестве
текстовой рамки, а также отрегулируйте его прозрачность (см. разд. "Заливка",
"Обводка" и "Регулировка прозрачности"гл. 4).

Оформление текстовой дорожки
Под оформлением текстовой дорожки понимается формирование внешнего вида
текстовой надписи вместе с векторным контуром (дорожкой), вдоль которого
эта надпись располагается. В CorelDRAW 12 предусмотрены следующие опера-
ции оформления текстовой дорожки:

П трансформация надписи художественного текста;

П трансформация дорожки (без текста);

О трансформация дорожки вместе с художественным текстом;

П изменение формы дорожки;

П изменение параметров оформления дорожки;
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3 перемещение текста вдоль дорожки;

О форматирование текстовых символов дорожки;

П форматирование всей текстовой надписи дорожки;

О оформление символов обычного и художественного текста.

Рассмотрим все эти операции по порядку, за исключением последней, которая
была рассмотрена в данном разделе.

Трансформация надписи художественного текста
1. Выберите рабочий инструмент Pick (Выбор), нажмите клавишу <Ctrl> и

щелкните на одном из символов надписи художественного текста, находя-
щейся на дорожке, выделив ее. При этом вокруг надписи появится восемь
черных квадратных маркеров, свидетельствующих о переходе в режим ее
масштабирования.

2. С помощью данных маркеров и мыши выполните масштабирование надписи
по нужным вам координатам.

3. Перейдите в режим поворота и наклона надписи, шелкнув на любом ее сим-
воле.

4. Выполните наклон надписи по горизонтали или вертикали, используя для
этого маркеры в виде двунаправленных стрелок, расположенные посередине
(поворот надписи в данном случае недопустим, поскольку она жестко привя-
зана к дорожке).

На рис. 6.13 зафиксированы три момента процесса масштабирования по верти-
кали надписи художественного текста: слева — момент задания режима масшта-
бирования надписи, в центре — момент перемещения вниз нижнего середин-
ного маркера и справа — момент завершения операции масштабирования.

Рис. 6.13. Пример масштабирования надписи художественного текста
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На рис. 6.14 зафиксированы три момента процесса наклона по горизонтали
надписи художественного текста: слева — момент задания режима наклона над-
писи, в центре — момент перемещения вправо нижнего серединного маркера и
справа — момент завершения операции наклона.

Рис. 6.14. Пример наклона надписи художественного текста

Трансформация только дорожки
1. Выделите текстовую дорожку рабочим инструментом Pick (Выбор), щелкнув

на ней.

2. Выполните масштабирование дорожки с помощью выделяющих маркеров
и мыши.

3. Перейдите в режим поворота и наклона дорожки, щелкнув в любом ее месте.

4. Выполните трансформацию дорожки в данном режиме.

Трансформация дорожки вместе с художественным текстом
1. Выберите рабочий инструмент Pick (Выбор).

2. Выделите комбинированный объект, состоящий из надписи художественного
текста и дорожки. Для этого установите указатель на любом символе надписи
и щелкните мышью.

3. С помощью выделяющих маркеров и мыши выполните масштабирование
комбинированного объекта.

4. Перейдите в режим поворота и наклона объекта, щелкнув в любом месте
надписи или дорожки.

5. Выполните трансформацию объекта в выбранном режиме.

Примечание

Если надпись на дорожке выполнена текстом обычного типа, то эта надпись
не будет трансформироваться вместе с дорожкой.
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Изменение формы дорожки
1. Выберите рабочий инструмент Pick (Выбор).

2. Выделите текстовую дорожку, щелкнув на ней.

3. Если дорожка представляет собой контур стандартной геометрической фигу-
ры (прямоугольника, эллипса или многоугольника), то преобразуйте ее
в кривую Безье. Для этого выполните команду Arrange > Convert To Curves
(Расположить > Преобразовать в кривые) или щелкните на кнопке Convert To
Curves, расположенной крайней справа на панели свойств.

4. Выберите рабочий инструмент Shape (Форма) и отредактируйте форму до-
рожки с помощью узелков и контрольных точек.

5. Выберите снова инструмент Pick, завершив данную операцию.

Изменение параметров оформления дорожки
1. Выделите текстовую дорожку рабочим инструментом Pick (Выбор), щелкнув

на ней.

2. Если вы хотите изменить лишь цвет дорожки или сделать ее невидимой, то
выполните это с помощью рабочей цветовой патитры, щелкнув в ней правой
кнопкой мыши на выбранном цветовом образце или образце прозрачной об-
ласти (с двумя диагональными линиями), находящемся в верхней ячейке.

3. Для изменения других параметров оформления дорожки откройте диалоговое
окно Outline Pen (Контурное перо) рабочего инструмента Outline (Контур) и
выполните настройку параметров. В этом окне вы можете задать: цвет до-
рожки (список цветовых образцов Color), ее толщину (поле Width), а также
стиль оформления (список Style).

Перемещение текстовой надписи вдоль дорожки
1. Выберите рабочий инструмент Pick (Выбор) и щелкните на любом символе

текстовой надписи, находящейся на дорожке, выделив ее. При этом слева от
надписи появится управляющий маркер красного цвета, который называется
маркером перемещения текстовой надписи (см. рис. 6.15).

2. Поместите на данном маркере указатель (он примет форму двух ортогональ-
ных двунаправленных стрелок), нажмите кнопку мыши и переместите над-
пись в заданном направлении вдоль дорожки на некоторое расстояние, после
чего отпустите кнопку мыши.

Примечание

Перемещение текстовой надписи вдоль разомкнутой дорожки имеет следую-
щую особенность. Если расстояние между маркером и концом дорожки мень-
ше, чем первоначальная длина надписи, то произойдет наложение друг на дру-
га тех символов текста, которые находятся в конце надписи.
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Перемещение текстовых символов вдоль дорожки
1. Выберите рабочий инструмент Shape (Форма).

2. Щелкните на любом символе текстовой надписи, находящейся на дорожке,
выделив ее. При этом в основании каждого символа появится небольшой
квадратный маркер белого цвета.

3. Поместите указатель на выделяющем маркере выбранного символа, нажмите
кнопку мыши и переместите символ вдоль дорожки в требуемое место, затем
отпустите кнопку мыши.

4. Повторите предыдущий щаг инструкции для всех перемещаемых символов
текстовой надписи.

Форматирование текстовых символов
1. Выберите рабочий инструмент Pick (Выбор).

2. Щелкните кнопкой мыши в свободном месте области документа, отменив
возможные выделения объектов в документе.

3. Выберите рабочий инструмент Text (Текст),

4. Установите указатель перед первым символом из группы форматируемых
символов текстовой надписи. Медленно перемещая указатель вдоль выбран-
ного символа, добейтесь такого изменения его формы, когда он будет выгля-
деть как латинская буква "I". Как только это произойдет, нажмите кнопку
мыши и выделите нужную группу символов, отпустив кнопку мыши.

5. С помощью панели свойств отрегулируйте требуемые параметры форматиро-
вания выделенных символов, такие как: шрифт (список Font List), размер
кегля (список Font Size List), а также стиль начертания символов (кнопки
Bold (Полужирный), Italic (Курсив) и Underline (Подчеркивание)).

6. В случае необходимости выполните настройку других параметров форматиро-
вания выбранных текстовых символов, открыв для этого диалоговое окно
Format Text (Форматировать текст) второй кнопкой справа на панели свойств.

Форматирование текстовой надписи
1. Выберите рабочий инструмент Pick (Выбор).

2. Выделите комбинированный объект, состоящий из текстовой надписи и до-
рожки, щелкнув на одном из символов данной надписи.

3. С помощью панели свойств настройте параметры форматирования текстовой
надписи, находящейся на дорожке. Дгтя этого выберите в списке Preset List (он
первый слева) требуемый стиль форматирования текстовой дорожки, затем от-
регулируйте при необходимости отдельные параметры форматирования.

4. Если надпись выполнена обычным текстом и вы хотите равномерно распре-
делить все ее символы по дорожке, автоматически изменив размер кегля
шрифта, то воспользуйтесь командой Text > Fit Text To Frame (Текст >
Разместить текст в рамке).
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На рис. 6.15 показаны различные варианты форматирования текстовой надписи,
находящейся на разомкнутой дорожке. Вверху изображена панель свойств в режиме
настройки параметров для выделенной надписи, расположенной первой слева.

2 3

.... J
'teM

lain

' toil?
ЕГ

a

1 L 1 1
5̂<Г235̂ : '«ЬЕ*=- 'e'«™ ; _»i5,s M T ; ^[ -

^jtUUlOVE

j&^'*2 v^xVV-12 <!-SV9~r2 ^й\э30:з

-̂  V^v gS' ..̂
eV' -̂ <*0> A>10— ••* • v

Рис. 6.15. Пример форматирования разомкнутой текстовой дорожки:
10 — маркер перемещения текстовой надписи;
11 — визуальный индикатор выбранного стиля

Поясним назначение элементов управления панели свойств в режиме формати-
рования тестовой надписи на дорожке (их номера, приведенные на рисунке,
даны в квадратных скобках):

П [1| — раскрывающийся список Preset List, предназначенный для выбора од-
ного из стилей форматирования текстовой дорожки; каждый их этих стилей
представляет собой набор параметров форматирования, сохраненный в файле
под определенным именем вместе с изображением дорожки с текстом, ис-
пользуемым в качестве визуального индикатора данного стиля;

П [2] — кнопка Add Preset, используемая для формирования нового стиля фор-
матирования дорожки;

П [3] — кнопка Delete Preset, предполагающая удаление текущего стиля (как
показала проверка, данную кнопку использовать невозможно, поскольку она
всегда заблокирована);

П [4] — список Text Orientation, позволяющий выбрать один из четырех вари-
антов ориентации текстовых символов вдоль дорожки;

G [5] — список Vertical Placement, используемый для выбора одного из пяти
вариантов вертикального расположения текста на дорожке;

П [6] — список Text Placement, содержащий три (для разомкнутой дорожки)
или четыре (для замкнутой дорожки) варианта горизонтального расположе-
ния текста;

П [7] — поле Distance from Path, используемое для задания величины верти-
кального смещения текста от дорожки при условии выбора последнего пунк-
та в списке Vertical Placement;

П [8] — поле Horizontal Offset, в котором можно задать величину дополнитель-
ного горизонтального смещения текста на дорожке;

G [9] — кнопка Place on Other Side, выполняющая зеркальный разворот текста
относительно дорожки.
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На рис. 6.16 показаны три варианта расположения текстовой надписи на замк-
нутой дорожке, представляющей собой контур эллипса. Вверху изображена па-
нель свойств. Обратите внимание, что все элементы управления панели выгля-
дят точно так же, как и на предыдущем рисунке, за исключением содержимого
списка Text Placement.

iCrCWJmm *; " US 0,0mm ^ '

Рис. 6.16. Пример форматирования замкнутой текстовой дорожки

Форматирование текста
В программе CorelDRAW 12 предусмотрены два способа форматирования тек-
стовой информации: настройкой отдельных параметров форматирования вы-
бранного текста и применением текстовых стилей.

Примечание

В современных текстовых приложениях используются текстовые стили двух ти-
пов: символьные и абзацные. В рассматриваемой программе применяются
комбинированные текстовые стили, используемые для форматирования как
отдельных символов, так и абзацев текста. В частности, в них задаются сле-
дующие параметры форматирования: шрифт, кегль, стиль начертания, меж-
строчный интервал, цвета раскраски символов и др.

Для реализации этих способов служат следующие средства CorelDRAW 12:

О панель свойств;

П панель инструментов Text (Текст);

П диалоговое окно Format Text (Форматировать текст);

П инструменты форматирования диалогового окна Edit Text (Редактировать
текст);

П вкладка Text (Текст) докера Object Properties (Свойства объекта);

G докер Graphic and Text Styles (Графические и текстовые стили);

П команды меню Text (Текст);

П горизонтальная измерительная линейка, позволяющая регулировать отступы
для обычного текста и расставлять табуляторы.
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Рассмотрим особенности форматирования текстовой информации указанными
средствами.

Панель свойств позволяет форматировать текст при работе с тремя рабочими

инструментами: l^ Pick (Выбор), 'Щ Text (Текст) и $" Shape (Форма). Если

вам необходимо отформатировать один или нескольких текстовых блоков, нахо-
дящихся на открытой странице документа, их следует выделить инструментом
Pick (последовательными щелчками при нажатой клавише <Shift>) и обработать
с помощью элементов управления панели свойств. Для форматирования неко-
торого текстового фрагмента, находящегося на текущей странице документа
в одной или нескольких связанных текстовых рамках, вы должны выделить этот
фрагмент инструментом Text и обработать его с помощью той же панели
свойств. Инструмент Shape (Форма) используется при форматировании отдель-
ных текстовых символов, расположенных в блоке в произвольном порядке.

Примечание

Если вы выделили один из связанных между собой текстовых блоков и выпол-
нили его форматирование, то возможны следующие три варианта: а) отформа-
тируется только выбранный блок; б) отформатируете* текущий и все после-
дующие блоки; в) отформатируются все блоки. Выбор соответствующего вари-
анта форматирования связанных блоков текста производится на вкладке Text
(Текст) докера Object Properties (Свойства объекта).

Панель инструментов Text (Текст) в ее стандартном виде выглядит почти так
же, как панель свойств при работе с рабочим инструментом Text или с рабочим
инструментом Pick (Выбор) при условии выбора им некоторого текстового бло-
ка (на панели Text отсутствуют три кнопки управления, входящие в состав па-
нели свойств). Данную панель целесообразно использовать лишь в том случае,
когда вы расширите ее состав, добавив новые инструменты форматирования
(см. разд. "Параметры интерфейса"гл. 8).

Диалоговое окно Format Text (Форматировать текст), открываемое одноименной
командой меню Text (Текст), обладает наиболее широкими возможностями
форматирования текстового материала. Оно используется в тех случаях, когда
с помощью указанных выше панелей инструментов нельзя задать требуемые па-
раметры форматирования текста.

С помощью инструментов диалогового окна Edit Text (Редактировать текст),
открываемого одноименной командой меню Text, вы можете выполнять почти
все операции форматирования, доступные для панели свойств или панели Text.
кроме работы со стилями. Преимущество данного окна по сравнению с указан-
ными выше панелями инструментов состоит в том, что оно позволяет формати-
ровать любую выделенную часть текстового материала, расположенного в свя-
занных текстовых рамках на любых страницах документа.

На вкладке Text (Текст) докера Object Properties (Свойства объекта) можно не
только выбрать основные параметры форматирования текста, но и определиты я
в отношении области воздействия этих параметров форматирования на связан-
ные между собой блоки обычного текста.
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Докер Graphic and Text Styles (Графические и текстовые стили) используется
для выполнения различных операций с текстовыми и графическими стилями,
а также для загрузки их в документ из файла шаблона и сохранения в этом фай-
ле (см. разд. "Стили" гл. 3).

^ Примечание

Существующие текстовые стили вы можете применять не только с помощью
докера Graphic and Text Styles, но и с помощью панели свойств при работе
с рабочими инструментами Pick (Выбор) и Text (Текст), а также панели инстру-
ментов Text (Текст).

В CorelDRAW 12 имеются и другие возможности форматирования текста, кото-
рые реализуются следующими командами меню Text (Текст):

О Fit Text To Frame (Разместить текст в рамке), используемая для автоматиче-
ского изменения кегля шрифта для блока обычного текста, размещенного
в текстовой рамке или на дорожке так, что текст полностью заполняет отве-
денную для него область;

П Align To Baseline (Выровнять по базовой линии), отменяющая параметры
форматирования текстовых символов, связанных с их вертикальным смеще-
нием;

П Straighten Text (Выровнять текст), отменяющая все параметры форматирова-
ния символов, которые определяют их вертикальное и горизонтальное сме-
щение, а также поворот относительно базовых линий.

При выполнении операции форматирования вы должны иметь в виду сле-
дующее. Если изменяемый вами параметр относится ко всему текстовому аб-
зацу (например, выключка или отступ текстовых строк), то достаточно уста-
новить текстовый курсор в любом месте текущего абзаца. Если же параметр
форматирования относится к символам текста (шрифт, кегль или стиль начер-
тания), то в этом случае обрабатываемые символы должны быть предвари-
тельно выделены мышью.

Форматирование панелями инструментов
Рассмотрим назначение элементов настройки параметров форматирования, на-
ходящихся на панели свойств и панели инструментов Text (Текст) при работе
с текстовыми объектами документа.

Панель свойств при работе
с инструментами Pick и Text
На рис. 6.17 представлен вид панели свойств при выборе текстового объекта

румента

рабочим инструментом % Pick (Выбор) или при активизации рабочего инст-

Text (Текст).
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Рис. 6.17. Панель свойств в режиме обработки текста
инструментом Pick или Text

Поясним назначение отдельных элементов управления панели свойств (их но-
мера, приведенные на рисунке, даны в квадратных скобках):

ГЗ [I] — переключатель на два положения Default Style to Edit, предназначен-
ный для выбора стиля обычного или художественного текста, используемого
по умолчанию, перед вводом текста в документ (при установке в документе
текстового курсора данный переключатель будет заблокирован);

О [2] — раскрывающийся список Style List, используемый для выбора тексто-
вого стиля;

G [3] — список Font List, в котором производится выбор текстового шрифта;

G [4] — список с редактируемым полем Font Size List, позволяющий задать
кегль используемого шрифта;

П |5] — кнопка Bold, задающая полужирное начертание текста;

П [6] — кнопка Italic, определяющая начертание курсивом;

П [7] — кнопка Underline, задающая начертание с подчеркиванием;

П [8] — кнопка Horizontal Alignment, открывающая дополнительную панель для
выбора режима горизонтального выравнивания текста, называемого выключ-
кой; на этой панели представлены следующие варианты выбора: None (Нет),
Left (Слева), Center (По центру), Right (Справа), Full (Полная) и Force Full
(Принудительная);

П [9] — кнопка Decrease Indent, дискретно уменьшающая отступ текста от ле-
вой границы текстовой области;

П [10] — кнопка Increase Indent, дискретно увеличивающая отступ текста ог
левой границы данной области;

П [11] — кнопка Show/Hide Bullet, задающая режим оформления выбранных
текстовых абзацев маркерами;

СЗ [12] — кнопка Show/Hide Drop Cap, подключающая режим оформления вы-
бранных текстовых абзацев буквицами;

П [13] — кнопка Non-printing Characters, управляющая режимом отображении
служебных (непечатаемых) символов;

П [14] — кнопка Format Text, открывающая одноименное диалоговое окно,
предназначенное для форматирования текста;

О [15] — кнопка Edit Text, открывающая одноименное диалоговое окно с це-
лью редактирования текста.
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Порядок работы с инструментом Pick

\ Отобразите на экране область документа, где находятся текстовые объ-

екты, которые необходимо отформатировать.

2. Выделите эти объекты рабочим инструментом Pick (Выбор), щелкнув на ка-
ждом из них при нажатой клавише <Shift>.

3. С помощью инструментов панели свойств выполните форматирование тек-
ста, находящегося в данных объектах. Если этих инструментов окажется не-
достаточно, откройте диалоговое окно Format Text (Форматировать текст),
щелкнув на кнопке [14] панели свойств, и отформатируйте текст.

Порядок работы с инструментом Text

Отобразите на экране в нужном масштабе область, где находятся один

или несколько связанных между собой текстовых блоков, которые необхо-
димо отформатировать.

2. Выберите рабочий инструмент Text (Текст).

3. Установите текстовый курсор в то место одного из блоков, где начинается
форматируемый фрагмент текста (он может находиться в нескольких связан-
ных блоках), нажмите кнопку мыши и выделите данный фрагмент, перемес-
тив курсор в его конец, после чего отпустите кнопку мыши.

4. Выполните форматирование выделенного текста с помощью инструментов
панели свойств. Если этих инструментов недостаточно, откройте кноп-
кой [14J диалоговое окно Format Text и отформатируйте текст там.

Панель свойств при работе с инструментом Shape

Рабочий инструмент Shape (Форма) позволяет не только обрабатывать кон-

туры Безье векторных объектов, но и форматировать текстовые символы, распо-
ложенные в блоке текста в произвольном порядке. Параметры форматирования
задаются на панели свойств, а также могут быть выбраны в диалоговом окне
Format Text (Форматировать текст).

Выбор символа для форматирования производится щелчком на квадратном мар-
кере белого цвета, расположенном внизу слева от символа (при выделении мар-
кер становится черным). Кроме выделения символа данный маркер выполняет
еще три функции:

П позволяет перемещать символ мышью по области документа;

П является тем центром, относительно которого может быть выполнен поворот
символа;

О при двойном щелчке на маркере открывается диалоговое окно Format Text.

На рис. 6.18 представлен пример форматирования текстовых символов инстру-
ментом Shape (Форма). Вверху изображена панель свойств с параметрами фор-
матирования для четырех выделенных символов.
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Рис. 6,18. Пример обработки текста инструментом Shape:
14 — маркер невыделенного символа; 15 — маркер выделенного символа

Поясним назначение отдельных элементов управления панели свойств (их но-
мера, приведенные на рисунке, указаны в квадратных скобках):

О [1] — раскрывающийся список Font List, в котором производится выбор тек-
стового шрифта;

П [2] — список с редактируемым полем Font Size List, позволяющий задать
кегль используемого шрифта;

П [3] — кнопка Bold, задающая полужирное начертание текста;

П [4] — кнопка Italic, определяющая начертание курсивом;

П [5] — кнопка Underline, задающая начертание с подчеркиванием;

П [6] — поле Horizontal Shift, в котором задается горизонтальное смешение вы-
бранных текстовых символов относительно своего исходного положения;

О [7] — поле Vertical Shift, используемое для задания вертикального смещения
данных символов;

П [8] — поле Angle of Rotation, позволяющее задать угол поворота против часо-
вой стрелки (в градусах) символов относительно своих маркеров;

О [9] — кнопка Superscript, преобразующая выделенные обычные символы тек-
ста в верхние индексы;

П [10] — кнопка Subscript, выполняющая преобразование выбранных символов
в нижние индексы;

П [И] — кнопка All Small Capitals, преобразующая текстовые символы в капи-
тели, представляющие собой уменьшенные по размеру прописные символы;

Примечание

Проверка данной кнопки показала, что для русских символов имеет место
ошибка преобразования: символы трансформируются не в капитель, а в про-
писные буквы.

П [12] — кнопка All Capitals, выполняющая преобразование выбранных симво-
лов в прописные;

П [13] — кнопка Format Text, открывающая одноименное диалоговое окно,
предназначенное для форматирования текста.
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Порядок работы с инструментом Shape

\ Отобразите на экране область документа, где находится текстовый объ-

ект, символы которого необходимо отформатировать.

2. Выберите рабочий инструмент Shape (Форма).

3. Щелкните на одном из символов текстового объекта, отобразив маркеры всех
символов.

4. Выделите те символы, которые будут форматироваться, сделав последова-
тельные щелчки на их маркерах при нажатой клавише <Shift>.

5. С помощью инструментов панели свойств выполните форматирование выде-
ленных символов. Если этих инструментов окажется недостаточно, откройте
диалоговое окно Format Text (Форматировать текст), щелкнув на кнопке 113 |
панели свойств, и отформатируйте символы.

Панель Text
На панели Text (Текст) в ее стандартном виде (см. разд. "Панели инструментов"
гл. 2) находятся те же инструменты, что и на панели свойств при работе с одно-
именным рабочим инструментом, за исключением трех кнопок, расположенных
в коние:

G Show/Hide Drop Cap (Показать/Спрятать буквицу), которая управляет
оформлением буквицей выбранного текстового абзаца;

П Format Text (Форматировать текст) и Edit Text (Редактировать текст), кото-
рые открывают одноименные диалоговые окна, предназначенные для форма-
тирования и редактирования текста.

Порядок форматирования текста инструментами панели Text (Текст) анало-
гичен использованию панели свойств при работе с рабочими инструментами
Pick и Text.

Форматирование в окне Format Text
Текст любого типа можно отформатировать в полном объеме с помощью диалого-
вого окна Format Text (Форматировать текст), открываемого командой Text >
Format Text (Текст К Форматировать текст). Для этого необходимо предварительно
выделить нужный блок текста рабочим инструментом Pick (Выбор), текстовый
фрагмент рабочим инструментом Text (Текст) или произвольный набор символов
рабочим инструментом Shape (Форма) с использованием клавиши <Shift>.

Параметры форматирования задаются на всех пяти вкладках диалогового окна
Format Text при работе с обычным текстом или на первых двух вкладках при
обработке художественного текста. На этих вкладках параметры форматирова-
ния систематизированы по функциональному признаку.

Особенность окна Format Text состоит в том, что в открытом состоянии оно не
препятствует выполнению любых операций с объектами документа, в том числе
и с теми, которые форматируются. Это означает, что в данном окне вы можете
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выполнить форматирование любых текстовых блоков документа, включая и те,
которые будут созданы после его открытия. Необходимо лишь перед переходом
к другому текстовому объекту щелкнуть на кнопке Применить, зафиксирован
новые параметры форматирования для текущего объекта, а для закрытия окна
щелкнуть на кнопке подтверждения ОК.

Опишем устройство вкладок рассматриваемого окна.

Вкладка Character

Вкладка Character (Символ) диалогового окна Format Text предназначена для на-
стройки параметров форматирования символов текста любого типа. На рис. 6.19
показан вид этой вкладки на экране в процессе настройки параметров выделен-
ных символов блока обычного текста, находящегося слева.

•
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Рис. 6.19. Пример настройки параметров форматирования текста
на вкладке Character окна Format Text

В левой части вкладки Character находятся следующие элементы настройки:

П раскрывающийся список Font (Шрифт), используемый для выбора тексто-
вого шрифта;

G поле Size (Размер), в котором задается кегль выбранного шрифта (в пунктах);

П список Style (Стиль), предназначенный для выбора стиля начертания тексто-
вых символов шрифта;

G список Script (Типы шрифтов), в котором выбирается порядок следования
символов в тексте, использующем арабские или азиатские шрифты (для ев-
ропейских шрифтов задан по умолчанию пункт Latin).

В правой части вкладки представлены следующие списки:

О Underline (Линия снизу), позволяющий выбрать один из семи вариантов
оформления текста линиями, проходящими внизу, с кнопкой редактирова-
ния параметров линий, находящейся справа;
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G Slrikcthru (Линия посредине), используемый для выбора одного из семи ва-
риантов оформления текста линиями, проходящими посередине, с кнопкой
редактирования справа;

П Overline (Линия сверху), предназначенный для выбора одного из семи вари-
антов оформления текста линиями, проходящими вверху, с кнопкой редак-
тирования справа;

G Uppercase (Верхний регистр), используемый для выбора одного из трех вари-
антов преобразования выбранных символов в прописные;

О Position (Положение), позволяющий выбрать один из трех вариантов преоб-
разования выделенных символов в индексы.

В нижней части вкладки расположены:

П вверху слева — поле, определяющее горизонтальное смещение выделенных
символов (в процентах к кеглю шрифта);

П вверху в центре — поле, задающее вертикальное смещение выбранных сим-
волов (в процентах к кеглю шрифта);

П вверху справа — поле, в котором указывается угол поворота выделенных
символов (в градусах);

П внизу — поле Range kerning (Интервальный кернинг), используемое для за-
дания величины кернинга при установке текстового курсора между двумя
символами или трекинга в случае выделения группы символов (в процентах
к ширине символа пробела).

Вкладка Paragraph
Вкладка Paragraph (Абзац) диалогового окна Format Text используется для на-
стройки параметров форматирования абзацев текста любого типа. На рис. 6.20
представлен вид этой вкладки на экране в процессе настройки параметров вы-
бранного абзаца обычного текста, находящегося слева.
В области Alignment (Выравнивание), расположенной в верхней части вкладки
Paragraph, находятся следующие элементы настройки:

П список Alignment, используемый для выбора режима горизонтального вырав-
нивания текста (выключки): без выключки (пункт None); выключка слева
(Left); выключка по центру (Center); выключка справа (Right); полная вы-
ключка, когда происходит выравнивание полных строк текста (Full Justify);
принудительная выключка, когда выравниваются все строки текста (Force
Justify);

G кнопка Settings (Настройки), открывающая диалоговое окно с предельными
коэффициентами увеличения и уменьшения интервалов между словами и
символами при работе с полными и принудительными выключками: макси-
мальный и минимальный промежутки между словами (поля Max. word
spacing и Min. word spacing); максимальный интервал между символами
(Max. char, spacing);
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Рис. 6.20. Пример настройки параметров форматирования текста
на вкладке Paragraph окна Format Text

О кнопка Hyphenation (Настройки переносов), открывающая диалоговое окно
со следующими элементами настройки текстовых переносов:

• флажок Automatic hyphenation, при установке которого задается режим ав-
томатической расстановки переносов;

• флажок Break capitalized, при установке которого подключается режим
переноса слов из прописных букв;

• поле Hot zone, в котором задается ширина зоны переноса слов;

• поле Min. word length, используемое для задания минимального количест-
ва букв в словах, допускающих переносы;

• поле Min. characters before, в котором указывается минимальное число
букв перед первым переносом;

• поле Min. characters after, определяющее минимальное число букв после
последнего переноса.

В области Spacing (Интервал), расположенной в средней части вкладки, нахо-
дятся следующие поля:

П Character (Символ), в котором указывается дополнительный промежуток
между соседними символами (в процентах к ширине символа пробела);

П Word (Слово), задающее интервал между соседними словами (в процентах
к ширине символа пробела);

П Language (Язык), используемое для ввода дополнительного промежутка меж-
ду словами, относящимися к различным языкам (в процентах к ширине сим-
вола пробела);

П Before paragraph (Перед абзацем), задающее интервал между текущим и пре-
дыдущим абзацами (в единицах измерения, заданных в списке справа);
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П After paragraph (После абзаца), определяющее промежуток между текущим и
следующим абзацами (в тех же единицах измерения, что и в поле Before
paragraph);

П Line (Строка), в котором указывается интерлиньяж, представляющий собой
промежуток между соседними строками текстового абзаца (в тех же единицах
измерения, что и в поле Before paragraph).

В области Indents (Отступы), расположенной в нижней части вкладки, представ-
лены три поля:

П First Line (Первая строка), в котором задается отступ первой строки абзаца
от девой границы текстовой области (в единицах измерения, заданных
в программе по умолчанию);

П Left (Слева), указывающее отступ последующих строк абзаца от левой грани-
цы текстовой области (в единицах измерения по умолчанию);

П Right (Справа), определяющее отступ всех строк абзаца от правой границы
текстовой области (в тех же единицах измерения).

В области Text Direction (Направление текста), расположенной под областью
Indents, находятся два раскрывающихся списка:

О Orientation (Ориентация), в котором выбирается ориентация текстовых строк
для азиатских шрифтов;

П Direction (Направление), в котором задается направление следования тексто-
вых строк для азиатских шрифтов.

Примечание

Списки Orientation и Direction будут доступны для использования только при
условии подключения в Windows XP функции по работе с иероглифами.

Вкладка Tabs
Вкладка Tabs (Табуляторы) диалогового окна Format Text предназначена для
настройки параметров табуляции для текста обычного типа.

В рабочем окне, находящемся справа, содержится список регулируемых парамет-
ров установленных табуляторов, включающий следующие наборы параметров:

П интервалы табуляции (поле Tabs);

П типы табуляторов, характеризующих выравнивание ими текста (поле
Alignment);

П флажки наличия лидирующих символов (поле Leadered).

Под рабочим окном находятся три кнопки (в порядке слева направо):

П кнопка со знаком '+', используемая для добавления нового табулятора;

П кнопка со знаком '—', позволяющая удалить выделенный в списке табулятор;

П кнопка со значком перекрестия красного цвета, с помощью которой удаля-
ются все табуляторы.
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В левой части вкладки представлены:

П кнопка Add tabs every (Добавлять табуляторы каждые) с полем справа, позво-
ляющие задать фиксированный интервал между табуляторами;

О раскрывающийся список Character (Символ), используемый для выбора об-
разца лидирующих символов;

П поле Spacing (Интервал), в котором указывается промежуток между лиди-
рующими символами.

Вкладка Columns
Вкладка Columns (Колонки) диалогового окна Format Text используется для на-
стройки параметров текстовых колонок, а также для вертикального выравнива-
ния обычного текста. Здесь находятся следующие элементы упрашюния:

П поле Number of columns (Число колонок);

П список параметров колонок, для каждой из которых указывается ее ширина
(поле Width) и промежуток между текущей и следующей колонками (поле
Gutter);

П флажок Equal column width, при установке которого все колонки будут иметь
одинаковую ширину;

П переключатель Maintain current frame width, задающий режим сохранения
ширины текстовой рамки при изменении параметров колонок;

G переключатель Automatically adjust frame width, определяющий режим автома-
тической регулировки ширины рамки при изменении параметров колонок;

П раскрывающийся список Vertical Justification (Вертикальное выравнивание),
включающий четыре режима выравнивания текста по вертикали: Тор (Сверху),,
Center (По центру), Bottom (Снизу), Full (Полное).

Вкладка Effects
Вкладка Effects (Эффекты) диалогового окна Format Text предназначена для
настройки параметров оформления маркерами или буквицами абзацев текста
обычного типа. На рис. 6.21 показан вид этой вкладки на экране в процессе на-
стройки параметров буквицы для выбранного абзаца обычного текста, находя-
щегося слева.

Данная вкладка будет пустой, если в раскрывающемся списке Effect Type (Тип
эффекта), находящемся вверху слева, выбран пункт (попе) (нет).

Если в списке Effect Type выбран пункт Bullet (Маркер), то вкладка Effects будет
содержать элементы настройки параметров оформления текста маркерами, та-
кие как:

П раскрывающийся список Font (Шрифт), предназначенный для выбора сим-
вольного шрифта;

153ак. 250



450 Глава 6

^^универсальная
"графико-изДательская

Лрограмма,

Character | Paragraph J Tabs | Columns Effect' |

Drcpfled lmei:

Indents

Distance from text;

Dropped- Hanging Insert

Рис. 6.21. Пример настройки параметров форматирования текста
на вкладке Effects окна Format Text

О список Symbol (Символ), позволяющий выбрать образец символа заданного
шрифта, который будет использован в качестве маркера;

П поле Symbol, в котором задается и отображается порядковый номер выбран-
ного символа;

П поле Size (Размер), определяющее кегль выбранного шрифта;

П поле Baseline Shift (Смещение от базовой линии), задающее смещение мар-
кера от базовой линии текста;

П поле Position (Положение), в котором указывается величина отступа маркера
от левой границы текстовой области;

П кнопка Bulk1 ted (Маркированный), задающая вариант оформления текста
маркером со смещением первой строки абзаца текста;

П кнопка Hanging Indent (Висячий отступ), определяющая вариант оформления
текста со смешением вправо всех строк абзаца.

Если в списке Effect Type выбран пункт Drop Cap (Буквица), то на вкладке
Effects будут представлены элементы настройки параметров оформления текста
буквицами. К ним относятся:

П поле Dropped lines (Спадающие строки), используемое для задания числа
верхних строк абзаца, на которые будет спускаться вниз буквица;

П! поле Distance from text (Расстояние от текста), в котором указывается вели-
чина отступа буквицы от текста;

О кнопка Dropped (Спадающая), задающая вариант оформления текста букви-
цей со смещением первых строк абзаца текста;

О кнопка Hanging Indent (висячий отступ), определяющая вариант оформления
текста со смещением вправо всех строк абзаца.
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Порядок работы
1. Отобразите в нужном масштабе область документа, где находится первая по

порядку группа текстовых объектов, требующих форматирования.

2. Откройте диалоговое окно Format Text (Форматировать текст), выполнив
команду Text » Format Text (Текст > Форматировать текст). Доступ к этой
команде имеется также на панели свойств (кнопка с буквой "F" в правой час-
ти панели свойств) при условии выбора рабочего инструмента Text (Текст)
или при выделении некоторого текстового объекта рабочим инструментом
Pick (Выбор). Расположите на экране окно Format Text таким образом, что-
бы оно не закрывало форматируемые текстовые объекты.

3. Нажмите внизу окна кнопку с изображением замка, подключив режим авто-
матического обновления параметров обрабатываемого текста после их изме-
нения.

4. Выполните одно из трех действий:

• выберите инструментом Pick (с помощью клавиши <Shift>) текстовые
объекты, для которых будут задаваться одинаковые параметры формати-
рования;

• выделите инструментом Text требуемый текстовый фрагмент, который
может находиться в нескольких связанных блоках;

• выделите рабочим инструментом Shape (Формат) и клавишей <Shift> от-
дельные текстовые символы.

5. Последовательно открывая вкладки окна команды, выполните настройку
необходимых параметров форматирования текста.

Примечание

Если вы хотите по виду обрабатываемого текста убедиться в действии некото-
рого параметра, новое значение которого было введено в соответствующее
поле вкладки окна, выполните щелчок мышью в любом другом поле данной
вкладки или измените другой параметр.

6. Повторите шаги 4 и 5 инструкции для остальных текстовых объектов доку-
мента, подверженных форматированию.

7. Закройте окно Format Text, щелкнув на кнопке подтверждения ОК.

Форматирование в окне Edit Text
Если текстовый материал находится в связанных между собой текстовых блоках,
то его форматирование удобнее всего выполнять в диалоговом окне Edit Text
(Редактировать текст), для открытия которого используется одноименная
команда меню Text (Текст). В частности, только таким образом вы сможете от-
форматировать за один прием текстовый материал, расположенный на несколь-
ких страницах документа.
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Форматирование в окне Edit Text производится с помощью инструментов, рас-
положенных на верхней панели данного окна, а также диалогового окна Format
Text (Форматировать текст), открываемого кнопкой, расположенной крайней
справа.

Примечание

Диалоговое окно Format Text, вызываемое из окна Edit Text, отличается от од-
ноименного окна команды Text > Format Text (Текст > Форматировать текст)
тем, что для текста обычного типа вкладка Columns (Колонки) будет в нем за-
блокирована.

На рис. 6.22 показаны инструменты форматирования диалогового окна Edit Text.

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15
„ J __ 1 1 1 1 1 1 1 1 1 1 1 1 1 L.

4_L
ArialCyr '{f | I 24

Рис. 6.22. Инструменты форматирования окна Edit Text: 1 — шрифт;
2 — кегль шрифта; 3 — полужирное начертание; 4 — начертание курсивом;
5 — начертание с подчеркиванием; 6 — без выключки; 7 — выключка слева;

8 — выключка по центру; 9 — выключка справа; 10 — полная выключка;
11 — принудительная выключка; 12 — оформление текстовых абзацев маркерами;

13 — оформление абзацев буквицами; 14 — режим отображения служебных символов;
15 — открытие диалогового окна Format Text

Порядок работы
1. Откройте документ на странице, где находится один из связанных текстовых

объектов, содержащих нужный вам текстовый материал.

2. Выделите данный объект рабочим инструментом Pick (Выбор) или выберите ра-
бочий инструмент Text (Текст), установив в любом его месте текстовый курсор.

3. Выполните команду Text > Edit Text (Текст > Редактировать текст), доступ
к которой имеется также через панель свойств (кнопка со значком "аЫ",
расположенная крайней справа на панели свойств). В результате откроется
диалоговое окно Edit Text (Редактировать текст).

4. Выделите в рабочем окне данного окна фрагмент текста, который будет
форматироваться.

5. Выполните операцию форматирования с помощью соответствующих инстру-
ментов окна команды (см. рис. 6.22), а если их недостаточно, то откройте
также диалоговое окно Format Text (Форматировать текст), щелкнув на од-
ноименной кнопке (она крайняя справа).

6. Повторите шаги 4 и 5 инструкции для всех требуемых фрагментов текстового
материала.

7. Закройте окно Edit Text щелчком на кнопке подтверждения ОК.
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Форматирование докером Object Properties
Если для выделенного текстового фрагмента или целого блока текста выполнить
команду Properties (Свойства), находящуюся в основном меню Edit (Правка)
или в контекстном меню рабочего окна документа, то на экране откроется до-
кер Object Properties (Свойства объекта) с шестью вкладками, среди которых
есть и вкладка Text (Текст). С ее помощью вы можете отформатировать любые
фрагменты или целые блоки текста, а также задать область воздействия пара-
метров форматирования на связанные между собой блоки обычного текста.
Кроме того, на вкладке General (Общие) данного докера вы можете выбрать
текстовый стиль для выделенного текста, а также настроить параметры тексто-
вой оборки для объекта, находящегося внутри текста.

На рис. 6.23 показан вид докера Object Properties, открытого на вкладке Text.

Object Properties:

а и

Range; ...

fflSelected And Subseq... *•

Рис. 6.23. Вкладка Text докера Object Properties

Порядок работы
1. Выделите рабочим инструментом Text (Текст) текстовый фрагмент либо ра-

бочим инструментом Pick (Выбор) один или несколько блоков текста. Если
выделяемый блок обычного текста расположен внутри векторного объекта,
то для его выделения инструментом Pick необходимо нажать клавишу <Ctrl>
и щелкнуть мышью в области объекта.

2. Откройте докер Object Properties (Свойства объекта) командой Edit t
Properties (Правка > Свойства) или командой Properties контекстного меню
рабочего окна документа. Перейдите на вкладку Text (Текст) докера, щелк-
нув на ее ярлычке.
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3. Если выбранный текстовый объект представляет собой блок обычного тек-
ста, связанный с другими блоками, то задайте область воздействия парамет-
ров форматирования на эти блоки. Для этого откройте список Range (Диапа-
зон), находящийся внизу вкладки докера, и выберите в нем один из
следующих трех пунктов: Selected Frames Only (Только выделенные рамки),
Selected And Subsequent Frames (Выделенная и все последующие рамки) или
All Frames (Все рамки).

4. Задайте те параметры форматирования текста, которые вам необходимы: шрифт
(список Font),, кегль (список Size), порядок следования символов в тексте с араб-
скими или азиатскими шрифтами (список Scripts), стиль начертания символов
(кнопки Bold, Italic и Underline), выключку (кнопка Horizontal Alignment). Если
этих параметров вам недостаточно, выполните форматирование текста в диало-
говом окне Format Text (Форматировать текст), открыв его щелчком на кнопке
с буквой "F", находящейся внизу справа.

5. Щелкните на кнопке Apply (Применить), если вами не был предварительно
задан режим автоматического обновления параметров форматирования путем
нажатия кнопки с изображением замка.

6. Закройте докер Object Properties, щелкнув на кнопке с перекрестием в его
правом верхнем углу.

Работа с интервальными маркерами
и табуляторами
При работе с обычным текстом у вас может возникнуть потребность сместить
строки этого текста относительно границ рамки, в котором он находится, а так-
же представить текст в табличном виде с помощью табуляторов. Как известно,
эти операции могут быть выполнены на вкладках Paragraph (Абзац) и Tabs
(Табуляторы) диалогового окна Format Text (Форматировать текст), описанного
ранее.

Однако проще всего сделать указанные операции в интерактивном режиме
с помощью элементов управления, которые располагаются на горизонтальной
измерительной линейке при условии выбора в документе абзаца или всего блока
обычного текста (см. рис. 6.24).

В этом случае смещение текстовых строк абзаца относительно границ текстовой
рамки выполняется с помощью трех интервальных маркеров, а представление
текста в табличном виде — с использованием табуляторов четырех типов, для
которых предусмотрены следующие операции:

О установка нового табулятора (щелчком мыши в нужном месте линейки);

П изменение положения табулятора (перетаскиванием его мышью вдоль ли-
нейки);

П удаление табулятора (перетаскиванием его мышью в область документа);

П изменение типа выбранного табулятора (установкой на нем указателя, рас-
крытием правой кнопкой контекстного меню и выполнением команды с на-
званием требуемого типа табулятора).
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На рис. 6.24 слева показан пример работы с интервальными маркерами, а спра-
в а — с табуляторами.

1 2 3 6

'•

Программа векторной гра-
фики CorelDRAW 12 обладает
широкими возможностями обра-
ботки текстовой информации.I

Рис. 6.24. Пример работы с интервальными маркерами и табуляторами

Поясним назначение элементов управления измерительной линейки, представ-
ленных и пронумерованных на рисунке (их номера даны здесь в квадратных
скобках):

П [1] — интервальный маркер, регулирующий отступ всех строк выбранного
абзаца текста от левой границы текстовой рамки;

П [2] — интервальный маркер, регулирующий отступ второй и последующих
строк текущего абзаца от левой границы рамки;

П [3] -~ интервальный маркер, регулирующий отступ первой строки данного
абзаца от левой границы рамки;

П [4] — интервальный маркер, регулирующий отступ всех строк выбранного
абзаца текста от правой границы рамки;

П [5] — левый табулятор (left tab), по которому происходит выравнивание ле-
вой границы текста;

П [6] — центральный табулятор (center tab), по которому происходит выравни-
вание середины текста;

П [7] — правый табулятор (right tab), по которому происходит выравнивание
правой границы текста;

П [8] — десятичный табулятор (decimal tab), по которому происходит выравни-
вание разделительных знаков (запятых), отделяющих целые части чисел от
дробных.

Редактирование текста
В CorelDRAW 12 предусмотрены весьма широкие возможности редактирования
текстовой информации, соизмеримые с возможностями современного текстового
редактора. Перечислим основные функции программы по редактированию текста:

П выделение текстового фрагмента двумя способами:

• протягиванием текстового курсора при нажатой кнопке мыши;

• установкой курсора в начальной точке выделяемого фрагмента, нажатием
клавиши <Shift> и щелчком мыши в конечной точке;
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П перенос выделенного фрагмента текста в другое место двумя способами:

• через буфер обмена Windows;

• перетаскиванием мышью при нажатой ее кнопке;

П удаление выделенного фрагмента текста двумя способами:

• клавишей <Del>;

• через буфер обмена;

П поиск и замена в тексте документа заданных текстовых фрагментов (с воз-
можным учетом регистра символов);

П отображение в тексте документа ошибочных слов путем их подчеркивания
красными волнистыми линиями при условии выбора рабочего инструмента
Text (Текст);

О поиск и исправление орфографических ошибок в тексте любого языка, под-
ключенного при установке программы;

П поиск и исправление грамматических ошибок в английском тексте;

П замена в английском тексте слов на синонимы, хранящиеся в словаре сино-
нимов (тезаурусе) данного языка;

О режим автозамены (quick correct — быстрое исправление), состоящий в автома-
тическом исправлении описок в тексте и формировании служебных символов;

П заданное изменение регистра символов для выделенного текстового фрагмента;

П подсчет числа букв и слов в выделенном тексте или во всем документе.

Операции редактирования можно выполнять двумя способами:

П непосредственно в документе с помощью мыши и команд меню Text (Текст)
(см. раздел "Команды меню Тех!" гл. 9);

О в диалоговом окне Edit Text (Редактировать текст), открываемом одноимен-
ной командой меню Text (см. рис. 6.25).

При работе с небольшими фрагментами текста, не имеющими между собой свя-
зей, их редактирование целесообразно выполнять непосредственно в документе.
Если же текстовый материал достаточно большой по размеру и состоит из не-
скольких связанных текстовых блоков, в этом случае его удобнее всего редакти-
ровать в диалоговом окне Edit Text.

^го связано с двумя причинами. Во-первых, весь текст, с которым вы работаете,
находится в рабочем окне данного окна и оформлен однообразно (размеры всех
букв здесь одинаковы). На самом же деле этот текст может состоять из нескольких
связанных между собой текстовых блоков, расположенных в различных местах до-
кумента и иметь разные параметры форматирования для отдельных его фрагментов.
Во-вторых, в окне Edit Text имеется доступ почти ко всем командам редактирования
текста, а также к инструментам форматирования и команде импорта.

^ Примечание

В CorelDRAW 12 не функционируют применительно к русским текстам режимы
проверки грамматики и тезауруса, тогда как для английских текстов они работают.
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Для загрузки в диалоговое окно Edit Text требуемого текстового материала до-
кумента этот материал необходимо прежде всего выбрать. Это можно сделать
двумя способами: выделением одного из текстовых блоков материала рабочим
инструментом Pick (Выбор) или установкой в любом его месте текстового кур-
сора рабочим инструментом Text (Текст). Затем следует открыть окно Edit Text
щелчком на одноименной кнопке панели свойств (она крайняя справа) или вы-
полнением команды Text t Edit Text (Текст > Редактировать текст).

Окно Edit Text
Диалоговое окно Edit Text (Редактировать текст) изображено на рис. 6.25.

If Arid Cyr J II >~А£ яг

За горами, за лесами,
За широкими морями,
Не на небе - на земле
Жил старик в одном селе.
У старинушки три сына:
Старший умный был детина,

Средний сын и так и сяк,
Младший вовсе был дурак.

П.П. Ершов!

,

Options т Import,.. Cancel Help

Рис. 6.25. Диалоговое окно Edit Text

Рассмотрим устройство данного окна. На верхней его панели расположены
инструменты, с помощью которых вы можете отформатировать текущий тек-
стовый материал (см. разд. "Форматирование текста" данной главы, подразд.
"Форматирование в окне Edit Text"). В центре находится рабочее окно с верти-
кальной полосой прокрутки, предназначенное для размещения выбранного
текстового материала. Внизу расположено пять кнопок управления (назначе-
ние последних трех кнопок понятно из их названий, а описание первых двух
рассмотрим более подробно).
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Кнопка Options (Параметры) открывает контекстное меню команд. С их помо-
щью вы можете выполнять различные операции редактирования текста, а также
производить настройку параметров программы, относящихся к работе с тексто-
вой информацией. В данное меню входят следующие команды:

П Select All (Выделить все), выделяющая весь текст в рабочем окне диалогового
окна Edit Text;

П подменю Change Case (Изменить регистр) содержит пять команд, позволяю-
щих изменить регистр символов для выделенных текстовых символов:
Sentence case (Как в предложении), lowercase (все буквы строчные),
UPPERCASE (ВСЕ БУКВЫ ПРОПИСНЫЕ), Title Case (Первая Буква Слова
Прописная) и tOGGLE cASE (ИЗМЕНЕНИЕ РЕГИСТРА ДЛЯ ВСЕХ БУКВ);

О Find Text (Найти текст), предназначенная для поиска в текущем текстовом
материале выбранного слова или фразы;

G Replace Text (Заменить текст), используемая для замены в данном материале
одного слова (фразы) другим;

П Spell Check (Орфография), выполняющая проверку текста на наличие орфо-
графических ошибок и их исправление;

П Grammatik (Грамматика), производящая проверку и исправление грамматиче-
ских ошибок;

П Thesaurus (Тезаурус), используемая для вставки слов-синонимов из словаря
синонимов (тезауруса);

О Show Font (Показать шрифт), управляющая режимом представления текста
в рабочем окне символами используемого шрифта при фиксированном раз-
мере его кегля;

П Show Toolbar (Показать панель инструментов), управляющая режимом выво-
да инструментов форматирования на верхнюю панель окна Edit Text;

П Text Options (Параметры текста), открывающая диалоговое окно Options
(Параметры) на вкладке Workspace > Text (Рабочая область * Текст) с пара-
метрами настройки режимов работы с текстовой информацией.

Кнопка Import (Импорт) окна Edit Text открывает одноименное диалоговое ок-
но команды импорта, позволяющее вставлять в документ текстовую информа-
цию из выбранного файла. Данная информация будет вставлена в то место те-
кущего текстового материала, где находится текстовый курсор, или вместо
выделенного фрагмента текста.

Обработка обычного текста
В этом разделе рассматриваются различные операции обработки текста обыч-
ного типа, в том числе:

G трансформация рамки и текста;

П перетекание текста;

П формирование текстовых оборок.
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Трансформация
Для блока обычного текста, расположенного в рамке объекта или документа,
можно выполнять следующие операции трансформации:

О трансформация текстовой рамки:

• масштабирование рамки;

• поворот рамки с текстом;

• наклон рамки;

• зеркальные развороты рамки (горизонтальный и вертикальный);

• изменение формы рамки документа;

• изменение формы рамки объекта;

П трансформация текстовых символов:

• перемещение символов текста;

• изменение размеров символов;

• поворот символов.

На рис. 6.26 показан пример изменения формы прямоугольной рамки докумен-
та с помощью оболочки. Вверху расположена панель свойств с параметрами на-
стройки, которые при этом использовались.

'Presets... О

П

ххЗа горами, за лесами,
За широкими морями,

на небе - на земле
Жил старик в одном селе,

,У старинушки три сына:

L:

В В

Рис. 6.26. Пример изменения формы прямоугольной рамки объекта
с помощью оболочки

Масштабирование рамки
1. Выберите рабочий инструмент Pick (Выбор).

2. Выделите щелчком мыши блок обычного текста, находящийся в рамке доку-
мента или объекта.
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3. Для изменения вертикального размера рамки установите указатель на одном
из серединных выделяющих маркеров белого цвета, расположенном над или
под рамкой, и переместите его вниз или вверх при нажатой кнопке мыши.
Чтобы в процессе изменения размера рамки сохранить положение ее геомет-
рического центра, выполняйте перемещение выбранного маркера при нажа-
той клавише <Shift>.

4. Для изменения горизонтального размера рамки установите указатель на од-
ном из серединных маркеров черного цвета, находящемся слева или справа
от рамки, и переместите его влево или вправо. Для сохранения положения
центра рамки при изменении ее размера перемещайте маркер при нажатой
клавише <Shift>.

5. Для пропорционального изменения размеров рамки установите указатель на
одном из ее угловых маркеров и переместите его по диагонали в нужном на-
правлении. Чтобы положение центра рамки сохранялось при изменении ее
размеров, выполняйте перемещение выбранного маркера при нажатой кла-
више <Shift>,

Поворот рамки с текстом
1. Выделите текстовый объект рабочим инструментом Pick (Выбор), щелкнув на

нем мышью.

2. Щелкните еще один раз внутри объекта, перейдя в режим его поворота и на-
клона (выделяющие маркеры примут при этом вид двунаправленных стрелок).

3. Отрегулируйте положение центра вращения объекта, если он не должен сов-
падать с геометрическим центром объекта. Для этого поместите указатель на
метку центра вращения (она имеет вид небольшой окружности с точкой по-
середине), нажмите кнопку мыши и переместите метку в требуемое место,
после чего кнопку отпустите.

4. Установите указатель на одном из угловых выделяющих маркеров, нажмите
кнопку мыши и поверните текстовый объект в заданном направлении на
требуемый угол.

Наклон рамки
1. Выделите текстовый объект рабочим инструментом Pick (Выбор), щелкнув на нем.

2. Выполните еще один щелчок внутри объекта, перейдя в режим поворота и
наклона текстовой рамки.

3. Чтобы наклонить вертикальные стороны прямоугольной области охвата тек-
стовой рамки, установите указатель на одном из серединных выделяющих
маркеров, расположенных над и под рамкой, и переместите его при нажатой
кнопке мыши влево или вправо на заданное расстояние.

4. Для наклона горизонтальных сторон области охвата рамки установите указа-
тель на одном из серединных маркеров, находящихся слева и справа от рам-
ки, и переместите его вверх или вниз.
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Зеркальный разворот рамки
В CorelDRAW 12 вертикальный и горизонтальный зеркальные развороты рамки
с текстом существенно отличаются. Так, при выполнении операции вертикаль-
ного разворота произойдет разворот только рамки (без изменения ориентации
текстовых строк). Если же выполнить горизонтальный разворот рамки, то текст
внутри нее повернется на 180° вокруг центра рамки. Обе эти операции лучше
всего выполнять с помощью докера Transformation (Трансформация), поскольку
панель свойств будет недоступной для разворота рамки документа.

Порядок зеркального разворота состоит в следующем.

1. Выделите рамку с текстом рабочим инструментом Pick (Выбор).

2. Откройте докер Transformation (Трансформация) на вкладке Scale and Mirror
(Масштаб и зеркальный разворот), выполнив для этого команду
Arrange > Transformations V Scale (Расположить > Трансформации * Масштаб).

3. Для горизонтального разворота текстовой рамки (относительно вертикальной
оси ее симметрии) с одновременным поворотом текста на 180° нажмите мы-
шью первую сверху кнопку в докере Transformation, после чего щелкните на
кнопке Apply (Применить) внизу докера.

4. Для вертикального разворота рамки (относительно горизонтальной оси сим-
метрии) нажмите мышью вторую сверху кнопку в докере и щелкните на
кнопке Apply.

5. Закройте докер Transformation.

Изменение формы рамки документа
1. Выделите рабочим инструментом Pick (Выбор) блок текста, расположенный

в прямоугольной рамке документа,

2. Выберите рабочий инструмент Interactive Envelope (Интерактивная оболоч-
ка), заключив текстовую рамку в оболочку, доступную для обработки.

3. Отрегулируйте форму оболочки, используя для этого ее узелки и контроль-
ные точки, а также элементы управления панели свойств (см. разд. "Создание
эффектов"гл. 4, подразд. "Оболочка").

4. Выберите снова инструмент Pick, завершив обработку формы рамки.

Изменение формы рамки объекта
1. Выберите рабочий инструмент Pick (Выбор).

2. Поместите указатель на контуре (но не внутри) векторного объекта, содер-
жащего блок текста, и щелкните кнопкой мыши. Признаком правильного
выделения объекта является наличие на панели свойств списка Outline Width
(Толшина обводки), используемого для задания толщины обводки. Отсутст-
вие данного списка означает, что при выделении объекта кончик указателя
находился внутри него. В этом случае отмените выделение объекта щелчком
в свободной области документа и повторно выполните данную операцию.
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3. Если данный объект представляет собой стандартную геометрическую фигуру
(прямоугольник, эллипс или многоугольник), то преобразуйте ее контур
Б кривую Безье. Для этого выполните команду Arrange > Convert To Curves
(Расположить > Преобразовать в кривые) или щелкните на кнопке Convert To
Curves, расположенной крайней справа на панели свойств.

4. Выберите рабочий инструмент Shape (Форма) и откорректируйте форму тек-
стовой рамки с помощью узелков и контрольных точек.

5. Выберите снова инструмент Pick, завершив данную операцию.

Перемещение текстовых символов
1. Выделите требуемый текстовый объект рабочим инструментом Pick (Выбор).

2. Если для данного объекта был ранее создан эффект оболочки, то отмените
его с помощью команды Effects > Clear Effect (Эффекты > Удалить эффект),
в названии которой будет указан имеющийся эффект, иначе вы не сможете
перемещать символы мышью.

3. Выберите рабочий инструмент Shape (Форма), отобразив у основания каж-
дого текстового символа небольшой квадратный маркер белого цвета.

4. Поместите указатель на маркер выбранного символа, нажмите кнопку мыши
и перетащите символ в нужное место области текстовой рамки, после чего
кнопку отпустите.

5. Повторите предыдущий шаг инструкции для всех перемещаемых символов
текстового блока.

Изменение размеров символов

1. Выполните одно из трех действий:

• выберите рабочий инструмент Pick (Выбор) и щелчком мыши выделите
весь блок обычного текста (при нажатой клавише <Ctrl>, если он нахо-
дится в рамке объекта);

• выберите рабочий инструмент Text (Текст) и выделите им требуемый
фрагмент текста;

• выберите рабочий инструмент Shape (Форма) и последовательными щелчками
мыши (при нажатой клавише <Shift>) выделите требуемые символы текста.

2. Откройте список Font Size (Размер шрифта), расположенный в центре пане-
ли свойств, и выберите в нем новое значение кегля шрифта.

3. Нажмите клавишу <Enter>.

Поворот символов
1. Выделите текстовый объект рабочим инструментом Pick (Выбор).

2. Если для данного объекта был ранее создан эффект оболочки, то отмените
его командой Effects > Clear Effect (Эффекты » Удалить эффект), поскольку
иначе вы не сможете выполнить данную операцию.
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3. Выберите рабочий инструмент Shape (Форма), отобразив у основания каж-
дого текстового символа небольшой квадратный маркер белого цвета.

4. Выделите требуемые символы, выполнив последовательные щелчки на их
маркерах при нажатой клавише <Shift>, при этом маркеры станут черного
цвета.

5. Введите значение угла поворота в поле Angle of Rotation (Угол поворота) па-
нели свойств и нажмите клавишу <Enter>.

Перетекание текста
В документе CorelDRAW 12 допускается размещение обычного текстового мате-
риала в разных местах, в том числе и на различных страницах, при сохранении
информационных связей между отдельными блоками материала. На практике
это означает установление связей (назовем их текстовыми) между текстовыми
рамками и дорожками, которые соединяются друг с другом в одну цепочку.
Ввод текста производится в исходную рамку, при заполнении которой текст ав-
томатически перетекает в следующую рамку и так далее.

На рис. 6.27 представлен пример размещения текста обычного типа в трех свя-
занных объектах: текстовой рамке документа, текстовой дорожке и текстовой
рамке объекта, имеющей форму эллипса.

п.................. .....................
. 'За горами, за лесами,

/ За широкими морями,
/Не на небе - на земле
Жил старик в одном селе.
ХУ старинушки три сына:

'•Старший умный был детина,
" " "

ж

Младший
вовсе был дурак

Л.П. Ершов

Рис. 6.27. Пример перетекания обычного текста
между различными объектами документа

В CorelDRAW 12 текстовые связи, обеспечивающие перетекание обычного тек
ста между объектами, могут быть сформированы двумя способами.
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Формирование текстовых связей (первый способ)
1. Создайте и расположите в нужных местах страниц документа объекты, в ко-

торые будет помешен текстовый материал. В качестве таких объектов могут
использоваться текстовые рамки обоих типов, текстовые дорожки, а также
векторные объекты с замкнутыми и разомкнутыми контурами. При этом
первый по порядку объект, в который будет вводиться текстовая информация
(или она там уже имеется), обязательно должен иметь текстовую рамку.

2. Выделите исходный объект рабочим инструментом Pick (Выбор).

3. Установите указатель на нижнем серединном маркере объекта и щелкните
мышью. При этом указатель примет вид страницы с текстом, от правого
нижнего утла которой отходит по диагонали стрелка.

4. Перейдите на ту страницу документа, где находится следующий по порядку
объект, с которым должна быть установлена связь, и подведите к нему указа-
тель, который теперь примет вид жирной стрелки. Щелкните мышью, уста-
новив между этими объектами одностороннюю связь (текст будет перетекать
из первого объекта во второй). Если второй объект до установления связи
был графическим, то в результате он преобразуется в текстовую рамку или
дорожку.

^ Примечание

Если не подводить указатель к объекту, с которым должна быть установлена
связь, а поместить в свободном месте документа, то при щелчке мышью будет
создана прямоугольная текстовая рамка документа, связанная с исходным
объектом (размеры этой рамки буду теми же, что и у страницы документа). Ес-
ли щелчок выполнить в области страницы, то данная рамка расположится по
ее контуру, а если в другом месте рабочего окна документа, то положение ле-
вой верхней вершины рамки будет совпадать с местом нахождения указателя
в момент щелчка.

5. Повторите шаги 2—4 инструкции для всех остальных связываемых объектов,
принимая во внимание следующие особенности организации связи с исполь-
зованием текстовой дорожки:

• дорожку можно связать со следующим по порядку объектом лишь при ус-
ловии, что на ней находится какой-либо текст;

• если векторный объект, в который должен перетекать текст, имеет замкну-
тый контур, то при установлении с ним связи будет сформирована тексто-
вая рамка. Для преобразования этой рамки в дорожку вы должны выпол-
нить команду Text t Fit Text To Path (Текст > Разместить текст на дорожке).

Формирование текстовых связей (второй способ)
1. Создайте и расположите на активной странице документа объекты, в кото-

рых будет помещен текстовый материал. В качестве таких объектов могут ис-
пользоваться лишь текстовые рамки обоих типов и текстовые дорожки.
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2. Выберите рабочий инструмент Pick (Выбор).

3. Выделите связываемые текстовые объекты, делая на них последовательные
щелчки при нажатой клавише <Shift> в порядке, обратном по отношению
к порядку перетекания между ними текста (исходный объект необходимо
всегда выделять последним).

4. Выполните команду Text > Link (Текст > Связать).

Разрыв текстовых связей
Для разрыва связи, установленной между двумя текстовыми рамками (дорожка-
ми), необходимо выделить эти рамки рабочим инструментом Pick (Выбор)
и выполнить команду Text > Unlink (Текст > Удалить связь). При этом текст, ко-
торый находился во второй и последующих рамках, будет помещен в первую
рамку, переполнив ее.

Текстовые оборки
Текстовой оборкой называется пустая область в тексте обычного типа, которая
появляется из-за обтекания текстом объекта, находящегося внутри него.
В CorelDRAW 12 оборки можно создавать для объектов любых типов (вектор-
ных, растровых, текстовых и OLE-объектов), за исключением лишь разомкну-
тых векторных контуров.

Текстовые оборки можно формировать двумя способами:

П с помощью кнопки Wrap Paragraph Text (Обтекать объект обычным текстом)
панели свойств;

П с использованием вкладки General (Общие) докера Object Properties (Свойст-
ва объекта), раскрываемого тремя командами Properties (Свойства), первая из
которых находится в меню Edit (Правка), вторая — в подменю Dockers (До-
керы) меню Window (Окно), а третья — в контекстном меню рабочего окна
документа.

Последний способ может использоваться применительно к объектам любых
доступных типов, а первый — лишь для объектов трех типов (для остальных
объектов кнопка Wrap Paragraph Text на панели свойств будет отсутствовать):

П объекты векторной графики с замкнутыми контурами;

П текстовые рамки объектов;

П растровые изображения.

Оборка может быть сформирована либо по периметру объекта или его прямо-
угольной выделяющей области, либо с одной из сторон объекта (данной облас-
ти). В CorelDRAW 12 допускается регулировка отступа текста от границ объекта.
При этом порядок взаимного расположения объекта и текста по толщине доку-
мента совершенно не важен (объект может находиться как перед текстом, так
и позади него, хотя проще выделять объект, находящийся сверху).
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Если объект, для которого создается оборка, яатяется растровым, то для него
можно сформировать произвольную область обтекания с помощью обтравочного
контура (см. разд. "Общие операции" гл. 5, подразд. "Работа с обтравочными контура-
ми"). Для объектов других типов используется следующий искусственный прием
создания произвольной оборки. Формируется вспомогательный векторный объект
требуемой формы, который располагается в нужном месте текста. Для этого объ-
екта создается текстовая оборка, после чего он делается прозрачным.

На рис. 6.28 слева показаны два образца текстовых оборок, а справа — панель
управления инструмента Wrap Paragraph Text (Обтекать объект обычным тек-
стом) с параметрами оформления нижней оборки.

... -О о Г

Wrapping Style:

Щ None

Contour --------

Ш. Text Flows Left

3 Text Flows Right

!f2 Straddle Text

Square - -

E£ Text Flows Left

f'*-\lj% Text Flows Right

Ш Straddle Text

Above/Below

Text wrap

OK Cancel

Рис. 6.28. Пример создания текстовых оборок первым способом

Порядок создания оборки (первый способ)
1. Создайте или импортируйте векторный или растровый объект, вокруг кото-

рого будет сформирована оборка в тексте.

2. Расположите данный объект в нужном месте блока обычного текста и выде-
лите его рабочим инструментом Pick (Выбор). При этом в правой части па-
нели свойств появится кнопка Wrap Paragraph Text (Обтекать объект обыч-
ным текстом).

3. Щелкните на данной кнопке, открыв дополнительную панель с параметрами
настройки текстовой оборки.
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4. Задайте стиль оформления текстовой оборки, выбрав одну из следующих
кнопок (в порядке сверху вниз):

• None — обтекание текстом объекта отсутствует;

• Text Flows Left — обтекание текстом слева объекта;

• Text Flows Right — обтекание справа объекта;

• Straddle Text — обтекание с обеих сторон объекта;

• Text Flows Left — обтекание текстом слева прямоугольной выделяющей
области объекта;

• Text Flows Right — обтекание справа выделяющей области;

• Straddle Text — обтекание с обеих сторон данной области;

• Above/Below — обтекание текстом сверху и снизу объекта.

5. Задайте в поле Text wrap величину отступа текста от границ объекта.

6. Щелкните на кнопке подтверждения ОК.

Порядок создания оборки (второй способ)
1. Расположите объект для оборки в нужном месте блока обычного текста и

выделите его рабочим инструментом Pick (Выбор).

2. Откройте докер Object Properties (Свойства объекта), выполнив команду
Properties (Свойства) контекстного рабочего окна документа. Перейдите па
вкладку General (Общие).

3. Раскройте в докере список Wrap paragraph text (Обтекать объект обычным
текстом) и выберите в нем требуемый стиль оформления текстовой оборки:

• обтекание текстом отсутствует (пункт None);

• обтекание текстом слева объекта (Contour - Text Flows Left);

• обтекание справа объекта (Contour — Text Flows Right);

• обтекание с обеих сторон объекта (Contour — Straddle Text);

• обтекание текстом слева прямоугольной выделяющей области объекта
(Square — Text Flows Left);

• обтекание справа выделяющей области (Square — Text Flows Right):

• обтекание с обеих сторон данной области (Square — Straddle Text);

• обтекание текстом сверху и снизу объекта (Above/Below).

4. Введите в поле Text wrap величину отступа текста от объекта.

5. Щелкните на кнопке подтверждения Apply (Применить).

6. Закройте докер Object Properties.
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Обработка художественного текста
В разделе рассматриваются различные операции обработки текста художествен-
ного типа.

Трансформация
Как известно, образеп художественного текста обладает свойствами текстового
и векторного объектов, поэтому возможности его трансформации шире, чем для
обычного текста. Перечислим операции, обеспечивающие изменение формы
блока художественного текста:

П масштабирование текстового блока или его выбранных символов;

П поворот блока или выделенных символов;

П наклон блока или выбранных символов;

П зеркальные развороты блока или его символов (вертикальный и горизон-
тальный);

С1 перемещение отдельных символов блока;

П изменение размеров символов;

П поворот символов;

G изменение формы текстового блока посредством заключения его в оболочку
либо создания в нем эффекта искажения или перспективы.

На рис. 6.29 показан пример изменения формы блока художественного текста
путем выполнения различных операций по его трансформации.

CorelDRAW12

C°fe

Рис. 6.29. Пример трансформации блока художественного текста:
1 — исходный текст; 2 — масштабирование по вертикали; 3 — поворот;

4 — наклон; 5 — эффект перспективы; 6 — эффект оболочки
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Масштабирование текстового блока
или группы символов
1. Выделите блок художественного текста рабочим инструментом Pick (Выбор).

2. Для масштабирования отдельных текстовых символов выполните следующие
действия. Отделите символы блока друг от друга, применив к ним команду
Arrange ^ Break Apart (Расположить > Разъединить) один или несколько раз
в зависимости от того, сколько слов входит в текстовый блок. Выделите
нужные символы инструментом Pick при нажатой клавише <Shift>.

3. Для изменения вертикального размера выбранного текстового блока (группы
символов) установите указатель на одном из серединных выделяющих марке-
ров, расположенных над или под блоком (символами), и переместите его
вниз или вверх при нажатой кнопке мыши. Чтобы в процессе изменения
размера блока сохранить положение его геометрического центра, выполняйте
перемещение выбранного маркера при нажатой клавише <Shift>.

4. Для изменения горизонтального размера блока (символов) установите ука-
затель на одном из серединных маркеров, находящемся слева или справа, и
переместите его влево или вправо. Для сохранения положения центра бло-
ка при изменении его размера перемещайте маркер при нажатой клавише
< Shift >.

5. Для пропорционального изменения размеров блока (символов) установите
указатель на одном из угловых маркеров и переместите его по диагонали
в нужном направлении. Чтобы положение центра блока сохранялось при из-
менении его размеров, выполняйте перемещение выбранного маркера при
нажатой клавише <Shift>.

Поворот текстового блока
или группы символов
1. Выделите блок художественного текста рабочим инструментом Pick (Выбор).

2. Для выполнения поворота отдельных текстовых символов примените к дан-
ному блоку один или несколько раз команду Arrange > Break Apart (Располо-
жить > Разъединить), после чего выделите нужные символы инструментом
Pick (Выбор), щелкнув на каждом из них при нажатой клавише <Shift>.

3. Сделайте еще один щелчок на одном из выбранных символов, перейдя в ре-
жим их поворота и наклона (выделяющие маркеры примут вид двунаправ-
ленных стрелок).

4. Отрегулируйте положение центра вращения блока текста (группы символов),
если он не должен совпадать с его геометрическим центром. Для этого по-
местите указатель на метку центра вращения, нажмите кнопку мыши и пере-
местите метку в требуемое место, после чего отпустите кнопку мыши.

5. Установите указатель на одном из угловых выделяющих маркеров, нажмите
кнопку мыши и поверните текстовый блок (группу символов) в заданном на-
правлении на требуемый угол.
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Наклон текстового блока или группы символов
1. Выделите блок художественного текста рабочим инструментом Pick (Выбор).

2. Для выполнения наклона отдельных текстовых символов примените к блоку
один или несколько раз команду Arrange > Break Apart (Располо-
жить > Разъединить), после чего выделите нужные символы инструментом
Pick (Выбор).

3. Щелкните еще один раз на одном из выбранных символов, перейдя в режим
их поворота и наклона.

4. Чтобы наклонить вертикальные стороны прямоугольной области охвата вы-
бранного текстового блока (группы символов), установите указатель на од-
ном из серединных выделяющих маркеров, расположенных над и под бло-
ком, и переместите его при нажатой кнопке мыши влево или вправо на
заданное расстояние.

5. Для наклона горизонтальных сторон области охвата блока (группы символов)
установите указатель на одном из серединных маркеров, находящихся слева
и справа от блока, и переместите его вверх или вниз.

Зеркальный разворот текстового блока
или группы символов
1. Выделите блок художественного текста рабочим инструментом Pick (Выбор).

2. Для выполнения зеркального разворота отдельных текстовых символов при-
мените к данному блоку один или несколько раз команду Arrange > Break
Apart (Расположить > Разъединить), после чего выделите нужные символы
инструментом Pick (Выбор).

3. Откройте докер Transformation (Трансформация) на вкладке Scale and Mirror
(Масштаб и зеркальный разворот), выполнив для этого команду
Arrange > Transformations > Scale (Расположить > Трансформации > Масштаб).

4. Для горизонтального разворота текстового блока (относительно вертикаль-
ной оси его симметрии) нажмите мышью первую сверху кнопку в докере
Transformation, после чего щелкните на кнопке Apply (Применить) внизу
докера.

5. Для вертикального разворота блока (относительно горизонтальной оси сим-
метрии) нажмите мышью вторую сверху кнопку в докере и щелкните на
кнопке Apply.

6. Закройте докер Transformation.

Перемещение текстовых символов
1. Выделите блок художественного текста рабочим инструментом Pick (Выбор).

2. Если для данного текстового объекта ранее был создан эффект оболочки,
искажения или перспективы, то отмените его с помощью команды
Effects * Clear Effect (Эффекты > Удалить эффект), в названии которой будет
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указан имеющийся эффект. В противном случае вы не сможете перемещать
символы мышью.

3. Выберите рабочий инструмент Shape (Форма), отобразив у основания каж-
дого текстового символа небольшой квадратный маркер белого цвета.

4. Поместите указатель на маркер выбранного символа, нажмите кнопку мыши
и перетащите символ в нужное место области документа, затем отпустите
кнопку мыши.

5. Повторите предыдущий шаг инструкции для всех перемещаемых символов
текстового блока.

Изменение размеров символов
1. Выделите одно из трех:

• целый блок художественного текста рабочим инструментом Pick (Выбор);

• отдельный текстовый фрагмент рабочим инструментом Text (Текст);

• произвольную группу текстовых символов рабочим инструментом Shape
(Форма).

2. Откройте список Font Size (Размер шрифта), расположенный в центре пане-
ли свойств, и выберите в нем новое значение кегля шрифта.

3. Нажмите клавишу <Enter>.

Поворот символов
1. Выделите блок художественного текста рабочим инструментом Pick (Выбор).

2. Если для данного объекта был ранее создан эффект оболочки, искажения
или перспективы, то отмените его командой Effects > Clear Effect (Эффекты >
Удалить эффект), в названии которой будет указан имеющийся эффект.

3. Выберите рабочий инструмент Shape (Форма), отобразив у основания каж-
дого текстового символа небольшой квадратный маркер белого ивета.

4. Выделите требуемые символы, выполнив последовательные щелчки на их мар-
керах при нажатой клавише <Shift>, при этом маркеры станут черного цвета

5. Введите значение угла поворота в поле Angle of Rotation (Угол поворота) па-
нели свойств и нажмите клавишу <Enter>.

Изменение формы блока
Данную операцию можно выполнить путем создания в блоке художественного
текста одного из трех эффектов векторной графики: оболочки, искажения или
перспективы (см. разд. "Создание эффектов" гл. 4).

Изменение формы эффектом оболочки

1. Выделите блок художественного текста рабочим инструментом Pick (Выбор).

2. Выберите рабочий инструмент Interactive Envelope (Интерактивная оболоч-
ка), с помощью которого будет создан эффект оболочки.
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3. Сформируйте эффект оболочки в выбранном блоке.

4. Выберите снова инструмент Pick, завершив процесс создания эффекта обо-
лочки.

Изменение формы эффектом искажения

1. Выделите блок художественного текста рабочим инструментом Pick.

2. Выберите рабочий инструмент Interactive Distortion (Интерактивное искаже-
ние), с помощью которого будет создан эффект искажения.

3. Сформируйте эффект искажения в выбранном блоке.

4. Выберите снова инструмент Pick, завершив процесс создания эффекта иска-
жения.

Изменение формы эффектом перспективы

1. Выделите блок художественного текста рабочим инструментом Pick.

2. Выполните команду Effects > Add Perspective (Эффекты > Добавить перспек-
тиву).

3. Отрегулируйте форму текстового блока с помошью четырех квадратных мар-
керов черного цвета, расположенных по углам выделенной области, и двух
крестообразных меток, которыми отмечены точки схода.

4. Выберите снова инструмент Pick (Выбор), завершив процесс создания эф-
фекта перспективы.

Создание эффектов
Поскольку блоки художественного текста обладают почти всеми свойствами
векторных объектов, для них можно создавать такие же художественные эффек-
ты, как и для объектов векторной графики, а именно; переход, контур, искаже-
ние, оболочку, выдавливание, тень, линзу, перспективу и PowerClip
(см. разд. "Создание эффектов" гл. 4). В текстовом блоке вы можете сформировать
как один такой эффект, так и несколько различных эффектов, достигая тем са-
мым максимальной художественной выразительности.

Из всех перечисленных эффектов для блока обычного текста доступным является
лишь эффект тени. Эффект оболочки или искажения позволяет изменить форму
текстовой рамки, но не текстовых символов. Что касается эффектов линзы и
PowerClip, то их можно применить к обычному тексту лишь при условии, что этот
текст используется в качестве содержимого, а не линзы или контейнера.

В художественном тексте можно создать и другие эффекты, используя для этого
следующие операции (в любом их сочетании):

П трансформация;

П регулировка прозрачности;

П формирование векторного объекта по контуру текстовых символов;
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П выполнение заливок различных типов;

П преобразование текстовых символов в кривые.

Заметим, что последние две операции доступны и для обычного текста.

В качестве иллюстрации к сказанному рассмотрим порядок создания эффекта
градиентной заливки области обводки художественного текста.

1. Создайте образец художественного текста, отобразив его на экране в требуе-
мом масштабе.

2. Выделите данный объект рабочим инструментом Pick (Выбор).

3. Откройте диалоговое окно Outline Pen (Контурное перо) рабочего инстру-
мента Outline (Контур) и задайте в нем достаточно большую толщину линий
обводки для текстовых символов (см. рис. 6.30, вверху).

4. Выполните команду Arrange»Convert Outline To Object (Расположить >
Преобразовать контур в объект), сформировав комбинированный векторный
объект по контуру текстовых символов (назовем этот объект контурным).

5. Выделите инструментом Pick дополнительно образовавшийся объект из об-
ластей заливки символов и удалите его клавишей <Del>.

6. Снова выделите контурный объект и задайте для него параметры обводки,
используя инструмент Outline.

7. Выберите рабочий инструмент Interactive Fill (Интерактивная заливка) и вы-
полните градиентную заливку контурного объекта, настроив параметры за-
ливки с помощью панели свойств и управляющей конструкции данного ин-
струмента (см. разд. "Заливка"гл. 4).

Вверху на рис. 6.30 представлена исходная надпись художественного текста
с обычной обводкой ее символов, а внизу — та же надпись с эффектом гради-
ентной заливки, созданным в области обводки этой надписи.

Рис. 6.30. Пример создания эффекта градиентной заливки
области обводки художественного текста
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Преобразование текста в кривые
Данная операция представляет собой преобразование символов обычного или
художественного текста в векторные объекты. Ее выполняют в тех случаях, ко-
гда для художественного оформления текстовых символов недостаточно воз-
можностей CorelDRAW 12. Поэтому символы текста преобразуют в векторные
объекты с контурами Безье, что позволяет произвольным образом изменять их
форму с помощью рабочего инструмента Shape (Форма), создавать эффекты
векторной графики (для исходного текста обычного типа) или формировать
фигурные обводки рабочим инструментом Artistic Media (Комплект художника).

Преобразование текста в кривые может вам понадобиться не только с целью его
художественного оформления, но и для решения проблемы отсутствия тексто-
вых шрифтов, которая иногда возникает при переносе файла на другой компью-
тер или при электронной публикации документа.

Рассматриваемая операция выполняется в CorelDRAW 12 с помощью команды
Convert To Curves (Преобразовать в кривые) меню Arrange (Расположить).

На рис. 6.31 представлен пример создания эффекта искажения в блоке обыч-
ного текста путем преобразования текста в кривые.

На рис. 6.32 изображен пример создания эффекта наложения изображения на
символы художественного текста посредством преобразования текста в кривые.

'/^Г^'"'^: 1": I..' •>"• •---« •'-'- • ' '
у 1 UIlLLJUIlrtfT I* -

^^универсальная
"графико-изДательская

программа.
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Рис. 6.31. Пример художественного оформления блока обычного текста
путем его преобразования в кривые

Рис. 6.32. Пример художественного оформления блока художественного текста
путем его преобразования в кривые
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Порядок преобразования
1. Выделите текстовый блок рабочим инструментом Pick (Выбор).

2. Если вы собираетесь обрабатывать в дальнейшем отдельные фрагменты тек-
ста, преобразованные в векторные объекты, выполните команду Arrange >
Break Apart (Расположить » Разъединить) один или несколько раз, разбив ис-
ходный блок текста на требуемое число частей.

3. Выделите целый блок или его отдельные части инструментом Pick (Выбор).

4. Преобразуйте символы текста в векторные объекты с контурами Безье, при-
менив к ним команду Arrange»Convert To Curves (Расположить >
Преобразовать в кривые).

5. Выполните художественную обработку векторных объектов, имеющих форму
текстовых символов. Для этого можете использовать рабочие инструменты
Shape (Форма) и Artistic Media (Комплект художника), а также другие рабо-
чие инструменты и команды программы, предназначенные для создания эф-
фектов в объектах векторной графики.

Вставка текстовых символов
Текстовыми символами называются комбинированные векторные объекты,
имеющие заданные размеры и хранящиеся в файлах шрифтов, которые исполь-
зуются для ввода в документ текстовой информации, а также для оформления
самих документов.

В соответствии с назначением текстовых символов, шрифты, содержащие их,
подразделяются на текстовые и символьные. К числу таких шрифтов, исполь-
зуемых в CorelDRAW 12, относятся масштабируемые шрифты трех типов: True
Туре (обычные шрифты), Туре 1 (шрифты PostScript) и Open Type (шрифты от-
крытого типа).

Примечание

Текстовый символ состоит из набора замкнутых контуров, с помощью которых
формируются области, доступные для заливки. Такой объект может быть co:i-
дан в программе из нескольких обычных векторных объектов путем их объеди-
нения командой Arrange > Combine (Расположить > Скомбинировать) и после-
дующего преобразования в текстовый символ с помощью команды Tools <r
Create > Character (Инструменты > Создать > Символ).

В CorelDRAW 12 с текстовыми символами можно выполнять следующие операции:

О вставлять непосредственно в документ символы, хранящиеся в файлах
шрифтов;

П вставлять в обычный или художественный текст документа символы из фай-
лов шрифтов;

О вставлять в текст в качестве его символов любые объекты документа;
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П формировать новые символы и вставлять их в существующие и новые файлы
шрифтов (см. разд. "Создание образцов и шаблонов" ел. 4).

—,— ""'•̂ и
Примечание

В предыдущих версиях программы CorelDRAW можно было вставлять в доку-
мент не только отдельные символы, ни и их мозаичные наборы. К сожалению,
такая возможность в CorelDRAW 12 не предусмотрена.

Для работы с символами, хранящимися в файлах шрифтов, используется докер
Insert Character (Вставить символ), который можно открыть одноименной
командой меню Text (Текст). С помощью этого докера обеспечивается доступ
к символам выбранного шрифта.

Докер Insert Character (Вставить символ) содержит следующие элементы управ-
ления (см. рис. 6.33):

О раскрывающийся список шрифтов Font;

О список кодовых страниц Code Page;

П рабочее окно со списком образцов символов, входящих в состав выбранного
шрифта (посередине);

П поле Character Size, в котором задается размер символа.

Контекстное меню докера, открываемое правой кнопкой мыши при установке
указателя на кнопке раскрытия списка Fonts, содержит четыре команды: True
Type Fonts (Показать текстовые шрифты True Type), Typel Fonts (Показать тек-
стовые шрифты Typel), True Type Symbols (Показать символьные шрифты True
Туре) и Typel Symbols (Показать символьные шрифты Typel). Эти команды
управляют указанными в них режимами отображения шрифтов различных типов
(при подключении режима в названии команды будет стоять галочка).

Опишем различные операции с текстовыми символами, выполняемые в Corel-
DRAW 12.

Вставка в документ символа из файла шрифта
1. Откройте докер Insert Character (Вставить символ), выполнив для этого ко-

манду Text > Insert Character (Текст > Вставить символ).

2. Поместите указатель на кнопку раскрытия списка Font, нажмите правую кноп-
ку мыши и в открывшемся контекстном меню докера задайте режимы отобра-
жения всех шрифтов, установив галочки во всех четырех пунктах меню.

3. Задайте размер символа в поле Character Size, находящемся внизу докера.

4. Выберите в списке Font нужный символьный или текстовый шрифт, загрузив
его символы в рабочее окно докера.

5. Выберите в списке Code Page требуемую кодовую страницу, обеспечиваю-
щую правильное отображение символов данного шрифта.



Обработка текста 477

6. Прокрутите список символов в рабочем окне докера, отобразив значок тре-
буемого символа. Выделите этот значок мышью и сделайте одно из двух:
щелкните на кнопке Insert (Вставить) внизу докера или перетащите значок
в область рабочего окна документа. В результате выбранный символ будет
вставлен в центр текущей страницы документа в качестве векторного объекта
заданных размеров.

7. Обработайте данный векторный объект.

8. Закройте докер Insert Character.

На рис. 6.33 показан пример вставки в документ некоторого символа из файла
шрифта Webdings. Справа изображен докер Insert Character, с помощью кото-
рого была выполнена данная операция.

" Insert Character ====± x

Font: 0 Webdings Ц:р

Code Page-:

Keystroke; Alt+ #; \ 066

Character Size: !50,8 -™ mr

Insert

Рис. 6.33. Пример вставки в документ символа из файла шрифта
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Вставка в текст символа из файла шрифта
1. Откройте докер Insert Character (Вставить символ), выполнив для этого ко-

манду Text > Insert Character (Текст > Вставить символ).

2. Поместите указатель на кнопку раскрытия списка Font, нажмите правую
кнопку мыши и в открывшемся контекстном меню докера задайте режимы
отображения всех шрифтов.

3. Отобразите на экране в требуемом масштабе область документа, в которой
находится нужный вам текстовый блок.

4. Выберите рабочий инструмент Text (Текст) и установите текстовый курсор
в то место блока текста, куда должен быть вставлен символ.

5. Выберите в списке Font необходимый символьный или текстовый шрифт,
загрузив его символы в рабочее окно докера.

6. Выберите в списке Code Page требуемую кодовую страницу, обеспечиваю-
щую правильное отображение символов данного шрифта.

7. Прокрутите список символов в рабочем окне докера, отобразив значок тре-
буемого символа. Выделите этот значок мышью и сделайте одно из двух:
щелкните на кнопке Insert (Вставить) внизу докера или сделайте двойной
щелчок на значке. В результате выбранный символ будет вставлен в то место
текста, где находится курсор, при этом его размер будет соответствовать раз-
меру букв данного текста.

8. Закройте докер Insert Character.

На рис. 6.34 показан пример вставки в надпись "CorelDRAW 12" фигурного
символа из некоторого файла шрифта.

CorelDRAW12

•cg!CorelDRAW12- J

• • -•

©
0
so

О
Ф
G3

©

03

°&
1

Рис. 6.34. Пример вставки в текст символа из файла шрифта

Вставка в текст объекта документа
I . Отобразите на экране текстовый блок, а также тот объект документа (его тип

может быть произвольным), который необходимо вставить в этот блок в ка-
честве символа. Если данный объект находится на другой странице докумен-
та, скопируйте его на текущую страницу или переместите объект через ком-
поновочную зону документа.
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2. Выберите рабочий инструмент Pick (Выбор) и выделите им вставляемый
объект.

3. Поместите на данный объект указатель, нажмите правую кнопку мыши и
перетащите объект в область блока текста, При этом на экране появится
метка текстового курсора, которую поместите в то место текста, куда будет
вставлен объект, после чего кнопку мыши отпустите. В открывшемся кон-
текстном меню выберите одну из двух команд: Move Into Text (Переместить
в текст) или Copy Into Text (Скопировать в текст). В результате произойдет
вставка копии объекта в отмеченное место текста (для первой команды -
с удалением исходного объекта, а для второй — с его копированием), размер
которой будет соответствовать размеру текстовых символов.

CorelDRAW 12

CorelDRAW 12

Рис. 6.35. Пример вставки в текст объекта документа

На рис. 6.35 показан пример вставки в надпись "CorelDRAW 12" растрового
изображения, символизирующего компанию Corel Corporation.
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Работа с документом

Любая графическая, издательская или текстовая программа обладает набором
функций по обработке документа, не связанных с конкретными типами исполь-
зуемых объектов или формами представления информации. К числу таких
функций, предусмотренных в программе CorelDRAW 12, относятся:

П создание нового документа;

П открытие и сохранение документа;

П импорт и экспорт информации;

П форматирование и макетирование документа;

П манипуляция страницами документа;

О работа с линейками, направляющими (обычными и динамическими) и сеткой;

П перемещение объектов документа;

П поиск и замена в документе информации;

П печать документа (в том числе и в режиме слияния информации);

П формирование электронных версий документа (в форматах HTML и PDF).

Чтобы объективно оценить указанные возможности CorelDRAW 12, отметим
теперь те функции, которые в этой программе отсутствуют, но имеются в со-
временных издательских программах:

П форматирование отдельных страниц документа на основе индивидуальных
шаблонов;

П обработка больших документов, состоящих из нескольких файлов.

Создание нового документа
В рассматриваемой программе новый документ создается на базе выбранного
шаблона (шаблонного документа), который отличается от обычного документа
CorelDRAW 12 лишь своим расширением (cdt вместо cdr). Пользователь может
сформировать самостоятельно шаблонный документ и использовать в качестве
образна для разработки на его основе обычных документов.

163ак. 250
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Новый документ можно создать тремя способами:

П командой File t New (Файл > Новый) — из базового шаблона, используемого
в программе по умолчанию, файл которого Coreldrw.cdt хранится в одной из
папок операционной системы Windows XP;

П командой File > Open (Файл > Открыть) — из шаблона, созданного пользова-
телем и хранящегося в любом месте дисковой памяти компьютера;

О командой File > New From Template (Файл > Новый из шаблона) — из шаблона,
входящего в одну из пяти библиотек шаблонов программы, файлы которых
хранятся в отдельных папках, вложенных в папку Languages\En\Draw\Template.

Рассмотрим порядок формирования нового документа с использованием ука-
занных способов.

Использование базового шаблона
Для создания в CorelDRAW 12 нового документа на основе базового шаблона
используется команда File »New (Файл > Новый). В результате будет создан но-
вый одностраничный документ с параметрами базового шаблона Coreldrw.cdt.

Примечание

Если некоторые параметры или атрибуты оформления базового шаблона вас
не устраивают, то вы можете их изменить. Для этого задайте требуемые пара-
метры (атрибуты) для обрабатываемого документа и выполните команду
Tools > Save Settings As Default (Инструменты > Сохранить настройки для ис-
пользования по умолчанию). В результате эти параметры будут сохранены
в файле базового шаблона.

Использование пользовательского шаблона
1. Выполните команду File > Open (Файл > Открыть), открыв диалоговое окно

Open Drawing (Открыть графику).

2. Выберите в окне файл нужного шаблонного документа (с расширением cdt)
и щелкните на кнопке Open (Открыть).

Openl.CDT

Choose New from Template to begin a document
based on the selected template. Choose Open
for Editing to modify an existing template.

New from Template

Open for Editing

V With Contents

or Cancel Help

Рис. 7.1. Дополнительное окно, в котором задается режим работы
с выбранным шаблоном
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3. В открывшемся окне Open <название шаблона> (рис. 7.1) выберите переклю-
чатель New from Template (Новый из шаблона) и определитесь в отношении
состояния флажка With Contents (С содержимым). Если установить флажок,
то в новый документ будет перенесено все содержимое выбранного шаблона,
а если сбросить — только его текстовые и графические стили.

4. Щелкните на кнопке подтверждения ОК.

Использование библиотечного шаблона
1. Выполните команду File > New From Template (Файл > Новый из шаблона),

открыв диалоговое окно New From Template (Новый из шаблона) для работы
с библиотеками шаблонов, хранящимися на диске (см. рис. 7.2).

2. Выберите нужную библиотеку шаблонов, открыв одну из первых пяти вкла-
док окна команды с названиями библиотек на их ярлычках либо последнюю
вкладку Browse, используемую для поиска файла шаблона на диске.

3. С помощью области просмотра, расположенной справа, выберите в текущей
библиотеке требуемый шаблон.

4. Если вы хотите загрузить в документ графическую информацию, имеющуюся
в шаблоне, установите флажок Include graphics (Включать графику).

5. Щелкните на кнопке подтверждения ОК. В результате будет создан новый
документ с параметрами форматирования выбранного шаблона, в который
будут перенесены текстовые и графические стили шаблона, а также имею-
щиеся в нем графические объекты (если такой режим был задан).

|Ме« From Template

Full Page | Q Label j И Envelope' IP Side-Fold j $g Web | ffi Browse j

?"j| Blank Generic CorelDRAW Document * martini_card

ba!l__card f^ pattern „card

•rj bug_card

*j| buttrflyjrard

^Jcelticl_card

|j design_card

И5 dragnfly_card

™J heart_card

И У Include graphics

Cancel Help

Рис. 7.2. Диалоговое окно New From Template
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На рис. 7.3 показан вид в своем рабочем окне второй и третьей страниц нового
документа, созданного на основе шаблона birds_card, который был выбран
в библиотеке шаблонов Side-Fold (см. рис. 7.2). В этой библиотеке находятся
шаблоны печатных документов, состоящих из четырех страниц, которые фор-
мируются путем двойного изгиба печатного листа, имеющего одностороннюю
печать.

1 1|] Griptiicl

. .

И < -2 of'

^̂ ^̂ ™^

*

* *

. ..

> Н V Рзде 1 \ Раде 2

^̂ ^̂ ^™и

Clatre^? WP-I Tattoo!
Ъ ООЛ hatte texl

/ Page 3 / Раде Л I < i

•Ш~ТпГх1

„J

>J

: |

т
•_j; ' - -£ j£ jГ— -l" - — -J -J

Рис. 7.З. Вид двух страниц нового документа,
созданного из шаблона birds_card

Открытие и сохранение документов
В этом разделе рассматриваются операции открытия и сохранения документов.

Открытие документов
Открытие документов в CorelDRAW 12 производится командой File > Open
(Файл > Открыть), диалоговое окно Open Drawing (Открыть графику) которой
показано на рис. 7.4. С помощью этой команды можно загружать в программу
документы, представленные в следующих файловых форматах векторного типа:
AI, CDR, CDT, CDX, CGM, CLK, CMX, CPX, CSL, DES, DRW, DSF, DWG,
DXF, EMF, EPS, FH, FMV, GEM, HPGL, HTML, MET, NAP, PAT, PDF, PIC,
PICT, PPT, PRN, PS, SHW, SVG, SVGZ, VSD, WMF и WPG (см. разд. "Файловые
форматы"гл. 3).
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(Open Drawing

Папка: CorelDRAW

• Недвение

РйбОЧИЙ СТОЛ

Mai
док^уненты

Artistic Meaie cdr

В asket.avt

Diagram .cdr

£:. Effeds.cdr

Exe.cdr
^3 GLASS WAV

'lnt_obj (ver11J.cdr

*> InteractfF lash), cdr

||]lrrteracttFlash).rttm

ф° lrtter8ct(Flash).swt
?

B Internet ( ver11J.cdr

^ Internet „Imp oil. с dr

*fr Inter netjmport.pdl

^jlnternet_Te^(Flash) htm

y,' lnternet_Text(FleshXswf

I.;- !nternet_Text cdr

ols.csl

SymbolsJ cdr

Symbo!s_2.cdr

Text .cdr

Text_1.cdr

Text_3.cdr

TGXt_4.cdr

TBxt_5.cdr
Text_exper«ncflr

£- lnt_orjj_irTiport(Flash).swl

'4nt_obj_i.Tipcirt.cdr

"",, OCIectManager.cdr

•ĵ  S1yles.cdr

Q Symbols! .csl

File name: . 3.cdr

Fib of type; i All File Format!

Sort type: Default

CodePage; 1251 ( A N S I - I

Keywords:

Notes:

FBe Version: Version 1*

Coffl[»ession ratio; 81.3%

Last saved by:

Last saved In:

Preview

CoielDRAW 12 (pc)
buld 458

Английский (США)

Maintain layers and pages

Options « Cancel

Рис. 7.4. Диалоговое окно Open Drawing

Порядок открытия
1. Выполните команду File > Open (Файл > Открыть), открыв ее диалоговое окно

Open Drawing (Открыть графику).

2. Если на кнопке Options (Параметры), находящейся внизу слева, изображен
значок "»", то щелкните на ней мышью, раскрыв данное окно полностью
(см. рис. 7.4).

3. Выберите папку с нужными документами, отобразив их в рабочей области
диалогового окна команды, используя для этого раскрывающийся список
Папка (вверху) и кнопку возврата на предыдущий уровень вложения (справа
от списка),

4. Убедитесь в том, что в списке Files of type (Типы файлов), находящемся
в нижней части окна команды, указан требуемый файловый формат или все
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форматы, доступные для открытия (пункт All File Formats). Если необходимо,
предварительно отсортируйте элементы данного списка по типам файлов, выбрав
соответствующий вариант сортировки в списке Sort type (Тип сортировки).

5. Задайте названия открываемых документов одним из трех способов:

• выделением наименований документов рабочей области окна с помощью
мыши и клавиш <Ctrl> или <Shift>;

• вводом с клавиатуры в редактируемое поле списка File name (Название
файла) названия файла документа;

• выбором в списке File name полного названия документа (с учетом его
положения на диске), который открывался ранее.

6. Убедитесь в том, что открывается нужный документ. Для этого установите
флажок Preview (Просмотр), расположенный под областью просмотра спра-
ва, в этой области отобразится миниатюра первой страницы выбранного до-
кумента.

7. Определитесь в отношении состояния следующих элементов настройки, на-
ходящихся в нижней части окна Open Drawing:

• раскрывающегося списка Code Page, предназначенного для выбора кодо-
вой таблицы, правильно отображающей названия открываемых файлов
документов, ключевые слова и примечания;

• флажка Extract embedded ICC profile, при установке которого задается ре-
жим извлечения профиля из файла документа при его включении в об-
щий список профилей, доступных для использования в программе;

• флажка Maintain layers and pages, при установке которого подключается
режим открытия документов, представленных в файловых форматах типа
PostScript (PDF, EPS и т. п.), при котором порядок расположения стра-
ниц в открываемом документе будет таким же, что и в исходном.

8. Щелкните на кнопке подтверждения Open (Открыть).

Сохранение документа
Существуют различные способы сохранения документа, созданного в CorelDRAW 12.
Эти способы реализуются с помощью следующих команд меню File (Файл):

П Save (Сохранить) и Save As (Сохранить как) — сохранение активного доку-
мента в выбранном векторном формате;

П Print (Печать) — сохранение документа, выводимого на печать, в одном из
двух векторных форматов, базирующихся на языке PostScript: PRN или PS
(см. разд. "Печать документа"настоящей главы)',

П HTML и Flash embedded in HTML (Flash, внедренный в HTML) из подменю
Publish To The Web (Публикация на Web) — сохранение документа в вектор-
ном формате HTML, используемом в Интернете (см. разд. "Создание электрон-
ных документов" данной главы)]
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П Publish To PDF (Публикация в формате PDF) — сохранение в векторном
формате PDF (Portable Document Format), используемом при различных ви-
дах электронной публикации (см. разд. "Создание электронных документов"
настоящей главы).

В данном разделе рассматривается выполнение операции сохранения документа
с помощью первых двух команд, используемых чаще других. Команда Save при-
меняется при повторном сохранении документа в его файле с прежними пара-
метрами сохранения, a Save As — во всех остальных случаях.

К числу файловых форматов, доступных для сохранения документов командами
Save и Save As, относятся следующие векторные форматы: AI, CDR, CDT,
CGM, CLK, CMX, CSL, DES, DWG, DXF, EMF, FMV, GEM, HPGL, PAT,
PICT, SVG, SVGZ, WMF и WPG (см. разд. "Файловые форматы"гл. 3).

На рис. 7.5 представлено диалоговое окно Save Drawing (Сохранить графику),
открываемое командой Save As, в котором задаются параметры сохранения
документа.

Save Drawing

Не дм Hire
документы

Рабочий стоп

догуиенты

Пагка; j l_J CorelDRAW

_JCorel ",," OblectManager.cdr

'-̂ images Щ Print .cdr

î Lodr £ Stytes.cOr

'! ;i2.cdr * SymbolsJ ,c*

Ф-'-Artistic Medra.cdr ~ Text.cdr

I ifiJDiagram cdr •• --Text_1.cdr

?'^: Effects.cdr -*!-•• Тext_3.cdr

' Exe cdr -- -Text_4.cdr

' 'lrt_obj (ver 11 ).cdr Щ Text_5.cdr

''lrt_obj_import.cdr -f.-'Text^experim.cdf

f* lnteract[Flash).cdr

-^ Internet (ver 11).cdr

^ lnternet_lmport.cdr

. 7 Internet Text.cdr

Filename; EFFectsl.cdr

Sawe as type; j CDR - CorelDRAW

Sort type; [Default

Keywords! [ effects

. Эффекты векторной графики

Version 12.0

(color)

Advanced:.. '

!</' Web_safeJHenames

Г" Embfid Forts usincj TrueDpC (TM)

Save Cancel

Рис. 7.5. Диалоговое окно Save Drawing
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Порядок сохранения
1. Если документ сохраняется не в первый раз и он должен быть помещен

в свой файл с прежними параметрами сохранения, выберите команду File >
Save (Файл > Сохранить), завершив на этом выполнение данной инструкции.

2. Если вы хотите сохранить только некоторые объекты текущей страницы до-
кумента, то выделите эти объекты рабочим инструментом Pick (Выбор).

3. Выполните команду File > Save As (Файл > Сохранить как), открыв диалого-
вое окно Save Drawing.

4. Если на кнопке Options (Параметры), находящейся внизу слева, изображен
значок "»", то щелкните на ней мышью, раскрыв данное окно полностью
(см. рис. 7.5).

5. Выберите папку, в которую будет помещен файл сохраняемого документа,
используя для этого список Папка (верху) и кнопку возврата на предыду-
щий уровень вложения (справа от списка).

6. Выберите в списке Save as type (Сохранить как тип), находящемся в нижней
части окна, файловый формат, в котором документ должен быть сохранен.
Если необходимо, предварительно отсортируйте элементы данного списка,
выбрав вариант его сортировки в списке Sort type (Тип сортировки).

7. Задайте название сохраняемого документа одним из трех способов:

• выделением исходного названия документа мышью в рабочей области
диалогового окна, с последующей его коррекцией в редактируемом поле
списка File name (Название файла);

• вводом с клавиатуры в поле списка File name наименования файла со-
храняемого документа;

• выбором в списке File name полного названия документа, который был
сохранен ранее.

8. Если хотите, можете ввести в поле Keywords ключевые слова, а в поле
Notes — примечания, что облегчит поиск файла документа и его идентифи-
кацию при последующем открытии.

9. В списке Version выберите версию файлового формата, заданного для со-
хранения документа.

10. В списке Thumbnail задайте параметры миниатюры изображения первой
страницы документа, которая будет отображаться в диалоговом окне при
открытии документа.

11. Определитесь в отношении состояния следующих четырех флажков, нахо-
дящихся в правом нижнем углу окна Save Drawing:

• Selected only, при установке которого задается режим сохранения текущей
страницы документа с объектами, которые выделены (этот флажок будет
отображаться в окне команды лишь при наличии выделенных объектов);

• Web_safe_filenames, при установке которого подключается режим приве-
дения названий сохраняемых документов в соответствии с требованиями
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Web, предусматривающий, в частности, замену символов пробела на сим-
волы подчеркивания;

Примечание

На рис. 7.5 в поле File name находится следующее название документа;
Effects1.cdr, которое содержит один пробел. В связи с тем, что флажок
Web_safe_f He names здесь установлен, фактически будет сформирован файл
документа со следующим названием: Effects_1 .cdr.

• Embed Fonts using TrueDoc (TM), при установке которого активизируется
режим внедрения в файл документа используемых шрифтов;

• Save with embedded VBA Project, при установке которого задается режим
сохранения в файле документа макрокоманд, созданных с помощью
программы Microsoft Visual Basic.

12. Если вам необходимо изменить параметры настройки CorelDRAW 12, отно-
сящиеся к сохранению документов, откройте вкладку Document > Save
(Документ > Сохранить) диалогового окна Options (Параметры), щелкнув на
кнопке Advanced (Расширенные), отредактируйте там нужные параметры,
после чего закройте данное окно щелчком на кнопке ОК.

13. Щелкните на кнопке подтверждения Save (Сохранить).

Импорт и экспорт информации
Операция импорта представляет собой вставку в активный документ информа-
ции (графической или текстовой), хранящейся в одном или нескольких вы-
бранных файлах. Операция экспорта — это сохранение выбранной в документе
информации в файле заданного формата.

Операция импорта
В CorelDRAW 12 операция импорта выполняется с помощью команды
File > Import (Файл > Импорт).

К числу доступных для импорта файловых форматов относятся следующие
(см. разд. "Файловые форматы" гл. 3):

П векторные- Al , CDR, CDX, CGM, CLK, CMX, CPX, CSL, DES, DRW,
DSF, DWG, DXF, EMF, EPS, FH, FMV, GEM, HPGL, HTML, MET, NAP,
PDF, PIC, PICT, PPT, PRN, PS, SHW, SVG, SVGZ, VSD, WMF и WPG;

П растровые- BMP, CAL, CPT, CUR, EXE, FPX, GIF, ICO, IMG, JPEG,
MAC, PCD, PCX, PNG, PP, PSD, RIFF, SCT, TGA, TIFF, WI, XCF и ХРМ;

П текстовые - DOC, Quattro, RTF, TXT, WK, WP, WS и XLS.

Импорт графической информации производится лишь в ту область документа,
которая была видна на экране перед выполнением команды Import, то есть на
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открытую ранее страницу или в компоновочную зону, отображаемую в рабочем
окне документа. Импортируемая текстовая информация может быть размещена
как на текущей странице документа, так и, на последующих его страницах
(см. разд. "Ввод текста"гл. 6).

На рис. 7.6 показано диалоговое окно Import, открываемое одноименной
командой.

i*l'_B£AR.tlf

CROCODl.ti1

•̂ .108003. TIF

•(08004 TIF

ADOBE. EPS

•it ANNA. TIF
IBtr.Burlekovtil
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•SSCALEND_4.TIF

.TIF

"5Clipping1.eps

CLIPPING EPS

orel gi1
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_Kat_D4.1if
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_07 lif
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'<l*,Kat_07_2.tif

Files of type: All File Formats

Sort type: ! Default

Code Page: I \^,Z (AN51 - Jisin f

Imageslze; 373X2-15 Pixels, 16, 7 Million Colors (24-brt)

FJe format: TIF - TIFF Sitmap Uncompressed
Link bitmap external/

Check for Watermark

Г L hkt о high resolution file for output using CPI

Options «

Рис. 7.6. Диалоговое окно Import

На рис. 7.7. представлены два дополнительных диалоговых окна: Crop Image
(Обрезать изображение) и Rcsample linage (Изменить параметры изображения),
работа с которыми может происходить при импорте растровых изображений.

На рис. 7.8 изображен вид указателя перед непосредственной вставкой в доку-
мент содержимого импортируемого файла.
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Crop Image
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New image size:
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Resample Image
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Рис. 7.7. Дополнительные окна Crop Image и Resample Image

wi 110,067 mm, h: 68,439 mm
Click and drag to resize.
Press Enter to center on page,

Рис. 7.8. Вид указателя перед вставкой в документ
содержимого импортируемого файла
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Порядок импорта
1. Откройте документ на той странице, куда будет помещена импортируемая

информация.

2. Выполните команду File »Import (Файл > Импорт), открыв диалоговое окно
Import.

3. Если на кнопке Options (Параметры), находящейся внизу слева, изображен
значок "»", то щелкните на ней мышью, раскрыв данное окно полностью
(см. рис. 7.6).

4. Выберите папку с нужными файлами, отобразив их в рабочей области диа-
логового окна, используя для этого список Папка (вверху) и кнопку возврата
на предыдущий уровень вложения (справа от списка).

5. Убедитесь в том, что в списке Files of type (Типы файлов), находящемся
в нижней части окна, указан нужный вам файловый формат либо все форма-
ты, доступные для импорта (пункт All File Formats). Если необходимо, пред-
варительно отсортируйте элементы данного списка, выбрав вариант его сор-
тировки в списке Sort type (Тип сортировки).

6. Установите флажок Preview (Просмотр), чтобы отобразить уменьшенную ко-
пию выбранного изображения в области просмотра (справа).

7. Задайте названия импортируемых файлов одним из трех способов:

• выделением наименований файлов рабочей области окна с помощью мы-
ши и клавиши <Ctrl> или <Shift>;

• вводом с клавиатуры названия файла в редактируемое поле списка File
name (Название файла);

• выбором в списке File name (Название файла) полного названия файла,
который импортировался ранее.

8. Выберите в списке Code Page кодовую таблицу, правильно отображающую
названия импортируемых файлов, ключевые слова и примечания.

9. Определитесь в отношении состояния следующих флажков, находящихся
в нижней части окна Import:

• Link bitmap externally, при установке которого задается режим органи-
зации связи между импортируемым растровым файлом и активным до-
кументом;

• Combine multi-layer bitmap, при установке которого подключается режим
сведения слоев (объединения всех слоев в один) для импортируемого рас-
трового изображения;

• Extract embedded ICC profile, при установке активизируется режим извле-
чения профиля из импортируемого файла с его включением в общий спи-
сок профилей, доступных для использования в программе;

• Check for Watermark, при установке которого задается режим проверки
наличия водяного знака в импортируемом растровом изображении;
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• Do not show filter dialog, при установке которого будет отменен вывод на
экран диалогового окна с параметрами настройки используемого фильт-
ра импорта;

• Maintain layers and pages, при установке которого подключается режим
импорта информации, хранящейся в выбранном файле формата PDF или
EPS, при котором порядок ее расположения на страницах активного до-
кумента останется прежним;

• Link to high resolution file for output using OPI, при установке которого ак-
тивизируется режим установления связи, задаваемой с помощью языка
OPI (Open Prepress Interface — открытый интерфейс допечатной подго-
товки); эта связь устанавливается между документом и растровым фай-
лом высокого разрешения, которым будет заменено при печати импор-
тируемое изображение.

10. Если вы импортируете одно растровое изображение, выберите режим его встав-
ки в документ, используя для этого раскрывающийся список, находящийся
справа от списка Files of type. В этом списке представлены три варианта:

• Full Image — режим импорта целого изображения при сохранении его
исходных параметров;

• Crop — режим обрезки изображения перед его импортом (на рис. 7.6 вы-
бран этот режим);

• Resample — режим изменения параметров растровой подложки изобра-
жения перед его импортом.

11. Щелкните на кнопке подтверждения Import (Импорт).

12. Если импортируется растровое изображение и был задан режим его обрезки
или изменения параметров подложки, то откроется дополнительное диало-
говое окно Crop Image (Обрезать изображение) или Resample Image (Изме-
нить размеры изображения) (см. рис. 7.7). В открывшемся окне необходимо
выполнить соответствующие настройки, после чего закрыть его щелчком на
кнопке ОК.

13. Как только на экране появится изображение указателя в виде уголка с тек-
стовой информацией (см. рис. 7.8), включающей название текущего импор-
тируемого файла, размеры содержащегося в нем изображения или рамки
с текстом, а также возможные ваши действия, сделайте одно из трех:

• нажмите клавишу <Enter>, расположив в центре документа импортиро-
ванное изображение (рамку с текстом) без изменения его масштаба;

• поместите указатель в то место документа, где должна находиться левая
верхняя вершина импортируемого изображения (рамки с текстом) и
щелкните мышью, вставив в данное место информацию их выбранного
файла (также без изменения ее масштаба);

• установите указатель в месте расположения левой верхней вершины им-
портируемого изображения (рамки с текстом), нажмите кнопку мыши и,



494 Глава 7

не отпуская ее, протяните указатель по диагонали. При этом вокруг об-
ласти перемещения указателя появится прямоугольная пунктирная рам-
ка, задающая фактический масштаб импортируемого изображения при
сохранении пропорции его исходных размеров. Если при этом дополни-
тельно нажать клавишу <Alt>, то вы сможете отрегулировать этот мас-
штаб независимо по горизонтали и вертикали. Как только данная рамка
примет нужные размеры, отпустите кнопку мыши.

14. Если в документе появится новое изображение уголка с наименованием
следующего файла (в случае выбора нескольких импортируемых файлов), то
повторите предыдущий пункт инструкции.

Импорт документов CorelDRAW
Как известно, документы, которые разрабатывались в различных версиях про-
граммы CorelDRAW, хранятся в файлах векторного формата CDR. Такие файлы
можно открывать и импортировать в CorerlDRAW 12.

Перечислим ситуации, когда следует использовать операцию импорта, а не от-
крытия, при загрузке документа, хранящегося в файле формата CDR:

П параметры форматирования обрабатываемого документа отличаются от соот-
ветствующих параметров загружаемого (исходного) документа;

П положение содержимого на страницах обрабатываемого документа отличает-
ся от положения этого содержимого в исходном документе;

О исходный документ создавался в одной из старых версий программы
CorelDRAW, при этом из него предполагается формировать в CorerlDRAW 12
файлы электронного документа формата HTML.

Примечание

Проверка показала, что в процессе выполнения команды HTML подменю
Publish To The Web (Публикация на Web) меню File (Файл), создающей Web-
страницу или Web-сайт из открытого документа, разработанного в CorerlDRAW 11,
происходило аварийное закрытие программы CorerlDRAW 12. Если же файл
исходного документа не открывался, а импортировался в новый документ, то
работа программы происходила нормально.

Операция экспорта
Операция экспорта выполняется с помощью команды File > Export (Файл >
Экспорт), которая позволяет сохранять выбранную в документе информацию
в следующих файловых форматах:

П векторных— AI, CGM, CMX, DWG, DXF, EMF, EPS, Flash, FMV, GEM,
HPGL, PFB, PICT, SVG, SVGZ, TTF, WMF и WPG;

П растровых- BMP, CAL, CPT, CUR, FPX, GIF, ICO, IMG, JPEG, MAC,
PCX, PNG, PP, PSD, SCT, TGA, TIFF, WI и ХРМ;

П текстовых — DOC, RTF, TXT, WP и WS
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Порядок экспорта
1. В случае экспорта из документа не всего его содержимого, откройте до-

кумент на той странице, где находится требуемая информация.

2. Чтобы экспортировать из документа некоторые его объекты, находящиеся на
открытой странице или в компоновочной зоне, выберите их рабочим инст-
рументом Pick (Выбор) при нажатой клавише <Shift> либо выделите нужный
текстовый фрагмент инструментом Text (Текст).

3. Выполните команду File > Export (Файл > Экспорт), открыв диалоговое окно
Export (Экспорт).

4. Если на кнопке Options (Параметры), находящейся внизу слева, изображен
значок "»", то щелкните на ней мышью, раскрыв данное окно полностью.

5. Выберите папку, в которую будет помещен файл с экспортируемой инфор-
мацией, используя список Папка (вверху) и кнопку возврата на предыдущий
уровень вложения (справа от списка).

6. Выберите в списке Save as type (Сохранить как тип), находящемся в нижней
части окна, файловый формат, в котором экспортируемая информация
должна быть сохранена. Если необходимо, предварительно отсортируйте
элементы данного списка, выбрав вариант его сортировки в списке Sort type
(Тип сортировки).

7. Задайте название файла с экспортируемой информацией одним из трех спо-
собов:

• выделением исходного названия в рабочей области диалогового окна
с последующей коррекцией в редактируемом поле списка File name (На-
звание файла);

• вводом с клавиатуры в поле списка File name наименования экспортируе-
мого файла;

• выбором в списке File name полного названия файла с экспортированной
ранее информацией.

8. Если вы хотите, введите в поле Notes примечание, что облегчит идентифика-
цию файла экспорта при его последующей загрузке.

9. Определитесь в отношении состояния флажков, находящихся в правом ниж-
нем углу диалогового окна:

• Export this page only, при установке которого задается режим экспорта
информации лишь из текущей страницы документа (данный флажок
можно использовать при одновременном выполнении двух условий: ак-
тивный документ содержит более одной страницы; выбранный файловый
формат допускает хранение содержимого нескольких страниц документа);

• Selected only, при установке которого подключается режим экспорта толь-
ко выделенных объектов (данный флажок будет отображаться лишь при
наличии в документе выделенных объектов);
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• Web_safe_filenames, при установке которого активизируется режим при-
ведения названий формируемых файлов в соответствие с требованиями
Web, предусматривающий, в частности, замену символов пробела на
символы подчеркивания;

• Do not show filter dialog, при установке которого задается режим отмены
вывода на экран диалогового окна с параметрами настройки используе-
мого фильтра экспорта.

10. Если экспортируется растровое изображение, и список Compression type
(Тип сжатия) будет доступен для использования то выберите в нем способ
сжатия информации в файле или отсутствие сжатия (пункт Uncompressed).

11. Щелкните на кнопке подтверждения Export (Экспорт).

Форматирование документа
Под операцией форматирования документа понимается задание размеров исход-
ных страниц документа, из которых в дальнейшем будут сформированы страни-
цы макета (макетируемые страницы) документа, отображаемые на экране и вы-
водимые на печать.

При создании нового документа ему будут присвоены параметры форматирова-
ния того шаблона, на базе которого он создается. Если документ формируется
на основе базового шаблона Coreldnv.cdt, используемого по умолчанию, то ему
будут переданы следующие параметры: формат страницы документа (она будет
единственной)— А4 (210x297 мм), ориентация страницы— портретная. При
вставке новых страниц все они будут иметь те же размеры и ориентацию, что и
у исходной, при этом в рабочем окне документа будет отображаться одна стра-
ница (открытая).

^ Примечание

Параметры форматирования базового шаблона, а также другие его параметры
и атрибуты оформления (в том числе и стили) могут быть изменены. Для этого
вы должны задать требуемые параметры для обрабатываемого документа и
выполнить команду Tools > Save Settings As Default (Инструменты > Сохранить
настройки для использования по умолчанию). В результате эти параметры бу-
дут сохранены в файле базового шаблона, на основе которого будут созда-
ваться новые документы.

Форматирование активного документа может быть выполнено тремя способами:

О с помощью панели свойств при условии выбора рабочего инструмента Pick
(Выбор) и отсутствии в документе выделенных объектов;

О с помощью той же панели, но при работе в режиме сортировки страниц, пе-
реход в который происходит с помощью команды View > Page Sorter View
(Вид > Вид сортировщика страниц) (см. разд. "Манипуляция страницами" данной
главы, подразд. "Сортировщик страниц")',
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П путем настройки параметров, находящихся на вкладке Document > Page > Size
(Документ > Страница > Размер) диалогового окна Options (Параметры).

Форматирование панелью свойств
Если выбрать рабочий инструмент Pick (Выбор) и отменить им выделение объ-
ектов, щелкнув в свободной области документа, то на панели свойств появятся
инструменты, с помощью которых можно выполнить форматирование докумен-
та (текущей его страницы или всех страниц), а также задать некоторые общие
параметры настройки программы (рис. 7.9).

1 2 3 4 5 6 7 8 9 101112131415
1 i i i i i i i - \ V \ \ l 1 L

Рис. 7.9. Панель свойств в режиме форматирования документа

Поясним назначение элементов управления этой панели (их номера, приведен-
ные на рисунке, даны в квадратных скобках):

О [1] — раскрывающийся список Paper Type/Size, используемый для выбора
формата текущей страницы (или всех страниц) документа, характеризующий
стандартные ее размеры;

П 12) — два поля (со счетчиками) Paper Width and Height, в которых указыва-
ются произвольные размеры страницы: в верхнем —- ширина и в нижнем —
высота;

D [3J — кнопка Portrait, задающая портретную ориентацию страницы на мон-
тажном столе;

П [4J — кнопка Landscape, определяющая альбомную ориентацию страницы;

П [5] - кнопочный переключатель Set Default or Current Page Size and
Orientation, позволяющий выбрать режим настройки параметров страниц до-
кумента: в верхнем его положении — групповой режим (для всех страниц) и
в нижнем —- индивидуальный (для текущей страницы);

Я [6] — список Drawing Units, в котором производится выбор текущих единиц
измерения программы;

О [7| — поле (со счетчиками) Nudge Offset, н котором указывается величина
шага смещения выбранного объекта с помощью клавиши-стрелки;

П [8| — два поля (со счетчиками) Duplicate Distance, используемые для задания
относительных координат первой по порядку копии объекта, формируемой
командой Duplicate (Создать копию) меню Edit (Правка);

О [9] — кнопка Snap To Grid, задающая режим привязки к сетке;

П [10] — кнопка Snap To Guidelines, подключающая режим привязки к направ-
ляющим;
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П [И] — кнопка Snap To Objects, активизирующая режим привязки к объектам;

П [12] — кнопка Draw Complex Objects When Moving or Transforming, задающая
режим формирования пунктирной линии вокруг группового объекта при его
перемещении или трансформации (проверка показала, что данный режим не
работает);

П [13] — кнопка Treat As Filled, подключающая режим выделения прозрачных
векторных объектов щелчками внутри них;

П [14] — кнопка Options, открывающая одноименное диалоговое окно с пара-
метрами настройки программы;

О [15] — кнопка Dynamic Guides, подключающая режим работы с динамиче-
скими направляющими.

Порядок форматирования
1. Откройте документ на той странице, которую необходимо отформатировать.

2. Если новые размеры должны быть заданы только для текущей страницы до-
кумента, то выберите индивидуальный режим настройки параметров страниц
(нижнее положение переключателя [5], см. рис. 7.9), в противном случае -
групповой режим (верхнее его положение).

3. Выберите в списке Drawing Units единицы измерения, в которых будут ука-
зываться размеры страниц (обычно это миллиметры).

4. Выберите в списке [1] новый формат страницы, после чего задайте ориента-
цию страницы — портретная (кнопка [3]) или альбомная (кнопка |4]). Если
нужный вам формат в списке отсутствует, то введите новые размеры страни-
цы в поля [2].

5. Если выполняется индивидуальная настройка параметров страниц документа,
повторите предыдущие пункты инструкции для всех форматируемых стра-
ниц, последовательно переходя на каждую из них с помощью навигатора
страниц или команды Layout > Go To Page (Макет > Перейти на страницу).

Форматирование в окне Options
С помощью параметров настройки CorelDRAW 12, находящихся на вкладке
Document > Page > Size (Документ > Страница > Размер) диалогового окна Options
(Параметры), также выполняется форматирование документа. Эти параметры
можно сохранить для последующего использования в качестве параметров фор-
матирования новых документов.

Порядок форматирования
1. Выполните команду Layout > Page Setup (Макет * Настройка страницы),

открыв диалоговое окно Options на вкладке Document »Page > Size (До-
кумент > Страница > Размер) (см. рис. 8.7).
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2. Настройте параметры форматирования страниц документа (всех или теку-
щей), используя необходимые элементы управления вкладки из следующего
перечня:

• переключатели Portrait и Landscape — выбор ориентации страниц: порт-
ретная или альбомная;

• список Paper — выбор формата страницы;

• поля Width и Height — задание ширины и высоты страницы;

• список справа от поля — выбор текущих единиц измерения;

• поле Bleed — задание величины поля обрезки документа;

• флажок Resize current page only — выбор режима индивидуального форма-
тирования текущей страницы документа;

• кнопка Set From Printer — задание размеров страницы, которые указаны
в параметрах используемого принтера;

• кнопка Save Custom Page — сохранение нестандартных параметров стра-
ницы в качестве ее нового формата;

• кнопка Add Page Frame — формирование рамки страницы, представляю-
щей собой векторный объект прямоугольной формы, границы которого
совпадают с границами открытой страницы документа.

3. Если вы хотите использовать заданные параметры страниц для форматирова-
ния новых документов, то перейдите на вкладку Document (Документ) и ус-
тановите там два флажка: Save options as default for new documents (Сохранить
параметры по умолчанию для новых документов) и Page options (Параметры
страницы).

4. Щелкните на кнопке подтверждения ОК,

Макетирование документа
В широком смысле слова термин "макетирование документа" предполагает ре-
шение следующих трех задач, связанных с обработкой документа
CorelDRAW 12:

П формирование страниц макета документа из его исходных страниц с распо-
ложением их на монтажном столе, отображаемом в рабочем окне документа;

CJ размещение графического и текстового материала на страницах макета до-
кумента;

О расположение этих страниц на печатных листах (signatures).

Примечание

Последняя операция в издательской программе Adobe PageMaker называется
спуском полос.
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В этом разделе рассматривается лишь первая из перечисленных задач, посколь-
ку вторая задача в той или иной мере затрагивается почти в каждой главе книги,
а третья — в разд. "Печать документа " данной главы.

Если все страницы документа отформатированы одинаково, то для них можно
задать так называемую схему макета, под которой понимается вариант разбивки
исходной страницы документа на фактические страницы макета, а также их
расположение в рабочем окне документа (по одной или по две). В процессе
распечатки документа на базе схемы макета формируется стиль макетирования,
определяющий расположение страниц макета на печатных листах.

Прежде чем приступить к фактическому макетированию документа, состоящему
в размещении на его страницах объектов различных типов, необходимо преоб-
разовать исходные страницы документа в страницы макета, выбрав соответст-
вующую схему макета.

В зависимости от того, документ какого типа создается (обычный или с ярлы-
ками), схема макета формируется по-разному. Для обычного документа пара-
метры схемы задаются на вкладке Document >• Page > Layout (Документ»
Страница > Макет) диатогового окна Options (Параметры), а для ярлыков — на
вкладке Document t Page > Label (Документ > Страница > Ярлык) того же окна
(см. разд. "Параметры документа"гл. 8).

Формирование схемы макета
для обычного документа
1. Задайте для всех страниц документа одинаковые параметры форматирования.

2. Откройте окно Options на вкладке Document > Page > Size (Документ >
Страница ¥ Размер), выполнив для этого команду Layout > Page Setup (Макет >
Настройка страницы).

3. Выберите переключатель Normal Paper (Обычная страница).

4. Перейдите на следующую по порядку вкладку Document t Page > Layout (До-
кумент > Страница > Макет) (см. рис. 7.10).

5. Выберите в списке Layout (Макет) вариант разбивки исходной страницы до-
кумента на страницы макета, проконтролировав его в области просмотра
справа. Если страница макета должна совпадать с исходной страницей, вы-
берите пункт Full Page (Полная страница).

6. Определитесь в отношении состояния флажка Facing pages (С разворотом),
при установке которого задается режим отображения двух соседних страниц
макета в рабочей области документа.

7. Если вы хотите использовать выбранные параметры в новых документах, то
перейдите на вкладку Document (Документ) и установите два флажка: Save
options as default for new documents (Сохранить параметры по умолчанию для
новых документов) и Page options (Параметры страницы).

8. Нажмите кнопку подтверждения ОК.
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Рис. 7.10. Верхняя часть вкладки Document > Page > Layout диалогового окна Options

Формирование схемы макета для ярлыков
1. Выберите следующие параметры форматирования, одинаковые для всех

страниц: формат страниц — А4, ориентация — портретная.

2. Выполните команду Layout > Page Setup (Макет > Настройка страницы), открыв
окно Options (Параметры) на вкладке Document > Page > Size (Документ >
Страница » Размер).

3. Выберите переключатель Labels (Ярлыки), в результате чего произойдет пе-
реход на вкладку Document ^ Page > Label (Документ > Страница > Ярлык).

4. Выберите требуемый тип ярлыков в рабочей области слева (в ней находится
вложенный список стандартных типов ярлыков), отобразите в области про-
смотра справа схему размещения ярлыков на печатном листе.

5. Если размеры или размещение ярлыков вас не устраивает, измените пара-
метры ярлыков в дополнительном диалоговом окне Customize Label (Настро-
ить ярлык), открыв его с помощью одноименной кнопки.

6. Чтобы использовать выбранные параметры ярлыков в новых документах,
перейдите на вкладку Document (Документ) и установите два флажка: Save
options as default for new documents (Сохранить параметры по умолчанию для
новых документов) и Page options (Параметры страницы).

7. Щелкните на кнопке подтверждения ОК. В результате окно Options закроет-
ся, а в рабочем окне документа появится один ярлык, представляющий со-
бой страницу макета документа.

Манипуляция страницами

Для многостраничных графических документов, обрабатываемых в CorelDRAW 12,
возникает потребность в выполнении различных операций манипуляции стра-
ницами: перехода на любую страницу документа, вставки новых страниц, удале-
ния имеющихся, переименования страниц.
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Существуют четыре способа выполнения этих операций:

О с использованием навигатора страниц;

О с помощью команд основного меню Layout (Макет);

О в режиме работы сортировщика страниц, переход в который производится
командой View \ Page Sorter View (Вид > Вид сортировщика страниц);

П с использованием контекстных меню навигатора и сортировщика страниц.

Рассмотрим эти способы по порядку.

Навигатор страниц
На рис. 7.11 представлен вид навигатора страниц с открытым контекстным меню.

I.
|jf Rename Page...

Ep; Insert Page After

[SJ Delete Page

R^ Switch Page Orientation
M + 1 of 4 ^ H Ч P^ytt^i! / paytf'Z / rayc? J / rgyeЬ
2 3 5 6

Рис. 7.11. Навигатор страниц документа

На панели навигатора находятся следующие элементы управления (их номера,
приведенные на рисунке, даны в квадратных скобках):

П [1] — контекстное меню навигатора, относящееся к текущей странице доку-
мента;

П [2] — кнопка перехода на первую страницу документа;

П [3] — кнопка, выполняющая переход на предыдущую страницу (если она
имеется) или создающая новую страницу при ее расположении в начале до-
кумента (в противном случае);

П [4] — кнопка открытия диалогового окна для указания в нем номера страни-
цы для перехода;

О [5] — кнопка, выполняющая переход на следующую страницу (при ее нали-
чии) или создающая новую страницу при ее расположении в конце докумен-
та (в противном случае);

О [6] — кнопка перехода на последнюю страницу документа;

П [7] — ярлычки страниц документа, управляющие их открытием;

П [8] — регулятор размера участка навигатора с ярлычками страниц.
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Используя навигатор, вы можете открыть любую страницу документа или вставить
новую страницу в начале документа или в его конце. Переход на произвольную
страницу выполняется щелчком на кнопке [4| с последующим вводом номера
страницы перехода в диалоговом окне Go To Page (Перейти на страницу).

Команды меню Layout
В состав меню Layout (Макет) входит пять команд по манипуляции страницами
документа, назначение которых определяется их названиями: Insert Page (Вста-
вить страницу), Delete Page (Удалить страницу). Rename Page (Переименовать
страницу), Go To Page (Перейти на страницу) и Switch Page Orientation (Поме-
нять ориентацию страницы). Опишем порядок работы с этими командами.

Вставка новых страниц
1. Откройте требуемую страницу документа.

2. Выполните команду Layout I* Insert Page (Макет > Вставить новую страницу),
открыв ее диалоговое окно Insert Page.

3. Задайте в этом окне следующие параметры:

• количество вставляемых страниц (поле Insert);

• положение новых страниц в документе: перед выбранной (переключатель
Before) или за нею (After);

• номер той страницы, перед или за которой будут вставлены новые (поле
Page);

• ориентацию страниц: портретную (переключатель Portrait) или альбомную
(Landscape);

• формат будущих страниц (список Paper) или их ширину и высоту (поля
Width и Height) в единицах измерения, указанных в списке справа.

4. Щелкните на кнопке подтверждения ОК.

Удаление страниц
1. Откройте нужную страницу документа.

2. Выполните команду Layout > Delete Page (Макет * Удалить страницу), открыв
ее диалоговое окно Delete Page.

3. Введите следующие параметры:

• номер первой удаляемой страницы (поле Delete page);

• режим удаления группы страниц, если это необходимо (флажок Through
to page);

• номер последней удаляемой страницы (поле Inclusive).

4. Щелкните на кнопке подтверждения ОК.
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Переименование страниц
1. Откройте требуемую страницу документа.

2. Выполните команду Layout > Rename Page (Макет > Переименовать страни-
цу), открыв ее диалоговое окно Rename Page.

3. Введите с клавиатуры в поле Page name новое название страницы, которое
отобразится на ярлычке страницы (справа от ее номера страницы через
двоеточие).

4. Щелкните на кнопке подтверждения ОК.

Переход на другую страницу
1. Откройте нужную страницу документа.

2. Выполните команду Layout > Go To Page (Макет > Перейти на страницу), от-
крыв ее диалоговое окно Go To Page.

3. Введите в поле Go To Page номер страницы, которая должна быть открыта.

4. Щелкните на кнопке подтверждения ОК.

Изменение ориентации страницы
1. Откройте требуемую страницу документа.

2. Выполните команду Layout > Switch Page Orientation (Макет > Поменять ори-
ентацию страницы).

Сортировщик страниц
В CorelDRAW 12 есть специальная функция сортировки страниц документа,
которая называется сортировщиком страниц. Она позволяет перемещать страни-
цы документа с помощью мыши, располагая их в произвольном порядке.
В режиме работы сортировщика вы можете также форматировать любые стра-
ницы документа инструментами панели свойств, а также манипулировать ими
с помощью команд контекстного меню, относящегося к выбранной странице.

Переход в режим работы сортировщика страниц производится командой
View > Page Sorter View (Вид > Вид сортировщика страниц). При этом в рабочем
окне документа отображаются значки страниц, доступные для манипуляции
с помощью мыши. Эти значки имеют приблизительно одинаковые размеры (для
удобства работы с ними) и прямоугольную форму, а их ориентация будет той
же, что и у соответствующих страниц документа. Для выхода из данного режима
необходимо отжать кнопку Page Sorter View (Вид сортировщика страниц), рас-
положенную крайней справа на панели свойств, или повторно выполнить ука-
занную выше команду.
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Примечание

Сортировщик страниц CorelDRAW 12 обладает одним недостатком: в рабочем
окне документа нельзя изменять масштаб отображения значков страниц. Это
приводит к неудобству в работе при наличии в документе большого числа
страниц, которые не помещаются на экране.

На рис. 7.12 показан пример работы сортировщика страниц. В данном случае
зафиксирован момент перемещения первой страницы документа (ее значок вы-
делен черной рамкой) на место между второй и третьей страницами.

567

Рис. 7.12. Работа в режиме сортировки страниц:
1 — выбор формата страниц документа; 2 — ширина и высота страницы;

3 — портретная ориентация страницы; 4 — альбомная ориентация;
5 — режим настройки параметров форматирования всех страниц документа;

6 — режим настройки параметров текущей страницы; 7 — выход из режима работы
сортировщика страниц; 8 — выбранная страница документа;

9 — место нового расположения выбранной страницы

Команды контекстного меню
Перечислим команды контекстных меню навигатора и сортировщика страниц
(эти меню одинаковы). Первое из них открывается щелчком правой кнопки
мыши на ярлычке соответствующей страницы, а второе — щелчком правой
кнопки мыши на значке выбранной страницы. В эти меню входят следующие
команды:

О Rename Page, используемая для переименования текущей страницы документа;

G Insert Page After, выполняющая вставку в документ новой страницы при ее
расположении сразу же за текущей страницей;

О Insert Page Before, вставляющая в документ новую страницу с размещением
перед текущей страницей;

О Delete Page, удаляющая текущую страницу;

П Switch Page Orientation, изменяющая ориентацию выбранной страницы на
противоположную.
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Работа с линейками, направляющими
и сеткой
Как и в любой другой графической программе, в CorelDRAW 12 предусмотрена
возможность работы с измерительными линейками (горизонтальной и верти-
кальной) и с линиями разметки (направляющими и сеткой). Линейки исполь-
зуются для выполнения различных измерений в документе, а линии разметки -
для удобства выравнивания в документе различных объектов, регулировки их
размеров, а также для рисования прямых линий.

CorelDRAW 12 позволяет работать с направляющими двух типов: обычными и
динамическими. Обычные направляющие представляют собой прямые линии,
формируемые пользователем путем их "отделения" мышью от измерительных
линеек. Такие направляющие можно поворачивать рабочим инструментом Pick
(Выбор) на заданный угол относительно произвольной точки документа.

Динамические направляющие отображаются на экране лишь в процессе выполне-
ния тех или иных операций с объектами документа. Они предоставляют пользо-
вателю два типа служебной информации:

П графическую информацию в виде прямых линий, проходящих вдоль траекто-
рии перемещения выбранного объекта по области документа (при нажатой
кнопке мыши) при условии, что эта траектория имеет один из фиксирован-
ных углов наклона к горизонтали, заданных в установочных параметрах
программы;

3 текстовую информацию, выводимую на экран при нахождении указателя
мыши в определенных точках документа, которая включает:

• угол наклона к горизонтали отображаемой направляющей;

• величину смещения вдоль направляющей перемещаемого объекта относи-
тельно исходного положения данного объекта или положения другого
объекта документа.

Динамические направляющие облегчают выполнение различных операций
с объектами документа с помощью мыши. К числу таких операций относятся:

О перемещение выбранного объекта по области документа;

П трансформация объекта в интерактивном режиме;

П регулировка размеров создаваемого нового векторного объекта.

На рис. 7.13 представлено рабочее окно документа в режиме работы с линейка-
ми, обычными направляющими и сеткой. В данном случае две перпендикуляр-
ные направляющие используются для выравнивания двух объектов эллиптиче-
ской и прямоугольной форм. Третья направляющая изображена в момент ее
поворота.

На рис. 7.14 показан пример использования динамической направляющей для
перемещения объекта под углом в 45° на заданное расстояние.
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Рис. 7.13. Вид на экране линеек, обычных направляющих и сетки

Рис. 7.14. Пример работы с динамической направляющей

Работа с линейками
Перечислим основные операции, выполняемые в CorelDRAW 12 с измеритель-
ными линейками.

Управление выводом линеек на экран
Для отображения линеек на экране выполните команду View > Rulers
(Вид > Линейки), установив слева от ее названия галочку. Для удаления линеек
повторно выберите команду View > Rulers.
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Изменение масштаба измерения линеек
1. Выберите рабочий инструмент Pick (Выбор) и отмените возможные выделе-

ния объектов в документе, щелкнув в свободном месте документа.

2. Откройте на панели свойств список Drawing Units (в центре) и задайте в нем
новые единицы измерения.

Регулировка положения центра координат линеек
1. Установите указатель в месте пересечения линеек (в левом верхнем углу ра-

бочего окна документа).

2. Нажмите кнопку мыши и переместите указатель в новое место расположения
центра, после чего отпустите кнопку мыши. В процессе перемещения указа-
теля на экране появятся две пунктирные перпендикулярные прямые, облег-
чающие выполнение данной операции.

3. Для восстановления первоначального положения центра координат линеек,
совпадающего с положением левой нижней вершины прямоугольной области
страницы документа, поместите указатель в место стыка линеек и выполните
двойной щелчок.

Настройка параметров линеек
1. Выведите на экран линейки (если их нет), установите на одной из них указа-

тель, откройте правой кнопкой мыши контекстное меню и выполните в нем
команду Ruler Setup (Настройка линейки). В результате откроется диалоговое
окно Options (Параметры) на вкладке Document > Rulers (Документ >
Линейки). Здесь вы можете задать следующие параметры:

• в обл. . - - Units вкладки: единицы измерения для горизонтальной и вер-
тикал^ .ой линеек (списки Horizontal и Vertical и флажок Same units for
Horn mtal and Vertical rulers);

• в области Origin: величины смещения центра координат по горизонтали
и вертикали относительно своего исходного положения (списки Horizontal
и Vertical);

• количество промежутков, на которые разбиваются интервалы между
большими делениями (поле Tick divisions);

• режим отображения на линейках дробных величин (флажок Show
fractions);

• режим вывода линеек на экран (флажок Show Rulers).

2. Закройте окно Options щелчком на кнопке ОК.

Фиксация параметров линеек
Чтобы использовать текущие параметры линеек при работе с новыми докумен-
тами, выберите один из двух вариантов действий:

О откройте (любым способом) окно Options (Параметры) и перейдите в нем на
вкладку Document (Документ), установите два флажка: Save options as default



Работа с документом 509

for new documents (Сохранить параметры по умолчанию для новых докумен-
тов) и Grid and ruler options (Параметры сетки и линейки), после чего за-
кройте окно щелчком на кнопке ОК;

3 выполните команду Tools > Save Settings As Default (Инструменты > Сохранить
настройки для использования по умолчанию), сохранив все текущие пара-
метры документа в качестве параметров по умолчанию.

Работа с обычными направляющими
Перечислим операции, выполняемые в программе с обычными направляющими.

Создание новой направляющей
1. Выведите на экран линейки с помощью команды View ^ Rulers (Вид >

Линейки).

2. Задайте режим отображения направляющих, выполнив команду View > Guidelines
(Вид * Направляющие) и установив в ее названии галочку.

3. Для создания вертикальной (горизонтальной) направляющей установите ука-
затель на вертикальной (горизонтальной) линейке, нажмите кнопку мыши и
перетащите указатель в область документа, затем отпустите кнопку мыши.
В месте отпуска кнопки появится новая направляющая, имеющая вид пря-
мой пунктирной линии, параллельной вертикальной (горизонтальной) оси.

Перемещение направляющей
Для перемещения направляющей параллельно ее исходному положению сделай-
те следующее.

1. Выберите рабочий инструмент Pick (Выбор). Подведите указатель к направ-
ляющей (он примет форму двунаправленной стрелки) и нажмите кнопку
мыши.

2. Переместите направляющую в нужное место документа и отпустите кнопку
мыши.

Поворот направляющей
Для поворота направляющей на заданный угол относительно некоторой точки
области документа выполните следующие действия.

1. Выберите инструмент Pick.

2. Подведите указатель к направляющей и щелкните на ней мышью, выделив ее
(цвет направляющей изменится на красный).

3. Сделайте еще один щелчок на направляющей, отобразив по ее краям два
маркера в виде двунаправленных стрелок, в центре — метку центра вращения
в виде небольшой окружности с точкой посредине.

4. Если положение центра вращения направляющей должно отличаться от ис-
ходного, задайте его, перетащив центр вращения в нужную точку документа.
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5. Установите указатель на одном из маркеров (в виде стрелок), нажмите кноп-
ку мыши и поверните направляющую на требуемый угол, после чего отпус-
тите кнопку мыши.

Удаление направляющей
1. Выделите направляющую инструментом Pick (Выбор), щелкнув на ней.

2. Нажмите клавишу <Del>.

Настройка параметров направляющих
1. Откройте диалоговое окно Options (Параметры) с помощью команды

View > Guidelines Setup (Вид > Настройка направляющих) основного меню
программы или команды Guidelines Setup (Настройка направляющих) кон-
текстного меню измерительных линеек.

2. Отрегулируйте в этом окне параметры, расположенные на пяти вкладках,
относящихся к категории настроек второго уровня Guidelines (Направляю-
щие), входящей в категорию Document (Документ) (см. разд. "Параметры до-
кумента" гл. 8).

3. Закройте окно Options щелчком на кнопке ОК.

Фиксация параметров направляющих
Чтобы использовать текущие параметры направляющих при работе с новыми
документами, выберите один из двух вариантов действий:

П откройте (любым способом) окно Options (Параметры) и перейдите в нем на
вкладку Document (Документ), установите два флажка: Save options as default
for new documents (Сохранить параметры по умолчанию для новых докумен-
тов) и Guideline options (Параметры направляющих), после чего закройте ок-
но щелчком на кнопке ОК;

П выполните команду Tools > Save Settings As Default (Инструменты >
Сохранить настройки для использования по умолчанию), сохранив все теку-
шие параметры документа в качестве параметров по умолчанию.

Работа с динамическими направляющими
Рассмотрим операции с динамическими направляющими, выполняемые
в CorelDRAW 12.

Управление отображением направляющих
Для подключения режима работы с динамическими направляющими выполните
команду View > Dynamic Guides (Вид t Динамические направляющие), установив
галочку в ее названии. Для отключения данного режима повторно выполните
указанную команду, удалив галочку.
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Настройка параметров направляющих
1. Выполните команду View > Dynamic Guides Setup (Вид > Настройка динамиче-

ских направляющих), открыв диалоговое окно Options (Параметры) на
вкладке Workspace » Dynamic Guides (Рабочая область > Динамические на-
праатяющие).

2. Настройте на этой вкладке параметры динамических направляющих
(см. разд. "Параметры интерфейса"гл. 8).

3. Закройте окно Options щелчком на кнопке ОК.

^~ Примечание

Цвет динамических направляющих— синий, он не может быть изменен поль-
зователем.

Работа с сеткой
Перечислим операции, выполняемые в CorelDRAW 12 с сеткой.

Управление выводом сетки на экран
Для отображения сетки на экране выполните команду View > Grid (Вид > Сетка),
установив слева от ее названия галочку. Для удаления сетки повторно выберите
команду View > Grid.

Настройка параметров сетки
1. Откройте диалоговое окно Options (Параметры) на вкладке Document > Grid

(Документ»Сетка), использовав для этого команду View > Grid And Ruler
Setup (Вид > Настройка сетки и линейки) основного меню или команду Grid
Setup (Настройка сетки) контекстного меню линеек.

2. Настройте параметры сетки.

3. Закройте окно Options щелчком на кнопке ОК.

Фиксация параметров сетки
Чтобы использовать текущие параметры сетки при работе с новыми документа--
ми, выберите один из двух вариантов действий:

G откройте (любым способом) окно Options (Параметры) и перейдите в нем на
вкладку Document (Документ), установите два флажка: Save options as default
for new documents (Сохранить параметры по умолчанию для новых докумен-
тов) и Grid and ruler options (Параметры сетки и линейки), после чего за-
кройте окно щелчком на кнопке ОК;

П выполните команду Tools > Save Settings As Default (Инструменты >
Сохранить настройки для использования по умолчанию), сохранив все теку-
щие параметры документа в качестве параметров по умолчанию.
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Работа в режимах привязки
Основным назначением направляющих и сетки является выравнивание объектов
в документе. Такое выравнивание удобней всего производить при выборе соот-
ветствующих режимов привязки, когда перемещение объекта мышью будет про-
исходить не плавно, а скачками. При этом грани и вершины объекта будут как
бы притягиваться к соответствующим линиям разметки или к другим объектам,
расположенным в непосредственной близости от него.

В программе CorelDRAW 12 предусмотрены три режима привязки: к линиям
сетки, к направляющим и к объектам. Подключить нужные режимы вы сможете
двумя способами:

П с помощью трех команд меню View (Вид): Snap To Grid (Привязать к сетке),
Snap To Guidelines (Привязать к направляющим) и Snap To Objects (Привя-
зать к объектам);

О с использованием трех кнопок управления, имеющих такие же названия, ко-
торые находятся в правой части панели свойств при условии выбора инстру-
мента Pick (Выбор) и отсутствия в документе выделенных объектов.

Следует отметить очень широкие возможности режима привязки к объектам,
реализованного в CorelDRAW 12. Если в предыдущих версиях данной програм-
мы привязка опорной точки перемещаемого объекта (точки захвата объекта ука-
зателем) осуществлялась лишь к узелкам и геометрическим центрам других объ-
ектов, то теперь стало возможным делать следующее:

П выполнять привязку ко многим другим элементам объектов (в том числе к их
границам, точкам пересечения контуров, серединным точкам, расположен-
ным между двумя соседними узелками, и т. п.);

О отображать на экране значки и названия различных элементов объектов,
к которым осуществляется привязка.

Настройка параметров режима привязки к объектам производится на вкладке
Workspace > Snap to Objects (Рабочая область * Привязать к объектам) диалого-
вого окна Options (Параметры) (см. разд. "Параметры интерфейса" &i. 8).

f^ Примечание

Чтобы повысить эффективность режима привязки при работе со стандартными
геометрическими фигурами (прямоугольниками, эллипсами и правильными
многоугольниками), разработчики CorelDRAW 12 отказались от интерактивной
регулировки формы таких фигур с помощью рабочего инструмента Pick (Вы-
бор), используемого при перемещении объектов. Теперь такую регулировку
можно выполнить лишь рабочим инструментом Shape (Форма).

На рис. 7.15 показан пример привязки перемещаемого объекта эллиптической
формы к различным элементам другого объекта, имеющего форму прямоуголь-
ника. Обратите внимание на различия в значках и названиях элементов, к кото-
рым осуществляется привязка.
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Рис. 7.15. Пример работы в режиме привязки к объектам

Перемещение объектов
В документе CorelDRAW 12 объекты можно перемешать следующим образом:

О по области документа, видимой на экране;

О между страницами документа;

П по толщине документа внутри активного слоя;

О по толщине документа между его слоями.

Рассмотрим эти операции по порядку.

Перемещение объектов в видимой области
документа
Указанная операция может выполняться двумя способами: с помощью рабочего
инструмента Pick (Выбор) и с использованием команд, входящих в подменю
Align and Distribute (Выровнять и распределить) меню Arrange (Расположить)
В первом случае перемещение выбранных объектов производится вручную
с помощью мыши, а во втором — автоматически в соответствии с заданным кри-
терием их выравнивания или равномерного распределения. Причем с помощью
инструмента Pick можно не только перемешать объекты, но и копировать их.

7 Зак 250
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Перемещение или копирование объектов
инструментом Pick
1. Выберите рабочий инструмент Pick (Выбор).

2. Откройте документ на нужной странице, задайте требуемый масштаб и ото-
бразите в рабочем окне документа ту его область, в которой будут переме-
шаться объекты.

3. Выделите один или группу объектов, которые должны быть перемещены.

4. Установите указатель на метку геометрического центра прямоугольной об-
ласти выделения объектов, нажмите кнопку мыши, переместите объекты
в нужное место документа и сделайте одно из двух:

• при выполнении операции перемещения объектов отпустите кнопку мыши;

• при выполнении операции копировании объектов щелкните правой
кнопкой мыши, после чего отпустите левую ее кнопку.

Выравнивание и распределение объектов
Данные операции выполняются с помощью десяти команд, входящих в подме-
ню Align and Distribute меню Arrange. Перечислим эти команды, указав их на-
значение:

П Align Left (Выровнять слева) (быстрая клавиша — <L>) — выравнивает левые
границы выделенных объектов по левой границе того из них, который был
выбран последним;

О Align Right (Выровнять справа) (<R>) — выполняет аналогичную функцию
команды Align Left, только относительно правых границ объектов;

П Align Top (Выровнять сверху) (<Т>) — выполняет аналогичную функцию ко-
манды Align Left, только относительно верхних границ объектов;

О Align Bottom (Выровнять снизу) (<В>) — выполняет аналогичную функцию
команды Align Left, только относительно нижних границ объектов;

П Align Centers Horizontally (Выровнять центры по горизонтали) (<Е>) — вы-
равнивает центры выделенных объектов по горизонтали, проведенной через
центр того из них, который был выбран последним;

О Align Centers Vertically (Выровнять центры по вертикали) (<С>) — выравни-
вает центры выбранных объектов по вертикали, проведенной через центр
того из них, который был выбран последним;

П Center to Page (По центру страницы) (<Р>) — выравнивает центры выделен-
ных объектов по центру текущей страницы документа;

П Center to Page Horizontally (По центральной горизонтали страницы) — вы-
равнивает центры выбранных объектов по горизонтали, проведенной через
центр страницы документа;

П Center to Page Vertically (По центральной вертикали страницы) — выравни-
вает центры выделенных объектов по вертикали, проведенной через центр
страницы документа;
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О Align and Distribute (Выровнять и распределить) — открывает одноименное
диалоговое окно, позволяющее выполнить различные операции выравнива-
ния и равномерного распределения выбранных объектов (выравнивание бу-
дет производиться по объекту, выбранному последним).

Выравнивание объектов командой Align and Distribute

1. Выделите в документе группу объектов, положение которых должно быть
выровнено относительно одного из них или относительно границ открытой
страницы (в последнем случае объект может быть один). Если выравнивание
производится относительно некоторого объекта, то его необходимо выделить
последним.

2. Выполните команду Arrange > Align and Distribute > Align and Distribute (Распо-
ложить > Выровнять и распределить > Выровнять и распределить), открыл
диалоговое окно Align and Distribute (Выровнять и распределить) на вкладке
Align (Выровнять) (рис. 7.16). Расположите это окно так, чтобы оно не засло-
няло область выравнивания объектов.

3. Определитесь в отношении состояния следующих флажков, рядом с которы-
ми изображены соответствующие схемы выравнивания:

• слева: Тор (Сверху), Center (По центру), Bottom (Снизу) — управление
режимом вертикального выравнивания объектов;

• вверху: Left (Слева), Center (По центру), Right (Справа) — управление ре--
жимом горизонтального выравнивания объектов.

4. Определитесь в отношении состояния списка Align Objects To, выбрав в нем
область выравнивания:

• Active objects — область охвата выделенных объектов;

• Edge of page — область текущей страницы документа;

• Center of page — центр страницы;

• Grid — линии сетки;

• Specific point — произвольная точка документа, задаваемая щелчком
мыши.

5. Определитесь в отношении состояния списка For Text Source Objects Use,
выбрав в нем критерий выравнивания для текстовых объектов:

• First line baseline — выравнивание по базовой линии первой строки текста;

• Last line baseline — выравнивание по базовой линии последней строки;

• Bounding box — выравнивание по той точке тестового объекта, которая за-
дается с помощью установленных в окне флажков.

6. Щелкните мышью на кнопке Apply, выполнив операцию выравнивания
в соответствии с заданным критерием.

7. Если в списке Align Objects To был выбран пункт Specific point, то задайте
в документе требуемую точку выравнивания, выполнив в ней щелчок мышью.
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Если необходимо выровнять другие объекты документа, повторите предыду-
щие шаги инструкции в отношении них, в противном случае закройте окно
Align and Distribute щелчком на кнопке Close.

' =>*
Mian ind DiBtribute E31

Align Distribute |

K> <f» ,. . ,'•' *C>

! ' Left. - Г" Certet '' Right

Щ ~ Top 4Ji(n Objects To:

Active objects -Tj

SY ** Center . ' ••',;• :i..;"' , .
For Text Source Ob|ects Usa:

Of} ' Bottom Bounding box ^

Apply Close

Рис. 7.16. Пример вертикального выравнивания трех объектов
командой Align and Distribute

Распределение объектов командой Align and Distribute

1. Выделите не менее двух объектов, положение которых должно быть равно-
мерно распределено в определенной области документа в соответствии с вы-
бранным критерием.

2. Выполните команду Arrange > Align and Distribute > Align and Distribute (Распо-
ложить > Выровнять и распределить > Выровнять и распределить), открыв
диалоговое окно Align and Distribute (Выровнять и распределить), и перейди-
те на вкладку Distribute (Распределить) (рис. 7.17). Расположите это окно так,
чтобы оно не закрывало область распределения объектов.

3. Задайте требуемый критерий распределения, определившись в отношении
состояния флажков, рядом с которыми изображены соответствующие схемы
распределения:

• слева: Тор (Верхние границы), Center (Центры), Spacing (Промежутки),
Bottom (Нижние границы) — управление режимом равномерного верти-
кального распределения указанных элементов выбранных объектов или
промежутков между ними;

• флажки вверху: Left (Левые границы), Center (Центры), Spacing (Проме-
жутки), Right (Правые границы) — управление режимом равномерного
горизонтального распределения указанных элементов выделенных объек-
тов или промежутков между ними.

4. Выберите один из двух режимов: режим распределения объектов в области
выделения (переключатель Extent of selection) или в области открытой стра-
ницы документа (переключатель Extent of page).

5. Щелкните мышью на кнопке Apply, выполнив операцию выравнивания
в соответствии с заданным критерием.
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6. Если необходимо выполнить операцию распределения и для других объектен
документа, повторите предыдущие шаги инструкции в отношении них, в про-
тивном случае закройте окно Align and Distribute щелчком на кнопке Close.

Align and Distribute

Distribute

Left • Canter Г 5рзспд Г Right

;-Distribute to ••

а*Г У Center ' ! ;• Extent of selection

n°J I Spacing ' Extent of page

.̂i Г Bottom

Рис. 7.17. Пример равномерного распределения трех объектов
командой Align and Distribute

Перемещение объектов
между страницами документа
Существуют два способа перемещения одного или нескольких объектов с одно)!
страницы документа на другую: через буфер обмена операционной системы и
с использованием компоновочной зоны монтажного стола.

Перемещение объектов через буфер обмена
Этот способ обычно используется Б тех случаях, когда необходимо перенести на
другую страницу объекты без изменения их координат либо когда таких объек-
тов несколько.

1. Откройте документ на нужной странице и выделите на ней группу переме-
щаемых объектов, используя для этого рабочий инструмент Pick (Выбор) и
клавишу <Shift>.

2. Выполните команду Edit > Cut (Правка > Вырезать).

3. Перейдите на страницу, куда объекты должны быть помешены.

4. Выполните команду Edit > Paste (Правка > Вставить).

Перемещение объектов через компоновочную зону

1. Откройте документ на нужной странице.

2. Переместите инструментом Pick из области текущей страницы в компоно-
вочную зону те объекты, которые должны находиться на другой странице.

3. Перейдите на требуемую страницу и переместите в ее область данные объек-
ты из компоновочной зоны, расположив их так, как необходимо.
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Перемещение объектов
внутри текущего слоя документа
Если несколько объектов расположены внутри одного слоя документа, частично
или полностью заслоняя друг друга, то вы можете изменить порядок их пакети-
рования в данном слое двумя способами:

П с помощью семи команд подменю Order (Упорядочить) меню Arrange (Рас-
положить);

П с использованием докера Object Manager (Диспетчер объектов) (см. разд.
"Слои" гл. 3),

Перемещение объекта
командами подменю Order меню Arrange
1. Выделите требуемый объект рабочим инструментом Pick (Выбор).

2. Чтобы разместить выбранный объект перед всеми другими объектами своего
слоя, выполните команду То Front (Вверх), а позади всех — команду То Back
(Вниз).

3. Для изменения порядка взаимного расположения выбранного объекта и того,
который находится непосредственно перед ним (или за ним), выполните ко-
манду Forward One (На один вперед) (или команду Back One (На один назад)).

4. Чтобы разместить выбранный объект перед любым другим объектом теку-
щего слоя документа, который находится перед ним (или позади него), вы-
полните команду In Front Of (Перед) (или команду Behind (Сзади)). При
этом указатель примет вид жирной стрелки, которую необходимо поместить
в область другого объекта и щелкнуть кнопкой мыши.

5. Для изменения порядка пакетирования в слое двух произвольных объектов
нужно выделить их инструментом Pick (Выбор) и клавишей <Shift>, а затем
выполнить команду Reverse Order (Обратный порядок).

Перемещение объекта
докером Object Manager
1. Выделите требуемый объект рабочим инструментом Pick (Выбор).

2. Откройте докер Object Manager (Диспетчер объектов) одноименной коман-
дой подменю Dockers (Докеры) меню Window (Окно).

3. В рабочем окне докера сделайте следующее. Откройте вложенный список
слоев, относящийся к текущей странице документа. Установите указатель на
строке выбранного объекта, нажмите кнопку мыши и перетащите строку
в другое место подсписка текущего слоя, расположив перед или позади стро-
ки с другим объектом. Как только в месте вставки объекта появится черная
разделительная линия между строками списка, отпустите кнопку мыши.
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Перемещение объектов
между слоями документа
Перемещение объекта из одного слоя документа в другой (с сохранением его
положения на странице) может быть выполнено с помощью докера Object
Manager. Порядок работы в данном случае будет тем же, что и при перемеще-
нии объекта внутри текущего слоя документа. Исключение состоит лишь в том,
что выбранный элемент списка перемещается в другую его ветвь, относящуюся
к иному слою той же страницы документа.

Поиск и замена информации
В процессе работы над документом векторной графики вам может понадобиться
поиск объектов с заданными характеристиками либо замена одних параметров
оформления объектов другими. Если в документе есть текстовая информация,
то может потребоваться поиск или замена определенных текстовых фрагментов.

В CorelDRAW 12 для решения такого рода задач предусмотрена специальная
функция поиска и замены информации. Она реализуется с помощью следующие
четырех команд, входящих в подменю Find and Replace (Найти и заменить) ме-
ню Edit (Правка): Find Objects (Найти объекты), Replace Objects (Заменить объ-
екты). Find Text (Найти текст) и Replace Text (Заменить текст).

Поиск объектов командой Find Objects
С помощью команды-мастера Find Objects (Найти объекты) вы можете находить
в документе объекты, параметры которых соответствуют заданным. В частности,

Which object w^uld уем ice to find? Select theii propefliet below.

Object Types j fii|s • Outlines Special Effects;

Find, arty lupeof.object

Select the object typeihal
'yew want lo find. Click on
Fills, Dutlnes, 01 Special
Effects so define your
search (ml he*.

Reel angles

.'.S3 Ellipses
7]r Polygon;
'.'.&1 Interactive Connector Line
"_"]-JTexl
' ' ! L '"1 Dimensions

:_j Others

Look tor Object Narnes 01 Styles

Отмена

Рис. 7.18. Диалоговое окно Find Wizard в режиме формирования критерия поиска
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она допускает поиск произвольных линий, геометрических фигур, соединитель-
ных и размерных линий, образцов обычного и художественного текста, растро-
вых изображений, объектов OLE, а также трехмерных объектов. В критерии по-
иска вы можете указывать не только типы объектов, но и их конкретные
параметры (геометрические размеры, атрибуты заливки и обводки, стили, пара-
метры оформления используемых эффектов и т. п.).

На рис. 7.18 представлено одно из диалоговых окон команды-мастера Find
Objects, на вкладках которого формируется критерий поиска (все эти окна име-
ют общее название Find Wizard (Мастер поиска)).

На рис. 7.19 показан пример поиска к документе векторных объектов в форме
прямоугольников, которые были заданы в критерии поиска.

FjnjNeJQ Find fill £dl Search... ':

Рис. 7.19. Пример поиска в документе прямоугольников

Порядок работы
1. Если вы хотите найти в документе объекты, идентичные некоторому объекту,

используемому в качестве образца, то выделите этот объект рабочим инстру-
ментом Pick (Выбор).

2. Выполните команду-мастера Edit > Find and Replace > Find Objects (Правка >
Найти и заменить > Найти объекты), открыв ее первое по порядку окно,
входящее в группу диалоговых окон под названием Find Wizard (Мастер
поиска).

3. Выберите один из трех режимов поиска, доступных для использования:

• начать новый поиск (переключатель Begin a New Search);

• загрузить файл с заданными параметрами поиска (переключатель Load
a search from disk);

• осуществить поиск объектов по выделенному образцу (переключатель Find
objects that match the currently selected object).

4. Щелкните на кнопке Далее, находящейся внизу, и перейдите к следующему
по порядку окну команды-мастера.
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5. Выполните настройку необходимых параметров во всех диалоговых окнах,
сформировав требуемый критерий поиска объектов (для перехода от одного
окна к другому используйте кнопку Далее).

6. При работе в режиме нового поиска, который используется чаще других,
выполните следующие действия. На вкладке Object Types (Типы объектов)
второго диалогового окна команды-мастера (см. рис. 7.18) отметьте флажка-
ми типы объектов, которые необходимо включить в критерий поиска, либо
установите один из двух флажков: Find any type of object при поиске объектов
любых типов или Look for Object Names or Styles в случае поиска объектов
по их именам или используемым стилям. Если оба флажка сброшены, про-
должите настройку параметров на других вкладках окна: Fills (Заливки),
Outlines (Обводки) и Special Effects (Специальные эффекты).

7. При появлении внизу диалогового окна кнопки Готово убедитесь в правиль-
ности формирования критерия поиска, отображаемого в этом окне (послед-
нем). Если представленные в списке параметры вас не устраивают, то откор-
ректируйте их, вернувшись к предыдущим окнам с помощью кнопки Назад,,
В противном случае щелкните на кнопке Готово, перейдя в режим поиска
объектов в документе (предварительно вы можете сохранить сформирован-
ный критерий поиска в файле с расширением fin для последующего исполь-
зования, щелкнув на кнопке Save).

8. Для поиска требуемых объектов на текущей странице документа и в компоно-
вочной зоне выполняйте последовательные щелчки на кнопке Find Next (Най-
ти следующий), расположенной на плавающей панели Find (см. рис. 7.19).
В результате те объекты, которые удовлетворяют критерию поиска, будут по-
следовательно выделяться. Если вы решите перейти к предыдущему объекту,
найденному ранее, то щелкните на кнопке Find Previous (Найти предыду-
щий). Для выделения всех объектов текущей страницы и компоновочной зо-
ны, отвечающих критерию поиска, щелкните на кнопке Find All (Найти все).
Изменение критерия поиска производится с помощью кнопки Edit Search
(Редактировать критерий поиска).

9. Если необходимо, повторите предыдущий шаг инструкции для других стра-
ниц документа. На следующую страницу вы сможете перейти после того, как
завершится поиск на текущей странице, о чем свидетельствует предупреж-
дающее сообщение, которое будет выведено на экран.

Замена параметров объектов
командой Replace Objects
Команда-мастер Replace Objects (Заменить объекты) используется для замены
одних параметров оформления объектов другими, указанными пользователем
в критерии замены.

На рис. 7.20 представлено одно из диалоговых окон команды Replace Objects,
используемое при выборе цветовых параметров объектов, подверженных замене
(все эти окна имеют обшее название Replace Wizard (Мастер замены)).
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Replace wizard

Select which Colof you would like to find and which Color
you would like to replace it with.

find

fleplace with:

, Replace colors used as

| -:• .Fills

Outlines

у Apply to fountain fiils .

v Apply to 2-color pattern fills.

V Apply to rjonochiome bitmaps

< Назад Finish Отмена

Рис. 7.20. Диалоговое окно Replace Wizard
в режиме задания цветовых параметров объектов

Порядок работы
1. Выполните команду-мастер a Edit t Find and Replace ^ Replace Objects (Правка >

Найти и заменить * Заменить объекты), открыв первое по порядку окно, входя-
щее в группу диалоговых окон под названием Replace Wizard (Мастер замены).

2. Выберите один из четырех возможных режимов замены параметров оформ-
ления объектов:

• замена цвета заливки или обводки объектов (переключатель Replace a color);

• замена используемой цветовой модели или библиотеки цветов (переклю-
чатель Replace a color model or palette);

• замена параметров обводки (переключатель Replace outline pen properties);

• замена параметров форматирования текста (переключатель Replace text
properties).

3. Определитесь в отношении состояния флажка Apply to currently selected objects
only (Применить только к выделенным объектам), при установке которого бу-
дет выполняться замена параметров лишь для выделенных объектов.

4. Щелкните на кнопке Далее, находящейся внизу, перейдя к следующему по
порядку окну команды-мастера.

5. Выполните настройку требуемых параметров, находящихся во всех диалого-
вых окнах данной команды, сформировав критерий замены параметров объ-
ектов (для перехода от одного окна к другому используется кнопка Далее).
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6. Щелкните в последнем окне на кнопке Finish (Конец), перейдя в режим по-
иска объектов с заданными параметрами оформления и замены их на другие,
указанные в критерии.

7. Для последовательной замены заданных параметров объектов, находящихся
на текущей странице документа и в компоновочной зоне, выполняйте после-
довательные щелчки на кнопке Replace (Заменить), расположенной на пла-
вающей панели Find and Replace (Найти и заменить), а для одновременной
замены параметров всех этих объектов щелкните на кнопке Replace АН (За-
менить все).

&. Если необходимо, повторите предыдущий шаг инструкции для других стра-
ниц документа. На следующую страницу вы сможете перейти после того, как
завершится замена параметров объектов на текушей страниие, о чем свиде-
тельствует предупреждающее сообщение, которое будет выведено на экран.

Поиск и замена текстовой информации
Команда Find Text (Найти текст) предназначена для поиска в документе задан-
ного текстового фрагмента (ключевого слова или фразы). Команда Replace Text
(Заменить текст) отличается от предыдущей команды тем, что выполняет не
только поиск определенного фрагмента текста, но и его замену на другой фраг-
мент, заданный пользователем.

Особенность этих команд состоит в том, что поиск и замена текстовой инфор-
мации может производиться как во всех текстовых материалах документа, так
и в текущем материале, в котором находится текстовый курсор. Этим данные
команды отличаются от одноименных команд диалогового окна Edit Text
(Редактировать текст), позволяющих выполнять аналогичные операции лишь
в текущем текстовом материале (см. разд. "Редактирование текста" гл. 6).

Порядок работы с командой Find Text
1. Если вы хотите произвести поиск ключевого слова или фразы в одном из

нескольких текстовых материалов документа, то выберите рабочий инстру-
мент Text (Текст) и установите текстовый курсор в любом месте блока тек-
ста, относящегося к данному материалу.

2. Выполните команду Edit > Find and Replace > Find Text (Правка > Найти и за-
менить > Найти текст), открыв диалоговое окно Find Text.

3. Введите в поле Что: ключевое слово (фразу).

4. Если в процессе поиска необходимо учитывать регистр клавиатуры, в кото-
ром представлены буквы ключевого слова, то установите флажок С учетом
регистра.

5. Выполняйте щелчки на кнопке Найти далее, производя последовательный
поиск и выделение образцов ключевого слова в текущем текстовом материале
либо во всех материалах документа, в которых это слово встречается.

6. Закройте окно Find Text щелчком на кнопке Close.
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Порядок работы с командой Replace Text
1. Чтобы произвести поиск и замену ключевого слова или фразы в одном из

нескольких текстовых материалов документа, выберите инструмент Text
и установите текстовый курсор в любом месте блока текста, относящегося
к данному материалу.

2. Выполните команду Edit > Find and Replace > Replace Text (Правка > Найти
и заменить > Заменить текст), открыв диалоговое окно Replace Text.

3. Введите в поле Что: ключевое слово или фразу, по которому будет производиться
поиск, а в поле Чем: — то слово (фразу), на которое оно будет заменено.

4. Если в процессе поиска необходимо учитывать регистр клавиатуры, в кото-
ром представлены буквы ключевого слова, то установите флажок С учетом
регистра.

5. Выполняйте щелчки на кнопке Заменить, производя последовательный по-
иск и замену образцов ключевого слова в текущем текстовом материале либо
во всех материалах документа. При щелчке на кнопке Заменить все такая
замена будет выполнена одновременно во всех выбранных текстовых мате-
риалах документа.

6. Закройте окно Replace Text щелчком на кнопке Close.

Слияние информации при печати
Под термином слияние информации при печати понимается функция
CorelDRAW 12 по формированию нескольких копий печатного документа, от-
личающихся между собой текстовыми надписями, выводимыми в определенных
его местах. Эти надписи хранятся в рабочей таблице, сформированной пользо-
вателем или загруженной из выбранного источника данных,

Таким источником служит текстовый файл (с расширением txt, csv или rtf) или
файл базы заданного формата, отвечающего стандарту ODBC (Open DataBase
Connectivity — Открытый доступ к данным). Места размещения в документе
текстовых надписей задаются с помощью так называемых меток полей слияния,
В этих местах будут располагаться записи из соответствующих полей рабочей
таблицы данных. Параметры форматирования этих меток, представляющих собой
образцы художественного текста (этим текстом указываются названия полей),
будут теми же, что и для выводимой при печати текстовой информации.

Примечание

Функция слияния информации при печати реализована также в текстовом ре-
дакторе Microsoft Word.

Для выполнения различных операций, относящихся к слиянию информации
при печати, применяются следующие средства программы:

D панель инструментов Print Merge (Слияние при печати) (см. разд. "Панели
инструментов" гл. 2)',
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П три команды подменю Print Merge (Слияние при печати) меню File (Файл):

• Create/Load Merge Fields (Создать/Загрузить поля слияния), предназна-
ченная для запуска в работу мастера Print Merge Wizard (Мастер слияния
при печати), с помощью которого можно создать собственную таблицу
данных или загрузить такую таблицу из источника данных, поддержи-
вающего стандарт ODBC;

• Perform Merge (Выполнить слияние), открывающая диалоговое окно ко-
манды Print (Печать) с целью настройки в нем параметров печати, а так-
же распечатки документа в режиме слияния информации;

• Edit Merge Fields (Редактировать поля слияния), используемая для запуска
в работу мастера Print Merge Wizard с целью редактирования текущей
таблицы данных.

На рис. 7.21 показано дополнительное окно мастера слияния, в котором произ-
водится выбор источников данных, поддерживающих стандарт ODBC.

Выбор источника данных

.Файловый источник данных

Папка: Data Sources

Источник данных компьютера

„dBASE Files (no! sharablel.dsn

lExcel Files (not sharablej.dsn

'FoxPro Files (nol sharable).dsn

rMS Access Э7 Database (not sharable).dsn

I Tent Files (not sharable).dsn

ИмяОЗМ: JdBASE Files (not shatable) Создать.

Выберите Файловый источник данный, описывающий драйвер, с которым
нужно ycraHoevfTb связь. Допускается использовать любой источник
данных, который ссылается на драйвер ODBC, установленный на данном
компьютере.

СЖ

Рис. 7.21. Диалоговое окно Выбор источника данных

На рис. 7.22 представлено диалоговое окно мастера слияния, в котором редак-
тируется структура текущей таблицы данных.

На рис. 7.23 изображено диалоговое окно мастера слияния, в котором редакти-
руется содержимое данной таблицы.

На рис. 7.24 показан фрагмент окна программы в режиме формирования меток
полей слияния.
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Рис. 7.22. Окно редактирования структуры таблицы данных

Piinl Meige

Create or edit data in lecord
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Дет списания d
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< Назад Далее > Отмена j

Рис. 7.23. Окно редактирования содержимого таблицы данных

1 * j J^Oefauit Artistic Text* >j j -ц- дпа| Суг

<KOD>

•iPRZ>

<PRZ>

Рис. 7.24. Пример формирования меток полей слияния
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Порядок слияния информации
1. Выполните команду-мастера File > Print Merge > Create/Load Merge Fields

(Файл ^Слияние при печати ^Создать/Загрузить поля слияния), открыв
первое по порядку диалоговое окно мастера слияния Print Merge Wizard.

2. Задайте способ получения данных для слияния с содержимым документу:
ввод с клавиатуры (переключатель Create from scratch) или загрузка из фай-
ла (переключатель Select from existing file), после чего перейдите к следую-
щему диалоговому окну, щелкнув внизу на кнопке Далее.

3. Если выбран способ загрузки данных из файла, выполните следующие дей-
ствия. Задайте тип источника: текстовый (переключатель Data file и кнопку
выбора файла на диске) или ODBC (переключатель ODBC Data Source и
кнопка Select ODBC Data Source). Для второго типа файлов задайте в рас-
крывшемся дополнительном окне Выбор источника данных (см. рис. 7.21)
упраштяющий файл (с расширением dsn), описывающий драйвер, с которым
нужно установить связь, и задающий адрес папки с источниками данных.
Если такой файл в списке окна отсутствует, то сформируйте его (кнопка
Создать). Щелкните на кнопке ОК, закрыв данное окно и открыв окно
Select Table (Выделить таблицу). Выберите в нем конкретный источник
(файл), из которого данные будут загружены в рабочую таблицу, после чего
закройте это окно щелчком на кнопке ОК. В окне Print Merge Wizard
щелкните на кнопке Далее.

4. В следующих двух окнах мастера слияния создайте новую или отредакти-
руйте существующую таблицу с данными (см. рис. 7.22 и 7.23), затем перей-
дите в последнее окно мастера.

5. Если вы хотите сохранить текущую таблицу данных в файле для последую-
щего использования, то установите флажок Save data settings as (Сохраните
настройки данных как), введите название таблицы в поле под флажком и
с помощью кнопки, находящейся справа, задайте имя файла, его формат
и положение на диске.

6. Щелкните на кнопке Готово, закрыв последнее окно мастера и открыв па-
нель инструментов Print Merge (Слияние при печати).

7. Активизируйте режим формирования в документе меток полей слияния,
нажав на панели кнопку Insert selected print merge field (крайняя справа).

S. Последовательно выбирая в списке Print merge field (Поле слияния при пе-
чати) панели Print Merge названия требуемых полей слияния, разместите их
метки в нужных местах документа (см. рис. 7.24). Все эти метки будут от-
форматированы стилем по умолчанию для художественного текста.

9. Отключите режим формирования меток полей слияния, отжав кнопку Insert
selected print merge field.

10. Если необходимо, откорректируйте рабочим инструментом Pick (Выбор)
положение, форму и параметры форматирования меток полей слияния,
вставленных в документ.
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11. Откройте диалоговое окно Print (Печать) в режиме слияния информации
при печати, выполнив команду File > Print Merge > Perform Merge (Файл >
Слияние при печати > Выполнить слияние) или щелкнув на кнопке Perform
Print Merge (Выполнить слияние при печати) панели инструментов Print Merge.

12. Настройте в данном окне параметры печати (см. разд. "Печать документа"
данной главы).

13. Нажмите кнопку Print, запустив распечатку документа в режиме слияния
информации.

Печать документа
Все операции по настройке параметров печати документа выполняются с ис-
пользованием трех команд меню File (Файл): Print (Печать), Print Preview
(Предварительный просмотр печати) и Print Setup (Настройка печати). Рассмот-
рим эти команды по порядку.

Команда Print
Команда Print (Печать) меню File предназначена для настройки всех параметров
печати, выдачи принтеру управляющего сигнала на распечатку документа. Од-
ноименное диалоговое окно команды содержит шесть или семь вкладок, на ко-
торых параметры печати сгруппированы по функциональному признаку (допол-
нительная вкладка появляется при использовании принтера типа PostScript).

Рассмотрим (в порядке слева направо) назначение общих кнопок управления
диалогового окна Print, находящихся внизу, вне областей открытых вкладок
(см. рис. 7.25):

П Print Preview (Предварительный просмотр печати) — открывает диалоговое
окно одноименной команды;

П кнопка с двумя треугольными стрелками, направленными вправо или вле-
во, — управляет открытием дополнительной панели с окном просмотра, ко-
торая располагается справа; в этом окне можно последовательно просмотреть
все печатаемые страницы документа;

Примечание

В CorelDRAW 12 предусмотрены два режима просмотра документа, выводимо-
го на печать. Первый из них (основной) реализуется с помощью команды Print
Preview, а второй (вспомогательный)— с использованием указанной дополни-
тельной панели окна Print.

П Print — закрывает одноименное диалоговое окно с выдачей сигнала принтеру
на распечатку документа с текущими параметрами печати;

П Cancel — закрывает данное окно без сохранения текущих параметров и выда-
чи сигнала на печать документа;
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П Apply —- выполняет сохранение всех текущих параметров печати без закрытия
окна печати;

П Help (Помощь) — открывает окно справочной системы CorelDRAW 12 с ин-
формацией об операции печати.

Вкладка General
Вкладка General (Общие) диалогового окна Print (Печать) содержит наиболее
важные параметры печати, настройка которых выполняется каждый раз при
очередной распечатке документа (рис. 7.25).

General I Layout | Separations | Prepress j PostScript j Misc

•"'Destination '̂

Name:

1 Issue

Type;

, Status;

Where:

Comment;

Р LaserJet 5P/5MP PostScript

HP LaserJet 5P/5MP PostScript

Ready

LPT1:

3 Properties,..
„ _ _._. ____„ _ - i

Use PPD

Print to He

Print range -—

t* Current document

i Current page

<: Pages:

Documents

"Copies "-

Number of copies:

Print style: Custom (Current settings not saved) Save As...

Print Preview Print Cancel Apply Help

Рис. 7.25. Вкладка General диалогового окна Print

Рассмотрим представленные элементы настройки:

G раскрывающийся список Name, используемый для выбора драйвера принтера.;

Примечание

Если в списке Name выбрать пункт Device Independent PostScript File (Неза-
висимый от устройства постскриптовский файл), то при нажатии на кнопку Print
будет сформирован файл документа одного из двух возможных векторных
форматов, базирующихся на языке PostScript: PRN или PS.

G кнопка Properties, открывающая диалоговое окно с параметрами настройки
выбранного принтера;
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П флажок Use PPD, при установке которого подключается режим использова-
ние? PPD-файла (PostScript Printer Description) с параметрами печати для
принтера типа PostScript;

П флажок Print to file, при установке которого задается режим формирования
файла печати формата PRN, представляющего собой файл документа, подго-
товленный для последующей печати на принтере PostScript;

G кнопка с черной треугольной меткой (справа от флажка Print to file), откры-
вающая контекстное меню для выбора одного из четырех режимов печати
в файл:

• For Mac — формирование файлов печати для Macintosh;

• Single File — сохранение всего документа в одном файле;

• Pages to Separate Files — сохранение страниц документа в отдельных файлах;

• Plates to Separate Files — сохранение цветоделенных пленок в отдельных
файлах;

П в области Print range (Диапазон печати) находятся:

• переключатель Current document, устанавливающий режим печати всего
активного документа;

• переключатель Current page, задающий режим печати только текущей
страницы документа;

• переключатель Pages, подключающий режим печати тех страниц актив-
ного документа, которые указаны в поле справа;

• переключатель Documents, активизирующий режим печати открытых до-
кументов, отмеченных в списке ниже;

• переключатель Selection, задающий режим печати выделенных объектов,
находящихся на текущей странице;

• раскрывающийся список (внизу) с перечнем страниц, выводимых на пе-
чать в режиме печати всего активного документа, в котором представлены
три варианта выбора: Even & Odd (Все страницы), Odd Pages (Нечетные
страницы) и Even Pages (Четные страницы);

О в области Copies (Копии) расположены:

• поле Number of copies, в котором указывается число копий печатаемого
документа;

• флажок Collate, при установке которого задается режим сортировки стра-
ниц документа по копиям;

О раскрывающийся список Print Style, используемый для выбора стиля печати,
представляющего собой набор предварительно заданных параметров печати,
сохраненных в памяти компьютера под определенным именем;

П кнопка Save As, сохраняющая текущие параметры печати в файле
(с расширением prs) в качестве нового стиля печати.
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Вкладка Layout
Вкладка Layout (Макет) диалогового окна Print включает параметры, определяю-
щие размещение макетируемых страниц документа на странице печатного листа.

Здесь находятся следующие элементы настройки:

О переключатель As in document, задающий режим сохранения первоначальных
пропорций между размерами выводимого изображения и размерами макети-
руемой страницы документа, на которой оно находится;

О переключатель Fit to page, подключающий режим заполнения изображением
всей печатаемой страницы;

П переключатель Reposition images to, устанавливающий режим задания произ-
вольных размеров и координат изображения на странице документа;

О кнопка Settings for Page, позволяющая выбрать страницу документа, для изо-
бражения которой будут заданы геометрические параметры;

П два поля Position, содержащие координаты центра области изображения;

П два поля Size, в которых указываются размеры этой области по горизонтали
и вертикали;

П два поля Scale factor, содержащие коэффициенты масштабирования области
изображения;

Примечание

Ввод информации в поля Position, Size и Scale factor возможен лишь при вы-
бранном переключателе Reposition images to.

О два поля # of tiles, указывающие количество (по горизонтали и вертикали)
мозаичных фрагментов прямоугольной формы, выводимых на печать на от-
дельных листах, на которые разбивается большая страница макета документа;

П кнопка с изображением замка, подключающая режим пропорционального
масштабирования области изображения, выводимого на печать;

П флажок Print tiled pages, при установке которого задается режим разбивки
страницы макета на прямоугольные мозаичные фрагменты, располагаемые
на отдельных печатных листах;

П флажок Tiling marks, при выборе которого будут распечатаны специальные
метки, позволяющие состыковать мозаичные элементы между собой;

П два поля Tile overlap, в которых указывается ширина поля (в абсолютных и
относительных единицах) для стыковки мозаичных фрагментов страницы
документа;

П флажок Bleed limit, при установке которого подключается режим формирова-
ния поля обрезки, определяющего выступ области изображения за линию
обрезки;

G поле справа от данного флажка, в котором указывается ширина поля обрезки;
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П раскрывающийся список Imposition layout, используемый для выбора стиля
макетирования;

П кнопка Edit, выполняющая переход в режим редактирования стиля макети-
рования.

Вкладка Separations
Вкладка Separations (Цветоделение) диалогового окна Print содержит параметры
цветоделения, которые используются при выводе цветоделенных пленок, из ко-
торых изготавливаются формы для цветной растровой печати (рис. 7.26).

General J Layout Separations j Prepress j PostScript | Misc | £& 1 Issue j

Options

Г HexaChrome plates

Г Gcr^tsb* colors to дпкея

Г~ Print empty plates

ч* Use advanced settings

Color '. 1 С

0 И Cyan

0Щ Magenta 2
0 Yellow 3

0BBlack 4

1 In-RlP trapphg •_.=-!:« о*; ..

i"1 Preserve ddCLment overprhts

Always overprint black
1 Г Auto-spreading Г Five j iMdlh

Mj/;:mij-ri: • Te>f:ofaover j

G.5 pt **M ' IviO £i£ яи*и

Advanced... |

irder ; • Frequency ,- | Angle . Overprint

80,0000 15,0000 ^ Щ

30,0000 75,0000 А ^

30,0000 0,0000 &, Щ

30,0000 45,0000 ,& tQ

Print Preview Print Cancel Apply Help

Рис. 7.26. Вкладка Separations диалогового окна Print

На этой вкладке представлены следующие элементы настройки:

О флажок Print separations, при установке которого задается режим печати
с цветоделением;

П флажок Print separations in color, при установке которого активизируется ре-
жим печати цветоделенных пленок на цветном (композитном) принтере;

О флажок Hexachrome plates, при установке которого подключается режим пе-
чати шестью базовыми цветами, позволяющими получить высокое качество
цветопередачи;

П флажок Convert spot colors to process, при установке которого устанавливается
режим преобразования стандартных цветов в базовые цвета модели CMYK;
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П флажок Print empty plates, при установке которого активизируется режим
печати пустых пленок;

П группа элементов в области Trapping, с помощью которых задаются параметры
цветовых ловушек (см. разд. "Печать с наложением и цветовые ловушки" гл. 3)\

П флажок Use advanced settings, при установке которого задается режим регу-
лировки дополнительных параметров цветоделения в списке цветеделенных
пленок, находящемся внизу;

G кнопка Advanced, открывающая диалоговое окно Advanced Separations Settings
с дополнительными параметрами цветоделения, где можно выбрать: стиль
формирования растра (список Screening technology), разрешение (список
Resolution), частоту растра (список Basic screen), форму точек растра (список
Halftone type), а также параметры, задаваемые в списке цветоделенных пленок;

О список цветоделенных пленок, для каждой из которых могут быть заданы
следующие параметры: режим вывода пленки на печать (метка слева); часто-
та растра (поле Frequence), угол наклона растра (поле Angle); режим печати
с наложением объектов, раскрашенных цветом данной пленки (поле Overprint).

J^ Примечание

Дополнительные параметры цветоделения доступны лишь при подключении
драйвера принтера типа PostScript, при этом в диалоговом окне Print появля-
ется новая вкладка с тем же названием.

Вкладка Prepress
Вкладка Prepress (Режимы печати) диалогового окна Print используется для за-
дания режимов печати содержимого документа и дополнительной служебной
информации.

Здесь представлены следующие элементы настройки:

О флажок Invert, задающий режим печати в негативе;

О флажок Mirror, подключающий режим печати в зеркальном отражении, ис-
пользуемом при печати на пленках;

П флажок Print registration marks, активизирующий режим печати меток при-
водки;

d список Style, используемый для выбора образцов меток приводки;

П флажок Print file information, задающий режим печати служебной информа-
ции о файле документа;

О флажок Print page numbers, подключающий режим печати номеров страниц:;

П флажок Position within page, активизирующий режим расположения номеров
страниц внутри области макетируемой страницы документа;

П флажок Crop/fold marks, задающий режим печати меток обрезки/изгиба пе-
чатного листа;
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О флажок Exterior only, при установке которого будут печататься только те
метки обрезки/изгиба, которые находятся снаружи от выводимых страниц
печатного документа;

G флажок Marks to objects, при установке которого метки обрезки/изгиба будут
располагаться по углам прямоугольных областей охвата печатаемых объектов
документа;

О флажок Color calibration bars, подключающий режим печати шкалы калиб-
ровки цветов;

П флажок Densitomener scales, активизирующий режим печати на цветоделен-
ньтх пленках шкал плотностей; •*

П список Densities, в котором указываются уровни серого цвета, используемые
в шкалах плотностей.

Вкладка PostScript
Вкладка PostScript появляется в диалоговом окне Print при выборе драйвера
принтера типа PostScript, который используется при цветоделении.

На вкладке находятся, в частности, следующие элементы настройки:

П раскрывающийся список Compatibility, используемый для выбора версии
языка PostScript;

П флажок Use JPEG Compression, при установке которого задается режим ис-
пользования метода сжатия растровых файлов формата JPEG при печати до-
кумента с растровыми изображениями;

П флажок Maintain OPI links, при установке которого подключается режим ис-
пользования связей с растровыми файлами высокого разрешения, задавае-
мых в формате OPI (открытого интерфейса допечатной подготовки);

G список Screen frequency, в котором производится выбор частоты растра.

Вкладка Misc
На вкладке Misc (Разное) диалогового окна Print находятся вспомогательные
параметры печати. Наиболее важные из этих параметров задаются с помощью
следующих элементов настройки:

О флажок Apply ICC profile, при установке которого задается режим использо-
вания цветового профиля по умолчанию для принтера выбранного типа
(композитного или для цветоделения);

П флажок Print job information sheet, при установке которого будет выводиться
протокол печати, представляющий собой текстовый документ с информаци-
ей о параметрах печати исходного графического документа;

П кнопка Info Settings, открывающая дополнительное окно для формирования
перечня параметров печати активного документа, которые будут включены
в протокол печати;
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П флажки Print vectors, Print bitmaps и Print text, при установке которых произ-
водится вывод на печать объектов соответствующих типов: векторных, рас-
тровых и текстовых;

О элементы управления в области Bitmap downsampling, определяющие режимы
снижения разрешения при печати растровых изображений (цветных, оттен-
ков серого и черно-белых), а также значения используемых разрешений.

Вкладка Preflight
Вкладка Preflight (Предупреждения) диалогового окна Print предназначена для
выдачи предупреждающих сообщений о нарушениях, которые могут возникать
при распечатке документа. С помощью кнопки Settings вы можете открыть диа-
логовое окно Preflight Settings и отметить в списке предупреждающих сообще-
ний Printing, относящемся к операции печати, те сообщения, которые будут вы-
водиться при возникновении соответствующих нарушений.

^ Примечание

Всего в окне Preflight Settings находится пять списков предупреждающих со-
общений. Кроме указанного выше списка Printing, есть еще четыре списка, от-
носящихся к формированию электронных документов в форматах HTML и PDF,
а также к экспорту информации в форматах Flash и SVG.

На ярлычке вкладки Preflight вместо ее названия указывается (через некоторое
время после открытия окна Print) число выведенных предупреждающих сооб-
щений, рядом с которым стоит слово Issue(s), При отсутствии таких сообщений
будет выведена надпись No Issues,

Команда Print Preview
Команда Print Preview (Предварительный просмотр печати) меню File предна-
значена для просмотра печатаемых страниц документа, настройки параметров
печати, а также запуска распечатки документа. Диалоговое окно команды Print
Preview (рис. 7,27) открыто на весь экран. Оно содержит все необходимые инст-
рументы, позволяющие выполнять практически любые операции настройки па-
раметров печати. В рабочей области данного окна, расположенной в центре,
отображаются страницы документа, выводимые на печать.

Рассмотрим устройство данного окна. Внешне оно напоминает окно самой
программы CorelDRAW 12. В самом деле, наверху находится строка основного
меню, под которой расположены две панели инструментов: стандартная и па-
нель свойств. На вертикальной панели слева расположены четыре рабочих ин-
струмента. Состав инструментов на стандартной панели фиксирован, а на пане-
ли свойств меняется в зависимости от используемого рабочего инструмента.

Поясним назначение элементов управления, находящихся на стандартной пане-
ли (их номера, приведенные на рисунке, указаны в квадратных скобках):

П [1] — раскрывающийся список Print Style, предназначенный для выбора сти-
ля печати;
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Рис. 7.27. Диалоговое окно команды Print Preview
при работе с инструментом Marks Placement

Я [2] — кнопка Save Print Style As, используемая для формирования нового
стиля печати;

Г) [3] — кнопка Delete Print Style, удаляющая выбранный стиль печати;

О [4] — кнопка Print Options, открывающая одноименное диалоговое окно,
на вкладках которого представлены те же параметры печати, что и в окне
команды Print;

П [5] — кнопка Print, выдающая сигнал принтеру на распечатку документа;

О [6] — список Zoom, используемый для выбора стандартного масштаба ото-
бражения печатаемых страниц документа в рабочем окне;

П [7] — кнопка Full Screen, подключающая режим полноэкранного просмотра
документа;

О [8] — кнопка Enable Color Separations, задающая режим цветоделения;

П [9] — кнопка Invert, активизирующая режим печати в негативе;

G [10] — кнопка Mirror, подключающая режим печати в зеркальном отражении;

П [11] — кнопка Close Print Preview, выполняющая закрытие диалогового окна
команды.
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К числу рабочих инструментов команды Print Preview относятся следующие
(в порядке сверху вниз): Pick, Imposition Layout, Marks Placement и Zoom.

Инструмент Pick (Выбор) используется для регулировки положения

изображения страницы макета документа на странице печатного листа,
а также для изменения размеров этого изображения. Эти операции могут
быть выполнены как с помощью инструментов панели свойств, так и непо-
средственно в рабочем окне документа в интерактивном режиме.

Инструмент Imposition Layout (Стиль макетирования) предназначен для

выбора на панели свойств стиля макетирования документа (он определяет
порядок расположения страниц макета документа на страницах печатного
листа), а также для настройки параметров этого стиля. Данный инструмент
позволяет изменять в интерактивном режиме номера страниц макета, а также
разворачивать любую их них по вертикали.

Инструмент Marks Placement (Размещение меток) используется для за-

дания параметров вывода на печать различной служебной информации (но-
меров страниц, меток и калибровочных шкал). Кроме того, он позволяет
регулировать в интерактивном режиме положение линии обрезки (прямо-
угольной пунктирной рамки красного цвета) на странице печатного листа,
а также положение и размеры изображений страниц макета (см. рис. 7.27).

Примечание

Регулировка линии обрезки мышью возможна лишь при отключенном режиме
печати в зеркальном отражении {кнопка [10] на стандартной панели должна
быть отжата).

Инструмент Zoom (Масштаб) позволяет регулировать масштаб отобра-

жения печатаемого документа в рабочей области диалогового окна.

Команда Print Setup
Команда Print Setup (Настройка печати) меню File используется для выбора
в одноименном диапоговом окне драйвера принтера, а также настройки пара-
метров принтера в дополнительном окне, открываемом кнопкой Properties.

Примечание

Указанные операции могут быть также выполнены на вкладке General (Общие)
диалогового окна Print (Печать) (список Name и кнопка Properties).
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Создание электронных документов
В программе CorelDRAW 12 можно созлавать не только документы, предназна-
ченные для печати, но их электронные версии, допускающие использование
двух файловых форматов векторного типа: HTML (с расширением htm) и PDF.
Первый формат используется при публикации документа в Интернете, а вто-
рой — при любых видах электронной публикации.

Существует ряд общих ограничений, которые следует принимать во внимание
при формировании файлов электронного документа. Вот они:

П нельзя использовать русскоязычные имена для этих файлов;

П исходный документ может содержать связанные растровые файлы только тех
форматов, которые используются в Web (GIF, JPEG и PNG), в противном
случае изображения в электронном документе будут теряться.

Обработка исходного документа
Перед формированием электронного документа необходимо соответствующим
образом доработать исходный документ, осуществив ввод в его объекты гипер-
ссылок (сетевых и локальных адресов перехода) и закладок (меток, позволяю-
щих переходить к этим объектам из других мест документа).

Сетевой адрес перехода задается в формате URL (например, адрес Web-сайта
компании Corel имеет следующий вид: http://www.corel.com). Что касается ло-
кального адреса, го он может представлять собой одно из двух:

П полное название подключаемого файла электронного документа или испол-
няемого файла (например: C:\Video\Basket.avi);

П адрес объекта перехода текущего документа, формируемый программой ав-
томатически и состоящий из двух частей: стандартного названия страницы,
на которой этот объект находится, и закладки, содержащейся в нем (напри-
мер: _PAGE2#2).

Если документ предполагается сохранять в формате HTML, тогда вам может
понадобиться его дополнительная обработка, включающая:

П вставку в документ так называемых объектов Интернета, выполняющих
в электронном документе различные управляющие и информационные
функции (к числу таких объектов относятся исполняемые файлы, текстовые
поля и рамки, списки, кнопки, флажки и переключатели);

П формирование в документе интерактивных состояний (см. разд. "Интерак-
тивность" гл. 3)\

П обработку текстовых объектов, содержащих текст обычного типа, командой
Text > Make Text HTML Compatible (Текст > Сделать текст совместимым
с HTML), что позволит выделять этот текст в электронном документе (с це-
лью привлечения к нему внимания или копирования через буфер обмена
Windows).
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Примечание

В результате обработки текстовых объектов командой Text > Make Text HTML
Compatible, эти объекты будут преобразованы в объекты Интернета, распола-
гаемые в отдельном (верхнем) слое исходного документа.

Ввод гиперссылок и закладок
Существуют два способа ввода в объекты документа гиперссылок и закладок,
а также другой управляющей и текстовой информации. Первый из них базиру-
ется на использовании панели инструментов Internet (Интернет), а второй —
докера Object Properties (Свойства объекта). Рассмотрим эти способы по порядку.

На рис. 7.28 представлен фрагмент окна программы в режиме ввода информа-
ции в выбранный объект документа с помощью панели инструментов Internet
и докера Object Properties.

Привет всем

Программа
CorelDRAW 12;

URL

Background:

Рис. 7.28. Панель инструментов Internet
и докер Object Properties в процессе работы
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Порядок ввода информации первым способом
1. Откройте панель инструментов Internet (Интернет). Для этого установите

указатель в свободном месте любой панели или блока инструментов, открой-
те правой кнопкой мыши контекстное меню и выберите в нем команду
Internet (Интернет).

2. Выделите рабочим инструментом Pick (Выбор) объект документа, в который
необходимо вставить управляющую и текстовую информацию.

3. Для вставки в объект закладки откройте список Behavior (Поведение), выбе-
рите в нем пункт Bookmark (Закладка) и введите закладку в поле Internet
Bookmark, находящееся справа.

4. Для вставки гиперссылки выберите в списке Behavior пункт URL, затем вы-
полните один из двух вариантов:

• выберите в списке Internet Address (Адрес Интернета) одну из гиперссы-
лок, которые вводились ранее в этот или другие документы, обрабаты-
вавшиеся в программе;

• введите с клавиатуры новую гиперссылку в редактируемое поле данного
списка.

5. Выберите в списке Target Frame (Целевой раздел) режим отображения в окне
Web-обозревателя новой страницы электронного документа, связанной с его
текущей страницей через гиперссылку.

6. Щелчком на кнопке Alt Comments (Контекстные комментарии) откройте до-
полнительную панель и введите в ее поле контекстное сообщение, которое
будет отображаться в электронном документе рядом с указателем.

7. Щелчком на кнопке Hotspot (Горячая зона) откройте дополнительную па-
нель и задайте на ней следующие параметры:

• форму области срабатывания, которая может совпадать с формой объекта
(кнопка Object shape) или быть прямоугольной (кнопка Bounding box
of object);

• параметры оформления области срабатывания (два флажка и два раскры-
вающихся списка с образцами цветов).

8. Повторите шаги 2—7 инструкции для всех объектов документа, в которые
необходимо ввести управляющую и текстовую информацию.

9- Закройте панель Internet (Интернет), щелкнув на кнопке с перекрестием,
находящейся в правом верхнем углу.

Порядок ввода информации вторым способом
1. Откройте докер Object Properties (Свойства объекта), выполнив для этого

команду Edit К Properties (Правка > Свойства) основного меню программы или
команду Properties (Свойства) контекстного меню рабочего окна документа.
Перейдите на вкладку Internet (Интернет) докера, щелкнув на ее ярлычке.
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2. Выделите рабочим инструментом Pick объект документа, в который необхо-
димо вставить управляющую и текстовую информацию.

3. Для вставки в объект закладки откройте список Behavior (Поведение), выбе-
рите в нем пункт Bookmark (Закладка) и введите закладку в поле, располо-
женное под списком.

4. Для вставки гиперссылки выберите в списке Behavior пункт URL, а затем
в списке URL выберите гиперссылку, которая вводилась ранее (при обра-
ботке этого или других документов), или введите ее с клавиатуры в редакти-
руемое поле данного списка.

5. Выберите в списке Target Frame режим отображения в окне Web-
обозревателя новой страницы электронного документа, связанной с его те-
кущей страницей через гиперссылку.

6. Введите в поле Alt Comments контекстное сообщение, отображаемое в дан-
ном документе рядом с указателем.

7. Откройте список, расположенный под полем Alt Comments, и задайте в нем
форму области срабатывания, выбрав один из двух пунктов:

• Object's Shape — в форме объекта;

• Object's Bounding Box — в форме прямоугольника, описанного вокруг
объекта.

8. Используя два флажка и два раскрывающихся списка с образцами цветов,
находящихся внизу докера, задайте параметры оформления области сраба-
тывания.

9. Если режим автоматического обновления параметров объекта не был задан
(кнопка с изображением замка внизу докера отжата), то щелкните на кнопке
Apply (Применить), введя управляющую информацию в выбранный объект.

10. Повторите шаги 2—9 инструкции для всех объектов документа, в которые
необходимо ввести управляющую и текстовую информацию.

11. Закройте докер Object Properties, щелкнув на кнопке с перекрестием, нахо-
дящемся в правом верхнем углу.

Докер Internet Bookmark Manager
С помощью докера Internet Bookmark Manager (Диспетчер закладок Интернета,),
открываемого одноименной командой подменю Dockers меню Window (Окно),
вы также можете выполнять некоторые операции с закладками. В частности,
можно изменять связи между объектами документа или создавать новые.

В рабочем окне докера содержится список закладок (поле Bookmark) с указани-
ем страниц, на которых находятся соответствующие объекты (поле Page). Внизу
докера расположены три кнопки управления, имеющие следующее назначение
(в порядке слева направо):

О Link — устанавливает связь между объектом, выделенным в окне документа,
и объектом с закладкой, отмеченным в окне докера;
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П Select — открывает ту странипу документа, на которой находится объект
с закладкой, выбранный в окне докера;

О Remove — удаляет закладку, выделенную в докере.

Вставка объектов Интернета
1. Откройте докер Object Properties (Свойства объекта), выполнив для этого ко-

манду Edit > Properties (Правка » Свойства) основного меню программы или
команду Properties (Свойства) контекстного меню рабочего окна документа.

2. Откройте документ на требуемой странице и вставьте в нужном его месте
объект Интернета, используя для этого ту команду подменю Insert Internet
Object (Вставить объект Интернета) меню Edit (Правка), в названии которой
указывается требуемый тип создаваемого объекта. В это подменю входят сле-
дующие одиннадцать команд: Java applet (Java-приложение), Embedded file
(Внедренный файл), Simple Button (Простая кнопка), Submit Button (Кнопка
инициации), Reset Button (Кнопка сброса), Radio Button (Переключатель),
Check Box (Флажок), Text Edit Field (Текстовое поле с редактированием),
Text Edit Box (Текстовая рамка с редактированием), Popup Menu (Всплы-
вающее меню) и Options List (Список параметров).

Примечание

При вставке а документ объектов Интернета все они будут располагаться
в специально отведенном для них верхнем слое документа, положение которо-
го изменять нельзя.

3.. Выделите объект Интернета рабочим инструментом Pick (Выбор) и перейди-
те на последнюю вкладку докера Object Properties, где будет выполняться
ввод в объект управляющей и текстовой информации.

4. Выполните обработку объекта, введя в него (через выбранную вкладку доке-
ра) необходимую информацию.

Примечание

Особенность ввода информации в объект Интернета Embedded file состоит
в следующем. После вставки (с помощью кнопки) в редактируемое поле докера
Object Properties полного адреса исполняемого файла, внедряемого в доку-
мент, следует установить курсор в данное поле, нажать клавишу <Enter>. Если
этого не сделать, то введенный в поле адрес пропадет при отмене выделения
данного объекта Интернета.

5. Если режим автоматического обновления параметров объекта не был задан
(кнопка с изображением замка внизу докера отжата), то щелкните на кнопке
Apply (Применить).

6. Повторите шаги 2—5 инструкции для всех объектов Интернета, встаатяемых
в документ.

7. Закройте докер Object Properties.
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На рис. 7.29 показан вид документа CorelDRAW 12, содержащего различные
объекты Интернета. Справа изображен докер Object Properties в режиме на-
стройки параметров выбранного объекта, представляющего собой внедренный
файл (в данном случае — видеоклип). Обратите внимание на два квадрата
с одинаковым рисунком, расположенных вверху справа (тот, который выделен,
и яштяется файлом видеоклипа). Эти квадраты представляют в документе под-
ключаемые файлы. Их размеры, регулируемые с помощью мыши, определяют
области отображения в электронном документе видеоинформации данных фай-
лов или области расположения контроллеров для проигрывателей аудиоклипов
(см. рис. 7.32).

Объекты интернета
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Рис. 7.29. Вид документа с объектами Интернета

Формирование изображения для Web
С помощью команды Web Image Optimizer (Оптимизатор изображения для Web)
подменю Publish To The Web (Публикация на Web) меню File (Файл) вы можете
решать две задачи:

G выполнять настройку файловых параметров изображения открытой страницы
документа, сохраняемого в одном из растровых форматов для Web (GIF,
JPEG, PNG-8 или PNG-24);

П формировать стили сохранения изображений с целью их последующего ис-
пользования при создании электронных документов в формате HTML.
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Примечание

Стиль сохранения изображения представляет собой набор файловых парамет-
ров растрового изображения, предназначенного для Web, сохраненный под оп-
ределенным именем в файле с целью ускорения обработки многих изображений.

Команда Web Image Optimizer обладает широкими возможностями по настройке
файловых параметров результирующего изображения, исходя из требуемого его
качества и заданных ограничений на размер файла. Она позволяет выполнять
цветовую обработку изображений, имеющих табличный цветовой формат, что
характерно для двух используемых файловых форматов: GIF и PNG-8.

^ Примечание

Аналогичная функция обработки растровых изображений для Web реализована
в таких популярных графических программах, как Adobe Illustrator и Adobe Photoshop.

На рис. 7.30 представлено диалоговое окно Web Image Optimizer одноименной
команды в процессе обработки изображения страницы документа, область кото-
рой почти полностью заполнена импортированным растровым изображением.

b Image Optimizer

ш а.

ЦВЮО.ОО'Н! IQ454PX

37.29 KB (^Adaptive

f 1.71 % • 16

Preview Reset

Advanced,.

Рис. 7.30, Диалоговое окно Web Image Optimizer
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Рассмотрим устройство данного окна. На верхней его панели находятся сле-
дующие элементы управления (в порядке слева направо):

G список стандартных скоростей передачи модема (в Кбит/сек), предназначен-
ный выбора той скорости, для которой будет рассчитываться время загрузки
по сети файла изображения;

П список масштабов представления в данном окне образцов изображений до-
кумента;

П четыре кнопки управления, задающие количество и расположение разделов
в окне, в каждом из которых будет находиться один обрабатываемый образец
изображения (схема расположения разделов представлена на каждой кнопке).

В центре окна располагаются его разделы (один, два или четыре), каждый из
которых состоит из двух частей:

П верхняя часть раздела представляет собой рабочую область, ь которой нахо-
дится текущий образец изображения;

Примечание

Изображение можно масштабировать и перемещать лишь в том разделе окна,
в котором указатель принимает вид кисти руки. При этом изображения, нахо-
дящиеся в других разделах, будут иметь такие же положение и масштаб, что и
регулируемое изображение.

D в нижней части раздела находится управляющая панель раздела, выполняю-
щая три функции: 1) настройку файловых параметров текущего образца изо-
бражения; 2) активизацию изображения (щелчком мыши в области панели)
с целью его сохранения в файле; 3) отображение параметров изображения,
характеризующих его файловые размеры и качество; на данной панели рас-
положены следующие элементы настройки (в порядке слева направо):

• список файловых форматов для текущего образца изображения, вклю-
чающий пять пунктов: Original исходное изображение документа
(не обрабатывается); Gif - - обрабатываемое изображение в файловом
формате GIF; Jpeg -- в формате JPEG; Png8 - - в формате PNG-S;
Png24 — в формате PNG-24;

• список стилей сохранения изображений (в названии каждого стиля ука-
зывается используемый файловый формат и другая важная информация,
характеризующая его);

• кнопка, действие которой автору выяснить не удалось;

• кнопка создания нового стиля (со знаком "+");

• кнопка удаления текущего стиля (со знаком "—");

• кнопка Advanced (она находится внизу справа), открывающая дополни-
тельное диалоговое окно, предназначенное для настройки файловых па-
раметров текущего изображения.

18 Зак. 250
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Внизу окна находится пять кнопок управления, выполняющих общие функции;
Preview (Просмотр), Reset (Сброс), OK, Cancel (Отменить) и Help (Помощь).
В частности, кнопка Preview задает режим автоматического обновления изобра-
жений в окне при изменении их параметров, кнопка Reset выводит во всех раз-
делах окна образцы исходного изображения документа, а назначение остальных
кнопок понятно из их названий.

Порядок работы
1. Откройте документ на той странице, изображение которой будет обрабаты-

ваться командой с целью его использования в Web либо для создания на его
основе стиля сохранения изображения.

2. Выполните команду File > Publish To The Web * Web Image Optimizer
(Файл > Публикация на Web > Оптимизатор изображения для Web), открыв
одноименное диалоговое окно (см. рис. 7.30).

3. Задайте требуемые количество и порядок расположения изображений в окне,
которых должно быть не менее двух (три правые кнопки в правом верхнем
углу окна).

4. Подключите режим автоматического обновления изображений в окне, нажав
кнопку Preview в левом нижнем углу.

5. В одном из разделов окна выведите исходное изображение (пункт Original
в левом списке управляющей панели раздела), чтобы визуально сравнивать
с ним обрабатываемые образцы изображений.

6. В остальных разделах окна (в одном или в трех) настройте файловые пара-'
метры результирующих образцов изображений, задав для каждого из них
требуемый стиль сохранения изображения и, при необходимости, выполнив
настройку файловых параметров изображения (кнопка Advanced). Контроли-
руйте свои действия по виду изображений на экране, а также по той инфор-
мации, которая отображается на управляющих панелях.

7. Если вы собираетесь в дальнейшем формировать изображения для Web с та-
кими же файловыми параметрами, что и текущие, то сформируйте стили
сохранения для тех образцов изображений, которые вас устраивают. Если
сохранение одного из изображений в файле не предусматривается, то за-
кройте окно, щелкнув на кнопке Cancel (Отменить), в противном случае пе-
рейдите к следующему пункту инструкции.

8. Выберите в окне тот обработанный образец изображения, который больше
всего вас устраивает. Для этого щелкните в области управляющей панели,
относящейся к данному изображению, выделив данную область красной
рамкой.

9. Щелкните на кнопке ОК и в открывшемся диалоговом окне Save Web Image
to Disk (Сохранить на диске изображение для Web) введите название файла
изображения (поле Имя файла), выберите папку для него и сделайте щелчок
на кнопке подтверждения Сохранить.
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Создание документов в формате HTML
В CorelDRAW 12 формирование электронного документа формата HTML может
быть выполнено с помощью двух команд подменю Publish To The Web (Публи-
кация на Web) меню File (Файл): HTML и Flush embedded in HTML (Flash, вне-
дренный в HTML). Рассмотрим их.

Команда HTML
Перечислим особенности создания электронного документа командой HTML
подменю Publish To The Web меню File:

П каждая страница исходного документа представляется в окне Web-обозревателя
отдельной Web-страницей, состоящей из основного файла формата HTML
(с расширением htm) и набора файлов с растровыми изображениями;

П между страницами электронного документа (Web-сайта) в исходном доку-
менте могут устанавливаться связи через объекты, которые находятся на этих
страницах;

П все графические объекты исходного документа, а также образцы художест-
венного текста сохраняются в файлах трех растровых форматов для Web, вы-
бираемых пользователем: GIF, JPEG и PNG (PNG-8 и PNG-24);

О гиперссылки и интерактивные состояния, созданные в исходном документе,
переносятся в электронный документ, а файлы аудиоклипов, связанные
с этими состояниями, теряются;

П для объекта с гиперссылкой контекстное сообщение, задаваемое в поле
(кнопкой) Alt Comments докера Alt Comments (панели инструментов Internet),
будет отображаться рядом с указателем только при условии, что этот объект
не является растровым изображением;

П блоки обычного текста могут быть представлены в электроном документе в каче-
стве текста, доступного для выделения и копирования, либо в виде изображений;
необходимым условием сохранения текстовой информации в HTML-файле яаш-
ется обработка исходного текстового объекта командой Text > Make Text HTML
Compatible (Текст > Сделать текст совместимым с HTML);

П русский текст обычного типа, обработанный командой Make Text HTML
Compatible, а также содержащийся в объектах Интернета, не будет искажать-
ся в окне Web-обозревателя Internet Explorer 6.0 при условии выбора режима
кодировки Юникода (наличие метки в пункте Юникод (UTF-8) подменю
Кодировка меню Вид).

На рис. 7.31 представлено диалоговое окно Publish To The Web (Публикация на
Web), открываемое командой HTML, состоящее из шести вкладок, с открытой
вкладкой General (Общие).

На рис. 7.32 показан вид Web-страницы в окне обозревателя Internet
Explorer 6.0, которая была сформирована командой HTML из исходного доку-
мента с объектами Интернета, представленного на рис. 7.29.
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Publish To The Web

General Details | Images | Advanced | Summary ^ No Issues

HTML Layout Method;

" Destination ' ~

[c:\CORELJ2_WORX\CORELDRA,., _*

\ ' Use HTML name for image sub-Folder

Image Folder: j images^

: Replace existing Fles

Display In Browser When Etone

FTP Upload

Export Range •

'* Ail

1 Current Page

Presets: 1 default

Pages s

Selection

Browser Preview... •. Cancel Help

Рис. 7.31. Вкладка General диалогового окна Publish To The Web

lnl_otii_import Митькой Internet Explorer - (Автономии гмбон)

Ч вин Правив Ви» избраггое Сервис Сг>с

Объекты интернета

Button

Reset

Текстовая строка

!"1эвэматр

Рис. 7,32. Вид электронного документа с объектами Интернета
в окне Internet Explorer 6.0
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Порядок создания документа

1. Выполните команду File > Publish To The Web > HTML (Файл > Публикация
на Web > HTML), открыв диалоговое окно Publish To The Web на вкладке
General (см. рис. 7.31).

2. Настройте параметры команды, сгруппированные по функциональному при-
знаку на первых четырех вкладках окна (последние две вкладки являются
информационными). К числу наиболее важных параметров относятся сле-
дующие:

• метод макетирования HTML-файла (список HTML Layout Method на
вкладке General, в котором рекомендуется выбрать пункт HTML Table
(most compatible));

• имя и адрес папки, в которой будут находиться HTML-файлы Web-
страниц документа, а также имя вложенной в нее папки с растровыми
изображениями (область Destination вкладки General);

• диапазон сохраняемых страниц документа, а также режим сохранения вы-
деленных объектов (область Export Range вкладки General);

• названия Web-страниц и их файлов (вкладка Details);

• названия растровых изображений электронного документа, а также ис-
пользуемые стили их сохранения (вкладка Images).

3. Если перед формированием файлов электронного документа вы захотите
просмотреть его в окне Web-обозревателя, шелкните на кнопке Browser
Preview (Просмотр в обозревателе) внизу окна Publish To The Web.

4. Щелкните на кнопке подтверждения ОК.

Примечание

Внизу диалогового окна Publish To The Web, открываемого командой HTML, нахо-
дятся список Presets (Предустановки) и две кнопки управления (справа от него), ко-
торые предназначены для работы со стилями сохранения документа в формате
HTML. Данный список содержит всего один стиль Default (По умолчанию).

Команда Flash embedded in HTML
Существуют некоторые особенности формирования электронных документов
HTML-формата командой Flash embedded in HTML (Flash, внедренный в HTML) под-
меню Publish To The Web (Публикация на Web) меню File (Файл). Рассмотрим их:

П создаваемый электронный документ состоит всего из одной Web-страницы,
являющейся копией текущей страницы исходного документа, при этом свя-
зи, установленные между страницами исходного документа, теряются;

П все содержимое текущей страницы исходного документа сохраняется в одном
файле векторного формата Flash (с расширением swf)-, в котором текстовая
информация будет представлена в Web-странице в виде изображения (ее нельзя
выделять);
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О гиперссылки, а также интерактивные состояния и связанные с ними файлы
аудиоклипов, заданные в исходном документе, переносятся в электронный
документ;

П объекты Интернета, содержащиеся в исходном документе, не будут работать
в электронном документе.

Примечание

Проверка показала, что в CorelDRAW 12 нельзя подключать файлы аудиокли-
пов к состояниям Down объектов с интерактивными состояниями (такой недос-
таток отсутствовал в предыдущих версиях данной программы).

На рис. 7.33 представлено диалоговое окно Flash Export (Экспорт в формате
Flash) команды Flash embedded in HTML, состоящее из трех вкладок, с открытой
вкладкой General (Общие).

1 Flash Export JEF[

General | HTML j - J^J 2 Issues

Bitmap setting

JPG Compression;

Resolution (dpi);

Smoothing;

- Bounding Box Size —

'• Page

<> Objects

X Use sound behaviors

0

0

——

r

\

~ {"Optimization

j l Convert dashed outlnes

i \* Rounded caps and corners

j Г~ Use default fountain steps

1 File Protection from import

R Terfastext '

Г Display in browser when done"

J ^

Compression; • . ,.. .̂j

presets;

Preview,.,

T I " * " - " !

OK Cancel Help __

Рис. 7.33. Вкладка General диалогового окна Flash Export

Порядок создания документа

1. Выполните команду File > Publish To The Web > Flash embedded in HTML
(Файл > Публикация на Web > Flash, внедренный в HTML), открыв диалого-
вое окно Export (Экспорт).
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2. Выберите папку, в которую будут помещены два файла формируемого одно-
страничного электронного документа (с расширениями htm и swf), используя
для этого список Папка (вверху) и кнопку возврата на предыдущий уровень
(справа от списка).

3. Укажите название файла с изображениями электронного документа, имею-
щего векторный формат Flash. Это можно сделать одним из трех способов:

• выделением исходного названия в рабочей области диалогового окна
с последующей коррекцией в редактируемом поле списка File name (На-
звание файла);

• вводом с клавиатуры наименования файла в поле списка File name;

• выбором в списке File name полного названия файла, сформированного
ранее.

4. Щелчком на кнопке Export закройте одноименное диалоговое окно и от-
кройте на вкладке General окно Flash Export с параметрами сохранения до-
кумента в форматах HTML и Flash (см. рис. 7.33).

5. Откройте список Presets (Предустановки) внизу вкладки и выберите в нем
стиль сохранения документа (в его названии указывается качество изображе-
ния и другие его основные параметры). Если этот стиль вас не устраивает
полностью, выполните настройку параметров команды, сгруппированных по
функциональному признаку на двух вкладках окна (третья вкладка использу-
ется для выдачи предупреждающих сообщений о проблемах, которые могут
возникнуть при формировании файлов электронного документа).

Примечание

Для воспроизведения аудиоклипов, подключенных к интерактивным состояни-
ям объектов документа, следует установить флажок Use sound behavior на
вкладке General окна Flash Export.

6. Если вы изменяли параметры текущего стиля, при этом выбранные парамет-
ры предполагается использовать в дальнейшем при работе с другими доку-
ментами, то сохраните их в качестве нового стиля (кнопка со знаком " ",
находящаяся справа от списка Presets на вкладке General).

7. Щелкните на кнопке подтверждения ОК.

Создание документа в формате PDF
Формирование электронной версии документа CorelDRAW 12 в векторном фай-
ловом формате PDF, основанном на языке PostScript, выполняется с помощью
команды Publish To PDF (Публикация в формате PDF) меню File (Файл).

Существуют следующие особенности публикации документа в формате PDF:

П интерактивные состояния и связанные с ними файлы аудиоклипов, заданные
в исходном документе, теряются в электронном документе;
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О объекты Интернета, содержащиеся в исходном документе, не будут работать
в электронном документе;

П контекстное сообщение, задаваемое в поле или кнопкой Alt Comments
(Альтернативные комментарии) будет отображаться в окне примечания,
свернутом в значок желтого цвета, расположенный рядом с соответствующим
объектом.

Примечание

Как известно, в состав популярного пакета программ Adobe Acrobat входят сле-
дующие инструментальные средства: Acrobat Reader— программа чтения элек-
тронных документов формата PDF; Acrobat PDFWriter и Acrobat Distiller— про-
граммы создания электронного документа данного формата из исходного,
созданного в некотором приложении; Acrobat Exchange— программа обработки
электронного документа PDF-формата. При формировании такого документа
в CorelDRAW 12 потребность в использовании последних трех программ отпадает.

На рис. 7.34 представлено диалоговое окно Publish To PDF, состоящее из шести
вкладок, с открытой вкладкой General (Обшие). Это окно открывается кнопкой
Settings диалогового окна команды Publish To PDF.

Publish To PDF

General j Objects j Document j Prepress Advanced j J3 * Issue |

File name: C:\Corel_12_Work\CorelDRAW),Internet Import.pdf

Export range - •

* Current document

•: Documents

•:' Selection

Current Page

Pages; | I—

Compatibly:

Cancel Help

Рис. 7.34. Вкладка General диалогового окна Publish To PDF

На рис. 7.35 показан вид первой страницы двухстраничного электронного доку-
мента формата PDF в окне программы Acrobat Reader 6.0 (исходный документ
изображен на рис. 7.28). Указатель находится на объекте с гиперссылкой, по-
этому он имеет вид кисти руки с вытянутым указательным пальцем.
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ШМоЬе Header . llirttn.Mfmport.pni)

Программа
CorelDRAW 12

Рис. 7.35. Вид документа в окне программы Acrobat Reader 6.0

Порядок создания документа
1. Выполните команду File t Publish To PDF (Файл > Публикация в формате

PDF), открыв диалоговое окно Save As PDF (Сохранить как PDF).

2. Выберите папку, в которую будет помещен файл сохраняемого документа,
используя список Папка (внизу) и кнопку возврата на предыдущий уровень
вложения (справа от списка).

3. Задайте название сохраняемого документа одним из двух способов:

• выделением исходного названия в рабочей области диалогового окна
с последующей коррекцией в поле Имя файла;

• вводом в данное поле с клавиатуры наименования файла сохраняемого
документа.

4. Щелкните на кнопке Settings (Настройки), открыв на вкладке General (Об-
щие) диалоговое окно Publish To PDF (Публикация в формате PDF) с пара-
метрами сохранения документа в указанном формате (см. рис. 7.34).



554 Глава 7

5. Откройте список PDF style, находящийся внизу, и выберите в нем стиль со-
хранения документа в формате PDF. Если стиль вас не устраивает полностью,
то настройте параметры команды, сгруппированные по функциональному
признаку на пяти вкладках окна (шестая вкладка используется для выдачи
предупреждающих сообщений о тех проблемах, которые могут возникнуть
при сохранении документа в данном формате).

6. Если выбранные параметры предполагается использовать в дальнейшем при
работе с другими документами, то сохраните их в качестве нового стиля со-
хранения документа в формате PDF (кнопка со знаком "+", находящаяся
справа от списка PDF style на вкладке General).

7. Закройте окно Publish To PDF щелчком на кнопке ОК.

8. Щелкните в окне Save As PDF на кнопке Сохранить.
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Настройка параметров
CorelDRAW^

Программа CorelDRAW 12 обладает широкими возможностями настройки ее
параметров. Она позволяет не только задавать установочные параметры, опреде-
ляющие режимы работы программы, но и менять ее пользовательский интер-
фейс. Это означает, что вы можете создавать свои собственные наборы команд
меню (основного и контекстных), инструментов и быстрых клавиш, сохраняя их
под определенными именами для последующего использования.

В диалоговом окне Options (Параметры) выполняются все настройки программы.
В левой части этого окна находится вложенный список установочных параметров
программы, систематизированных по функциональному признаку (см. рис. 8.1).
Далее мы будем называть такую иерархическую структуру параметров списком ка-
тегорий настроек, а уровень их вложения — уровнем категории.

У каждой группы параметров, относящейся к той или иной категории, есть оп-
ределенное название, которое зависит от их назначения. Оно отображается
вверху диалогового окна при выборе данного названия в списке категорий. При
этом в самом окне отображаются параметры, которые составляют его открытую
вкладку (аналогично вкладке диалогового окна, открываемой щелчком на ее
ярлычке или на соответствующей кнопке).

Чтобы установить взаимно однозначное соответствие между открытой вкладкой
окна Options и ее представлением в списке категорий настроек, мы будем далее
применять не ее фактическое название, указанное в окне, а перечень наимено-
ваний категорий, к которым она относится. Благодаря этому открытие нужной
вкладки существенно упростится, а также устранится та неоднозначность, кото-
рая присутствует в связи с одинаковыми названиями некоторых из них.

На рис. 8.1 представлен вид диалогового окна Options (Параметры), открытого
на вкладке Workspace > General (Рабочая область к Общие).

Данное окно можно открыть с помощью ряда команд основного и контекстных
меню программы. Ниже перечислены эти команды с указанием тех вкладок ок-
на, которые будут при этом открыты.
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Рис. 8.1. Вкладка Workspace > General диалогового окна Options

К группе команд основного меню, открывающих окно Options, относятся сле-
дующие:

О View * Grid and Ruler Setup (Вид > Настройка сетки и линейки), открывающая
вкладку Document > Grid (Документ > Сетка);

П View > Guidelines Setup (Вид > Настройка направляющих), открывающая
вкладку Document ^Guidelines (Документ > Направляющие);

О View t Snap to Objects Setup (Вид > Настройка привязки к объектам), откры-
вающая вкладку Workspace > Snap lo Objects (Рабочая область > Привязать
к объектам);

О View ^ Dynamic Guides Setup (Вид > Настройка динамических направляющих),
открывающая вкладку Workspace > Dynamic Guides (Рабочая область >
Динамические направляющие);

П Layout t Page Setup (Макет > Настройка страницы), открывающая вкладку
Document к Page > Size (Документ > Страница ^ Размер);

П Layout» Page Background (Макет > Фон страницы), открывающая вкладку
Document > Page > Background (Документ > Страница > Фон);

П Text > Writing Tools > Settings (Текст * Инструменты правописания > Настройки),
открывающая вкладку Workspace > Text > Spelling (Рабочая область > Текст >
Правописание);
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О Tools > Options (Инструменты > Параметры), открывающая ту вкладку, кото-
рая открывалась в программе последней;

П Tools > Customization (Инструменты * Настройка), открывающая вкладку
Workspace > Customization (Рабочая область > Настройка);

О Window > Toolbars > More Toolbars (Окно f Панели инструментов > Еще пане-
ли инструментов), открывающая вкладку Workspace > Customization.

Контекстное меню, открываемое правой кнопкой мыши при установке указате-
ля на измерительной линейке, содержит три команды открытия окна Options
(Параметры):

О Grid Setup (Настройка сетки), открывающая вкладку Document > Grid
(Документ > Сетка);

П Ruler Setup (Настройка линейки), открывающая вкладку Document > Rulers
(Документ > Линейки);

О Guidelines Setup (Настройка направляющих), открывающая вкладку
Document > Guidelines (Документ > Направляющие).

Все категории настроек параметров CorelDRAW 12 разбиты на три уровня вло-
жений. Первый, самый верхний уровень включает три категории: Workspace
(Рабочая область), Document (Документ) и Global (Глобальные). К категории
Workspace относятся параметры настройки пользовательского интерфейса.
к категории Document — параметры настройки активного документа, а в катего-
рию Global входят те параметры настройки программы, которые не вошли
в первые две категории.

Параметры интерфейса
К категории первого уровня Workspace (Рабочая область) относятся параметры
настройки основных режимов работы программы и ее пользовательского ин-
терфейса (меню, быстрых и горячих клавиш, панелей инструментов, цветовых
палитр и т. п.).

Вкладка Workspace
Вкладка Workspace (Рабочая область) диалогового окна Options (Параметры)
предназначена для выбора, формирования и удаления образцов интерфейсов
CorelDRAW 12, которые представляют собой группы параметров из категории
Workspace (Рабочая область). Эти образцы хранятся в памяти компьютера под
определенными именами.

Порядок настройки
1. Откройте диалоговое окно Options (Параметры) на вкладке Workspace (Рабо-

чая область).

2. В рабочей области окна (она находится в центре), содержащей список поль-
зовательских интерфейсов CorelDRAW 12, установите метку слева от назва-
ния того интерфейса, который будет применяться в дальнейшем.
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3, Используя приведенные рекомендации, выполните другие необходимые дей-
ствия в окне Options (Параметры):

• чтобы создать новый образец интерфейса, содержащего текущие установ-
ки программы, щелкните на кнопке New (Новый). При этом откроется
диалоговое окно New Workspace (Новая рабочая область), где необходимо
ввести определенную информацию;

• для удаления выделенного интерфейса из списка доступных щелкните на
кнопке Delete (Удалить);

• чтобы включить в список интерфейсов программы образец интерфейса,
хранящийся на диске в файле (с расширением cwf), щелкните на кнопке
Import (Импорт);

• чтобы сохранить выбранный интерфейс в файле (с тем же расширением)
для его последующего переноса на другой компьютер, щелкните на кноп-
ке Export (Экспорт),

4. Если настройка параметров программы на этом заканчивается, щелкните на
кнопке подтверждения ОК. Для продолжения настройки перейдите на дру-
гую вкладку диалогового окна.

Вкладка General
Вкладка Workspace > General (Рабочая область > Общие) диалогового окна
Options (Параметры) включает элементы настройки общих параметров интер-
фейса программы (см. рис. 8.1):

О поле Regular, где указывается допустимое число последовательно выполнен-
ных операций по обработке объектов документа, которые можно отменить
командой Undo (Отменить) меню Edit (Правка);

О поле Bitmap effects для ввода допустимого числа операций по обработке рас-
трового изображения, которые могут быть отменены той же командой;

Примечание

С увеличением значений параметров Regular и Bitmap effects объем опера-
тивной памяти, потребляемой программой, возрастает.

G флажок Center dialog boxes when displayed, при установке которого задается
режим размещения открываемых диалоговых окон в центре экрана;

П флажок Show titles on floating dockers, при установке которого активизируется
режим отображения заголовков плавающих докеров;

П флажок Auto-execute single item pop-up menus, при установке которого задает-
ся режим автоматического выполнения команды при открытии контекстного
меню, содержащего только эту команду;

О флажок Show overprints, при установке которого подключается режим ото-
бражения областей векторных объектов с печатью с наложением (то есть без
выбивок);
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G флажок Enable sounds, при установке которого активизируется режим подачи
звукового сигнала по завершении очередной операции;

^ Примечание

Присвоение образцов звуковых сигналов определенным событиям, возникаю-
щим в программе CorelDRAW 12 в процессе обработки документа, выполняет-
ся в диалоговом окне Свойства: Звуки и ауднеустройства Панели управле-
ния Windows XP, которое открывается двойным щелчком на значке Звуки
и аудиоустройства.

О флажок Enable RealTime Preview, при установке которого подключается ре-
жим отображения всего объекта, а не только его контура, в процессе пере-
мещения рабочим инструментом Pick (Выбор);

П раскрывающийся список (с редактируемым полем) Resolution, который ис-
пользуется для выбора величины разрешения дополнительных растровых
изображений, создаваемых программой в процессе формирования эффекта
тени, а также при обработке объектов документа рабочим инструментом
Interactive Transparency (Интерактивная прозрачность);

CJ список On CorelDRAW start-up, содержащий варианты загрузки документа
при запуске программы. При выборе пункта Welcome Screen на экране
отобразится панель Welcome to CorelDRAW(R) 12 (Добро пожаловать
в CorelDRAW(R) 12) с набором управляющих кнопок. С их помощью можно
выбрать один из шести режимов открытия окна программы.

Вкладка Display
На вкладке Workspace > Display (Рабочая область > Отображение) диалогового
окна Options (Параметры) расположены элементы настройки, актинизирующие
режимы отображения на экране объектов документа:

G группа из двух переключателей Preview colors, определяющих способ переда-
чи на экране цветовых оттенков изображения: применяется в CorelDRAW
(переключатель Corel dithering) или в Windows (Windows dithering);

П флажок Interruptible refresh, при установке которого задается режим преры-
вания процесса перерисовки экрана при щелчке мышью или нажатии опре-
деленной клавиши;

П флажок Manual refresh, при установке которого подключается режим ручной пе-
рерисовки экрана в том случае, когда перерисовка происходит только при сме-
щении бегунка одной из полос прокрутки рабочего окна документа или при вы-
полнении команды Refresh Window (Обновить окно) меню Window (Окно);

П флажок Use Offscreen Image, при установке которого активизируется режим
перерисовки документа в оперативной памяти компьютера без отображения
на экране промежуточных фаз данного процесса;

G флажок Auto-panning, при установке которого задается режим автоматиче-
ской прокрутки документа в его рабочем окне в случае перемещения мышью
определенного объекта за пределы окна;
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П флажок Show Tooltips, при установке которого активизируется режим ото-
бражения контекстных подсказок для рабочих инструментов программы;

П флажок Enable node Tracking, при установке которого подключается режим
выделения узелков, находящихся на контуре объекта, инструментом Pick
(Выбор) или одним из инструментов рисования;

П флажок Show PostScript fills in enhanced view, при установке которого активи-
зируется режим отображения заливок узорами PostScript с помощью улуч-
шенного режима отображения содержимого документа;

П флажок Antialias bitmaps in enhanced view, при установке которого подключа-
ется режим сглаживания краев в растровых изображениях в процессе работы
в улучшенном режиме отображения документа;

П флажок Enable selection after drawing, при установке которого активизируется
режим автоматического выделения объекта после его формирования;

П флажок Highlight outline for selected objects, при установке которого подклю-
чается режим отображения пунктиром контуров выделенного объекта;

П группа из двух переключателей Full-screen Preview, с помощью которых обес-
печивается управление качеством отображения графической информации
в режиме полноэкранного просмотра: обычное (переключатель Use draft
view) или улучшенное (Use enhanced view);

О флажок Show page border, при установке которого активизируется режим
отображения границ макетируемой страницы документа при полноэкранном
просмотре;

П поле Preview fountain steps, с помощью которого обеспечивается управление
количеством градиентных переходов при их отображении на экране (по
умолчанию — 256).

Вкладка Edit
На вкладке Workspace > Edit (Рабочая область > Правка) диалогового окна
Options (Параметры) находятся элементы настройки различных режимов редак-
тирования объектов документа:

П поле Constrain angle, предназначенное для задания (в градусах) принудительного
(фиксированного) угла поворота объекта при нажатии клавиши <CtrI>;

П поле Drawing precision, где указывается количество десятичных знаков после
запятой в значениях координат указателя и размеров выбранного объекта,
отображаемых в строке состояния;

П поле Miter limit, предназначенное для задания минимально допустимого угла
между двумя смежными прямолинейными участками векторного контура
(в градусах), когда не будет происходить обрезка их выступающей части
в месте соединения;

G поле Minimum extrude facet size, в котором указывается минимальное рас-
стояние между оттенками цветов при формировании в векторном объекте
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эффекта выдавливания (действие этого параметра автору обнаружить не
удалось);

П флажок Save facet size with document, при установке которого задается режим со-
хранения значения параметра Minimum extrude facet size вместе с документом;

П флажок Auto-center new PowerClip contents, при установке которого подклю-
чается режим размещения выбранного объекта в центре объекта-контейнера,
куда он будет вставлен в процессе формирования эффекта PowerClip.

Вкладка Snap to Objects
На вкладке Workspace > Snap to Objects (Рабочая область > Привязать к объек-
там) диалогового окна Options (Параметры) находятся элементы настройки па-
раметров режима привязки к объектам (см. рис. 8.2):

~] флажок Snap to Objects On (Alt+Z), при установке которого активизируется
режим привязки к объектам;

П флажок Show Snap location marks, при установке которого подключается ре-
жим отображения значков элементов объектов документа, к которым осуще-
ствляется привязка;
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|nap to Objects

' Snap to Objects On (Alt+Z) Snapping threshold ] Medium "" |

v Show Snap location marks
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Рис. 8.2. Вкладка Workspace > Snap to Objects диалогового окна Options
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П флажок Screen Tip, при установке которого подключается режим отображе-
ния названий элементов объектов в процессе привязки к ним;

П раскрывающийся список Snapping threshold, в котором выбирается пороговое
значение расстояния между опорной точкой перемещаемого объекта и неко-
торым элементом другого объекта, при котором осуществляется привязка
этих объектов;

П список из девяти элементов объектов документа, предназначенный для вы-
бора (с помощью меток) тех элементов, для которых будут отображаться
значки и названия в процессе привязки;

П кнопка Select АИ, устанавливающая метки для всех элементов указанного
выше списка;

П кнопка Deselect All, удаляющая все метки из данного списка.

Вкладка Dynamic Guides
На вкладке Workspace > Dynamic Guides (Рабочая область > Динамические на-
правляющие) диалогового окна Options (Параметры) находятся элементы на-
стройки параметров динамических направляющих:

П флажок Dynamic Guides On (Ait+Shift+D), при установке которого подключа-
ется режим работы с динамическими направляющими;

П флажок Angle Screen Tip, при установке которого отображается угол наклона
к горизонтали сформированной направляющей;

П флажок Distance Screen Tip, при установке которого отображается величина
смещения перемещаемого объекта (относительно исходного его положения
или другого объекта документа) вдоль динамической направляющей;

П флажок Snap to ticks, при установке которого подключается режим привязки
объекта, перемещаемого вдоль направляющей, к условным делениям на этой
направляющей, не видимым на экране;

О поле Tick Spacing, в котором задается промежуток между соседними услов-
ными делениями на направляющей, к которым осуществляется привязка пе-
ремещаемого объекта;

О поле degrees, в котором задается угол наклона новой динамической направ-
ляющей, которая может быть сформирована;

П список подключаемых углов наклона динамических направляющих (слева),
в котором задаются (с помощью меток) те углы наклона направляющих к го-
ризонтали, при которых они будут формироваться в документе;

П кнопка Add, создающая новые направляющие с углом наклона, заданным
в поле degrees;

П кнопка Delete, удаляющая направляющие с углом наклона, выбранным
в списке слева;

П кнопка Select All, устанавливающая все метки в списке слева;
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П кнопка Deselect All, удаляющая все метки из данного списка;

П область просмотра (справа), в которой отображаются динамические направ-
ляющие со всеми возможными углами их наклона, заданными на этой
вкладке;

П флажок Extend Along Segment, при установке которого подключается режим
формирования динамических направляющих вдоль прямолинейных участков
контуров объектов документа.

Вкладка Warnings
Вкладка Workspace * Warnings (Рабочая область > Предупреждения) диалогового
окна Options (Параметры) включает список предупреждающих сообщений, ко-
торые отображаются на экране тогда, когда наступают соответствующие события
при условии, что они отмечены в списке. По умолчанию все сообщения в спи-
ске выбраны.

Вкладка VBA
На вкладке Workspace > VBA (Рабочая область > VBA) диалогового окна Options
(Параметры) находятся элементы настройки параметров режима выполнения
(воспроизведения) макрокоманд, сформированных в документе программой
Microsoft Visual Basic 6.3.

^ Примечание

Данную программу называют также Visual Basic for Applications (сокращенно —
VBA), в связи с чем рассматриваемая вкладка и была так названа.

Вкладка содержит такие элементы настройки:
G переключатель High, обеспечивающий высокую степень защиты документов

от подозрительных макрокоманд и предусматривающий их отключение, если
они относятся к ненадежным источникам;

О переключатель Medium, обеспечивающий среднюю степень защиты и позво-
ляющий пользователю самому принимать решение о применении подозри-
тельных макрокоманд;

G переключатель Low (not recommended), отключающий защиту от применения
подозрительных макрокоманд;

G флажок Trust all installed CMS modules, при установке которого задается ре-
жим доступа ко всем глобальным источникам макрокоманд, имеющих фай-
ловое расширение gms и называемых модулями GMS;

О в области Incompatibility Warnings (Предупреждения о несовместимости):

• установка первого сверху флажка означает, что при открытии модуля
GMS, содержащего более современные версии проектов VBA, чем те,
с которыми происходит работа в CorelDRAW 12, выполняется команда,
указанная в списке справа;
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Примечание

Проект VBA может содержать несколько макрокоманд.

• установка второго сверху флажка предусматривает выполнение команды,
указанной в списке справа, при открытии документа, содержащего более
современные версии проектов VBA;

• флажок Delay Load VBA, при установке которого задается режим задерж-
ки в выполнении макрокоманд.

Вкладка Save
На вкладке Workspace > Save (Рабочая область >• Сохранить) диалогового окна
Options (Параметры) расположены элементы настройки, предназначенные для
формирования и сохранения резервных копий файлов-документов:

П флажок Auto-backup every, при установке которого активизируется режим
создания резервной копии документа через определенный промежуток, вели-
чина которого выбирается в списке minutes (минуты) справа;

П группа из двух переключателей, предназначенных для задания местоположе-
ния резервных копий документов: в папке Windows со временными файлами
(верхний переключатель) или в папке, задаваемой с помощью кнопки Browse
(нижний переключатель);

О флажок Make backup on save, при установке которого подключается режим
формирования копии документа в момент сохранения оригинала.

Вкладка Memory
Вкладка Workspace > Memory (Рабочая область ^ Память) диалогового окна
Options (Параметры) содержит элементы настройки, которые регулируют ис-
пользование программой дисковой и оперативной памяти компьютера:

П раскрывающиеся списки Primary disk и Secondary disk, предназначенные для
выбора основного и дополнительного дисков, на которых будут формиро-
ваться файлы подкачки CorelDRAW 12;

П поле Maximum в области Memory Usage, где задается доля свободной опера-
тивной памяти компьютера (в процентах), которую программа может исполь-
зовать;

О флажок Enable Compression, при установке которого активизируется режим
сжатия документа при его сохранении в файле.

Вкладка Plug-Ins
На вкладке Workspace ^ Plug-Ins (Рабочая область t Дополнения) диалогового
окна Options (Параметры) представлен редактируемый список папок, который
формируется при установке CorelDRAW 12. В этих папках размещены дополни-
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тельные программные модули (дополнения), используемые программой. Чтобы
подключить новую папку с дополнениями, нужно воспользоваться кнопкой Add
(Добавить). Для временного отключения от программы группы дополнений,
необходимо убрать метку слева от названия ее папки, а для полного удаления
папки из списка — щелкнуть на кнопке Remove (Удалить).

Категория второго уровня Text
На пяти вкладках категории Text (Текст) размещены параметры, которые уста-
навливают различные режимы работы с текстовой информацией.

Вкладка Text
Вкладка Workspace > Text (Рабочая область > Текст) диалогового окна Options
(Параметры) содержит элементы настройки, определяющие общие параметры
по работе с текстом:

П флажок Edit text on screen, при установке которого задается режим редакти-
рования текста прямо в документе;

П флажок Drag and drop editing, при установке которого подключается режим
редактирования текста путем его перемещения мышью с помощью метода
"перетащи и отпусти";

3 флажок Auto-Keyboard switching, при установке которого активизируется ре-
жим автоматической активизации клавиатуры того языка, подключенного
к Windows, к которому относятся выделенные текстовые символы или сим-
волы, между которыми находится текстовый курсор;

П флажок Show handlers while editing, при установке которого обеспечивается
возможность применения выделяющих маркеров при работе в режиме редак-
тирования текста в документе;

П поле Minimum line width, в котором задается минимальная ширина текстовой
строки (в количестве букв);

П поле Greek text below, где указывается минимальный размер текстовых сим-
волов (в пикселах), при которых их еще можно различить на экране;

П поле Display, в котором задается предельное количество символов, отобра-
жаемых в режиме ручного кернинга;

П поле Keyboard Text Increment, предназначенное для задания числа пунктов,
на которые будет изменяться размер кегля в случае однократного примене-
ния соответствующей комбинации быстрых клавиш;

П флажок Calligraphic text, при установке которого текстовый объект, перено-
симый через буфер обмена Windows из документа CorelDRAW 12 в документ,
созданный в программе Adobe Illustrator, не будет преобразован в объект век-
торной графики;

П флажок Text in metafile, при установке которого текстовый объект, копируе-
мый в буфер обмена, будет представлен там в формате метафайла;
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О список Non-printing characters, в котором отмечаются служебные (непечатае-
мые) символы документа, отображаемые на экране при условии задания
в программе соответствующего режима (команда Show Non-Printing Characters
(Показать служебные символы) меню Text (Текст));

П список Default text units, предназначенный для задания единиц измерения,
в которых указывается кегль текстового шрифта (по умолчанию — пункты).

Вкладка Paragraph
На вкладке Workspace » Text > Paragraph (Рабочая область > Текст > Абзац) диа-
логового окна Options (Параметры) представлены элементы настройки парамет-
ров режима работы с обычным текстом:

О флажок Show linking of text frames, при установке которого подключается
режим отображения связей между текстовыми рамками;

Q флажок Show text frames, при установке которого активизируется режим ото-
бражения текстовой рамки в виде пунктира при отсутствии ее выделения;

П флажок Expand and shrink paragraph text frames to fit text, при установке ко-
торого задается режим изменения размеров рамки в соответствии с ее содер-
жимым;

G набор из трех переключателей, обеспечивающих подключение режима фор-
матирования связанных текстовых блоков, размещаемых:

• во всех текстовых рамках (переключатель to all linked frames);

• только в текущей рамке (переключатель to selected frame only);

• в текущей и во всех последующих рамках (переключатель to selected and
subsequent frames);

О флажок Make all new paragraph text frames Web-compatible, при установке
которого задается режим создания новых текстовых рамок, отвечающих
требованиям Web к параметрам обычного текста, который будет в них раз-
мещаться.

Другие вкладки категории Text
Вкладка Workspace > Text > Fonts (Рабочая область > Текст > Шрифты) диалого-
вого окна Options (Параметры) включает элементы настройки параметров тек-
стовых и символьных шрифтов.

Вкладка Workspace » Text > Spelling (Рабочая область > Текст > Правописание)
содержит элементы настройки параметров функции правописания.

На вкладке Workspace > Text > QuickCorrect (Рабочая область > Текст > Быстрое
исправление) предсташтены элементы настройки параметров функции автозаме-
ны, в том числе и редактируемый список пар заменяемых текстовых фраз.
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Категория второго уровня Toolbox
Параметры категории второго уровня Toolbox (Блок инструментов) расположе-
ны на 14 вкладках диалогового окна Options (Параметры). Каждая из них назы-
вается в соответствии с наименованием одного или двух рабочих инструментов
программы и содержит параметры их настройки, используемые по умолчанию.

Вкладка Connector Toot
На вкладке Workspace > Toolbox > Connector Tool (Рабочая область > Блок инструмен-
тов > Инструмент "Соединитель") диалогового окна Options (Параметры) задается
один параметр рабочего инструмента Interactive Connector > Angled connector (Интер-
активный соединитель V Угловой соединитель). В поле Straight line threshold указы-
вается минимально допустимый размер прямолинейных сегментов соединительной
линии, которые размещаются параллельно осям координат.

Вкладка Dimension Tool
На вкладке Workspace > Toolbox > Dimension Tool (Рабочая область » Блок инст-
рументов > Инструмент "Размер") диалогового окна Options (Параметры) задают-
ся параметры рабочего инструмента Dimension (Размер), который применяется
при рисовании обычных размерных линий (не угловых). Данные параметры
могут быть также заданы на панели свойств.

На вкладке представлены следующие элементы настройки:

О раскрывающийся список Style, в котором производится выбор стиля оформ-
ления размерных величин, доступный для использования в первых четырех
режимах рисования размерных линий;

П список Precision, предназначенный для указания числа десятичных знаков
после запятой, применяемых в угловых размерных величинах;

G список Units, в котором задаются единицы измерения;

О поле Prefix, где определяется начальная константа, которая используется
в размерных надписях;

П поле Suffix, предназначенное для задания конечной константы, применяемой
в размерных надписях.

Вкладка Angular Dimension Tool
На вкладке Workspace > Toolbox > Angular Dimension Tool (Рабочая область > Блок
инструментов * Инструмент "Угловые размеры") диаюгового окна Options (Па-
раметры) задаются параметры рабочего инструмента Dimension (Размер), кото-
рый применяется в режиме рисования угловых размерных линий. Данные пара-
метры могут быть также заданы на панели свойств.

На вкладке находятся такие элементы настройки:

О раскрывающийся список Precision, предназначенный для выбора числа деся-
тичных знаков после запятой, применяемых в угловых размерных величинах:
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О список Units, в котором задаются единицы измерения;

О поле Prefix, где определяется начальная константа, которая используется
в размерных надписях;

П поле Suffix, в котором задается конечная константа, применяемая в размер-
ных надписях.

Вкладка Ellipse Tool
На вкладке Workspace * Toolbox > Ellipse Tool (Рабочая область > Блок инстру-
ментов > Инструмент "Эллипс") диалогового окна Options (Параметры) задаются
параметры рабочего инструмента Ellipse (Эллипс). Данные параметры могут
быть также заданы на панели свойств.

На вкладке находятся такие элементы настройки:

П переключатель Ellipse, задающий режим рисования эллипса;

П переключатель Pie, подключающий режим рисования сектора;

П переключатель Arc, определяющий режим рисования дуги;

О поля Starting angle и Ending angle, в которых указываются углы поворота
(в направлении против часовой стрелки) соответственно первого и второго
образующих радиусов будущей фигуры относительно горизонтали;

О переключатель Clockwise, задающий режим перехода по часовой стрелке
между первым и вторым образующими радиусами при формировании секто-
ра или дуги;

П переключатель Counter-clockwise, подключающий режим перехода против
часовой стрелки между первым и вторым образующими радиусами.

Вкладка Eraser Tool
На вкладке Workspace > Toolbox * Eraser Tool (Рабочая область * Блок инстру-
ментов > Инструмент "Ластик") диалогового окна Options (Параметры) задаются
параметры рабочего инструмента Eraser (Ластик). Данные параметры могут быть
также заданы на панели свойств.

На вкладке представлены два элемента настройки:

П поле Thickness, в котором задается ширина области воздействия инструмента
на объект обработки;

П флажок Auto-reduce nodes of resulting objects, при установке которого задается
режим автоматического удаления лишних узелков на участках контуров,
формируемых инструментом.

Вкладка Freehand/Bezier Tool
На вкладке Workspace > Toolbox v Freehand/Bezier Tool (Рабочая область >
Блок инструментов > Инструмент "Рисование от руки/Безье") диалогового окна
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Options (Параметры) задаются параметры рабочих инструментов Freehand (Рисо-
вание от руки) и Bezier (Безье):

П ползунок Freehand smoothing, предназначенный для настройки уровня сгла-
живания кривой при ее рисовании с помощью инструмента Freehand;

О поле Autotrace tracking, где задается допуск (в пикселах), в пределах которого
создается векторный контур в режиме автоматической трассировки растро-
вого изображения;

П поле Corner threshold, в котором задается порог создания узелка углового ти-
па (в пикселах) при рисовании кривой с помощью инструмента Freehand или
в режиме автоматической трассировки;

П поле Straight line threshold, где определяется порог создания прямолинейных
отрезков (в пикселах) при рисовании кривой от руки или при ее трассировке;

П поле Auto-join, используемое для задания порога замыкания концов вектор-
ного контура (в пикселах) при его создании с помощью инструментов
Freehand и Bezier.

Примечание

В том образце программы CorelDRAW 12, которая здесь описывается, режим
автоматической трассировки, реализуемый рабочими инструментами Freehand
и Bezier, отсутствовал.

Вкладка Graph Paper Tool
На вкладке Workspace > Toolbox > Graph Paper (Рабочая область > Блок инстру-
ментов > Инструмент "Сотовая структура") диалогового окна Options (Парамет-
ры) задаются два параметра настройки рабочего инструмента Graph Paper (Со-
товая структура), которые дублируются на панели свойств: в поле Number of cells
wide задается число ячеек по горизонтали, а в поле Number of cells high — число
ячеек по вертикали.

Вкладка Knife Tool
На вкладке Workspace > Toolbox > Knife Tool (Рабочая область > Блок инструмен-
тов > Инструмент "Нож") диалогового окна Options (Параметры) задаются пара--
метры рабочего инструмента Knife (Нож). Данные параметры могут быть также
заданы на панели свойств.

На вкладке представлены два элемента настройки:

П флажок Leave as one object, при установке которого задается режим сохране-
ния единого объекта в процессе его обработки;

О флажок Automatically close object, при установке которого подключается ре-
жим автоматического замыкания контуров составных частей объекта.
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Вкладка Mesh Fill Tool
На вкладке Workspace У Toolbox * Mesh Fill Tool (Рабочая область > Блок инстру-
ментов > Инструмент "Заливка по сетке") диалогового окна Options (Параметры)
задаются параметры рабочего инструмента Mesh Fill (Заливка по сетке). Данные
параметры могут быть также заданы на панели свойств. На вкладке находятся
два поля; Number of columns и Number of rows, в которых задаются числа ячеек
в сетке по горизонтали и вертикали.

Вкладка Pick Tool
На вкладке Workspace > Toolbox * Pick Tool (Рабочая область * Блок инструмен-
тов > Инструмент "Выбор") диалогового окна Options (Параметры) задаются па-
раметры рабочего инструмента Pick (Выбор). Вкладка содержит следующие эле-
менты настройки:

О флажок Cross hair cursor, при установке которого задается форма указателя
в виде двух ортогональных прямых линий;

П флажок Treat all objects as filled, при установке которого любой векторный
объект без заливки можно выделить щелчком внутри него;

О флажок Redraw complex objects, при установке которого активизируется ре-
жим создания пунктирной линии вокруг группового объекта при его пере-
мещении с задержкой, минимальная величина которой указывается в поле
Delay;

Примечание

Проверка показала, что указанный режим в программе не работает.

О переключатель Traditional CorelDRAW, устанавливающий режим применения
клавиш <Ctrl> и <Shift>, принятый в CorelDRAW 12:

• для клавиши <Ctrl> — принудительный поворот объекта на фиксирован-
ный угол;

• для клавиши <Shift> — масштабирование объекта из центра;

О переключатель Windows standard, задающий режим применения указанных
клавиш, принятый в Windows:

• для клавиши <Ctrl> — формирование копии выбранного объекта при пе-
ремещении указателя;

• для клавиши <Shift> — принудительный поворот объекта на фиксирован-
ный угол.

Вкладка Polygon Tool
На вкладке Workspace » Toolbox > Polygon Tool (Рабочая область > Блок инст-
рументов > Инструмент "Многоугольник") диалогового окна Options (Параметры)
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находятся элементы настройки параметров рабочего инструмента Polygon
(Многоугольник):

О переключатель Polygon, предназначенный для задания режима рисования
выпуклых многоугольников (со сплошной областью заливки фигуры);

О переключатель Star, устанавливающий режим рисования звезд (с прозрачной
центральной частью фигуры);

П переключатель Polygon as Star, задающий режим рисования многоугольников
в форме звезд (со сплошной областью заливки фигуры);

О поле Number of points/sides, в котором указывается число внешних вершин
фигуры;

О ползунок Sharpness, регулирующий остроту выступающих частей фигуры.

^ Примечание

Режим рисования многоугольников, представленных в виде звезд, задаваемый
с помощью переключателя Polygon as Star, является вспомогательным, так
как любой выпуклый многоугольник можно трансформировать в фигуру звезды,
регулируя серединные узелки его контура.

Вкладка Rectangle Tool
На вкладке Workspace > Toolbox > Rectangle Tool (Рабочая область > Блок инстру-
ментов > Инструмент "Прямоугольник") диалогового окна 'Options (Параметры:)
находится ползунок Corner roundness, с помощью которого задается параметр
рабочего инструмента Rectangle (Прямоугольник). Это — радиус скругления уг-
лов фигуры.

Вкладка Smart Drawing Tool
Вкладка Workspace > Toolbox » Smart Drawing Tool (Рабочая область > Блок инст-
рументов > Инструмент "Умное рисование") диалогового окна Options (Парамет-
ры) содержит ползунок Drawing assistance delay, с помощью которого задается
параметр рабочего инструмента Smart Drawing (Умное рисование). Это — про-
межуток времени, в течение которого будет образована результирующая фигура
из исходной фигуры, нарисованной от руки.

Вкладка Spiral Tool
На вкладке Workspace > Toolbox > Spiral Tool (Рабочая область > Блок инструмен-
тов > Инструмент "Спираль") диалогового окна Options (Параметры) задаются
параметры рабочего инструмента Spiral (Спираль). Данные параметры могут
быть также заданы на панели свойств.

На вкладке представлены следующие элемента настройки:

П переключатель Symmetrical, задающий режим формирования спирали сим
метричного типа, который характеризуется фиксированным шагом;
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П переключатель Logarithmic, подключающий режим создания спирали лога-
рифмического типа, для которого шаг спирали возрастает по логарифмиче-
скому закону;

О поле Number of revolutions, в котором указывается число витков спирали;

О ползунок Expansion, с помощью которого задается коэффициент увеличения
шага для спирали логарифмического типа.

Вкладка Zoom, Hand Tool
Вкладка Workspace » Toolbox > Zoom, Hand Tool (Рабочая область > Блок инстру-
ментов > Инструмент "Масштаб", "Рука") диалогового окна Options (Параметры)
содержит элементы настройки параметров двух рабочих инструментов: Zoom
(Масштаб) и Hand (Рука):

G группа из двух переключателей Mouse button 2 for the Zoom tool, определяющих
режим применения правой кнопки мыши в процессе работы с инструментом
Zoom: для уменьшения масштаба отображения документа на экране (переклю-
чатель Zoom out) или для открытия контекстного меню (Context menu);

П аналогичная группа переключателей для инструмента Hand;

П флажок Use traditional zoom flyout, при установке которого задается режим
открытия дополнительной панели при выборе рабочего инструмента Zoom,
на которой расположены те же инструменты, что и на панели свойств;

О флажок Zoom Relative to 1:1, при установке которого активизируется режим
масштабировании, при котором для единичного масштаба (100 %) фактиче-
ские размеры интервалов между делениями измерительных линеек будут со-
ответствовать указанным там величинам (при условии точной калибровки
линеек);

О кнопка Calibrate Rules, предназначенная для задания режима калибровки из-
мерительных линеек.

Категория второго уровня Customization
Параметры категории второго уровня Customization (Настройка), размещенные
на четырех вкладках диалогового окна Options (Параметры), предназначены для
настройки элементов интерфейса программы: панелей инструментов, строки
состояния, команд меню (в том числе быстрых и горячих клавиш), а также цве-
товых палитр.

Вкладка Command Bars
На вкладке Workspace f Customization > Command Bars (Рабочая область >
Настройка » Командные панели) диалогового окна Options (Параметры) задают-
ся параметры, управляющие отображением на экране панелей инструментов и
строки состояния программы (status bar), а также их внешним видом
(см. рис. 8.3). Здесь можно также создавать новые панели инструментов и уда-
лять те, которые были созданы пользователем ранее.
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В центральной части вкладки Command Bars расположены общие элементы на-
стройки панелей инструментов. В нее входят:

О рабочее окно со списком панелей инструментов, предназначенное для выбо-
ра тех из них, которые должны быть открыты;

О кнопка New, используемая для формирования новой панели инструментов;

О кнопка Reset/Delete, предназначенная для воссоздания исходного варианта
размещения инструментов на выбранной стандартной панели или удаления
панели, созданной пользователем.

В правой части вкладки находятся элементы, управляющие параметрами
оформления той панели инструментов, которая была ранее выделена в рабочем
окне. Сюда входят:

G раскрывающийся список Button, где указывается размер кнопок управления,
размещенных на текущей панели инструментов;

G поле Border, задающее ширину интервалов по краям панели;

П список Default Button Appearance, предназначенный для задания вида кнопок
управления указанной панели:

• Caption Below Image — текст, находящийся под изображением;
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• Caption Only — только текст;

• Caption to Right of Image — текст, располагаемый справа от изображения;

• Default — данный вариант применяется по умолчанию;

• Image Only — только изображение;

О флажок Show title when toolbar is floating, при установке которого задается
режим отображения заголовка на плавающей панели инструментов;

П при выбранном пункте Property Bar (Панель свойств) в рабочем окне: список
Property Bar Mode, в котором задается режим работы программы, опреде-
ляющий требуемый вид панели свойств.

Примечание

Работа со списком Property Bar Mode становится необходимой тогда, когда
требуется изменить компоновку панели свойств для одного или нескольких ре-
жимов работы программы, отличных от первоначального.

На рис. 8.3 представлен вид окна программы, содержащего панель свойств, и
диалоговое окно Options, открытое на вкладке Command Bars. Обратите внима-
ние на то, что вид панели свойств соответствует режиму обработки текста, кото-
рый был выбран в списке Property Bar Mode данной вкладки, перед этим был
выделен пункт Property Bar в списке панелей инструментов.

Вкладка Commands
Вкладка Workspace > Customization > Commands (Рабочая область > Настройка >
Команды) диалогового окна Options (Параметры) обладает широкими возмож-
ностями настройки. Она содержит три встроенные вкладки (в правой ее части),
назначение которых состоит в следующем:

G встроенная вкладка General (Общие) — изменение компоновки панелей ин-
струментов, строки состояния, а также основного и контекстных меню про-
граммы, включая формирование новых списков меню;

СЗ встроенная вкладка Shortcut Keys (Быстрые клавиши) — настройка быстрых
клавиш команд;

П встроенная вкладка Appearance (Внешний вид) — настройка наименований
команд, их горячих клавиш (символов с подчеркиванием), а также внешнего
вида кнопок инструментов.

В центре вкладки Commands (Команды) находятся общие элементы настройки,
к числу которых относятся:

О раскрывающийся список категорий команд, применяемых в CorelDRAW 12
(вверху);

П кнопка (с изображением бинокля), предназначенная для поиска нужной ко-
манды по ее названию;

G рабочее окно вкладки, включающее список команд, которые относятся
к выбранной категории.
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Примечание

Общее число команд CorelDRAW 12, доступ к которым имеется через рабочие
окно вкладки Commands (Команды), гораздо большее, чем тех, которые входят
в основное и контекстные меню программы. Каждую команду из данного списка
можно представить в двух видах: как пункт меню и как кнопку инструмента,
которую можно расположить на любой панели инструментов. Именно в этом
заключаются особенности процедуры настройки команд в программе
CorelDRAW 12.

Настройка панелей и меню

Настройка панелей инструментов и различных меню программы выполняется
с помощью встроенной вкладки General (Общие), находящейся в правой части
вкладки Workspace > Customization > Commands (Рабочая область > Настройка ^
Команды) диалогового окна Options (Параметры).

На рис. 8.4 изображен вид окна CorelDRAW 12 в процессе добавления новой
кнопки инструмента к панели свойств, находящейся в режиме обработки текста.
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Рис. 8.4. Пример настройки панели свойств в режиме обработки текста

Порядок настройки панелей и меню состоит в следующем.

1. Откройте вкладку Workspace > Customization > Command Bars (Рабочая об-
ласть f Настройка > Командные панели) диалогового окна Options (Парамет-
ры) и отрегулируйте положение окна на экране.
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2. Откройте ту панель инструментов, панель основного меню (Menu Bar), па-
нель контекстных меню (Context Menu Bar) или панель строки состояния
(Status Bar), которая будет настраиваться. При этом расположите ее внизу
или вверху экрана так, чтобы окно Options не закрывало ее.

3. Если настройка будет производиться для панели основного меню или пане-
ли свойств (Property Bar), то задайте в списке Menu/Property Bar Mode ре-
жим работы программы, который определяет текущий вид панели (в данном
случае был выбран пункт Text (Текст) для панели свойств, см. рис. 8.3).

4. Перейдите на вкладку Commands (Команды) той же категории настроек и
откройте там встроенную вкладку General (Общие) с помощью щелчка на ее
ярлычке.

5. Укажите в списке категорий команд (в верхней части вкладки) нужную ка-
тегорию (в данном случае указан пункт Text (Текст)). При этом в рабочее
окно вкладки Commands (Команды) будет загружен список команд данной
категории.

6. С помощью мыши укажите в рабочем окне вкладки тот элемент списка
(в данном случае это пункт Subscript (Нижний индекс)), который будет
вставляться в качестве новой кнопки инструмента на заданную панель или
новой команды в один из списков команд заданного меню программы.

7. Установите указатель на выделенном пункте списка. Нажмите кнопку мыши
и перетащите его на панель, видимую на экране, или в раскрытый вами
список команд меню. Отпустите кнопку в том месте, отмеченном черной
разделительной линией, куда эта кнопка или команда должна быть помеще-
на (в случае, представленном на рис. 8.4, выполняется вставка кнопки инст-
румента Subscript на панель свойств).

8. Чтобы удалить с панели (открытого списка меню) лишний инструмент (ко-
манду), поместите на нем указатель, нажмите кнопку мыши, перетащите
выбранный инструмент (команду) в область диалогового окна Options. Как
только под стрелкой указателя появится значок в форме черного перекре-
стия, отпустите кнопку мыши.

9. Повторите предыдущие шаги инструкции для всех инструментов (команд),
которые будут вставляться на панели (в списки меню) или удаляться из них.

10. Щелкните на кнопке подтверждения ОК, если настройка параметров про-
граммы на этом заканчивается. В противном случае перейдите на другую
вкладку окна.

Настройка быстрых клавиш

Настройка быстрых клавиш выполняется с помощью встроенной вкладки
Shortcut Keys (Быстрые клавиши), находящейся в правой части вкладки
Workspace > Customization ^ Commands (Рабочая область > Настройка > Команды)
диалогового окна Options (Параметры) (рис. 8.5).
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Рис. 8.5. Пример задания новой комбинации быстрых клавиш

Порядок настройки быстрых клавиш состоит в следующем.

1. Откройте диалоговое окно Options (Параметры) на вкладке Workspace >
Customization t Commands (Рабочая область > Настройка * Команды).

2. Перейдите на встроенную вкладку Shortcut Keys (Быстрые клавиши), щелк-
нув на ее ярлычке.

3. Укажите в списке категорий команд, находящемся вверху вкладки, необхо-
димую категорию (в данном случае указан пункт File (Файл)). При этом в ра-
бочее окно вкладки Commands (Команды) будет загружен список команд, ко-
торые относятся к этой категории.

4. С помощью мыши укажите в рабочем окне ту команду, для которой будет
устанавливаться новая комбинация быстрых клавиш (в данном случае это
команда New From Template (Новый из шаблона)).

5. В том случае, если выбранная команда не является текстовой, выберите
в списке Shortcut Key Table (Таблица быстрых клавиш) пункт Main (Основ-
ная). В противном случае — пункт Text Editing (Редактирование текста).

6. Если в поле Current Shortcut Keys указана текущая комбинация быстрых клавиш
для данной команды, то удалить ее вы сможете щелчком на кнопке Delete.

!93ак. 25С
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7. Установите текстовый курсор в редактируемое поле New Shortcut Key, а затем
введите с клавиатуры новый набор быстрых клавиш (нажатием одной или
двух управляющих клавиш с последующим нажатием обычной клавиши).

8. В том случае, если в информационном поле Currently assigned to отобразит-
ся некоторая информация, являющая собой название команды, для которой
данная комбинация клавиш уже применяется, выполните одно из следую-
щих двух действий:

• очистите поле New Shortcut Key и повторно введите с клавиатуры в него
такую комбинацию клавиш, которая больше нигде не используется (так,
чтобы поле Currently assigned to осталось пустым), затем щелкните на
кнопке Assign (Присвоить);

• щелкните на кнопке Assign, присвоив заданную комбинацию клавиш
указанной команде. После этого удалите такую же комбинацию, имев-
шуюся у другой команды (для перехода к ней предварительно установите
флажок Navigate to conflict on Assign).

9. Повторите шаги 3—8 инструкции для всех команд, для которых будут указы-
ваться новые комбинации быстрых клавиш.

10. Если вам необходимо восстановить комбинации быстрых клавиш, применяемых
в программе по умолчанию, щелкните на кнопке Reset АН (Сбросить все).

И. Чтобы просмотреть, распечатать или сохранить в файле нужную вам таблицу
с комбинациями быстрых клавиш, укажите ее в списке Shortcut Key Table и
щелкните на кнопке View All (Просмотреть все) для открытия таблицы.

12. Щелкните на кнопке подтверждения ОК, если настройка параметров про-'
граммы на этом заканчивается. Для продолжения настройки перейдите на
другую вкладку диалогового окна.

Настройка названий команд и вида кнопок инструментов

Настройка названий команд, их горячих клавиш (символов с подчеркиванием),
а также внешнего вида кнопок инструментов выполняется с помощью встроен-
ной вкладки Appearance (Внешний вид). Она находится в правой части вкладки
Workspace > Customization > Commands (Рабочая область > Настройка > Команды)
диалогового окна Options (Параметры) (рис. 8.6).

Порядок настройки названий команд и внешнего вида кнопок инструментов
состоит в следующем.

1. Откройте диалоговое окно Options (Параметры) на вкладке Workspace >
Customization * Commands (Рабочая область > Настройка > Команды).

2. Перейдите на встроенную вкладку Appearance (Внешний вид) с помощью
щелчка на ее ярлычке.

3. Укажите в списке категорий команд, находящемся в верхней части вкладки,
необходимую категорию (в данном случае выбран пункт File (Файл)). При
этом в рабочее окно вкладки Commands (Команды) будет загружен список
команд, которые относятся к этой категории.
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Рис. 8.6. Пример редактирования значка инструмента Open

4. С помощью мыши выделите в рабочем окне ту команду (в данном случае это
команда Open (Открыть)), для которой будет изменяться название или редак-
тироваться изображение кнопки соответствующего инструмента.

5. В том случае, если необходимо изменить название указанной команды (ин-
струмента), отредактируйте его в поле Caption (Заголовок). При этом устано-
вите символ амперсанта "&" перед той буквой, которая в фактическом назва-
нии команды будет подчеркнута и обозначать горячую клавишу.

6. Если вас не устраивает вид кнопки инструмента, представленный справа
в увеличенном виде, то выберите другое изображение, щелкнув для этого на
кнопке Import (Импорт).

7. Отредактируйте изображение кнопки заданного инструмента с помощью ра-
бочих инструментов вкладки Appearance (Внешний вид).

8. Повторите шаги 3—7 инструкции для всех команд, для которых будут изме-
няться названия и внешний вид соответствующих кнопок инструментов.

9. Щелкните на кнопке подтверждения ОК, если настройка параметров про-
граммы на этом заканчивается. Для продолжения настройки перейдите на
другую вкладку диалогового окна.
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Вкладка Color Palette
На вкладке Workspace ^ Customization > Color Palette (Рабочая область > Настройка >
Цветовая палитра) диалогового окна Options (Параметры) выполняется настрой-
ка параметров цветовых палитр. Здесь представлены следующие элементы на-
стройки:

П поле Maximum palette rows when docked, где задается число вертикальных ря-
дов с образцами цветов, постоянно присутствующих на экране в стационар-
ной цветовой палитре;

О флажок Wide borders, при установке которого обеспечивается наличие кром-
ки в цветовых образцах палитры;

П1 флажок Large swatches, при установке которого обеспечивается наличие
больших размеров цветовых образцов;

П1 флажок Show "No color" well, при установке которого активизируется режим
появления вверху палитры ячейки (с перекрестными линиями), создающей
прозрачную область заливки или обводки объекта;

П группа из двух переключателей Secondary Mouse button, с помощью которых
задается режим использования правой кнопки мыши: для открытия контек-
стного меню (переключатель Context menu) или для выполнения обводки
(Set outline color).

Примечание

При выполнении обводки векторного объекта контекстное меню можно открыть
и в том случае, если правую кнопку мыши удержать в нажатом состоянии в те-
чение одной секунды.

Вкладка Application
Вкладка Workspace > Customization > Application (Рабочая область > Настройка >
Приложение) диалогового окна Options (Параметры) содержит элементы на-
стройки режима отображения частично прозрачными тех элементов интерфейса
CorelDRAW 12, которые расположены на плавающих панелях:

О флажок Make Use Interface Transparent, при установке которого подключает-
ся режим отображения частично прозрачными заданных элементов интер-
фейса программы;

П флажок Command Bar, при установке которого подключается режим отобра-
жения прозрачными панелей инструментов;

П флажок Dockers, при установке которого подключается режим отображения
прозрачными докеров;

П флажок UI with color information, при установке которого подключается ре-
жим отображения прозрачными открытых цветовых палитр;

П ползунок Transparence Level, регулирующий уровень прозрачности элемен-
тов интерфейса CorelDRAW 12, находящихся на плавающих панелях.
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Параметры документа
Категория первого уровня Document (Документ) содержит в себе все параметры
настройки документа, который обрабатывается в программе.

Вкладка Document
На вкладке Document (Документ) диалогового окна Options (Параметры) задают-
ся режимы сохранения параметров настройки документа для их применения но
умолчанию при работе с новыми документами. Вкладка содержит следующие
элементы настройки:

П флажок Save options as default for new documents, при установке которого
подключается режим сохранения групп параметров, входящих в категорию
Document и отмеченных на данной вкладке, для их последующего примене-
ния при обработке других документов;

П флажки: General options (Общие параметры документа), Page options (Пара-
метры страницы), Grid and ruler options (Параметры сетки и линейки),
Guideline options (Параметры направляющих). Styles (Стили), Save options
(Параметры сохранения документа) и Publish to the Web options (Параметры
публикации на Web), при установке которых будут сохранены соответствую-
щие группы параметров текущего документа для дальнейшего использования
в процессе работы с новыми документами.

Вкладка General
На вкладке Document * General (Документ > Общие) диалогового окна Options
(Параметры) задаются общие параметры документа с помощью следующих эле-
ментов настройки:

П раскрывающийся список Display, в котором производится выбор режима
отображения документа на экране. Он содержит пять вариантов выбора:
Simple Wireframe (Упрощенный каркас), Wireframe (Каркас), Draft View (Чер-
новой вид), Normal View (Обычный вид) и Enhanced View (Улучшенный вид);

П флажок Fill open curves, при установке которого задается режим заливки
внутренних областей для векторных объектов с разомкнутыми контурами;

П флажок Auto inflate bitmaps for bitmap effects, при установке которого активи-
зируется режим автоматического наращивания растровой подложки при вы-
полнении операции растрирования.

Категория второго уровня Раде
Пять вкладок категории Page (Страница) диалогового окна Options (Параметры)
содержат различные параметры настройки страницы макетируемого документа.
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Вкладка Раде
На вкладке Document > Page (Документ * Страница) расположены три флажка:

П Show page border, при установке которого подключается режим отображения
на экране границ страницы документа (выделен по умолчанию);

П Show printable area, при установке которого активизируется режим отображе-
ния печатаемой области;

П Show bleed area, при установке которого задается режим отображения облас-
ти обрезки.

Вкладка Size
На вкладке Document > Page > Size (Документ * Страница » Размер) диалогового
окна Options (Параметры) задаются параметры, определяющие размеры и раз-
мещение открытой страницы документа (рис. 8.7).

iS Workspace
В Document

. General
; Б Page

= Layout
: Label
= • Background

H- Guidelines

:- Grid
j • Rulers

; •• Styles

; Save
[i] Publish To The Web

Global

Г* Normal Paper • Labels

'•• Portrait Landscape

Paper;

Widths
I

Height; [297,0 -iJ mitimeters

Restee current page only

,,.'!'•. . ; . - • .

5et From Printer

Add Page Frame

Cancel Help

Рис. 8.7. Вкладка Document > Page > Size диалогового окна Options

На вкладке представлены следующие элементы настройки:

П группа из двух переключателей, задающих тип страницы документа: обычная
(переключатель Normal Paper, который должен быть выбран) или для ярлы-
ков (Labels);
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D группа из двух переключателей, задающих ориентацию страницы: портретная
(переключатель Portrait) или альбомная (Landscape);

П раскрывающийся список Paper, предназначенный для выбора стандартного
формата страницы;

П поля Width и Height, где задаются ширина и высота страницы в единицах
измерения, выбранных в списке справа;

О флажок Resize current page only, при установке которого активизируется режим
регулировки размеров и ориентации только данной страницы документа;

П список Resolution, в котором выбирается величина расчетного разрешения
для задания размеров документа в пикселах (они выбираются в списке, нахо-
дящемся справа от поля Width);

П поле Bleed, в котором указывается ширина поля обрезки;

П кнопка Set From Printer, задающая размеры страницы в соответствии с пара-
метрами используемого принтера;

П кнопка Save Custom Page, с помощью которой можно сохранить нестандарт-
ные параметры страницы в качестве ее нового формата;

G кнопка Add Page Frame, создающая векторный объект прямоугольной формы
(с параметрами по умолчанию), границы которого соответствуют границам
открытой страницы документа.

Вкладка Layout
На вкладке Document * Page > Layout (Документ > Страница > Макет) диалогового
окна Options (Параметры) задаются параметры настройки схемы макета доку-
мента. Эта схема определяет вариант создания макетируемых страниц документа
из исходных страниц, а также их размещение в рабочем окне. Здесь представле-
ны следующие элементы настройки:

О раскрывающийся список Layout, в котором указываются варианты разбивки
исходной страницы документа на страницы макета;

О флажок Facing pages, при установке которого задается режим разворота стра-
ниц, то есть отображения двух соседних страниц макета в рабочей области
документа;

П флажок Start on, при установке которого указывается место размещения
в окне документа первой по порядку страницы: справа (пункт Right Side) или
слева (Left Side).

Вкладка Label
На вкладке Document > Page > Label (Документ » Страница * Ярлык) диалоговою
окна Options (Параметры) задаются параметры макетирования ярлыков с помо-
щью следующих элементов настройки:

П группа из двух переключателей, с помощью которых выбирается тип страни-
цы документа: обычная (переключатель Normal Paper) или для ярлыков
(переключатель Labels, который должен быть выбран);
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П рабочая область, содержащая вложенный список типов ярлыков и стилей их
макетирования (слева), в которой производится выбор требуемых типа и стиля;

П область для просмотра выбранного варианта схемы размещения ярлыков на
странице печатного листа (справа);

П кнопка Customize Label, позволяющая установить режим настройки парамет-
ров ярлыков в ручном режиме.

Вкладка Background
На вкладке Document > Page > Background (Документ > Страница > Фон) диалого-
вого окна Options (Параметры) выполняется настройка параметров фонового
изображения документа с помощью следующих элементов:

П переключатель No Background, задающий режим отсутствия фона в документе;

О переключатель Solid, подключающий режим использования в качестве фона
равномерной заливки, цвет которой выбирается из списка цветовых образцов;

П переключатель Bitmap, активизирующий режим использования фонового
мозаичного узора, создаваемого из растрового изображения, хранящегося
в файле, который открывается с помощью кнопки Browse;

П группа из двух переключателей Source, используемых для выбора одного из
двух режимов:

• устаноатения связи между документом и заданным файлом растрового
изображения (переключатель Linked);

• внедрения данного изображения в тело документа (Embedded);

О группа из двух переключателей Bitmap Size, устанавливающих режим исполь-
зования:

• стандартных размеров растрового изображения (переключатель Default
Size):

• произвольных размеров (переключатель Custom Size), определяемых с по-
мощью полей Н (Ширина) и V (Высота), а также флажка Maintain Aspect
Ratio (Сохранить заданную пропорцию);

П флажок Print and Export Background, при установке которого активизируется
режим печати и возможного экспорта фонового изображения документа.

Другие вкладки
Перечислим остальные вкладки диалогового окна Options с параметрами на-
стройки документа, не рассматривая подробно каждую из них. Назначение па-
раметров, расположенных на этих вкладках, зависит от их наименования. Этот
принцип действует и по отношению к уровню вложения категорий настроек.
К числу этих вкладок относятся:

О Document > Guidelines (Документ > Направляющие), на которой активизи-
руются режимы отображения направляющих и привязки к ним объектов
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документа, а также задаются цвета направляющих, создаваемых вручную и
автоматически;

П Document > Guidelines > Horizontal (Документ > Направляющие > Горизонталь-
ные), на которой указываются вертикальные координаты для горизонтальных
направляющих, создаваемых в документе;

П Document > Guidelines > Vertical (Документ > Направляющие > Вертикальные),
на которой задаются горизонтальные координаты для вертикальных направ-
ляющих;

П Document > Guidelines > Guides (Документ > Направляющие > Наклонные на-
правляющие), на которой определяются параметры для наклонных направ-
ляющих, создаваемых в документе;

П Document > Guidelines > Presets (Документ > Направляющие > Предустановки),
на которой активизируется режим создания определенных групп напрап-
ляющих (они называются предустановками), а также задаются параметры та-
ких направляющих;

G Document»Grid (Документ > Сетка), на которой указываются параметры
оформления линий сетки, режим отображения сетки, а также подключаются
режимы привязки объектов документа к линиям сетки;

И Document > Rulers (Документ > Линейки), на которой задаются параметры
оформления измерительных линеек;

П Document > Styles (Документ > Стили), на которой выполняется настройка
параметров существующих текстовых и графических стилей;

О Document > Save (Документ > Сохранить), на которой активизируются режи-
мы сохранения в файле документа информации, относящейся к различному
его содержимому;

G Document > Publish To The Web (Документ > Публиковать на Web), на которой
задаются общие параметры настройки, которые применяются в процессе
создания электронного документа;

П Document > Publish To The Web > Image (Документ > Публиковать на Web t
Изображение), на которой выбирается файловый растровый формат (JPEG,
GIF или PNG), а также стиль сохранения изображений для создаваемых
Web-страниц;

П Document > Publish To The Web * Text (Документ > Публиковать на Web >
Текст), на которой активизируется режим представления текстовой инфор-
мации исходного документа в будущем электронном документе;

П Document > Publish To The Web V Links (Документ > Публиковать на Web >
Связи), на которой задаются параметры оформления гиперссылок, приме-
няемых в электронном документе.
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Общие параметры программы
К категории первого уровня Global (Глобальные) относятся параметры настрой-
ки CorelDRAW 12, которые не вошли в две уже рассмотренные категории
Workspace (Рабочая область) и Document (Документ). В категорию входят пара-
метры, имеющие отношение к цветовой коррекции, операции печати, универ-
сальному диалоговому окну коррекции и эффектов, а также к фильтрам импор-
та/экспорта и ассоциативным связям.

Вкладка Global
Вкладка Global (Глобальные) диалогового окна Options (Параметры) содержит
следующие элементы настройки;

П флажок Enable CARM, при установке которого подключается система ава-
рийной защиты Corel Application Recovery Manager (Диспетчер восстановле-
ния приложения Corel), позволяющая сохранить активный документ в файле
при аварийном выходе из программы CorelDRAW 12;

О раскрывающийся список Select the Language for the user interface, предназна-
ченный для выбора языка, на котором будет представлен интерфейс про-
граммы CorelDRAW 12;

О флажок Ask me the next time the software starts, при установке которого будет
производиться выбор языка интерфейса при запуске очередного сеанса рабо-
ты программы.

Категория второго уровня Printing
На двух вкладках категории Printing (Печать) диалогового окна Options (Пара-
метры) задаются параметры печати, применяемые в программе по умолчанию,
а также два редактируемых списка предупреждающих сообщений и условий их
вывода. К этим вкладкам относятся:

G Global t Printing (Глобальные » Печать), на которой выполняются следующие
настройки:

• производится выбор стиля печати по умолчанию (список Default print style);

• подключается режим печати по умолчанию только текущей страницы до-
кумента (флажок Print only current page by default);

• задаются условия вывода предупреждающих сообщений на вкладке
Preflight (Предупреждения) диалогового окна Print (Печать); данная опе-
рация выполняется в поле Settings списка Special Settings, содержащего
полный перечень этих сообщений;

О Global > Printing > Driver Compatibility (Глобальные > Печать > Совместимость
драйвера)., на которой выполняются следующие настройки:

• задается драйвер принтера по умолчанию (список Printer);

• выбираются параметры печати, отменяющие действие соответствующих
параметров по умолчанию, относящихся к используемому принтеру.
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Вкладка Bitmap Effects
На вкладке Global > Bitmap Effects (Глобальные > Растровые эффекты) диалого-
вого окна Options (Параметры) задаются параметры настройки окна коррекции
и эффектов. Вкладка содержит следующие элементы настройки:

О группа из четырех переключателей Initial Preview Method, задающих вид
этого окна при его открытии:

• без окон предварительного просмотра (переключатель Full Screen);

• с двумя окнами для просмотра изображения до и после его обработки
(переключатель Before and After);

• с одним окном для просмотра результата обработки (переключатель Result
only);

• вариант, который был применен последним (переключатель Last Used);

О флажок Prefill dialogs with last used values, при установке которого задается
режим сохранения в окне коррекции и эффектов параметров команды, ука-
занных в предыдущем сеансе ее использования.

Категория второго уровня Filters
Данная категория содержит две вкладки.

Вкладка Filters
На вкладке Global > Filters (Глобальные > Фильтры) диалогового окна Options
(Параметры) формируется набор фильтров импорта и экспорта информации
(рис. 8.8). Эти фильтры будут применяться в CorelDRAW 12 при работе с фай-
лами векторных, растровых, текстовых и видеоформатов.

Порядок настройки

1. Откройте диалоговое окно Options (Параметры) на вкладке Global > Filters
(Глобальные > Фильтры).

2. В рабочей области Available file types (Доступные типы файлов), расположен-
ной слева, откройте вложенный список типов файлов. Выберите тот из них,
для которого нужно подключить фильтр импорта/экспорта.

3. Щелкните на кнопке Add (Добавить). Вследствие этого выделенный фильтр
будет включен в список доступных для использования и отобразится в рабо-
чем окне List of active filters (Список активных фильтров) справа.

4. Чтобы удалить из программы фильтр, который применяться не будет, выбе-
рите его название в окне справа и щелкните на кнопке Remove (Удалить).

5. Повторите шаги 2—4 инструкции для всех фильтров, которые необходимо
подключить к программе или удалить из нее.

6. Если вам необходимо восстановить исходный набор фильтров, который был
задан при установке программы, щелкните на кнопке Reset.
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1. Щелкните на кнопке подтверждения ОК, если настройка параметров про-
граммы на этом заканчивается, в противном случае перейдите на другую
вкладку диалогового окна.

Options

Ei- Workspace
щ Document
Fi-Global

т- Printing
]••• Bitmap Effects

tl Fiters
Associate

Available file types:

I ® ^Raster
Щ -$L- Vector
ф" ft Text
3 -3^ Animation

Ш CLK-Corel R-АЛ
: jjjh SWF-Macromed

•liih GIF - GIF Animatl

List of active filters:

Move Up

Move Down

DES - Corel DESIGNER
IL - Corel Symbol Library

CHX - Corel Presentation E
EPS - Encapsulated PostSc
AI - Adobe Illustrator
At - Adobe Illustrator
PS, PRN, EPS - PostScript)
WPG - Corel WordPerfect t
WMF - Windows Metafile ,,

•Description -

Corel RAV.E. Import Filter
(•.OK) Reset

Cancel Help

Рис. 8.8. Вкладка Global > Filters диалогового окна Options

Вкладка Associate
С помощью вкладки Global > Filters > Associate (Глобальные > Фильтры * Связывать)
диалогового окна Options (Параметры) указываются ассоциативные связи между
файлами документов различных типов и программой CorelDRAW 12, которая бу-
дет запускаться в работу автоматически (с загрузкой в нее документа) с помо-
щью двойного щелчка на названии выбранного файла. Связи задаются путем
установки меток слева от названий соответствующих типов файлов в списке
типов, находящемся в центре вкладки.



Глава 9

Команды меню CorelDRAW 12

В этой главе приводится описание всех команд основного меню программы
CorelDRAW 12. Для тех команд, которые не рассматривались в предыдущих гла-
вах книги, здесь представлена подробная информадия, а для остальных — крат-
кая с указанием тех разделов книги, которые им посвящены. Команды распо-
ложены в том же порядке, что и в меню программы.

Команды меню File
Меню File (Файл) содержит команды, выполняющие работу с файлами до-
кументов.

П Команда New (Новый) (<Ctrl>+<N>) позволяет сформировать и открыть но-
вый документ, состоящий из одной страницы. При этом параметры вновь
формируемого документа определяются шаблоном, используемым в про-
грамме по умолчанию (см. разд. "Создание нового документа"гл. 7).

П Команда New From Template (Новый из шаблона) используется для форми-
рования нового документа на основе шаблона (шаблонного документа). Этот
шаблон выбирается пользователем из библиотек шаблонов, входящих в со-
став установочного комплекта CorelDRAW 12 (см. разд. "Создание нового до-
кумента" гл. 7).

П Команда Open (Открыть) (<Ctrl>+<O>) позволяет открыть один или не-
сколько графических документов, хранящихся в файлах, а также сформиро-
вать новый документ на основе файла шаблона (с расширением cdt), вы-
бранного на диске. В частности, открывает документы, представленные
в таких известных векторных форматах, как: AI, CDR, CDT, СМХ, ЕМН,
EPS, FH, PDF, WMF и др. (см. разд. "Открытие и сохранение документов" гл. 7).

О Команда Close (Закрыть) закрывает активный документ с выводом на экран
предупреждающего сообщения, если этот документ обрабатывался в про-
грамме после его предыдущего сохранения.
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О Команда Save (Сохранить) (<Ctrl>+<S>) предназначена для сохранения до-
кумента в том файле, из которого он открывался. В том случае, если доку-
мент сохраняется первый раз, для него будет выполняться команда Save As.

О Команда Save As (Сохранить как) (<Ctrl>+<Shift>+<S>) используется для
сохранения документа в файле, который не является исходным (имеет другое
имя или расширение либо находится в другом месте дисковой памяти ком-
пьютера) (см. разд. "Открытие и сохранение документов" гл. 7).

П Команда Revert (Вернуться) позволяет загрузить копию исходного документа,
хранящуюся в файле, на место активного, обрабатываемого в программе.
Применяется для возвращения к исходной версии документа.

О Подменю Acquire Image (Получить изображение) содержит две команды,
применяемые для работы со сканером:

• команда Select Source (Подключить источник) производит выбор драйве-
ра сканера, который необходим для его подключения к компьютеру через
стандартный интерфейс TWAIN;

• команда Acquire (Получить) позволяет подключить сканер путем загрузки
в программу его пользовательского интерфейса.

П Команда Import (Импорт) (<Ctrl>+<!>) выполняет операцию импорта, кото-
рая заключается в загрузке в активный документ информации, хранящейся
в выбранных файлах (векторных, растровых или текстовых). В одноименном
диалоговом окне производятся все требуемые настройки параметров коман-
ды (см. разд. "Импорт и экспорт информации"гл. 7).

СЗ Команда Export (Экспорт) (<Ctrl>+<E>) выполняет операцию экспорта, со-
стоящую в сохранении выбранной информации активного документа (век-
торной, растровой или текстовой) в одном из указанных файловых форматов
(см. разд. "Импорт и экспорт информации"гл. 7).

О Подменю Send To (Отправить) содержит шесть команд, предназначенных для
отправки предварительно сохраненного активного документа по адресам, за-
данным в названиях команд:

• команда Macromedia FreeHand MX открывает окно одноименной про-
граммы векторной графики (если она установлена на компьютере пользо-
вателя), загружая в нее активный документ;

• команда Адресат открывает окно программы электронной почты с целью
создания в нем нового сообщения с уже присоединенным к нему файлом
сохраненного активного документа;

• команда Мои документы позволяет сохранить файл предварительно со-
храненного активного документа в папке "Мои документы";

• команда Рабочий стол (создать ярлык) используется для сохранения фай-
ла предварительно сохраненного активного документа на диске при одно-
временном создании для него ярлыка, размещенного на рабочем столе;
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• команда Сжатая ZIP-папка создает архивный файл формата ZIP для ак-
тивного документа, помещая этот файл в папку, содержащую исходный
файл данного документа;

• команда Mail (Почта) создает растровое изображение открытой страницы
документа, после чего открывает окно программы электронной почты и
формирует в нем новое сообщение с присоединенными к нему двумя
файлами: активного документа и изображения его открытой страницы
(при получении сообщения данное изображение будет отображаться в его
тексте).

П Команда Prmt (Печать) (<Ctrl>+<P>) предназначена для настройки в одно-
именном диалоговом окне многочисленных параметров, используемых при
распечатке активного документа, а также для выполнения самого процесса
печати (см. разд. "Печать документа"гл. 7).

П Подменю Print Merge (Слияние при печати) содержит три команды, исполь-
зуемые для выполнения операции слияния информации при печати
(см. разд. "Слияние информации при печати"гл. 7}'.

• команда Create/Load Merge Fields (Создать/Загрузить поля слияния)
предназначена для запуска в работу мастера Print Merge Wizard (Мастер
слияния при печати), с помощью которого можно создать собственную
таблицу данных или загрузить такую таблицу из источника данных, под-
держивающего стандарт ODBC (Open DataBase Connectivity — Открытый
доступ к данным). После закрытия окна мастера на экране отобразится
панель инструментов Print Merge (Слияние при печати), которая исполь-
зуется для размещения в документе меток полей (их содержимое будет
выводиться при печати в режиме слияния);

• команда Perform Merge (Выполнить слияние) позволяет открыть диалого-
вое окно команды Print (Печать) и настроить в нем параметры печати,
а также выполнить операцию печати в режиме слияния информации до-
кумента с информацией, которая будет последовательно выбираться из
текущей таблицы данных и выводиться в места размещения меток полей;

• команда Edit Merge Fields (Редактировать поля слияния) используется для
запуска в работу мастера Print Merge Wizard с целью редактирования те-
кущей таблицы данных.

П Команда Print Preview (Предварительный просмотр печати) позволяет ото-
бразить на экране печатаемые страницы документа, а также настроить необ-
ходимые параметры печати (см. разд. "Печать документа" ы. 7).

П Команда Print Setup (Настройка печати) предназначена для загрузки драйве-
ра принтера, необходимого при печати документа, а также для настройки его
параметров (см. разд. "Печать документа"гл. 7).

П Команда-мастер Prepare For Service Bureau (Подготовить для сервисного
центра) позволяет выполнить все требуемые операции по подготовке доку-
мента для его передачи в сервисный центр, где он будет распечатан. Все
нужные файлы для их передачи в центр будут собраны в папке, выбранной
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пользователем. Сюда входят: исходный файл документа; графические файлы,
которые к нему относятся, файл документа в формате PDF (если было ука-
зано его создание), а также текстовый файл со служебной информацией
о документе и его разработчике.

О Подменю Publish To The Web (Публикация на Web) содержит три команды,
предназначенные для электронной публикации разработанного документа
в Интернете:

• команда HTML позволяет создать электронную версию активного доку-
мента в формате HTML, графическая информация которого может быть
сохранена в одном из трех растровых форматов, используемых в Web:
GIF, JPEG или PNG (см. разд. "Создание электронных документов" гл. 7, под-
разд. "Создание документов в формате HTML");

• команда Flash embedded in HTML (Flash, внедренный в HTML) предна-
значена для сохранения выбранной информации открытой страницы до-
кумента в файловом формате Flash (с расширением swf), а также для соз-
дания управляющего HTML-файла с целью формирования Web-страницы
(см. разд. "Создание электронных документов" гл. 7, подразд. "Создание доку-
ментов в формате HTML")',

• команда Web Image Optimizer (Оптимизатор изображения для Web) ис-
пользуется для сохранения изображения открытой страницы документа
в одном из трех растровых файловых форматов, применяемых в Web: GIF,
JPEG и PNG (PNG-8 и PNG-24). Обладает широкими возможностями по
настройке файловых параметров сохраняемой информации, обеспечивая
их оптимизацию исходя из допустимого размера файла, времени его за-
грузки по сети, а также качества сохраняемого изображения
(см. разд. "Создание электронных документов" гл. 7, подразд. "Формирование
изображения для Web ").

П Команда Publish To PDF (Публикация в формате PDF) предназначена для сохра-
нения документа в векторном файловом формате PDF, который используется
для различных видов электронных публикаций (чтение документа производится
в окне программы Adobe Acrobat Reader). В одноименном диалоговом окне вы-
полняются все требуемые настройки команды (см. разд. "Создание электронных до-
кументов" гл. 7, подразд. "Создание документа в формате PDF").

D Команда Document Info (Информация о документе) информирует пользова-
теля о различных параметрах документа, в частности, о самом документе и
его файле, графических объектах, текстовой информации, растровых изобра-
жениях, стилях, эффектах, заливках и обводках. Эта информация может быть
сохранена в текстовом файле и распечатана.

П Команда Exit (Выход) (<AH>-+-<F4>) позволяет закрыть программу с выводом
на экран предупреждающих сообщений о необходимости сохранения тех от-
крытых документов, которые обрабатывались.

О Команда Close All (Закрыть все) используется для закрытия всех открытых
документов с выводом предупреждающих сообщений о том, что требуется
сохранить те из них, которые обрабатывались.
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П Команда Export For Office (Экспортировать для офиса) сохраняет содержи-
мое документа в файле векторного формата EMF или WPG либо растрового
формата PNG. Выбор формата производится автоматически в зависимости от
заданного назначения формируемого файла, который предполагается исполь-
зовать в документе, разработанном в одном из офисных приложений
(Microsoft Word или WordPerfect Office).

П Список полных названий пяти графических документов, которые открыва-
лись в программе последними. Порядок размещения документов в списке
обратный тому, в котором они до этого открывались. Открыть выбранный
документ можно щелчком мыши на его названии.

Команды меню Edit
В меню Edit (Правка) находятся команды, которые используются для выполне-
ния различных операций редактирования объектов документа и его текстовой
информации.

П Команда Undo (Отменить) (<Ctrl>+<Z>) используется для отмены операции
по обработке объекта документа, которая выполнялась в программе послед-
ней (отменяемая операция указывается в названии команды рядом со словом
"Undo"). С ее помощью можно последовательно отменить несколько опера-
ций, которые выполнялись последними. Максимальное число таких опера-
ций указывается при настройке параметров CorelDRAW I2.

П Команда Redo (Повторно выполнить) (<Ctrl>+<Shift>+<Z>) предназначена
для повторного выполнения той операции, которая до этого была отменена
командой Undo.

П Команда Repeat (Повторить) (<Ctrl>-b<R>) повторно выполняет ту операцию
(в отношении текущего выделенного объекта), которая до этого выполнялась
последней. Название этой операции указывается в наименовании команды
рядом со словом "Repeat". Команда применяется, в частности, для выполне-
ния операций трансформации объектов, а также заливки и обводки вектор-
ных объектов.

П Команда Cut (Вырезать) (<Ctrl>+<X>) позволяет удалить из документа выде-
ленные объекты или текстовый фрагмент, помещая их при этом в буфер об-
мена Windows (clipboard) для последующего переноса в другое место доку-
мента или в иной документ.

ГЗ Команда Сору (Копировать) (<Ctrl>+<C>) предназначена для копирования
выделенных объектов или текстового фрагмента в буфер обмена Windows без
их удаления из документа.

П Команда Paste (Вставить) (<Ctrl>+<V>) вставляет в документ информацию,
которая находится в буфере обмена, куда она могла быть помещена данной
или иной программой. В том случае, если эта информация текстовая, следует
установить для ее вставки в документе текстовый курсор.

П Команда Paste Special (Специальная вставка) позволяет переместить в документ
информацию из буфера обмена, которая была там размещена с помощью
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программы, отличной от CorelDRAW 12, при работе в одном из двух режи-
мов OLE: связывания и внедрения объектов. Подключение режима OLE вы-
полняется в диалоговом окне команды (см. разд. "Механизм OLE" гл. 3).

О Команда Delete (Удалить) (<Delete>) предназначена для удаления из до-
кумента выделенных объектов без их помещения в буфер обмена Windows.

О Подменю Symbol (Символ) включает восемь команд, предназначенных для
работы с символами (см. разд. "Символы"гл. 3):

• команда New Symbol (Новый символ) формирует новый символ из выде-
ленных объектов документа;

• команда Edit Symbol (Редактировать символ) подключает режим редакти-
рования символа, потомок которого выбран в документе;

• команда Finish Editing Symbol (Закончить редактирование символа), вы-
полняет действие, указанное в ее названии;

• команда Revert to Objects (Вернуться к объектам) разрывает связь, уста-
новленную между выбранным потомком и его образующим символом;

• команда Symbol Manager (Диспетчер символов) (<Ctrl>+<F6>) управляет
открытием одноименного докера, предназначенного для работы с симво-
лами документа;

• команда Break Link (Разорвать связь) преобразует в собственные символы
документа те используемые внешние символы, хранящиеся в файле биб-
лиотеки символов (с расширением csl), потомки которых были предвари-
тельно выделены;

• команда Update From Link (Обновить через связь) обновляет связи с теми
внешними символами, потомки которых были выбраны в документе;

• команда Export Library (Экспортировать библиотеку) предназначена для
формирования файла библиотеки символов из тех символов активного
документа, потомки которых были выделены.

П Команда Duplicate (Создать копию) (<Ctrl>+<D>) используется для форми-
рования копии выделенного объекта, со смещением ее по отношению к это-
му объекту таким же образом, каким была смещена копия относительно
оригинала в предыдущем сеансе выполнения команды. Задание шага смеще-
ния для первой копии выполняется при настройке программы.

П Команда Clone (Клонировать) также позволяет создать копию выбранного
объекта. Отличается от команды Duplicate тем, что параметры сформирован-
ной копии будут определяться текущими параметрами исходного объекта
(в случае их изменения в оригинале они будут точно так же меняться и
у объекта-копии).

П Команда Copy Properties From (Копировать свойства из) используется для
передачи параметров оформления одного объекта документа другому, вы-
бранному перед выполнением команды. Параметры, которые будут копиро-
ваться, задаются в диалоговом окне команды. К ним могут относиться пара-
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метры оформления линии обводки и области заливки. После закрытия диа-
логового окна указатель примет вид жирной стрелки, которую следует под-
вести к тому объекту, параметры которого будут использованы, и щелкнуть
кнопкой мыши.

П Подменю Select All (Выделить все) содержит четыре команды:

• команда Object (Объекты) предназначена для выделения всех объектов
документа, которые находятся на текущей странице и в компоновочной
зоне;

• команда Text (Текст) выполняет те же функции относительно текстовых
объектов;

• команда Guidelines (Направляющие) позволяет выделить все направляю-
щие;

• команда Nodes (Узелки) используется для выделения всех узелков вы-
бранного контура Безье (команда выполняться не будет в том случае, если
контур Безье не выделен или выделено несколько таких контуров).

П Подменю Find and Replace (Найти и заменить) содержит пять команд, пред-
назначенных для поиска и замены в документе необходимой информации
(см. разд. "Поиск и замена информации" aii. 7)'.

• команда-мастер Find Objects (Найти объекты) находит в документе объек-
ты, отвечающие указанному критерию поиска. В качестве критерия мож-
но использовать, в частности, тип объекта и его форму, параметры залив-
ки и обводки, сформированный в объекте эффект;

• команда-мастер Replace Objects (Заменить объекты) позволяет заменить
такие параметры оформления графических и текстовых объектов доку-
мента: цвета заливки и обводки, цветовые модели, параметры оформления
линий обводки, атрибуты форматирования текста;

• команда Find Text (Найти текст) предназначена для поиска в документе
текстовых объектов, в которых встречается ключевой набор символов,
указанный пользователем, а также для поиска такого набора в текстовом
материале, в котором установлен текстовый курсор;

• команда Replace Text (Заменить текст) отличается от команды Find Text
тем, что в тексте выполняется не только поиск ключевого набора симво-
лов, но и замена его на другой набор, указанный пользователем;

• команда Recent Search (Недавний поиск) предназначена для осуществле-
ния повторного поиска клипов (образцов векторной и растровой графи-
ки), найденных ранее докером Scrapbook (Записная книжка) в библиоте-
ках клипов, хранящихся на компакт-дисках установочного комплекта
CorelDRAW 12.

П Подменю Insert Internet Object (Вставить объект Интернета) содержит один-
надцать команд, позволяющих сформировать объекты Интернета, приме-
няемые для электронных публикаций. Названия команд определяют типы
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формируемых объектов Интернета. После создания объекта в него вводятся
нужные данные с помощью команды Properties (Свойства) указанного меню.
К командам этого подменю относятся следующие: Java applet (Java-
приложение), Embedded file (Внедренный файл), Simple Button (Простая
кнопка), Submit Button (Кнопка инициации), Reset Button (Кнопка сброса),
Radio Button (Переключатель), Check Box (Флажок), Text Edit Field (Текстовое
поле с редактированием), Text Edit Box (Текстовая рамка с редактированием),
Popup Menu (Всплывающее меню) и Options List (Список параметров).

П Команда Insert Barcode (Вставить новый штрих-код) создает и вставляет
в документ штрих-код, используемый для кодирования параметров образцов
товаров при их продаже в торговой сети.

П Команда Insert New Object (Вставить новый объект) предназначена для
вставки с помощью механизма OLE (связывания и внедрения объектов)
в документ объекта, сформированного в другом приложении. Позволяет
сформировать новый OLE-объект с внедрением его в тело документа, а так-
же вставить существующий объект, хранящийся в выбранном в файле, при
его внедрении в документ или установлении с ним связи (см. разд. "Механизм
OLE" гл. 3).

П Команда Links (Связи) позволяет выполнять различные операции со связями,
которые установлены между документом и объектом OLE, хранящимся
в файле. Используется, в частности, для обновления связей, их изменения и
разрыва (см. разд. "Механизм OLE" гл. 3).

О Команда Properties (Свойства) (<AIt>+<Enter>) открывает докер Object
Properties (Свойства объекта) с целью задания и отображения в нем всех па-
раметров выделенного объекта. Данный докер содержит несколько вкладок,
на которых параметры сгруппированы по функциональному признаку. Тип
обрабатываемого объекта определяет число этих вкладок и их содержимое.

П Команда Overprint Outline (Печать обводки с наложением) подключает режим
печати с наложением (без выбивки) фонового объекта в области заливки
верхнего объекта.

П Команда Overprint Fill (Печать заливки с наложением) подключает режим
печати с наложением фонового объекта в области обводки верхнего объекта.

П Подменю Object (Объект) содержит три команды, с помощью которых мож-
но обрабатывать выделенный объект OLE (см. разд. "Механизм OLE" гл. 3):

• команда Изменить позволяет переместить в окно CorelDRAW 12 инстру-
менты той программы, в которой формировался объект OLE, для его ре-
дактирования;

• команда Открыть отличается от предыдущей тем, что OLE-объект загру-
жается в отдельное окно программы, в котором он был сформирован;

• команда Преобразовать используется для преобразования типа объекта
OLE и отображения его в документе в виде пиктограммы.
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Команды меню View
В меню View (Вид) находятся команды, которые управляют отображением на
экране содержимого активного документа и линий разметки (направляющих и
сетки), а также команды, которые используются для работы с этими линиями.

П Команда Simple Wireframe (Упрощенный каркас) подключает одноименный
режим отображения объектов документа. При этом на экран выводится ми-
нимальный объем графической информации и обеспечивается максимальная
скорость ее перерисовки (объекты принимают вид контуров черного цвета
без отображения в них тех составных частей, которые появились в результате
формирования некоторых эффектов).

О Команда Wireframe (Каркас) активизирует одноименный режим отображения
объектов документа. При этом на экран выводится больше графической ин-
формации, чем при работе в режиме Simple Wireframe (Упрощенный каркас)
(объекты и их составные части принимают вид контуров черного цвета).

CJ Команда Draft (Черновик) позволяет задать одноименный режим отображе-
ния объектов документа. При этом на экран выводится больше графической
информации, чем при работе в режиме Wireframe (Каркас) (объекты пред-
ставлены в цвете, однако векторные объекты с заливками различных типов
принимают вид объектов с равномерными заливками).

3 Команда Normal (Обычный) предназначена .для активизации одноименного
режима отображения объектов документа. При этом на экран выводится
больше графической информации, чем при работе в режиме Draft (Черновик)
(объекты представлены в цвете, однако не отображаются узоры PostScript,
которыми выполнена заливка векторных объектов).

П Команда Enhanced (Улучшенный) используется для подключения одноимен-
ного режима отображения объектов документа. При этом на экран выводится
максимальный объем графической информации при минимальной скорости
ее перерисовки (качество отображения графической информации будет са-
мым высоким).

О Команда Full-Screen Preview (Полноэкранный просмотр) (<F9>) удаляет
с экрана все элементы интерфейса, отображая на весь экран те объекты, ко-
торые размещались в рабочем окне документа перед использованием коман-
ды. Чтобы возвратиться в обычный режим отображения, следует нажать бы-
струю клавишу команды <F9> или клавишу <Esc>.

П Команда Preview Selected Only (Полноэкранный просмотр выделенного)
управляет режимом отображения только выделенных объектов при переходе
в режим полноэкранного просмотра (с помощью команды Full-Screen Preview).

П Команда Page Sorter View (Вид сортировщика страниц) подключает режим
сортировки страниц документа, предназначенный для манипуляции этими
страницами в интерактивном режиме, а также для изменения их размеров
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и ориентации с помощью панели свойств (см. разд. "Манипуляция страни-
цами" гл. 7).

П Команда Rulers (Линейки) управляет режимом отображения на экране изме-
рительных линеек (чтобы активизировать данный режим, необходимо уста-
новить галочку слева от названия команды).

О Команда Grid (Сетка) позволяет подключить режим отображения сетки.

П Команда Guidelines (Направляющие) предназначена для активизации режима
отображения направляющих, которые находятся в документе или будут соз-
даваться в будущем.

П Подменю Show (Показать) содержит пять команд, управляющих режимами
отображения служебной информации и вспомогательных элементов интер-
фейса программы, указываемых в их названиях. К этим командам относятся
такие: Page Border (Границы страницы), Bleed (Линия обрезки), Printable
Area (Печатаемая область), Overprinted Objects (Объекты с печатью поверх) и
Text Frames (Текстовые рамки).

П Команда Enable Rollover (Активизировать интерактивность) позволяет под-
ключить в активном документе режим имитации воздействия мыши на об-
ласти срабатывания, предназначенные для работы в будущем электронном
документе с целью создания эффекта интерактивности.

О Команда Snap To Grid (Привязать к сетке) (<Ctrl>+<Y>) управляет режимом
привязки перемещаемого объекта к линиям сетки.

П Команда Snap To Guidelines (Привязать к направляющим) управляет режи-
мом привязки перемешаемого объекта к направляющим.

П Команда Snap To Objects (Привязать к объектам) (<Alt>+<Z>) управляет ре-
жимом привязки перемещаемого объекта к другим объектам документа.

П Команда Grid and Ruler Setup (Настройка сетки и линейки) открывает диа-
логовое окно Options (Параметры) на вкладке Document > Grid (Доку-
мент > Сетка) с параметрами настройки сетки.

О Команда Guidelines Setup (Настройка направляющих) открывает окно Options
на вкладке Document > Guidelines (Документ > Направляющие) с параметрами
настройки направляющих.

П Команда Snap to Objects Setup (Настройка привязки к объектам) открывает
окно ^Options на вкладке Workspace > Snap to Objects (Рабочая область >
Привязать к объектам) с параметрами режима привязки к объектам.

П Команда Dynamic Guides (Динамические направляющие) (<Alt>+<Shift>+<D>)
управляет режимом работы с динамическими направляющими.

О Команда Dynamic Guides Setup (Настройка динамических направляющих)
открывает диалоговое окно Options (Параметры) на вкладке Workspace >
Dynamic Guides (Рабочая область > Динамические направляющие) с парамет-
рами настройки динамических направляющих.
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Команды меню Layout
Меню Layout (Макет) содержит команды, позволяющие манипулировать стра-
ницами документа и настраивать их параметры.

О Команды: Insert Page (Вставить страницу), Delete Page (Удалить страницу),
Rename Page (Переименовать страницу), Go To Page (Перейти на страницу)
и Switch Page Orientation (Поменять ориентацию страницы) выполняют функ-
ции, соответствующие их названиям (см. разд. "Манипуляция страницами"гл. 7).

О Команда Page Setup (Настройка страницы) открывает диалоговое окно
Options (Параметры) на вкладке Document > Page»Size (Документ *
Страница > Размер), на которой задаются параметры активной страницы до-
кумента. Выбранные параметры страницы будут применяться в программе по
умолчанию при формировании новых документов в том случае, если перед
закрытием окна установить флажок Page options (Параметры страницы) на
вкладке Document (Документ).

О Команда Page Background (Фон страницы) используется для открытия диа-
логового окна Options на вкладке Document > Page > Background (Доку-
мент > Страница > Фон), на которой указываются параметры фонового изо-
бражения для страниц документа. Таким изображением может быть
равномерная заливка заданного цвета или мозаичный узор, создаваемый
программой из изображения, хранящегося в выбранном файле.

Команды меню Arrange
В меню Arrange (Расположить) представлены команды, выполняющие транс-
формацию и перемещение объектов документа.

О Подменю Transformations (Трансформации) содержит пять команд, позво-
ляющих выполнять различные операции трансформации (относительно вы-
деленного объекта или его сформированной копии) с помощью докера
Transformation (Трансформация) с пятью вкладками (см. разд. "Трансформация
объектов" гл. 4):

• команда Position (Положение) (<Alt>+<F7>) открывает докер Transformation
(Трансформация) на вкладке Position, допускающей выполнение операции
перемещения выделенного объекта или его созданной копии;

• команда Rotate (Поворот) (<AIt>+<F8>) открывает докер Transformation
на вкладке Rotate, которая допускает выполнение операции поворота вы-
бранного объекта или его сформированной копии;

• команда Scale (Масштаб) (<Alt>+<F9>) открывает докер Transformation на
вкладке Scale and Mirror (Масштаб и зеркальный разворот), допускающей
выполнение операций масштабирования и зеркальных разворотов выде-
ленного объекта или его созданной копии;

• команда Size (Размер) (<Alt>+<F10>) открывает докер Transformation на
вкладке Size, которая допускает выполнение операции изменения разме-
ров выбранного объекта или его сформированной копии;
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• команда Skew (Наклон) открывает докер Transformation на вкладке Skew,
допускающей выполнение операции наклона выделенного объекта или
его созданной копии.

О Команда Clear Transformations (Отменить трансформации) предназначена для
отмены любой трансформации выбранного объекта, независимо от того, был
ли объект трансформирован командой меню или с помощью инструмента
Pick (Выбор) и маркеров.

П Подменю Align and Distribute (Выровнять и распределить) включает следую-
щие десять команд, предназначенных для выравнивания и распределения
выделенных объектов: Align Left (Выровнять слева) (<L>); Align Right (Вы-
ровнять справа) (<R>); Align Top (Выровнять сверху) (<Т>); Align Bottom
(Выровнять снизу) (<В>); Align Centers Horizontally (Выровнять центры по
горизонтали) (<Е>); Align Centers Vertically (Выровнять центры по вертикали)
(<С>); Center to Page (По центру страницы) (<Р>); Center to Page
Horizontally (По центральной горизонтали страницы); Center to Page
Vertically (По центральной вертикали страницы); Align and Distribute (Выров-
нять и распределить) (см. разд. "Перемещение объектов"гл. 7).

П Подменю Order (Упорядочить) содержит семь команд, позволяющих менять
порядок пакетирования объектов по толщине активного слоя документа
в соответствии с их названиями. К этим командам относятся: То Front
(Вверх) (<Shift>+<PgUp>), To Back (Вниз) (<Shift>+<PgDn>), Forward One
(На один вперед) (<Ctrl>+<PgUp>), Back One (На один назад) (<Ctrl>+<PgDn>),
In Front Of (Перед), Behind (Сзади) и Reverse Order (Обратный порядок). По-
следняя команда может использоваться лишь по отношению к группе выде-
ленных объектов.

П Команда Group (Сгруппировать) (<Ctrl>+<G>) предназначена для объедине-
ния нескольких выделенных объектов в групповой объект.

П Команда Ungroup (Разгруппировать) (<Ctrl>+<U>) используется для выпол-
нения обратного действия. Если при создании группового объекта применя-
лись вложенные уровни группировки исходных объектов, то после выполне-
ния этой команды групповой объект будет разбит на подгруппы.

П Команда Ungroup All (Разгруппировать все) отличается от предыдущей тем,
что групповой объект, содержащий несколько уровней вложений, будет раз-
бит на исходные объекты, из которых он был создан.

П Команда Combine (Скомбинировать) (<Ctrl>+<L>) позволяет создать из не-
скольких выделенных векторных объектов один, обладающий следующими
свойствами: те области, в которых четное число исходных объектов наклады-
валось друг на друга, становятся прозрачными, при этом раскраска результи-
рующего объекта совпадает с раскраской самого нижнего из исходных.
Используется для обработки как векторных графических объектов, так и об-
разцов художественного текста (см. разд. "Объединение объектов"гл. 4).

О Команда Break Apart (Разъединить) (<Ctrl>+<K>) предназначена для разбив-
ки выбранного объекта произвольного типа (векторного, растрового, тексте-
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вого или комбинированного) на отдельные составные объекты. Для этого ис-
ходный объект должен состоять из нескольких частей, имеющих различную
природу или отделенных друг от друга областями разрыва, либо быть сфор-
мированным из нескольких векторных объектов командой Combine.

П Команда Lock Object (Заблокировать объект) позволяет блокировать выпол-
нение любых операций обработки с выделенным объектом.

П Команда Unlock Object (Разблокировать объект) предназначена для отмены
установленной ранее блокировки обработки выделенного объекта.

G Команда Unlock АН Objects (Разблокировать все объекты) используется для
отмены блокировки для всех объектов, находящихся на текушей странице
документа.

П Подменю Shaping (Обработка форм) содержит семь команд, предназначен-
ных для выполнения различных операций объединения выделенных объек-
тов. К ним относятся: Weld (Слияние), Trim (Обрезка), Intersect (Пересече-
ние), Simplify (Упрощение), Front Minus Back (Передний минус задний),
Back Minus Front (Задний минус передний) и Shaping (Обработка форм). На-
значение первых шести команд определяется их названиями. Последняя ко-
манда открывает докер Shaping, позволяющий выполнить любые операции
объединения (см. разд. "Объединение объектов"гл. 4).

П Команда Convert To Curves (Преобразовать в кривые) (<Ctrl>+<Q>) предна-
значена для преобразования контура стандартной геометрической фигуры
или текстового символа в контур типа Безье, редактируемый с помощью
узелков и контрольных точек при использовании рабочего инструмента
Shape (Форма).

П Команда Convert Outline To Object (Преобразовать контур в объект)
(<Ctrl>+<Shift>+<Q>) используется для создания векторного объекта по
границам линии обводки для любого исходного векторного объекта или об-
разца художественного текста.

П Подменю Close Path (Замкнуть контур) включает четыре команды, выпол-
няющие замыкание концов выделенных разомкнутых контуров в соответст-
вии с критериями, указанными в названиях этих команд. К этим командам
относятся: Closest Nodes with Straight Lines (Ближайшие узелки прямыми ли-
ниями), Closest Nodes with Curve Lines (Ближайшие узелки кривыми линия-
ми), Start to End with Straight Lines (Начала и концы прямыми линиями) и
Start to End with Curvy Lines (Начала и концы кривыми линиями).

Команды меню Effects
Меню Effects (Эффекты) включает команды, позволяющие выполнять цветовую
и тоновую коррекцию изображений, а также создавать эффекты в объектах век-
торной графики.

О Подменю Adjust (Коррекция) содержит тринадцать команд, с помощью
которых можно выполнять цветовую и тоновую коррекцию растровых
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изображений (четыре команды из этой группы применимы и для векторных
изображений):

• команда Contrast Enhancement (Повышение контрастности) предназначена
для тоновой коррекции растровых изображений. Выполняет как общую
коррекцию всего изображения, так и коррекцию каждого из его цветовых
каналов (см. разд. "Тоновая коррекция" гл. 5)'.

• команда Local Equalization (Локальное выравнивание) используется для
тоновой коррекции растровых изображений. Подчеркивает границы кон-
трастных участков изображения, имеющих резкие переходы между свет-
лыми и темными тонами (см. разд. "Тоновая коррекция" гл. 5)',

• команда Sample/Target Balance (Исходный/Конечный баланс) предназначена
для цветовой коррекции растровых изображений. Осуществляет коррекцию
по трем базовым точкам изображения, которые выбираются пользователем
в областях теней, полутонов и светов. Используется для выполнения как
обшей коррекции всего изображения, так и коррекции в одном из его
цветовых каналов (см. разд. "Цветовая коррекция" гл. 5);

• команда Tone Curve (Тоновая кривая) используется для тоновой коррек-
ции растровых изображений. Отличие от команды Contrast Enhancement
состоит в том, что данная команда выполняет тоновую регулировку по любо-
му закону, который задается графически (см. разд. "Тоновая коррекция" гл. 5)\

• команда Aulo Equalize (Автоматически выровнять) предназначена для то-
новой коррекции растровых изображений в автоматическом режиме, ко-
гда самые темные и самые светлые пикселы изображения становятся чер-
ными и белыми, а уровни яркости остальных пикселов равномерно
перераспределяются по всему его тоновому диапазону (см. разд. "Тоновая
коррекция" гл. 5);

• команда Brightness/Contrast/Intensity (Яркость/Контрастность/Интенсивность)
(<Ctrl>+<B>) используется для тоновой коррекции растровых и вектор-
ных изображений. Коррекция выполняется с помощью трех параметров
команды, первый из которых отвечает за яркость пикселов изображения,
второй — за их контрастность, третий — также за контрастность, однако
только в светлых и темных участках изображения (см. разд. "Тоновая кор-
рекция" гл. 5)\

• команда Color Balance (Цветовой баланс) (<Ctrl>+<Shift>4-<B>) предна-
значена для цветовой коррекции растровых и векторных изображений пу-
тем регулировки в изображении цветового баланса (соотношения цвето-
вых компонентов). Производить коррекцию можно как во всем тоновом
диапазоне, так и в областях теней, полутонов и светов (см. разд. "Цветовая
коррекция" гл. 5)',

• команда Gamma (Гамма) используется для тоновой коррекции растровых
и векторных изображений путем регулировки отображения отдельных де-
талей на неконтрастных участках изображения без изменения уровней его
светлых и темных тонов (см. разд. "Тоновая коррекция" гл. 5)',
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• команда Hue/Saturation/Lightness (Оттенок/Насыщенность/Светлота)
(<Ctrl>+<Shift>+<U>) предназначена для цветовой коррекции растровых
и векторных изображений. Коррекция осуществляется как во всем цвето-
вом спектре изображения, так и в отдельных его диапазонах, которые от-
носятся к шести основным цветам цветового круга, а также к оттенкам
серого цвета (см. разд. "Цветовая коррекция"гл. 5)\

• команда Selective Color (Выборочная коррекция цвета) используется для
цветовой коррекции растровых изображений. Отличается от предыдущей
команды тем, что здесь коррекция выполняется только для отдельных
цветовых диапазонов изображения, которые относятся к базовым цветам
цветовых моделей RGB и CMYK (см. разд. "Цветовая коррекция"гл. 5);

• команда Replace Colors (Заменить цвета) предназначена для цветовой кор-
рекции растровых изображений. Выделяет участки изображения с задан-
ными цветовыми оттенками пикселов и раскрашивает их в любой другой
цвет, выбранный пользователем (см. разд. "Цветовая коррекция" гл. 5);

• команда Desaturate (Обесцветить) используется для цветовой коррекции
растровых изображений. Удаляет из изображения все цвета, представляя
его в оттенках серого цвета и сохраняя при этом его исходный цветовой
формат (см. разд. "Цветовая коррекция"гл. 5)\

• команда Channel Mixer (Смешение каналов) предназначена для цветовой
коррекции растровых изображений. Смешивает в указанных пропорциях
значения канальных яркостей пикселов исходного изображения при вы-
числении каждого из этих параметров для соответствующих пикселов ре-
зультирующего изображения (см. разд. "Цветовая коррекция"гл. 5).

П Подменю Transform (Преобразовать) включает три команды, первая из кото-
рых используется для коррекции растровых изображений, а остальные две -
для цветовой обработки изображений любых типов (см. разд. "Создание эф-
фектов" гл. 5, подразд. "Подменю Transform"):

• команда Delntcrlacc (Коррекция развертки) предназначена для формиро-
вания эффекта коррекции четных или нечетных строк пикселов растро-
вого изображения;

• команда Invert (Инвертировать) формирует эффект инверсии изображе-
ния, когда текущие значения яркости пикселов канальных изображении
заменяются на дополнительные величины;

• команда Posterize (Постеризовать) используется для формирования эф-
фекта плакатной живописи, который состоит в ограничении количества
цветовых оттенков, применяемых в изображении.

О Подменю Correction (Коррекция) содержит команду фильтрации Dust and
Scratch (Пылинки и царапины), создающую в растровых изображениях кор-
ректирующий эффект (см. разд. "Создание эффектов" гл.5, подразд. "Подменю
Correction ").

П! Команда Artistic Media (Комплект художника) управляет открытием одно-
именного докера с образцами изображений, используемых при рисовании
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тремя разновидностями рабочего инструмента Artistic Media (Комплект ху-
дожника): Preset (Фигурная кисть), Brush (Художественная кисть) и Sprayer
(Распылитель).

О Команда Blend (Переход) управляет открытием одноименного докера с пара-
метрами настройки эффекта перехода, формируемого с помощью рабочего
инструмента Interactive Blend (Интерактивный переход).

П Команда Contour (Контур) (<Ctrl>+<F9>) управляет открытием одноимен-
ного докера с параметрами настройки эффекта контура, формируемого с по-
мощью рабочего инструмента Interactive Contour (Интерактивный контур).

G Команда Envelope (Оболочка) (<Ctrl>+<F7>) управляет открытием одно-
именного докера с параметрами настройки эффекта оболочки, формируе-
мого с помощью рабочего инструмента Interactive Envelope (Интерактивная
оболочка),

G Команда Lens (Линза) (<A!t>+<F3>) управляет открытием одноименного
докера, в котором осуществляются настройки параметров формируемого эф-
фекта линзы (см. разд. "Создание эффектов" гл. 4, подразд. "Линза").

О Команда Add Perspective (Добавить перспективу) позволяет сформировать
эффект перспективы. Он состоит в имитации вида выбранного объекта, на-
блюдаемого под определенным углом в пространстве. Регулировка парамет-
ров эффекта выполняется в интерактивном режиме (см. разд. "Создание эф-
фектов" гл. 4, подразд. "Перспектива" того же разд.).

П Подменю PowerClip содержит четыре команды, с помощью которых можно
формировать и редактировать эффект PowerClip. Он позволяет отобразить
выбранные объекты произвольных типов в области объекта векторного типа
(см. разд. "Создание эффектов"гл. 4, подразд. "PowerClip"):

• команда Place Inside Container (Поместить внутрь контейнера) создает
эффект PowerClip путем вставки выделенного объекта внутрь другого объ-
екта (векторного), выбираемого с помощью мыши;

• команда Extract Contents (Извлечь содержимое) удаляет данный эффект,
восстанавливая при этом исходные объекты;

• команда Edit Contents (Редактировать содержимое) подключает режим ре-
дактирования объекта с эффектом PowerClip, допускающим перемещение
содержимого внутри контейнера;

• команда Finish Editing This Level (Завершить редактирование этого уровня)
используется для выхода из режима редактирования, который задается
предыдущей командой.

СЗ Подменю Rollover (Интерактивность) содержит четыре команды. С их помо-
щью можно формировать и редактировать интерактивные состояния, кото-
рые будут реализованы в будущем электронном документе при создании
в нем эффекта интерактивности (см. разд. "Интерактивность"гл. 3):

• команда Create Rollover (Создать интерактивность) позволяет создать
в выбранном объекте интерактивные состояния трех типов: Normal (ис-
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ходное состояние), Over (состояние, которое появляется при вводе указа-
теля в область срабатывания) и Down (состояние, которое появляется при
нажатии кнопки мыши в данной области);

• команда Extract Rollover Objects (Извлечь объекты интерактивности)
предназначена для удаления из выбранного объекта его интерактивных
состояний, когда к исходному объекту добавляются те объекты, которые
были созданы ранее для состояний Over и Down;

• команда Edit Rollover (Редактировать интерактивность) используется для
подключения режима редактирования интерактивных состояний, с помо-
щью которого можно создать и оформить дополнительные объекты для
состояний типа Over и Down;

• команда Finish Editing Rollover (Завершить редактирование интерактивно-
сти) выполняет функцию, соответствующую ее названию.

О Команда Clear Effect (Удалить эффект) применяется для удаления из объек-
тов эффекта перспективы, а также эффектов, которые были сформированы
с помощью шести интерактивных инструментов, расположенных в десятом
ряду блока инструментов программы. При выборе команды в ее названии
вместо слова "Effect" указывается наименование существующего в объекте
эффекта, который будет удален.

П Подменю Copy Effect (Копировать эффект) содержит девять команд, создан-
ных с целью переноса эффектов, указанных в названиях этих команд, из
объектов с такими эффектами на объекты без них. Элементами подменю яв-
ляются следующие команды: Perspective From (Перспективу из), Envelope
From (Оболочку из), Blend From (Переход из), Extrude From (Выдавливание
из), Contour From (Контур из), Lens From (Линзу из), PowerClip From
(PowerClip из), Drop Shadow From (Тень от объекта из) и Distortion From
(Искажение из).

О Подменю Clone Effect (Клонировать эффект) содержит четыре команды кло-
нирования эффектов, каждая из которых выполняет перенос соответствую-
щего эффекта от одного объекта (источника) к другому объекту (приемнику,!
при сохранении зависимости параметров эффекта объекта-приемника от со-
ответствующих параметров эффекта объекта-источника. К числу этих команд
относятся следующие: Blend From (Переход из), Extrude From (Выдавливание
из), Contour From (Контур из) и Drop Shadow From (Тень от объекта из).

О Команда Extrude (Выдавливание) упрашшет открытием одноименного докерл.
с параметрами настройки эффекта выдавливания, формируемого с помощью
рабочего инструмента Interactive Extrude (Интерактивное выдавливание).

Команды меню Bitmaps
В меню Bitmaps (Растровая графика) представлены команды, с помощью кото-
рых можно выполнять различные операции обработки растровых изображений,
в том числе формировать в них эффекты фильтрации.
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П Команда Convert to Bitmap (Преобразовать в растр) позволяет выполнить опе-
рацию растрирования, которая состоит в преобразовании выбранных объектов
документа (произвольных типов) в растровое изображение. Применять растри-
рование можно к объектам таких типов: векторным, растровым, текстовым и
OLE-объектам (см. разд. "Общие операции" гл. 5, подразд. "Растрирование").

П Команда Edit Bitmap (Редактировать растр) используется для запуска про-
граммы растровой графики Corel PHOTO-PAINT 12 с загрузкой в нее выде-
ленного растрового изображения документа с целью его редактирования
(см. разд. "Общие операции"гл. 5, подразд. "Обработка другими программами").

О Команда Crop Bitmap (Обрезать растр) выполняет обрезку растровой под-
ложки изображения после уменьшения размеров его видимой части с помо-
щью обтравочного контура (см, разд. "Общие операции" гл. 5, подразд. "Обрезка
изображения").

G Команда Trace Bitmap (Трассировать растр) выполняет запуск программы
трассировки CorelTRACE 12 с загрузкой в нее выбранного растрового изо-
бражения для формирования его векторной копии (см. разд. "Общие операции"
гл. 5, подразд. "Обработка другими программами").

П Команда Resample (Изменить параметры изображения) предназначена для
изменения размеров и разрешения выбранного растрового изображения
(см. разд. "Общие операции" гл. 5, подразд. "Изменение размеров и разрешения").

П Подменю Mode (Режим) содержит восемь команд, из которых первые семь
используются для преобразования цветового формата растрового изображения
в другие форматы, указанные в их названиях (см. разд. "Преобразование цветовых
форматов" гл. 5). Последняя команда выполняет цветовую коррекцию растро-
вого изображения путем применения к нему выбранного цветового профиля
(см. разд. "Общие операции"ел. 5, подразд. "Применение цветового профиля")'.

• команда Black and White (1-bit) (Черно-белый (1 бит)) преобразует цветовой
формат исходного растрового изображения в черно-белый формат, где каж-
дый пиксел может быть раскрашен только черным или белым цветом;

• команда Grayscale (8-bit) (Оттенки серого (8 бит)) преобразует цветовой
формат изображения в формат оттенков серого;

• команда Duotone (8-bit) (Дуплекс (8 бит)) используется для обесцвечива-
ния растрового изображения с последующей его раскраской оттенками от
одного до четырех цветов, выбранных пользователем (дуплексный цвето-
вой формат);

• команда Paletted (8-bit) (Палитровые (8 бит)) преобразует цветовой фор-
мат выбранного растрового изображения в табличный формат палитровых
цветов;

• команда RGB Color (24-bit) (Модель RGB (24 бита)) преобразует цветовой
формат изображения в форма]' цветовой модели RGB;

• команда Lab Color (24-bit) (Модель Lab (24 бита)) преобразует цветовой
формат изображения в формат цветовой модели Lab;
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• команда CMYK Color (32-bit) (Модель CMYK (32 бита)) преобразует цве-
товой формат изображения в формат в формат цветовой модели CMYK;

• команда Apply ICC Profile (Применить профиль ICC) выполняет функ-
цию, соответствующую ее названию.

П Подменю Inflate Bitmap (Нарастить подложку) содержит две команды, позво-
ляющие увеличить размеры растровой подложки выбранного изображения
(см. разд. "Общие операции"гл. 5, подразд. "Увеличение размеров подложки"):

• команда Auto Inflate Bitmap (Автоматически нарастить подложку) предна-
значена для автоматического увеличения размеров подложки на неболь-
шую величину при выполнении операции растрирования;

• команда Manually Inflate Bitmap (Вручную нарастить подложку) использу-
ется для увеличения размеров растровой подложки на любые значении,
задаваемые пользователем.

П Команда Bitmap Color Mask (Растровая цветовая маска) управляет открытием
одноименного докера. С его помощью можно создать и наложить на вы-
бранное растровое изображение цветовую маску, позволяющую сделать про-
зрачными или, наоборот, видимыми отдельные участки изображения с за-
данными цветовыми оттенками (см. разд. "Регулировка прозрачности" гл. 5).

П Команда Break Link (Разорвать связь) позволяет внедрить в тело документа
растровое изображение, которое хранится в отдельном файле и связано с ним.

П Команда Update From Link (Обновить связь) предназначена для обновления
в документе копии низкого разрешения для растрового изображения, кото-
рое хранится в файле и связано с документом.

П Подменю 3D Effects (Трехмерные эффекты) содержит семь команд фильтра-
ции, позволяющих формировать художественные эффекты, имитирующие
трансформацию в пространстве подложки, на которой расположено изобра-
жение (см. разд. "Создание эффектов"гл. 5, подразд. "Подменю 3D Effects").

О Подменю Art Strokes (Художественные штрихи) содержит четырнадцать ко-
манд фильтрации, позволяющих формировать художественные эффекты,
имитирующие рисование с помощью различных методов живописи и графи-
ки (см. разд. "Создание эффектов"гл. 5, подразд. "Подменю Art Strokes").

П Подменю Blur (Размытие) включает девять команд фильтрации, дозволяю-
щих формировать эффекты, которые связаны с коррекцией изображения и
его размытием (см. разд. "Создание эффектов" гл. 5, подразд. "Подменю Blur").

П Подменю Camera (Камера) содержит команду фильтрации Diffuse (Диффу-
зия), создающую в растровых изображениях корректирующий эффект
(см. разд. "Создание эффектов"гл, 5, подразд. "Подменю Camera").

П Подменю Color Transform (Преобразование цвета) включает четыре команды
фильтрации, позволяющие формировать художественные эффекты, которые
связаны с цветовой обработкой изображения (см. разд. "Создание эффектов"
гл. 5, подразд. "Подменю Color Transform").
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О Подменю Contour (Контур) содержит три команды фильтрации, с помощью
которых формируются художественные эффекты, связанные с созданием
контурного изображения (см. разд. "Создание эффектов" гл. 5, подразд. "Подменю
Contour").

G Подменю Creative (Формирование) включает четырнадцать команд фильтра-
ции, позволяющих формировать художественные эффекты, которые имити-
руют составление изображения из отдельных элементов или определенное
воздействие на него со стороны пользователя (см. разд. "Создание эффектов"
гл. 5, подразд. "Подменю Creative").

О Подменю Distort (Искажение) содержит десять команд фильтрации, позво-
ляющих формировать художественные эффекты, которые имитируют различ-
ные варианты искажения изображения (см. разд. "Создание эффектов" гл. 5,
подразд. "Подменю Distort").

П Подменю Noise (Шум) включает шесть команд фильтрации, с помощью ко-
торых формируются эффекты устранения или добавления в изображения
мелких неоднородностей в виде зерен или шума (см. разд. "Создание эффектов"
гл. 5, подразд, "Подменю Noise").

П Подменю Sharpen (Резкость) содержит пять команд фильтрации, позволяю-
щих формировать эффекты повышения в изображении резкости (см. разд.
"Создание эффектов"гл. 5, подразд. "Подменю Sharpen").

П Подменю Plug-Ins (Дополнения) включает две команды фильтрации, кото-
рые были разработаны сторонними производителями. Они сгруппированы во
вложенном подменю Digimarc (Цифровая метка) (см. разд. "Создание эффек-
тов" гл. 5, подразд. "Подменю Plug-Ins")'.

• команда фильтрации: Embed Watermark (Вставить водяной знак) позволяет
внедрить в растровое изображение водяной знак (авторский код разработ-
чика);

• команда Read Watermark (Прочитать водяной знак) используется для чте-
ния водяного знака, содержащегося в изображении.

Команды меню Text
Меню Text (Текст) содержит команды, позволяющие обрабатывать текстовую
информацию, которая представлена в документе двумя типами текста: обычным
и художественным.

П Команда Format Text (Форматировать текст) (<Ctrl>+<T>) позволяет форма-
тировать выбранные текстовые блоки или выделенный текстовый фрагмент.
Открывает диалоговое окно, которое состоит из пяти вкладок (для художест-
венного текста используются только первые две из них) и выполняет на-
стройку любых параметров форматирования, предусмотренных в программе
(см. разд. "Форматирование текста" гл. 6, подразд. "Форматирование командой
Format Text").
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О Команда Edit Text (Редактировать текст) (<CtrI>+<Shift>+<T>) предназначе-
на для редактирования текстового материала. Открывает одноименное диа-
логовое окно, в рабочем окне которого размещается выбранный текст, и да-
лее производится его обработка (см. разд. "Редактирование текста" гл. 6).

О Команда Insert Character (Вставить символ) (<CtrI>+<Fl 1>) управляет от-
крытием одноименного докера, позволяющего вставлять в текст или непо-
средственно в документ текстовые символы, хранящиеся в файлах шрифтов

П Команда Fit Text To Path (Разместить текст на дорожке) предназначена для
размещения блока обычного или художественного текста вдоль текстовой
дорожки, в качестве которой можно использовать любой векторный контур

О Команда Fit Text To Frame (Разместить текст в рамке) используется для ав-
томатического изменения кегля шрифта для блока обычного текста, разме-
щенного в текстовой рамке или на дорожке так, что текст полностью запол-
няет отведенную для него область.

П Команда Align To Baseline (Выровнять по базовой линии) (<Alt>+<F12>)
предназначена для отмены параметров форматирования текстовых символов,
связанных с их вертикальным смещением.

G Команда Straighten Text (Выровнять текст) позволяет отменить все парамет-
ры форматирования символов, которые определяют их вертикальное и гори-
зонтальное смещение, а также поворот относительно базовых линий.

П Подменю Writing Tools (Инструменты правописания) содержит шесть ко-
манд, предназначенных для редактирования текста. В диалоговых окнах пер-
вых трех команд можно выбрать язык, в котором выполняется работа с тек-
стовой информацией (см. разд. "Редактирование текста"гл. 6):

• команда Spell Check (Проверка орфографии) (<Ctrl>+<F12>) использует-
ся для обнаружения и исправления в тексте орфографических ошибок;

• команда Grammatik (Грамматика) обнаруживает и исправляет в тексте
грамматические ошибки;

• команда Thesaurus (Тезаурус) позволяет заменять в тексте слова на сино-
нимы, которые находятся в тезаурусе (словаре синонимов) программы;

• команда QuickCorrect (Быстрое исправление) используется для открытия
диалогового окна с целью настройки параметров режима автозамены, по-
зволяющего автоматически устранять опечатки в тексте и создавать раз-
личные служебные символы;

• команда Language (Язык) выполняет различные операции с библиотеками язы-
ков программы для подключения тех из них, которые необходимы при обра-
ботке в документах текстовой информации. В частности, эта команда позволяет
задать язык, используемый по умолчанию (основной язык программы);

• команда Settings (Настройки) предназначена для открытия диалогового
окна Options (Параметры) на вкладке Workspace »Text > Spelling (Рабочая
область > Текст * Правописание) с параметрами настройки режима про-
верки правописания.

20 Зак. 250
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П Команда Change Case (Изменить регистр) (<Shift>+<F3>) используется для
изменения регистра символов для выделенного текстового фрагмента в соот-
ветствии с алгоритмом, который выбран в диалоговом окне, открываемом
командой.

О Команда Make Text HTML Compatible (Сделать текст совместимым с HTML)
позволяет сохранять блоки обычного текста в виде текста (а не изображения)
при преобразовании исходного документа в электронный, имеющий формат
HTML.

О Команда Convert (Преобразовать) (<Ctrl>+<F8>) выполняет преобразование
типов текста: обычного в художественный и наоборот. Тип исходного текста
определяет ту или иную операцию преобразования, при этом соответственно
изменяется и название команды: Convert To Artistic Text (Преобразовать
в художественный текст) или Convert To Paragraph Text (Преобразовать
в обычный текст).

П Команда Text Statistics (Статистика текста) используется для предоставления
статистической информации о выбранном текстовом блоке, выделенном тек-
стовом фрагменте или обо всем тексте документа (число текстовых объектов и
их типы, количество символов, слов и строк, а также применяемые шрифты).

П Команда Show Non-Printing Characters (Показать служебные символы) вы-
полняет функцию, соответствующую ее названию.

П Команда Link (Связать) позволяет установить связи между выделенными тек-
стовыми рамками, предназначенные для перетекания текста между ними,
При этом направление такого перетекания будет обратным по отношению
к порядку выделения этих рамок (последовательными щелчками мыши) пе-'
ред выполнением данной команды.

О Команда Unlink (Удалить связь) используется для удаления текстовой связи,
установленной между двумя выбранными текстовыми рамками документа.

П Команда Encode (Кодировка) предназначена для выбора требуемой кодовой
таблицы, позволяющей правильно отобразить иностранный текст, выбран-
ный в документе.

Команды меню Tools
В меню Tools (Инструменты) представлены команды, позволяющие открывать
докеры и диалоговые окна, с помощью которых в CorelDRAW 12 можно выпол-
нять различные системные и вспомогательные операции, а также настраивать
параметры программы.

П Команда Options (Параметры) (<Ctd>+<J>) предназначена для открытия од-
ноименного диалогового окна с параметрами настройки программы на
вкладке, которая открывалась последней.

П Команда Customization (Настройка) открывает диалоговое окно Options на
вкладке Workspace > Customization (Рабочая область > Настройка) для выпол-
нения настройки панелей инструментов, команд или цветовых палитр.
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О Команда Color Management (Цветовая коррекция) используется для открытия
одноименного диалогового окна с целью выполнения настройки режима цве-
тового управления программой.

О Команда Save Settings As Default (Сохранить настройки для использования
по умолчанию) сохраняет параметры настройки текущего документа для ис-
пользования по умолчанию при работе с новыми документами.

П Команды: Object Manager (Диспетчер объектов), Object Data Manager (Дис-
петчер данных об объекте), View Manager (Диспетчер видов) (<Ctrl>+<F2>),
Link Manager (Диспетчер связей), Undo Docker (Докер отмен), Internet
Bookmark Manager (Диспетчер закладок Интернета) и Color Styles (Цветовые
стили) используются для открытия докеров, указанных в их названиях. По-
вторное выполнение любой команды приводит к удалению с экрана соответ-
ствующего докера.

О Команда Palette Editor (Редактор палитры) предназначена для открытия диа-
логового окна редактора цветовых палитр.

П Команды Graphic and Text Styles (Графические и текстовые стили)
(<Ctrl>+<F5>) управляет открытием одноименного докера.

О Подменю Create (Создать) включает три команды, позволяющие формиро-
вать векторные объекты, которые применяются в качестве образцов и шаб-
лонов (см, разд. "Создание образцов и шаблонов" гл. 4):

• команда Arrow (Стрелка) формирует наконечники для стрелок из отдель-
ных векторных объектов;

• команда Character (Символ) используется для формирования текстовых
символов, в качестве которых могут применяться только векторные объ-
екты с замкнутыми контурами;

• команда Pattern (Шаблон) предназначена для создания двухцветных и
многоцветных шаблонов для заливки.

D Команда Run Script (Запустить сценарий) позволяет открыть одноименное
диалоговое окно с целью выбора в нем файла необходимого сценария
(с расширением esc), хранящегося на диске, и его последующего воспроиз-
ведения.

П Подменю Visual Basic содержит семь команд по работе с известным прило-
жением Microsoft Visual Basic 6.3, позволяющим автоматизировать обработку
в CorelDRAW 12 объектов документа с помощью формирования и воспроиз-
ведения макрокоманд (macros). В подменю входят следующие команды: Play
(Воспроизвести), Record (Записать), Pause (Приостановить), Stop (Остано-
вить), Visual Basic Editor (Редактор Visual Basic) (<Alt>+<Fll>), Security
(Безопасность) и Add-in Manager (Диспетчер дополнений). Функции команд
соответствуют их названиям. Кроме того, здесь также находится вложенное
подменю Add-ins (Дополнения), обеспечивающее доступ к дополнительным
программным модулям по работе с Visual Basic при условии их подключения
к данной программе.
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П Подменю Scrapbook (Записная книжка) содержит три команды, используе-
мые для открытия одноименного докера с тремя вкладками и активизации
различных режимов работы в нем:

• команда Browse (Просмотр) открывает одноименную вкладку докера
Scrapbook, на которой производится просмотр содержимого библиотек
клипов (образцов векторной и растровой графики), хранящихся на компакт-
дисках установочного комплекта CorelDRAW 12, с целью выбора клипов
для их загрузки в активный документ;

• команда Contents on the Web (Содержимое на Web) открывает одноимен-
ную вкладку докера Scrapbook, на которой производится выход в Интер-
нет с целью поиска там необходимых файлов;

• команда Search (Поиск) открывает одноименную вкладку докера
Scrapbook с целью поиска по заданным ключевым словам требуемых кли-
пов в библиотеках, хранящихся на компакт-дисках CorelDRAW 12.

Команды меню Window
Меню Window (Окно) включает команды, управляющие отображением на экра-
не открытых документов, цветовых палитр, докеров и панелей инструментов
программы.

П Команда New Window (Новое окно) предназначена для открытия еще одного
рабочего окна для активного документа, где можно установить новые пара-
метры отображения документа на экране: открытую страницу, масштаб и
размещение документа в окне.

П Команда Cascade (Каскадом) используется для размещения одинаковых по раз-
меру рабочих окон открытых документов друг на друге с небольшим смещением
вниз и вправо, Таким образом, в любой момент можно выбрать необходимое ок-
но и сделать его активным с помощью щелчка мыши на видимом участке.

П Команда Tile Horizontally (Сверху вниз) позволяет расположить открытые
документы друг под другом. При этом каждое из рабочих окон документов
занимает все свободное пространство окна программы по горизонтали.

П Команда Tile Vertically (Слева направо) выполняет размещение документов
рядом друг с другом, полностью разворачивая их по вертикали.

О Команда Arrange Icons (Упорядочить значки) предназначена для расположе-
ния свернутых окон открытых документов в левом нижнем углу рабочей об-
ласти интерфейса программы.

П Подменю Color Palettes (Цветовые палитры) включает команды по управле-
нию выводом на экран цветовых палитр. Выполнение любой команды при-
ведет к открытию соответствующей цветовой палитры, если до этого она не
была отображена на экране, либо к ее закрытию. Для открытой палитры сле-
ва от ее названия имеется галочка:

• команда None (Отсутствуют) позволяет удалить с экрана все цветовые па-
литры;
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• пятнадцать команд, предназначенных для открытия или закрытия цвето-
вых палитр, которые указаны в их названиях;

• команда Open Palette (Открыть палитру) используется для открытия фай-
ла цветовой палитры (с расширением cpl), размешенного в любом месте
дисковой памяти компьютера;

• команда Color Palette Browser (Просмотр цветовых палитр) позволяет от-
крыть одноименный докер, применяемый для загрузки палитры, которая
входит в состав библиотеки цветовых палитр графического пакета
CorelDRAW Graphic Suite 12;

• команда Create Palette From Selection (Создать палитру из выделенного)
формирует новую цветовую палитру из выделенных объектов активного
документа;

• команда Create Palette From Document (Создать палитру из документа)
предназначена для формирования новой цветовой палитры из всех объек-
тов документа;

• команда Palette Editor (Редактор палитры) открывает диалоговое окно ре-
дактора цветовых палитр, позволяющего отредактировать любую цветовую
палитру программы;

• три команды, используемые для открытия или закрытия цветовых палитр,
которые указаны в их названиях.

П Подменю Dockers (Докеры) содержит команды, с помощью которых можно
открыть 23 докера CorelDRAW 12 (все докеры программы, за исключением
Insert Character (Вставить символ)). Названия команд совпадают с наимено-
ваниями открываемых докеров. Повторное выполнение команды приведет
к удалению соответствующего докера с экрана.

П Подменю Toolbars (Панели инструментов) включает 13 команд, управляющих
открытием следующих элементов интерфейса программы: блока инструмен-
тов (Toolbox), строки основного меню (Menu Bar), строки состояния (Status
Ваг) и панелей инструментов (двух основных и восьми дополнительных).

О Команда Close (Закрыть) позволяет закрыть активный документ, предвари-
тельно выводя на экран предупреждающее сообщение о необходимости его
сохранения при условии его обработки в программе.

G Команда Close All (Закрыть все) предназначена для закрытия всех открытых
документов с выводом предупреждающих сообщений о том, что требуется
сохранить те из них, которые обрабатывались.

П Команда Refresh Window (Обновить окно) (<Ctrl>+<W>) используется для
очистки области обработки рабочего окна документа от всякого "мусора", ко-
торый иногда остается на экране при перерисовке обрабатываемых объектов.

П Список названий открытых документов (с указанием номеров окон, в кото-
рых они находятся) с пометкой активного документа. При щелчке кнопкой
мыши на названии любого открытого документа он становится активным.
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Команды меню Help
В меню Help (Помощь) представлены команды, предназначенные для работы со
справочной системой программы CorelDRAW 12, а также для предоставления
пользователю различной помощи.

П Команда Help Topics (Справочная система) (<F1>) позволяет открыть на эк-
ране диалоговое окно справочной системы CorelDRAW 12 (см. разд. "Справоч-
ная система"гл. 2).

П Команда CorelTUTOR (Учебник по CorelDRAW) используется для открытия
окна Web-обозревателя, применяемого на компьютере по умолчанию, и за-
грузки в него электронного учебника, где предоставлена основная информа-
ция о программе CorelDRAW 12.

П Команда What's New? (Что нового?) позволяет вывести на экран информаци-
онное окно, в котором описываются новые возможности CorelDRAW 12, от-
сутствующие в предыдущей версии программы.

П Команда Technical Support (Техническая помощь) предназначена для откры-
тия окна справочной системы с информацией, с помощью которой можно
получить требуемую техническую помощь по работе в программе.

П Подменю Corel on the Web (Corel в Web) содержит пять команд, которые по-
зволяют получить через Интернет требуемую справочную информацию.

П Команда Working with Office (Работа с офисом) открывает раздел справочной
системы CorelDRAW 12, посвященный совместной работе данной программы
с офисными приложениями Microsoft Word и WordPerfect Office.

О Команда About CorelDRAW (О программе CorelDRAW) предоставляет общую
информацию о программе CorelDRAW 12.



Глава 10

Дополнительные программы

В состав пакета графических программ CorelDRAW Graphic Suite 12 входят две
основные графические программы: CorelDRAW 12 и Corel PHOTO-PAINT 12,
а также ряд дополнительных программ, выполняющих достаточно узкие, но
весьма важные функции, связанные с разработкой графических документов.

Наибольший интерес представляют следующие три дополнительные программы,
которые будут рассмотрены в этой главе:

О Corel R.A.V.E. 3.0 — программа анимации, предназначенная для создания
видеоклипов;

П CorelTRACE 12 — программа трассировки растровых изображений;

П Corel CAPTURE 12— программа-фотограф, используемая для съемки изо-
бражений с экрана монитора.

Программа анимации Corel R.A.V.E. 3.0
Corel R.A.V.E. 3.0 входит в состав графического пакета CorelDRAW Graphic
Suite 12 в качестве дополнительной программы. Она предназначена для разра-
ботки видеоклипов с целью их вставки в различные электронные документы,
а также для самостоятельной публикации.

Рассматриваемая программа обладает следующими возможностями по разработ-
ке видеоклипов:

О наличие почти всех рабочих инструментов и команд программы
CorelDRAW 12, что обеспечивает практически такие же широкие возможно-
сти обработки объектов анимационного документа, как и в указанной про-
грамме (порядок обработки статической информации в Corel R.A.V.E. 3.0 тот
же, что и в CorelDRAW 12);

П формирование анимационных эффектов в любых векторных, растровых и тек-
стовых объектах, которые могут быть созданы или импортированы в документ;

П импорт в документ готовых видеоклипов, хранящихся в файлах форматов
GIF, A V I и MOV;
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П создание интерактивных эффектов путем формирования в объектах докумен-
та интерактивных состояний таким же образом, как в CorelDRAW 12
(см. разд. "Интерактивность" гл. 3)\

П формирование звуковых эффектов путем импорта в документ аудиофайлов,
которые могут быть подключены как непосредственно к кадрам временной
диаграммы документа, так и к интерактивным состояниям, созданным в объ-
ектах документа;

О независимая обработка объектов документа в отдельных кадрах, выбранных
пользователем в качестве ключевых;

П плавное изменение в промежуточных кадрах, расположенных между двумя
ключевыми кадрами, следующих параметров объекта:

• координат, что позволяет создавать эффект движущегося объекта по лю-
бой заданной траектории;

• параметров масштабирования, поворота и наклона объекта;

• формы объекта векторной графики;

• толщины и цвета раскраски линии обводки контура векторного объекта;

• цвета равномерной заливки объекта;

• параметров градиентной заливки для заданного типа градиента;

• цветов градиентной заливки по сетке;

• параметров прозрачности областей заливки и обводки объекта при равно-
мерной или градиентной регулировке прозрачности;

• параметров имеющегося в векторном объекте одного эффекта, относя-
щегося к одному из девяти эффектов векторной графики, предусмотрен-
ных в CorelDRAW 12 и Corel R.A.V.E. 3.0: переход, контур, искажение,
оболочка, выдавливание, тень, линза, перспектива и PowerClip;

П вращение объекта (в плоскости документа) относительно геометрического
центра объекта;

G имитация вращения в пространстве векторного объекта с эффектом выдавливания;

П организация управления динамическими процессами в анимационном доку-
менте следующими двумя способами:

• присвоением любому выбранному кадру документа или интерактивному со-
стоянию некоторого объекта заданного набора командных действий, вхо-
дящих в состав 11 стандартных действий, предусмотренных в протрамме;

• вставкой гиперссылок в объекты документа;

G регулировка частоты, размеров и разрешения кадров результирующего ви-
деоклипа;

П сохранение результирующих видеоклипов в файлах следующих четырех фор-
матов: векторном Flash, растровом GIF и двух видеоформатов: AVI и MOV,
из которых только формат Flash поддерживает интерактивность и звук;

О формирование анимационной Web-страницы, состоящей из двух файлов:
управляющего файла формата HTML и файла видеоклипа формата Flash;
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О удобство эксплуатации Corel R.A.V.E. 3.0, которое заключается в простоте
обработки содержимого документа, а также создания в нем анимационных,
интерактивных и звуковых эффектов.

Анимационные возможности программы базируются на использовании в ней
следующих трех принципов разработки видеоклипов: аддитивности, раскадров-
ки и плоского морфинга.

Аддитивность выражена здесь в независимой обработке объектов документа, для
каждого из которых решаются две задачи:

П задается последовательный набор кадров, в которых объект будет отобра-
жаться на экране, представляемый на временной диаграмме документа инди-
катором видимости объекта;

П выбираются ключевые кадры, для которых выполняется обработка объекта
в рабочем окне документа.

Раскадровка (tweening) представляет собой процесс автоматического плавного
изменения параметров выбранного объекта документа для группы промежуточ-
ных кадров, расположенных между двумя соседними ключевыми кадрами. Пло-
ский морфинг — это процесс постепенного (растянутого во времени) изменения
формы плоского векторного объекта анимационного документа.

Перечислим недостатки программы Corel R.A.V.E. 3.0, связанные с невыполне-
нием ряда функций, реализованных в известной программе создания видеокли-
пов Macromedia Flash:

О не предусмотрена работа на нескольких сценах анимационного документа,
между которыми могут происходить переходы;

О отсутствуют библиотеки стандартных интерактивных и анимационных
элементов;

О отсутствует язык разработки сценариев, позволяющий формировать любые
командные действия и присваивать их объектам и кадрам документа.

К сожалению, в Corel R.A.V.E. 3.0 существует также и ряд недоработок, которые
удалось обнаружить автору. К их числу относятся следующие:

О в ряде случаев возникают различия в характеристиках исходного анимацион-
ного документа и результирующего видеоклипа формата Flash;

О возможна потеря в клипе некоторых атрибутов оформления векторных объ-
ектов документа, в том числе и тех, которые связаны с имеющимися в объ-
ектах эффектами;

П в некоторых случаях возникают сбои в работе программы или она вообше
зависает.

Примечание

Как показала проверка, зависание программы Corel R.A.V.E. 3.0 происходит,
в частности, в режиме формирования файла видеоклипа формата Flash из до-
кумента, содержащего некоторый перемещаемый объект с эффектом линзы
типа Invert (Негатив).
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Интерфейс программы
На рис. 10.1 изображено окно программы Corel R.A.V.E. 3.0 при открытии в нем
некоторого анимационного документа.

1 i

Рис. 10.1. Окно программы Corel R.A.V.E. 3.0: 1 —системные меню;
2 — заголовок программы; 3 — строка меню; 4 — стандартная панель;
5 — панель свойств; 6 — системные кнопки; 7 — блок инструментов;

8 — область текущего кадра документа; 9 — навигатор кадров; 10 — цветовая палитра;
11 — полосы прокрутки документа; 12 — навигатор документа;

13 — диспетчер объектов (левая часть докера Timeline); 14 — область диаграммы
(правая часть докера Timeline); 15 — строка состояния программы;

16 — полосы прокрутки диаграммы

Пользовательский интерфейс Corel R.A.V.E. 3.0 очень похож на интерфейс
программы CorelDRAW 12 (см. рис. 2.2). В частности, в программе используют-
ся многие рабочие инструменты и команды CorelDRAW 12, за исключением:

G трех инструментов: Free Transform (Произвольная трансформация), Dimension
(Размер) и Interactive Connector (Интерактивный соединитель);

О меню команд Layout (Макет).

Рассмотрим основные отличия интерфейса рассматриваемой программы от ин-
терфейса CorelDRAW 12.
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В Corel RA.V.E. 3.0 рабочее окно документа используется для обработки и ото-
бражения содержимого открытого анимационного документа, а также для его
перемещения и масштабирования на экране. Этот документ, из которо "о
в дальнейшем будет сформирован файл видеоклипа, состоит из серии кадров
(аналог страниц обычного документа), имеющих одинаковые размеры и распо-
лагаемых друг на друге.

Данное окно включает следующий набор элементов: заголовок (при его непол-
ном раскрытии), область обработки, навигатор кадров, полосы прокрутки и на-
вигатор документа. Навигатор кадров, расположенный в левом нижнем углу,
представляет собой набор элементов управления, позволяющих выполнять раз-
личные операции по манипуляции кадрами активного документа. Навигатор
документа позволяет регулировать область анимационного документа, отобра-
жаемую в его рабочем окне, в том случае, если текущий кадр отображается не
полностью.

Corel R.A.V.E. 3.0 содержит следующие элементы интерфейса, отсутствующие
в CorelDRAW 12:

О докер Timeline (Временная диаграмма), предназначенный для формирования
временной диаграммы анимационного документа;

П меню Movie (Видеоклип), включающее команды обработки динамической
информации документа, к числу которых относятся:

• Movie Setup (Настройка видеоклипа) — настройка общих параметров ви-
деоклипа, включающих размеры, разрешение и частоту кадров;

• Insert Keyframe (Вставка ключевого кадра) — вставка метки ключевого
кадра на выбранном индикаторе видимости в месте расположения теку-
щего кадра;

• Delete Keyframe (Удаление ключевого кадра) ~- удаление выбранной метки
ключевого кадра;

• Create Sequence from Blend (Создание серии объектов из объекта перехо-
да) — разбивка выбранного объекта перехода на серию составных объек-
тов с расположением каждого из них в отдельном кадре;

• Create Sequence from Group (Создание серии объектов из группового объ-
екта) — разбивка выбранного группового объекта на серию составных
объектов с расположением каждого из них в отдельном кадре;

• Create Sequence from Text (Создание серии объектов из текста) — разбив-
ка выбранного образца художественного текста на отдельные текстовые
символы с расположением каждого из них в отдельном кадре;

• шесть команд, составляющих подменю Control (Управление) — управле-
ние воспроизведением анимационного документа (дублируют действие
элементов управления навигатора кадров);

• Insert Frame (Вставить кадр) — выполнение операции вставки новых кад-
ров во временную диаграмму документа;
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• Delete Frame (Удалить кадр) — выполнение операции удаления кадров из
временной диаграммы;

• Label Frame (Именовать кадр) — присвоение ярлыка выбранному кадру
диаграммы;

• Behaviors (Поведения) (<Ctrl>-H<B>) — формирование заданного набора
командных действий, относящихся к выбранному кадру временной диа-
граммы или интерактивному состоянию некоторого объекта документа;

• Loop (Зациклить) — управление зацикливанием индикатора видимости
объекта, выбранного на временной диаграмме;

• пять команд, составляющих подменю Tween (Временная диаграмма) —
управление раскадровкой выбранного индикатора видимости;

• Timeline (Временная диаграмма) — управление выводом на экран одно-
именного докера.

Докер Timeline
Докер Timeline (Временная диаграмма) расположен в нижней части окна про-
граммы Corel R.A.V.E. 3.0 (см. рис. ЮЛ). Он предназначен для выполнения раз-
личных операций с временной диаграммой анимационного документа, задаю-
щей динамические характеристики этого документа (результирующего
видеоклипа).

В левой части докера Timeline находится диспетчер объектов, выполняющий те
же функции, что и докер Object Manager (Диспетчер объектов) в CorelDRAW 12
(см. разд. "Слои" гл. 3). Правая часть докера используется для формирования
временной диаграммы, в связи с чем она называется областью диаграммы.

Временная диаграмма представляет собой набор элементов, имеющих вид гори-
зонтальных полосок черного цвета с метками внутри и на концах. Каждый та-
кой элемент относится к определенному объекту документа, а если этот объект
имеет интерактивные состояния, то — к конкретному его состоянию.

Область диаграммы разделена горизонтальными и вертикальными линиями на
строки и колонки. Строки используются для расположения элементов диаграм-
мы, а колонки соответствуют определенным кадрам документа, отображаемым
в его рабочем окне.

Положение элемента временной диаграммы в области диаграммы полностью
характеризует диапазон кадров, в которых будет отображаться (или звучать) со-
ответствующий объект документа. В связи с этим данные элементы называются
индикаторами видимости объектов, а для импортированных аудиоклипов —
индикаторами звучания.

Примечание

Индикаторы звучания располагаются всегда в самых верхних строках времен-
ной диаграммы, относящихся к так называемому звуковому слою.
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На рис. 10.2 показан вид на экране докера Timeline, содержащего временную
диаграмму некоторого анимационного документа, который рассматривается на всем
протяжении этого раздела. Этот документ, который представлен на рис. ЮЛ
в окне программы Corel R.A.V.E. 3.0, содержит пять объектов. Перечислим их
в том же порядке, как они расположены в диспетчере объектов:

П кнопка запуска воспроизведения анимационного документа, находящаяся
в правом нижнем углу области кадра (верхняя);

П кнопка останова воспроизведения документа, находящаяся под кнопкой за-
пуска;

О надпись художественного текста "RAVE 3.0", для которой вначале был создан
эффект выдавливания, а затем — эффект поворота в пространстве относи-
тельно вертикальной оси;

П преобразованная в кривые надпись художественного текста "Corel" с эффек-
том линзы типа Heat Map (Тепловая карта), перемещаемая по горизонтали
в процессе воспроизведения документа;

П фоновое растровое изображение, полностью покрывающее область кадра.

1 2 3 4 5 6 7 8 9 1 0
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Рис. 10.2. Докер Timeline

Поясним назначение элементов докера и временной диаграммы, пронумерован-
ных на рисунке (их номера указаны в квадратных скобках):

[1] — кнопка Close Docker Group, закрывающая докер Timeline;

[2] — кнопка New Layer, создающая в документе новый слой, который будет
расположен перед всеми другими слоями;

[3] — кнопка Delete, удаляющая из документа выбранный слой, если он не
единственный;

[4] — кнопка Insert Keyframe, создающая метку ключевого кадра в выбранном
месте текущего индикатора видимости;

[5] — кнопка Delete Keyframe, удаляющая выделенную метку ключевого кадра;
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[6] — кнопка Insert Frame, открывающая одноименное диалоговое окно, позво-
ляющее вставить заданное число кадров во временную диаграмму документа;

[7] — кнопка Delete Frame, открывающая одноименное диалоговое окно для
удаления определенного числа кадров из диаграммы документа;

[8] — кнопка Show Onion Skin, подключающая режим визуализации в контурах
соседних кадров;

[9] — кнопка Launch Behaviors Dialog, открывающая диалоговое окно для фор-
мирования в нем набора командных действий, присваиваемых выбранному кад-
ру или интерактивному состоянию;

[10] — селектор кадра, выбирающий кадр анимационного документа, отобра-
жаемый в его рабочем окне;

[II] — шкала кадров;

[12] — ползунок Change Timeline Zoom, регулирующий масштаб шкалы кадров;

[13] — кнопка Collapse Docker, сворачивающая докер Timeline;

[14] — метка управления, которая свидетельствует о том, что данному интер-
активному состоянию выбранного объекта документа присвоены некоторые
командные действия;

[15] — невыделенные индикаторы видимости;

[16] — выделенный индикатор видимости;

[17] — метки ключевых кадров.

Каждый элемент диаграммы может содержать метки двух типов:

3 концевые метки в форме черных кружков, которые отображают начальный и
конечный кадры индикатора видимости или звучания объекта, не имеющего
ключевых кадров (вид такого объекта остается неизменным для всего задан-
ного диапазона кадров);

О концевые и промежуточные метки в форме черных квадратиков с белыми
кружками внутри, которые отображают ключевые кадры индикатора видимо-
сти объекта (в каждом из этих кадров выполняется независимая обработка
объекта).

Примечание

В индикаторах звучания ключевые кадры отсутствуют.

Обработка динамической информации
Под обработкой динамической информации в Corel R.A.V.E. 3.0 понимается соз-
дание в документе анимационных, интерактивных и звуковых эффектов.

Создание эффектов анимации
Рассмотрим основные операции, с помощью которых создаются анимационные
эффекты.
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Общие операции обработки элементов временной диаграммы

При работе в докере Timeline (Временная диаграмма) с элементами временной
диаграммы, представляющими собой индикаторы видимости и звучания объек-
тов, вы должны руководствоваться следующими рекомендациями:

П динамические характеристики любого объекта документа определяются пре-
жде всего его состояниями в ключевых кадрах. Такие кадры формируются
в тех местах индикатора видимости объекта, в которых необходимо задать
новые значения параметров объекта, плавно изменяемые программой в про-
межуточных кадрах. Для обработки объекта в некотором его ключевом кадре
достаточно щелкнуть на метке этого кадра, после чего обработать объект
в рабочем окне документа;

П для выделения некоторого кадра анимационного документа следует щелкнуть
в соответствующем месте шкалы кадров, установив там селектор кадров;

П чтобы сформировать требуемый диапазон кадров в анимационном документе
(видеоклипе), следует отрегулировать положение в области диаграммы самой
правой концевой метки среди всех имеющихся элементов диаграммы, распо-
ложив ее в последнем кадре данного диапазона;

О для выделения на временной диаграмме документа некоторого индикатора
видимости (звучания) нужно сделать одно из двух:

• шелкнуть в любом месте данного индикатора, отличном от метки его
ключевого кадра;

• выбрать в диспетчере объектов соответствующий объект и щелкнуть на
его названии мышью;

Примечание

Изменение размера индикатора звучания приведет к соответствующему изме-
нению частотного диапазона звучания данного аудиоклипа.

П чтобы сформировать метку ключевого кадра в некотором месте индикатора
видимости (но не в его начале), необходимо выполнить одно из двух действий:

• сделать двойной щелчок в выбранном месте индикатора;

• щелкнуть в данном месте, после чего сделать щелчок на кнопке Insert
Keyframe (Вставить ключевой кадр) диспетчера объектов или выполнить
одноименную команду меню Movie (Видеоклип);

П для удаления метки ключевого кадра достаточно сделать на ней двойной
щелчок.

Создание нового индикатора видимости объекта

Порядок формирования индикатора видимости для нового объекта документа
состоит в следующем.

1. Установите селектор кадра в исходном кадре диапазона отображения кадров
будущего объекта, щелкнув в соответствующем месте шкалы кадров докера
Timeline.
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2. Выберите в диспетчере объектов докера тот слой документа, в котором дол-
жен находиться объект.

3. Сформируйте в окне документа или импортируйте требуемый объект, кото-
рый расположится над всеми другими объектами текущего слоя документа.
В результате, в текущем кадре документа сформируется индикатор видимо-
сти объекта длиной в один кадр (он будет иметь вид черного кружка).

4. Поместите указатель в область данного индикатора, нажмите кнопку мыши и
перетащите его вправо до конечного кадра из диапазона кадров отображения
объекта, после чего отпустите кнопку мыши.

Перемещение индикатора и его элементов

Любой индикатор видимости (звучания) объекта и его отдельные элементы
можно перемещать мышью по области диаграммы в горизонтальном направле-
нии. Перечислим операции, которые можно выполнять, а также получаемый
при этом результат:

О перемещение индикатора, не имеющего промежуточных ключевых кадров,
приводит к смещению всего диапазона кадров отображения (звучания) вы-
бранного объекта на временной диаграмме документа;

П перемещение концевой метки индикатора без промежуточных ключевых кад-
ров приводит к изменению всего диапазона кадров отображения (частотного
диапазона звучания) объекта;

О перемещение части индикатора, находящегося между двумя ключевыми кад-
рами приводит к изменению частичных диапазонов кадров отображения, ко-
торые относятся к соседним участкам индикатора;

П перемещение метки ключевого кадра в индикаторе с промежуточными клю-
чевыми кадрами приводит к изменению частичных диапазонов кадров ото-
бражения, относящихся к примыкающим участкам индикатора.

Копирование и удаление индикатора и его элементов

Особенность программы Corel R.A.V.E. 3.0 состоит в том, что любому объекту
анимационного документа соответствует всего один индикатор видимости (зву-
чания), задающий отдельный диапазон кадров отображения объекта. Поэтому,
чтобы сформировать несколько таких диапазонов, обеспечивающих прерыви-
стое отображение объекта при воспроизведении документа, необходимо создать
требуемое количество копий этого объекта (выключая весь его индикатор). Фак-
тически же здесь выполняется операция копирования индикатора объекта или
его элемента, а новый объект формируется при этом автоматически.

Копирование индикаторов производится через буфер обмена Windows с помо-
щью команд Сору (Копировать) и Paste (Вставить) меню Edit (Правка). Особен-
ности выполнения этой операции состоят в следующем:

П копироваться в буфер обмена будет лишь выделенный элемент индикатора;
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О для выделения всего индикатора, имеющего промежуточные ключевые кад-
ры, необходимо в диспетчере объектов выбрать соответствующий объект;

О копирование индикатора, имеющего промежуточные ключевые кадры, следу-
ет выполнять по частям (по отрезкам индикатора, соединяющим два ключе-
вых кадра), поскольку в противном случае исходные размеры этих частей
могут самопроизвольно изменяться;

О для вставки копии индикатора из буфера обмена в нужное место диаграммы
необходимо перед выполнением команды Paste установить селектор кадра
в то место, где должна находиться первая концевая метка нового индикатора;

О для удаления индикатора достаточно его выделить и нажать клавишу <Del>

Зацикливание индикатора

Под зацикливанием индикатора видимости (индикатора звучания) понимается
операция по циклическому отображению (звучанию) выбранного объекта (ау-
доклипа) во всем диапазоне кадров анимационного документа. Данная операция
применяется в тех случаях, когда в цикле воспроизведения документа необхо-
димо сформировать внутренний циклический процесс для некоторого объекта,
у которого конечный кадр индикатора расположен левее последнего кадра вре-
менной диаграммы документа.

Для зацикливания некоторого индикатора достаточно его выделить и применить
один из двух вариантов:

П выполнить команду Movie > Loop (Видеоклип > Зациклить);

П щелкнуть в диспетчере объектов на метке в виде горизонтальной стрелки,
находящейся слева от значка соответствующего объекта (см. рис. 10.2), при-
дав ей вид двух связанных дугообразных стрелок.

Перемещение и вращение объекта

Любой объект, имеющий различные координаты в соседних ключевых кадрах,
будет перемещаться по прямолинейным траекториям в процессе воспроизведе-
ния документа. Вместе с тем, вы можете задать любую траекторию движения
объекта, использовав в качестве нее произвольный векторный контур.

Порядок формирования такой траектории состоит в следующем.

1. Создайте перемещаемый объект, сформировав для него индикатор видимости
с двумя кониевыми ключевыми кадрами и задав для этих кадров исходное и
конечное положения объекта в документе.

2. Сформируйте в любом кадре документа, относящемся к диапазону кадров ото-
бражения данного объекта, векторный контур, который будет использован
в качестве направляющей для перемещения данного объекта. Чтобы этот кон-
тур отображался в тех же кадрах, что и перемещаемый объект, сформируйте
индикатор видимости такого же размера и положения, что и для объекта.

21 Зак. 250
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3. Выберите рабочий инструмент Pick (Выбор).

4. Выделите в диспетчере объектов перемещаемый объект, щелкнув на его на-
звании.

5. Выполните команду Movie > Tween > Attach To Path (Видеоклип >
Раскадровка > Прикрепить к контуру) или щелкните на кнопке Attach To
Path панели свойств. При этом указатель примет вид изогнутой стрелки,
кончик которой подведите к любому месту контура и щелкните мышью.
В результате объект будет перемещаться по траектории, совпадающей с бли-
жайшей к объекту частью этого контура.

6. Для перемещения объекта по всему контуру, к которому он прикреплен, сде-
лайте следующее. Щелкните в любом месте индикатора данного объекта, от-
личном от метки ключевого кадра, а затем — на кнопке Sets the Tween to
occur along full path панели свойств (кнопка [14] на рис. 10.3).

7. Чтобы скрыть с экрана контур, используемый в качестве направляющей, выде-
лите его щелчком мыши, после чего щелкните правой кнопкой мыши в верх-
ней ячейке (с двумя диагонапьными линиями) рабочей цветовой палитры.

В Corel R.A.V.E. 3.0 предусмотрена возможность изменения различных парамет-
ров движущегося объекта, а также создания эффекта его вращения в плоскости
документа. Все эти операции могут быть выполнены с помошью соответствую-
щих инструментов панели свойств при условии активизации инструмента Pick
(Выбор) и выбора перемещаемого объекта в диспетчере объектов.

К числу регулируемых параметров движущегося объекта относятся следующие:

О траектория его перемещения, в качестве которой может использоваться про-
извольный векторный контур;

О направление изменения цвета раскраски объекта, выбираемое в цветовом
круге;

П ускорение в перемещении объекта вдоль заданной траектории;

П ускорение в изменении цвета раскраски объекта;

П ориентация объекта вдоль траектории его перемещения;

П количество циклов вращения перемещаемого объекта относительно его гео-
метрического центра, а также направление такого вращения (по часовой
стрелке или против).

Если выбранный вами объект является векторным и в нем создан эффект вы-
давливания, имитирующий его объемность, то в этом случае ко всем предыду-
щим функциям программы добавляется еще одна — имитация вращения дан-
ного объекта в пространстве.

На рис. 10.3 представлен вид созданного документа, в котором происходит вра-
щение в пространстве образца художественного текста с эффектом выдавлива-
ния, находящегося внизу кадра. Вверху изображена панель свойств в режиме
настройки динамических параметров данного объекта.
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Рис. 10.3. Вид документа в режиме настройки динамических параметров
объемного объекта

Поясним назначение элементов управления панели свойств, доступных для ис-
пользования в данном режиме (их номера, приведенные на рисунке, указаны
в квадратных скобках):

П [1] — два поля Object(s) Position, в которых указываются координаты геомет-
рического центра выбранного объекта;

П [2] — два поля Object(s) Size, используемые для задания размеров объекта;

П [3] — кнопка X-axis, задающая режим вращения в пространстве объекта во-
круг горизонтальной оси;

G [4] — кнопка Y-axis, подключающая режим вращения в пространстве объекта
вокруг вертикальной оси (на рис. 10.3 этот режим выбран);

П [5] — кнопка Z-axis, активизирующая режим вращения объекта в плоскости
документа;

П [6] — раскрывающийся список Rotation Direction, используемый для выбора
одного из двух возможных направлений вращения объекта;

П J7] — поле Number of Rotations, в котором указывается число циклов враще-
ния объекта за время его отображения на экране;

П [8] — кнопка Direct Color Tween, задающая направление изменения цветовых
оттенков в цветовом круге по отрезку прямой между цветами раскраски объ-
екта в исходном и конечном ключевых кадрах его индикатора видимости;
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П [9] — кнопка Clockwise Color Tween, определяющая направления изменения
цветовых оттенков в цветовом круге по часовой стрелке между цветами рас-
краски объекта;

G [10] — кнопка Counterclockwise Color Tween, выбирающая направление изме-
нения цветовых оттенков против часовой стрелки;

П [11] — кнопка Object and Color Acceleration, открывающая дополнительную
панель с двумя ползунками, задающими ускорения в перемещении объекта
вдоль заданной траектории и в изменении цвета его раскраски;

П [12] — кнопка Attach To Path, предназначенная для формирования траекто-
рии перемещения объекта вдоль выбранного векторного контура;

П [13] — кнопка Detach From Path, восстанавливающая исходную прямолиней-
ную траекторию перемещения объекта путем отделения от объекта дополни-
тельного векторного контура, который до этого использовался в качестве на-
правляющей;

П [14] — кнопка Sets the Tween to occur along full path, подключающая режим
перемещения объекта по всему векторному контуру, когда для разомкнутого
контура объект в исходном и конечном кадрах будет находиться на его кон-
цах, а для замкнутого контура — в одной точке;

П [15] — кнопка Rotate all objects relative to the path, задающая режим ориента-
ции объекта вдоль траектории его перемещения;

П [16] — кнопка Copy Tween Properties, используемая для копирования пара-
метров раскадровки от другого объекта документа;

О [17] — кнопка Clear Tween, удаляющая раскадровку из индикатора видимости
выбранного объекта.

Просмотр анимации

Просмотр анимационных эффектов в Corel R.A.V.E. 3.0 производится в режиме
воспроизведения документа в его рабочем окне. Для этой цели используются
следующие средства программы:

П навигатор кадров, расположенный слева от горизонтальной полосы прокрут-
ки рабочего окна документа (см. рис. 10.1);

П команды подменю Control (Управление) меню Movie (Видеоклип).

В процессе воспроизведения документа, а также при отображении в статике его
отдельных кадров предусмотрена возможность визуализации в окне документа
нескольких соседних кадров. При этом в текущем кадре объекты отображаются
полностью (в цвете), а в предыдущих и последующих кадрах — в контурах. Ре-
жим визуализации соседних кадров удобно использовать в тех случаях, когда
необходимо проследить динамку изменения формы и положения движущегося
объекта.

Режим визуализации соседних кадров задается с помощью кнопки Show Onion
Skin диспетчера объектов (на рис. 10.2 она под номером 8), а количество ото-
бражаемых соседних кадров — с использованием двух маркеров, исходящих от
селектора кадра при включенном данном режиме.
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Создание эффектов интерактивности
Под эффектом интерактивности здесь понимается изменение вида анимацион-
ного документа (результирующего видеоклипа) или выполнение определенного
командного действия под воздействием мыши на некоторый его объект. Для
такого объекта в исходном документе формируются интерактивные состояния
трех типов:

П Normal — исходное состояние, когда в области срабатывания объекта нет
указателя мыши;

П Over — состояние, возникающее при вводе указателя в область срабатывания
(с отжатой кнопкой мыши);

О Down — состояние, возникающее при нажатии кнопки мыши в данной области.

Работа с интерактивными состояниями происходит в Corel R.A.V.E. 3.0 точно
так же, как и в программе CorelDRAW 12 (см. разд. "Интерактивность"гл. 3). Для
этой цели состояний используются следующие средства программы:

П панель инструментов Internet (Интернет);

П команда Enable Rollover (Активизировать интерактивность) меню View (Вид),
подключающая режим имитации интерактивных состояний в анимационном
исходном документе, обрабатываемом в программе;

П четыре команды подменю Rollover (Интерактивность) меню Effects (Эффек-
ты): Create Rollover (Создать интерактивность), Extract Rollover Objects (Из-
влечь объекты интерактивности), Edit Rollover (Редактировать интерактив-
ность) и Finish Editing Rollover (Завершить редактирование интерактивности).

^ Примечание

Указанные команды дублируются кнопками управления панели Internet, нахо-
дящимися в левой ее части.

В программе предусмотрены два способа тестирования интерактивных эффектов
в рабочем окне документа:

П при активизации режима просмотра интерактивных состояний документа,
что может быть выполнено командой Enable Rollover (Активизировать интер-
активность) меню View (Вид) или кнопкой Live preview of Rollovers (Про-
смотр интер активности) панели Internet;

П при выборе одного из интерактивных состояний выделенного объекта доку-
мента в списке Active Rollover State (Активное интерактивное состояние) па-
нели Internet.

Первый способ имеет преимущество перед вторым, поскольку позволяет прове-
рять интерактивные состояния сразу для всех объектов документа, тогда как
второй — только для выбранного объекта.

Эффекты интерактивности, создаваемые в Corel R.A.V.E. 3.0, поддерживаются
лишь файловым форматом Flash. Это означает, что при формировании файла
видеоклипа любого другого доступного формата (AVI, GIF или MOV) данные
эффекты будут утеряны.
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Создание звуковых эффектов
В Corel R.A.V.E. 3.0 предусмотрено создание различных звуковых эффектов,
сохраняемых в файлах видеоклипов формата Flash. Для этой цели используются
два способа:

П импорт в анимационный документ, обрабатываемый в программе, выбран-
ного файла аудиоклипа — команда Import (Импорт) меню File (Файл);

П подключение файла аудиоклипа к интерактивному состоянию типа Over или
Down, относящемуся к некоторому объекту документа — панель инструмен-
тов Internet (Интернет).

Импорт аудиоклипа в документ

Первый способ создания звуковых эффектов (импорт в документ аудиоклипов)
характеризуется следующими свойствами:

П аудиоклип представляется на временной диаграмме индикатором звучания,
доступным для перемещения и масштабирования мышью;

П положение данного индикатора на диаграмме и его длина определяют диапа-
зон кадров, в которых аудиоклип будет звучать, а относительное изменение
этой длины — соответствующее изменение частотного диапазона звучания
клипа;

О звуковые эффекты, созданные данным способом, будут реализовываться
в режиме воспроизведения документа в его рабочем окне.

Вставка аудиоклипа в интерактивное состояние

Второй способ создания звуковых эффектов (подключение аудиоклипов к интер-
активным состояниям объектов) обладает следующими свойствами:

П файл аудиоклипа, подключенный к интерактивному состоянию, может быть
лишь изменен или отключен (никакие другие операции с ним не предусмот-
рены и на временной диаграмме он не представлен);

П звуковые эффекты, созданные данным способом, могут быть проверены лишь
в режиме воспроизведения результирующего видеоклипа формата Flash.

Организация управления в документе
В новой версии программы предусмотрены гораздо более широкие возможности
упраштения динамическими процессами, чем в предыдущей версии. Раньше до-
пускалось лишь вводить в любой объект документа следующую управляющую
информацию:

П гиперссылку, представляющую собой сетевой адрес другого документа или
исполняемого файла в формате URL;

П раздел окна Web-обозревателя, в котором будет отображаться страница элек-
тронного документа, вызываемая через гиперссылку;

П форму области срабатывания, которая может совпадать с непрозрачной обла-
стью объекта или с прямоугольной областью охвата этого объекта.
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В Corel R.A.V.E. 3.0 вы можете не только выполнять указанные операции, но и
вводить в любой кадр временной диаграммы документа или в выбранное интерак-
тивное состояние объекта одно или несколько заданных командных действий,
входящих в состав 11 стандартных действий, предусмотренных в программе.

Данная операция выполняется с помощью диалогового окна Behaviors (Поведе-
ния), которое после выбора требуемого кадра или интерактивного состояния
может быть открыто двумя способами:

П кнопкой Launch Behaviors Dialog докера Timeline (на рис. 10.2 она под
номером 9);

О командой Movie > Behaviors (Видеоклип > Поведения).

На рис. 10.4 окно Behaviors изображено в режиме присвоения команды Play
интерактивному состоянию Down, относящемуся к выбранному в документе
объекту-кнопке (об этом свидетельствует дополнительная надпись в заголовке
окна). Данная команда запускает процесс воспроизведения документа. Список
Behavior, содержащий набор команд, представлен открытым, чтобы по названию
команд можно было судить об их назначении.

Behaviors (Rollover [DOWN])

Frame label name;

-Behavior; |Play

Tell Target: Stop
Goto
Load movie
Unload movie
Toggle High Quality
Stop all sounds
Show
Hide
URL

I Sound

Apply

OK Cancel Help

Рис. 10.4. Диалоговое окно Behaviors

Порядок разработки видеоклипа
1. Запустите в работу Corel R.A.V.E. 3.0.

2. Создайте новый анимационный документ, выполнив команду File > New
(Файл > Новый).
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3. С помощью команды Movie t Movie Setup (Видеоклип t Настройка видео-
клипа) настройте параметры документа, задав его размеры, разрешение и
частоту кадров.

4. Если при обработке документа предполагается использовать рабочие инст-
рументы, которые заслоняются докером Timeline (Временная диаграмма), то
отрегулируйте мышью положение верхнего края докера или периодически
сворачивайте докер с помощью кнопки, находящейся внизу слева.

5. Создайте в документе требуемое количество объектов, а также импортируй-
те в него необходимые дополнительные объекты (растровые изображения,
текстовую информацию, видеоклипы и аудиоклипы).

6. С помощью диспетчера объектов, находящегося в левой части докера
Timeline, расположите объекты в заданном порядке по толщине документа.

7. Создайте при необходимости интерактивные состояния для некоторых объек-
тов документа, используя для этого панель инструментов Internet (Интернет).

8. Для каждого объекта документа сформируйте индикатор видимости (звуча-
ния), отрегулировав его размеры и положение в области диаграммы докера
Timeline.

9. Создайте в нужных местах индикаторов метки ключевых кадров, сделав
двойной щелчок мышью в каждом из них.

10. Последовательно выбирая мышью метки ключевых кадров, сформируйте для
них состояния соответствующих объектов, обработав их в окне документа.

11. Если в документе предусмотрены интерактивные состояния, задайте режим
их тестирования, выполнив для этого команду View > Enable Rollover
(Вид > Активизировать интерактивность).

12. Просмотрите полученный результат в режиме воспроизведения анимацион-
ного документа (средняя кнопка в навигаторе кадров), если он вас не уст-
раивает, то продолжите обработку документа, в противном случае перейдите
к следующему шагу инструкции.

13. Выполните команду File > Save As (Файл ^ Сохранить), сохранив анимаци-
онный документ в файле векторного формата CLK, являющегося собствен-
ным форматом программы Corel R.A.V.E. 3.0 и допускающим последующую
обработку.

14. Сформируйте файл результирующего видеоклипа (формата Flash, GIF, AVi
или MOV) или два файла анимационной Web-страницы (форматов HTML и
Flash). В первом случае вы должны выполнить команду File > Export
(Файл > Экспорт), а во втором — команду File > Publish To The Web (Файл »
Публикация на Web).

На рис. 10.5 показаны три кадра анимационного документа, который рассмат-
ривается в данном разделе главы. Номера этих кадров отмечены селектором
кадров на шкале кадров, изображенной внизу. Как вы видите, здесь реализова-
ны два анимационных процесса: горизонтальное перемещение верхней тексто-
вой надписи и поворот в пространстве нижней надписи объемной формы.
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Рис. 10.5. Вид трех кадров анимационного документа

М Macromedia Flash Player 7

File View Control Help

Рис. 10.6. Вид результирующего видеоклипа

На рис. 10.6 изображено окно проигрывателя Flash с загруженным в него фай-
лом результирующего видеоклипа и зафиксирован момент выбора указателем
нижней кнопки, расположенной в правом нижнем углу, с целью приостановки
процесса воспроизведения клипа щелчком на ней.

Программа трассировки CorelTRACE12
CorefTRACE 12 входит в состав графического пакета CorelDRAW Graphic
Suite 12 в качестве дополнительной программы. Она предназначена для автома-
тической трассировки растровых изображений, то есть для создания их вектор-
ных копий. Загрузка исходных изображений в программу производится тремя
способами:

О открытием выбранного растрового файла;

О из документа, обрабатываемого в данный момент в CorelDRAW 12;

П в результате выполнения операции сканирования.
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По качеству формируемых векторных изображений данная программа ничем не
уступает известной программе трассировки Adobe Streamline 4.0, однако превос-
ходит ее по широте- выполняемых функций и в удобстве эксплуатации. В част-
ности, CorelTRACE 12 предоставляет пользователю восемь режимов трассиров-
ки, четыре из которых используются для создания различных художественных
эффектов (штриховки и мозаики).

Интерфейс программы
На рис. 10.7 представлено окно программы CorelTRACE 12 в процессе трасси-
ровки. Слева находится исходное растровое изображение с областью, выделен-
ной для трассировки, а справа — результирующее векторное.

е 10

Рис. 10.7. Окно программы CorelTRACE 12: 1 — системные меню;
2 — заголовки программы и документов; 3 — строка меню; 4 — стандартная панель;

5 — панель свойств; 6 — системные кнопки; 7 — блок инструментов;
8 — строка состояния; 9 — растровое изображение; 10 — векторное изображение

Интерфейс CorelTRACE 12 выглядит почти так же, как у программы векторной
графики CorelDRAW 12 (см. рис. 2.2), за исключением следующего:

П докеры и цветовые палитры отсутствуют;

П количество команд меню и рабочих инструментов намного меньше, чем
в CorelDRAW 12;
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П часть интерфейса, в котором происходит обработка и отображение информации,
называется рабочим окном документов (а не документа, как в CorelDRAW 12), по-
скольку работа здесь происходит не с одним документом, а с двумя: исход-
ным (растровым) и результирующим (векторным).

Рабочее окно документов разделено на две равные части: слева находится рас-
тровое изображение, а справа — его векторная копия. Если изображение не по-
мещается в своей половине окна, то снизу и справа от него появляются полосы
прокрутки, с помощью которых изображение можно перемещать в отведенной
для него области. При этом перемещение изображений с помощью полос про-
крутки выполняется независимо, а изменение их масштаба — синхронно.

Вверху левой половины рабочего окна, содержащей растровое изображение,
указываются размеры этого изображения (в пикселах) и его цветовой формат,
а вверху правой половины — количество векторных объектов, составляющих
трассированное изображение, По этому интегральному параметру вы сможете
оценить сложность последующей обработки результирующего векторного изо-
бражения и его файловый размер, а также проследить зависимость между пара-
метрами трассировки, задаваемыми на панели свойств, и ее качеством.

Блок инструментов
Блок инструментов CorelTRACE 12 содержит 12 рабочих инструментов, распо-
ложенных в один вертикальный ряд (см. рис. 10.7). Восемь верхних инструмен-
тов предназначены для выбора режима трассировки, а остальные четыре — для
выполнения различных операций в окне документов.

Рассмотрим рабочие инструменты программы в порядке их расположения
в блоке инструментов (сверху вниз).

Рабочий инструмент Outline (Контур) подключает одноименный режим

трассировки, который состоит в следующем. Из исходного растрового изобра-
жения формируется его векторная копия, представляющая собой сгруппирован-
ный набор областей равномерной заливки при отсутствии линий обводки. Ха-
рактеризуется всего одним параметром настройки, определяющим качество
трассировки.

Рабочий инструмент Advanced Outline (Улучшенный контур) задает одно-

именный режим трассировки, который отличается от режима Outline большим
количеством параметров настроек. Это позволяет добиться более высокого каче-
ства трассировки или меньшего файлового размера конечного изображения, чем
при использовании предыдущего режима.

Рабочий инструмент Centerline (Средняя линия) подключает одноименный

режим трассировки, который состоит в следующем. Из исходного растрового
изображения с черно-белым цветовым форматом создается векторное изображе-
ние в виде контурного рисунка черного цвета. Это изображение представляет
собой сгруппированный набор разомкнутых и замкнутых линий обводки чер-
ного цвета. Перед выполнением операции трассировки необходимо преобразовать
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текущий цветовой формат открытого растрового изображения в черно-белый
формат с помощью команды Image > Mode > Black and White (Изображение >
Режим > Черно-белый).

Рабочий инструмент Centerline Outline (Контур по средней линии) задает

одноименный режим трассировки, который состоит в следующем. Из исходного
растрового изображения с черно-белым цветовым форматом создается его век-
торная копия, представляющая собой сгруппированный набор областей заливки
черного цвета. Перед выполнением операции трассировки необходимо преобра-
зовать текущий цветовой формат открытого растрового изображения в черно-
белый формат, выполнив команду Image > Mode ^ Black and White.

Рабочий инструмент Sketch (Эскиз) подключает одноименный режим трас-

сировки, который состоит в следующем. Результирующее векторное изображе-
ние имеет вид штрихового рисунка и образуется путем нанесения определен-
ного количества слоев штриховки с заданными геометрическими параметрами.
Данное изображение представляет собой сгруппированный набор линий обводки.

Рабочий инструмент Mosaic (Мозаика) задает одноименный режим трасси-

ровки, который состоит в следующем. Трассированное изображение представля-
ется в виде мозаичного узора, составленного из цветных элементов одинаковых
размеров, имеющих форму прямоугольника, эллипса или ромба. Данное изо-
бражение является сгруппированным набором областей равномерной заливки.

Рабочий инструмент 3D Mosaic (Объемная мозаика) подключает одно-

именный режим трассировки, который отличается от режима Mosaic лишь рас-
краской мозаичных элементов, создающих иллюзию их объемности. Эти эле-.
менты могут принимать форму пирамиды, объемной плитки или двухскатной
крыши.

Рабочий инструмент Woodcut (Резьба по дереву) задает одноименный ре-

жим трассировки, который состоит в следующем. В результирующем векторном
изображении создается эффект резьбы по дереву. Это изображение представляет
собой сгруппированный набор областей равномерной заливки.

Рабочий инструмент Select (Выделение) выполняет две функции:

выделение, масштабирование и перемещение рамок областей трассировки
(красного цвета), формируемых в растровом изображении;

выделение в трассированном изображении последовательными щелчками
мыши при нажатой клавише <Shift> векторных объектов с целью:

• скрытия с экрана остальных объектов изображения (командой Hide other
objects контекстного меню) и последующего копирования оставшихся
объектов в буфер обмена Windows;

• удаления этих объектов из данного изображения, для чего следует сфор-
мировать область охвата этих объектов, выделив их узелки, после чего
нажать клавишу <Del>.
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Рабочий инструмент Zoom (Масштаб) регулирует масштаб представления

изображений на экране, используя для этого три способа:

П щелчком левой кнопки мыши — увеличение масштаба в два раза;

О щелчком правой кнопки — уменьшение масштаба в два раза;

П выделением прямоугольной области изображения (при нажатой кнопке мы-
ши) — увеличение масштаба до величины, при которой выбранный фрагмент
изображения заполняет свою половину рабочего окна документов.

Рабочий инструмент Pan (Панорама) используется для перемещения в ра-

бочем окне документов обоих изображений, частично отображаемых на экране,
путем воздействия (при нажатой кнопке мыши) на любое из них. Дублирует
действие полос прокрутки с тем лишь отличием, что обеспечивает синхронное
перемещение в окне обоих изображений.

Рабочий инструмент Draw Trace Block (Формирование области трассиров-

ки) позволяет формировать (при нажатой кнопке мыши) в растровом изображе-
нии прямоугольные рамки красного цвета, которыми очерчиваются границы
областей трассировки.

Стандартная панель
Стандартная панель инструментов предназначена для выполнения общих опера-
ций с изображениями, обрабатываемыми в CorelTRACE 12 (рис. 10.8).

100%

Рис. 10.8. Стандартная панель инструментов

Поясним назначение элементов управления данной панели (их номера, приве-
денные на рисунке, даны в квадратных скобках):

П [1J — кнопка Opens an image, используемая для открытия растрового изобра-
жения, хранящегося в выбранном файле, с целью его трассировки;

П [2] — кнопка Save Trace Result позволяет сохранить результирующее (трасси-
рованное) изображение в файле;

О [3] — кнопка Gets image from scanner, подключающая режим сканирования
изображения;

П [4] — кнопка Cut, удаляющая активные рамки областей трассировки из рас-
трового изображения;

О [5] — кнопка Copies the active vector to the Clipboard, копирующая в буфер
обмена Windows результирующее векторное изображение или его отдельные
объекты, видимые на экране;
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П [6] — раскрывающийся список Zoom Levels, позволяющий выбрать масштаб
отображения в рабочем окне исходного и результирующего изображений.
Содержит такие пункты:

• Actual Size — фактические размеры изображений;

• численные значения со знаком процента — значения масштаба изображе-
ний, заданные в процентах по отношению к единичному масштабу, при
котором размеры растрового изображения определяются фактическим
разрешением экрана (размеры векторного изображения будут такими же);

О [7] — кнопка Stop Tracing, останавливающая процесс трассировки;

П [8] — кнопка Application Launcher, открывающая дополнительную панель со
списком программ, входящих в состав графического пакета CorelDRAW
Graphic Suite 12, которые могут быть запущены в работу.

Панель свойств
Панель свойств CorelTRACE 12 содержит инструменты, предназначенные для
настройки параметров трассировки. Как и в CorelDRAW 12, эта панель обладает
свойством трансформации, изменяя свой вид и состав в зависимости от вы-
бранного режима трассировки.

Рассмотрим устройство этой панели при всех восьми режимах трассировки,
предусмотренных в программе.

Режим Outline

На рис. 10.9 показан вид панели свойств при работе в режиме трассировки
Outline (Контур).

Рис. 10.9. Панель свойств в режиме трассировки Outline

В этом режиме панель свойств содержит всего два инструмента:

СИ [1] — ползунок Accuracy, регулирующий уровень качества трассировки;

П [2) — кнопка Do Trace, запускающая операцию трассировки.

Режим Advanced Outline

На рис. 10.10 представлен вид панели свойств при работе в режиме трассировки
Advanced Outline (Улучшенный контур).

Рис. 10.10. Панель свойств в режиме трассировки Advanced Outline
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В этом режиме панель свойств содержит следующие элементы:

О [1] — раскрывающийся список Select Preset, в котором производится выбор
одного из стилей трассировки в данном режиме, представляющих собой на-
боры предварительно установленных параметров трассировки, сохраненных
под определенными именами;

П [2] — две кнопки (со знаками "+" и "-") Add/Remove Preset, верхняя из кото-
рых используется для создания нового стиля, а нижняя — для удаления вы-
бранного стиля;

П [3] — список Noise Filter, используемый для выбора режима фильтрации (по-
давления) шума в трассированном изображении;

О [4] — ползунок Complexity, регулирующий уровень проработки мелких дета-
лей в результирующем изображении (чем выше этот уровень, тем из боль-
шего числа объектов будет состоять данное изображение);

П [5] — поле (со счетчиками) Max Colors, в котором указывается максимальное
число цветов в векторном изображении;

П [6] — ползунок Node Reduction, задающий величину порога для удаления
лишних узелков из контуров векторных объектов;

П [7] — список Node Type, определяющий тип узелков векторных контуров,
формируемых в процессе трассировки;

О [8] — поле (со счетчиками) Minimum Object Size, в котором указывается ми-
нимально допустимый размер векторного объекта, который может быть соз-
дан при трассировке;

П [9] — кнопка Do Trace, запускающая операцию трассировки.

Режим Centerline

На рис. 10.11 изображен вид панели свойств при работе в режиме трассировки
Centerline (Средняя линия).

1 2 3 4 5
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Рис. 10.11. Панель свойств в режиме трассировки Centerline

В этом режиме панель свойств содержит следующие элементы:

О [I] — раскрывающийся список Select Preset, используемый для выбора стиля
трассировки в заданном режиме;

О [2] — две кнопки (со знаками "+" и "-") Add/Remove Preset, позволяющие
создать новый стиль и удалить выбранный;

П [3] — ползунок Node Reduction, регулирующий величину порога для удаления
из векторных контуров лишних узелков;
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П [4] — поле (со счетчиками) Iteration, в котором указывается число итераций,
используемых в процессе трассировки;

О [5] — кнопка Do Trace, запускающая операцию трассировки.

Режим Centerline Outline

На рис. 10.12 показан вид панели свойств при работе в режиме трассировки
Centerline Outline (Контур по средней линии).
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Рис. 10.12. Панель свойств в режиме трассировки Centerline Outline

В этом режиме панель свойств содержит следующие элементы:

О [1] — раскрывающийся список Select Preset, предназначенный для выбора
стиля трассировки в указанном режиме;

П [2| — две кнопки (со знаками "+" и "-") Add/Remove Preset, используемые
для создания нового стиля и удаления выбранного;

П [3] — ползунок Node Reduction, регулирующий величину порога для удаления
из векторных контуров лишних узелков;

П [4] — поле (со счетчиками) Iteration, в котором указывается число итераций,
используемых в процессе трассировки;

П [5] — ползунок Accuracy, задающий уровень качества трассировки;

П [6] — кнопка Do Trace, запускающая операцию трассировки.

Режим Sketch

На рис. 10.13 показан пример трассировки некоторого изображения в режиме
Sketch (Эскиз). Вверху изображена панель свойств.

В этом режиме панель свойств содержит следующие элементы:

П f t ] — раскрывающийся список Select Preset, используемый для выбора стиля
трассировки в заданном режиме;

П [2] — две кнопки (со знаками "+" и "-") Add/Remove Preset, предназначен-
ные для создания нового стиля и удаления выбранного;

П [3J — поле (со счетчиками) Line Spacing, в котором указывается величина
промежутка между соседними л и н и я м и штриховки;

П [4] — список Sketch Layers, содержащий названия слоев со штриховками,
для каждого из которых задается свой собственный набор параметров;

ГЛ [5J — две кнопки (со знаками "+" и "—") Add/Remove Layer, верхняя из кото-
рых используется для формирования нового слоя со штриховкой, а ниж-
няя — для удаления текущего слоя, выбранного в предыдущем списке;
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Рис. 10.13. Пример трассировки в режиме Sketch

П [6] — поле (со счетчиками) Layer Angle, задающее угол наклона штриховых
линий к горизонтали;

П [7] — ползунок Threshold, регулирующий пороговый уровень яркости пиксе-
лов растрового изображения, ниже которого будет выполняться трассировка;

О [8] — кнопка Do Trace, запускающая операцию трассировки.

Режим Mosaic

На рис. 10.14 представлен пример трассировки некоторого изображения в ре-
жиме Mosaic (Мозаика). Вверху изображена панель свойств.

2 3 4 5

Рис. 10.14. Пример трассировки в режиме Mosaic

В этом режиме панель свойств содержит следующие элементы:

П [1] — раскрывающийся список Select Preset, в котором производится выбор
стиля трассировки в указанном режиме;
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П [2] — две кнопки (со знаками "+" и "-") Add/Remove Preset, используемые
для создания нового стиля и удаления выбранного;

Q [3] — кнопка Rectangle, задающая прямоугольную форму элементов мозаики;

П [4J — кнопка Circle, определяющая эллиптическую форму элементов мозаики;

П [5] — кнопка Diamond, выбирающая ромбическую форму элементов мозаики;

О [6] — поле (со счетчиками) Horizontal Tiles, в котором указывается число
элементов мозаики по горизонтали;

П [7] — поле (со счетчиками) Vertical Tiles, в котором задается число элементов
мозаики по вертикали;

П [8] — кнопка Do Trace, запускающая операцию трассировки.

Режим 3D Mosaic

На рис. 10.15 показан пример трассировки некоторого изображения в режиме
3D Mosaic (Объемная мозаика). Вверху изображена панель свойств.
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Рис. 10.15. Пример трассировки в режиме 3D Mosaic

В этом режиме панель свойств содержит следующие элементы:

О [1] — раскрывающийся список Select Preset, используемый для выбора стиля
трассировки в заданном режиме;

П [2] — две кнопки (со знаками "+" и "—") Add/Remove Preset, позволяющие
создать новый стиль и удалить выбранный;

П [3] — кнопка Pyramid, задающая элементы мозаики в форме пирамиды;

П [4] — кнопка Brick, определяющая элементы мозаики в форме объемной
плитки;

П [5] — кнопка Fan, выбирающая элементы мозаики в форме двухскатной
крыши;
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О [6] — поле (со счетчиками) Horizontal Tiles, в котором указывается число
элементов мозаики по горизонтали;

П [7] — поле (со счетчиками) Vertical Tiles, в котором задается число элементов
мозаики по вертикали;

О [8] — кнопка Do Trace, запускающая операцию трассировки.

Режим Woodcut

На рис. 10.16 представлен пример трассировки некоторого изображения в ре-
жиме Woodcut (Резьба по дереву). Вверху изображена панель свойств.

1 2 3 4 5 6 7 8

Ь "5,0 '

Рис. 10.16. Пример трассировки в режиме Woodcut

В этом режиме панель свойств содержит следующие элементы:

П [1] — раскрывающийся список Select Preset, предназначенный для выбора
стиля трассировки в указанном режиме;

П [2] — две кнопки (со знаками "+" и "-") Add/Remove Preset, используемые
для создания нового стиля и удаления выбранного;

П [3] — ползунок Node Reduction, регулирующий величину порога для удаления
лишних узелков из векторных объектов результирующего изображения;

П [4] — ползунок Threshold, задающий пороговый уровень яркости пикселов
растрового изображения, ниже которого будет выполняться трассировка;

П [5] — поле (со счетчиками) Angle, в котором указывается угол наклона линий
штриховки к горизонтали;

П [6] — поле (со счетчиками) Width, определяющее толщину штриховых линий;

О [7] — кнопка Woodcut Properties, открывающая дополнительную панель
управления, на которой можно задать следующие параметры трассирован-
ного изображения:

• режим формирования цветных линий (флажок Color Woodcut);
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• режим формирования сплошных линий переменной толщины (флажок
Continuous cut);

• режим формирования линий, сужающихся к их концам (флажок Tapered
ends);

• режим инвертирования толщины линий, сформированных на первом эта-
пе трассировки (флажок Inverted);

• режим формирования линий симметричной формы (флажок Symmetric);

П [8] — кнопка Do Trace, запускающая операцию трассировки.

Порядок работы
1. Запустите в работу CorelTRACE 12.

2. Если в процессе запуска этой программы не было открыто растровое изо-
бражение, выбранное ранее для трассировки в обрабатываемом документе
CorelDRAW 12, то выполните один из двух вариантов:

• загрузите требуемое изображение из файла командой File > Open
(Файл > Открыть);

• сканируйте изображение с помощью команды File t Acquire Image >
Acquire (Файл > Получить изображение > Получить).

3. Задайте нужный режим трассировки растрового изображения, активизировав
один из первых восьми рабочих инструментов с названием данного режима.
При этом вы должны руководствоваться следующими рекомендациями:

• для выполнения обычной трассировки выберите режим Outline (Контур)
или Advanced Outline (Улучшенный контур), первому из которых следует
отдать предпочтение в случае, если у вас нет достаточного опыта или вре-
мени для настройки параметров трассировки;

• чтобы сформировать векторное изображение в виде одноцветного контур-
ного рисунка или черно-белой копии растрового изображения, задайте
в первом случае режим Centerline (Средняя линия), а во втором -
Centerline Outline (Контур по средней линии), после чего представьте ис-
ходное изображение в черно-белом цветовом формате, выполнив команду
Image l Mode > Black and White (Изображение > Режим > Черно-белый);

• для создания в результирующем изображении эффекта штриховки выбе-
рите режим трассировки Sketch (Эскиз) или Woodcut (Резьба по дереву),
а для создания эффекта мозаики — режим Mosaic (Мозаика) или 3D Mosaic
(Объемная мозаика).

4. Выберите необходимый масштаб представления изображений в рабочем окне
документов, используя для этого рабочий инструмент Zoom (Масштаб) или
список Zoom Levels (Масштабы) стандартной панели.

5. Если вам необходимо выполнить трассировку не всего изображения, а его
отдельных участков прямоугольной формы, выделите такие участки рамоч-
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ками, сформировав их рабочим инструментом Draw Trace Block (Формиро-
вание области трассировки), после чего отрегулируйте их размеры и положе-
ние рабочим инструментом Select (Выделение).

6. Для любого режима трассировки, за исключением Outline (Контур), задайте
в списке Select Preset панели свойств (он крайний слева) требуемый стиль
трассировки. Если этот стиль вас не полностью устраивает, то отрегулируйте
параметры трассировки с помощью инструментов панели свойств.

7. Запустите процесс трассировки, щелкнув на кнопке Do Trace (крайняя справа).

8. Если результирующее векторное изображение, представленное в правой час-
ти рабочего окна документов, вас не удоштетворяет, то повторите два или три
предыдущих шага инструкции. В противном случае выполните один из трех
вариантов:

• сохраните трассированное изображение в файле заданного векторного
формата, использовав для этого команду File > Save trace result
(Файл * Сохранить результат трассировки);

• скопируйте данное изображение в буфер обмена Windows для его последую-
щей вставки в графический документ, обрабатываемый в CorelDRAW 12. Для
этого выделите правую половину рабочего окна щелчком на его верхней
панели и выполните команду Edit > Сору (Правка > Копировать). Если вы
хотите перенести в буфер обмена не все векторное изображение, а неко-
торые его объекты, то перед выполнением указанной команды выделите
их инструментом Select (при нажатой клавише <Shift>), а затем скройте
с экрана остальные объекты командой Hide Other Objects (Спрятать дру-
гие объекты) контекстного меню;

• если CorelTRACE 12 запускалась из программы CorelDRAW 12 командой
Bitmaps > Trace Bitmap (Растровая графика > Трассировать растр), то пе-
ренесите трассированное изображение в исходный открытый документ
с помощью команды File > Exit (Файл > Выход, подтвердив при этом выпол-
нение данной операции.

9. Если параметры трассировки регулировались вами, при этом текущие значе-
ния этих параметров предполагается в дальнейшем использовать при обра-
ботке других изображений, то создайте новый стиль трассировки (кнопка со
знаком "+", расположенная второй слева на панели свойств).

Программа-фотограф Corel CAPTURE 12
Corel CAPTURE 12 входит в состав графического пакета CorelDRAW Graphic
Suite 12 в качестве дополнительной программы. Она предназначена для съемки
с экрана монитора, то есть для формирования растровой копии некоторой об-
ласти изображения, видимого на экране.

Программа-фотограф Corel CAPTURE 12 обладает следующими достоинствами:

П высоким качеством съемки;
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П простотой и удобством эксплуатации;

О широкими возможностями выделения областей экрана для съемки;

О наличием четырех режимов использования сформированного изображения;

• сохранение в файле;

• копирование в буфер обмена;

• вывод на печать;

• загрузка в одну из двух основных программ графического пакета
CorelDRAW Graphic Suite 12 (в CorelDRAW 12 или Corel PHOTO-
PAINT 12);

П высокой производительностью съемки (благодаря наличию режима автома-
тической нумерации файлов со снимками);

G устойчивостью работы при дефиците свободных ресурсов компьютера, в том
числе и в многозадачном режиме.

Работа с Corel CAPTURE 12 происходит в два этапа. На первом из них произво-
дится настройка различных параметров программы в ее диалоговом окне, а на
втором — собственно съемка.

Если вам необходимо сделать целую серию снимков в каком-то одном режиме
работы программы, то это можно сделать достаточно быстро с помощью горя-
чей клавиши (по умолчанию это клавиша <F7>). При этом не нужно будет тра-
тить время на раскрытие диалогового окна программы и выдачу в нем сигнала
на инициацию процесса съемки.

Параметры настройки
Все параметры настройки программы-фотографа Corel CAPTURE 12 располо-
жены на пяти вкладках ее одноименного диалогового окна, где они сгруппиро-
ваны по функциональному признаку. На рис. 10.17 это окно показано при от-
крытой первой вкладке, имеющей название Source (Источник).

Вкладка Source
Вкладка Source содержит элементы настройки, позволяющие выбрать стиль
съемки с экрана, а также режим съемки (см. рис. 10.17).

Примечание

Стиль съемки представляет собой набор предварительно заданных парамет-
ров съемки, сохраненных под определенным именем в файле.

Здесь представлены следующие элементы настройки (в порядке сверху вниз):

П раскрывающийся список Lets you choose a Capture preset, используемый для
выбора стиля съемки с экрана;
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incorel CAPTURE 12

JP Source J Щ, Activation | Щ Image

Lets you choose a Capture preset

Destination Э Options

;

Type oF Capture
1 • Window Capture

[Current window

С Menu Capture

(' Area Capture

Help Capture Close

Рис. 10.17. Вкладка Source окна Corel CAPTURE 12

О две кнопки справа от списка (со знаками "+" и "—"), первая из которых по-
зволяет создать новый стиль, а вторая — удалить выбранный;

CJ переключатель Window Capture (Съемка окна), задающий режим съемки окна
или панели. Тип конкретного объекта съемки выбирается в списке Window
Туре (Тип окна), включающем следующие пункты:

• Current window — съемка активного окна;

• Client window — съемка окна клиента, представляющего собой активное
окно без заголовка и строки меню;

• Animation — съемка окна с анимацией;

• Full screen — съемка всей области экрана монитора;

• Current object — съемка некоторой панели, выделенной указателем, без
отображения ее границ;

• Current Object with border — съемка текущей панели с границами;

• Scroll Window — съемка рабочей области окна с полосами прокрутки, но
без включения данных полос в область съемки;

П переключатель Menu Capture (Съемка меню), определяющий режим съемки
открытого меню команд. Параметры конкретного объекта съемки задаются
на дополнительной панели, открываемой кнопкой Settings (Настройка).
На этой панели находятся следующие элементы:

• флажок Cascade Menu (Каскад меню) — съемка вложенных открытых ме-
ню, отображаемых на экране;
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• флажок Include Menu (Включать меню) — включение в область съемки
строки основного меню открытого окна программы;

• флажок Replace Background (Заменить фон) — режим раскраски фонового
участка изображения в цвет, выбранный в списке образцов цветов справа;

П переключатель Area Capture (Съемка области экрана), активизирующий ре-
жим съемки выделенной пользователем области экрана. Параметры этой об-
ласти задаются с помощью следующих элементов настройки:

• раскрывающийся список Type of Area (Тип области) — выбор одной из
трех возможных форм области съемки: прямоугольная (пункт Rectangle
area), эллиптическая (Elliptical area) или многоугольная (Freehand area);

• список цветовых образцов цвета Background Color — выбор цвета раскрас-
ки той части формируемого изображения прямоугольной формы, которая
примыкает снаружи к выделенной для съемки области в форме эллипса
или многоугольника;

• флажок Show Editable Marquee — режим отображения вспомогательного
контура с маркерами, позволяющего регулировать размеры сформирован-
ной многоугольной области съемки, а также изменять ее форму.

Вкладка Activation
Вкладка Activation (Активизация) включает параметры, управляющие процессом
съемки. Здесь представлены следующие элементы настройки:

П раскрывающийся список Hot key, используемый для выбора горячей клави-
ши, инициирующей процесс съемки (по умолчанию используется функцио-
нальная клавиша <F7>);

П флажок Initial delay before first capture (1—60 sec), при установке которого
возникает задержка от момента нажатия горячей клавиши до начала съемки
или до момента формирования пользователем области съемки;

О поле (справа), в котором указывается величина этой задержки (в секундах);

П флажок Hide icon when capturing, при установке которого подключается ре-
жим удаления во время съемки значка программы Corel CAPTURE 12, нахо-
дящегося на панели задач Windows;

П флажок Show area in zoom (area capture only), при установке которого задает-
ся режим навигатора (только при съемке области экрана), который состоит
в следующем: в левом верхнем углу экрана в увеличенном виде отображается
фрагмент области съемки, формируемой пользователем;

О флажок Capture Cursor (non area captures only), при установке которого акти-
визируется режим отображения на снимке указателя мыши;

П переключатель Current cursor, при установке которого подключается режим
сохранения текущей формы указателя, отображаемой на экране;

П переключатель Use custom cursor, при установке которого задается режим
выбора формы указателя в раскрывающемся списке его образцов (справа).
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Вкладка Image
Вкладка Image (Изображение) содержит параметры, определяющие качество и
размеры формируемого растрового изображения. Здесь находятся следующие
элементы настройки:

О раскрывающийся список Туре, используемый для выбора цветового формата
изображения;

О поле (со счетчиками) Resolution, в котором указывается разрешение изобра-
жения;

О флажок Maintain aspect ratio, при установке которого подключается режим
сохранения первоначальной пропорции размеров изображения, доступных
для регулирования;

О переключатель Scale, задающий режим масштабирования изображения по
отношению к его оригиналу, отображаемому на экране;

О поля (со счетчиками) Width и Height справа от данного переключателя, в ко-
торых указываются масштабы изображения по горизонтали и вертикали
(в процентах);

О переключатель Specific size, подключающий режим задания размеров изо-
бражения в абсолютных единицах;

П поля (со счетчиками) Width и Height справа от данного переключателя, в ко-
торых указываются ширина и высота изображения в единицах измерения,
выбранных в списке справа.

Вкладка Destination
Вкладка Destination (Назначение) включает параметры, определяющие режимы
использования изображения, снятого с экрана. Здесь представлены следующие
элементы настройки:

П флажок File, при установке которого подключается режим сохранения эк-
ранного снимка в растровом файле;

П кнопка со значком изогнутой стрелки, открывающая диалоговое окно
Capture as (Снять как) для выбора в нем следующих параметров сохранения
снимков в файлах:

• папки, в которые будут помешаться файлы со снимками (список Папка
вверху и кнопка возврата на предыдущий уровень вложения справа от него);

• названия отдельного файла со снимком или постоянной части в названи-
ях серии файлов со снимками в случае использования режима автомати-
ческой нумерации (поле Имя файла);

• растрового файлового формата (список Тип файла);

• способа сжатия информации в файле (список Compression type);

• режима автоматической нумерации файлов (флажок Use automatic
naming);
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• исходного значения индексируемого трехзначного числа, которое будет
добавляться к постоянной части названия файла в режиме автомагической
нумерации (поле Start naming at);

О флажок Clipboard, при установке которого задается режим копирования
снимка в буфер обмена для его последующего использования другими при-
ложениями;

О флажок Printer, при установке которого активизируется режим распечатки
снимка;

G кнопка Setup, открывающая диалоговое окно Настройка принтера для выбора
в нем следующих параметров печати снимка:

• драйвера принтера (список Имя);

• параметров принтера (кнопка Свойства);

• формата листа бумаги (список Бумага);

• используемого лотка принтера (список Подача);

• ориентации листа бумаги (переключатели Книжная и Альбомная);

О флажок OLE automated application, при установке которого активизируется
режим автоматической загрузки сделанного снимка в программу Corel-
DRAW 12 или Corel PHOTO-PAINT 12, выбранную в списке внизу, которая
будет при этом запущена в работу.

Вкладка Options
Вкладка Options (Параметры) содержит следующие пять флажков, с помощью
которых задаются различные режимы выдачи предупреждающих сообщений:

П Notify end of capture — режим вывода на экран сообщения о завершении
операции съемки;

G Show ready to capture dialog — режим вывода на экран предупреждающего
сообщения о готовности программы выполнить съемку;

П Show warning when overwriting an existing file — режим сохранения сформиро-
ванного изображения в существующем файле;

П Show warning for scrolling window capture — режим выдачи предупреждающего
сообщения в случае обрезки снятого изображения (данный режим автору
проверить не удалось);

G Enable sounds — режим выдачи звуковых сигналов при выполнении в про-
грамме различных операций.

Порядок работы
1. Запустите в работу Corel CAPTURE 12, открыв ее одноименное диалоговое

окно на вкладке Source (Источник).
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2. Выберите в списке Lets you choose a Capture preset стиль съемки с экрана.
Если этот стиль вас полностью устраивает, перейдите к шагу 9 данной инст-
рукции, в противном случае — к следующему шагу.

3. Задайте режим и параметры съемки с экрана, убедившись в правильности
выполненных настроек по виду объекта съемки, схематически изображен-
ному в левой части вкладки Source (см. рис. 10.17).

4. Откройте вкладку Activation (Активизация) и задайте параметры, управляю-
щие процессом съемки. Здесь рекомендуется установить все имеющиеся
флажки и задать режим сохранения исходной формы указателя (переключа-
тель Current cursor).

5. Перейдите на вкладку Image (Изображение) и выберите параметры, опреде-
ляющие качество и размеры формируемых изображений. Здесь рекоменду-
ется использовать: цветовой формат RGB (пункт RGB Color (24-bit) в спи-
ске Туре) и разрешение 96 точек на дюйм (поле Resolution). Для сохранения
пропорции размеров изображения, которые будут регулироваться, установите
флажок Maintain aspect ratio, а для сохранения исходных размеров изображения
выберите переключатель Scale и введите значение 100 в соответствующие
поля Width и Height.

6. Откройте вкладку Destination (Назначение) и определитесь в отношении ре-
жимов использования формируемых изображений: сохранение в файлах
(флажок File и кнопка справа от него); копирование в буфер обмена (фла-
жок Clipboard); распечатка (флажок Printer и кнопка Setup); загрузка в рабо-
тающую программу CorelDRAW 12 (флажок OLE automated application).

7. Перейдите на вкладку Options (Параметры) и задайте режимы выдачи пре-
дупреждающих сообщений (рекомендуется установить все флажки).

8. Чтобы зафиксировать текущие параметры съемки в качестве нового стиля
съемки с экрана, перейдите снова на вкладку Source и щелкните на кнопке
со знаком "+". В открывшемся окне Capture Presets введите название фор-
мируемого стиля и щелкните на кнопке Save (Сохранить).

9. Щелкните на кнопке Capture (Съемка), находящейся внизу диалогового ок-
на Corel CAPTURE 12. Если при этом откроется панель Ready to capture
с предупреждающим сообщением о готовности программы к съемке, то
щелкните на кнопке Continue (Продолжить). В результате в правом конце
панели задач Windows появится квадратный значок темно-синего цвета, оз-
начающий, что программа готова к съемке.

10. Нажмите заданную горячую клавишу, инициирующую процесс съемки либо
формирование пользователем области съемки. При выполнении одного из
трех перечисленных ниже условий выполните соответствующее действие;

• если выбран режим съемки окна или панели с любым объектом для
съемки, за исключением всей области экрана, выделите данный объект
с помощью указателя;

• если выбран режим съемки области экрана, имеющей форму прямо-
угольника или эллипса (пункт Rectangle area или Elliptical area в списке
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Type of Area), то, как только указатель примет вид оружейного прицела,
сформируйте (при нажатой кнопке мыши) требуемую область съемки,
отрегулируйте ее размеры, а затем щелкните мышью внутри нее;

• если активизирован режим съемки многоугольной области (пункт
Freehand Area в списке Type of Area), сформируйте такую область после-
довательными щелчками мыши в точках изгиба ее контура (последний
щелчок должен быть либо двойным в любой точке экрана, либо одинар-
ным в исходной точке контура). Отрегулируйте размеры и форму соз-
данной области, после чего сделайте щелчок мышью внутри нее.

11. Если на экране появится панель с предупреждающим сообщением о завер-
шении съемки, щелкните на кнопке ОК.

12. Чтобы выполнить следующую съемку с экрана при тех же параметрах на-
стройки Corel CAPTURE 12, перейдите к шагу 10 инструкции.

13. Для повторной съемки при других параметрах настройки программы от-
кройте ее диалоговое окно, щелкнув на значке Corel CAPTURE 12 в правой
части панели задач, после чего перейдите к шагу 2.

14. Для завершения работы в программе откройте ее диалоговое окно щелч-
ком на значке Corel CAPTURE 12 и сделайте в нем щелчок на кнопке
Close (Закрыть), находящейся внизу.
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Приложение 1

Быстрые клавиши CorelDRAW 12

В данном приложении даются быстрые клавиши команд основного меню про-
граммы CorelDRAW 12.

Меню File

Команда Быстрые клавиши

New (Новый) <Ctrl>+<N>

Open (Открыть) <Ctrl>+<O>

Save (Сохранить) <Ctrl>+<S>

Save As {Сохранить как) <Ctrl>+<Shift>+<S>

Import (Импорт) <Ctrl>+<!>

Export (Экспорт) <Ctrl>+<E>

Print (Печать) <Ctrl>+<P>

Exit (Выход) <Alt̂ +<F4>

Меню Edit

Команда Быстрые клавиши

Undo (Отменить) <Ctrl>+<Z>

Redo (Повторно выполнить) <Ctrl>+<Shift>+<2>

Repeat (Повторить) <Ctrl>+<R>

Cut (Вырезать) <Ctrl>+<X>

Copy (Копировать) <Ctrl>+<C>
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(окончание)

Команда Быстрые клавиши

Paste (Вставить) <Ctrl>+<V>

Delete (Удалить) <Delete>

Symbol > Symbol Manager (Символ > Диспетчер символов) <Ctrl>+<F6>

Duplicate (Создать копию) <Ctrl>+<D>

Properties (Свойства) <Alt>+<Enter>

Меню View

Команда Быстрые клавиши

Full-Screen Preview (Полноэкранный просмотр)

Snap To Grid (Привязать к сетке)

Snap To Objects (Привязать к объектам)

Dynamic Guides (Динамические направляющие)

<F9>

<Ctr!>+<Y>

<Alt>+<Shift>+<D>

Меню -Arrange

Команда Быстрые клавиши

Transformations > Position (Трансформации > Поло- <Alt>+<F7>
жение)

Transformations > Rotate (Трансформации * Поворот) <Alt>+<F8>

Transformations > Scale (Трансформации * Масштаб) <Alt>+<F9>

Transformations > Size (Трансформации * Размер) <Alt>+<F10>

Align and Distribute > Align Left <L>
(Выровнять и распределить к Выровнять слева)

Align and Distribute > Align Right <R>
(Выровнять и распределить > Выровнять справа)

Align and Distribute > Align Top <T>
(Выровнять и распределить > Выровнять сверху)

Align and Distribute * Align Bottom <B>
(Выровнять и распределить t Выровнять снизу)

Align and Distribute > Align Centers Horizontally <E>
(Выровнять и распределить > Выровнять центры по го-
ризонтали)

Align and Distribute > Align Centers Vertically <C>
(Выровнять и распределить > Выровнять центры по вер-
тикали)
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(окончание)

Команда Быстрые клавиши

Align and Distribute * Center to Page
(Выровнять и распределить t По центру страницы)

Order > To Front (Упорядочить > Вверх)

Order > To Back (Упорядочить > Вниз)

Order > Forward One (Упорядочить > На один вперед)

Order > Back One (Упорядочить > На один назад)

Group (Сгруппировать)

Ungroup (Разгруппировать)

Combine (Скомбинировать)

Break Apart (Разъединить)

Convert To Curves (Преобразовать в кривые)

Convert Outline To Object (Преобразо-
вать контур в обьект)

<Shift>+<PgUp>

<Shift>+<PgDn>

<Ctrl>+<PgUp>

<Ctrl>+<PgDn>

<Ctrl>+<G>

<Ctrl>+<U>

<Ctrl>+<L>

<Ctrl>+<K>

<Ctrl>+<Q>

<Ctrl>+<Shift>+<Q>

Меню Effects

Команда Быстрые клавиши

Adjust > Brightness/Contrast/Intensity
(Коррекция > Яркость/Контрастность/Интенсивность)

Adjust > Color Balance {Коррекция > Цветовой баланс)

Adjust > Hue/Saturation/Lightness
(Коррекция t Оттенок/Насыщенность/Светлота)

Contour (Контур)

Envelope (Оболочка)

Lens (Линза)

<Ctrl>+<B>

<Ctrl>+<Shift>+<B>

<Ctrl>+<Shifl>+<U>

<Ctrl>+<F9>

<Ctrl>+<F7>

<Alt>+<F3>

Меню Text

Команда Быстрые клавиши

Format Text (Форматировать текст)

Edit Text (Редактировать текст)

Insert Character (Вставить символ)

Align To Baseline (Выровнять по базовой линии)

Writing Tools > Spell Check
(Инструменты правописания > Проверка орфографии!

<Ctrl>+<T>

<Ctrl>+<Shift>+<T>

<Alt>+<F12>

<Ctrl>+<F12>
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(окончание)

Команда Быстрые клавиши

Change Case (Изменить регистр)

Convert (Преобразовать)

<Shift>+<F3>

<Ctrl>+<F8>

Меню Tools
Команда Быстрые клавиши

Options (Параметры) <Ctrl>-t-<J>

View Manager (Диспетчер видов) <Ctrl>+<F2>

Graphic and Text Styles (Графические и текстовые стили) <Ctrl>+<F5>

Visual Basic > Visual Basic Editor <Alt>+<F11>
(Visual Basic > Редактор Visual Basic)

Меню Window
Команда Быстрые клавиши

Dockers > Properties (Докеры > Свойства) <Alt>+<Enter>

Dockers > View Manager (Докеры > Диспетчер видов) <Ctrl>+<F2>

Dockers t Contour (Докеры t Контур) <Ctrl>+<F9>

Dockers > Envelope (Докеры > Оболочка) <Ctrl>+<F7>

Dockers > Lens (Докеры > Линза) <Alt>+<F3>

Dockers > Graphic and Text Styles <Ctrl>+<F5>
(Докеры > Графические и текстовые стили)

Dockers > Symbol Manager <Ctrl>+<F6>
(Докеры > Диспетчер символов)

Dockers > Transformations > Position <Alt>+<F7>
(Докеры > Трансформации > Положение)

Dockers > Transformations ^ Rotate <Alt>+<F8>
(Докеры > Трансформации ^ Поворот)

Dockers > Transformations > Scale <Alt>+<F9>
(Докеры ^ Трансформации > Масштаб)

Dockers k Transformations > Size <Alt>+<F10>
(Докеры > Трансформации * Размер)

Refresh Window (Обновить окно) <Ctrl>-t-<W>

Меню Help

Команда Быстрые клавиши

Help Topics (Справочная система]
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Используемые термины

В приложении представлены те термины векторной графики, которые необхо-
димо знать каждому, кто собирается освоить CorelDRAW 12 с помощью на-
стоящего руководства и которые могут встретиться в процессе практической
работы в этой программе.

О URL (Uniform Resource Locator — Универсальный указатель ресурса). Стан-
дартный формат описания конкретных ресурсов в Интернете, позволяющим
обеспечить к ним доступ. Включает в себя название протокола, по которому
происходит доступ к требуемому ресурсу, имя домена и путь к самому ресурсу.

О Web (World Wide Web — "Всемирная паутина"). Информационная среда Ин-
тернета, обеспечивающая быстрый и удобный доступ к распределенным ин-
формационным ресурсам глобальной сети с помощью специальных про-
грамм, называемых Web-обозревателями.

О Web-обозреватель. Специализированная программа просмотра Web-страниц
и других ресурсов Интернета.

О Авторский код (идентификационный номер) разработчика. Набор цифр, за-
кодированных в виде небольшого шума, который добавляется к светлым час-
тям растрового изображения с целью идентификации его автора. Этот шум
невидим невооруженным глазом, в связи с чем его называют водяным знаком.

О Буквица. Большая заглавная буква абзаца, которая спускается вниз на не-
сколько текстовых строк и обтекается текстом абзаца. Обычно используется
в начале главы или раздела текстового документа.

Ш Векторное изображение. Изображение, которое описывается математически
в обрабатывающем приложении с использованием линий и кривых. Вектор-
ные изображения обладают следующими преимуществами перед растровыми:

• их можно неограниченно масштабировать и трансформировать без сни-
жения качества;

• они имеют более высокое качество, особенно при наличии тонких линий
и мелких деталей;

• файловый объем векторного изображения меньший, чем у аналогичного
растрового изображения.
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П Вид (вид документа). Вариант отображения на экране в заданном масштабе
некоторой страницы графического документа или ее отдельной части.

П Выбивка. Пустая область в фоновом объекте документа в месте расположе-
ния на нем другого объекта. Выбивки используются для устранения искаже-
ний в типографском оттиске из-за наложения слоев краски в местах пере-
крытия объектов.

О Выделяющие маркеры. Восемь мерных квадратных меток, расположенных по
углам и серединам сторон прямоугольной области охвата выделенного объек-
та, а также крестообразная метка центра этой области.

П Выключка, Вариант горизонтального выравнивания строк текстового абзаца.
В CorelDRAW 12 предусмотрено пять типов выключки: выключка слева (по
левой границе текста), выключка по центру, выключка справа (по правой
границе), полная выключка (выравнивание полных строк абзаца с обеих сто-
рон текста), а также принудительная выключка (выравнивание всех строк аб-
заца с обеих сторон).

О Гиперссылка (адрес перехода). Адрес, внедренный в некоторый объект или
текстовый фрагмент электронного документа, по которому происходит пере-
ход при щелчке на объекте мышью при работе в Web, локальной сети или на
компьютере пользователя. Этот адрес обычно задается в формате URL.

D Градиентная заливка. Раскраска внутренней области векторного контура от-
тенками двух или более цветов, выбираемых в качестве базовых, при плав-
ных переходах от одного базового цвета к другому и выбранной форме этих
переходов, определяющей тип градиента.

П Графический стиль. Набор параметров оформления векторного объекта, ко-
торый сохранен под определенным именем в файле обрабатываемого доку-
мента или его шаблона с целью ускорения оформления этим стилем других
векторных объектов документа.

О Диапазон печати. Перечень страниц активного документа или список откры-
тых документов, выводимых на печать.

П Докер (докерное окно). Разновидность диалогового окна, используемая
в графических программах компании Corel Corporation. Докер отличается от
обычного диалогового окна тем, что при раскрытии не мешает выполнению
каких-либо операций. Обычно докер представляется в стационарном виде и
располагается на экране справа. Однако он может иметь и плавающую фор-
му, напоминая палитру программы Adobe Photoshop.

G Документ. Объект обработки графической, издательской или текстовой
программы, предназначенный для самостоятельного распространения в виде
печатной или электронной продукции либо для использования в других до-
кументах. Сохраняется в виде файла.

О Закладка. Метка электронного документа, вставляемая в некоторый объект
с целью перехода к нему от других объектов документа при выполнении на
них щелчков мышью.
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П Заливка по сетке. Раскраска векторного объекта с использованием управляе-
мой сетки типа Безье, доступной для регулировки с помощью узелков и кон-
трольных точек. Данная сетка накладывается на выбранный векторный объект,
после чего участки объекта, прилегающие к узелкам сетки, раскрашиваются
в заданные цвета. При этом происходит автоматическое формирование про-
граммой градиентных оттенков между этими участками. Использование сет-
ки позволяет выполнить произвольную градиентную заливку объекта, а так-
же в дальнейшем ее отредактировать.

П Заливка текстурой (текстурная заливка). Заполнение внутренней области
векторного объекта мозаичным узором, составленньш программой из копий
образца растрового изображения, называемого текстурой, которая допускает
регулировку цветовых и геометрических параметров ее элементов.

G Заливка узором PostScript. Заполнение внутренней области векторного объек-
та мозаичным узором, сформированным с помощью языка PostScript. Чтобы
такую заливку увидеть на экране в CorelDRAW 12, следует выбрать режим
отображения Enhanced (Улучшенный), а чтобы распечатать — использовать
принтер типа PostScript.

П Заливка шаблоном (шаблонная заливка). Заполнение внутренней области век-
торного объекта мозаичным узором, составленным программой из копий вы-
бранного образца векторного или растрового изображения, называемого шаб-
лоном.

П Заливка. Раскраска внутренней области векторного или растрового объекта
документа каким-либо одним цветом, градиентным узором или мозаичным
узором, составленным программой из копий выбранного образца изображе-
ния. В CorelDRAW 12 заливку можно выполнять только для объектов век-
торной графики и текстовых объектов.

П Зона захвата. Допустимое расстояние (в пикселах) между опорной точкой
перемещаемого объекта (перемещаемым узелком векторного контура) и бли-
жайшей направляющей, линией сетки или контуром другого объекта, при
котором происходит "притягивание" этой точки (узелка) к данной линии или
контуру при активизации соответствующего режима привязки.

П Интерактивное состояние (rollover state). Состояние электронного докумен-
та, относящееся к некоторой области срабатывания, сформированной в ис-
ходном графическом документе CorelDRAW 12. Интерактивное состояние
задает определенный вариант манипуляции мышью по отношению к данной
области срабатывания, которому ставятся в соответствие те или иные объек-
ты документа. Таким образом происходит управление видом электронного
документа с помощью мыши, создающее в нем эффект интерактивности.

П Каналы. Системное средство программы растровой графики, используемое:
для работы с составными частями растрового изображения. Каналы бывают
двух типов: цветовые и служебные. Цветовые каналы применяют для разло-
жения исходного изображения на составные, относящиеся к базовым цветам"
используемой цветовой модели, а служебные каналы — для хранения масок,
а также для вывода на печать дополнительных изображений, раскрашенных
цветами готовых красителей.
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П Категория настроек. Набор параметров настроек программы CorelDRAW 12,
которые сгруппированы по функциональному признаку, имеют определенное
название и представляются в виде элементов вложенного списка параметров.

О Кегль. Размер текстовых символов выбранного шрифта.

О Кернинг. Величина промежутка между двумя текстовыми символами в месте
расположения текстового курсора.

П Команда фильтрации (фильтр). Команда графической программы, предна-
значенная для обработки растровых изображений, которая при определении
новых значений параметров пикселов обрабатываемого изображения исполь-
зует цветовые, тоновые или геометрические параметры других пикселов
этого или иного изображения. Таким образом, в изображении создается ху-
дожественный эффект или выполняется его коррекция.

П Контур (векторный контур). Составная часть векторного графического объ-
екта, которая определяет его границу и форму. Контур может быть замкну-
тым или разомкнутым. Операция оформления контура называется обводкой.

П Контур Безье (кривая Безье). Векторный контур, состоящий из узелков, от-
резков соединительных линий (сегментов) и контрольных точек, располо-
женных на отрезках прямых, проходящих через узелки. Регулировка кривой
Безье производится в интерактивном режиме путем перемещения мышью
узелков и контрольных точек, изменения типов узелков, а также их добавле-
ния к контуру или удаления. Это позволяет с высокой точностью формиро-
вать и редактировать такие кривые.

G Масштаб рисования (drawing scale). Отношение между фиктивными размера-
ми страницы документа, отображаемыми на измерительных линейках, выве-
денных на экран, и реальными размерами этой страницы. В CorelDRAW 12
данный масштаб можно задать на вкладке Document > Rulers (Доку-
мент > Линейки) диалогового окна Options (Параметры).

О Метки приводки. Метки, находящиеся на цветоделенных пленках и печатных
формах, которые используются для совмещения цветов при типографской
печати.

П Морфине (morphing). Процесс постепенного превращения одного объекта
анимационного документа в другой объект или в тот же объект, но с другими
его параметрами. Различают две разновидности морфинга: объемный и пло-
ский. Первый из них характеризует переход между объемными объектами,
моделируемыми в обрабатывающем приложении, а второй — между плоски-
ми объектами. В частности, объемный морфинг может быть создан в про-
грамме объемного моделирования 3D Studio MAX, а плоский — в програм-
мах создания видеоклипов Macromedia Flash и Corel R.A.V.E. 3.0.

П Муар. Паразитный узор на цветном печатном оттиске, который возникает
при неточном совмещении печатных форм или при неправильно выбранных
углах наклона растра.

О Начертание (стиль начертания). Вариант оформления букв текстового шриф-
та. Наиболее распространенными начертаниями являются: regular (обычный),
bold (полужирный), italic (курсив), bold-italic (полужирный-курсив).
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О Обводка. В документе векторной графики обводкой называется операция
оформления контура выбранного векторного объекта или области, примы-
кающей к данному контуру. В растровом документе обводка представляет со-
бой операцию оформления границы выделенной области изображения, гра-
ницы отдельного объекта документа или следа от векторного контура.

П Область срабатывания (горячая зона — hot spot). Область электронного до-
кумента, относящаяся к некоторому объекту исходного документа, при воз-
действии на которую мышью изменяется вид документа, происходит переход
по внедренной в эту область гиперссылке или выполняется некоторый сце-
нарий.

О Обтравочный контур. Векторный контур, делающий невидимой часть рас-
трового изображения, расположенную снаружи от него (или внутри).
В программе CorelDRAW 12 используются обтравочные контуры двух типов:
встроенные и наложенные. Встроенный контур формируется в программе рас-
тровой графики в процессе создания изображения и сохраняется вместе с ним
в векторном файловом формате EPS. Наложенный контур создается непосред-
ственно в документе CorelDRAW 12 в процессе обработки изображения.

П Объект OLE. Графический или текстовый объект, созданный в другом при-
ложении, в котором его можно отредактировать в процессе обработки доку-
мента CorelDRAW 12. Объект OLE может быть внедрен в тело документа или
вставлен в него через связь с файлом, в котором находится.

О Объект документа. Составная часть графического или текстового документа,
которую можно выделять, перемещать и обрабатывать как единое целой.
В зависимости от типа содержащейся информации объекты подразделяются
на графические и текстовые, по способу обработки — на векторные и рас-
тровые. Все эти объекты встречаются в документах CorelDRAW 12. Кроме
того, там могут также присутствовать объекты OLE, объекты Интернета
и символьные объекты.

П Объект Интернета. Объект документа CorelDRAW 12, выполняющий неко-
торую управляющую или информационную функцию при распространении
документа в электронном виде. Объектами Интернета могут быть, в частно-
сти: исполняемые файлы, кнопки, флажки, переключатели, списки, тексто-
вые рамки и поля.

О Объект перехода. Комбинированный векторный объект, формируемый
в программе CorelDRAW 12 рабочим инструментом Interactive Blend (Интер-
активный переход) путем добавления к двум базовым элементам (исходные
векторные объекты) заданного количества промежуточных элементов, поло-
жение, форма и раскраска которых плавно изменяются.

П Обычный текст. Текст графического документа, для работы с которым ис-
пользуются те же приемы обработки, что и в обычном текстовом редакторе.
В CorelDRAW 12 предусмотрена возможность установления связей между от-
дельными блоками обычного текста, а также расположение такого текста
в рамках произвольных форм и на векторных контурах (на текстовых дорожках)
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О Открытый интерфейс допечатной подготовки (Open Prepress Interface —
OPI). Набор условных обозначений на языке PostScript, с помощью которого
можно задавать при печати различные режимы импорта графических изо-
бражений, представленных в форматах TIFF и EPS, в том числе и устанавли-
вать связи с высококачественными изображениями, хранящимися в отдель-
ных файлах.

П Пакетирование (stacking). Взаимное расположение объектов по всей толщине
графического документа или по толщине его отдельного слоя.

G Панель свойств. Перестраиваемая панель инструментов программы
CorelDRAW 12, обладающая свойством трансформации в зависимости от вы-
бранного рабочего инструмента или выполняемой операции обработки объ-
ектов документа.

О Печать поверх. Наложение красок при типографской печати в тех местах
печатного документа, в которых два или более объекта расположены друг на
друге.

П Пиксел. Минимальный элемент квадратной формы, для которого задаются
цветовые параметры, относящиеся к растровому изображению, экрану мони-
тора или выводимому на печать графическому документу.

П Поле обрезки. Поле выступа области изображения в печатном документе за
линию обрезки.

П Ползунок. Регулятор линейного типа, состоящий из движка и направляющей,
вдоль которой этот движок может перемещаться с помощью указателя мыши.

П Равномерная заливка. Раскраска выбранным цветом внутренней области век-
торного контура.

CJ Размерная линия. Группа прямолинейных отрезков, соединяющих две или
три выбранные точки объектов документа (одного или двух), возле которых
указывается расстояние между этими точками или угловой размер в заданных
единицах измерения. В CorelDRAW 12 размерные линии обладают следую-
щим свойством: размеры объектов, вычисляемые программой и отображае-
мые на экране, автоматически изменяются при трансформации или переме-
щении этих объектов.

Г\ Разрешение. Число пикселов на единицу длины, обычно на дюйм (dpi или
ppi), для растрового, экранного или печатаемого изображения. С увеличени-
ем разрешения повышается качество изображения, но при этом возрастает
объем памяти, необходимой для его хранения.

3 Раскадровка (tweening). Процесс автоматического изменения параметров не-
которого объекта анимационного документа (видеоклипа) для выбранной
группы последовательно расположенных кадров. В результате раскадровки
происходит плавный переход от параметров объекта в начальном и конечном
ключевых кадрах данной группы, используемых в качестве исходных.

П Растровая подложка. Среда, в которой на компьютере создается растровый
документ, состоящий из одного или нескольких изображений, находящихся
в отдельных слоях. Подложка состоит из одного или нескольких слоев, среди
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которых может быть один фоновый слой (непрозрачный) и несколько про-
зрачных слоев. Подложка имеет прямоугольную форму и характеризуется
разрешением и цветовым форматом.

П Растровое изображение. Изображение, состоящее из небольших элементов
квадратной формы, называемых пикселами. Для каждого пиксела изображе-
ния, имеющего определенные координаты, задаются значения канальных яр-
костей используемой цветовой модели. Растровые изображения используют-
ся в следующих случаях:

• при создании художественных эффектов, недоступных для объектов век-
торной графики;

• при сканировании и цифровой фотосъемке;

• с целью использования в электронных документах.

П Связывание и внедрение объектов (Object Linking and Embedding — OLE).
Вставка в документ объектов, созданных в других приложениях, при сохране-
нии возможности их'редактирования непосредственно в самом документе.
Такие объекты называются объектами OLE. Механизм OLE состоит в следую-
щем. Если в документ, обрабатываемый в CorelDRAW 12, всташген некоторый
объект OLE, то при выборе этого объекта произойдет запуск относящегося
к нему приложения, где этот объект может быть отредактирован, Внедрение
OLE-объекта состоит в его вставке непосредственно в тело документа, а связы-
вание — в установлении связи с файлом, в котором он находится.

П Сглаживание краевых пикселов. Размытие краев растрового изображения,
формируемого в документе векторной графики за счет раскрашивания со-
седних пикселов в оттенки, близкие к краевым пикселам. Сглаживание при-
меняется для снижения уровня зубцов, пояачяюшихся по краям изображения
низкого разрешения, которые расположены под некоторым углом к его оси
координат.

П Символ. Вторичный объект, формируемый в CorelDRAW 12 из исходных
объектов документа с целью многократного использования путем копирова-
ния в документ в качестве символьных объектов или потомков (instances).
Символы документа хранятся в локере Symbol Manager (Диспетчер символен)
и обладают следующими свойствами:

• любое изменение символа приводит к автоматическому изменению всех
его потомков, связанных с ним;

• потомки символа, находящиеся в документе, занимают гораздо меньше
памяти, чем если бы они были созданы в качестве независимых объектен.

П Символьный объект (потомок). Копия некоторого символа, помещенная
в документ CorelDRAW 12 и имеющая с этим символом связь. Любая копия
может отличаться от других копий данного символа положением в докумен-
те, параметрами трансформации, а также прозрачностью.

G Слой. Аналог прозрачной кальки, которая применяется в художественном
дизайне. В программах растровой графики слои предназначены для обработки
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составных частей растрового документа (в одном слое может находиться
всего один объект документа), а в программах векторной графики — для ра-
боты с любыми объектами документа (в одном слое могут располагаться не-
сколько объектов произвольных типов).

О Сноска. Текстовая надпись, относящаяся к некоторому объекту документа, кото-
рая связана с этим объектом прямой или ломаной линией. В CorelDRAW 12 ис-
пользуются ломаные лини сносок, состоящие из двух прямолинейных отрезков.

П Составные цвета (полиграфические цвета). Отличаются от стандартных цветов
тем, что при печати документа в режиме цветоделения разлагаются на четыре
базовых цвета модели CMYK, каждый из которых выводится на отдельную
цветоделенную пленку. Типичным представителем библиотек составных цве-
тов, входящих в состав CorelDRAW 12, является библиотека TRUMACH Color.

П Стандартные цвета (цвета готовых красителей или плашечные цвета). От-
личаются от составных цветов тем, что при печати документа в режиме цве-
тоделения каждый их этих цветов выводится на отдельную цветоделенную
пленку. Типичным представителем библиотек стандартных цветов Corel-
DRAW 32 является библиотека PANTONE.

П Стиль (общее определение). Набор параметров, зафиксированных в файле
под определенным именем, который предназначен для ускорения обработки
в документе объектов некоторого типа или выполнения конкретной опера-
ции. В CorelDRAW 12 при обработке объектов документов используются тек-
стовые, графические и цветовые стили, а при распечатке документов — сти-
ли печати.

П Стиль макетирования. Вариант размещения страниц макета документа на
печатных листах.

О Стиль оформления линии. Набор параметров, определяющих в CorelDRAW 12
вид основной части формируемой линии (без наконечников). В программе
предусмотрена возможность рисования сплошных линий и линий прерыви-
стых, состоящих из отдельных штрихов или точек.

П Стиль оформления эффекта. Набор параметров оформления некоторого эф-
фекта, создаваемого в CorelDRAW 12 для векторных объектов, который со-
хранен под определенным именем в файле с целью ускорения процесса
формирования данного эффекта в других объектах документов. В состав сти-
ля оформления эффекта обычно входит визуальный индикатор эффекта, об-
легчающий поиск требуемого стиля в списке стилей оформления эффекта,
доступных для использования.

П Стиль печати. Набор параметров печати документа, сохраненный под опре-
деленным именем в файле с целью многократного использования.

G Схема макета документа. Вариант разбивки исходной страницы документа
на фактические страницы макета, а также их расположения в рабочем окне
документа (по одной или по две).

П Сценарий (макрокоманда). Набор команд обработки содержимого графического
документа, зафиксированный в памяти компьютера под определенным именем
с целью автоматизации обработки этим сценарием многих документов.
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П Текстовая дорожка. Векторный контур, вдоль которого расположены или
могут располагаться в документе CorelDRAW 12 символы обычного или ху-
дожественного текста.

П Текстовая оборка. Пустая область, появляющаяся в тексте в результате обте-
кания им некоторого объекта, находящегося внутри него.

П Текстовая рамка. Область документа CorelDRAW 12, сформированная рабо-
чим инструментом Text (Текст) или образованная внутри векторного объекта
с замкнутым контуром, в которой находится или может находиться текст
обычного типа. Рамка, созданная инструментом Text, имеет прямоугольную
форму и называется текстовой рамкой документа. Рамка внутри векторною
объекта называется текстовой рамкой объекта.

G Текстовый блок. Фрагмент текста, находящийся в текстовой рамке, на тек-
стовой дорожке, либо непосредственно в теле документа, который можно не-
зависимо перемещать по области документа или трансформировать.

П Текстовый материал. Текстовая информация графического документа, со-
стоящая из одного или нескольких текстовых блоков, связанных между собой.

П Текстовый стиль. Набор параметров форматирования текстовой информации,
сохраненный под определенным именем в файле обрабатываемого документа
или его шаблона с целью ускорения процесса форматирования текста докумен-
та. В специализированных текстовых редакторах обычно используются тексто-
вые стили двух типов: символьные и абзацные. В CorelDRAW 12 применяются
комбинированные стили, позволяющие одновременно форматировать выде-
ленные символы и абзацы текста.

П Текстура. Поверхность среза объемного объекта, имеющего определенную
природу (дерево, скальная порода, металл и т. п.), поверхность материала
с характерными для него неровностями (брезент, холст, кирпичная кладка
и др.) либо вид облачного неба.

П Точка схода (для эффекта выдавливания). Точка на текущей странице доку-
мента CorelDRAW 12, к которой сходятся все прямые линии, являющиеся
продолжением ребер боковых граней объекта с эффектом выдавливания.

П Точка схода (для эффекта перспективы). Точка на текущей странице доку-
мента, к которой сходятся прямые линии, являющиеся продолжением про-
тивоположных сторон четырехугольной рамки, охватывающей объект с эф-
фектом перспективы.

П Трекинг. Величина промежутка между соседними выделенными текстовыми
символами.

П Художественный текст. Отличается от обычного текста тем, что допускает
выполнение в CorelDRAW 12 большинства операций, используемых при об-
работке объектов векторной графики, а также может вводиться непосредст-
венно в тело документа.

П Цветовая ловушка. Тонкий контур вокруг объекта, который печатается по-
верх другого объекта (фонового), имеющего выбивку. Использование цвето-
вых ловушек позволяет компенсировать ошибку в совмещении форм при
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печати на типографском оборудовании. Существуют два способа создания
цветовых ловушек: растяжка и заслонка, первый из которых состоит в уве-
личении размеров объекта, расположенного над фоновым объектом, а вто-
рой — в уменьшении размера выбивки в фоновом объекте.

П Цветовая маска. Маска, формируемая в растровом изображении путем вы-
деления в нем областей с заданными оттенками с целью управления отобра-
жением или обработкой пикселов данного изображения. В CorelDRAW 12
цветовые маски используются для регулировки прозрачности одноцветных
участков растровых изображений.

П Цветовая модель. Способ представления цветов в изображении путем разде-
ления исходного цвета на базовые цветовые компоненты с указанием их ко-
личественных значений. Наиболее распространенными цветовыми моделями
являются RGB (Red — красный, Green — зеленый, Blue — синий) и CMYK
(Cyan — голубой, Magenta -- пурпурный, Yellow — желтый, ЫасК — чер-
ный). Первая модель применяется при электронной публикации и сканиро-
вании, а вторая — в полиграфии.

П Цветовое пространство (цветовой охват). Совокупность цветовых и тоновых
оттенков, которые воспроизводит или воспринимает то или иное техниче-
ское или биологическое устройство. В документах, предназначенных для пе-
чати, под цветовым пространством подразумевается пространство цветовой
модели CMYK.

П Цветовой круг. Схема взаимодействия цветов, представляемых и форматах
цветовых моделей RGB и CMY, которая имеет вид цветного круга. На этой
схеме базовые цвета указанных моделей расположены в следующем порядке
(при движении по часовой стрелке): желтый, красный, пурпурный, синий,
голубой и зеленый. Каждый такой цвет находится напротив дополняющего
его цвета и одновременно между цветами, с помощью которых он получен.

П Цветовой профиль. Набор параметров, описывающих цветовое пространство
устройства отображения или вывода графической информации (монитора,
сканера или принтера). Этот набор, который сохраняется в отдельном файле,
предназначен для устранения или сведения к минимуму тех цветовых иска-
жений в изображении, которые вызваны несоответствием цветовых про-
странств используемых устройств. В CorelDRAW 12 используются стандарт-
ные цветовые профили, базирующиеся на универсальном языке описания их
цветовых параметров. Такие профили можно внедрять в файлы разрабаты-
ваемых документов, а также использовать при работе со многими програм-
мами, поддерживающими механизм их формирования.

3 Цветовой формат. Способ кодирования цветов, используемых в изображени-
ях, создаваемых на компьютере. Цветовые форматы бывают четырех типов:
цветовых моделей, систем соответствия цветов, табличные и дуплексный.

П Цветовые гармонии. Наборы из групп цветовых образцов, гармонично соче-
тающихся друг с другом по цветовым и тоновым оттенкам.

П Цветовые стили. Наборы цветовых образцов, которые формируются пользо-
вателем и сохраняются вместе с документом с целью оформления ими мно-
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гих объектов документа. Каждый цветовой стиль состоит из одного исходного
образца цвета (родителя) и набора оттенков, зависящих от него (потомков).

П Цветоделение. Процесс разделения цветного изображения, созданного
в компьютере, на несколько одноцветных изображений при их распечатке на
пленках (их называют цветоделенными). Из этих пленок будут в дальнейшем
изготовлены формы для печати цветных оттисков на типографском оборудо-
вании. Каждое составное изображение, относящееся к отдельной форме, яв-
ляется растрированным. Оно состоит из точек растра, имеющих определен-
ные форму, расположение и размеры. Параметры этих точек подбираются
таким образом, чтобы при печати они располагались рядом, создавая много-
цветное изображение, идентичное исходному. При использовании в исход-
ном изображении цветов какой-либо цветовой модели или составных библио-
течных цветов будут распечатаны четыре цветоделенные пленки для базовых
цветов модели CMYK. Если же изображение раскрашено стандартными цвета-
ми, то каждый такой цвет будет представлен на отдельной пленке.

П Цветоделенные пленки. Оттиски, получаемые на пленках при распечатке до-
кумента в режиме цветоделения с целью последующего изготовления печат-
ных форм, с помощью которых выполняется цветная печать на типограф-
ском оборудовании.

П Частота растра (линиатура растра). Число линий на дюйм (Ipi), задаваемых
при распечатке изображения. На идеальном бумажном носителе качество пе-
чати будет возрастать с увеличением частоты растра. Оптимальная линиатура
растра определяется качеством используемой бумаги (на тонкой бумаге, хо-
рошо впитывающей краску, изображение будет размазываться при высокой
линиатуре). В зависимости от сорта бумаги обычно выбирают линнатуру рас-
тра в следующих пределах: для газетной бумаги — 70—90 Ipi, для бумаги
среднего качества — 90-100 Ipi, а для глянцевой — 133 Ipi и выше.

П Шаблон (шаблонный документ). Документ, используемый в качестве образца
с целью создания на его основе новых документов, в которые будут перене-
сены все его параметры и содержимое. В CorelDRAW 12 шаблон представля-
ет собой файл документа (с расширением cdt), содержащий параметры фор-
матирования. Он также может включать текстовые, графические и цветовые
стили, а также различные объекты.

П Шрифт (гарнитура шрифта). Набор текстовых символов одного рисунка всех
размеров и начертаний. Например: Arial, Courier, Jikharev.

П Электронный документ. Объект обработки некоторого приложения, предна-
значенный для самостоятельного распространения в Интернете, локальных
сетях или на компакт-дисках. Сохраняется в памяти компьютера в виде од-
ного или нескольких файлов. Если электронный документ предназначен для
публикации в Web, то его называют Web-страницей (если он состоит из од-
ной страницы) или Web-сайтом (если из нескольких страниц).
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Manually Inflate Bitmap, 294

подменю Mode
Black and White (1-bit), 302
CMYK Color (32-bit), 307
Duotone (8-bit), 304
Grayscale (8-bit), 307
Lab Color (24-bit), 307
Paletted (8-bit), 305
RGB Color (24-bit), 307

подменю Noise
Add Noise, 397
Maximum, 398
Median, 399
Minimum, 400
Remove Moire, 400
Remove Noise, 401

подменю Plug-Ins
Embed Watermark, 405
Read Watermark, 406

подменю Sharpen
Adaptive Unsharp, 401
Directional Sharpen, 402
High Pass, 402
Sharpen, 403
Unsharp Mask, 404

Команды меню Edit
подменю Find and Replace

Find Objects, 519
Find Text, 523
Replace Objects, 521
Replace Text, 523

Команды меню Effects
Acid Perspective, 276
подменю Adjust

Auto Equalize, 316
Brightness/Contrast/Intensity, 316
Channel Mixer, 325
Color Balance, 319
Contrast Enhancement, 311
Desaturate, 324
Gamma, 317
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Нне/Saturation/Lightness, 320
Local Equalization, 313
Replace Colors, 323
Sample/Target Balance, 318
Selective Color, 321
Tone Curve, 314

подменю Correction
Dust and Scratch, 330

подменю PowerClip
Place Inside Container, 277

подменю Transform
Delnterlace, 328
Invert, 328
Posterize, 329

Команды меню File
Print, 528
Print Preview, 535
Print Setup, 537
Publish To PDF, 551
подменю Print Merge

Create/Load Merge Fields, 527
подменю Publish To The Web

Flash embedded in HTML, 549
HTML, 547
Web Image Optimizer, 543

Команды меню Tools
подменю Create

Arrow, 280
Character, 280
Pattern, 281

Команды меню View
Page Sorter View, 504

M
Макрокоманды, 127
Механизм OLE, 106

H
Настройка параметров

CorelDRAW 12, 555

П
Панели инструментов

Internet, 63, 540
Print Merge, 65
Scrapbook, 67
Text, 61
Transform, 65
Transformations, 68
Visual Basic

for Applications, 66
Zoom, 62
панель свойств, 59
стандартная панель. 57

Параметры CorelDRAW 12
(окно Options),
вкладка Document, 581
General, 581
Grid, 585
Guidelines, 584

Guides, 585
Horizontal, 585
Presets, 585
Vertical, 585

Page, 582
Background, 584
Label, 583
Layout, 583
Size, 582

Publish To The Web, 585
Image (Изображение), 585
Links, 585
Text, 585

Rulers, 585
Save, 585
Styles, 585

Параметры CorelDRAW 12
(окно Options),
вкладка Global, 586
Bitmap Effects, 587
Filters, 587

Associate, 588
Printing, 586

Driver Compatibility, 586
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Параметры CorelDRAW 12
(окно Options),
вкладка Workspace, 557
Customization

Appication, 580
Color Palette, 580
Command Bars, 572
Commands, 574
Commands > Appearance, 578
Commands > General, 575
Commands > Shortcut Keys, 576

Display, 559
Dynamic Guides, 562
Edit, 560
General, 558
Memory, 564
Plug-Ins, 564
Save, 564
Snap to Objects, 561
Text, 565

Fonts, 566
Paragraph, 566
QuickCorrect, 566
Spelling, 566

Toolbox:
Angular Dimension, 567
Connector Tool, 567
Dimension Tool, 567
Ellipse Tool, 568
Eraser Tool, 568
Freehand/Bezier Tool, 568
Graph Paper, 569
Knife Tool, 569
Mesh Fill Tool, 570
Pick Too], 570
Polygon Tool, 570
Rectangle Tool, 571
Smart Drawing Tool, 571
Spiral Tool, 571
Zoom, Hand Tool, 572

VBA, 563
Warnings, 563

Печать с наложением, 119
порядок задания, 120

Рабочие инструменты
3 Point Curve, 51, 153
3 Point Ellipse, 52, 175
3 Point Rectangle, 52, 172
Arrow Shapes, 53
Aitistic Media, 51

Brush, 199
Calligraphic, 157
Preset, 155
Pressure, 159
Sprayer, 202

Basic Shapes, 53
Bezier, 51, 149
Callout Shapes, 53
Dimension, 52, 161
Ellipse, 52, 173
Eraser, 49, 192
Eyedropper, 55
Fill, 55, 207, 216, 220, 224, 227
Flowchart Shapes, 53
Free Transform, 50, 252
Freehand, 51, 145
Graph Paper, 53, 181
Hand, 50
Interactive Blend, 53, 256
Interactive Connector, 52

Angled connector, 164
Straight connector, 166

Interactive Contour, 54, 260
Interactive Distortion, 54, 263
interactive Drop Shadow, 54, 271
Interactive Envelope, 54, 265
Interactive Extrude, 54, 268
Interactive Fill, 55, 210, 214, 218,

222, 225
Interactive Mesh Fill, 56, 228
Interactive Transparency, 54, 239,

240, 243, 245
Knife, 49, 190
Outline, 55, 232
Paintbucket, 55, 211
Pen, 51, 152
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Pick, 49, 251
Polygon, 53, 176
Polyline, 51, 148
Rectangle, 52, 169
Roughen Brush, 50, 196
Shape, 49, 186
Smart Drawing, 56, 183
Smudge Brush, 194
Smudge Brush, 50
Spiral, 53, 180
Star Shapes, 53
Text, 53
Virtual Segment Delete, 50, 198
Zoom, 50

Растровые изображения:
возможности обработки, 283
зеркальный разворот

изображения, 291
изменение размеров и

разрешения, 292
изменение связей, 299
масштабирование изображения

импортируемого, 289
существующего, 288

наклон изображения, 290
обработка другими

программами, 301
обрезка изображения, 299
обтравочные контуры,

обработка, 294
инструментом Eraser, 297
инструментом Shape, 296, 297,

296, 297
поворот изображения, 289
преобразование цветовых

форматов, 302
преобразование цветовых

форматов, команды
Black and White (I-bit), 302
CMYK Color (32-bit), 307
Duotone (8-bit), 304
Grayscale (8-bit), 307
Lab Color (24-bit), 307
Paletted (8-bit), 305

RGB Color (24-bit), 307
растрирование. 286
регулировка прозрачности, 308

докером Bitmap
Color Mask, 308

средства обработки, 284
панель свойств, 284

тоновая коррекция, 310
тоновая коррекция, команды

Auto Equalize, 316
Brightness/Contrast/Intensity, 316
Contrast Enhancement, 311
Gamma, 317
Local Equalization, 313
Tone Curve, 314

трансформация
изображения,287

увеличение размеров
подложки, 293

цветовая коррекция, 317
цветовая коррекция, команды

Channel Mixer, 325
Color Balance, 319
Desaturate, 324
Hue/Saturation/Lightness, 320
Replace Colors, 323
Sample/Target Balance, 318
Selective Color, 321

цветовой профиль,
применение, 300

эффекты, 326
эффекты, команды

3D Rotate, 330
Adaptive Unsharp, 401
Add Noise, 397
Bit Planes, 361
Blocks, 384
Charcoal, 339
Conte Crayon, 340
Crafts, 368
Crayon, 341
Crystalize, 369
Cubist, 342
(окончание рубрики на стр. 680)
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Растровые изображения
(окончание):
эффекты, команды

Cylinder, 331
Delnterlace, 328
Diffuse, 360
Directional Sharpen, 402
Directional Smooth, 354
Displace, 386
Dust and Scratch, 330
Edge Detect, 365
Embed Watermark, 405
Emboss, 332
Fabric, 370
Find Edges, 366
Frame, 371
Gaussian Blur, 354
Glass Block, 373
Halftone, 362
High Pass, 402
Impressionist, 343
Invert, 328
Jaggy Despeckle, 355
Kid's Play, 374
Low Pass, 355
Maximum, 398
Median, 399
Minimum, 400
Mosaic, 375
Motion Blur, 356
Offset, 387
Page Curl, 334
Palette Knife, 344
Particles, 376
Pastels, 345
Pen & Ink, 346
Perspective, 335
Pinch/Punch, 336
Pixelate, 388
Pointillist, 347
Posterize, 329
Psychedelic, 363
Radial Blur, 357
Read Watermark, 406

Remove Moire, 400
Remove Noise, 401
Ripple, 390
Scatter, 378
Scraperboard, 348
Sharpen, 403
Sketch Pad, 349
Smoked Glass, 378
Smooth, 358
Soften, 359
Solarize, 364
Sphere, 337
Stained Glass, 379
Swirl, 391
Tile, 393
Trace Contour, 367
Unsharp Mask, 404
Vignette, 381
Vortex, 382
Water Marker, 352
Watercolor, 350
Wave Paper, 353
Weather, 383
Wet Paint, 394
Whirlpool, 395
Wind, 396
Zoom, 359

Связи, 99
докер Link Manager, LOO

Связывание
и внедрение объектов, 106
вставка объекта OLE, 109, ПО
обработка объекта OLE, 110
создание объекта OLE, 109

Символы, 102
докер Symbol Manager, 104

Слои,81
докер Object Manager, 81

Смешение цветов, режимы, 237
События, 126

докер Undo, 126
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Стили, 89
текстовые
и графические стили, 89

докер Graphic
and Text Styles, 90

коррекция стиля, 93
применение стиля, 94
создание стиля, 93

цветовые стили, 94
докер Color Styles, 94
коррекция элемента стиля, 98
применение стиля, 99
создание стиля, 97
формирование набора цветов-

потомков, 98
формирование одного цвета-

потомка, 98
Сценарии, 129

докер Corel Scripts Manager, 129

Ф

Файловые форматы:
векторные форматы

AI, 130
CDR, 131
СОТ, 131
CDX, 131
СОМ, 131
CLK, 131
СМХ, 131
СРХ, 132
CSL, 132
DES, 132
DRW. J32
DSF, 132
DWG, 132
DXF, 132
EMF, 133
EPS, 133
FH, 133
Flash, 133
FMV, 134
GEM, 134

HPGL, 134
HTML, 134
MET, 134
NAP, 134
PAT, 134
PDF, 135
PFB, 135
PIC, 135
PICT, 135
PPT, 135
PRN, 135
PS, 136
SHW, 136
SVG, 136
SVGZ, 136
TTF, 136
VSD, 136
WMF, 136
WPG, 137

растровые форматы
BMP, 137
CAL, 137
CPT, 137
CUR, 137
EXE, 138
FPX, 138
GIF, 138
ICO, 138
IMG, 138
JPEG, 138
MAC, 139
PCD, 139
PCX, 139
PNG, 139
PP. 139
PSD, 140
RIFF, 140
SCT, 140
TGA, 140
TIFF, 140
W l , 141
XCF, 141
XPM, 141
(окончание рубрики на стр. 682)
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системы соответствия
цветов, 116

табличные форматы, 117
цветовые модели, 115

Цветоделение, 118

Электронный документ
ввод гиперссылок

и закладок, 539
вставка объектов Интернета, 542
обработка

исходного документа, 538
создание документа формата

HTML
команда Flash embedded in

HTML, 549
команда HTML, 547

создание документа формата
PDF, 551

создание документов, 538
формирование изображения для

Web, 543

682

Файловые форматы (окончание):
текстовые форматы

DOC, 141
Quattro, 141
RTF, 141
TXT, 141
WK, 142
WP, 142
WS, 142
XLS, 142

Ц
Цветовое управление, 122

диалоговое окно Color
Management, 123

преобразование цветовых
пространств, 124

цветовые профили, 122
Цветовые ловушки, 119

порядок формирования, 121
Цветовые форматы, 114

дуплексный формат, 117
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ЭФФЕКТИВНАЯ РАБОТА С ВЕКТОРНОЙ ГРАФИКОЙ
В ПОЛНОМ ОБЪЕМЕ

* J O J-1

доктор технических наук, видный специалист в области оптимизации
дискретных информационных процессов. В последние годы активно
занимается авторской деятельностью по компьютерной тематике.
Опубликовал 16 книг по графическим, издательским и мультимедийным
приложениям.

Книга представляет собой полное руководство по популярнейшей программе векторной
графики CorelDRAW. Широкий доступ к материалу книги обеспечивается за счет хорошо
структурированной справочной информации, детального рассмотрения функций и
возможностей пакета CorelDRAW 12-й версии. Большое количество иллюстраций
с примерами делает процесс изучения более наглядным. Кроме программы CorelDRAW
в руководство включены описания дополнительных программ: Corel R.A.V.E 3.0 (создание
видеоклипов), CorelTRACE 12 (трассировка) и Corel Capture 12 (захват изображений
с экрана).


